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Text mail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 40
Third party CTI - TAPI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . APPLI File 1
Third party CTI - TAPI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . APPLI File 2
Tickets and statements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . APPLI File 5
Time ranges (MMC station) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . MMC File 6
Time Ranges  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 11
TL and ISDN access (MMC station)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . MMC File 7
TL forwarding. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . HARD File 7
Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 26
Transit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . PRIVNET File 1
Trunk groups (MMC station) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . MMC File 8
Trunk groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 2
Trunk line allocation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 49

U
UAI (board) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . HARD File 9
UPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . HARD File 12
UUS (User-to-user signaling). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 15

V
VBTEL (visually impaired OS). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . TERM File 7
Visual mailbox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VMU File 4
VN7 (compatibility). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 16
Voice prompts management (PM5) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . PM5 File 3
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Voice server dimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VMU File 1
Voice server operating modes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VMU File 1
Voice Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 54
VoIP CoCPU (installation) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VOIP File 2
VPN Client to LAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . IP File 8
VPN LAN to LAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . IP File 8
VPN  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . IP File 8
VPNs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . PRIVNET File 1

W
Wake-up ticket. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . APPLI File 5
Wake-up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 44
Welcome messages (MMC station) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . MMC File 18
Withdraw from group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FEATURES File 28
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REASONS FOR CHANGING ISSUE
In relation to issue 03 of the technical documentation, this issue 04 adds the following changes:

- "Product presentation" section:

• "Capacities and limits" file: miscellaneous updates ; addition of boards implementation and
power supply limits.

- "Environment compatibility between Alcatel OmniPCX Office" file: addition of this new fi-
le.

- "Hardware" section:

• "Main power supplies" file: addition of batteries maintenance recommendations.

- "CALL SERVER: Telephone features" section:

• "Making/Answering a call" file: addition of the configuration of broadcast on external louds-
peaker.

- "List of services offered": miscellaneous updates (no loudspeaker on 4003 and First sets).

- "CALL SERVER: Mobility" section:

• "Traffic counters" file: updates of the PM5 examples.

- "e-SERVER: Internet applications" section:

• "Electronic messaging" file: addition of Email addresses description.
- "VPN" file": informations on the IPsec interoperability.

- "Applications" section:

• "Starting-up an Elitecost 64-128: addition of this new file.

- "PM5: System configuration": section

• "Installation procedures" file: miscellaneous updates.
- "Voice prompts management" file: addition of this new file.

- "Software keys" section:

• "Software keys" file: miscellaneaous updates.

- "Maintenance" section:

• "System messages" file: update of the description of message 125.
• "Data restorations" file: addition of this new file.
• "Start and stop a system" file: addition of this new file.
Ed. 04 1/2Réf. 3EH 21000 BSAA
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- "Data transfer problem with Windows NT4" file: addition of this new file.
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CLAUSES
Copyright and Trademarks
Datalight is a registered trademark of Datalight, Inc.
FlashFXtm is a trademark of Datalight, Inc.
Copyright 1993 - 2000 Datalight, Inc., All Rights Reserved.
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GENERAL DESCRIPTION
Alcatel OmniPCX Office is an "e-communication server", a new "all-in-one" concept combining proven 
telephony functions with data management and access to all the resources of the Internet. This "multi-
purpose" server provides a turnkey global communication solution for small and medium-scale enter-
prises with 6 to 200 employees.

MAIN FEATURES

Voice:

- voice mail
- automatic exchange
- CTI server
- Voice over IP

Data:

- LAN switch
- router and integrated firewall
- DHCP and DNS server

Internet:

- shared access to the Internet (ISDN or xDSL connection)
- Proxy server
- Cache server
- Mail server
- VPN
Ed. 04 1/8Réf. 3EH 21000 BSAA
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INSTALLATION SYNOPSIS

Z

ISDN

Private network
(QSIG/ISVPN)

Analog public
network 

Z

Z

Reflexes terminals

Reflexes terminals
- First
- Easy
- Premium
- Advanced

DECT 4070 IO/EO base 

Analog terminal

Fax

Ancillaries

General bell

Loudspeaker

"Please wait" music

Background music

Doorphone

- Internet Access
- Proxy Server
- Cache Server
- Firewall
- Mail server

PM5

e-Reflexes

10 base T

Z

Pulse metering
- Elitecost
- Printer

Z

TAPI 2.1 or CSTA server

Integrated Internet applications:

@

LAN

Z

- Integrated voice server
- Integrated CTI server
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HARDWARE DESCRIPTION

In order to cover the entire market segment for small and medium-sized enterprises (6 to 200 users), 
Alcatel OmniPCX Office is available in 3 modules in 19" rack format, which can be mounted in a com-
puter cabinet or placed on a shelf:

Rack 1 

- 28 ports
- 1 CPU slot + 2 general-purpose slots (no SLI16 board)
- Energy consumption: 1 A / 70 W.
- Dimensions: H = 66 mm; W = 442 mm; D = 400 mm.
- Weight: 6 kg.

Rack 2

- 48 ports
- 1 CPU slot + 5 general-purpose slots
- Energy consumption: 2 A / 100 W.
- Dimensions: H = 110 mm; W = 442 mm; D = 400 mm.
- Weight: 11 kg.
Ed. 04 3/8Réf. 3EH 21000 BSAA
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Rack 3

- 96 ports
- 1 CPU slot + 4 specific general-purpose slots (no UAI16 and MIX boards)
- Energy consumption 2,3 A / 150 W.
- Dimensions: H = 154 mm; W = 442 mm; D = 400 mm.
- Weight: 13 kg.

Maximum capacity:

The system can be extended by adding one or two modules to the main module. All combinations are 
possible, with a maximum of 3 modules. The maximum capacity is 236 stations.
Ed. 044/8 Réf. 3EH 21000 BSAA
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PRODUCT LINE-UP

Different solutions exist for each model, depending on the desired level of service:

VOICE SOLUTIONS - Alcatel OmniPCX Office S, M, L and XL

Based on a mature product offering meeting telephony requirements (conventional automated atten-
dant), these packages include:

- a basic voice mail unit (2 ports, 20 minutes of recording) providing a voice mailbox to all users
equipped with dedicated Alcatel Reflexes terminals

- an automated attendant
- a CTI server

The RACK x modules are equipped with a standard CPU board with 32MB of SDRAM.

e-SOLUTIONS - Alcatel OmniPCX Office e-S, e-M, e-L and e-XL

Based on more advanced telephony requirements (voice mail service on 6 or 8 ports), these packages 
allow upgrading to provide the most comprehensive Internet services (electronic mail server, Proxy and 
cache server, VPN and Voice over IP). Alcatel OmniPCX Office thus becomes an e-communication ser-
ver.

The RACK x modules are equipped with a CPUe (enhanced) board with 64MB of SDRAM.

Nota : Refer to the "Capacities" sheet for a detailed description of the functions offered by each 
package.

These solutions allow the system to be built up by adding modules, boards, applications and software 
keys.
Ed. 04 5/8Réf. 3EH 21000 BSAA
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BOARDS AND OPTIONS 

Board Function Optional boards Connections

ATA2
ATA4

2 or 4 analog trunk line in-
terfaces

MET: pulse meter recei-
ver

Analog trunk line (TL), 
TL-PS diversion

BRA2
BRA4
BRA8

2, 4 or 8 T0 basic accesses ISDN network

CPU, CPUe Processing Unit HSL1, HSL2: intercon-
nection with add-on 
modules
XMEM: memory exten-
sion and/or IDE interfa-
ce for the hard disk
VoIP: Voice over IP for 
e-XS model
AFU: auxiliary functions

Lanswitch or Ethernet 
terminal
Please-wait message 
player
Tuner for background 
music
Alarm
Doorphone
Loudspeaker
General call ringer
Pulse metering device
PC PM5

CoCPU, CoCPU@ CoProcessing Unit VoIP: Voice over IP
SLANX: mini-switch 
(CPU/CPUe - CoCPU/
CoCPU@ link)
WAN: additional Ether-
net link

Lanswitch or Ethernet 
terminal

LanX8
LanX16

8 or 16 10/100 BT Ether-
net ports

@ Phones, Hub, 
Lanswitch, PC, etc.

MEX (equipped 
with an HSL1 
board)

Add-on module controller

MIX244
MIX484
MIX448
MIX044
MIX084
MIX048

0, 2 or 4 T0 basic accesses 
+ 4 or 8 UA interfaces
+ 4 or 8 Z interfaces

ISDN network, analog Z 
terminals and Alcatel 
Reflexes stations

PRA-T2
PRA-T1
DASS2
DLT2

PRA -T2, DASS2, DLT2: 30 
B-channels + 1 D-channel; 
2048 kbps)
PRA-T1: 23 B-channels + 1 
D-channel; 1544 kbps

PRA-T2: ISDN network
DASS2: UK public/priva-
te network
DLT2: Private QSIG 
network
PRA-T1: Hong-Kong 
ISDN network
Ed. 046/8 Réf. 3EH 21000 BSAA
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FUNCTIONS PROVIDED AND HARDWARE REQUIRED

SLI4
SLI8
SLI16

4, 8 or 16 Z interfaces Analog Z terminals

UAI4
UAI8
UAI16

4, 8 or 16 UA interfaces Alcatel Reflexes stations
Multi-Reflexes
4070 IO/EO DECT base 
stations

Board Function Optional boards Connections

CPUe

VoIP

Rack 1

Rack 3

Rack 2 CPU

+

CoCPU

+
CoCPU@

e-SOLUTION

VOICE only
Internet access

only
 + VPN

 + Proxy,
Cache,

Mail server

+ Hard disk

+ Hard disk

Only one CoCPU supported

CPUe + VoIP4 +  Hard disk

Restrictions: 2 IP channels with maximum of 16 users
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CAPACITIES AND LIMITS
The following table gives the capacities provided by the various Alcatel OmniPCX Office solutions.

S / e-S M / e-M L / e-L XL / e-XL Maximum 
limits

System

Type of module Rack 1 Rack 2 Rack 3 Rack 3 + 
extension 
Rack 3

3 modules, 
all combina-
tions possi-

ble

Total number of slots (with CPU 
and MEX boards

3 6 9 18 27

Available slots 2 5 8 16 24

Total number of CPU/CPUe 
boards

1

Total number of UAI16 boards 1 3 4 8 12

Total number of SLI16 boards 0 2 5 10 12

Total number of UAI16 + MIX 
boards

2 5 4 8 12

Co-processing CPU (CoCPU) 
including 1 CoCPU@ maxi-
mum per system

1 2 2 5 6

IP channels 16 32 32 80 88

VOIP daughterboards 1 2 2 5 6

Hard disk 1 2

Hard disk capacity 6 Gbytes minimum

Communication ports

Users' ports (Reflexes + Z) 28 56 96 192 200

Multi-Reflexes 4099 6 6 6 12 18

Lanswitch boards 1 LanX16 1 LanX16 
+ 1 LanX8

2 LanX16 4 LanX16 6 LanX16

Available Ethernet ports (*) 14 20 28 56 84

Analog trunk lines (**) 4 16 24 48 72
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Primary T2 access 1 3 3 6 9

Basic T0 access 8 12

IP trunks 16 32 32 80 96

Total trunk lines and B-chan-
nels

34 90 120 120 120

Terminals + Work stations

User directory numbers (***) 250

Reflexes terminals + simple 
terminals (Z)

28 56 96 192 236

Reflexes terminals 24 56 96 192 236

Simple terminals (Z) 16 32 80 160 196

Mobile Reflexes (*****) 235

IP subscribers (IP Reflexes + 
PIMphony IP)

55 120 120 200 200

Client PC H.323 55 120 150

PIMphony clients with integra-
ted CTI server

25

CTI server

CSTA sessions 25

CSTA supervision 208

Reflexes terminal options

Add-on modules (max. 2/ter-
minal)

10 40 60 120 136

S0, Z, V24 metering interfaces 12 24 42 48 48

V24 metering interface 1

Mobility equipments (full wireless configurations)

Remotely supplied DECT 4070 
RF bases

7 14 24 48 60

DECT 4070 LF bases 23 47 60 60 60

Call server

Voice mail ports from 2 to 8

Voice mail storage capacity from 20 to 80 minutes

Voice mail storage capacity 
with hard disk

up to 200 hours

S / e-S M / e-M L / e-L XL / e-XL Maximum 
limits
Ed. 042/10 Réf. 3EH 21000 BSAA
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(*): 2 Ethernet ports are used for:

- interconnecting the LAN with the CPU

Preannouncement from 4 to 8

Languages from 2 to 4

Directory entries 3000

Speed dial numbers 2200

Basic on hold music 16 seconds

Customizable on hold music up to 2 minutes

On hold music with hard disk up to 10 minutes

Multiple EDN per S0 98

Entries in ARS table 500

Account codes 250

Metering tickets up to 1,000 tickets

NMC tickets with hard disk up to 30,000 tickets

Groups (terminals + broadcas-
ting + pick-ups)

50 with maximum of 32 users per group

Operator groups 8 with maximum of 8 operator stations per group

Conference 3 simultaneously

e-server

Shared Internet access

- ISDN
- ADSL modem or external

router (**)
up to 128 kbps (2 B-channels)

up to 2 Mbps

Internet users 28 200

Simultaneous Internet accesses Depends on available bandwidth (e.g.: up to 20 over a 128-kbps 
link)

Web page cache capacity (****) 500 Mb 1.5 GB

E-mailboxes (****) 28 200

E-mail storage capacity (****) 2.2 GB 3.7 GB

Simultaneous PPTP teleworkers 2 5

LAN networking via the Internet 
(IP sec)

1 2

S / e-S M / e-M L / e-L XL / e-XL Maximum 
limits
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- cascading of the LAN switches (Uplink = always reserved on each LAN board)

(**): Available from version R1.1 onwards

(***): Subscribers numbersinclude all terminals and virtual users 13 auxiliary ports (VMU, Internet ac-
cess, Remote access), main operator terminal number.

(****): Hard disk obligatory

(*****): Be aware that radio base station number dimensionning is adapted to mobile sets number.
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BOARDS IMPLEMENTATION 

Rack 1

Yes +: recommended slot

Rack 2

BOARD SLOT 1 SLOT 2 CPU SLOT 

CPU, CPUe, MEX No No Obligatory

MIX x/y/z Yes + Yes No

UAI4, UAI8, UAI16 Yes + Yes No

SLI4, SLI8 Yes + Yes No

SLI16 No No No

PRA-T2, PRA-T1, DASS2, 
DLT2 

Yes Yes + No

ATA2, ATA4 Yes Yes + No

BRA2, BRA4, BRA8 Yes Yes + No

CoCPU, CoCPU@ Yes Yes + No

LANX8, LANX16 Yes Yes + No

Empty slot blanking cover Yes Yes No

SLOT1 SLOT2 SLOT C PU

SLOT1 SLOT2

SLOT4SLOT3 SLOT5

SLOT C PU
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Yes +: recommended slot

Rack 3

BOARD SLOT 1-3 SLOT 2-4 SLOT 5 CPU SLOT 

CPU, CPUe, MEX No No No Obligatory

MIX x/y/z Yes + Yes Yes No

UAI4, UAI8, UAI16 Yes + Yes Yes No

SLI4, SLI8, SLI16 Yes + Yes Yes No

PRA-T2, PRA-T1, DASS2, 
DLT2 

Yes Yes + Yes No

ATA2, ATA4 Yes Yes + Yes No

BRA2, BRA4, BRA8 Yes Yes + Yes No

CoCPU, CoCPU@ Yes Yes Yes + No

LANX8, LANX16 Yes Yes Yes + No

Empty slot blanking cover Yes Yes Yes No

BOARD SLOT 1-2-3-4 SLOT 5-8 SLOT 6-7 CPU SLOT 

CPU, CPUe, MEX No No No Obligatory

MIX x/y/z Yes No No No

UAI4, UAI8 Yes + Yes Yes No

UAI16 Yes + No No No

SLI4, SLI8, SLI16 Yes + Yes Yes No

SLOT1 SLOT2

SLOT4

SLOT7SLOT6

SLOT3 SLOT5

SLOT8

SLOT C PU
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Yes +: recommended slot

PRA-T2, PRA-T1, DASS2, 
DLT2 

Yes Yes Yes + No

ATA2, ATA4 Yes Yes Yes + No

BRA2, BRA4, BRA8 Yes Yes Yes + No

CoCPU, CoCPU@ Yes Yes + Yes No

LANX8, LANX16 Yes Yes + Yes No

Empty slot blanking cover Yes Yes Yes No
Ed. 04 7/10Réf. 3EH 21000 BSAA
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POWER SUPPLY LIMITS

The following tables give the details power consumption of the different items (boards and terminals) 
and the limit not to be exceeded for each model (all values are in W unit).

The maximum budget at the charger level is also indicaded for each model and you have just to add 
the values for all items presents in the system. The configuration will be in the power supply limits if the 
total obtained is less or equal to the maximum budget allowed to the type of rack used :

- maximum budget for Rack 1 = 34 W

- maximum budget for Rack 2 = 57 W

- maximum budget for Rack 3 = 85 W

Boards and terminals Rack 1 Rack 2 Rack 3

CPU boards

CPU/CPUe 5,16 6,40

CoCPU/CoCPU@ 5,73 7,10

MEX 1,32 1,64

Daughter boards

XMEM 0,10 0,12

VOIP 16 channels 1,74 2,16

VOIP 8 channels 1,01 1,25

VOIP 4 channels 0,65 0,81

HSL 0,30 0,37

WAN 0,73 0,91

Hard Disk 2,33 2,89

SLANX 1,62 2,01

AFU 0,55 0,68

Trunk boards

BRA 8 0,97

BRA 4 0,56

BRA 2 0,33

Metering 0,06

PRA - T2/T1 0,33

ATB 4 1,42

ATB 2 0,78
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Datacom boards

LANX 8 3,64 4,51

LANX 16 6,88 8,53

Mixed boards

4T0/8UA/4Z 2,90

4T0/4UA/8Z 3,45

4T0/4UA/4Z 2,13

8UA/4Z 2,39

4UA/8Z 2,96

4UA/4Z 1,86

Extension boards

UAI 16 2,21

UAI 8 1,32

UAI 4 0,87

SLI 16 5,00

SLI 8 2,51

SLI 4 1,26

Terminals

Reflexes (UA) keystation 0,45 0,39

Add-on module 0,24 0,21

Multi Reflexes UA 0,61 0,53

CTI/AP option 0,92 0,80

S0 option 1,23 1,07

4070 (IBS) remote feeding (from PABX) 2,90 2,52

4070 (IBS) local feeding (with power supply) 0,00 0,00

Analog terminal 0,21 0,18

Boards and terminals Rack 1 Rack 2 Rack 3
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COMPLIANCE WITH STANDARDS
SAFETY DECLARATION

Compliance with IEC 60950 3rd ed. standards

SELV: Safety Extra Low Voltage

TNV-3: Telecommunication Network Voltage

To maintain safety levels, it is essential to connect up circuits of the same nature and to ensure that all 
means of connection comply with the constraints laid down for each circuit type.

Interface classifica-
tion

Interface location

TNV-3 - Z interface (SLI board)
- Z interface for Alcatel Reflexes station (AP board)
- Analog trunk line interface (ATA board)

SELV - Alcatel Reflexes station interface (UAI board or Multi-Reflexes option 4099)
- 4070 IO/EO base station interface (UAI board)
- T0 interface (BRA board)
- T2/T1 interface (PRA board)
- S0 interface (S0 board)
- Please-wait or background music interface (CPU/CPUe board)
- Alarm interface (CPU/CPUe board)
- General bell interface (CPU/CPUe board)
- Doorphone interface (CPU/CPUe board)
- Loudspeaker interface (CPU/CPUe board)
- V24 interface (CPU/CPUe board)
- CTI interface for Alcatel Reflexes station (CTI or V24/CTI board)
- 10/100 base T Ethernet interface (CPU/CPUe or CoCPU/CoCPU@ board)
- 4070 IO/EO base station (inputs-outputs)
- 4097 CBL UA/DECT adapter
Ed. 04 1/2Réf. 3EH 21000 BSAA
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ESSENTIAL REQUIREMENTS

This product complies with the core requirements of European Community R&TTE Directive 1999/5/
EC.

Electromagnetic compatibility :

- EN 5502 Ed. 1998 class B: Limits and methods of measuring the characteristics of radioelectric
disturbances produced by information technology equipment.

- EN 55024 Ed. 1998: Information technology equipment: immunity characteristics.
- EN 61000-3-2 Ed. 1995: Electromagnetic compatibility: harmonic current emission limits.
- EN 61000-3-3 Ed. 1995: Electromagnetic compatibility: voltage fluctuation and flicker limits in low

voltage networks.

Safety:

- IEC 60950 Ed. 3: Safety of information technology equipment.
Ed. 042/2 Réf. 3EH 21000 BSAA
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ENVIRONMENT COMPATIBILITY 
BETWEEN ALCATEL OMNIPCX OFFICE
On the new generation Alcatel OmniPCX Office, it is possible to re use some equipments and terminals 
from the Alcatel Office range.

TERMINAL COMPATIBILITY ON THE ALCATEL OMNIPCX OFFICE

Compatible Alcatel Reflexes

- The complete range 2G : 4001, 4003, 4011, 4012, 4023, 4034, 4081L, 4081M and 4088.
- The complete range Beta 2G.
- The complete range 3G : Advanced (4035), Premium (4020), Easy (4010, and First (4004), 4097

CBL.
- All sub-devices behind Alcatel Reflexes : 4083 ASM, 4084 IS, 4084 ISW, 4085 AB, 4091, 4093

ASY, 4094 ISW, 4095 AP. 
- Sub-devices CTI 4091 support only the UA protocol. SPI for TAPI interface is not imple-

mented anymore.

Compatible Alcatel Reflexes IP terminals

- Alcatel IP Enabler 4098 FRE.

Compatible Alcatel mobile terminals

- Terminals DECT 2G : 4073 GS, 4074 GB, GBEx, GH, GI and SGAP.
- Terminals DECT Mobile 100 and 200.
- Reflexes DECT terminals with 4097 CBL.
- Alcatel intelligent base station 4070 IO/EO (IBS) and gain antennas.

COMPATIBLE APPLICATIONS ON ALCATEL OMNIPCX OFFICE

- Cost control:

• Eltecost
• Alcatel 4715 release 4.4.14
- Alcatel 4740 release 4.4.14

- CTI applications CTI Third party only:

• PIMphony offer (with TAPI 2.0 SPI connected on LAN)

- TAPI & CSTA servers

- The Alcatel Office Call Center is compatible, except the AOCC built-in voice mail, in re-
lease 1.0. It is fully compatible in release 1.1.
Ed. 04 1/2Réf. 3EH 21000 BSAA
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INCOMPATIBLE HARDWARE PARTS ON ALCATEL OMNIPCX OFFICE

- The complete range of Alcatel Reflexes 1G (first generation).
- Alcatel mobile DECT sets 4075, 4074 B, 4074 Bex, 4074 H.
- Base station DECT RBS Alcatel 4070 IA and 4070 EA.
- The complete range Alcatel 160 sets.
- The complete range Alcatel 4120 (900B) sets.
- Voice mail of Alcatel Office Call Center in release 1.0.
Ed. 042/2 Réf. 3EH 21000 BSAA
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RACK 1 - RACK 2 - RACK 3 MODULES
RACK 1

The RACK 1 module consists essentially of a plastic frame.
The plastic frame receives all the parts for attaching the power supply board, the fans, the battery and 
the mains power connector, and everything needed to facilitate the routing of the cables.
There is no backplane board: the metric connectors are on the power supply module.

The enclosure comprises 3 parts: metal cover and base, plastic front face.

Access to the fans, the power supply module and the battery is gained by disconnecting the mains ca-
ble and removing the top metal cover (it is vital to removal all the boards before opening the cover).

Metal cover

Power supply (+ Backpanel) 

Battery

Battery retaining clip

Fan

Boards (CPU +
interfaces)

Metal base

Grounding clips

Plastic frame

Plastic front face

Mains power cable

Mains power connector
mounting plate
Ed. 04 1/2Réf. 3EH 21000 BSAA
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RACK 2 AND RACK 3

The frame consists of a "U"-shaped sheath closed on the top by a riveted plate. The boards are guided 
by 2 (Rack 2) or 3 (Rack 3) rails riveted vertically to the frame.
The enclosure consists of a metal top part, two metal side parts and a plastic front face.

Access to the fans, the power supply module and the batteries is gained by disconnecting the mains 
cable and unscrewing the back panel.

Power supply

Cooling zone
(fans) Mains power

connector

Batteries
Board
installation
areas 
Ed. 042/2 Réf. 3EH 21000 BSAA
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CPU - CPUe BOARDS
The CPU and CPUe boards (Processing Unit) present the following characteristics:

- CPU: call handling, 100-MHz processor, 32 MB SDRAM.
- CPUe: call handling, management of the router function for accessing the Internet, 133 MHz pro-

cessor, 64 Mb S-DRAM, more powerful DSPs.
Plug-in to BACKX board

XMEM or VOIP

SDRAM

HSL AFU

ASPEN

+

-

1 4

ON
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DAUGHTER BOARDS

The CPU - CPUe boards can take the following daughter boards:

- HSL (High Speed Link): for cabinet interconnections
- XMEM (eXtended MEMory): memory extension + 2.5-inch hard drive connection
- VoIP (Voice over IP): converts voice signals into data packets and back again
- AFU (Auxiliary Function Unit): support for auxiliary functions: general bell, doorphone, audio In,

audio Out, etc.

SDRAM CAPACITY

DAUGHTER BOARDS CPU CPUe

XMEM YES YES

VoIP NO YES for model 
e-XS

HSL1 YES YES

HSL2 YES YES

AFU YES YES

HARD DRIVE YES YES

Capacity CPU CPUe

SDRAM32 YES NO

SDRAM64 NO YES

SDRAM128 NO YES on CPUe 
model e-XS 

only
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OUTPUT PORTS (BOARD STIFFENER)

Available functions:

- LAN: 10/100 base T Ethernet port (MDI-II/straight)
- AUDIO-OUT: loudspeaker, alarm and general bell interfaces; 12V output
- AUDIO-IN: please-wait message and background music interfaces
- DOORPHONE: doorphone interfaces
- CONFIG: RS232 for MMC, NMC and PPP connections
- MODULE1: HSL to add-on module 1
- MODULE2: HSL to add-on module 2

RJ45 pin 1 2 3 4 5 6 7 8

LAN outputs TX+ TX- RX+ RX-

AUDIO-OUT out-
puts

Audio 
Out A

Audio 
Out B

Alarm A CenRg 
A

CenRg 
B

Alarm B Ground +12 V

CONFIG outputs CTS DSR RX Ground Ground TX DTR RTS

MODULE1 out-
puts

TX+ TX- RX+ RX-

MODULE2 out-
puts

TX+ TX- RX+ RX-

AUDIO-IN outputs Audio In 
A

Audio In 
B

Audio 
Ctrl A

Audio 
Ctrl B

DOORPHONE 
outputs

Door 
PHB1

DoorPH
A1

DoorPH
A2

Door 
PHB2

LAN AUDIO-OUT CONFIG

MODULE1 MODULE2 AUDIO-IN DOORPHONE

PROCESSING UNIT

LAN FAN POWER

CPU

CPU

MODULE

WAN

WAN

LAN AUDIO-OUT CONFIG

MODULE1 MODULE2 AUDIO-IN DOORPHONE

PROCESSING UNIT

LAN FAN POWER

CPU

CPUe

MODULE
Ed. 04 3/12Réf. 3EH 21000 BSAA
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MEANING OF THE LED INDICATIONS

Name Color Function

CPU Green CPU functioning LED (flashing)

POWER Red/Green - Mains operation: steady green LED
- Battery operation: steady yellow LED
- Idle: flashing red LED

FAN Red/Green - Both fans functioning: steady green LED
- 1 or both fans down: steady red LED

LAN Green LAN functioning LED (flashes when there is traffic)

MODULE Green Presence of HSL board

WAN Green Not Used
Ed. 044/12 Réf. 3EH 21000 BSAA
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GENERAL CONNECTION DIAGRAM

Configuration without SLANX4 (recommended configuration)

PROCESSING UNIT CPU

MEX

MEX

COPROCESSING UNIT CoCPU

COPROCESSING UNIT CoCPU

ETHERNET LANSWITCH LANX8

"Please wait" message 
Background music

Loudspeaker
Alarm

External LAN Switch 

PC (PM5, NMC)

Doorphone

12V serviceable voltage

CoCPU board + SLanX4 board

CPU board

MEX  board (extension unit) 1

MEX  board (extension unit 2)

CPU board

LANX board

ADD-ON MODULE 

ADD-ON MODULE 

General bell
Ed. 04 5/12Réf. 3EH 21000 BSAA
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Configuration with SLANX4

MEX  board (extension unit 1)

MEX  board (extension unit 2)

"Please wait" message 
Background music

General bell 
Loudspeaker
Alarm

CoCPU board + SLanX4 board

CPU board

External LAN Switch 

CPU board

PC (PM5, NMC)

Doorphone

PROCESSING UNIT CPU

ADD-ON MODULE MEX

ADD-ON MODULE MEX

COPROCESSING UNIT CoCPU

COPROCESSING UNIT CoCPU

12V serviceable voltage

ETHERNET LANSWITCH LANX8

LANX board

OR 
Ed. 046/12 Réf. 3EH 21000 BSAA
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CONNECTING A HARD DISK

Hard disks are fitted using an XMEM board.

Important : During installation, always take anti-static precautions (wristband, heelpiece, etc.) befo-
re handling the hard disk. Electrostatic discharges shorten the life of the disk. 

When going into stand-by mode, wait for red Power LED to stop flashing before you re-
move the module's CPU board. Extracting the disk before the switch to standby is 
completed can destroy part of the disk or damage its contents. Never handle the 
hard disk until the motor has stopped completely (about 4 seconds after the red Power 
LED stops flashing).

CONNECTING A PLEASE-WAIT MESSAGE PLAYER

This is connected via the AUDCTRL output (control contact open when idle) and the AUDIN input of 
the AUDIO-IN connector.

Audio input characteristics:

- Input impedance: 600 Ohms

Hard disk

CPU board

XMEM board

44-point connectors connected by a flat cable 

Support

Audio In B

AudCrtl A
Distribution panel

Control
circuit 

Audio
circuit

Audio In A

AudCrtl B

Power supply

PROCESSING UNIT CPU
Ed. 04 7/12Réf. 3EH 21000 BSAA
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Contact characteristics (same characteristics for the alarm and doorphone control contacts):

- Max. power: 10 W
- Max. voltage: 100 V
- Max. current: 500 mA

CONNECTING A BACKGROUND MUSIC TUNER

This is connected via the AUDIN input of the AUDIO-IN connector.

Audio input characteristics:

- Input impedance: 600 Ohms
- Input level: access +10 dBr

CONNECTING AN ALARM

The alarm is activated under the same conditions as TL forwarding (power outage or software com-
mand).

It is connected via the ALARM output (control contact closed when idle) of the AUDIO-OUT connector.

Distribution panel

Audio In B

Audio In A

Power supply

TUNER

PROCESSING UNIT CPU
Ed. 048/12 Réf. 3EH 21000 BSAA
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Alarm B

Alarm A

PROCESSING UNIT CPUDistribution panel

Alarm
device

Power supply
Ed. 04 9/12Réf. 3EH 21000 BSAA
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CONNECTING A DOORPHONE

The doorphone interface comprises an intercom and an optional doorstrike powered by the mains 
supply through a SELV (Safety Extra Low Voltage) transformer.

It is connected via the DOORPHA and DOORPHB outputs (control contacts open when idle) of the 
DOORPHONE connector.

Connecting an NPTT doorphone

- A single doorphone with doorstrike may be connected to the system.
- The system also allows for the connection of 2 doorphones without doorstrikes.

Connecting Telemini and Universal Doorphones

These doorphones only require the use of a Z station interface.

- Several of these doorphones can be connected to the system; the limit is determined by the maxi-
mum number of analog stations the system can support.

- A system cannot have TELEMINI and UNIVERSAL doorphones at the same time.

DoorPhB1

DoorPhB2

DoorPhA1

DoorPhA2

PROCESSING UNIT CPUDistribution panel

DOORPHONE

To door
keeper
Ed. 0410/12 Réf. 3EH 21000 BSAA
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CONNECTING A GENERAL BELL

The general bell is connected via the CENRG output of the AUDIO-OUT connector.

CONNECTING A BROADCAST LOUDSPEAKER

Broadcast loudspeakers are connected via the AUDOUT output of the AUDIO-OUT connector.

- Output impedance: < 500 Ohms
- Output level: access + 3 dBr

USING THE 12V OUTPUT

The GROUND and + 12V outputs on the AUDIO-OUT connector allow for the connection of an ex-
ternal 12V device with a maximum energy consumption of 150 mA (Rack 1 and Rack 2) or 300 mA 
(Rack 3).

CenRg B

CenRg A

PROCESSING UNIT CPUDistribution panel

Power supply

General 
call ringer

Aud Out B

Aud Out A

PROCESSING UNIT CPUDistribution panel

Power supply

Amplifier
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MEX BOARD
The MEX board (Module EXpansion) performs the controller functions in the add-on modules.

Plug-in to BACKX board

HSL1
Ed. 04 1/2Réf. 3EH 21000 BSAA
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DAUGHTER BOARD

The MEX board is equipped with an HSL1 (High Speed Link) board for interconnecting with the basic 
module.

OUTPUT PORTS (BOARD STIFFENER)

Available functions:

- MAIN: HSL to basic module.

MEANING OF THE LED INDICATIONS

CONNECTION

The MEX board is connected to the MODULE 1 or MODULE 2 connector on the CPU/CPUe board. 
See also the General Diagram in the section on CPU-CPUe boards.

RJ45 pin 1 2 3 4 5 6 7 8

MAIN outputs TX+ TX- RX+ RX-

Name Color Function

POWER Red/Green - Mains operation: steady green LED
- Battery operation: steady yellow LED
- Idle: flashing red LED

FAN Red/Green - Both fans functioning: steady green LED
- 1 or both fans down: steady red LED

MAIN

MODULE EXPANSION

POWERFAN

MEX
Ed. 042/2 Réf. 3EH 21000 BSAA
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CoCPU - CoCPU@ BOARDS
The CoCPU and CoCPU@ (CoProcessing Unit) boards offer applications such as Voice over IP and 
access to the Internet and to Internet services. 

Plug-in to BACKX board

XMEM  VOIPor

SDRAM

WAN SLANX

ASPEN

+

-

1 4

ON

1 4

ON

CoCPU

CoCPU@
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DAUGHTER BOARDS

The CoCPU - CoCPU@ boards can take the following daughter boards:

- VoIP (Voice Over IP): Gateway H323 with integrated Gatekeeper function; supports the manage-
ment of CODECs and DSPs for IP telephony and IP Trunk (IP trunk lines) applications

- SLANX (Switched LANX): 4 LAN switch ports
- WAN: Ethernet link allowing the connection of an external DSL modem or an external router

SDRAM CAPACITY

DAUGHTER BOARDS CoCPU CoCPU@

VoIP YES NO

WAN NO YES

SLANX4 YES YES

HARD DRIVE NO YES

Capacity CoCPU CoCPU@

SDRAM32 YES NO

SDRAM128 NO YES
Ed. 042/4 Réf. 3EH 21000 BSAA



File
4

COCPU - COCPU@ BOARDSHARDWARE

 

OUTPUT PORTS (BOARD STIFFENER)

Available functions:

- LAN: 10/100 base T Ethernet port (MDI-II/straight)
- WAN: Ethernet 10/100 Base T port (MDI-II/straight); connection to an ADSL modem (available

from version R1.1 onwards)
- UNIT1, UNIT2, UNIT3: ports on integrated LAN switch (MDI-X/crossover)
- UPLINK: Integrated LAN switch uplink port (MDI-II/straight).

MEANING OF THE LED INDICATIONS

RJ45 pin 1 2 3 4 5 6 7 8

LAN/WAN outputs TX+ TX- RX+ RX-

Uplink outputs TX+ TX- RX+ RX-

Unit 1 to 3 outputs RX+ RX- TX+ TX-

Name Color Function

CPU Green CPU functioning LED (flashing)

LAN Green LAN functioning LED (flashes when there is traffic)

WAN Green WAN functioning LED (flashes when there is traffic); LED used if 
an ADSL modem is connected, available from version R1 
onwards

UNITS 1 - 4

UPLINK

Green LAN switch interfaces 1 to 4 functioning LED (flashes when there 
is traffic)

LAN

COPROCESSING UNIT

LAN

CPUUplinkUnit 3Unit 2Unit1

CoCPU

UNIT1 UNIT2 UNIT3 UP-LINK

WAN

LAN

COPROCESSING UNIT

LAN

CPUUplinkUnit 3Unit 2Unit1

CoCPU@

UNIT1 UNIT2 UNIT3 UP-LINK

WAN
Ed. 04 3/4Réf. 3EH 21000 BSAA
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CONNECTION

The CoCPU boards are connected either to the CPU board (LAN port) or to a LAN switch port. See 
General Diagram in the CPU - CPUe board section.

CONNECTING A HARD DISK

Hard disks are fitted using an XMEM board.

Important : During installation, always take anti-static precautions (wristband, heelpiece, etc.) befo-
re handling the hard disk). Electrostatic discharges can shorten the life of the disk. 

When going into stand-by mode, wait for red Power LED to stop flashing before you re-
move the module's CPU board. Extracting the disk before the switch to standby is 
completed can destroy part of the disk or damage its contents. Never handle the 
hard disk until the motor has stopped completely (about 4 seconds after the red Power 
LED stops flashing).

Hard disk

CPU board

XMEM board

44-point connectors connected by a flat cable 

Support
Ed. 044/4 Réf. 3EH 21000 BSAA
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BRA BOARD
The BRA board The BRA (Basic Rate Access) board provides the basic access points (2 x 64-Kbps B-
channels + 1 x 16-Kbps D-channel per access) for connecting the system to the ISDN digital public 
network (point-to-point or multipoint T0 link). 3 board versions are available:

- BRA2: 2 T0 accesses
- BRA4: 4 T0 accesses
- BRA8: 8 T0 accesses

OBC

Plug-in to BACKX board

FICA
2

FICA
4

FICA
6

FICA
8

FICA
1

FICA
3

FICA
5

FICA
7
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OUTPUT PORTS (BOARD STIFFENER)

CONNECTING A T0 ACCESS

The Alcatel OmniPCX system can be installed near the digital network termination or at a certain dis-
tance (up to 350 m), as required. 

RJ45 pin 1 2 3 4 5 6 7 8

Outputs TX+ RX+ RX- TX-

1 2 3 4 5 6 7 8

ISDN ACESS - T0 BRA8 

12345678

Female RJ45, front

Distribution panel ISDN ACCESS - T0

DNT

Transmission

Reception

TX

RX

BRA8
Ed. 042/2 Réf. 3EH 21000 BSAA
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PRA BOARD
 The PRA (Primary Rate Access) board provides 1 primary access for connecting the Alcatel OmniPCX 
system to the ISDN digital public network or to private networks:

- PRA -T2, DASS2, DLT2: 30 B-channels + 1 D-channel; 2048 kbps)
- PRA-T1: 23 x 64-Kbps B-channel + 1 x 64-Kbps D-channel

There are several connection options: T2  120-ohm symmetrical pairs and T1 100-ohm symmetrical 
pairs. A coaxial 75-ohm connection is available using an external adapter kit.

OBC

Plug-in to BACKX board

FALC

1

4

3

2

Citroen straps 
(definition of 
board type)
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OUTPUT PORTS (BOARD STIFFENER)

T2 board example

NETW: connection to public network DLT.

PBX: network operation (QSIG).

BOARD TYPE DEFINITION (CITROEN STRAPS)

The board type is defined by the Citroën strap solder:

- T2 (ex-factory) : no solders   
- T1 : solder on strap 1
- CAS-T1 : solders on straps 2 and 3
- DLT2 : solder on strap 2
- DASS2 : solder on strap 3
- CAS-T2 : solder on strap 4

RJ45 pin 1 2 3 4 5 6 7 8

NETW outputs RX+ RX- TX+ TX-

PBX outputs TX+ TX- RX+ RX-

ISDN ACCESS - E1 

BUSY RAI AIS

NOS CRC LOS
PBX XNETW II 

PRA-T2 

12345678

Female RJ45, front
Ed. 042/4 Réf. 3EH 21000 BSAA
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ALARM LEDS

In brackets: French abbreviations

CONNECTION (120- OHM SYMMETRICAL PAIRS)

The PRA board is connected to a digital line termination (DLT) by 2 reinforced symmetrical pairs.

Cable impedance: 120 Ohms +/- 20% between 200 kHz and 1 MHz; 120 Ohms +/- 10% at 1 MHz.
We recommend using an L120-series cable (or the L204 equivalent).
The distance T2-DLT is limited by the amount of loss between the DLT and T2, which must not exceed 
6 dB at 1024 kHz.

T2 Name T1 Name Function

BUSY BUSY B-channels busy (red LED lights up if at least 1 B-channel is busy)

RAI (ATD) RAI Remote frame alarm (red LED lights up on alarm)

AIS (SIA2M) AIS Too many "1"s in the 2-Mbit binary train (red LED lights up on 
alarm)

NOS (MS) NSIG Absence of 2-Mbit signal (red LED lights up on alarm)

CRC (TE) CRC CRC error (red LED lights up on alarm)

LOS (PVT) NSYN Loss of frame alignment (red LED lights up on alarm)

BUSY RAI AIS

NOS CRC LOS

Distribution panel

DLT

Transmission

Reception

TX

RX

ISDN ACCESS - E1 PRA-T2
Ed. 04 3/4Réf. 3EH 21000 BSAA
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ATA BOARD
The ATA (Analog Trunk Access) board serves to connect analog trunk lines (TL). 2 board versions are 
available:

- ATA-2: 2 trunk lines
- ATA-4: 4 trunk lines

X1, X2, X3, X4: plug-in connectors for MET daughter boards (call charge metering receivers).

DSLAC

Plug-in to BACKX board

OBC
DSLAC

X1 X2

X4

X3
Ed. 04 1/4Réf. 3EH 21000 BSAA
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OUTPUT PORTS (BOARD STIFFENER)

CONNECTING A TL

Without TL forwarding

RJ45 pin 1 2 3 4 5 6 7 8

Outputs 1 to 4 PEA PEB

SLI outputs ZA ZB

PHONE outputs ZSETA ZSETB

1 2 3 4

ANALOG TRUNK ACCESS ATA4

SLI PHONE

12345678

Female RJ45, front

PEB

PEA

Distribution panel ANALOG TRUNK ACCESS ATA4

Analog
Public 
Network 
Ed. 042/4 Réf. 3EH 21000 BSAA
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With TL forwarding

In the event of a power cut or CPU failure, this solution forwards the analog line connected to device 
1 on the ATA board to another analog set in the system.

ANALOG INTERFACES SLI16

PEB

PEA

Distribution panel
ANALOG TRUNK ACCESS ATA4

Analog Public
Network 

Analog
terminal

ZSETA

ZSETB

ZA, ZB
Ed. 04 3/4Réf. 3EH 21000 BSAA



ATA BOARD HARDWARE

 

ADAPTATION TO UK PROTOCOLS

In accordance with the UK analogue public network, 2 types of ATA boards are available:

- ATA board (2 or 4 equipments) equipped with polarity inversion detectors.

- ATA LCG board (2 or 4 equipments) equipped with calibrated power failure detectors.

Protocol Board type Supported functionality

ATA ATA 
LCG

Detection release of 
remote

Detection discon-
nect of remote

"Loop calling unguarded clear" pro-
tocol

YES YES NO NO

"Loop calling guarded clear" proto-
col

NO YES YES NO

IP protocol YES NO NO YES
Ed. 044/4 Réf. 3EH 21000 BSAA
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MIX BOARD
The MIX board The MIX (Mixed Lines) board serves to connect ISDN basic accesses (T0), Alcatel Re-
flexes stations (UA) and 2-wire analog terminals (Z). 6 board versions are available:

- MIX244: 2 T0 accesses, 4 UA interfaces and 4 Z interfaces
- MIX484: 4 T0 accesses, 8 UA interfaces and 4 Z interfaces
- MIX448: 4 T0 accesses, 4 UA interfaces and 8 Z interfaces
- MIX044: 4 UA interfaces and 4 Z interfaces
- MIX084: 8 UA interfaces and 4 Z interfaces
- MIX048: 4 UA interfaces and 8 Z interfaces

E.g. MIX484 board

OBC

Plug-in to BACKX board

 T0
1 to 4

 UA
1 to 4

 UA
5 to 8Q

C
IA

LA
 (Z

1 
to

 Z
4

 (f
or

 X
/8

/4
) o

r 
Z5

 to
 Z

8 
(fo

r 
X/

4/
8)

Q
C

IA
LA

 Z
1 

to
 Z

4
 (f

or
 X

/4
/8

)

Ed. 04 1/2Réf. 3EH 21000 BSAA
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OUTPUT PORTS (BOARD STIFFENER)

CONNECTING AN ANALOG STATION (Z)

Follow the rules in the "SLI board" section.

CONNECTING AN ALCATEL REFLEXES STATION

Follow the rules in the "UAI board" section.

CONNECTING A T0 BASIC ACCESS

Follow the rules in the "BRA board" section.

RJ45 pin 1 2 3 4 5 6 7 8

Z outputs ZA ZB

UA outputs L1 L2

T0 outputs TX+ RX+ RX- TX-

1 2 3 4 1 2 3 4

1 2 3 4 5 6 7 8

MIXED

DIGITAL INTERFACES

ISDN T0 ANALOG INTERFACES

MIX4/8/4

1 2 3 4 5 6 7 8

1 2 3 4 1 2 3 4

MIXED

DIGITAL INTERFACES

ISDN T0 ANALOG INTERFACES

MIX4/4/8

ANALOG INTERFACES

12345678

Female RJ45, front
Ed. 042/2 Réf. 3EH 21000 BSAA



9

UAI BOARDHARDWARE

 

File
UAI BOARD
The UAI board allows the connection of Alcatel Reflexes stations (UA). 3 board versions are available:

- UAI4: 4 UA interfaces
- UAI8: 8 UA interfaces
- UAI16: 16 UA interfaces

OBC

Plug-in to BACKX board

CATS CATS

CATS CATS

UA interfaces 9 to 12 UA interfaces 13 to 16

UA interfaces 1 to 4 UA interfaces 5 to 8
Ed. 04 1/2Réf. 3EH 21000 BSAA
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OUTPUT PORTS (BOARD STIFFENER)

CONNECTING A REFLEXES STATION

 The terminals are equipped with a cable and a self-acting switch that plugs into the wall socket.  Each 
terminal is connected up by a pair of 0.5 or 0.6 mm diameter wires.

System - Reflexes station distances:

- 0.5 mm SYT type cable: 800 m (station without option) or 600 m (station with S0 or Z option)
- 278 type 0.6 mm cable: 1200 m (station without option) or 850 m (station with S0 or Z option)

RJ45 pin 1 2 3 4 5 6 7 8

Outputs L1 L2

9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8

DIGITAL INTERFACES UAI16

12345678

Female RJ45, front

L2 (5)

L1 (4)

Distribution panel DIGITAL INTERFACES UAI16

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16
Ed. 042/2 Réf. 3EH 21000 BSAA
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SLI BOARD
The SLI board (Single Line) allows the connection of 2-wire analog terminals (Z). 3 board versions are 
available:

- SLI4: 4 Z interfaces
- SLI8: 8 Z interfaces
- SLI16: 16 Z interfaces

OBC

Plug-in to BACKX board

Q
C

IA
LA

 (Z
1 

to
 Z

4)

Q
C

IA
LA

 (Z
9 

to
 Z

12
)

Q
C

IA
LA

 (Z
13

 to
 Z

16
)

Q
C

IA
LA

 (Z
5 

to
 Z

8)
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OUTPUT PORTS (BOARD STIFFENER)

CONNECTING AN ANALOG Z STATION

The sets are equipped with a cable and self-acting switch for connection to a wall socket. Each set is 
connected up with a pair of 0.5 or 0.6-mm wires (the maximum distance with 0.5-mm cabling is 1.3 
km).

RJ45 pin 1 2 3 4 5 6 7 8

Outputs ZA ZB

9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8

ANALOG INTERFACES SLI16

12345678

Female RJ45, front

ZB

ZA

1

3

5

2

4

6

Distribution panel ANALOG INTERFACES SLI16
Ed. 042/2 Réf. 3EH 21000 BSAA
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LANX BOARD
The LanX board (Ethernet LAN Switch) serves to connect Ethernet terminals (IEEE 802.3 compatible). 2 
board versions are available:

- LanX8: eight 10/100 BT Ethernet ports (ports 1 to 7: MDI-X/crossover; Uplink: MDI-II/straight)
- LanX16: sixteen 10/100 BT Ethernet ports (ports 1 to 15: MDI-X/crossover; Uplink: MDI-II/straight)

Plug-in to BACKX board

OBC

Converter

KS8998 KS8998
Ed. 04 1/4Réf. 3EH 21000 BSAA
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OUTPUT PORTS (BOARD STIFFENER)

Each category-5 RJ45 connector has 2 green LEDs:

- LED A = link status and activity: 
• off: link disconnected
• on: link connected
- blinking: link active

- LED B = full duplex/collision:
• off: Half Duplex
• on: Full Duplex
- blinking: collision

RJ45 pin 1 2 3 4 5 6 7 8

Port outputs (ports 
1 to 15)

RX+ RX- TX+ TX-

Up-Link output TX+ TX- RX+ RX-

9 10 11 12 13 14 15 UP-LINK

ETHERNET LANSWITCH

1 2 3 4 5 6 7 8

LANX16

5 6 7 UP-LINK

ETHERNET LANSWITCH

1 2 3 4

LANX8

12345678

Female RJ45, front

Led A Led B
Ed. 042/4 Réf. 3EH 21000 BSAA
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CONFIGURATION EXAMPLE

PROCESSING UNIT

SWITCH

Alcatel

Port 1

Port 2

Port 3

Port 4

Up-Link

ETHERNET LANSWITCH

Server 1

Server 2

Ethernet 10/100 Mbits

Ethernet 10/100 Mbits

Ethernet 10/100 Mbits

Ethernet 10/100 Mbits

Ethernet 10/100 Mbits

Host 1

Host 2

Host 3

LANX8
CPU
Ed. 04 3/4Réf. 3EH 21000 BSAA
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MAIN POWER SUPPLIES
POWER SUPPLY PS1

Power supply PS1 provides the different voltages required to operate a Rack 1 module and also acts 
as a backplane board (slots 1, 2 and CPU).

12V CPU fuse
(1A fast-acting)

Power supply connectors
for fans

LI
VE

N
EU

TR
A

L -BAT (black)

+BAT (red)

EA
RT

H
SLOT 1

SLOT 2

SLOT CPU

Battery connection 

F6.3AL/250V battery fuse
(6.3A fast-acting, low breaking 
capacity)

Mains filter
connection
Ed. 04 1/6Réf. 3EH 21000 BSAA
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POWER SUPPLY PS2

Power supply PS2, which provides the different voltages required to operate a Rack 2 module, compri-
ses 2 boards:

- PCH2 :charger board
- PCO2 :converter board

PCH2 Board

PCO2 Board

SWT
GND

POWER-V12DC

LI
VE

N
EU

TR
AL

PO
W

ER
-V

12
D

C
G

N
D

SW
T

1

3

-BAT (black)

+BAT (red)

Battery
connexion

Connection with
PCH2 board

Battery fuse F10AL/250V
(10 A fast-acting,
low breaking capacity)

Connection with
PCO2 board

Plug-in connectors
on BACK2*

12V fuse for CPU 
(1A fast-acting) 

Fan power supply connectors

Mains power connexion

110V/230V selection: 
-jumpers in 1-2: 110 V 
-jumpers in 2-3: 230 V
Ed. 042/6 Réf. 3EH 21000 BSAA
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POWER SUPPLY PS3

Power supply PS3, which provides the different voltages required to operate a Rack 3 module, compri-
ses 2 boards:

- PCH3 :charger board
- PCO3 :Converter board

PCH3 board

PCO3 board

SWT
GND

POWER-V40DCN

Battery fuse F6.3AL/250V
(6.3 A fast-acting,
low breaking capacity)

Plug-in connectors
on BACK3

Fan power supply connectors

Mains power connexion

LI
VE

N
EU

TR
AL

PO
W

ER
-V

40
D

C
N

G
N

D
SW

T

Connection with
PCH3 board

Battery
connexion

Connection with
PCO3 board

1

3
1

3

110V/230V selection: 
-2 jumpers in 1-2: 230 V 
-2 jumpers in 2-3: 110 V

-BAT (black)

+BAT (red)

12V fuse for CPU 
(1A fast-acting) 
Ed. 04 3/6Réf. 3EH 21000 BSAA
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BATTERIES

Equipment:

- Rack 1: 1 battery
- Rack 2: 2 batteries mounted in parallel
- Rack 3: 3 batteries mounted in series

Battery characteristics:

- sealed lead battery
- 1.2 Ah / 12 V
- fire resistance better than or equal to UL94-V2

Maintenance

To guarantee system shutdown without data loss in the event of a mains power failure or the mains 
plug is unplugged at the wall socket, replace the batteries every two years. This maintenance operation 
is vital to guarantee sufficient power autonomy to allow the files to be saved before the system shuts 
down.

In the case of only voice module, (without Hard Disk or CoCPU board), the autonomy time is equal to 
20 minutes.
Ed. 044/6 Réf. 3EH 21000 BSAA
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UPS (Uninterruptible Power Source)

A Pulsar ellipse UPS (Uninterruptible Power Source) increases the backup time generally provided by 
the system batteries.A maximum of 2 Alcatel OmniPCX modules can be connected to a UPS.

Cable provided with UPS

To mains
power UPS

Mains power cable provided with
system (country-specific)
Ed. 04 5/6Réf. 3EH 21000 BSAA
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Equipment:

The following table indicates the UPS models to use with each Alcatel OmniPCX Office system for a 
power autonomy of about 1 hour (40 minutes for the XL model used with a standard configuration).

Choice of UPS 

The following table indicates for each Alcatel OmniPCX system (in extreme configurations)the con-
sumption that s used to choose a UPS from the various models offered by UPS manufacturers.

System UPS

Alcatel OmniPCX model S Pulsar ellipse 300

Alcatel OmniPCX model M Pulsar ellipse 650S

Alcatel OmniPCX model L Pulsar ellipse 1200S

Alcatel OmniPCX model XL Pulsar ellipse 1200S

System Configuration Primary consumption

Alcatel OmniPCX model S 24 terminals 50 W

12 terminals + 1 CoCPU board 55 W

Alcatel OmniPCX model M 48 terminals 70 W

48 terminals + 1 CoCPU board 85 W

Alcatel OmniPCX model L 96 terminals 105 W

96 terminals + 1 CoCPU board 120 W

Alcatel OmniPCX model XL 192 terminals 210 W

192 terminals + 2 CoCPU boards 230 W
Ed. 046/6 Réf. 3EH 21000 BSAA
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MULTI-REFLEXES 4099 HUB FILE 2

 DECT 4070 IO/EO BASE STATIONS FILE 3

 MOBILE REFLEXES 100/200 HANDSETS FILE 4

FAST IP REFLEXES TERMINALS FILE 5

 PIMPHONY REFLEXES WORKSTATIONS FILE 6

VBTEL VISUALLY IMPAIRED OPERATOR STATION FILE 7

EARLIER GENERATION SETS FILE 8
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 ALCATEL REFLEXES 3G TERMINALS FILE 1

 DECT 4070 IO/EO BASE STATIONS FILE 3

 MOBILE REFLEXES 100/200 HANDSETS FILE 4

 PIMPHONY REFLEXES WORKSTATIONS FILE 6

EARLIER GENERATION SETS FILE 8

FAST IP REFLEXES TERMINALS FILE 5

MULTI-REFLEXES 4099 HUB FILE 2

VBTEL VISUALLY IMPAIRED OPERATOR STATION FILE 7
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 ALCATEL REFLEXES 3G TERMINALS
TERMINAL FEATURES

FEATURE DEDICATED DIGITAL SETS

FIRST EASY PREMIUM ADVANCED

Handset YES YES YES YES

Loudspeaker - YES YES YES

Buzzer YES - - -

1 x 20 character display - YES YES -

2 x 40 character display - - - YES

Pictograms associated with programma-
ble keys

- - 12 24

Soft keys - - - 5

Programmable keys 8 8 12 24

Fixed function keys - 5 10 7

Navigator - - - YES

Numerical keypad keys 12 12 12 12

Green LED YES YES - -

Two-colored LED - - YES YES

Internal alphabetical keyboard - - YES YES

4090M or 4090L add-on module - - Optional Optional

Optional modules (plugware) External External Internal/ex-
ternal

Internal/ex-
ternal

Wall mounting Integrated Integrated Optional Optional

4097 CBL UA/DECT adapter - - Optional Optional
Ed. 04 1/8Réf. 3EH 21000 BSAA
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Station 4004/FIRST Station 4010/EASY Station 4020/PREMIUM Station 4035/ADVANCED
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 4097 CBL ADAPTER

Alcatel Advanced sets can be equipped with a 4097 CBL UA/DECT adapter and can therefore com-
municate with the system over a DECT radio link. This device means you no longer have to worry about 
cabling constraints. An RS232 link is also advisable for CTI applications.

The Advanced set and its adapter are jointly called Advanced DECT/4036.

The 4097 CBL adapter is powered by a 220V AC/42V DC mains adapter. This mains adapter is also 
a power splitter. The base of the power socket must be positioned as close to the adapter as possible, 
and must also be easily accessible.

Notas : This adapter can also be used with an Alcatel Premium set (internal installation) or First or 
Easy sets (external installation).

Connection

UA Exit

CTI 
Port

External 
power supply

Adaptor

UA link
CTI

Radio UA

(15m max)

(3m max)
Alcatel 

OmniPCX

DECT link

BS

DC

4020 or 4035 station
Ed. 04 3/8Réf. 3EH 21000 BSAA
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OPTIONAL MODULES (PLUGWARE)

The optional modules are modules which are inserted in the UA link, in series, between a PABX and a 
dedicated UA set. They provide an interface for connecting terminals to the system.

Notas : The optional modules can also be used with Reflexes2G sets (the previous generation).

Alcatel Premium and Advanced sets have a slot under the panel for the optional module.

The optional modules available are:

- 4093 ASY-CTI
- 4094 ISW
- 4095 AP

Notas : When the option is used in stand-alone as a TA (Terminal Adapter) interface, you have to 
move the red jumper to the other connector position inside the module.

UA

Optional
Module

Alcatel UA3G station

UA Link UA Link

Optional port

Alcatel
OmniPCX

Optional
module

UA Link

Optional port

UA

4020 or 4035 station

Alcatel 
OmniPCX
Ed. 044/8 Réf. 3EH 21000 BSAA
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 4093 ASY-CTI module

This module allows the device to be connected to the system via a UA link, a PC-type peripheral device 
by means of an RS232 link (CTI port) and an DTE data terminal (V24 port).

CTI Port

The RS232 link carries the signaling (up to 9600 bit/s) and allows telephony functions such as call ma-
nagement and call supervision.
The audio function is performed by the associated dedicated set.

V24 Port

The V24 port is regarded as a DCE and supports asynchronous V24 transmission up to 19200 bps 
(ECMA 102) and 57600 bps (V14e). The electrical interface conforms to ITTCC recommendation V28. 
This port is used to connect up the metering data management system (connection cable provided).

Connection

UA 
Entry

UA Exit

CTI 
Port

V24 Port 

V24-CTI Module

40XX station

UA Link UA Link
CTI

UA UA

(15m max)

(3m max)

V24

up to 19,2 kbit/s (15m max)
and 57,6 kbit/s (2m max)

DCE

DTE

Alcatel
OmniPCX 
Ed. 04 5/8Réf. 3EH 21000 BSAA
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 4094 ISW module

This module connects an S0 terminal to the system via a UA link.

This optional module provides an S0 power bus which requires an external power supply (230V AC/
42V DC adapter), allowing terminals without their own power supply (ISDN terminals, etc.) to be con-
nected to the bus.
The mains supply transformer serves as a sectioning mechanism for the S0 interface. It must therefore 
remain easily accessible.

The S0 bus can be a point to point or short passive bus covering 150 m (up to 5 terminals, of which a 
maximum of 2 may be powered remotely). Operation is not guaranteed in the event of a power outa-
ge.

Connection

UA Entry

UA Exit

S0 
Port

External 
power
supply

S0 Module

40XX station

UA Link UA Link
S0 DC

UA UA
(3m max)

S0 station

ISDN Terminal

S0 Bus

Alcatel
OmniPCX

150 m 
Ed. 046/8 Réf. 3EH 21000 BSAA
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 4095 AP module 

This interface connects an analog peripheral such as a modem, teletext or answering machine to the 
system via a UA link.

The optional module supplies the terminal (DTMF signaling, ringer) and therefore requires an external 
power supply (230V AC/30V DC mains adapter).
The mains supply transformer serves as a sectioning mechanism for the AP interface. It must therefore 
remain easily accessible. Operation is not guaranteed in the event of a power outage.

Connection

UA Entry

UA Exit

AP 
Port

External 
power supply

AP Module

40XX Station

UA Link UA Link
AP DC

UA UA

(100m max)

(3m max)
Alcatel 

OmniPCX
Ed. 04 7/8Réf. 3EH 21000 BSAA
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MULTI-REFLEXES 4099 HUB
Multi-Reflexes option 4099 connects up 3 Alcatel Reflexes terminals using just one UA system link; this 
option makes it easier to install additional Reflexes terminals.

Option 4099 separates out the 3 B-channels of the UA interface into 3 terminal interfaces.

UA/PBXUA/Reflexes 3UA/Reflexes 2UA/Reflexes 1

UA

LED

3

2

UA link

Station interfaces

Reflexes 1

Option 4099

Reflexes 2

Reflexes 3
Ed. 04 1/2Réf. 3EH 21000 BSAA
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The following terminals can be connected to option 4099:

- Alcatel Reflexes 2G sets with or without add-on modules (a maximum of 3 modules per option
4099).

- Alcatel Reflexes 3G sets with or without add-on modules or the 4091 CTI option (the 2 sub-groups
are mutually exclusive).

- a 4088 adapter with a V24 4083 ASM board.

The following terminals cannot be connected to option 4099:

- DECT 4070 IO/EO base stations
- Alcatel Reflexes 2G sets with options 4084 IS/ISW or 4085 AB and
- Alcatel Reflexes 3G sets with options 4093 ASY-CTI, 4094 ISW, 4094 ISW-CTI or 4095 AP.

Maximum distances from system to set

- 0.4-mm cable: 325 m
- 0.5-mm cable: 500 m
- 0.6-mm cable: 730 m
Ed. 042/2 Réf. 3EH 21000 BSAA



3

DECT 4070 IO/EO BASE STATIONSTERMINALS

 

File
 DECT 4070 IO/EO BASE STATIONS
The DECT 4070 IO/EO (internal/external) base station can be connected to:

- 1 UA interface: 3 DECT channels
- 2 UA interfaces: 6 DECT channels

Maximum connection distances with remote power supply:

- 600 m with SYT 0.5 mm cable
- 850 m with LY278 0.6 mm cable

Local power supply

LED indicating 
operational state

Screw terminal block

Push button for 

Screw for locking 
cover

Impenetrable
plastic

Antennae

Case

4070 IO 4070 EO

opening cover
Ed. 04 1/2Réf. 3EH 21000 BSAA
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Local power supply

It is possible to connect a local power supply (230V/42V – 150 mA adapter) to an accessible socket 
on the lower part of the 4070 IO/EO base.

The local power supply is used in the following cases: 

- main power supply not authorized on the line's wires (depending on specific installation require-
ments)

- to increase the cable length between the interface and the station
- reduction in the system's electrical consumption.

When the external power supply is connected, the base passes automatically to local power supply mo-
de. In the event of a power cut, the base is not supplied.

States of the correct operation LED

State of the base station State of the LED

No power supply (local or remote) or fault on base Off

Fault after auto-test, base not operational On

Auto-test OK, base station operational. Normal operation for 
a base with 2 links.

1s on / 1 s off

Auto-test OK, base station operational. Normal operation for 
a base with one Master link only.

1s on / 200 ms off

Master link not connected, local power supply or slave link 
connected.

50 ms on / 50 ms off
Ed. 042/2 Réf. 3EH 21000 BSAA
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 MOBILE REFLEXES 100/200 
HANDSETS
FEATURE Mobile Reflexes 100 Mobile Reflexes 200/
200 Ex

Graphic matrix display: 96 x 48 pixels YES YES

Backlighting NO YES

Vibrator NO YES (except Mobile 
Reflexes 200 Ex)

Navigator YES YES

Headset socket YES YES

Loudspeaker YES YES

Belt clip YES YES

Color Dark green Aluminum

Battery pack Ni-MH Li-Ion
Ed. 04 1/4Réf. 3EH 21000 BSAA
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CHARGERS

Mobile Reflexes handsets are listed separately from the various battery charging devices available. The 
charger must therefore be ordered separately and selected from the models on offer, all of which are 
compatible with the Ni-MH or Li-Ion batteries used in Mobile Reflexes handsets. The Mobile Reflexes 
200 Ex handset does not support battery charging and therefore has to be used in conjunction with a 
"Dual-desktop " charger (for recharging the battery outside the handset). 

Whichever charger is used, the maximum charge time (battery connected to mobile) is identical: Mo-
bile Reflexes 100: 5 hrs; Mobile Reflexes 200/200 Ex: 3 hrs.

The "Corded" charger:

- the simplest model: calls can be made while the handset is on charge
- consists of a cable with a connector at one end and an AC/DC mains

adapter at the other.

The "Basic Desktop" charger:

- a simple model that acts as a base for the handset
- consists of a base unit with a built-in power supply cable terminated by

an AC/DC mains adapter.

The "Dual Desktop" charger:

- simultaneously recharges the handset battery and one other battery
- the charger comprises:

• a base unit with two slots (for the handset and additional battery) and
a battery charge indication light

- a removable power cable with AC/DC mains adapter.

Note: the max. charge time in the battery-only slot is 2h30.

The "Voice Desktop" charger:

- simultaneous battery charging and high quality hands-free communica-
tion functions

- the charger comprises:
• a one-slot support base with integrated loudspeaker and micropho-

ne, two volume adjustment buttons (+/-) and a call monitoring indi-
cator (on line, mute)

- a removable power cable with AC/DC mains adapter.
Ed. 04 3/4Réf. 3EH 21000 BSAA
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FAST IP REFLEXES TERMINALS
Fast IP Reflexes terminals are Reflexes sets with a 4098 FRE ("IP Enabler") module. There are two mo-
dels:

- Fast IP Advanced Reflexes / 4037F

- Fast IP Premium Reflexes / 4022F

Characteristics

- The IP Enabler is connected to the LAN via an RJ45 connector (10 Mbps Ethernet link for IP Enabler
V1.0 and 10/100 Mbps for IP Enabler V1.5).

- The module is initialized in dynamic (DHCP) or static IP address mode by downloading the binary
into the IP Enabler from the master VoIP CoCPU board, which is treated as a TFTP server.

- The IP Enabler is then recognized by the PABX as a Reflexes terminal in its own right. Voice and
signal data are encapsulated in UDP packets, enabling the "e-Reflexes" terminal to communicate
with any other type of terminal: Reflexes, DECT handsets, analog sets, other e-Reflexes, H.323 ter-
minals or gateways (e.g. PC NetMeeting), PIMphony IP Edition, networks, etc.

PC LAN
PC LAN CPU

UA

LAN

IP ENABLER
4098 FRE

Mains power
Ed. 04 1/2Réf. 3EH 21000 BSAA
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 4098 FRE MODULE (IP Enabler)

The switch can be used to reset the module with the previous software version (only possible in boot 
phase).

Function of the LEDs

- PC: green LED on steady when the PC link is active; orange LED lit if 100 BT, off if 10 BT.
- LAN: green LED on steady when the LAN link is active; orange LED lit if 100 BT, off if 10 BT.
- CPU: green LED blinking slowly when the module is active; on steady during the initialization pha-

se; blinking rapidly when downloading new software.

Connection

Configuring the module

See the "Voice over IP" section for more details.

PC LAN CPU

PC connection

UA output 
(to station) 

External power supply
LAN connection

Leds Switch

PC DC

LAN UA

( 15m )max 

LAN

FRE Module 
40XX station

LAN link UA link

(max 800m)(50m in 100 BT,
100m in 10 BT)
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 PIMPHONY REFLEXES 
WORKSTATIONS
The standard Alcatel OmniPCX Office offering includes an integrated CTI server (TAPI 2.0) that opens 
up a broad range of third party CTI applications. 

PIMphony Reflexes is a PC-based workstation equipped with the following PIMphony applications:

- PIMphony Basic
- PIMphony Pro
- PIMphony Team

They are installed from the CD-ROM provided in each system. PIMphony does not require a software 
key.

These applications can be used from an IP Comfort handset.

Connecting the Comfort handset

To connect the Comfort handset you need a full duplex sound card.

This handset system uses the loudspeaker and external mike for hands-free operation.
The handset also supports automatic on-hook and off-hook detection via the COM port. This system 
requires a power supply, conveyed via the keyboard or mouse PS/2 connection.

External mike

IP handset

Keyboard or mouse: PS/2 socket

To keyboard or mouse 
socket (PS/2) on PC  

9-point COM port

Socket for external LS

Connection to LS socket on PC

To mike socket 
on PC 
Ed. 04 1/2Réf. 3EH 21000 BSAA
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VBTEL VISUALLY IMPAIRED OPERATOR 
STATION
The VBTEL terminal is designed to act as a display for visually impaired operators, conveying the in-
formation presented on Reflexes terminals. There are 2 models:

- VBTEL 20: equipped with a piezoelectric Braille touchpad with 20 characters and 32 command
keys. 

- VBTEL 40: equipped with a piezoelectric Braille touchpad with 40 characters and 32 command
keys.

The information read in Braille on the terminal enables the operator to use the system entirely via a 
Reflexes terminal; all the operations (dialing, transfers, line seizures, etc.) are performed from the Re-
flexes terminal.

Description

The on button is located at the top left of the terminal.

The groups of 12 keys on the right and left side of the terminal make up the command keyboard; the 
keys are designated by a row letter and a column number (columns 4 and 5 are not used).

The Braille keyboard, in the center, consists of 8 keys, of which the first 6 are the 6 Braille points in 

A1 A2 A3

B1 B2 B3

C1 C2 C3

D1 D2 D3

A6 A7 A8

B6 B7 B8

C6 C7 C8

D6 D7 D8

3 2 1 4 5 6

7 8

Power supply
Reflexes station
Ed. 04 1/2Réf. 3EH 21000 BSAA
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Perkins alphabetical order, the 2 others being the backspace (7) and space keys (8).

A set of 20 or 40 piezoelectric cells located above the Braille keyboard enables Braille characters to 
be displayed. Each cell contains 8 points: points 1 to 6 serve to form the 64 characters of the Braille 
alphabet; when points 7 and 8 are raised simultaneously, they represent the cursor.
Ed. 042/2 Réf. 3EH 21000 BSAA
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EARLIER GENERATION SETS
TERMINALS NOT SUPPORTED

The following terminals are not supported by Alcatel OmniPCX Office:

- Reflexes 1G sets
- DECT 4075, 4074B, 4074H and 4074 BEx mobile sets
- Alcatel 160 sets
- Alcatel 4120 sets (900A and 900B)

 REFLEXES 2G 40XX* SETS

Reflexes terminals from the 2G range are supported by Alcatel OmniPCX Office for migration purpo-
ses.

*Depending on country/distribution network

FEATURE Characteristics

4003 4011 4012 4023 4034

Handset YES YES YES YES YES

Loudspeaker YES YES YES YES YES

Display - 1 x 20 1 x 20 2 x 20 2 x 40

Pictograms - 2 x 7 2 x 10 4 x 7 4 x 7

Soft keys and arrows - - - 3 + 1 10 + 1

Programmable keys 5 6 10 18 18

Fixed function keys 3 10 12 12 12

Numerical keypad keys 12 12 12 12 12

3-coloured LED - YES YES YES YES

4087 IFA internal alphabetical keyboard - - - YES YES

4087 EFA external alphabetical key-
board

- - Optional Optional Optional

Interface: 4083 ASM or 4083 PCT, 
4084 IS/ISW or 4085 AB

- - Optional - Optional

4081L or 4081 M add-on module - - Optional Optional Optional

Wall mounting Optional - - - -
Ed. 04 1/14Réf. 3EH 21000 BSAA
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Station 4011 Station 4012

Station 4023

      

Station 4034

Station 4003
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MOUNTING THE ADD-ON MODULES

A kit (a 10-cm cable with two 8-pin modular jacks) connects the 4081M or 4081L add-on modules to 
4012, 4023 and 4034 sets (there is no limit on the number of add-on modules in the system).

Procedure

- Turn the set and the module upside down
- Connect the cable to the set and the module
- Join the module to the set using the 2 screws provided in the kit

The same method is used to connect the 2 modules to each other.

CONNECTING UP AN EXTERNAL BELL

It is possible to connect, on the wall-mounted socket, an external call reinforcing bell to 4011, 4012, 
4023 and 4034 sets.

The standard connecting cable is 3 m long and has 2 conductors. To connect an external bell, replace 
this cable with an optional cable, 5 m long and with 4 conductors.

Available power: 2 mA under 5V (an adapter is therefore necessary).

To the 
other add-
on module

Station

FeetFixing screw

4081M 4081L

Female outlet
(view from underneath the set) 

1 : not used
2 : external bell (positive pole)
3 : telephone line
4 : telephone line
5 : external bell (negative pole)
6 : not used

4
6 1

35 2

IL+

IL-

1

3

5

2

4

6

Wall-mounted socket

AP -

AP +

Power supply

ADAPTER
Ed. 04 3/14Réf. 3EH 21000 BSAA
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CONNECTING THE 4088 ADAPTER 

The 4088 adapter is connected directly to an Alcatel UA set interface and enables the installation of 
an optional 4083 ASM, 4083 PCT, 4084 IS/ISW or 4085 AB board.

Link with UAI
Modular-jack

Interface connectors

Output pins of the 6-pin Modular jack for connection to UAI :

1 -not used
2 -not used
3 - IL+
4 - IL-
5 - not used
6 - not used
Ed. 044/14 Réf. 3EH 21000 BSAA
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REFLEXES 2G 50XX * SETS

Reflexes terminals from the 2G range are supported by Alcatel OmniPCX Office for migration purpo-
ses.

*Depending on country/distribution network

FEATURE Characteristics

5010 5015 5018 5022 5028

Handset YES YES YES YES YES

Loudspeaker YES YES YES YES YES

Display - - 1 x 20 1 x 20 2 x 40

Pictograms - 2 x 10 2 x 10 2 x 10 4 x 7

Soft keys and arrows - - - - 10 + 1

Programmable keys 5 10 10 10 18

Fixed function keys 5 12 12 12 12

Numeric keypad keys 12 12 12 12 12

LED YES YES YES YES YES

Internal alphabetical keyboard - - - - YES

External alphabetical keyboard - - Optional - Optional

V24/MAC PC 5083, S0 (2B + D) 
5081/5082 or Z 5088 interface

- - Optional - Optional

40-key add-on module - - Optional - Optional
Ed. 04 5/14Réf. 3EH 21000 BSAA
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STATION 5010 STATION 5018STATION 5015

STATION 5028STATION 5022
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OPTIONS FOR UA 2G SETS

4012, 4034, 5022 and 5028 sets on the Alcatel OmniPCX system can take an optional interface that 
plugs into the rear of the set:

- 4083 (or 5083) ASM: V24 - MAC/PC option
- 4083 PCT: PC option
- 4084 (or 5081/5082) IS/ISW: S0 - MAC/PC option 

S0 (2 B channels and 1 D channel) is available via a 4084 IS/ISW option installed on a 40XX set 
which is connected to a DLC16 board (16, 8 or 4 devices).
S0* (1 B channel and 1 D channel) is available via a 4084 IS/ISW option installed on a 40XX set 
which is connected to a DLC4/8 board with an S01B daughter board.

- 4085 (or 5088) AB: Z option

Connecting V24 and MAC/PC terminals

V24 terminals are connected using the X201 connector of board 4083 ASM installed in the set.

MAC/PC terminals are connected using connectors X401, X402 and X403 of boards 4083 ASM and 
4084 IS.

Maximum distances between terminal and set:15m at 19200 bps
2 m at 57600 bps

Function Circuit Signal

Protection ground 101 PG

Transmitting data 103 TD

Receiving data 104 RD

Request to send 105 RTS

Clear to send 106 CTS

Data set ready 107 DSR

Signaling ground 102 SG

Carrier detection 109 DCD

Local loop 141 LL

Data terminal ready 108/1, 2 DTR

Call indicator 125 RI

Test indicator 142 TI

X201 X401 X403 X402

Micro
processor

Micro
processor

REPROM REPROM

U103 U403

U101 U401

4083 ASM

Female outlet
(view from the bottom of the station)

DSR

CTS

RT
S

RD

TD

PG

TI RI DTR LL

13

25

1

14

DCD

SG

X201 : V24 output 25-pin SUB D female connector
Ed. 04 7/14Réf. 3EH 21000 BSAA
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X401: 8 pin female connector for PCs

X402, X403: 4 pin female connector for Macs

The maximum length of the ADB link is 5 m.

These two connectors enable the terminal and keypad to be connected up separately.

Connecting S0 terminals

Options 4084ISW and 4084 IS enable the connection of S0 terminals supplied remotely or otherwise.

The terminals are connected using the 8 pin connector (X301) of boards 4084 IS and 4084 ISW. The 
type of bus is specified by the positioning of the X102 connector jumpers. X302 defines the termination 
resistance of the 2 connection pairs.

X104: connector for the power supply

- 1: - 48 V - 2: + 48V

Female outlet
(view from the bottom of the station

7 (not used)

6 (not used)8 (not used)

4 : 
PCSG

1 : PCRTS2 : PCCTS

3 : PCTD5 : 
PCRD

Pin Signal Function Circuit

1

2

3

4

5

6

7

8

PCRTS

PCCTS

PCTD

PCSG

PCRD

Request to send

Data transmission

Signalling ground

Data reception

105

106

103

102

104

Clear to send

X301 X401 X403 X402

Micro
processor

Micro
processor

REPROM REPROM

U102 U402

U101 U401

U301

ISAC-S

1

3

X302

B
A

1
X102

X301 X104

Micro
processor

REPROM

U102

U101

U301

ISAC-S

1

3

X302

B
A

1
X102

U105 U406

4084 IS

4084 ISW

Jack for connecting the power
1313 supply

To transformer
socket unit
Ed. 048/14 Réf. 3EH 21000 BSAA
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X301: connector for the S0 bus

- 1 and 2 - not used - 5 - TX -
- 3 - RX + - 6 - RX -
- 4 - TX + - 7 and 8 - not used

Short passive bus Long point-to-point bus (X102 across 1-2) (X102 
across 2-3)

Short point-to-point bus           Extended bus (X102 across 1-2) (X102 across 2-3)

R

150 m
X302

150 m

R

X302

100 Ω
100Ω

100 Ω

100 Ω

3 m

R

X302

3 m
1

R

R

X302

15
0 

m50 Ω

50 Ω
100Ω

100Ω
Ed. 04 9/14Réf. 3EH 21000 BSAA
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Connecting analog terminals

The Z station interface is of type TNV (Telecommunication Network Voltage) with mains supply. The 
connection distance of an analog terminal to this interface is limited to 20 meters.

The user of a set connected to this interface has the same operation possibilities as a user using a 
classic Z interface (restriction: the set's Message LED cannot be used).

X101: 8 pin modular jack for connection to the analog terminal
- 1: GND - 5: L2 line wire
- 2: not used - 6: not used
- 3: not used - 7: not used
- 4: L1 line wire - 8: not used

X102: connector for the power supply

- 1: - 48 V - 2: + 48V

Various terminal cables

The cables below can be used for connecting terminals to UA sets (references 3AK..... represent the 
group of 5 cables described in the table).

CABLE CONNECTORS REFERENCE LENGTH

S0 8 pin modular jack - 8 pin modular jack 1AB 04521 0024 3 m

V24 DCE 25 pin SUBD male - 25 pin SUBD female 1AB 05412 0016 2 m

V24 DTE 25 pin SUBD male - 25 pin SUBD male 1AB 05412 0018 2 m

PC 8 pin mini din male - 9 pin SUBD female 1AB 07871 0003 2 m

MAC 4 pin mini din male - 4 pin mini din male 9191500 2 m

U450

Micro-
processor

CIALA - S
U201

8-pin modular jack for
connection to the analog

Jack for connection to the power supply

TRANSFO

8 1
terminal

REPROM

To transformer socket unit

U451

U500

COFIDEC

X102
X101

T350

U502

RMF

4085 AB
Ed. 0410/14 Réf. 3EH 21000 BSAA
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DECT 4074 HANDSETS 

FEATURE DECT HANDSETS

4074 GB 4074 GH 4074GI 4074GC

Handset with adjustable volume YES YES YES YES

ON/OFF switch (or keys) YES YES YES YES

16 character display YES YES YES YES

Numeric keypad keys 12 12 12 12

Line keys 2 2 2 2

Programmable keys 2 2 2 2

Navigator keys YES YES YES YES

Headset socket -- YES YES --

Keypad backlighting -- YES YES --

Protective cover -- YES YES --

Integrated vibrator -- -- YES YES

Charger 4071BA 
4071DA

4071DA 4071 DA 4071BC

Hands free -- -- -- YES
Ed. 04 11/14Réf. 3EH 21000 BSAA
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4074 GB/GC station 4074 GH/GI station 

Fri 15 Mar     14:30 Fri 15 Mar     14:30

4071 DA charger

4071 BA charger

4071 BC charger
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 4073 GS SMART DECT HANDSET

FEATURE 4073 GS 
SMART

Handset YES

On/Off Key YES

Display: 2 x 16 alphanumeric characters + 1 line of 8 icons YES

Numeric keypad keys 12

Navigator keys YES

Function keys 8

Vibrator YES
Ed. 04 13/14Réf. 3EH 21000 BSAA
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ALCATEL OMNIPCX OFFICE
Section CALL SERVER : Telephone features

RESOURCE KEYS (ASSOCIATED OPERATING MODES) FILE 1

TRUNK GROUPS FILE 2

HUNTING GROUPS FILE 3

OPERATOR STATIONS (OPERATOR GROUPS) FILE 4

SPECIFIC OPERATOR STATION SERVICES FILE 5

LINK CATEGORIES FILE 6

BARRING FILE 7

END OF DIALING DETECTION FILE 8

SPLITTING FILE 9

CALL DISTRIBUTION (DYNAMIC ROUTING) FILE 10

NORMAL AND RESTRICTED SERVICE FILE 11

AUTOMATIC WELCOME (PRE-ANNOUNCEMENT) FILE 12

DIRECT DIALING INWARDS FILE 13

CLASS COMPATIBILITY FILE 14

ISDN SERVICES FILE 15

VN7 COMPATIBILITY FILE 16

CCBS – COMPLETION OF CALLS TO BUSY SUBSCRIBER FILE 17

SPECIFIC FEATURES OF SO STATIONS FILE 18

SPECIFIC NUMBERING PLANS FILE 19

ALTERNATIVE CLIP AND COLP NUMBERS FILE 20

BUSY GREETING ON VOICE MAILBOX FILE 21
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MAKING/ANSWERING A CALL FILE 22

PRIORITY CALLS FILE 23

CAMP-ON ON BUSY STATION OR GROUP FILE 24

ANSWERING CAMPED-ON CALLS FILE 25

THREE PARTY CALLS FILE 26

INTERCOM INTRUSION FILE 27

FORWARDING FILE 28

MANAGER/SECRETARY SCREENING FILE 29

FORWARDING TO VOICE MAIL UNIT FILE 30

REMOTE FORWARDING FILE 31

EXTERNAL FORWARDING FILE 32

PABX FORWARDING * FILE 33

AUTOMATIC CALLBACK ON BUSY TRUNK GROUP FILE 34

TRANSMISSION OF DTMF CODES (OR END-TO-END SIGNALING) FILE 35

CALL PICK-UP FILE 36

CALL PARKING/PARKED CALL RETRIEVAL FILE 37

PAGING FILE 38

MAIN PABX RECALL FILE 39

TEXT MAIL/DELAYED CALLBACK REQUEST FILE 40

STATION COMFORT FEATURES FILE 41

BACKGROUND MUSIC FILE 42

HEADSET FEATURES FILE 43

APPOINTMENT REMINDER/WAKE-UP CALL FILE 44

CALL MONITORING FILE 45
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CUSTOMIZING STATIONS FILE 46

TEAMWORK FILE 47

ACCOUNT CODE/SUBSTITUTION FILE 48

ALLOCATION OF A TRUNK LINE FILE 49

METER TOTAL RECALL FILE 50

REMOTE SUBSTITUTION FILE 51

FAX CALL ROUTING FILE 52

 FAX NOTIFICATION FILE 53

LIST OF SERVICES OFFERED FILE 54
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ALCATEL OMNIPCX OFFICE
Section CALL SERVER : Telephone features (Index)

 FAX NOTIFICATION FILE 53

ACCOUNT CODE/SUBSTITUTION FILE 48

ALLOCATION OF A TRUNK LINE FILE 49

ALTERNATIVE CLIP AND COLP NUMBERS FILE 20

ANSWERING CAMPED-ON CALLS FILE 25

APPOINTMENT REMINDER/WAKE-UP CALL FILE 44

AUTOMATIC CALLBACK ON BUSY TRUNK GROUP FILE 34

AUTOMATIC WELCOME (PRE-ANNOUNCEMENT) FILE 12

BACKGROUND MUSIC FILE 42

BARRING FILE 7

BUSY GREETING ON VOICE MAILBOX FILE 21

CALL DISTRIBUTION (DYNAMIC ROUTING) FILE 10

CALL MONITORING FILE 45

CALL PARKING/PARKED CALL RETRIEVAL FILE 37

CALL PICK-UP FILE 36

CAMP-ON ON BUSY STATION OR GROUP FILE 24

CCBS – COMPLETION OF CALLS TO BUSY SUBSCRIBER FILE 17

CLASS COMPATIBILITY FILE 14

CUSTOMIZING STATIONS FILE 46

DIRECT DIALING INWARDS FILE 13

END OF DIALING DETECTION FILE 8
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ALCATEL OMNIPCX OFFICE
EXTERNAL FORWARDING FILE 32

FAX CALL ROUTING FILE 52

FORWARDING FILE 28

FORWARDING TO VOICE MAIL UNIT FILE 30

HEADSET FEATURES FILE 43

HUNTING GROUPS FILE 3

INTERCOM INTRUSION FILE 27

ISDN SERVICES FILE 15

LINK CATEGORIES FILE 6

LIST OF SERVICES OFFERED FILE 54

MAIN PABX RECALL FILE 39

MAKING/ANSWERING A CALL FILE 22

MANAGER/SECRETARY SCREENING FILE 29

METER TOTAL RECALL FILE 50

NORMAL AND RESTRICTED SERVICE FILE 11

OPERATOR STATIONS (OPERATOR GROUPS) FILE 4

PABX FORWARDING * FILE 33

PAGING FILE 38

PRIORITY CALLS FILE 23

REMOTE FORWARDING FILE 31

REMOTE SUBSTITUTION FILE 51

RESOURCE KEYS (ASSOCIATED OPERATING MODES) FILE 1

SPECIFIC FEATURES OF SO STATIONS FILE 18

SPECIFIC NUMBERING PLANS FILE 19
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RESOURCE KEYS (ASSOCIATED 
OPERATING MODES)
DESCRIPTION

A resource key is used to take a line in order to make or receive a call.

When a station has at least two resource keys, it is said to be multiline. In this mode, the user presses 
the resource key associated with the correspondent he wants to contact (using the shuttle call function, 
for example). Multiline stations can also operate in Key system or PABX mode.
A station which does not have resource keys is said to be monoline. These resources (3) are "virtual". 
In this mode, the user enters a code programmed in the "Features in Conversation" table, to activate 
a function such as a shuttle call.

Characteristics of the different modes:

(*) n = number of analog lines and B channels (within the station key limit).

(**) see explanation overleaf.

CONFIGURATION

Programming the resource keys on each station:

Programming the monoline, multiline, "key system" or "PABX" mode:

Type of subscriber Normal

Mode Monoline Key system PABX

Default resource keys 3 "virtual" resource keys 2 RGMints (**)

n (*) RSPs (**)

2 RGMints (**)

2 RSBs (**)

Simultaneous mana-
gement

1 conversation

1 hold
1 camp-on

1 conversation

(n+1) holds + camp-
ons

1 conversation

3 holds + camp-ons

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys.

- by MMC-Station: Subscr -> Keys.
Ed. 04 1/6Réf. 3EH 21000 BSAA
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- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Profiles.

- by MMC-PM5 (Easy view): Subscriber profiles
- by MMC-Station: TerPro.
Ed. 042/6 Réf. 3EH 21000 BSAA
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Authorize or cancel selection of an RSB if the external call arrives on a line which does not belong
to the trunk programmed for this key:

ACTIVATION/USE

Incoming, the system uses the resource keys in the following order of priority:

(*) Default operation (see section: "Configuration")

Outgoing, a call can be made:

- without pressing a resource key (the system selects the most appropriate key as soon as the user
dials)

- by pressing a resource key (before dialing the number), whether:
• for an external outgoing call:
• an RSD (dedicated to a trunk or an "Automatic Route Selection")
• an RSB (dedicated to a trunk or an "Automatic Route Selection")
• an RSP (dedicated to an external interface)
• an RGO (dedicated to outgoing calls)
• an RGMint/ext (not dedicated)
• for an internal outgoing call:
• on an RSL (dedicated to a directory n°): the system automatically dials the programmed number
• an RGMint (dedicated to internal calls)
• an RGO (dedicated to outgoing calls)
- an RGMint/ext (not dedicated)

Notas : The MMC-Station labels RGI, RGO and RGM (MMC station) are equivalent to RGX in MMC-
PM5 (+ definition of "Call Sense" field).

- by MMC-PM5 (Expert View):
System Miscellaneous -> Memory Read/Write -> Misc. Labels -> SelRSBsig.

- by MMC-Station: Global -> Rd/Wr -> Address s -> "SelRSBsig" -> Return -> Memory

-   Incoming call
(external)

RSP :   Resource dedicated to an external interface

RSD :   Resource dedicated to a directory no.

RSB :   Resource dedicated to a trunk (*)

if busy

if busy

RGMint/ext :   Resource not dedicated (internal and external calls)

if busy

-   Incoming call
(internal)

RSL :   Resource dedicated to a directory no.

RGMint :   Resource dedicated to internal calls
if busy

RGMint/ext :   Resource not dedicated (internal and external calls)
if busy
Ed. 04 3/6Réf. 3EH 21000 BSAA
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More details about the abbreviations RGM, RGO, RSL, etc. can be found in the glossary.

ADDITIONAL INFORMATION

- A resource key manages only one communication at a time.
- Z and First Reflexes stations are monoline; all other stations are multiline.
- The Reflexes 2G 4003 can be either monoline or multiline.
Ed. 044/6 Réf. 3EH 21000 BSAA
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PROFILES FOR ALCATEL REFLEXES 3G STATIONS

The first Alcatel Reflexes station (call number 100) is the Operator station; this Advanced Reflexes sta-
tion is part of all active Operator Groups as well as the default Operator Group.

The second Alcatel Reflexes station is a Secretary terminal and the third is a Manager terminal. Only 
Advanced or Premium Reflexes stations can provide the Manager/Secretary facility. 

First Reflexes station profile

First Reflexes stations operate in monoline mode.

Easy Reflexes station profile

Easy Reflexes stations cannot be used as Manager, Secretary or Operator stations.

Premium Reflexes station profiles

Key system mode 

Operator Station Manager Station Secretary Station Normal Station

Ann. 2 app.

 

 

 

 Pick-Up

Redial

DivertMail

Conference

Callback

Canc. Enquiry

Pers. SPD

 

 

 

 Transf.

Read+

Divert

Mail

Redial

Divert

Read+

Norm/Restr.

Conference

Int/Ext

Trunk 1 Trunk 2

Trunk 3 AttDiv

Trunk 4

Divert

Read+

SecMgr

Conference

Int/ext

Trunk 1 Trunk 2

Trunk 3 Secrtr.

Trunk 4

Divert

Read+

SecMgr

Conference

Int/ext Int/ext

Trunk 1 Trunk 2

Trunk 3 Patron

Trunk 4

Divert

Read+

Trunk 6

Conference

Int/ext Int/ext

Trunk 1 Trunk 2

Trunk 3 Trunk 4

Trunk 5

Redial

Int/Ext

Redial RedialRedial
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PABX mode

Differences from Key system mode:

- the first 2 line keys are replaced by "Ext. Call" (access to the public network with 9);
- the other line keys are replaced by undefined call keys; these can be programmed with an internal

destination (station) or external destination (number preceded by public network access prefix).

To program a call key (you can also use the station User Guide), proceed as follows:

- press the key .
- press the key you want to program.
- delete the old settings, if necessary, then enter the new number and validate. The station goes back

to idle.

Advanced Reflexes station profiles

Key system mode 

Operator Station Normal Station

Manager Stations Secretary Station

PABX mode

The same differences apply with regard to Key System mode as for a Premium Reflexes set.

i

Trunk 9 Trunk 10

Trunk 7

Trunk 6

Trunk 8

Int/Ext

Trunk 1 Trunk 2

Trunk 3 Trunk 4

Trunk 5

Pers. SPD Transf.

Mail ISDN

Trunk 11 Trunk 12

Trunk 13 Trunk 14

Trunk 15 AttDiv

Divert

Int/Ext

Trunk 9 Trunk 10

Trunk 7

Trunk 6

Trunk 8

Int/Ext

Trunk 1 Trunk 2

Trunk 3 Trunk 4

Trunk 5

Pers. SPD Transf.

Mail

Call

ISDN

Trunk 11 Trunk 12

Trunk 13 Trunk 14

Trunk 15 Trunk 16

Divert

Int/Ext

Trunk 9 Trunk 10

Trunk 7

Trunk 6

Trunk 8 

Int/Ext

Trunk 1 Trunk 2

Trunk 3 Trunk 4

Trunk 5

Pers. SPD Transf.

Mail

SecMgr

ISDN

Trunk 11 Trunk 12

Trunk 13 Trunk 14

Trunk 15 Secrtr

Divert

Trunk 9 Trunk 10

Trunk 7

Trunk 6

Trunk 8 

Int/Ext

Trunk 1 Trunk 2

Trunk 3 Trunk 4

Trunk 5

Pers. SPD Transf.

Mail

SecMgr

ISDN

Trunk 11 Trunk 12

Trunk 13 Trunk 14

Trunk 15 Managr.

Divert

Int/Ext
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TRUNK GROUPS
DESCRIPTION

Trunk groups are used to make calls to the network. A trunk group is made up of at least one analog 
line or B channel.

Each bundle has:

- a directory number defined in the main numbering plan
- a management type: cyclic or sequential
- barring and traffic sharing link categories (see "Link Categories")

CONFIGURATION

Configuring the trunk groups:

Defining the trunk group management type:

Modifying the default traffic sharing link categories (value 1 to 16):

Modify the "Traffic Sharing Matrix", if necessary, using MMC-PM5 (Expert View):

- by MMC-PM5 (Expert View): External Lines -> Trunk Groups -> Details
- by MMC-Station: TrGp

- by MMC-PM5 (Expert View): External Lines -> Trunk groups
- by MMC-Station: TrGp

- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Barring
- for the trunk groups: External Lines -> Trunk Groups -> Details -> Link-Cat

- by MMC-Station:
• for the users: Subscr -> BarTyp (last 2 values)
- for the trunk groups: TrGp -> Catego

System Miscellaneous -> Traffic Sharing and Barring -> Traffic Sharing Matrix
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To specify whether or not to authorize all the users to seize an analog line with predetermined rou-
ting for outgoing calls:

ACTIVATION/USE

To make a call to the network, a user can:

- dial a trunk group number
- press an RSD or RSB resource key (see "Resource keys")

If connection between the user and the trunk group is authorized (analysis of barring and traffic sha-
ring link categories: see "Link Categories" and "Barring"), the system selects a line (or channel) in the 
trunk group as follows:

(*) Priority is given to "outgoing" lines, then "mixed lines".

ADDITIONAL INFORMATION

- The maximum number of trunk groups in a system is 120.
• 1 main trunk group
- the others being secondary trunk groups

- The maximum number of lines or channels in a trunk group is 120.
- The total number of lines/channels across all the trunk groups must not exceed 500.
- The trunk group with index 120 may be reserved for Operator Groups (see "Operator stations").
- For an outgoing call, an analog line with predetermined routing (LRP) can be used either exclusively

or in priority by the destination user of this LRP.

- by MMC-PM5 (Expert View):
 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "TonPrRng"

- by MMC-Station:
 Global -> Rd/Wr -> Address -> "PRIOR_LRP" -> Return -> Memory

Management type cyclic sequential

Trunk line used in the trunk 
group

1st free line following the last se-
lected

1st free line (*), in the program-
med order
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HUNTING GROUPS
DESCRIPTION

Creating Hunting Groups makes it possible to call several stations using a single directory number; a 
single member of the group answers the call for the whole group.

Each group has:

- a directory number defined in the main numbering plan
- a parallel, cyclic or sequential management type
- an operation type, either "setup" (without supervision key, for calls destined for the group) or "si-

gnaling" (with supervision key)

CONFIGURATION

Configuring the groups:

Defining the group management type:

To select the operating mode for (hunting AND operator) groups: with or without a "Group Super-
vision" programmed key:

Programming the "group supervision" keys on each station (one for every group to which the station
belongs):

- by MMC-PM5 (Expert View): Hunting Groups
- by MMC-Station: Groups -> Subscr.

- by MMC-PM5 (Expert View): Hunting Groups
- by MMC-Station: Groups -> Subscr.

- by MMC-PM5 (Expert View):
 System Miscellaneous -> Feature Design -> Group called with signalisation mode

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys

- by MMC-Station: Subscr -> Keys
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To authorize the immediate group forwarding or withdrawal (see "Forwarding") of group calls from
the last member of a group (only with MMC-PM5 (Expert View)):

Defining the dynamic routing parameters of a group:

To authorize external calls to camp on the group, (MMC-PM5 only):

To define the response in the event of failure – MMC-PM5 (Expert View) only:

To define whether the Hunting Group is still considered free, depending on its status:

System Miscellaneous -> Feature Design ->"Disconnect Last Group Member Allowed"

- by MMC-PM5 (Expert View): Hunting Groups -> Dyn. Rout.
- by MMC-Station: Groups -> Hunt -> DynRou

- call arriving on an analog interface (TL, ATL, DDI, etc): 
 External Lines -> Protocols -> Parameters -> "Ringing Mandatory": deselect the box to
authorize holding 

- call arriving on a digital interface (T0, T2, etc) : 
 System Miscellaneous -> Feature Design -> "Call waiting/Automatic Camp-on": select
the box to authorize camp-on 

- call arriving on an analog interface (TL, ATL, DDI, etc): 
 External Lines -> Protocols -> Parameters -> from "Reaction on missing incoming digit"
to "Reaction on out of service"

- call arriving on a digital interface (T0, T2, etc): 
 External Lines -> Incoming Call Handling

- by MMC-PM5 (Expert View):
 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "BusyGrpInd"

- by MMC-Station: 
 Global -> Rd/Wr -> Address -> "BusyGrpInd" -> Return -> Memory
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ACTIVATION/USE

Depending on the management type chosen for the group, the system makes the stations ring as fol-
lows:

Management type parallel cyclic sequential

Stations rung all the free stations in the group 1st free station following the last 
selected

1st free station in the program-
ming order

For a group in SETUP mode, 
the call is camped on

on all busy stations on all the stations in the group, if all are busy

A busy station goes into idle 
status

the call with the highest priority is presented

To answer a call go off-hook or press Handsfree or the "Group Supervision" programmed key

For a group in SIGNALING 
mode, the call is camped on

if all stations are busy, on the first station in the group

NO YES

YES

YES

NO

NO

External call for a
 hunting group

Address 
“BusyGrpInd" = 1 ?

The group is treated
depending on  its status

Is the group
available?

Is hold
authorized (*) ?

Treatment of the failure
 depending on the configuration

The call is presented to the group or
camped on
If the preannouncement is not
activated, the calling party hears
the ringing tone (if it is activated,
see the corresponding file).
Dynamic routing (see file "call
distribution") is activated as well as
forwarding if present
Ed. 04 3/4Réf. 3EH 21000 BSAA



HUNTING GROUPS CALL SERVER : TELEPHONE FEATURES

 

ADDITIONAL INFORMATION

- The maximum number of groups in a system is 50 (Hunting Groups + Broadcast Groups + pickup
groups).

- The maximum number of stations in a group is 32.
- In SETUP mode and if the address "BusyGrpInd" = 1, the maximum number of calls camped onto

a Hunting Group is equal to the number of members in the group.
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OPERATOR STATIONS (OPERATOR 
GROUPS)
DESCRIPTION

An operator station basically makes it possible to distribute calls arriving on the network. Such a station 
has the following characteristics:

- camp-on always authorized
- intrusion always authorized
- access to certain programming features

Any station connected to the system can be an Operator Station, but, to have all the features of an 
operator, the station must:

- be part of an Operator Group
- have one of the "operator" profiles (see "Resource keys" and "Station profiles"):

(*) n = number of external interfaces; to monitor all the system's external interfaces, connect add-on modules to each operator station.

(**) Virtual Access Resource: used only for camped-on calls.

(***) The "overload" LED only applies to stations with a three-color LED (Reflexes range with the exception of 4003); it indicates:

-  : level 1 traffic overload (1 call camped on). 
-  : station test.
-  : level 2 traffic overload (one call camped on for at least 20 seconds, or more calls camped on than there are operators). 
-  : presence of a system message indicating a serious equipment fault or several less serious system messages.
-  : presence of a message (voice, written) or presence of a call in the non answered calls repertory.

OS groups are managed in parallel.

All Operator Groups have the same call numbers (a single Operator Group is active during any par-
ticular time range (see "Time Ranges")).

Operator profile in mode ... Key system PABX

Resource keys 2 RGMints

n RSPs (*)

2 RGMints

2 RSBs dedicated to the internal 
trunk group
1 RAV (**)

Function keys Group supervision

Normal/Restricted mode

Group supervision

Normal/Restricted mode

LED (***) Traffic overload Traffic overload
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An Operator Group can have:

- stations
- the general bell (see "Connection of a general bell")
- 1 dissuasion message (see "Automatic Welcome /Pre-announcement")

Default Operator Group

This group (index 8):

- is available no matter what the time range 
- can have up to 8 members including the general bell
- comes into service ... (see "Activation/Use")

General level

The general level is made up of:

- the Operator Group active in the applicable time range (may include the general bell)
- stations with the "General Monitoring" feature activated (see "Call Monitoring")

It is activated automatically:

- via the dynamic routing mechanism (see "Call distribution")
- via the operator recall mechanism (when a user's station in an external communication is switched

off or the activation of a service has failed)
- in accordance with the predefined settings, in the case of a misdial or when an ISDN access is com-

pletely busy.

By default, the following are programmed:

- OS groups are managed in parallel.
- Operator Groups of index 1 and 2, including the first station of the first board recognized by the

system
- the default group (index 8) including: 

• the first station of the first board recognized by the system
- the general call bell
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CONFIGURATION

Configuring the Operator Groups:

Modifying the internal call number of the Operator Groups:

Programming the external call number of the Operator Groups (N.B.: base identical to that of an
internal call number):

Programming the operator profile:

Assigning an Operator Group to each time range:

To select the management type for Operator Groups and Hunting Groups: with ("signaling" mode)
or without ("setup" mode) the "Group Supervision" programmed key:

To authorize the immediate group forwarding or withdrawal (see "Forwarding") of group calls from
the last member of a group (with MMC-PM5 only):

Defining the dynamic routing parameters (see "Call distribution") for an Operator Group:

- by MMC-PM5 (Expert View): Attendant Group List
- by MMC-Station: Groups -> OpGrp 

- by MMC-PM5 (Expert View): Numbering -> Internal Numbering Plan
- by MMC-Station: NumPln -> IntNum

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum

- by MMC-PM5 (Expert view): Subscribers/Basestations List -> Subscribers/Basestations List
-> Profiles

- by MMC-Station: TerPro -> Attend

- by MMC-PM5 (Expert view):  Time Ranges
- by MMC-Station: TimeRa

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "GrpCalWSig"

- by MMC-Station: 
 Global -> Rd/Wr -> Address -> "GrpCalWSig" -> Return -> Memory

System Miscellaneous -> Feature Design -> "Disconnect last Group Member allowed"

- by MMC-PM5 (Expert view): Attendant Group List -> Dyn. Rout.
- by MMC-Station: Groups -> AttGrp -> DynRou
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To authorize external calls arriving on an analog interface (TLC, ATL, DDI, etc) to camp on the
group (or prevent them from doing so) – MMC-PM5 (Expert View) only:

 To authorize external calls arriving on a digital interface (T0, T2, etc), to camp on the group (or
prevent them from doing so) – MMC-PM5 (Expert View) only:

To define the response in the event of failure – MMC-PM5 (Expert view) only:

External Lines -> Protocols -> Parameters -> "Ringing Mandatory":

System Miscellaneous -> Feature Design -> "Call Waiting/Automatic camp-on"

- call arriving on an analog interface (TL, ATL, DDI, etc): 
 External Lines -> Protocols -> Parameters -> from "Reaction on missing incoming digit"
to "Reaction on out of service"

- call arriving on a digital interface (T0, T2, etc):
 External Lines -> Incoming Call Handling
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ACTIVATION/USE

NO

Operator 
call

Restricted mode
activated by an

operator ?

Operator group 
active during time 

range

The free operators ring and the 
call is camped on the busy

operators

YES

If the call is external, the stations 
which have activated "general 

monitoring" will also ring

YES

NO

Is the group
available ?

If the pre-announcement is not 
activated, the calling party hears 
the ringing tone (if it is activated, 
see the corresponding field)
Dynamic routing (see the "Call 

as forwarding if present
Distribution" file) is activated 
as well

The call is released
externalIs the call 

external ?
Internal or

internal

The members
of the default

operator
group ring
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ADDITIONAL INFORMATION

- The maximum number of Operator Groups in a system: 8, default operator included.
- The maximum number of stations in an Operator Group: 8.
- Forwarding of the last member of the Operator Group (except for the default Operator Group) can

be authorized by programming.
- The destination of an immediate forwarding of Operator Group calls (see "Forwarding") does not

have the characteristics of an operator.
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SPECIFIC OPERATOR STATION 
SERVICES
DESCRIPTION

An Operator Station can:

- switch the entire installation to normal or restricted mode, independently of the time range (see
"Normal/Restricted service (system level)")

- reserve a trunk group (the last) for exclusive use of the Operator Stations. Each O.S. in the active
group can use this trunk group for communications with the network.

- activate the background music, coming from a tuner on an external loudspeaker connected to the
system.

- activate forwarding of all internal and external calls intended for the O.S. group to a network des-
tination, defined by a common speed dial number or an internal destination, either:
• by switching the installation into restricted mode (using a programmed key)
- or using a programmed Attendant diversion key

This forwarding can also be automatically activated according to the time range.

The system can be used to program 3 different forwarding destinations:
- the first, for automatic activation by scheduling: this is valid for all time ranges
- the second, for manual activation, by switching the installation to restricted mode on one of the

O.S. in the active group
- the third, by using the operator calls forwarding key pre-programmed with the local or collective

speed dial number for which the calls are intended

Operator call diversion is activated and deactivated in accordance with the following descending order 
of priority:

- by forwarding key
- by normal/restricted mode key 
- by scheduling.
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CONFIGURATION

For each time-range, define whether attendant diversion is activated when the OS switches ma-
nually to restricted mode – MMC-PM5 (Expert View) only:

To define the type of mechanism used to forward external incoming calls to a network number:
rerouting or joining (see "External Forwarding" for more details on the 2 types of forwarding):

When the selected mechanism for forwarding external incoming calls to a network number is "joi-
ning", fill out the connectivity matrix by MMC-PM5 (Expert View) only:

Program the number (internal or collective speed dial) to which the operator calls are forwarded
following automatic activation by scheduling – MMC-PM5 (Expert View) only:

Program the number (internal or collective speed dial) to which the operator calls are forwarded
following manual activation with the "NRmode" programmed key – MMC-PM5 (Expert View) only:

On the OSs, program one or more "Attendant diversion" keys with a number (internal or collective
speed dial) to which the operator calls are to be forwarded:

Time Ranges -> "All Days"

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Part 2 -> "External
Diversion Mode"

- by MMC-Station: Global -> Joing -> Forwd

Traffic Sharing and Barring -> Joining

Time Ranges -> "Destination for time ranges"

Time Ranges -> "Destination if restr. mode manually activated"

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys -> "Attendant Diversion"

- by MMC-Station: Subscr -> Key -> Option -> ExtFwd
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ACTIVATION/USE

P.K.: Programmed Key – defined using MMC-PM5 (expert View) or MMC-Station

CANCELLATION

Switch to restricted mode When the system operates in normal mode, P.K.: NRMode + operator code

Reservation of last trunk group P.K.: Reserv + operator code

Broadcasting music on an ex-
ternal loud speaker

P.K.: BkgMus+ operator code

Attendant diversion Automatic, by scheduling

or

P.K.: NRMode when installation is in "Normal" mode + operator code

or

P.K.: Attendant diversion + destination if necessary + operator code

By switching to normal mode When the system is in restricted mode, P.K.: NRMode + operator code

Reservation of last trunk group P.K.: Reserv + operator code

Broadcasting music on an ex-
ternal loud speaker

P.K.: BkgMus+ operator code

Attendant diversion Depending on activation mode:

Automatic, by scheduling

or

P.K.: NRMode when installation is in "Restricted" mode + operator code

or

P.K.: Attendant diversion + operator code
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ADDITIONAL INFORMATION

- There is no particular signal to indicate attendant diversion when it is activated by scheduling.
- The icon or the LED associated with the NRmode programmed key is lit when one of the O.S. has

used this key.
- The icon or LED associated with all of the "Attendant diversion" programmed keys signals activation

of forwarding by this key.
- No checks are run on the collective speed dial rights, the barring or the traffic sharing on forwar-

ding to an external number.
- When the O.S. call is the result of the dynamic routing mechanism (see "Incoming call distribution"),

the call is forwarded and the initial call destination and level 1 destination are released. 
- When calls to the O.S. are forwarded:

• there is no overflow to the default O.S. group
- pre-announcement is not used.
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LINK CATEGORIES
DESCRIPTION

Link categories enable the system to authorize or inhibit connection between an internal user and a 
network subscriber.

There are 3 types of link category:

- speed dial rights: access to the collective speed dial numbers
- barring link category: access to dialing prefixes
- traffic sharing link category: access to bundles (see also file "Bundles")

Link categories are attributed as follows:

(*) Collective speed dial numbers with class = 0 are emergency numbers to which all of the stations have access.

CONFIGURATION

Modifying the default speed dial rights:

Type of Link Ca-
tegory

Class Class Barring LC Traffic sharing 
LC

Attributed to ... each station each speed dial 
number

- each station

- each trunk group

- each station

- each trunk group

...depending on 
the mode, nor-
mal or restric-
ted...

1 value per mode 1 value per mode 1 value per mode 1 value per mode

...and the type of 
comm. (voice or 
data)

1 value per type of 
communication

1 value per type of 
communication

1 value per type of 
communication

-

Value authorized or 
unauthorized, for 
each class in the 
collective speed 
dial list

0 to 8 (*) 1 to 16 1 to 16
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- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Collective Speed Dial
- for access: External Lines -> List of Accesses -> Details -> Speed Dial 

- by MMC-Station:
• for access: Access -> RepEnt
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Modifying the default barring link categories:

Modifying default traffic sharing link categories:

To modify the "Barring Matrix" – MMC-PM5 (Expert View) only:

To modify the "Traffic Sharing Matrix" – MMC-PM5 (Expert View) only:

- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Barring
• for the trunk groups: External Lines -> Trunk Groups -> Details -> Link-Cat
- for access: External Lines -> List of Accesses -> Details -> Link-Cat.

- by MMC-Station:
• for the users: Subscr -> BarTyp
• for the trunk groups: TrGp -> Catego
- for access: Access -> Catego

- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Barring
• for the trunk groups: External Lines -> Trunk Groups -> Details -> Link-Cat
- for access: External Lines -> List of Accesses -> Details -> Link-Cat.

- by MMC-Station:
• for the users: Subscr -> BarTyp (last 2 values)
• for the trunk groups: TrGp -> Catego (last 2 values)
- for access: Access -> Catego (last 2 values)

Barring -> Barring Matrix

Barring -> Traffic Sharing Matrix
Ed. 04 3/4Réf. 3EH 21000 BSAA



LINK CATEGORIES CALL SERVER : TELEPHONE FEATURES

 

ACTIVATION/USE

(**) See "Barring"

ADDITIONAL INFORMATION

- Special case – transit: a call arriving on DLTx/Tx/TL/ATL is automatically routed by the system to a
DLTx/Tx/TL/ATL trunk group. In this case, the line used for the incoming call acts as a gateway with
respect to barring; its own link category is used rather than that of the trunk group to which it be-
longs.

- The emergency numbers predefined in the software on leaving the factory are valid regardless of
the barring mechanisms.

Is the external
call made by means

of a collective
speed dial
number?

Yes No

Analysis of the speed 
dial rights of the station 
and of the class of the 

speed dial number

Analysis of the user and trunk
Group traffic sharing Lcs

in the traffic sharing matrix

The call is authorized
or unauthorized

Connection is authorized
or unauthorized

Analysis of the barring LCs of 
the user and of the bundle in 

the barring matrix

The matrix determines
the barring level 

(1 to 6) (**)
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BARRING
DESCRIPTION

Barring comes into effect after the system has authorized connection between the user and the entered 
trunk group (following analysis of the traffic sharing link categories: see "Link Categories").

Barring makes it possible to define whether an internal user (or an access, in the case of transit) is 
authorized to make a call to the network, or not (other than by using the collective speed dial numbers), 
depending on the prefix (i.e. the first few digits) of the called number.

To do this, the system uses barring link categories (see "Link Categories") and barring tables.

The system has 6 barring tables, numbered 1 to 6: each table corresponds to a level of barring and 
can have "authorized" or "unauthorized" prefixes.

The system also uses two barring counters, C1 and C2:

- C1 states the maximum number of authorized digits if an authorized prefix has been recognized
or if there is no authorized prefix in the level of barring associated with the call. The default value
is 22.

- C2 states the maximum number of digits authorized if the dialed prefix is not programmed in the
level of barring associated with the call., while this level has at least one authorized prefix. The de-
fault value is 4.

CONFIGURATION

Modifying the default barring link categories:

To modify the "Barring Matrix" – MMC-PM5 (Expert View) only:

- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Barring
• for the trunk groups: External Lines -> Trunk Groups -> Details -> Link-Cat
- for access: External Lines -> List of Accesses -> Details -> Link-Cat.

- by MMC-Station:
• for the users: Subscr -> BarTyp
• for the trunk groups: TrGp -> Catego
- for access: Access -> Catego

Barring -> Barring Matrix
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Creating barring tables (adding a "!" authorizes or inhibits a complete barring level) – MMC-PM5
(Expert View) only:

To authorize or deny access to the network by transfer, for each station – MMC-PM5 (Expert View)
only:

 To authorize or deny access to the network, for each station – MMC-PM5 (Expert View) only:

To modify the length of barring counters – MMC-PM5 (Expert View) only:

ACTIVATION/USE

Having determined the barring level of a call, the system compares the requested number as it is being 
dialed, with the prefixes in the table associated with this level of discrimination:

Barring -> Barring Tables

Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Features -> 
"Transfer to External"

Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Features -> 
"Private Subscriber"

Barring -> Barring Tables

External dialing         

NO

YES

NO

YES

NO

YES

YES

NO

Circuit released
+

fast busy tone sent
to calling party

Call setup

Max. number of 
digits authorized 
by C1 reached?

Max. number
of digits authorized by

C2 reached?

Authorized
prefix

recognized ?

No authorized 
prefix ?

NO

YES

NO

YES
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ADDITIONAL INFORMATION

- The 6 prefix tables altogether (or barring levels) can have over 100 prefixes.
- Each prefix has a maximum of 10 digits (0 to 9, * and #).
- A private subscriber cannot be connected to the network (nor receive calls from or make calls to

the network).
- The emergency numbers predefined in the software on leaving the factory are valid regardless of

the barring mechanisms.
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File
END OF DIALING DETECTION
DESCRIPTION

On analog trunk lines, end of dialing detection makes it possible to define the moment when the 
system can release the DTMF receivers and carry out the bi-directional switching of the line.

The system uses the end of dialing prefix table to ascertain the length (number of digits) of the numbers 
transmitted. A counter, equal to or superior than 0, is associated with each prefix.

When a prefix has not been configured in this table, the system uses a reference counter.

On digital trunk lines, the trunk sends a message telling the system to carry out the two-way swit-
ching. By default, the system carries out this commutation after a time-out simulating going off-hook.

CONFIGURATION

Programming the end of dialing prefix table:

Modifying the reference counter value on all analog lines:

Modifying the off hook simulation time-outs:

- by MMC-PM5 (Expert View): Numbering -> End of Dialing Table
- by MMC-Station: EODPfx -> EODial -> Prefix

- by MMC-PM5 (Expert View): Numbering -> End of Dialing Table
- by MMC-Station: EODPfx -> EODial -> RefCnt

- call on an analog interface (TL, ATL, DDI, etc): External Lines -> Protocols -> Analog Trunks
-> Timers -> Modify

- call on a digital interface (T0, T2, etc):
• by MMC-PM5 (Expert View):  System Miscellaneous -> Memory Read/Write -> Timer

Labels -> "OffHookSim"
- by MMC-Station: Global -> Rd/Wr -> Timer -> "OffHookSim" -> Return -> Memory
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ACTIVATION/USE

ADDITIONAL INFORMATION

- Maximum number of prefixes in the table of end of dialing prefixes: 20.
- Maximum number of digits per prefix: 6.
- This mechanism does not concern lines or trunks declared in the system as being connected behind

a PABX.

NO
Is the counter value 

equal to 0 ?

YES

Trunk line seizure

Do the first digits correspond 
to a prefix configured in the 

end of dialing table of prefixes 
?

NO

The system uses the 
reference counter for 

all the lines and 
detects end of dialing 

when the counter 
value is reached

YES The system uses the 
counter value associated

with this prefix

Dialing is said to be 
OPEN since the system 
does not detect end of 

dialing

Dialing is said to be 
CLOSED and the system

detects end of dialing
when the counter 
value is reached

The 2-way communication
is carried out and 

the user can enter the 
features in conversation

After each transmitted digit, the system launches 
the off hook simulation time-out ; When his time-
out has lapsed end of dialing is arbitrarily detected

Is the counter value 
equal to 0 ?

NOYES
Ed. 042/2 Réf. 3EH 21000 BSAA



9

SPLITTINGCALL SERVER : TELEPHONE FEATURES

 

File
SPLITTING
DESCRIPTION

The splitting mechanism enables a user to dial a number on an analog trunk line or behind a PABX, 
without having to wait for any dialing splits.

It is accessed:

- by manual dialing
- by automatic dialing (last number redial, temporary memory number, speed dial number)

Splitting can be of two types:

- tone detection: TONE in the splitting prefix table
- pause: PAUSE in the splitting prefix table.

The mechanism applies at three levels:

- During line seizure: 
• if the splitting is TONE, dialing is possible as soon as the PABX has recognized the tone trans-

mitted by the trunk during a validation time-out. If, after expiry of a time-out, no tone has been
recognized, the system releases the line.

- if the splitting is PAUSE, dialing is transmitted after expiry of a programmable time-out, (diffe-
rent for private or public trunk lines).

- Intermediary splitting prefixes:
Dialing according to the prefixes in the splitting prefix table, is transmitted after tone detection or 
after a splitting time-out with the same principles as for the line seizure.

- Splitting prefixes defined in the personal or collective speed dial numbers:
A personal or collective speed dial number can have one splitting character (symbolized by "!"). The 
splitting method used (TONE or PAUSE) is the one programmed in the splitting prefix table.
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CONFIGURATION

Programming the line seizure type of splitting:

Programming or modifying the splitting prefix table:

To modify the pause time-out – MMC-PM5 (Expert View) only:

To modify the tone detection time-out – MMC-PM5 (Expert View) only:

To modify the tone non-detection time-out – MMC-PM5 (Expert View) only:

ACTIVATION/USE

- by MMC-PM5 (Expert View): Numbering -> Splitting Table
- by MMC-Station: EODPfx -> EODial -> Split -> TonDet

- by MMC-PM5 (Expert View): Numbering -> Splitting Table
- by MMC-Station: EODPfx -> EODial -> Split -> prefix

External Lines -> Protocols -> Analog Trunks -> Timers -> Modify -> "Pause after Seizure 
Trunk", "Pause after Seizure Main/Sat", "Pause Fractioning" (Part 2)

External Lines -> Protocols -> Analog Trunks -> Timers -> Modify -> "Tone Detection" 

External Lines -> Protocols -> Analog Trunks -> Timers -> Modify -> "TO if no Tone De-
tection"

The system waits 
for the end of the 
pause time-out 
then continues 
transmitting the 

dialing

Line seizure

Splitting = TONE or 
PAUSE ?

Pause

TONE
Is the tone present 

and valid ?

NO

Dialing is transmitted
after time-out

YES

Does the number 
contain a splitting 

prefix or a  "!" ?

YES with
TONE

YES

NO

The system 
releases the line

The system continues 
transmitting the dialing

with PAUSE

Is the tone present 
and valid ?

NO

YES
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ADDITIONAL INFORMATION

- Maximum number of prefixes in the table of splitting prefixes: 16.
- Maximum number of digits per prefix: 4.
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File
CALL DISTRIBUTION (DYNAMIC 
ROUTING)
DESCRIPTION

The system can automatically re-route:

- a call from the network and destined for the active Operator Group, or the default Operator Group
(see "Operator stations")

- a call arriving from the network and currently in transit
- a DDI call (Direct Dialing Inward) from the network and destined for a station or a Hunting Group
- an external call on a "personalized" or "reserved" line: all calls arriving on a personalized external

line are routed directly to a station or Hunting Group, depending on the system's normal or restric-
ted mode. Furthermore, a "personalized" line may be "reserved", i.e. a call on this line can neither
be picked up nor monitored

- an internal call
- a call from the private network

The system treats simultaneous calls destined for an Operator Group according to the following prio-
rities:

- external hold recall, delayed or otherwise
- internal hold recall, delayed or otherwise
- external callback
- external call
- internal callback
- call from an operator station
- internal call
- Operator Group call
- Hunting Group call

The system routes an internal incoming call depending on the following criteria:

- directory number of the destination station programmed in the main numbering plan
- type of call: private or not
- station accessible or not
- destination station resource keys (see "Resource keys")
- status of the resources: free or busy (see "Resource keys")
- features active on the destination set: internal forwarding (see "Forwarding"), monitoring (see "Call

Monitoring"), filtering (see "Manager/secretary screening"), external forwarding (see "External
Forwarding")

- dynamic routing parameters programmed for a resource, the station or the hunting group

The system routes an external incoming call depending on the following criteria:

- PABX forwarding activated by an operator (see "PABX forwarding")
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- system in normal or restricted service (see "Normal / restricted service (system level)")
- dissuasion message programmed in the active Operator Group (see "Automatic welcome")
- welcome message transmitted or not (see Automatic Welcome (Pre-announcement))
- destination station directory number: programmed in the public, private numbering plan (see "In-

coming transit") or main only
- type of call: for a private subscriber or not
- station accessible or not
- destination station resource keys (see "Resource keys")
- status of the resources: free or busy (see "Resource keys")
- features active on the destination set: internal forwarding (see "Forwarding"), monitoring (see "Call

Monitoring"), filtering (see "Manager/secretary screening"), external forwarding (see "External
Forwarding")

- dynamic routing parameters programmed for a resource, the station or the hunting group
NB: the dynamic routing programming on a resource key is duplicated on all the resources of the 
same type. To cancel this programming, erase all the keys of this type and re-program.

CONFIGURATION

Configuring a "personalized" line i.e. a line with predetermined routing:

Configuring a "reserved" line by attributing the feature "private subscriber" to the DDI number pro-
grammed for a personalized line:

- by MMC-PM5 (Expert View):
• complete the DDI numbering plan: Numbering -> Public Numbering Plan
- associate the number programmed in the DDI numbering plan with the appropriate line in

normal and/or restricted mode: External Lines -> List of Accesses -> Details -> Call-
Dist.

- by MMC-Station:
• complete the DDI numbering plan: NumPln -> PubNum
- associate the number programmed in the DDI numbering plan with the appropriate line in

normal and/or restricted mode: Access -> CalDis

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum
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Defining the dynamic routing parameters for a resource key:

Defining the dynamic routing parameters for a station:

Defining the dynamic routing parameters for a Hunting Group:

To select the active Operator Group with the general call ringer as level 2 destination:

To choose between the called party mail box and the automated attendant as destination level 1
when D1 is the directory number of the group containing the two voice mail accesses:

To choose between the called party mail box and the automated attendant as destination level 2 if
the voice mail belongs to the Operator Group called in D2:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys -> Resource Key -> Dyn. Rout.

- by MMC-Station: Subscr -> Keys -> Modify -> Resou -> DynRou

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Dyn. Rout.

- by MMC-Station: Subscr -> DynRou.

- by MMC-PM5 (Expert View): Hunting Groups -> Dyn. Rout.
- by MMC-Station: Groups -> Hunt -> DynRou.

- by MMC-PM5 (Expert View): check the Gen. Bell to Gen. Level. box in the "Dynamic Routing"
window

- by MMC-Station: GenBel so that the display indicates "GENBELL" in capital letters

- by MMC-PM5 (Expert View): VMU as Auto. Attendant (level 1):
• box selected: the automated attendant is called in D1
- box not selected: the destination station's mail box is called in D1

- by MMC-Station: VMUBeh -> Level 1:
• Level 1 = Auto-Sec: the automated attendant is called in D1
- Level 1 = Message: the destination station's mail box is called in D1

- by MMC-PM5 (Expert view): VMU as Auto. Attendant (level 2):
• box selected: the automated attendant is called in D2
- box not selected: the destination station's mail box is called in D2

- by MMC-Station: VMUBeh -> Level 2:
• Level 2 = Auto-Sec: the automated attendant is called in D2
- Level 2 = Message: the destination station's mail box is called in D2
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ACTIVATION/USE

Dynamic forwarding general principle

The initial destination D0 can be:

- a station
- a Hunting Group
- the general level (see "Operator stations")

If D0 is a station or a Hunting Group:

- D1can be a station, a Hunting Group, the voice mail unit (mail box or automated attendant) or a
collective speed dial number

- D2 is the active Operator Group (see "Operator stations") with (only if the call is external) or without
the general call ringer programmed in this group

If D0 is the general level:

- D1 can be a station, a Hunting Group or a collective speed dial number
- D2 is the default Operator Group (see "Operator stations") with (only if the call is external) or wi-

thout the general call ringer programmed in this Hunting Group

Initial destination (D0) rings

Incoming internal or external call

no

yes Has D0 answered 
the call before 
time-out T1 has 

expired?

Conversation

Destination level 1 (D1) also 
rings

no

yes
Has D0 or D1 

answered the call 
before time-out 
T2 has expired?

Conversation

Destination level 2 (D2) also 
rings
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Dynamic routing and call forwarding (see "Forwarding")

Incoming call 
(int/ext)

Destined for a 
station or a 

hunting group 
? Hunting group

Station

Station in 
immediate 
forwarding 

?

Yes

No
Forwarding 
destination 

rings

D.R active for 
the forwarding 
destination ?No

Yes

After T1,
destination level 1 

also rings

D.R active 
for station ?

No

Yes

After T1, destination
level 1 also rings 

Only  initial 
called party 

rings

After T2, general
level (*) 

also rings

(*) If the immediate forwarding destination of the initial called party is 
the active operator group, the system rings the default operator group, 
after T2

After T2, active 
operator group in 

immediate for
warding?

No

General level 
also rings

Yes

Operator forwarding 
destination + initial 

level 1 D.R destination
+ initial called 

party ring

D.R for 
active operator

group?

Yes

After T1', level 
1' destination 

also rings

After T2', default 
operator group 

also rings

No

Initial called party + 
its level 1 D.R 

destination+ general 
level ring

D.R = Dynamic Routing

Hunting group 
in immediate 
forwarding?

No

D.R active for 
the group ?

No

YesOnly hunting 
group rings

Yes

Is the hunting 
group the 

active operator 
group ?

Yes

After T1, destination
level 1 

also rings

After T2, default 
operator group 

also rings

Supposing that the forwarding authorizations are granted
(see file "Forwarding")

Forwarding 
destination 

rings

No

Forwarding

level 1 D.R destination
+ general 
level ring

Initial called party + its 
level 1 D.R destination + 
general level + level 1

operator group D.R destination
+ default operator 

group ring

Operator group + its 
level 1 D.R destination 

+ default operator 
group ring (+ possible 

hunting group
forwarding destination)

D.R for 

group? 

Yes

AfterT1', 

also rings 

After T2', default 
operator group 

also rings

No

Forwarding destination + its 
level 1 D.R destination + 

general level + level 1 operator
group D.R destination 

+ default operator group 
ring

Is D1 external 
(by means of collective

speed dial 
no.s)?

No

Yes

Only D1 
rings

Internal for
warding 

destination 
?

Yes

Only forwarding
destination

rings

No

DR active for 
the resource 
signalling 
the call?

No

Yes
Only forwarding
destination rings
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ADDITIONAL INFORMATION

- The sub-address and User to User Signaling (UUS) are not re-routed after a forwarding, a transfer
or a call pick-up.

- When dynamic routing is active but D1 or D2 is not programmed, or T1 or T2 is not used, the sys-
tem moves onto the next stage.

- The active and default Operator Groups may contain both integrated voice mail accesses (see cor-
responding file).

- Calls from the private network are handled with the INTERNAL call dynamic routing parameters.
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NORMAL AND RESTRICTED SERVICE
NORMAL AND RESTRICTED SERVICE - SYSTEM LEVEL

Description

The service mode affects the way in which the system distributes incoming calls and controls users' 
outgoing calls.

A day can be divided into a maximum of 7 time ranges each varying in duration. The following are 
associated with each time range: 

- a system operating mode: normal or restricted service
- an Operator Group (see "Operator stations" and "Specific operator services")

Switching from NORMAL MODE to RESTRICTED MODE and vice versa depends on the following pa-
rameters:

- the time (and therefore the time range)
- the Normal/Restricted mode function on the Operator Station

Configuration

Modifying the time ranges (beginning of time range, normal or restricted mode associated, active
Operator Group):

- by MMC-PM5 (Expert view):  Time Ranges
- by MMC-Station: TimeRa
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Activation/Use

Additional Information

When the switchover to restricted mode is carried out from an Operator Station, users who do not have 
"Inhibition Flag" feature rights are forced into "user" restricted mode.

Switching to
RESTRICTED mode 
by an OPERATOR?

RESTRICTED 
MODE

NO

Are all the operators 
of the current group 
forwarded or out of 

service?

DEFAULT OPERATOR 
GROUP

YES

Time range in 
NORMAL or 
RESTRICTED 

mode?

RestrictedNormal

OPERATOR HUNTING GROUP ASSOCIATED TO 
THE TIME RANGE

YESNO
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FORWARDING OF ALL EXTERNAL INCOMING CALLS

The system is made up of two public numbering plans, one of which is used in normal service while 
the other is used in restricted service. 

The restricted public numbering plan can be configured in such a way that certain DDI numbers are 
redirected to external destinations (using the group directory or the ARS mechanism) while others (Fax 
for example) reach their intended internal destinations. 

Configuring the public numbering plan in restricted mode

The public numbering plan for restricted service mode can contain a maximum of 99 entries (0 by de-
fault). 

The configuration (beginning and end of range, base, NMT) is identical to that of the public numbering 
plan for normal service mode (PubNum). 

If the destination of the DDI number is the same in normal and in restricted service, the 2 numbering 
plans must have the same configurations.

For more details, see "Numbering Plans" in the MMC-Station section.

Activation/Deactivation

Forwarding can be activated/deactivated from any station with an N/R Mode key. After pressing this 
key, dial the operator code.

Notas :

It can also be activated by configuring the time ranges.

Example of use

Normal service public numbering plan

- by MMC-PM5 (Expert View): Numbering -> Restricted numbering plan 
- by MMC-Station: NumPln -> ResNum

Begin End Base Function

120 170 120 Station

200 230 200 Station

500 525 500 Hunting Group
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Restricted service public numbering plan 

Internal numbering plan

Collective Speed Dial

In this example, the public numbering plan for restricted service uses the collective speed dial table.

The numbers 120 to 170 and 213 to 230 keep their normal destinations when the system is in restric-
ted service mode, as do calls to the range 500 to 524.

The external incoming calls to stations 200 to 209 are forwarded to the destinations defined by the 
first 10 entries in the collective speed dial table (8000 to 8009). Calls to numbers 210, 211, 212 and 
calls to group 525 are forwarded to the destination defined by the entry 8010 in the collective speed 
dial table.

Begin End Base Function

120 170 120 Station

200 210 0 Collective Speed Dial

211 211 10 Collective Speed Dial

212 212 10 Collective Speed Dial

213 230 200 Station

500 524 500 Hunting Group

525 525 10 Collective Speed Dial

Begin End Base Function

8000 8010 0 Collective Speed Dial

Speed dial number Level Called number

8000 8 59242

8001 8 59243

....... .. ...........

8009 8 59251

8010 8 59252
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NORMAL AND RESTRICTED SERVICE – USER LEVEL

Description

Depending on the time range, the system operates in either normal or restricted mode. The service 
mode affects the way in which the system distributes incoming calls and controls users' outgoing calls.

The installer can also configure the operation in "user" restricted mode for each station and in each 
time range.

Configuration

Define the time ranges during which a station operates in restricted service:

To specify whether or not to inhibit the switch to restricted service when the system is switched to
restricted service by an operator; see "Specific operator station services", in the "Telephone services"
section:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Barring -> "Time Ranges (outgoing traffic)"

- by MMC-Station: Subscr -> NorRes -> NorRes

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Inhibition Flag"

- by MMC-Station: Subscr -> NorRes -> Inhibi -> Choice
Ed. 04 5/6Réf. 3EH 21000 BSAA



NORMAL AND RESTRICTED SERVICE CALL SERVER : TELEPHONE FEATURES

 

Activation/Use

Additional Information

A station in restricted service and unlocked (see "Station comfort features", "Telephone services" sec-
tion) switches to user normal service when the code for unlocking the station is entered: this station 
can no longer be switched manually to restricted service but it can be locked.

NORMAL USER SERVICE RESTRICTED USER SERVICE 

NO

YES

YES

NO

Set locked by user?

YES

NO

SERVICE LOCKED

and/or

NO

YES

Does the user
have "inhibit restricted

mode" feature
rights?

Is the user in
restricted mode during

the applicable time
range?

Set locked by user?
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AUTOMATIC WELCOME (PRE-
ANNOUNCEMENT)
DESCRIPTION

This feature makes it possible to send a spoken message to a network caller before connecting him to 
the called party. The called party can be:

- a station
- a Hunting Group (see "Hunting Groups")
- an Operator Group (see "Operator stations")

The message can be sent to the caller either:

- before the destination station rings: this is mode 1
- while the destination station is ringing: this is mode 2

and, either:

- only if the called party is busy
- no matter what status the called party is in: free or busy

The system allows you to play up to 8 pre-recorded messages. These messages can be:

- welcome messages
- dissuasion messages
- voice prompts (for DISA transit for example)

The pre-announcement can be defined for:

- 15 DDI numbers (individual pre-announcement)
- all the system's users (general pre-announcement)

The installer can allocate a maximum of one message for each of the 7 time ranges.

CONFIGURATION

Selecting the source for the please wait music:

Recording RAM welcome and dissuasion messages – MMC-Station only:

- by MMC-PM5 (Expert View): System Miscellaneous -> Messages and Music -> Music on
Hold 

- by MMC-Station: Voice -> MusSrc -> Stndrd, VoicPr or Tape

Voice -> RecMsg -> Msg1 to Msg8 -> Record
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Listening to recorded RAM welcome and dissuasion messages – MMC-Station only:

Defining DDI numbers, for individual pre-announcement:

Assigning welcome messages:

Defining the pre-announcement mode (none, mode 1 or mode 2) depending on the time range:

To define whether the message is sent only if the called party is busy, or regardless of status, de-
pending on the time range – MMC-PM5 (Expert View) only:

To modify the pre-announcement time-outs:

To select transmission of ringing tone or "please wait" music (for a free station):

To select transmission of ringing tone or "please wait" music for a busy station:

To select transmission of ringing tone or "please wait" music for a Hunting Group (free or busy):

Voice -> RecMsg -> Msg1 to Msg8 or Music -> Listen

- by MMC-PM5 (Expert View): Numbering -> Numbering Plans -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum

- by MMC-PM5 (Expert View): Misc. Subscribers -> Pre-announcement
- by MMC-Station: PreAnn -> Add -> Msg

- by MMC-PM5 (Expert View): Misc. Subscribers -> Pre-announcement
- by MMC-Station: PreAnn -> Add -> Mode

Subscribers Misc. -> Preannouncement

- by MMC-PM5 (Expert View): Subscribers -> Pre-announcement -> Timers
- by MMC-Station: Global -> Rd/Wr -> Timers -> "AnsMsgTim" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "TonPrRng"

- by MMC-Station: Global -> Rd/Wr -> Address -> "TonPrRng" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "TonPrCmp"

- by MMC-Station: Global -> Rd/Wr -> Address -> "TonPrCmp" -> Return -> Memory

- by MMC-PM5 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "TonPr-
Grp"

- by MMC-Station: Global -> Rd/Wr -> Address -> "TonPrGrp" -> Return -> Memory
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ACTIVATION/USE

noyes

Positioning on the operator group or
 the default operator group

Is the called N° 
configured with 

individual
preannouncement in 

the current time 
range ?

Distribution of message configured
as individual preannouncement

External call to operator group destination
(see file "Normal/Restricted service (system level)")

noyes Does the operator
group have a welcome

message?

Dissuasion message sent and 
line released

External DDI call to a station or 
hunting group

Is general 
preannouncement

configured?

yes

no

The destination 
rings

Distribution of message configured
as general preannouncement
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Tree diagram operational after the system has determined the type of pre-announcement:

(*) sent by the public exchange
(**) The ringing tone or the "please wait" music is heard:

- by a caller on an analog TL up until the "Release after pre-announcement (norm or restr mode)" time-out has lapsed
- by a caller on digital access up until the called party goes off hook.

(***) ISDN calls only

Automatic transmission of
message and the called

station rings simultaneously.
If the called party is out of
service, the calling party

is released (***).

Caling party hears the ringing

 

tone (*) while the welcome
message is sent to other calling 
parties then during the "time-out

before preannouncement" 

YES NO

External incoming call

Is the access 
assigned to the 

welcome message
 busy?

Preannouncement
in mode1 or 

2 ?

Calling party hears the
ringing tone (*) during
the “time-out before
preannouncement”

Preannouncement
 in mode1 

or 2?

mode1

Automatic transmission 
of message to al
waiting callers

mode2

Automatic transmission

 

of message to all waiting
callers and the called

stations ring simultaneously.
If a called party is out of 

service, the corresponding 
calling party is released. (***)

 
 

Do one or
several called parties
go off hook during

transmission?

At the end of transmission,
the calling parties 

hear the ringing tone or 
the "please wait" music. 

(**)

NO

YES

Switch to conversation 
for called parties that 
have gone off hook

mode1 mode2

Automatic transmission
of message

Does the called 
party go off 
hook during 
transmission?

NO

YES

Switch to conversation

Is one of the 
called parties 

out of
service?

NO

YES Is the called 
party out of 

service?

NO

YES

Call returns to the
operator group

Call returns to the
operator group

At the end of transmission,
the calling party 

hears the ringing tone 
or the "please wait" 

music. (**)
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ADDITIONAL INFORMATION

- Duration of default "please wait" music: 16 s
- Maximum duration of the customizable "please wait" music: 2 min by default and up to 10 min with

a hard disk
- Maximum duration of a welcome or dissuasion message: 16 s
- Maximum number of pre-announcement messages: 8
- The automatic welcome is not activated when the called party has activated text answering or pa-

ging
- An empty Hunting Group can no longer use the Automatic Welcome service.
- The automatic welcome only concerns voice type calls. 
- The automatic welcome does not concern calls from the private network
- In mode 1, an external call released by the caller before being presented to the initial destination,

is not recorded in the repertory of unanswered calls. 
- An external call on an analog line , received with transmission of the welcome message and re-

maining unanswered, is released by the system after a time-out.
- Metering units arriving during the transmission of the welcome message are assigned to the called

party.
- Under no circumstances will the external call receive two welcome messages.
- An error message appears on the station display when the automatic welcome cannot transmit the

message to the incoming call.
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DIRECT DIALING INWARDS
DDI numbers can:

- contain up to 8 digits.
- use the numbering recovery mechanism described below.

NUMBERING RECOVERY

Description

When, in an existing installation, a new range of DDI numbers needs to be added, and the new se-
quence allocated by the public exchange overlaps the existing range, the installer can make use of the 
"DDI with more than 4 digits" mechanism.

Exemple :

Consider an existing system with the DDI numbers (XX = any possible "intercity prefix", "intercity code" 
and "recall prefix" – these can vary from country to country):

- XX 1 41 23 40 10 to XX 1 41 23 40 19 assigned to stations 120 to 129
- XX 1 41 23 41 00 to XX 1 41 23 41 19 assigned to stations 130 to 149

The exchange allocates the new range XX 1 41 33 40 15 to XX 1 41 33 40 24: these numbers are 
assigned to stations 150 to 159.

As described below, the numbering plan does not allow:

- use of the whole DDI range available; in actual fact, in order to route a DDI number to a called
station, the system only analyzes the last 4 digits of the number received from the network and the
DDI sequences XX 1 41 23 40 10 and XX 1 41 33 40 15 have in common, the range of the last 4
digits 40 15 to 40 19.

- transmission of the exact number of the caller (see "ISDN services") since the system would require
two installation numbers (XX 1 41 23 and XX 1 41 33) in order to operate correctly, which is im-
possible.
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Configuration

Configuring the installation number:

Filling in the substitution table:

Completing the DDI numbering plan:

Activation/Use

Functional analysis

A "DDI with more than 4 digits" mechanism is based on the analysis of all the received digits. They are 
modified using a substitution table and analyzed by the Public numbering plan. Programming such a 
mechanism requires you to have a global view of your DDI sequences.

Procedure to follow

- check the DDI sequences
- deduce the installation number by removing the "intercity prefix", "intercity code" if found
- deduce the minimum number of digits required to cover the DDI ranges
- analyze the remaining digits and create the DDI modification table
- configure the DDI numbering plan
- activate the mechanism 

Application using the above example 

- DDI sequences:
• 1st sequence: 1 41 23 40 10 to 1 41 23 40 19 for stations 120 to 129
• 2nd sequence: 1 41 23 41 00 to 1 41 23 41 19 for stations 130 to 149
- 3rd sequence: 1 41 33 40 15 to 1 41 33 40 24 for stations 150 to 159

- Deduction of the installation number:
Digits 1 41 are common to the 3 sequences of DDI numbers: these 3 digits will make up the ins-
tallation number. THE "INSTALLATION NUMBER" FIELD CAN BE LEFT EMPTY IF THERE IS NO 
COMMON DIGIT.

- Deduction of the minimum number of digits to cover the DDI ranges:
1 or 2 digits, at least, are necessary in order to join a series of stations.
• 1st sequence: 1 41 23 40 1 0 to 1 41 23 40 1 9: 10 stations with 1 digit (0 to 9)
• 2nd sequence: 1 41 23 41 00 to 1 41 23 41 19: 20 stations with 2 digits (00 to 19)
- 3rd sequence: 1 41 33 40 15 to 1 41 33 40 24: 10 stations with 2 digits (15 to 24)

- analysis of the remaining digits (by removing the installation number and the digits necessary to

- by MMC-PM5 (Expert View): Numbering -> Installation Numbers
- by MMC-Station: Global -> InsNum -> Public

- by MMC-PM5 (Expert View): Numbering -> DDI Number Modification Table
- by MMC-Station: Num Pln -> PubNMT 

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum
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cover the DDI ranges) and creation of the DDI modification table:
• 1st sequence: 1 41 23 40 10 to 1 41 23 40 19
• 2nd sequence: 1 41 23 41 00 to 1 41 23 41 19
- 3rd sequence: 1 41 33 40 15 to 1 41 33 40 24

The remaining digits are to be replaced by the substitution digits ,which, themselves, will be ana-
lyzed in the DDI numbering plan. To do this, apply the following rule:
Minimum number of digits to cover the DDI range + Length of the substitution number = 
4 (i.e. the maximum number of digits as defined in the DDI numbering plan).
For example, one can:
• for the 1st sequence: substitute "23 40 1" by "810" (in fact, "810" + 1 digit from 0 to 9 = 4 digits)
• for the 2nd sequence: substitute "23 41" by "82" (in fact, "82" + 2 digits from 00 to 19 = 4 digits)
- for the 3rd sequence: substitute "33 40" by "83" (in fact, "83" + 2 digits from 15 to 24 = 4 digits)

- Creation of the DDI numbering plan (from the DDI numbers modification table):

Result of the above example

The DDI number received from the network (here, XX 1 41 33 40 20) is analyzed by the system as 
follows:

- removal of any intercity prefix, etc... as well as the installation number: leaves the number 33 40
20.

- analysis of this number in the substitution table (the mechanism being authorized, this analysis is
carried out automatically for all DDI numbers received): the system deducts the number 8320

- analysis of the DDI number thus obtained in the DDI numbering plan: the system makes station
155 ring.

Function Begin End Base

Station -- 9 120

Station -- -- 130

Station -- -- 150
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Additional Information

- Maximum number of entries in the modification table of DDI numbers: 18
- Maximum number of digits for an entry in the modification table of DDI numbers: 16.
- Maximum number of digits in a substitution number: 4.
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CLASS COMPATIBILITY
DEFINITION

This feature allows information (from the public ISDN network or internal system network) to be pre-
sented on analog CLASS terminals connected to Alcatel OmniPCX Office.

In idle, when ringing or during a call, analog CLASS terminals have access to:

- date and time of the system
- CLIP (calling line identification)
- calling line identification restriction management
- caller's name (if available in the system directory)
- management of the Message LED

HARDWARE REQUIREMENTS

- CLASS terminals connected to SLI boards

CONFIGURATION

Specifying the analog station as a CLASS terminal:

Activating the name display:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Classiq. (class)

- by MMC-Station: Subscr -> Termnl -> Class

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> Name Display
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ISDN SERVICES 
DESCRIPTION

The default dialing mode on ISDN lines is digit by digit. At the press of a key, users can employ block 
dialing to access a range of services:

- addition of a sub-address to the number dialed
- activation of calling line identification restriction, i.e. the caller's identity is not transmitted to the

called party
- for a station with soft keys only, transmission of user-to-user signaling (UUS), i.e. a text message

on a station with a display.

The "Calling Line Identification Restriction" function can also be activated in digit-by-digit dialing 
mode for all stations (see "Making/Answering a call").

When a call is received, the "malicious call identification" service is available service can be used. 
This service, available by subscription to the network, involves the network operator recording certain 
call details during the communication, (numbers of both parties; date and time of call; sub-address of 
caller if applicable).

The keypad dialing features offer access (in transparent fashion) to the services provided by the pu-
blic network operator (the functional services of the particular operator).

CONFIGURATION

For each station, to specify whether or not to permanently activate "calling line identification res-
triction":

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Identity Secrecy"
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For each station, to specify whether or not to authorize reception of User to User Signaling:

To modify the maximum time-out, after going on hook, for requesting recording of the caller's iden-
tity – MMC-PM5 (Expert View) only:

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key

(*) Messages 1 to 27 are pre-defined in the system. Some of them have a variable part which must be 
completed (return time, room number, etc.). Message n° "0" can be made up completely from the al-
phabetic keypad (up to 32 characters).

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "UUS Allowed"

External Lines -> Protocols -> ISDN Trunk -> Layer 3 -> "T305 Disconnect Supervision"

Z Without 
display

With display, no soft 
keys

With soft keys

Activate calling line identification restriction before dia-
ling, in sequential or block dialing modes

-- P.K.: CLIR P.K.: CLIR P.K.: CLIR

Switch to block dialing mode -- -- F.K.: ISDN or P.K.: 
BMdial

F.K.: ISDN

Delete digit preceding the cursor in block mode dialing 
(number and sub-address)

F.K.: Mute S.K.: Rubout

Add a sub-address in block dialing mode -- -- P.K.: SubAdd S.K.: SubAdd

To validate the sub-address, in block dialing mode -- -- P.K.: SubAdd S.K.: OK

Add UUS, in block dialing mode -- -- -- S.K.: Text + n° of messa-
ge (from 0 to 27) (*)

Activation of calling line identification restriction, in 
block dialing mode

-- -- -- S.K.: Secret

To set up the call in block dialing mode (with or without 
sub-address, with or without UUS).

-- -- F.K.: ISDN or P.K.: 
BMdial

S.K.: Send

Activate malicious call identification Function code S.K.: MCID

Type of station
Service
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ADDITIONAL INFORMATION

- When the user has activated the block dialing mode, he cannot select a specific access via an RSP
(see "Resource Keys").

- In block dialing mode, if the dialing transmitted is incomplete, the line used is released as no digit
can be added to the dialing.

- Only a station with soft keys can receive UUS: it can be consulted during the conversation by pres-
sing the "Msg" soft key.

- Malicious call identification is not available to stations behind a private network
- Malicious call identification cannot be requested after a call transfer or suspension.
- The user is informed by the network of the reason for the rejection of a malicious call identification

request.
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KEYPAD DIALING FEATURES

In certain countries, the public ISDN operator provides services that can be activated using the ETSI 
ETS 300 122 protocol (in addition to these generic services, each public operator defines how these 
services are handled in their national specifications). 

To access these services, the system establishes transparent communications between the public ex-
change and the internal users, who can then key in codes and receive a response from the public ex-
change.
This service is available with all station types on an Alcatel OmniPCX system directly connected to the 
public exchange (not through a private network).

To activate the service:

- with the station in idle, dial the ISDN trunk group seizure code 
- press * or #
- dial the service code (22 digits maximum) or press a key programmed with this code. The response

from the public exchange is displayed for 5 seconds.

configuration

- To activate the service at system level:

- by MMC-PM5 (Expert View):
- by MMC-Station: Global -> KeyPad 
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VN7 COMPATIBILITY 
This section lists the compatibilities between Alcatel OmniPCX Office and version VN7 of the French 
ISDN network (RNIS).

BASIC CALLS

Basic calls (incoming and outgoing) are supported on the S0 and T0/T2 accesses.

COMPLEMENTARY SERVICES

The compatibility of complementary services varies according to whether the service is required on the 
user side (S0) or on the network side (T0/T2)

Service S0 side compatibility T0/T2 side compatibility 

AOC-E
Advice Of Charge at the 
End of the call

YES NO

AOC-D
Advice Of Charge Du-
ring the call

YES YES

CLIP
Calling Line Identifica-
tion Presentation

YES YES

DDI
Direct Dialing In

YES Not applicable

MSN
Multiple Subscriber 
Number

YES (in Point to Multipoint) YES

TP
Terminal Portability

Not applicable YES (locally, on the same access)

SUB
Sub-Address

YES (limited to 4 digits) YES (limited to 4 digits)

CW
Call Waiting

NO NO

HOLD NO YES
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MCID
Malicious Call Identifi-
cation

YES (Reflexes and S0 terminals) YES

UUS1
User to User Signaling

YES (limited to 32 characters) YES (limited to 32 characters)

CFB
Call Forwarding on 
Busy

NO NO

CFU
Call Forwarding Un-
conditional

YES (in Point to Point) YES

CFNR
Call Forwarding on No 
Reply

NO NO

CD
Call Deflection

YES (in Point to Multipoint) NO

CCBS
Call Completion on 
Busy Subscriber

YES (in Point to Point) NO

3PTY
3 Party conference

NO NO

ECT
Explicit Call Transfer

NO NO

CNIP
Caller Name Identifica-
tion Presentation

NO NO
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CCBS – COMPLETION OF CALLS TO 
BUSY SUBSCRIBER 
DESCRIPTION

CCBS - Completion of Calls to Busy Subscriber - is a complement of the ETSI service provided by the 
system on T0/T2 public exchange connections.

This function can be considered like an extension of the "Automatic call back on busy set" service. CCBS 
requires a service subscription with the operator offering this function and can be activated equally well 
for an incoming call as for an outgoing call.

CONFIGURATION

CCBS on outgoing call: authorize the set to use the service or not:

CCBS on incoming call: check the following settings:

Modify (or not) the timeout during which the CCBS is active in the system (30 minutes by default);
at the end of the timeout, the CCBS is cancelled:

- by MMC-PM5 (Expert View):Subscribers/Basestations List -> Subscribers/Basestations List -
> Details -> Features -> "Callback"

- by MMC-PM5 (Expert View):External Lines -> Incoming Call Handling -> Public Line -> On
Busy = Release System Misc. -> Feature Design -> Call Waiting/Automatic Camp-On
(not selected)

- by MMC-Station: 
 IncCal -> Public -> Busy -> ReacPu -> Release
 Global -> CalExt -> Mode (Ext Call Waiting YES / No)

- by MMC-PM5 (Expert View):  System Miscellaneous -> Memory Read/Write -> Timer La-
bels -> "BookBusTim"

- by MMC-Station: Global -> Rd/Wr -> Timer -> "BookBusTim" -> Return -> Memory
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Modify (or not) the timeout during which the party requesting a CCBS on an outgoing call is rung
(25 seconds by default); at the end of the timeout the CCBS is cancelled:

CCBS ACTIVATION/CANCELLATION ON OUTGOING CALLS

When a call is made to a public network user B whose line is busy, CCBS enables a user A with an 
Alcatel OmniPCX Office system to leave a call back request at the public exchange. When the public 
exchange informs the Alcatel OmniPCX Office system that B is free, Alcatel OmniPCX Office calls back 
A, and when A answers, it makes an automatic call back to B.

Attention :

Only one automatic call back request can be activated on a set: automatic call back to busy set, auto-
matic call back to busy trunk or CCBS. Any new CCBS request cancels the previous one.

CCBS ACTIVATION/CANCELLATION ON INCOMING CALLS

When a public network user (A) calls a busy Alcatel OmniPCX Office system set (B), A can activate the 
CCBS service provided by the public exchange. When the Alcatel OmniPCX Office system informs the 
public exchange that B is free, the public exchange calls back A, and when A answers it makes an 
automatic call back to B.

- by MMC-PM5 (Expert View):  System Miscellaneous -> Memory Read/Write -> Timer La-
bels -> "BookRecTim"

- by MMC-Station: Global -> Rd/Wr -> Timer -> "BookRecTim" -> Return -> Memory

All stations (inclu-
ding Z)

Without display (≠ Z) With display, no soft 
keys

With soft keys

CCBS request Automatic call back re-
quest code

P.K.: Automatic call-
back request

P.K.: oCback S.K.: oCback

CCBS cancellation Cancellation prefix P.K.: Cancel callback P.K.: nCback S.K.: nCback, before 
or during callback

Type of station

Type of service
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ADDITIONAL INFORMATION

- CCBS cannot be activated on incoming calls to a group, or to a set with call forwarding activated
- CCBS is deactivated automatically in the following cases:

• CCBS on outgoing call:
• expiry of the timeout during BookRecTim; 25 seconds by default
• expiry of the BookBusTim timeout; 30 minutes by default
• expiry of the public exchange timeout T-CCBS6 (timeout during which the public exchange user

must free the line; 60 minutes)
• CCBS on incoming call:
• expiry of the BookBusTim timeout; 30 minutes by default
- expiry of the public exchange timeout T-CCBS5 (timeout during which the public exchange user

must free the line; 60 minutes)
- There is no second call back attempt if the line is busy when the CCBS call back is made. The CCBS

request is cancelled; another request can be made.
- A CCBS can be cancelled during the CCBS initiator call-back phase.
- CCBS is only available on the ISDN accesses of an Alcatel OmniPCX Office system; the service is

not available on a "slave" system accessing the network by break-out.
- CCBS is not supported by the T0 basic accesses configured in Point-to-Multipoint mode.
- A CCBS call-back cannot be intercepted.
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SPECIFIC FEATURES OF SO STATIONS
DESCRIPTION

The PABX provides the following services for S0 stations:

- suspension, which consists in suspending an internal or external communication in progress on a
basic access and picking it up later from the same S0 station relocated on the basic access or ano-
ther S0 station connected to the same basic access. The communication can be identified by a code
before being suspended. This code is used to locate the call.

- call waiting, which enables an S0 station to be informed that an external call is intended for it even
if no B channel is available on its basic access. The S0 station can ignore, reject or accept the call.

- malicious call identification subscription so that the network operator can be asked to record the
caller's identity during the communication or for a programmable time after going on hook.

- forwarding of calls on no answer, enables the internal and/or external calls to be routed to the
programmed destination.

CONFIGURATION

To modify the default maximum suspension time-out – MMC-PM5 (Expert View) only:

To authorize or inhibit camp-on on S0 stations – MMC-PM5 (Expert View) only:

To modify the maximum time-out, after going on hook, for requesting recording of the caller's iden-
tity – MMC-PM5 (Expert View) only:

System Miscellaneous -> Feature Design -> Part 3 -> "Suspension"

System Miscellaneous -> Feature Design -> "Call Waiting/Automatic camp-on"

External Lines -> Protocols -> ISDN Trunk -> Layer 3 -> "T305 Disconnect Supervision"
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ACTIVATION/USE

Activation of the various services depends on the S0 station ; refer to the station user guide.

cancellation

Cancellation of the various services depends on the S0 station; refer to the station user guide.

ADDITIONAL INFORMATION

- A communication which is suspended and not retrieved after expiry of the suspension time-out is
released if internal and re-routed to the general level (see "Operator Stations") if external.

- A user cannot suspend a call if he or she already has a correspondent on hold.
- The user who suspended a call is charged for the entire communication, before suspension and

after retrieval.
- The number of calls suspended simultaneously is limited and depends on the size of the cabinet.
- Call waiting on an S0 station is limited by a non-modifiable time-out.
- The number of calls waiting on the same access is limited to 2.
- Malicious call identification cannot be requested after a call transfer or suspension.
- The user is informed by the network of the reason for the rejection of a malicious call identification

request.
- Apart from the caller's identity, the network records the time of identification request activation and

the number dialed by the caller.
- Multiple directory numbers: when an S0 option (Reflexes stations) is initialized, the system assigns

1, 2 or 3 directory numbers, depending on the country. With PM5, you can:
• add users for the S0 option (individually or in groups), up to the system capacity. There is no

automatic renumbering after adding users, so the installer should be careful to preserve the
coherence of the numbering plan;

- delete individual users (NB: the first user of an option cannot be deleted separately; deleting
the first user erases all the other users of the same option).
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8 DIGIT NUMBERING PLANS

Station and hunting group call numbers, as well as collective speed dial numbers, can have up to 8 
digits.

STAR NUMBERING

To use a 2, 3 or 4-figure default numbering plan, you can choose between a country-specific numbe-
ring plan or a generic numbering plan in which most codes (service codes or Features in Conversation) 
start with *; this structure provides several ranges for allocating DDI numbers to sets.

The default star numbering plans are described in the following pages.

Configuration

To select the default numbering plan:

Notas : The default numbering plan can also be selected using PM5 EasyView once the system is 
running.

- by MMC-PM5 (Expert View): Numbering -> Default Numbering Plan
- by MMC-Station: NumPln -> Nbdigi
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Codes common to all countries

Internal numbering plan

Functions 2-digit 3-digit 4-digit

Cancel all forwardings #21 #21 #21

Cancel "follow me" forwarding #27 #27 #27

Immediate call forwarding * 21 * 21 * 21

Forward on busy * 22 * 22 * 22

Do Not Disturb * 23 * 23 * 23

Forward to pager * 24 * 24 * 24

Group call forwarding * 25 * 25 * 25

Disconnect from group * 26 * 26 * 26

Rejoin the group # 26 # 26 # 26

Follow-me * 27 * 27 * 27

Selective forwarding * 28 * 28 * 28

Cancel callback # 5 # 5 # 5

Voice Mail Unit (secret code) **6 **6 **6

Voice Mail Unit (secret code) *#6 *#6 *#6

Redial last number **0 **0 **0

Room status * 70 * 70 * 70

Lock/unlock * 71 * 71 * 71

Appointment reminder (prog.) * 72 * 72 * 72

Protect against intrusion * 73 * 73 * 73

Replace set * 78 * 78 * 78

Move set * 79 * 79 * 79

Individual call pick-up * 81 * 81 * 81

Pick up group * 82 * 82 * 82

General Call Answer * 83 * 83 * 83

Parked call retrieval * 84 * 84 * 84

Programming mode * 87 * 87 * 87

Text mail * 88 * 88 * 88

Group broadcast * 01 to *08 * 01 to *08 * 01 to *08

Subscriber calls 10 to 79 100 to 799 1000 to 7999
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Feature code table

Seize secondary trunk groups * 50 to *53 * 500 to *534 * 500 to *534

Hunting Group calls * 54 to *59 * 540 to *565 * 540 to *565

Collective speed dial 8000 to 8999 8000 to 8999 8000 to 8999

 Consulting camped calls * 9 * 9 * 9

Trunk line allocation #11 to #17 #11 to #17 #11 to #17

Trunk allocation + MTR #21 to #27 #21 to #27 #21 to #27

Call Parking * 84 * 84 * 84

Malicious call identification * 89 * 89 * 89

Cancel enquiry * 1 * 1 * 1 

Shuttle * 2 * 2 * 2

Conference * 3 * 3 * 3

Intrusion * 4 * 4 * 4

Automatic callback request * 5 * 5 * 5

DTMF end-to-end signaling * 6 * 6 * 6

Main PABX recall (calibrated loopbreak) * 7 * 7 * 7
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Country specific

Operator call and main trunk group seizure

Different codes for operator calls and for seizing the main trunk group apply in each country. This re-
sults in different ranges of subscriber numbers.

Country OS call Seize trunk 
group

2/3/4-digit subs-
criber 

Paging type

Austria 10 0 11/110/1100 prefix

Australia 9 0 10/100/1000 prefix

Belgium 11 0 12/120/1200 suffix

Switzerland 11 0 12/120/1200 prefix

Germany 10 0 11/110/1100 prefix

Denmark 9 0 10/100/1000 prefix

Spain 9 0 10/100/1000 suffix

Finland 9 0 10/100/1000 suffix

France 9 0 10/100/1000 suffix

Britain 0 9 10/100/1000 suffix

Greece 10 0 11/110/1100 prefix

Ireland 10 0 11/110/1100 prefix

Italy 9 0 10/100/1000 prefix

Netherlands 9 0 10/100/1000 prefix

Norway 9 0 10/100/1000 prefix

Portugal 9 0 10/100/1000 prefix

Sweden 9 0 10/100/1000 prefix

SMBI 10 0 11/110/1100 prefix
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Paging type

Paging can be by prefix or by suffix.

Paging by prefix: the internal numbering plan has to have 2 codes: one for the "Prefix Paging Activa-
tion" function and one for the "Paging Answer Selective" function.
Paging by suffix: a "paging answer general " code is added to the internal numbering plan and a "suffix 
paging activation" code is added to the features plan.

Paging by suffix: Internal numbering plan entries

Paging by suffix: features plan entries

Paging by prefix: internal numbering plan entries

Function 2-digit 3-digit 4-digit

Answer paging general * 85 * 85 * 85

Function 2-digit 3-digit 4-digit

Suffix paging activation * 86 * 86 * 86

Function 2-digit 3-digit 4-digit

Answer paging selective * 85 * 85 * 85

Prefix paging activation * 86 * 86 * 86
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ALTERNATIVE CLIP AND COLP 
NUMBERS
CLIP and COLP are services that depend upon the public network (France: COLP is not provided)

These functions are provided by Alcatel OmniPCX Office systems connected to a public ISDN network 
(T0/T2 access).

Definitions

CLIP (Calling Line Identification Presentation): identification number sent by the caller when making 
an outgoing ISDN call.

COLP (Connected Line Presentation): identification number returned by the called party to the caller.

ALTERNATIVE SYSTEM CLIP

Description

This function is used to configure the calling number (CLIP) sent to correspondents on outgoing ISDN 
calls. For example, it enables a company with several sites always to send the same number to external 
called parties.

On an outgoing external call, the number transmitted is:

- the installation number completed by the DDI number of the caller (or the Operator Group num-
ber), if the "Alternative CLIP number" is not configured.

- the "Alternative CLIP number", if configured.

Without "Alternative CLIP number" With "Alternative CLIP number"

Installation number: 9125-5833
Alternative system CLIP : 0800111000

Public Network

DDI number: 111

T0/T2

Calling line number
(CLIP): 0800111000

Installation number: 9125-5833
Alternative system CLIP : none

Public Network

DDI number: 111

91255833111

T0/T2

Calling line number(CLIP)
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Configuration

Configure the Alternative system number (22 digits maximum according to ISDN protocol):

ALTERNATIVE CLIP/COLP NUMBERS

Description

This function enables CLIP/COLP numbers other than the users' DDI numbers (or Operator Group 
number if a DDI number has not be specified for this set) to be sent. 

Thus with a group of sets it is possible to configure CLIP/COLP numbers with the DDI number of the 
group, and therefore to call the group rather than a specific set in the group. 

Without personalized CLIP/COLP number           With personalized CLIP/COLP number

Configuration

Configure the alternative CLIP/COLP number for each set (4 digits maximum) – MMC-PM5 (Expert
View) only:

Additional Information

- Simultaneous alternative system CLIP and alternative CLIP/COLP numbers: in this case, the alter-
native system CLIP is used whether or not there is an alternative CLIP/COLP number already defi-
ned.

- by MMC-PM5 (Expert View): Numbering -> Installation Numbers -> Alternative System
CLIP

- by MMC-Station: Global -> InsNum -> AltCLI

Subscribers/Basestations List -> Subscribers/Basestations List -> Details ->Misc. ->Alterna-
tive CLIP/COLP number 

CLIP/COLP number:
9125583999

Installation number: 9125583
Personalized CLIP/COLP number: 999

Public network

T0/T2

DDI number: 111
Installation number: 9125583

Personalized CLIP/COLP number: none

Public network

DDI number: 111

CLIP/COLP number
9125583111

T0/T2
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BUSY GREETING ON VOICE MAILBOX 
DESCRIPTION

This feature makes it possible to immediately route an external incoming call to the called party's voice 
mailbox if the line is busy (Busy degree 1 or degree 2). The caller hears a specific welcome message 
and can, if he/she wishes, leave a message in the called party's voice mailbox.

Dynamic routing to the voice mailbox is immediate even when the dynamic routing timer is configured.

The service is activated if there is an incoming call to a busy set and:

- for all the sets if the "DynRoutBsy" flag = 1
- or if "DynRoutBsy" = 0, but only on the sets that have access to this function

CONFIGURATION

To globally activate the service, or not:

0: service inactive
1: service active; all incoming calls to a busy user are immediately forwarded to the called party's 
voice mailbox
To activate the service or not, set by set – MMC-PM5 (Expert View) only:

Configuring the VMU grouping as Level 1 called party in the case of dynamic routing

- by MMC-PM5 (Expert View):
 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "DynRoutBsy"

- by MMC-Station:
 Global -> Rd/Wr -> Address -> "DynRoutBsy" -> Return -> Memory

Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Dyn. Rout.

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Dyn. Rout.

- by MMC-Station: Subscr -> DynRou.
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ADDITIONAL INFORMATION

Summary table

Call forwarding

Routing to a voice mailbox is not performed if the user called has programmed the forward function 
on his/her set. The service becomes valid when the forward function is cancelled.

Forward on busy

If the user has programmed his/her voice mailbox as the destination of Call forwarding on busy, the 
internal or external caller will also hear the message.

Default value

After a cold reset, the "DynRoutBsy" flag is set to 0 (service inactive) by default and set-by-set activation 
is cancelled (active in France). 

Attention :

The mechanism is also active if the destination of T1 dynamic routing is a set instead of the VMU. In 
this case, the destination of dynamic routing will be rung immediately if the set called is busy.

There is no indication of service activation on the sets.

Service active (flag DynRoutBsy = 1) Service inactive (flag 
DynRoutBsy = 0)Called party busy Called party free

Routing to voice mail-
box

IMMEDIATE NO NO

Level 1 dynamic routing Does not start T1 timer T1 timer

Level 2 dynamic routing Does not start T2 timer T2 timer
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MAKING/ANSWERING A CALL
DESCRIPTION

A call can be either:

- internal, or
- external.

MAKING A CALL

Only an internal call can have 3 types of destination:

- a station
- a station in a Hunting Group (operator or stations)
- all the stations in a Broadcast Group, in the case of a broadcast call

To make a call, the user can either choose to go off hook first (obligatory if the station does not have 
a loudspeaker) or not.

Then, depending on the user's station, an internal or external call can be made either by:

- manual dialing:
• on the numeric keypad, or
- on the alphabetic keypad (Dial by name function:: this concerns the numbers programmed

in the internal directory or collective speed dial list)
- pre-recorded dialing:

• direct call key 
• repetition of last number (Redial) function ; the last number emitted by the station is automa-

tically memorized with its corresponding sub-address
• transmission of the number stored in the temporary memory; the last number transmitted from

a station can be transferred from the "Redial" memory to a "temporary memory"
• transmission of a personal speed dial number
• call back a number in the directory of unanswered calls:: this directory contains the

unanswered external calls, with or without User to User Signaling (see "ISDN Services") and the
internal calls with UUS (see "ISDN Services") automatically memorized by the system. 

• for external calls only, transmission of a collective speed dial number  (including emergency
numbers and collective speed dial numbers with speed dial rights = 0: see "Link Categories"
file) created by MMC. 

- for external calls only, transmission of an emergency number - one of 5 factory preset num-
bers which cannot be modified by MMC. These numbers are different from those programmed
as collective speed dial numbers.
Ed. 04 1/6Réf. 3EH 21000 BSAA



MAKING/ANSWERING A CALL CALL SERVER : TELEPHONE FEATURES

 

When making a call, the user can:

- protect the call protect this call (in particular data communications) against the camp-on tone and
third party intrusion (see "Camp-on on busy station or group" and "Intercom intrusion on free").
These measures can be programmed for each station and for all calls.

- opt not to disclose the caller's identity; this "Calling line identification restriction"can be activated
permanently by programming it into each station for all calls, or it can be activated call by call,
using a programmed key.

Auto. call setup on going off hook: this service enables an authorized user to call a correspondent 
pre-programmed by MMC, simply by going off-hook or pressing the Handsfree key, either immedia-
tely or after a time-out. The destination can be:

- an internal user (individual)
- a Hunting Group or Operator Group,
- an external user (by collective speed dial number)

Broadcast call: this service enables an "emitting" user belonging to a Broadcast Group to send a spo-
ken message lasting no more than 20 seconds to the free stations in this group equipped with a louds-
peaker. The destination stations are unable to answer this message.

RECEIVING A CALL

An incoming call is signaled by ringing of the station. The ringing rate varies according to whether the 
call is internal or external.

A monoline station (see "Resource keys") can only receive one call at a time. The user of this type of 
station can only answer this call by going off hook.

A multiline station (see "Resource keys") can take several calls at once. The answer mode can be:

- manual: the user can select the call he wishes to answer and even ignore all incoming calls if he
wishes to make a call

- a hotline call: the system determines what type of call is at the station (see "Answering camped-on
calls")

- auto-answer or Intercom mode (on a set with the Hands-Free feature and for internal calls only):
the station "answers" the call with the highest priority after a specific ring tone, and goes into hands
free mode (see also "Headset Features").
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CONFIGURATION

To specify whether or not to authorize the "Automatic call setup on going off hook" feature for each
station:

If the "Automatic call setup on going off hook" feature is authorized, define whether the call is im-
mediate or after a time-out and define the call destination for each station:

To modify the default time-out for the "delayed" automatic call setup on going off hook – MMC-
PM5 (Expert View) only:

To create the personal speed dial numbers for each station:

To create the collective speed dial numbers:

To create the internal directory:

For each station, all calls can be protected against intrusion and the camp-on tone:

- by MMC-PM5 (Expert View):Subscribers/Basestations List -> Subscribers/Basestations List -
> Details -> Misc. -> Hotline

- by MMC-Station: Subscr -> AutoCa -> Active

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> Hotline

- by MMC-Station: Subscr -> AutCa -> Temp

System Miscellaneous -> Feature Design -> Part 3 -> "Timer for delayed Automatic Call Se-
tup" (hotline)"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Pers. SPD

- by MMC-Station: Subscr -> PerSpd
- by customization: PerSpd

- by MMC-PM5 (Expert View): Collective Speed Dial
- by MMC-Station: ComSpd

- by MMC-PM5 (Expert View):  Directory
- by MMC-Station: Global -> Name

- by MMC-PM5 (Expert View):Subscribers/Basestations List -> Subscribers/Basestations List -
> Details -> Features -> "Intrusion Protection" and "Warntone Protection"
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For each station, the caller's identity can be restricted for all communications:

To create the Broadcast Groups:

Broadcast on external loudspeaker:

This feature is not controlled by a software key. To realise this feature, the system must be fitted 
with an AFU daughterboard on the CPU/CPUe board (the hardware can be check via PM5 menu 
-> Main CPU -> Details -> Daughterboards):

• In the Broadcast Groups menu, select one group and press Details.
• Press Add to add memebers into the group. If the system is equipped with a AFU daughter-

board, we will find Loudspeaker subscriber in the list.

- Add Loudspeaker subscriber with attribute Receive or Send/Receive and all other subscri-
bers allowed to make/receive the broadcast message.

The ringing time-out before going to hands free mode when intercom is activated can be modified
using MMC-PM5 Expert View (only):

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

ACTIVATING THE SERVICES

- by MMC-PM5 (Expert View):Subscribers/Basestations List -> Subscribers/Basestations List -
> Details -> Features -> "Identity Secrecy"

- by MMC-PM5 (Expert View): Broadcast Groups
- by MMC-Station: Groups -> Broadc

System Miscellaneous -> Feature Design -> Part 3 -> "Time before connection without 
headset"

Z Without dis-
play (≠ Z) 

and without 
Hands-Free 

feature

Without dis-
play (≠ Z) but 
with Hands-
Free feature

4011 With display, 
no soft keys, 
except 4011

With soft 
keys

Intercom mode -- -- P.K.: AutAns -- F.K.: Inter-
com, or P.K.: 

AutAns

F.K.: Auto-
answer 

mode (inter-
com mode)

Communication protection Prefix F.K.: Data or P.K.: ProCom

Identification restriction -- P.K.: CLIR F.K.: ISDN + 
S.K.: Secret

Transfer to temporary memory -- P.K.: Temporary number P.K.: TmpRep S.K.: NbSave

Type of service

Type of station
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ANSWERING A CALL

MAKING A CALL

Z Without dis-
play (≠ Z) 

and without 
Hands-Free 

feature

Without dis-
play (≠ Z) but 
with Hands-
Free feature

4011 With display, 
no soft keys, 
except 4011

With soft 
keys

In manual mode -- Press the resource key

In automatic mode Go off hook Go off hook Off hook or 
press F.K.: 
Handsfree

Go off hook Off hook or press F.K.: Hands-
free

In intercom mode -- Automatic 
connection

-- Automatic connection

Z Without dis-
play (≠ Z)

DECT With display, no soft keys With soft 
keys

Auto. call setup on going off 
hook

Go off hook Go off hook 
or press F.K.:  

Handsfree

Go off hook Go off hook or press F.K.:  Handsfree

Dial by name -- -- F.K.: Dial by 
name, then 
enter name, 

then F.K.: OK

P.K.: Dirtry, then enter name, 
then F.K.: LS or Mute to confirm 

Enter the na-
me, then "Re-

turn"

Redial Prefix F.K. or P.K.: 
Redial

F.K.: Redial S.K.: Redial

Temporary memory -- P.K.: Personal 
speed dial + 
P.K.: Tempo-
rary number

F.K.: Personal speed dial + P.K.: TmpRep S.K.: NbSend

Personal speed dial numbers -- P.K.: Personal 
speed dial + 
index 0 to 9

F.K.: Personal speed dial + index 0 to 9 F.K.: Personal 
speed dial + 
S.K. associa-
ted with num-

ber

Non answered calls repertory -- F.K.: Mail + 2 
+ F.K.: OK

F.K.: Mail or P.K.: TxtMsg + 2 
+ F.K.: LS

F.K.: Mail + 
S.K.: Text + 
S.K.: Read + 

S.K.: Call

Collective speed dial numbers 
(including emergency numbers)

Prefix

Emergency numbers not belon-
ging to the common speed dial 

numbers

Dial the emergency number

Broadcast call Broadcast 
Group num-

ber

P.K.: Direct call

Type of service

Type of station

Type of service

Type of station
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ADDITIONAL INFORMATION

- To use the directory of unanswered calls in a parallel group of stations (see "Hunting Groups"), the
first station in the group, on creation by MMC, must be a station with a display.

- In "Answering a call: manual connection" mode, an automatic callback or a hold reminder have
priority: the user cannot answer another call.

- During group broadcasting, all the stations involved are considered to be busy.
- To stop broadcasting to his own station, a user can go off hook or press the "Release" key.
- A forwarded station receives the broadcast message.
- If all members of the called Broadcast Group are busy, the broadcast call will be unsuccessful.
- The first Z station is considered as a fax and is therefore protected by default against intrusion and

the camp-on tone.
- Specific to Brazil: The DDC Protection flag (Subscribers/Basestations List -> Details -> Features

(part 2)) rejects all incoming calls which the caller tries to charge to the called party.
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PRIORITY CALLS 
DESCRIPTION

2 types of priority call can be made: 

- a call from a bank alarm system
- a voice call (or a call through a preprogrammed key)

Call from a bank alarm system (automatic call)

The bank alarm device is connected to the PABX by means of an SLI-board Z interface.

The call is triggered by the Z subscriber going off-hook.

The external destination is called using a collective speed dial number. The call is subject to checks on 
barring and traffic sharing link categories as well as collective speed dial rights (see "Link Categories").

The call takes priority over ordinary calls in progress. If all lines are busy, the system releases an ordi-
nary call in order to set up a priority call.

Call from a programmed key (manual call)

The call destination (collective speed dial number or external number) is associated with a program-
med key on a Reflexes or DECT terminal. 

Priority levels are defined to ensure that an automatic or manual call cannot cut off a higher-level call.
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CONFIGURATION

To declare the bank alarm system:

Define whether the call is a hotline call or normal:

Define the destination for the automatic call:

To activate or inhibit metering:

Modify the bank alarm device's default speed dial rights, if necessary:

Modify the default barring link categories, if necessary:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> "Special Function = Bank Alarm"

- by MMC-Station: Subscr -> SpeDev -> Choice -> Bank Alarm

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> "Hotline"

- by MMC-Station: Subscr -> AutoCa -> Active

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> "Hotline" -> "Destination n°"

- by MMC-Station: Subscr -> AutoCa -> Desti

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Metering

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Collective Speed Dial

- by MMC-PM5 (Expert View):
• for the bank alarm device: Subscribers/Basestations List -> Subscribers/Basestations

List -> Details -> Barring
- for the trunk groups: External Lines -> Trunk groups -> Details -> Link-Cat

- by MMC-Station:
• for the bank alarm device: Subscr -> BarTyp
- for the trunk groups: TrGp -> Catego
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Modify the default traffic sharing link categories, if necessary:

To create a priority call key:

Define the priority level (0 to 7 with 7 = highest priority):

- by MMC-PM5 (Expert View):
• for the users: Subscribers/Basestations List -> Subscribers/Basestations List -> Details

-> Barring
- for the trunk groups: External Lines -> Trunk groups -> Details -> Link-Cat.

- by MMC-Station:
• for the users: Subscr -> BarTyp (last 2 values)
- for the trunk groups: TrGp -> Catego (last 2 values)

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys = Priority Call

- by MMC-Station: Subscr -> Keys

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc.

- by MMC-Station: Subscr -> Prio
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PRIORITY CALL MADE BY A USER

ADDITIONAL INFORMATION

- The bank alarm device cannot be connected to a Z interface behind a Reflexes station.
- Several priority calls can be set up simultaneously
- A priority call may fail if the public exchange is saturated, if the destination is busy or if it collides

with an incoming call during the "setup" phase.
- The event "R_PRIORITY_CALL" – specifying the number of the station on which the call was released

– is generated in the PABX history table whenever a call is released to make way for a priority call.
- The bank alarm device's directory number cannot be a private one.
- To avoid the system releasing a basic call on a B channel belonging to the trunk group assigned

to the bank alarm device, when a B channel is free in another trunk group, it is advisable to con-
figure all the accesses on a single trunk group.

- All calls made from an S0 terminal are considered as priority calls if a priority level >0 is defined

Is there a free
channel in the trunk
group assigned to
the alarm device 

Priority call
The system looks for a B 

channel to release (*) 
NO

YES Search for busy B
channel with lowest

priority
Can one of the B 

channels be 
released?

NO

YES

The system releases the 
communication (**)

Is the release 
request accepted 
by the network?

YES

NO

The system waits for the 
call to be released by the 

network
The priority call is set  up

Call failure

Busy channel B 
found with low 

priority

NO

YES

(*) only a basic call (i.e. not a call which is on hold or camped on, nor a call which is engaged in a three-party call, etc...).

(**) the released line cannot be assigned to a user who has left an automatic call-back request on a busy trunk group

The trunk group can also include analog lines (TL)
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CAMP-ON ON BUSY STATION OR 
GROUP
DESCRIPTION

A user is automatically camped-on on the station he is calling when the following conditions are met:

- it is busy, in other words in conversation with a correspondent
- it has at least one resource free (see "Resource keys" file)
- it is not protected against camp-on
- the caller is authorized to camp-on

A user is automatically camped-on on a Hunting Group which he is calling when the following condi-
tions are met:

- it is in "setup" mode (see "Hunting Groups").
- all the stations in the group are busy, i.e. in conversation with a correspondent
- at least one of the stations in the group has a free resource (see "Resource keys" file)
- the stations in the group are not protected against camp-on
- the caller is authorized to camp-on

A caller camped-on can:

- release the call, possibly leaving a text message (see "Text mail/Call back request")
- leave an automatic callback request with the called party, if the station supports
- intrusion into the existing conversation, if the caller is authorized and if the station is not protected

against intrusion
- transfer his correspondent if on-hold (see "Conference")
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CONFIGURATION

To specify whether or not to protect a station against camp-on:

To specify whether or not to protect a station against the camp-on tone:

To specify whether or not to authorize camp-on for a station:

To specify whether or not to protect a station against intrusion:

To specify whether or not to authorize intrusion for a station:

To specify whether or not to authorize a station to leave an automatic call back request:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Camp-On Protection"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Warntone Protection"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Camp-On Allowed"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Intrusion Protection"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Intrusion Allowed"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Callback"
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

(*) When the called party becomes free, the station which requested call back is rung. If it goes off 
hook, the called party station rings in turn.

CANCELLATION

Prefix: Code programmed in the internal numbering plan

(**) The automatic call back request is also cancelled if:

- the person requesting call back does not go off hook within 15 seconds or presses the "Release"
key during these 15 seconds

- the called station does not release within 30 minutes.

All stations including 
Z

Without display (≠ Z) With display, no soft 
keys

With soft keys

Automatic call back request (*) Function code P.K.: Automatic call-
back request

P.K.: oCback S.K.: oCback

Intrusion Function code P.K.: Intrusion P.K.: Intru S.K.: oIntru

All stations including 
Z

Without display (≠ Z)  With display, no soft 
keys

With soft keys

Automatic call back (**) Prefix P.K.: Cancel callback P.K.: nCback S.K.: nCback, before 
or during callback

Intrusion Activation code P.K.: Intrusion P.K.: Intru S.K.: nIntru

Type of service

Type of station

Type of service

Type of station
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ADDITIONAL INFORMATION

- When camp-on is allowed and the called party is not protected against the camp-on tone, the cam-
ped caller hears the camp-on tone and the called party hears a single beep every 20 seconds.

- If the automatic call back request is accepted, the user hears the dial tone if he is off hook and
switches to the idle status in hands-free mode.

- An authorized station can only request a single automatic call back at a time.
- A station can only receive a single automatic call back request at a time.
- A call back request does not follow a call forwarding.
- The identity of the intruding station is displayed on the stations which are already in conversation. 
- Intrusion is refused (the user then remains camped-on) if:

• the called party is in a conference call
• the called party is intruding on another conversation
- at least one of the stations is protected against intrusion

- An operator station always has the authority to camp on and to intrude.
- When the user intrudes while having a correspondent on hold, he returns to this correspondent by

canceling the intrusion then going on hook and returning to the call on hold.
- The first Z station is considered as a fax and is therefore protected by default against intrusion and

the camp-on tone.
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ANSWERING CAMPED-ON CALLS
DESCRIPTION

When one or more callers (if the station has the necessary resources) are camped on a subscriber (see 
"Camp-on on busy station or group"), the subscriber can either:

- consult the identity of the camped callers, if the station has soft keys
- answer (consult) one or more camped-on calls, without releasing the current communication, or
- answer a camped-on call by releasing its current communication. In this case, the system determi-

nes which camped-on call is presented to the station according to the priority of the calls camped-
on.

The level of priority depends on three criteria:

- the type of caller: internal, external or OS (for example, if a station has a caller camped on but has
no resources left, an OS call "breaks" the first camp-on and is itself camped on)

- the type of called party: Operator Group, Hunting Group or station
- the type of call: simple call, recall (for example after transfer failure, see "Conference") or hold re-

minder

The system allocates the following descending order of priority:

- external hold recall, delayed or otherwise
- internal hold recall, delayed or otherwise
- external callback
- external call
- internal callback
- call from an operator station
- internal call
- Operator Group call
- Hunting Group call

CONFIGURATION

To specify whether or not to protect a station against camp-on:

To specify whether or not to protect a station against the camp-on tone:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Camp-On Protection"

- by MMC-PM5 (Expert View):Subscribers/Basestations List -> Subscribers/Basestations List -
> Details -> Features -> "Warntone Protection"
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To specify whether or not to authorize camp-on for a station:

ACTIVATION/USE

S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

(*) "Manual" answering of a camped-on caller entails exclusive hold (see "Three-party calls" file) of the current communication.
(**) When the identity of the caller to be consulted is displayed.

CANCELLATION

(*) In the first case, the caller is released and in the second, placed on exclusive hold.

ADDITIONAL INFORMATION

- A station which has activated paging or which is in a conference call (see "Conference") or intrusion
(see "Camp-on on busy station or group"), cannot answer a camped-on call.

- When consulting the identity of the camped-on callers, a station with soft keys can also consult the
User to User Signaling (UUS) of the caller (see "ISDN Services").

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Camp-On Allowed"

All stations including 
Z

Without display (≠ Z) With display, no soft 
keys

With soft keys

Consultation of camped-on cal-
ler identities

-- S.K.: Queue

Answer after consultation of 
identity (*)

-- S.K.: Answer(**)

Answer a camped-on call (*) Function code Resource key

All stations including 
Z

Without display (≠ Z) With display, no soft 
keys

With soft keys

Return to initial correspondent 
after consulting a camped-on 

caller

Enquiry or shuttle call 
cancellation code(*)

Resource key of correspondent on hold

Type of service

Type of station

Type of service

Type of station
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THREE PARTY CALLS
DESCRIPTION

3-party calls are:

- enquiry, prior to the following
- shuttle
- conference
- transfer

Enquiry/Hold

A station involved in an internal or external conversation can make a new internal or external call using 
either:
- one of the means described in "Making/Answering a call"
- or by answering a camped-on call (see "Camp-on on busy station or group")
- or by picking up a call intended for another station (see "Call Pick-Up" and "Call Parking/Parked

Call Retrieval")

The current correspondent is automatically placed on hold by the system. This type of hold is said to 
be "exclusive" because only the user which activated it can retrieve the correspondent.

A user can place a correspondent on exclusive hold when:
- he is in conversation with the correspondent
- he has called the correspondent and hears the ringing tone
- he has called the correspondent and hears the camped-on tone

"Manual" call holding is also possible. In this case, it is said to be "common" because all the users su-
pervising the resource on hold can retrieve the correspondent (RSP resource only).

A user can only place a correspondent with whom he is in conversation on common hold.

Hold recall:When a user goes on hook with a correspondent on hold, the system recalls the user. This 
can be either immediate (overlooked hold) or time-delayed. When the hold recall is time-delayed, the 
user can make an outgoing call or answer an incoming call: the hold recall will take place at the end 
of the time-out or at the end of the new communication.

Shuttle

This service enables the user to speak alternately with his correspondent on line and a correspondent 
on hold.
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Conference

This service enables an authorized user in an enquiry call to set up a call with two correspondents si-
multaneously.

Transfer

This service enables a call to be setup between the correspondent on hold and the correspondent on 
line. This latter was not necessarily in conversation with the user! Transfer can take place either:

- after conversation with the second correspondent
- when the user hears the ringing tone (the second correspondent has not answered)
- when the user is camped-on on the second correspondent's station
- when the user has activated paging for this second correspondent (who has not answered)
- during the routing phase of the second call, after dialing an external number

CONFIGURATION

Choose between immediate or delayed hold recall:

To modify the implicit value of the delayed hold recall time-out:

For the system, specify whether or not the conference is authorized in the system and if it is, the type
of conference authorized:

To specify whether or not each station is authorized to take conference calls (by default , all stations
have this facility):

- by MMC-PM5 (Expert View): System Miscellaneous  -> Memory Read/Write -> Misc. Labels
-> "TimedHldEn"

- by MMC-Station: Global -> Rd/Wr -> Address -> "TimedHldEn" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Part 3 -> Duration
of Hold Recall Ringing

- by MMC-Station:
 Global -> Rd/Wr -> Timer -> "OnHoldTim" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Part 2-> Confer-
ence (prohibited, internal only or Ext & Int)

- by MMC-Station: Global -> Conf

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> Conference
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For the system as a whole, to authorize or inhibit the transfer of incoming or outgoing trunk lines
to an outgoing network line (be careful with subscriber rights and trunk group link categories):

To authorize transfer of an incoming or outgoing network line to an outgoing network line, for each
station:

To define the type of system reaction in the event of transfer failure (operator or initiator recall, also
called "transfer master"):

Modify the implicit value of the rerouting time-out at general level in the event of transfer failure:

Authorize connection of two external lines by transfer (connection matrix):

To specify whether or not to authorize transfer by going on-hook with a multiline station:

To specify whether or not to authorize Ext/Ext transfer (intersite transfers) by going on-hook with a
Z station:

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> "Transfer Ext/Ext"
- by MMC-Station: Global -> Joing -> Transf

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> Part 2 -> "Join Incoming and Outgoing" and "Join Outgoing
and Outgoing"

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> "Go to initiator if
transfer fails"

- by MMC-Station: Global -> MasRec -> Choice

- by MMC-PM5 System Miscellaneous -> Memory Read/Write -> Timer Labels -> "Transfe-
Tim"

- by MMC-Station: Global -> Rd/Wr -> Timer -> "TransfeTim" -> Return -> Memory

Traffic Sharing and Barring -> Joining

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Transfer by on
hook

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Transfer Ext/Ext
by on hook
Ed. 04 3/6Réf. 3EH 21000 BSAA



THREE PARTY CALLS CALL SERVER : TELEPHONE FEATURES

 

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

cancellation

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

Z Monoline (≠ Z) Without display 
and multiline

With display, no 
soft keys

With soft keys

Enquiry  F.K.: R + call Call

Exclusive hold Automatic on enquiry, shuttle or reply to a camped-on call

Common hold -- -- P.K.: Hold S.K.: Hold

Shuttle Function code Resource key

Conference Function code P.K.: Conference F.K. or P.K.: Conference S.K.: oConf

Transfer On hook F.K.: Transfer S.K.: Transf

Z Monoline Without display 
and multiline

With display, no 
soft keys

With soft keys

Enquiry Shuttle F.K.: R + Code 
Cancel enquiry

Code Cancel en-
quiry

F.K.: End + resource key of initiator

Common Hold Retrieval or Voi-
ce Transfer

-- -- Resource key

Conference, with return to con-
versation preceding the confer-

ence

Function code P.K.: Conference F.K. or P.K.: Conference S.K.: nConf

Conference, with release of 
both correspondents

-- On hook

Type of service

Type of station

Type of service

Type of station
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ADDITIONAL INFORMATION

- A correspondent on hold hears the please-wait music if external and the hold tone if internal. 
- It is impossible to place on hold:

• a network call in the routing phase
• a broadcast call
• an intrusion
- a paging call

- At hold recall, the user's station rings and if he does not answer before the expiry of the hold recall
time-out:
• the call is returned to the general level if external
- the call is released if internal

- A shuttle call is refused when the user has intruded into a conversation, or is involved in a confer-
ence or paging call

- A user cannot put another correspondent on exclusive hold when he hears the ringing or camp-on
tone, only to return to the first correspondent on hold

- If one of the stations involved in a conference goes on hook and is not the initiator of this confer-
ence, the remaining two correspondents stay in communication

- The system allows 3 simultaneous conferences
- The services attributed to the stations must be of the "telephone" type, otherwise holding may be

refused.
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INTERCOM INTRUSION 
DESCRIPTION

When an internal user calls another internal user who does not answer, he can force the destination 
station to switch to hands free mode, if it supports this function.

The intercom call ringing tune rings the destination station for a programmed length of time and the 
latter switches automatically to hands free mode.

Notas :

For the activation of the "Intercom" function, see "Making/Answering a Call".

CONFIGURATION

To specify whether or not to protect a station against intercom intrusion on free:

To specify whether or not to authorize a station to activate intercom intrusion:

To modify the duration for the intercom call ringer:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Intrusion Protection"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Intrusion Allowed"

- by MMC-PM5 System Miscellaneous -> Memory Read/Write -> Timer Labels -> "Auto-
AnsTim"

- by MMC-Station: Global -> Rd/Wr -> Timer -> "AutoAnsTim" -> Return -> Memory
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key

ADDITIONAL INFORMATION

- The "Intercom Intrusion on Free" or "Forced" programmed key can be replaced by a macro pro-
grammed key "Macro1 = direct call of an internal number + intercom intrusion on free on the cal-
led station".

- The right to intercom intrusion is the same as that for intrusion (see "Camp-on on busy station or
group").

Type of station Z Without display and 
multiline

With display, no soft 
keys

With soft keys

Activation of intercom intrusion 
on free when the user hears the 

ringing tone

-- P.K.: Intercom intru-
sion on free

P.K.: Forced S.K.: oIntru
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FORWARDING
DESCRIPTION

Forwarding enables personal (individual) or group calls to be re-routed immediately. The type of calls, 
internal and/or external, affected by the active forwardings can be selected by configuration.

- Follow-me:  forwarding is activated from the destination station.
- Do Not Disturb: the user is not taking calls: internal calls are released and external calls rerouted

to the operator station.
- Immediate group call forwarding: calls intended for groups to which the user belongs are rou-

ted to another destination (programmed in advance or on activation of the service).
- Immediate call forwarding (individual): individual calls are routed to another destination

(whether set, group or VMU) programmed in advance or on activation of the service.
- Forward to text answering: internal calls are released after display of a text message, and ex-

ternal calls are routed to the operator station.
- selective forwarding: depending on the callers' identification (call number), the calls may or may

not be routed to a pre-programmed destination.
- Forward to pager: calls are routed to the called party's pager.
- Forward on busy: when the station is busy, calls are routed to another destination (programmed

in advance or on activation of the service).
- Withdraw from group: the user refuses calls intended for one or more Hunting Groups or Ope-

rator Groups to which he belongs.

Type of forwarding Incoming call type Initial desti-
nation

Personal or 
group 

forwarding

Final destination Feature rights

follow me Internal/external Station personal internal station -

Do Not Disturb Internal Station personal - -

External Operator station

Immediate Internal Station personal int. or ext. station or 
group

-

GrpPic Group internal station

External Station personal Int. or ext. station (*) (*) 
station or group

Yes for external forwar-
ding

GrpPic Group internal station

Text answering Internal Station personal - -

External Operator station

Selective Internal Station personal Int. or ext. station (*) (*) Yes

External

Paging Internal/external Station personal Paging "Bleep" -
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(*) External forwarding requires a particular configuration detailed in the "External Forwarding" file.

CONFIGURATION

For each station, select the type of calls (local, external or both) to be forwarded:

For each station, program the caller lists for selective forwarding (CLIP diversion),and the internal
or external destination for each list. Lists can be unused, active (until deactivated by the station),
inactive (until validated by the station ), validated (programmed but not usable), negative or othe-
rwise (a negative list is one where forwarding is activated by subscribers other than those on the
caller list):

To specify whether or not to authorize forwarding of the last member of a group – MMC-PM5 (Ex-
pert View) only:

For each station, external forwarding can be authorized:

Forwarding on busy Internal/external Station personal Internal or external sta-
tion or group

Yes

Withdraw from group Internal/external GrpPic Group - -

- by customization
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List

-> Details -> Dyn. Rout -> "Diversion Apply"
- by MMC-Station: Subscr-> DynRou -> Ext or Local  

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Clip. Div.  

System Miscellaneous -> Feature Design ->"Disconnect Last Group Member Allowed"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "External Diversion"

Type of forwarding Incoming call type Initial desti-
nation

Personal or 
group 

forwarding

Final destination Feature rights
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ACTIVATION/USE

P.K.: Programmed Key
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

Type of forwarding All stations including Z Without display (≠ Z) With display, no 
soft keys

With soft keys

Follow-me Prefix + station n° to be 
forwarded

P.K.: Follow Me+ n° of 
station to be forwarded

P.K.: FolloË+ n° of 
station to be 
forwarded

S.K.: Divert + Fol-

loË + n° of station 
to be forwarded

Do Not Disturb Prefix P.K.: Do Not Disturb P.K.: DND S.K.: Divert + 
DND

Immediate forwarding of per-
sonal calls

Prefix + Destination n° F.K.: Divert or (pre-)pro-
grammed (Master) indiv. 
immediate forwarding 

+ Destination n°

F.K.: Divert or (pre-
)programmed M 

ImmDË or Imme-

dË (indiv.) + Desti-
nation n°

S.K.: Divert + Im-

medË + Destina-
tion n° 

Forward to text answering -- -- P.K.: TextË S.K.: Divert + Tex-

tË
Forward to pager Prefix P.K.: Paging P.K.: PageË S.K.: Divert + Pa-

geË
Forward on busy Prefix + Destination n° P.K.: Forward on busy 

(master) + Destination n°
P.K.: MbusyË or 

BusyË + Destina-
tion n° 

S.K.: Divert + Bu-

syË + Destination 
n° 

Immediate forwarding of group 
callst

Prefix + Destination n° P.K.: (Master) Immediate 
call forwarding (group) 

+ Destination n° 

P.K.: M GrpË or ImmedË (group) + 
Destination n° 

Withdraw from group Prefix + n° of group to quit P.K.: Withdraw from 
group + number of the 

group to quit

P.K.: GrpWd + number of the group to 
quit

Selective forwarding Prefix P.K.: Selective forwar-
ding

P.K.: SelFwd
Ed. 04 3/6Réf. 3EH 21000 BSAA



FORWARDING CALL SERVER : TELEPHONE FEATURES

 

CANCELLATION

P.K.: Programmed Key
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

ADDITIONAL INFORMATION

- Only one personal forwarding active per station: activation of a personal forwarding supersedes
the previous one.

- A station can simultaneously activate personal forwarding, immediate group forwarding, selective
forwarding and as many group withdraws as is desired.

- Authorization to forward the last station of a group can be programmed (see "Configuration").
- The "follow-me" service can be cancelled from the destination station or the forwarded station.
- The "Withdraw from group" service is not available on S0 stations.
- A "Master forwarding" or "Selective forwarding" key (M. Immd', M. Busy', M. Grp') makes it possible

to activate or cancel the corresponding forwarding. Furthermore, the icon or LED associated with
this key, indicates when a forwarding is activated. All the preprogrammed or fixed keys are such
keys.

- The same station may have a "personal call forwarding" Master key and a "Group call forwarding"
Master key.

- A "text answering" forwarding can only be activated on a station with a display.
- The "local" type of calls to be forwarded includes internal calls as well as those coming from the

private network.
- Forward to text answering when a network call from a station without UUS capability (a Z station

for example) arrives at a station that has activated forwarding to text answering, the call is forwar-
ded to the Operator station, which also receives the message from the called station.

Type of forwarding All stations inclu-
ding Z

Without display (≠ 
Z)

With display, no soft 
keys

With soft keys

All, except "withdraw from 
group"

Prefix Cancel all 
forwardings

P.K.: Cancel all 
forwardings

P.K.: All S.K.: Divert + CanclË + 
type of forwarding

Follow-me (from the destina-
tion station)

Prefix Cancel fol-
low-me + n° of 
forwarded station

Prefix Cancel fol-
low-me + n° of 
forwarded station

Prefix Cancel follow-me 
+ n° of forwarded station

S.K.: Divert + CanclË + 

FolloË + n° of forwarded 
station

Rejoin the group Prefix + n° of group 
to rejoin

P.K.: Withdraw 
from group + 

number of group 
withdrawn from

P.K.: GrpWd + number of group withdrawn from
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- Prefixes for the forwarding functions in the numbering plans. The basic value may differ according
to the local version of the software; the following values apply in France:
• Forwarding: base 0 = cancel forwarding
• Forwarding: base 1 = immediate forwarding
• Forwarding: base 2 = forwarding on busy
• Forwarding: base 3 = do not disturb
• Forwarding: base 4 = forward to pager
• Forwarding: base 5 = group call forwarding
• Forwarding: base 6 = disconnect from group
• Forwarding: base 7 = rejoin group
• Forwarding: base 8 = follow me
• Forwarding: base 9 = cancel follow-me 
- Forwarding: base 10 = selective forwarding
Ed. 04 5/6Réf. 3EH 21000 BSAA



FORWARDING CALL SERVER : TELEPHONE FEATURES

 

Ed. 046/6 Réf. 3EH 21000 BSAA



29

MANAGER/SECRETARY SCREENINGCALL SERVER : TELEPHONE FEATURES

 

File
MANAGER/SECRETARY SCREENING
DESCRIPTION

The system can be used to create relations between manager-secretary stations so that the "secretary" 
station can screen calls intended for the "manager" station, in other words, answer calls intended for 
the manager station and then put the correspondents through if necessary.

In a manager-secretary relation, the "secretary station" can be a Hunting Group (see "Hunting 
Groups").

All the stations in a manager-secretary relation must be multiline.

CONFIGURATION

To create the manager-secretary relations:

For each station, authorize the type of calls (local, external, or both) to be screened:

- by MMC-PM5 (Expert View): Manager-secretary Relations
- by MMC-Station: TerPro -> MgrSec

- by MMC-PM5: Subscribers/Basestations List -> Subscribers/Basestations List -> Details -
> Dyn. Rout. -> "Diversion Apply"

- by MMC-Station: Subscr -> DynRou.
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ACTIVATION/USE

P.K.: Programmed Key – defined using MMC-PM5 (Expert View) or MMC-Station

cancellation

ADDITIONAL INFORMATION

- In order to differentiate between screened calls and direct calls to the secretary station:
• create a second directory number for the secretary
• program the screening with this second directory number
- create, on the secretary station, an RSD resource key programmed with this second number in

order to receive the screened calls there
- A secretary station can belong to several manager-secretary relations: the secretary station then

has a filter key (also on the corresponding manager's station) and an RSL key for each manager
station.

- A manager station can belong to several manager-secretary relations: the manager station then
has, for each secretary station, a filter key (also on each secretary station) and an RSL key.

- When the secretary station in a manager-secretary relation is a Hunting Group, the manager sta-
tion has a single filter key but as many RSL keys as there are members in the group.

- Any activation of individual forwarding on the secretary station or the manager station cancels and
replaces the previously active screening.

- Any request for activation of screening is rejected on a secretary station which has already activated
individual call forwarding.

Monoline Multiline without soft keys With soft keys

By the manager or secretary 
station

-- P.K.: Screening P.K.: Filter

Monoline Multiline without soft keys With soft keys

By the manager or secretary 
station

-- P.K.: Screening S.K.: Filter

Type of station
Service

Type of station
Service
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FORWARDING TO VOICE MAIL UNIT
DESCRIPTION

Users can activate unconditional call forwarding or forwarding on busy for their own calls (see "Forwar-
ding"), diverting them to the integrated Voice Mail Unit.

If the voice mail unit is configured as an answering device, the callers can leave a spoken message.

CONFIGURATION

Select the type of calls (local, external, or both) to be forwarded:

For each station, program the forwarding keys:

ACTIVATION/USE

P.K.: Programmed Key
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Dyn. Rout. -> "Diversion Apply"

- by MMC-Station: Subscr -> DynRou -> "Div"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys

- by MMC-Station: Subscr -> Keys

Z Without display With display, no 
S.K.s

With soft keys

Immediate forwar-
ding of personal 
calls to voice mail 

unit (VMU)

Prefix Immediate 
call forwarding of 
personal calls + 

function code Voice 
Mail

F.K.: Divert or (pre-)pro-
grammed (Master) indiv. 
immediate forwarding 
+ P.K.: Voice mail unit

F.K.: Divert or (pre-
)programmed M Im-

mDË or ImmedË (in-
div.) + P.K.: Voice 

mail unit

S.K.: Divert + ImmedË 
+ P.K.: Voice mail unit

Forwarding on busy 
to voice mail unit 

(VMU)

Prefix Forward on 
busy + function 
code Voice Mail

P.K.: Forward on busy 
(master) + P.K.: Voice 

mail unit

P.K.: MbusyË or Bu-

syË + P.K.: Voice 
mail unit

S.K.: Divert + BusyË + 
P.K.: Voice mail unit

Message present Specific voice prompt + Specific dailtone + LED 
on Reflexes without display

Flashing of 3-colour LED and icon corresponding to 
F.K.: Mail

Access voice mail Prefix access voice 
mail

P.K.: Access voice mail F.K.: Message + 1 F.K.: Mail + S.K.: Voice

Type of station

Service
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CANCELLATION

P.K.: Programmed Key
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

ADDITIONAL INFORMATION

For more details on the Alcatel OmniPCX Office integrated Voice Mail Unit, see "Integrated Voice Mail 
Unit".

All stations inclu-
ding Z

Without display (≠ 
Z)

With display, no soft 
keys

With soft keys

"Immediate" or "On busy" Prefix Cancel all 
forwardings

P.K.: Cancel all 
forwardings

P.K.: All S.K.: Divert + CanclË

Type of forwarding

Type of station
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REMOTE FORWARDING
DESCRIPTION

The remote forwarding  service enables an employee who is outside of the business premises, or at 
home to modify or cancel, from a DTMF dialing set, the unconditional internal or external forwarding 
active on his station, as if he were at work.

 

CONFIGURATION

For each set, to authorize or deny use of the "Remote Substitution" feature:

To validate the service in the public numbering plan (operates without base or NMT):

To define the service access code – MMC-PM5 (Expert View) only:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Remote Substitution"

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan -> Remote Substitution
- by MMC-Station: NumPln -> PubNum  -> Disa

External Lines -> Remote substitution -> Access control code

T2/T0/TL

T2/T0/TL

ATL/QSIG

Station A  
or D

forwarded
to B, C

Station B Station C

Station DCall to A or feature 
code to change the 
state of A
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To define the voice guidance message (none, message 1 to 8) – MMC-PM5 (expert View) only:

To define the system reaction if no DTMF receiver is available (Call Waiting or Release) – MMC-
PM5 (Expert View) only:

External Lines -> Remote Substitution -> Voice Guidance Message

External Lines -> Remote Substitution -> Wait for DTMF Receiver
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ACTIVATION/USE

Users can modify their station state remotely by:

- calling their station (necessarily in external forwarding mode). The user can then either modify the
immediate forwarding destination number or cancel forwarding, or

- dialing the feature code for "remote substitution". The user can then activate immediate forwar-
ding, modify the immediate forwarding destination number or cancel forwarding.

Does dialing
correspond to "remote
substitution" code in

public NP?

Analysis of the 
incoming dialing

 
YES

NO

Is the dialing
correct?

YES

Call the station using a
DDI number or a
"personalized" line

User gets ringing tone

NO
The call fails

Has an
MF receiver been 

assigned, after expiry 
of  time-out?

NO
The call fails

YES

User gets dial tone
The user dials:
-   either the prefix for immediate 
forwarding followed by the 
destination no (**)
-   or the prefix for forwarding 
cancellation

*   For security reasons, this code must be different from the 
default code
**   If the destination number is external, the acknowledge tone 
is sent either upon reception of the end-of-dialing character 
(#, by default) or upon expiry of the interdigit time-out

User gets acknowledge tone and 
the call is released

 User gets ringing tone

Voice guide for
external forwarding

The call fails

YES

Voice guide or dial tone 
sent to the userCalled station

being forwarded to an external 
number, authorization to use the 

feature has been given?

NO

The station is 
called

YES
The user dials :
-   the access code
-   the extension number
-   the personal code (*)

User dials
DTMF codes?

YESNO

NO Has an
MF receiver been 

assigned, after expiry 
of  time-out?
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ADDITIONAL INFORMATION

- The "Remote Forwarding" feature uses elements of the "Remote Substitution" and "External Forwar-
ding" features; see both corresponding files.

- A single DTMF receiver is available at any given time.
- This service can be used to cancel the "Do Not Disturb (DND)" function. 
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EXTERNAL FORWARDING
DESCRIPTION

When external forwarding is activated on a station, its internal and external personal incoming calls 
are routed to a network destination, programmed in advance or at activation of the service.

For external incoming calls, the system can manage 2 types of external diversion:

- by joining: the incoming analog line (or B channel) is switched to the outgoing line (or B channel)
by the PABX, the latter handles the barring and traffic sharing link categories of the destination sta-
tion and the lines to be joined (see "Link Categories") and subsequently the connectivity matrix. Both
resources are busy during the entire duration of the call. This type of forwarding does not need a
subscription..

- by re-routing, for ISDN DDI calls only, and on subscription from the network operator: the system
informs the network that the station called is forwarded and specifies the destination. The network
then manages the forwarding (no busy lines). The system takes account of the barring and traffic
sharing link categories of the destination station and the trunk group programmed into the desti-
nation number.

For internal incoming calls, the system performs forwarding by joining.

CONFIGURATION

For each station, program the forwarding keys:

For each station, external forwarding can be authorized:

Define the type of mechanism used for forwarding an external incoming call to a network number,
re-routing or joining:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys

- by MMC-Station: Subscr -> Keys

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details - Features -> "External Diversion" 

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design -> Part 2 -> "Exter-
nal Diversion Mode"

- by MMC-Station: Global -> Joing -> Divert
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When the selected mechanism for forwarding external incoming calls to a network number is "joi-
ning", fill out the connectivity matrix by MMC-PM5 (Expert View) only:

Define the type of identity retransmitted to the forwarding destination:

To specify whether or not the caller hears a pre-announcement message before being forwarded
– MMC-PM5 (Expert View) only:

ACTIVATION/USE

P.K.: Programmed Key
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

(*) If not a collective speed dial number, the external n° must contain a trunk group number or an RSP 
or RSB key

CANCELLATION

Traffic Sharing and Barring -> Joining

- by MMC-PM5 (Expert View): System Miscellaneous -> Feature Design ->"CLI for external
diversion" or "CLI is diverted party"

Subscribers Misc. -> Pre-announcement -> Voice Guidance for Diversion to External

All stations including Z Without display (≠ Z) With display, no 
soft keys

With soft keys

Immediate external forwarding Code + Destination n° (*) F.K.: Divert or (pre-)pro-
grammed (master) indiv. 
immediate forwarding 

+ Destination n° (*)

F.K.: Divert or (pre-
)programmed M 

ImmDË or Im-
med' (indiv.) + 

Destination n° (*)

S.K.: Divert + Im-

medË + Destina-
tion n° (*)

All stations inclu-
ding Z

Without display (≠ 
Z)

With display, no soft 
keys

With soft keys

Immediate external forwarding Prefix Cancel all 
forwardings

P.K.: Cancel all 
forwardings

P.K.: All S.K.: Divert + CanclË 

Service

Type of station

Service

Type of station
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ADDITIONAL INFORMATION

- Any activation of an individual forwarding supersedes the previous one.
- If the station which activates the forwarding has a display, it will show the forwarding and the Des-

tination n°.
- The icon or LED associated with the "Forwarding selection" or "Master Forwarding" programmed

key indicates activation of forwarding with this key.
- The "Master Forwarding" or "Forwarding Selection" programmed key for individual calls can also

be used to cancel an external forwarding.
- When the link categories do not allow external forwarding:

• an external caller is re-routed to the O.S.
- an internal caller is released

- Two analog lines can only be joined if they are configured with Polarity Reversal and if the public
exchange sends the corresponding IP.

- When a digital line (ISDN or SIG) is forwarded, it is possible to select which identity is retransmitted
by the system to the forwarding destination, either that of the initial caller or that of the forwarded
station.

- The caller can hear a pre-announcement message before being forwarded (see "Configuration").
- A private station can neither activate an external forwarding nor be forwarded externally.
- Neither the possible UUS nor the sub-address (see "ISDN Services") are retransmitted to the forwar-

ding destination.
- External forwarding can not be activated with an account code.

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features

�  CLI for external diversion

o  CLI is diverted party 

= Identity of caller

o  CLI for external diversion

�  CLI is diverted party

= Identity of forwarded station
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PABX FORWARDING *
* Depending on country; not available in France.

DESCRIPTION

All the external calls from the digital network (T0 or T2 accesses) intended for the stations in the instal-
lation can be re-routed to a destination on the network.

First of all, the system manager will have subscribed to "Call Forwarding Unconditional" with the 
network operator. There are two subscription formulae:

- for fixed forwarding, i.e. the forwarding destination is programmed into the public exchange and
is always the same.

- for a variable forwarding, i.e. the forwarding destination is specified at activation of the service
and can thus be different at each activation.

Access to the service is controlled by a password, either:

- in the public exchange: the password given by the network operator is retransmitted to the public
exchange on activation of forwarding.

- at system level: the password is that of the system operator and is not retransmitted to the public
exchange.

To configure the service in the system (so that it correctly transmits the PABX forwarding activation re-
quest) the configuration in the public exchange must take account of the installation's digital links. This 
can be of 3 types:

- type 0 configuration: all the digital links connecting the installation to the public exchange are con-
figured into a single "group" (equivalent to a trunk group) in the public exchange.

- type 1 configuration: the installation is connected to the public exchange by "groups" of links and
isolated digital links.

- type 2 configuration: the installation is connected to the public exchange by several "groups" of
digital links.

Depending on the type of configuration in the public exchange, it waits for one or more PABX forwar-
ding activation requests:

- in a type 0 configuration, a single activation request for the entire group of links
- in a type 1 configuration, an activation request for each link connecting the installation to the ex-

change
- in a type 2 configuration, an activation request for each group of links
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The activation request is made via a trunk group containing one of the installation's digital links, defi-
ned either:

- on programming the "PABX forwarding" key and, failing which, at the time of service activation, in
a type 0 configuration

- only if the diversion is variable, at programming of the "PABX forwarding" key and, failing which,
at the time of service activation, in a type 1 or 2 configuration

- only if diversion is variable, on programming the "PABX diversion" key and, failing which, at the
time of service activation, in a type 2 configuration; However, in this type of configuration, the sys-
tem will not use this trunk group, but that programmed in address "PbxDBdl" which should contain
a single digital link for each of the "groups" in the public exchange allocated to the installation.

CONFIGURATION

Define the type of PABX forwarding, fixed or variable:

Define the type of password used, network or system:

Define the type of configuration used by the public exchange, 0, 1 or 2:

If the configuration used by the public exchange is type 2, create the trunk group containing a di-
gital link of each of the groups assigned to the installation by the public exchange:

If the configuration used by the public exchange is type 2, define the trunk group index:

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "PbxDFix"

- by MMC-Station: Global -> Rd/Wr -> Address -> "PbxDFix" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "PbxDPwdNet"

- by MMC-Station: Global -> Rd/Wr -> Address -> "PbxDPwdNet" -> Return -> Memory

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "PbxDTReq"

- by MMC-Station: Global -> Rd/Wr -> Address -> "PbxDTReq" -> Return -> Memory

- by MMC-PM5 (Expert View): External Lines -> Trunk Groups -> Details
- by MMC-Station: TrGp

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "PbxDBdl"

- by MMC-Station: Global -> Rd/Wr -> Address -> "PbxDBdl" -> Return -> Memory
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station

(*) dial also, if not already pre-programmed in the "forwarding" key, either:
- the directory n° of the trunk group containing the activation request if forwarding is fixed or of type

1
- or the directory n° of the trunk group containing the activation request and the forwarding destina-

tion if forwarding is variable.

CANCELLATION

ADDITIONAL INFORMATION

- Activation of PABX forwarding is signaled:
• on the displays of all stations in the installation
- for a type 1 configuration, by the icon or LED of the forwarded RSP keys.

- After activation of PABX forwarding, outgoing calls are still authorized.
- Two metering statements are printed out: one at activation of the service, the other at cancellation

of it.
- The activation request for a "group" in which all the links are busy is rejected. The same applies to

an isolated link.
- For countries without this feature, PABX forwarding can be managed using a restricted public num-

bering plan in which every DDI number corresponds to a station which will divert to the outside.

Station without display (except Z) Station with display

PABX forwarding P.K.: Div PABX + password (*) P.K.: PABXË + password (*)

Station without display (except Z) Station with display

PABX forwarding P.K.: Div PABX + password P.K.: PABXË + password

Service

Type of station

Service

Type of station
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AUTOMATIC CALLBACK ON BUSY 
TRUNK GROUP
DESCRIPTION

When a user makes a network call (public or private) by:

- using an external RSD or RSB resource key (see "Resource Keys")
- dialing a trunk group number
- using the "Dial by Name" feature
- pressing a direct call key
- using the personal and collective speed dial numbers
- using the "Redial" and "Temporary Memory" features

and hears the busy tone for the selected trunk group, he can leave an automatic call back request 
on this trunk group.

CONFIGURATION

To specify whether or not to authorize a station to leave an automatic call back request:

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

(*) When a line in the trunk group is released, the subscriber requesting callback is rung. When he 
picks up the handset, he hears the dial tone. He then needs simply to dial the number without entering 
the trunk group number.
When the automatic callback request was left following an automatically dialed call (by personal speed 
dial, for example), the dialing is transmitted automatically by the system once the requester has answe-
red the callback.

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Callback"

All stations (inclu-
ding Z)

Without display (≠ Z) With display, no soft 
keys

With soft keys

Automatic call back request (*) Function code P.K.: Automatic call-
back request

P.K.: oCback S.K.: oCback

Type of service

Type of station
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CANCELLATION

Prefix: Code programmed in the "Features in Conversation" table

(**) The automatic call back request is also cancelled if:

- the person requesting call back does not go off hook within 25 seconds or presses the "Release"
key during these 25 seconds

- no line in the trunk group becomes free within 30 minutes
- all the resources of the person requesting call back are busy
- after the person requesting the callback has answered, all the lines in the trunk group return to

busy.

ADDITIONAL INFORMATION

- A user can leave only one type of automatic call back request at a time: on busy station or trunk
group.

- If the automatic call back request is accepted, the user hears the dial tone if he is off hook and
switches to the idle status in hands-free mode.

- An automatic call back request does not follow call diversion (not even a "Do Not Disturb").
- The system accepts as many automatic call back requests on a busy trunk group as it contains lines.
- Automatic call back cannot be picked up (see "Call pick-up").
- Automatic call back which the requesting party does not answer is not recorded in the directory of

unanswered calls.

All stations (including 
Z)

Without display (≠ Z) With display, no soft 
keys

With soft keys

Automatic call back (**) Prefix P.K.: Cancel callback P.K.: nCback S.K.: nCback, before 
or during callback

Type of service

Type of station
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TRANSMISSION OF DTMF CODES (OR 
END-TO-END SIGNALING)
DESCRIPTION

A station can dial either:

- in decadic mode, or
- in DTMF (dual-tone multi-frequencies)

In order to use the services of a server or a telephone answering device, a station must use DTMF dia-
ling so that the PABX can forward the digits dialed to this server without analyzing them.

A DTMF dialing station does this implicitly since it generates the DTMF dialing itself.

A decadic dialing station must activate the DTMF end-to-end signaling function. The digits dialed 
are then converted into DTMF dialing.

"DTMF end-to-end signaling" can be activated either:

- manually, during internal or external conversation
- automatically, via a pre-recorded number in which a "forced DTMF end-to-end signaling" cha-

racter is programmed, possibly followed by digits to be transmitted in DTMF: 
• in the personal speed dial numbers (internal or external number)
• in the collective speed dial numbers (external number)
- on a direct call key (internal or external number)

- automatically, during an internal or external conversation, via DTMF end-to-end signaling pro-
gramming for each station or system. 

CONFIGURATION

To modify the value of the time-out during which DTMF end-to-end signaling is active:

- by MMC-PM5 (Expert View):
 System Miscellaneous -> Memory Read/Write -> Timer Labels -> "IntDgMfTim"

- by MMC-Station:
 Global -> Rd/Wr -> Timers -> "IntDgMfTim" -> Return -> Memory
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To modify the value of the time-out during which forced DTMF end-to-end signaling is active:

Create the Features in Conversation making it possible to activate the end-to-end signaling and to
resend the * in DTMF:

To specify whether or not to activate DTMF end-to-end signaling for a given station (service deac-
tivated by default):

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

cancellation

- by MMC-PM5 (Expert view):
 System Miscellaneous -> Memory Read/Write -> Timer Labels -> "ForceMFTim"

- by MMC-Station:
 Global -> Rd/Wr -> Timer -> "ForceMFTim" -> Return -> Memory

- by MMC-PM5 (Expert View): Numbering -> FAC Numbering Plan
- by MMC-Station: NumPln -> Code -> Funct -> "Send MF num"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details ->  Features -> MF Transparency

Z decadic Without display With display, no S.K.s With soft keys

Manual activation du-
ring communication

Code DTMF end-to-
end signaling

P.K.: DTMF end-to-end 
signaling

P.K.: oDTMF S.K.: oDTMF

Automatic activation By collective speed dial 
numbers

All types of pre-recorded 
dialing

All types of pre-recorded 
dialing

All types of pre-recorded 
dialing

Z decadic Without display With display, no 
S.K.s

With soft keys

When activation has 
been done manually

Automatic deactivation on "IntDgMfTim" 
time-out.

P.K.: DTMF end-
to-end signaling

P.K.: oDTMF S.K.: nDTMF

When activation was 
automatic

Automatic deactivation on "ForceMFTim" time-out when the system encounters the "/" character or manual 
deactivation by key.

Type of stati
Service

Type of station

Service
Ed. 042/4 Réf. 3EH 21000 BSAA



File
35

TRANSMISSION OF DTMF CODES (OR
END-TO-END SIGNALING)

CALL SERVER : TELEPHONE FEATURES

 

ADDITIONAL INFORMATION

- When "DTMF end-to-end signaling" is forced in a pre-recorded number, the digits then to be sent
in voice frequencies can be either pre-recorded or dialed by the user when he makes the call.

- The character symbolizing "Forced DTMF end-to-end signaling" is the slash ("/"). This character also
introduces a 5-second pause (non-modifiable) before sending the rest of the number in DTMF end-
to-end signaling; to introduce a 10 second pause: xxxx // xxxx.

- When a number with "Forced DTMF end-to-end signaling" is recorded in the "Redial" or "Temporary
number" memory, the number is transmitted and the end-to-end signaling service activated when
the content of these memories is recalled. However, the digits to be sent in voice frequencies are
not retransmitted if they were dialed by the user at the time of making the call.

- The number of "Forced DTMF end-to-end signaling" characters and digits to be sent in voice fre-
quency format depend on the total number of digits authorized in programming a speed dial entry
or call key and the number of digits forming the directory number of the called server.

- The system makes it possible to program the DTMF end-to-end signaling feature in conversation
which, when it is dialed, enables the activation of the end-to-end signaling and the transmission of
the character "**", frequently requested by the voice servers (see "Configuration").

- DTMF end-to-end signaling: 
• when DTMF end-to-end signaling is active for the system or station in conversation, access to

the features in conversation is no longer offered (except for DTMF analog stations that have
access to these features via the intermediate of the "R" key).

• to carry out an enquiry call on a monoline station, DTMF end-to-end signaling must first be
cancelled by pressing on a key programmed "DTMF end-to-end signaling". A multiline station
uses a resource key.

- DTMF end-to-end signaling can be deactivated for the current call by pressing a soft key or
DTMF programmed key n (access to features in conversation and to enquiry calls is performed
as it was before activating this function).
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CALL PICK-UP
DESCRIPTION

When a station rings, another user can answer the call in place of the destination station. This call is 
"picked up". There are various types of pick-up:

- a call to a station outside a pick-up group: this is an individual pick-up
- a call to a station within a pick-up group: this is a group pick-up
- a call arriving at the general level: this is a general call answer

CONFIGURATION

To create the pick-up groups:

To specify whether or not to authorize a station to pick up a call:

- by MMC-PM5 (Expert View): Pickup Groups
- by MMC-Station: Groups -> Pick Up

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Call Pickup Allowed"
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

(*) If the pick-up is accepted, the user converses with the caller, if not, he hears the fast busy tone.

ADDITIONAL INFORMATION

- A private subscriber can only pick up internal calls.
- A private call cannot be picked up.
- A call intended for a Hunting Group with cyclic or sequential management (see section "system fea-

tures" file "Hunting Groups") can be picked up like an individual pick-up.
- A call intended for a group of operator stations can only be picked up by individual pick-up.
- Prefixes for pick-up functions in the numbering plans: the basic value may vary depending on the

local software version. The French settings are as follows:
• Pick-up: base 0 = individual pick-up
• Pick-up: base 1 = group pick-up
- Pick-up: base 2 = general call pick-up 

Multiline All stations (in-
cluding Z)

Without display 
(≠ Z)

With display, no 
soft keys

With soft keys

Individual pick-up (*) -- Code + n° of sta-
tion ringing

P.K.: Individual 
pickup + n° of 
station ringing

P.K.: IndPic + n° 
of station ringing

S.K.: Pickup + 
S.K.: IndPic + n° 
of station ringing

Group pick-up (*) -- Prefix P.K.: Group 
pick-up

P.K.: GrpPic S.K.: Pickup + 
S.K.: GrpPic

General call answer (*) -- Prefix P.K.: General 
Call Answer

P.K.: GenBel S.K.: Pickup + 
S.K.: GenBel

Type of service

Type of station
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CALL PARKING/PARKED CALL 
RETRIEVAL
DESCRIPTION

A user in conversation with an external correspondent can suspend this conversation and retrieve the 
correspondent later on from the same station or another station in the installation.

CONFIGURATION

Modify, if necessary, the default timeout before rerouting of the parked call (90 seconds) – MMC-
PM5 (Expert View) only:

The rerouting of parked calls depends on the contents of Incoming Call Handling -> Public Cal-
ler -> Go to Attendant or Release

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

(*) If the request is accepted, the external correspondent is placed on hold and hears the please-wait 
music.

System Miscellaneous -> Feature Design -> Part 3 -> "Time before parked call is rerouted"

All stations including 
Z

Without display With display, no soft 
keys

With soft keys

Parking of an external corres-
pondent

Prefix (*) P.K.: Call Parking (*) P.K.: Park (*) S.K.: Park (*)

Parked call retrieval Prefix Call Parking + 
n° of station from 

which the call was par-
ked

P.K.: Call Parking + 
n° of station from 

which the call was par-
ked

P.K.: Park + n° of sta-
tion from which the call 

was parked

S.K.: Pickup + S.K.: 
Park + n° of station 

from which the call was 
parked

Type of station
Service
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ADDITIONAL INFORMATION

- When a user is involved in a conference or an intrusion, call parking is refused.
- An internal call cannot be parked.
- When the external correspondent is parked for more than the default value of 90 seconds, the call

is routed to the general level (see "Operator Station").
- The system allows as many parked calls as there are network lines.
- Prefix for the Call Parking function in the numbering plans = Pick-up prefix + base 3. (For France:

the basic value may vary according to the local version of the software).
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PAGING
DESCRIPTION

An authorized user can inform another internal user with a portable receiver (or "bleep") that he is 
trying to contact him on the telephone.

Paging is carried out depending on the paging device connected to the PABX, either:

- by suffix, i.e. after calling the user to be paged, with the latter not answering the telephone
- par "mode 4" prefix: the caller dials the paging prefix then, depending on the device, makes a voice

announcement or dials a pager number. The called party dials the paging answer number 
- by "mode 2" prefix (using the ESPA protocol): the caller dials the paging number followed by the

number for the device (it is a good idea to make pager numbers match station numbers). The cal-
led party dials the answer number followed by his station number. 

CONFIGURATION

To specify whether or not to authorize a station to carry out paging by suffix:

To program the "bleep" numbers for users with pagers:

To configure the type of paging device connected to the PABX – MMC-PM5 (Expert View) only:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> "Paging"

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> "Paging Code/Phone Card Password"

- by MMC-Station: Subscr -> Paging

System Miscellaneous -> Feature Design -> "Paging Type"
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To modify the paging no-answer time-out value if required out – MMC-PM5 (Expert View) only:

If necessary modify the value of the paging device busy time-out – MMC-PM5 (Expert View) only:

To define the paging activation code:

To define the answer code:

For "by suffix" paging, configure the analog line to which the paging device is connected:

For "by prefix, mode 4" or mode 2" paging, configure the SLI interface to which the paging device
is connected:

System Miscellaneous -> Feature Design -> Part 2 -> "Maximum Waiting Time for Paging"

System Miscellaneous -> Feature Design -> Part 3 -> "Maximum Connection Time for Pa-
ging"

- by MMC-PM5 (Expert View): Numbering -> Internal Numbering Plan -> Paging Activation  

- by MMC-PM5 (Expert View): Numbering -> Internal Numbering Plan -> Paging Answ.
(Gen.) 

- by MMC-PM5 (Expert View): External Lines -> Trunk List -> Details -> "Paging"
- by MMC-Station: Access -> Paging

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc. -> "Special Function"

- by MMC-Station: Subscr -> SpeDev
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
Prefix: Code programmed in the internal numbering plan or the "Features in Conversation" table

(*) The requesting party stays on line and waits for the paged party to answer. Conversion of the set 
number into paging receiver number is carried out by the system, which informs the paging device.
(**) The requesting party stays on line and waits for the paged party to answer.

ADDITIONAL INFORMATION

- A user can only activate a single paging operation at a time.
- For the "by suffix" type of paging, the system allows 4 simultaneous answer attempts by default.
- Paging must be answered before the "Maximum Waiting Time for Paging" time-out expires.

All stations including 
Z

Without display With display, no soft 
keys

With soft keys

Paging by suffix, in ringing 
phase, the correspondent cal-

led does not answer

Prefix Paging by suffix 
(*)

P.K.: Paging by suffix 
(*)

P.K.: Page (*)

Paging by prefix, mode 4 Prefix Paging by pre-
fix + n° of pager(**)

P.K.: Paging by prefix 
+ n° of pager(**)

P.K.: PgPfx + n° of pager(**)

Paging by prefix, mode 2 Prefix Paging by pre-
fix + n° of station pa-

ged (*)

P.K.: Paging by prefix 
+ n° of station paged 

(*)

P.K.: PgPfx + n° of station paged (*)

Answering paging by suffix Prefix Selective pa-
ging answer + n° of 

station paged

P.K.: Selective paging 
answer + n° of station 

paged

P.K.: PgaSel + n° of station paged

Answering paging by prefix, 
mode 4

Prefix General Paging 
Answer

P.K.: General Paging 
Answer

P.K.: PgaGen

Answering paging by prefix, 
mode 2

Prefix Selective pa-
ging answer + n° of 

station paged

P.K.: Selective paging 
answer + n° of station 

paged

P.K.: PgaSel + n° of station paged

Type of station

Service
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MAIN PABX RECALL
DESCRIPTION

If a user wishes to use the services offered by the analog network operator, he must transmit a calibra-
ted loopbreak over the line.

This procedure must also be followed when the system is connected to a PABX of larger capacity via 
analog network lines.

CONFIGURATION

For each analog network line, configure the value of the calibrated loopbreak using MMC-PM5
Expert View (only):

To modify the default value for the activation of the time-out for the calibrated loopbreak if no fi-
gure has been transmitted:

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Code: Code programmed in the "Features in Conversation" table

(*) the system then transmits a main PABX recall to the local PABX and the following digits.

External Lines -> List of Accesses -> Details -> "Cut off Type"

- by MMC-PM5 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "IntClLp-
Tim"

- by MMC-Station: Global -> Rd/Wr -> Address -> "IntClLpTim" -> Return -> Memory

Type of station Z Without display With display, no soft 
keys

With soft keys

Main PABX recall F.K.: R. + Code (*) P.K.: Main PABX re-
call (*)

P.K.: oPBX. (*) S.K.: oPBX. (*)
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CANCELLATION

(*) after the expiry of a time-out of:

- 5 seconds, programmable, if no figure has been entered
- 10 seconds if a figure has been entered (normal time-out for figures)

ADDITIONAL INFORMATION

The "Main PABX Recall" programmed key or "oPBX" key can be replaced by a macro command pro-
grammed key "Macro3 = Main PABX recall + transmission of a number or code".

Type of station Z Without display With display, no soft 
keys

With soft keys

Cancel main PABX recall Automatic (*) P.K.: Main PABX re-
call

P.K.: oPBX. S.K.: nPBX.
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TEXT MAIL/DELAYED CALLBACK 
REQUEST
DESCRIPTION

Text mail

A user who has a station with display can send a to another internal user who has a display and Mes-
sage LED, either:

- whilst out of communication
- during call setup phase, whatever the called party's status

The system offers 27 pre-programmed messages. Some of these include a variable part (for example, 
a date or room number, etc.) that has to be filled in. A user who has a station with soft keys can also 
create a complete message using the alphabetic keypad.

When the recipient has a station without a display (but with a Message LED), the text message becomes 
a "delayed callback request".

Delayed call-back request

A user whose set does not have a display but which has a "Delayed call-back request key" can leave a 
delayed call-back request for another user whose set has a Message LED. The call-back request can 
only be left in call setup phase as long as the called party has still not answered.

CONFIGURATION

To modify the pre-defined messages – MMC-PM5 (Expert View) only:

System Miscellaneous -> Messages and Music -> Mailing Messages
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

(*) When the set is idle, the system gives priority to "reading" the messages received (voice messages 
first, then text).

ADDITIONAL INFORMATION

- On a Z station intended to receive a delayed call-back request, a "virtual" "Master Mailing" key must
be configured with MMC-PM5 (Expert View), or an "MsgLed" with MMC-Station.

- Calls from external Z users to stations in text answering diversion mode are forwarded to the Ope-
rator Station; the text message is shown on the OS display.

Z Without 
display (≠ 

Z)

With display, no S.K.s With soft keys

Choice of text 
message (*)

-- -- F.K.: Mail or P.K.: Ms-
gLED + 3 + Destination 
n° if requested + F.K. i + 

3 + Message n°

F.K.: Mail + S.K.: Text + n° of destination if requested + S.K.: Ms-
gNo +Message n° 

Modify lan-
guage for the 

message

-- -- F.K. i + 4 S.K.: Lang

To validate 
the chosen 
message

-- -- F.K.: LS S.K.: OK

To validate 
the variable 

part

-- -- F.K.: LS S.K.: OK

Read text 
messages re-

ceived (*)

-- -- F.K.: Mail +3 F.K.: Mail + S.K.: Text + S.K.: Read

Send a de-
layed call-

back request

Code 
+1

P.K.: De-
layed 

callback 
request + 

1

--

Presence of a 
text message 
or delayed 

call-back re-
quest

Flashing Message 
LED 

Flashing 2-colour LED and  Mail

Answer a de-
layed call-

back request

Prefix P.K.: De-
layed 

call-back 
request 

--

Service

Statio

or Function
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STATION COMFORT FEATURES
DESCRIPTION

User comfort involves:

- the ability to cut oneself off from the other party, i.e. to deactivate the microphone (in the handset
or the hands-free function) by activating "mute"

- for a station with display, the option of reading the number assigned to the station and the asso-
ciated name programmed into the internal directory using the "Station Identity" function

- for a station in the Reflexes range with a display, the ability to read the number associated with the
option connected to the station (V24, S0, Z, etc.) using the "Sub-Device" function

- the option of preventing use of one's own station (programming, making external calls, access to
text messages and non-answered calls repertory, activation and cancellation of call diversion) by
activating locking of the station 

- the ability to use the station's loudspeaker with amplified reception, and to adjust the volume.
- for Reflexes stations, the option of adjusting the conversation volume at the handset.

CONFIGURATION

On each station, the personal code can be modified by customization only.
For Reflexes stations, to specify whether or not to authorize adjustment of the handset volume:

- by MMC-PM5 System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "GainCtr-
lON"

- by MMC-Station: Global -> Rd/Wr -> Address -> "GainCtrlON" -> Return -> Memory
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key
S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

CANCELLATION

(*) Mute is also deactivated at the end of the communication.

Z Without dis-
play, without 
"mute" F.K.: 
and/or wi-

thout LS

Without dis-
play, with 

"mute" F.K.: 
and/or with 

LS

With display, no S.K.s With soft 
keys

Communication mute -- -- F.K.: Mute F.K.: Mute

Station identity -- -- -- 2 presses on key i F.K.: i + 
S.K.: 

WhoAmI

Option identity -- -- -- 2 presses on key i F.K.: i + 
S.K.: 

SubDv?

Locking Prefix + per-
sonal code 

P.K.: Lock/Unlock + personal 
code 

P.K.: Lock + personal code S.K.: Lock 
+ personal 

code 

Amplified reception -- -- F.K.: LS or 
F.K.: LS+

F.K.: LS

Adjust the loudspeaker volume or, 
for 40XX stations only, the handset 

volume

-- -- F.K.: LS- and 
LS+ or F.K.: 

LS+/-

F.K.: LS- and LS+

Z Without dis-
play, without 
"mute" F.K.: 
and/or wi-

thout LS

Without dis-
play, with 

"mute" F.K.: 
and/or with 

LS

With display, no S.K.s With soft 
keys

Communication mute -- -- F.K.: Mute F.K.: Mute

Unlocking Prefix + per-
sonal code 

P.K.: Lock/Unlock + personal 
code 

P.K.: Lock + personal code S.K.: Lock 
+ personal 

code 

Amplified reception -- -- F.K.: LS or 
F.K.: LS-

F.K.: LS

Type of station

Service

Type of station

Service
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BACKGROUND MUSIC
DESCRIPTION

When a radio or cassette recorder is connected to the system, a user can activate the broadcast of 
music through the loudspeaker on his station when it is idle.

ACTIVATION/USE

cancellation

ADDITIONAL INFORMATION

The transmission of the music is stopped automatically when a call arrives on the station or when the 
user makes a call.

Without loudspeaker With loudspeaker

Background music -- F.K.: LS or LS+

Adjust the volume -- F.K.: LS+ and LS- or LS+/-

Without loudspeaker With loudspeaker

Background music -- F.K.: LS or LS+

Type of station

Service

Type of station

Service
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HEADSET FEATURES
DESCRIPTION

The user of a station with the Handsfree function can use a headset, connected instead of the handset 
(for a wired station) and use the functions normally accessible from his or her station.

"Headset mode" must be activated by station customization.

To answer a call, three connection modes can be used, either:

- manual: the user answers the call manually by pressing the resource key signaling the call or the
Handsfree key

- a hotline call: the system determines what type of call is at the station (see "Answering camped-on
calls")

- in automatic Intercom mode: after ringing, the station "answers" the call of highest priority by swit-
ching to hands free mode.

CONFIGURATION

To modify the time-out before connection in automatic mode – MMC-PM5 (Expert View) only:

To activate headset mode (MMC-Station Administrator session only)

Nota : Headset mode can also be activated by customizing the stations; see "Customizing Stations" 
for how this is done, depending on the type of Reflexes station.

System Miscellaneous -> Feature Design -> Part 3 -> "Time before auto. conn. in headset 
mode"

Subscr -> n° of station -> Headst -> Choice
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USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
F.K.: Fixed Key

(*) When a caller is camped-on on the station in automatic answer mode, the user goes into conver-
sation with the caller after pressing the "End" key and the transmission of a beep.

Without Hands-Free feature, With Hands-Free feature

Answer a call manually -- Resource Key or F.K.: Handsfree

Activate automatic answer 
mode (*)

-- F.K.: Intercom or P.K.: AutAns or  In-
tercom

Type of station
Service
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APPOINTMENT REMINDER/WAKE-UP 
CALL
DESCRIPTION

A user can have his station ring at a time he can program himself. This is the "Appointment Reminder" 
function in the case of companies and the "Wake-Up" call in the case of a hotel (in the various num-
bering plans, it is referred to as "Wake-Up").

The "Appointment reminder" can be activated either:

- every day at the programmed time: this is a "permanent" appointment
- or only once in the 24 hours following programming: this is a "temporary" appointment.

CONFIGURATION

To program the time of the appointment or wake-up call for a station:

S.K.: Soft Key

Prefix: Code programmed in the internal numbering plan

To define the number of times temporary appointment reminders/wake-up calls should be repea-
ted (3 by default):

Without display With display, no soft keys With soft keys

Permanent appointment reminder -- Key i + function "Appmnt" 
then function " Perm + 4-digit 

permanent call time

S.K.: Appmnt + S.K.: Param 
+ 4-digit permanent call time 

Temporary appointment reminder Prefix Wake-up activation + 
4-digit wake-up call time 

Key i + function "Appmnt" + 
4-digit temporary reminder 

time 

S.K.: Appmnt + 4-digit tem-
porary reminder time 

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Timer Labels
-> "WakeUpRetr"

- by MMC-Station: Global -> Rd/Wr -> Address -> "TonPrCmp" -> Return -> Memory

Type of station
Service
Ed. 04 1/4Réf. 3EH 21000 BSAA



APPOINTMENT REMINDER/WAKE-UP 
CALL

CALL SERVER : TELEPHONE FEATURES

 

To define the ringing duration (15 seconds by default):

To define the timing between 2 wake-up calls (1 minute by default):

To define the timing between 2 groups of 5 wake-ups when there are too many simultaneous re-
quests (2 seconds by default):

To define the reaction in the event of a problem with a wake-up call on a room station (Hotel ver-
sion)

If YES is selected, the reception station rings with a specific call tone and the display shows "Wake-
up problem ".

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Timer Labels
-> "TmAppAnTim (temporary appointment) or PmAppAnTim (permanent appointment)"

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Timer Labels
-> "TmAppWaTim (temporary appointment) or PmAppWaTim (permanent appoint-
ment)"

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Timer Labels
-> "InAnnAppTim"

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "WakUpPrbRg"

- by MMC-Station: Global -> Rd/Wr -> Address -> "WakUpPrbRg" -> Return -> Memory
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ACTIVATION/USE

At the appointment or wake-up time, the station rings and the display shows the appointment.

Ringing stops when the user acknowledges the appointment reminder or wake-up call, for example by 
going off hook. If there is no acknowledgement, the station rings for 15 seconds (default setting) and 
then again one minute later (also by default) and then a third time (by default) after a further minute.

Whether acknowledged or not, a temporary appointment reminder or wake-up call is cancelled and 
a permanent appointment reminder is retained for the following day at the same time.

CANCELLATION

S.K.: Soft Key
Prefix: Code programmed in the internal numbering plan

ADDITIONAL INFORMATION

- When the station is busy at the time the appointment reminder or wake-up call is made, the station
does not ring but the user hears a specific tone.

- To avoid traffic overload, stations that have placed wake-up call requests are called in groups of
5, with a default time lapse of 2 seconds between 2 groups

- Number of analog stations called simultaneously: maximum of 4 per SLI board
- You can consult the appointment reminder/wake-up call status for each station in: Subscribers/

Basestations List -> Details -> WakUp.

Without display With display, no soft keys With soft keys

Permanent appointment reminder -- Key i  + function " Appmnt" 
then function " Perm" + F.K.: 
"Cancellation" + F.K.: "OK"

S.K.: Appmnt + S.K.: Perm 
S.K.: Clear + S.K.: OK

Temporary appointment reminder Prefix Wake-up activation Key i + function " Appmnt" 
then function " Temp" + F.K.: 

"Cancellation" + F.K. "OK"

S.K.: Appmnt + S.K.: Temp + 
S.K.: Clear + S.K.: OK

Type of station

Service
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CALL MONITORING
DESCRIPTION

A user can help one or more other users to manage their communications, by means of:

- supervision of one or more resource keys on these users' stations, with or without supervised call
ringing: the incoming calls on the supervised resource key are signaled in the same way as on the
associated supervision key

- the selective monitoring: the user also receives the calls intended for the selected directory num-
bers

- subscriber monitoring: the user also receives all the calls for the station monitored
- general monitoring: the user also receives external calls intended for the operator stations

CONFIGURATION

For a Z station wishing to use general monitoring, program a virtual key using MMC-PM5 (Expert
View):

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
Prefix: Code programmed in the internal numbering plan

Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Virtual Key -> 
"General Monitoring"

Z Without dis-
play and mo-

noline

Without display and multiline With display

Supervised call ringing -- -- P.K.: Supervision melody or 
Ring 

P.K.: Supervision 
melody or Ring 

Selective monitoring -- -- P.K.: Selective monitoring P.K.: Monit

Answer calls from selective monito-
ring

-- -- P.K.: Selective monitoring 
when the associated LED flashes

P.K.: Monit when 
the associated LED 

or icon flashes 

Subscriber monitoring -- -- P.K.: SubMon or Subscriber monitoring 

Answer calls from subscriber monito-
ring

-- -- Off-hook or press "Hands Free"

General monitoring Prefix Pro-
gramming 

mode + 6 (*)

P.K.: General monitoring P.K.: GenMon

Answer calls from General monitoring Go off hook Go off hook P.K.: General monitoring when 
associated LED or icon flashes

P.K.: GenMon when 
associated LED or 

icon flashes

Type of station
Service
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(*) If a "General Monitoring" virtual key is programmed on the station.

CANCELLATION

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
Prefix: Code programmed in the internal numbering plan

ADDITIONAL INFORMATION

- A "Selective Monitoring" programmed key can monitor up to 8 directory numbers (a user can have
several directory numbers for a single station: for example, an internal number defined in the main
numbering plan, and an external number defined in the DDI numbering plan. Thus, in order to
monitor both internal and external calls, both directory numbers must be programmed on one or
two selective monitoring keys).

- A station can have several selective monitoring keys.
- Selective or subscriber monitoring of a group of stations is impossible. However, when subscriber

monitoring is active for a station belonging to a parallel or sequential group, the group calls for
this station are monitored.

- Selective monitoring does not work for diverted or monitored calls.
- Subscriber monitoring does not work for calls coming from automatic call back on busy station or

trunk group, or from those coming from master recall if transfer fails.
- When all the station resources are busy, new monitored calls are lost.
- A programmed "subscriber monitoring" key can be used to monitor up to 8 directory numbers (if a

station has several call numbers, simply program one of them on a "subscriber monitoring" key for
all the numbers on this station to be monitored).

- So that a Z station can use general monitoring, the installer must configure a "virtual" General Mo-
nitoring key on it.

Z Without display 
and monoline

Without display and multili-
ne

With display

Supervised call ringing -- -- P.K.: Supervision melody or 
Ring 

P.K.: Supervi-
sion melody or 

Ring 

Selective monitoring -- -- P.K.: Selective monitoring P.K.: Monit

Subscriber monitoring -- -- P.K.: SubMon or Subscriber monitoring 

General monitoring Prefix Programming 
mode + 7

P.K.: General monitoring P.K.: GenMon

Type of station
Service
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CUSTOMIZING STATIONS
DESCRIPTION

Customization only affects the station on which it is performed (you cannot customize remote stations). 

Switching to Customization mode

Depending on the type of station, press Custo (2nd page, Advanced Station in Idle) or i + 5, or dial 
the "Programming Mode" function code.

The following pages describe the tree structures available for each type of station; navigation is done 
using soft keys or codes (with the help of voice guides).

Additional Information

- Answer Only mode: activating or deactivating "Answer Only" mode does not modify the greeting
in the voice mailbox ; the user has to select the appropriate default message or re-record a new
one that corresponds to the selected mode of operation.

- Destination number (personal assistant or message notification): 
• external numbers must include the network access prefix 
• external numbers are subject to barring controls
- if the pre-defined number is invalid or barred, the call is automatically put through to the des-

tination mailbox (personal assistant) or is not connected (remote notification).
- Time ranges: on initialization, the start time is 00:00 and the end time is 24:00
- Customization validation key: OK for stations with soft keys, # for stations without soft keys, 9 for

decadic stations.

Other available features:

- i key + key programmed with a specific parameter: modify the parameter value.
- Repertory key + i key: program personal speed dials.
- i key + Appmnt key: program a reminder call.
- i key + Divert key: program call types to be forwarded.

Nota : For a detailed description of how to set up these functions (passing from one function to 
another, deleting a value, etc), refer to the user guide for the relevant terminal.
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Stations with soft keys

OK

OK

Activate/deactivate

OK Validate current selection

OK Validate current selection

OK Validate current selection

OK Validate current selection

MBXANN

Mailbox: welcome message

CUSTOM

LISTEN

RECORD PAUSE

RECORD

DEFAULT

YES

NO

MODE SELECT

PERATT ON/OFF

OPTION

CODE

LANG

NOTIF ON/OFF

NUMBER

SCHED

SELECT

Remote message notification

Record personal greeting 

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Mailbox utilization mode:
standard or answering-only

Activate/deactivate personal assistant

Select user language from available options

Activate/deactivate notification of new messages

Number of the station to notify

Applicable time range for notification

Personal assistant

Custom options

MELODY Choose ringing tune

CNTRST

PHONE

HEADST

Station settings

SELECT Activate/deactivate headset mode

EXTNUM

OPERAT

HANDY

Route to operator station

MENU

STOP

Keep recorded personal greeting

SELECT

Pause recording

Stop recording (End)

Re-record

SELEC

MELODY

LEVEL+

SCREEN

ICON

Set ringing tune volume 

Set display contrast

Set icons contrast

Route to internal number

Route to external number

Route to mobile station

MODIFY

DISABL

Modify destination number

Validate current selection

Deactivate selection

Change personal code (enter old code followed by new code)

NAME RECORD RECORD

STOP

Record user's name Re-record

Stop recording (End)

INTNUM

MODIFY

Validate current selection
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Stations without soft keys but with displays

1
Mailbox: welcome message

1

LISTEN

RECORD1 PAUSE8

*2

DEFAULT3 YES1

NO2

MODE5

PERATT2 ON/ OFF1

INTNUM

OFF2

1

EXTNUM2

4 OPERAT

HANDY3

OPTION4 CODE1

LANG2

VOICE3

NOTIF5 ON/ OFF1

NUMBER2

SCHED3

ON1

OFF2

ON1 Activate personal assistant

Select user language from available options

Number of the station to notify

Applicable time range for notification

Remote message notification 

Personal assistant

Custom options

MELODY1MELODY Choose ringing tune

CNTRST Adjust display contrast

PHONE3 1

2

HEADST3

Station settings

ICON1

MENU2

STOP#

Keep recorded personal greeting

RECORD1

SIMPLE2

Mailbox in standard mode (answering and recording)

Mailbox in answering-only mode

Activate remote notification of new messages

Deactivate remote notification of new messages

1 ACTIVE

2

Activate voice prompts on station

Deactivate voice prompts on station

Record personal greeting Pause

Stop recording (End)

Re-recordListen to (personal or default) greeting

Delete recorded greeting; select default greeting

Deactivate personal assistant

LEVEL+2 Set ringing tune volume 

INACT

1 ACTIVE

2

Activate headset mode

Deactivate headset mode

Route to operator station

Route to internal number

Route to external number

Route to mobile station

MODIFY1

DISABL2

OK#

Modify destination
number

Validate current
selection 

Deactivate selection

Change personal code (enter old code followed by new code)

1 4

NAME4 RECORD1 *

STOP#

Record user's name

Stop recording (End)

Re-record

MBXANN CUSTOM

RECORD

RECORD

to

INACT

Activate/deactivate 

Validate current 
selection

MODIFY1

OK#
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Stations without displays or soft keys

1 1 8

*2

3 1

2

5

2 1

2

4 1

4 *

#

5 1

2

3

1

2

1

3 1

3

1

2

4

3

2

1

22

#

1

2

#

2 1 4

1

#

1

2

#

1

2

6 0 9 On-hook

Mailbox: welcome message

Personal assistant

Custom options

Mailbox in standard mode (answering and recording)

Mailbox in answering-only mode

Activate personal assistant

Deactivate personal assistant

Record user's name

Activate remote notification of new messages

Number of the station to notify

Applicable time range for notification

Remote message notification

Choose ringing tune

Station settings 

Activate headset mode

Pause

Stop recording (End)

Re-record

Deactivate selection

Stop recording (End)

Re-record

Set ringing tune volume

Deactivate headset mode

Deactivate remote notification of new messages

Confirm current tune

Change personal code (enter old code followed by new code)

Keep recorded personal greeting

Record personal greeting

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Select user language from available options

Modify destination number

Route to operator station

Route to internal number

Route to external number

Route to mobile station

to

Validate current selection

Activate/deactivate

Internal/external n° to be saved

Programming the personal directory
to

Validate current selection
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Analog Z stations 

1 1 8

*2

3 1

2

5

2 1

2

4 1

4 *

#

5 1

2

3

1

2

1

1

2

4

3

2

1

22

#

1

2

#

2 1 4

1

#

6 1

7 1

Mailbox: welcome message

Personal assistant

Custom options

Mailbox in standard mode (answering and recording)

Activate personal assistant

Deactivate personal assistant

Record user's name

Activate remote notification of new messages

Number of the station to notify

Applicable time range for notification

Remote message notification

Pause

Stop recording (End)

Re-record

Deactivate selection

Stop recording (End)

Re-record

Deactivate remote notification of new messages

Change personal code (enter old code followed by new code)

Keep recorded personal greeting

Record personal greeting

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Select user language from available options

Modify destination numberRoute to internal number

Route to external number

Route to mobile station

Validate current selection

Activate/deactivate

Activating general call monitoring (OS help)

Deactivating general call monitoring

Decadic stations use the 9 key for validation; the functions accessible with the * key are not available
(even though they are announced)

Route to operator station

Validate current selection
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File
TEAMWORK
DESCRIPTION

Teamwork simplifies the call management of all the members in a "work group" by equipping each 
station with:

- as many RSL keys as there are members in the group less one. Each RSL is programmed with the
number of one of the other members of the group. These keys enable:
• monitoring of the other stations, i.e. knowing whether they are free or occupied
- direct calls to other members of the group

- one or more selective call monitoring keys (one key makes it possible to monitor up to 8 directory
numbers) (see "Call Monitoring")

- a group call pick-up key (see "Call pick-up")

CONFIGURATION

To create a work group – MMC-Station only:

ADDITIONAL INFORMATION

- Group call pick-up is used when selective call monitoring is deactivated for the station which is rin-
ging.

- A work group is "virtual", i.e. there is no directory number. To remedy this, it is preferable to create
a Hunting Group with parallel management (see "Hunting Groups").

- By adding monitoring resource keys to the other stations in the work group, each member of the
group can monitor the other member's calls.

TerPro -> TeamWk -> Add
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ACCOUNT CODE/SUBSTITUTION
DESCRIPTION

Account code

An account code makes it possible to charge the cost of an external communication to a client account.

During a communication, a dedicated station can modify the account code or add one ; a Z station 
cannot.

All the account codes are configured in the account code table. For each account code, the installer 
can state:

- whether or not the client account is identified by a name which can be printed on the metering sta-
tement instead of the name of the call initiator

- whether or not the initiator of the call is to be identified by his directory number
- whether or not the initiator of the call must enter a password, either:

• his personal code, if the user's identity is required ("User-ID" field in MMC-PM5 = User)
- the personal code of the station on which the call is made, if the user's identity is not required

("User-ID" field by MMC-PM5 = No)
- whether the barring and traffic sharing link categories (see "Link Categories" and "Barring") used

for the call are:
• those of the 'set' on which the call is made
• those of the 'Guest' (MMC-PM5 label), i.e. of the station identified for this call
• the barring link category of the client account (between 1 and 16) and traffic sharing link cate-

gory of the station on which the call is made
- no barring: no barring link category but the system uses the traffic sharing link category of the

station on which the call is made
- the number of digits of the external number, masked on the metering statement:

• all: all the digits are masked (priority field in relation to the "Mask last 4 digits" field in the "Me-
tering Printout" menu)

• 0, 1, ...,9:  from 0 to 9 digits masked (priority field relative to the "Mask last 4 digits" field in the
"Metering Printout " menu)

- default: value of the "Mask last 4 digits" field in the "Metering Printout" menu (either 0 or 4 digits
masked).
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Furthermore, an account code can be:

- defined: in this case, it is composed exclusively of digits (e.g. "987654")
- partially defined: in this case, it is composed of digits and asterisks (e.g.: "1345*****"), the asterisks

represent the variable part ; the number of digits in the account code entered must be equal to the
number of digits of the defined and asterisk part

- variable: in this case, it is composed exclusively of asterisks ; the number of digits in the account
code entered must be equal to the number of asterisks.

When an account code is entered, the system checks first of all, whether it exists as a "defined" code, 
if not, a "partially defined" code, and finally as a "variable" code.

The installer can configure a code for activating the "Account Code" service in the main numbering 
plan. The "Base" field can be either:

- empty: in this case, the user enters the code associated with the client account himself
- 4 digits long, 0000 to 9999: in this case, the base refers to an account code configured in the ac-

count code table. The four digits of the base can correspond either to the 4 digits of a defined ac-
count code or to a variable code of 4 asterisks.

Substitution

This makes it possible to authorize a user to make an external call from any station in the installation, 
even barred or locked, as if he were making the call from his own station.

Substitution is a particular account code case for which:

- the user's identity is required
- barring and traffic sharing link categories are those of the "guest"
- the password may be required.
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CONFIGURATION

To create the code for activating the "Account Code" feature in the internal numbering plan:

To create the account code table:

Select the name printed on the metering ticket ; that of the client account or of the initiator of the
call – MMC-PM5 (Expert View) only:

ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
Prefix: Code programmed in the internal numbering plan

(*) the programmed keys, such as the numbering plan activation prefix, can contain the desired ac-
count code.

- by MMC-PM5 (Expert View):  Numbering -> Internal Numbering Plan ->"Account Code
New"

- by MMC-Station: NumPln -> IntNum -> Accoun

- by MMC-PM5 (Expert View): Traffic Sharing and Barring -> Account Code Table

Metering -> Printout -> Fields -> "Subscriber Name"

Z Without display With display

Before setting up the call Prefix New account code + 
account code if necessary + n° 
directory (if identity required) 

+ personal code if required + 
external n° 

P.K.: New account code(*) + 
account code if requested + 
directory n° if identity reques-
ted + personal code if reques-

ted + external n° 

P.K.: AccNew (*) + account 
code if requested + directory 
n° if identity requested + per-
sonal code if requested + ex-

ternal n°

During communication -- P.K.: Account code during 
communication + account 
code if requested + directory 
n° if identity requested + per-
sonal code if requested + ex-

ternal n°

P.K.: AccCom + account code 
if requested + directory n° if 
identity requested + personal 
code if requested + external n°

Type of station

Service
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ADDITIONAL INFORMATION

- The system rejects all calls with an account code using the default personal code.
- An account code can have up to 16 digits or asterisks.
- Partially defined account codes in formats "12**34", "1***6**" or "**88" are forbidden.
- FORCED ACCOUNT CODE: the installer can authorize the user to only make external calls using

an account code, by:
• assigning barring link categories specific to the account code on one hand and to the user on

the other
- configuring account code parameters in the following manner: the user's identity is required,

barring and traffic sharing link categories are those of the "station" and a password is also re-
quired

- The "New Account Code" and "AccNew" programmed key can be replaced by "Macro2" keys con-
taining the external code .

- The account code is not memorized with the number in the Last Number Redial and Temporary
memories.

- An account code can be modified several times during communication and until the user enters a
"defined" or "partially defined" code. 

- Masking of several or of all the digits in the external number dialed makes it possible to keep a call
confidential.

- The "names" of the account codes do not figure in the internal directory.
- An account code remains active after activation of a paging, after a recall in the case of a transfer

failure, after a call parking, a call pick-up, a forwarding or a transfer.
- The "Account Code" field can only be printed on statements with 132 columns.
- An S0 station cannot use these services.
- What not to do – example of an ineffective account code configuration: the user's identity is requi-

red, the barring and traffic sharing link categories are those of the "guest" and the personal code
may or may not be required.
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ALLOCATION OF A TRUNK LINE
DESCRIPTION

An authorized user can lease one of the trunk lines in the main trunk group to another barred user so 
that he may make a single external call. This user keeps his call confidential since he dials the number 
himself.

The authorized user must be in an internal communication with the user before leasing him the line.

The authorized user can also:

- select the barring level assigned to the call made after allocation of the line: no barring or level 1
to 6

- lease a line with metering reminder (see "Meter Total Recall")
- assign an account code to the communication that the other user is about to make (see "Account

Code")

CONFIGURATION

To specify whether or not to authorize a station to allocate one of the lines in the main trunk group:

For each station, to specify whether or not to program the keys for trunk line allocation, with or
without meter total recall:

To create the features in conversation for allocation of the trunk line, with a barring level from 1 to
7 (level 7 being "no barring"), with or without meter total recall:

- by MMC-PM5 (Expert View):
 Subscribers/Basestations List -> Details -> Features -> Part 2 -> "Trunk Allot"

- by MMC-PM5 (Expert View):
Subscribers/Basestations List -> Details -> Keys -> "Trunk Allot" or "Trunk Allot MTR"

- by MMC-Station: Subscr -> Keys -> "AllotN" or "AllotM"

- by MMC-PM5 (Expert View):
Numbering -> FAC Numbering Plan -> "Trunk Allot (1 to 7)" or "Trunk Allot MTR (1 to 7)"

- by MMC-Station: NumPln -> Code -> "AllotN Cat (1 - 7)" or "AllotM Cat (1 - 7)"
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
Prefix: Code programmed in the internal numbering plan

(*) Addition of an account code and the associated parameters must be done before activation of the
"trunk allocation" service.

ADDITIONAL INFORMATION

- The authorized user and the beneficiary user of the service must be connected to the same PABX.
- The beneficiary user of the service must have an available resource for the external communication.
- Meter total recall can only be requested on a station with display.
- If the service is refused, the beneficiary user hears the fast busy tone.
- The service is refused if the beneficiary station is locked or private without authorization to transfer.
- The allocated line is an analog trunk line or a digital access.
- The beneficiary user cannot use block dialing mode after trunk allocation.
- An S0 station cannot activate the service nor be a beneficiary user of the service.

Z Without display (except Z) With display

During a local communication, the 
authorized user uses...

Prefix Trunk allocation with 
or without MTR, and with or 

without barring

P.K.: Trunk allocation with 
or without MTR, and with or 

without barring (*)

P.K.: Trunk allocation with 
or without MTR, and with or 

without barring (*)

then the other user... hears the public network dial tone and makes the external call 

If a meter total recall has been re-
quested...

-- -- the authorized user's station 
rings and the display indicates 

the metering

Type of station

Service
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METER TOTAL RECALL
DESCRIPTION

A user who has a station with a display can request to be called back automatically to find out the cost 
of an external communication made by another system user. 

Meter total recall can be activated either:
- manually: in this case, meter total recall is requested before a single external call is setup.
- automatically, for each station in the installation: in this case, meter total recall is activated after all

the external calls on "monitored" stations.

The ringer for a meter total recall is the same as that for an appointment reminder.

CONFIGURATION

To create the prefix for activating "Meter Total Recall" in the internal numbering plan:

To specify whether or not to authorize the printing of a metering ticket during a meter total recall:

To specify whether or not to monitor a station after each external communication:

For each station, define the meter total recall destination for all external communications:

- by MMC-PM5 (Expert View):
Numbering -> Internal numbering plan -> "Meter Total Recall"

- by MMC-Station: NumPln -> IntNum -> Funct -> "MTR

- by MMC-PM5 (Expert View):
System Miscellaneous -> Memory Read/Write -> Misc. Labels -> "MTR_Print"

- by MMC-Station:
Global -> Rd/Wr -> Address -> "MTR_Print" -> Return -> Memory

- by MMC-PM5 (Expert View):
Subscribers/Basestations List -> Details -> Metering ->Monitoring

- by MMC-PM5 (Expert View):
Subscribers/Basestations List -> Subscribers/Basestations List -> Details ->Metering -
>Metering Total Recall ->Destination n°
Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Metering -
>Metering Total Recall ->Active
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ACTIVATION/USE

P.K.: Programmed Key – defined by MMC-PM5 (Expert View) or MMC-Station
S.K.: Soft Key

ADDITIONAL INFORMATION

- The recall is presented for 25 seconds ; if the recall is not acknowledged, the system temporarily
cancels the recall: it is presented again after any operation carried out on the station. 

- If the destination station for the recall is busy, the metering information is temporarily displayed
and a sound signal is transmitted. As soon as it is free, the destination station for the recall should
receive the metering information.

- When a station is the destination for several meter total recalls, the one which has been there the
longest is presented first.

- The service can only be used on external lines providing metering information (hence, not on ana-
log ATLs).

- A meter total recall does not follow a call forwarding.
- A "meter total recall" can be combined with a "trunk allocation" (see corresponding file).
- The character "#" precedes the number of the metering ticket printed on a meter total recall.

Without display With display, no soft keys With display, with soft keys

Activating in manual mode, during 
communication (local)

-- P.K.: MTR + external n° + F.K.: Transfer

Activating in manual mode, when 
idle

-- P.K.: MTR + external n° then, when the outside party answers, internal 
n° + F.K.: Transfer

Activating in automatic mode -- Automatic

During recall, reading the directory 
n° of the "monitored" station

-- P.K.: Read + P.K.: Read + if required

Printing a metering ticket -- 2 S.K.: Print.

Stopping the ringer and keeping 
the metering information on the 

display

-- 1 S.K.: MTR-OK

Acknowledging the meter total re-
call

-- 1 S.K.: MTR-OK

Type of station

Service
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REMOTE SUBSTITUTION 
DESCRIPTION

The remote substitution  service enables an employee who is outside of the business premises or at 
home to call a correspondent on the public network from a DTMF set (via the TL/T0/T2 access) or a 
user on a remote PABX on the same private network (via the ATL or the QSIG accesses) as if he were 
at work.

The user must pay for the call to the system; the company is charged for the call between the system 
and the external correspondent.

 

CONFIGURATION

To authorize or deny access to the service, for each station:

To validate the service in the public numbering plan (operates without base or NMT):

To define the service access code – MMC-PM5 (Expert View) only:

To define the voice guidance message (none, message 1 to 8) – MMC-PM5 (Expert View) only:

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> Part 2 -> "Remote Substitution"

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan -> Remote Substitution
- by MMC-Station: NumPln -> PubNum  -> Disa

External Lines -> Remote substitution -> Access control code

PUBLIC
NETWORK

T2/T0

Caller Called

ATL/QSIG 

Called
Set carrying the
communication 

T2/T0/TL
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To define the system reaction if no DTMF receiver is available (Call Waiting or Release) – MMC-
PM5 (Expert View) only:

ACTIVATION/USE

ADDITIONAL INFORMATION

- The traffic sharing and barring link categories are those of the local user.
- A single DTMF receiver is available at any given time.
- Metering: Every call generates 2 statement lines: one line for the incoming call (with Type = inco-

ming transit call using remote substitution <SI), the other is for the outgoing call (with Type =
outgoing transit call using remote substitution IS>).

External Lines -> Remote Substitution -> Voice Guidance Message

External Lines -> Remote Substitution -> Wait for DTMF Receiver

No. received ="Remote 
Substitution" service in 

the Internal Numbering 
Plan?

Analysis of the incoming 
dialing

YES

NO

Correct  dialing?

YES

DDI Call

Ringing tone sent to 
calling party

Voice Guidance Message or 
dial tone

The user dials
- the access code
- the number of the set
- the personal code *

Dial the number requested 
on the public network

NO
Call failure

After time-out
expiry, MF receiver

Assigned?

NO
Call failure

YES

* For security reasons this personal code
  must  be different from the default code
Ed. 042/2 Réf. 3EH 21000 BSAA



52

FAX CALL ROUTINGCALL SERVER : TELEPHONE FEATURES

 

File
FAX CALL ROUTING 
DESCRIPTION

This feature enables Alcatel OmniPCX Office users to receive voice and fax calls on the same number: 
their correspondents use a single number for either function. Once configured:

- all voice calls make the set ring;
- all fax calls are routed to the associated fax number. A text message advises the user that a fax has

arrived.

Modem type calls are also detected ; these calls are answered by the recipient (modem connected to 
an analog access) or by an integrated modem if configured in the OS group. The call is refused if no 
modem is present.

ACTIVATION/DEACTIVATION

This feature requires that a destination fax number be configured for every user wishing to take ad-
vantage of this service; the number is attached to the station's DDI number in the public numbering 
plan.

A greeting (general pre-announcement) has to be configured to keep the correspondent waiting during 
the fax detection phase.

Handling calls to the OS group 

- If the general pre-announcement message is configured, every incoming call is assessed for pos-
sible routing. 

- There is no need to associate a fax or modem number; fax calls are routed to the first analog in-
terface in the system and modem calls to the integrated modem (default configuration).

Private networkPublic network

External Fax and stations Internal Fax and stations
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 ISDN CONNECTION 

Notas :

If the service is not active (no associated fax number), any call with a service other than VOICE will be 
refused (service incompatibility).

The call rings station
XXX

Fax number
associated?

YES

NO

NO

YES

Service for this
call = Fax 2/3

or Fax 4?

Call is routed to the
associated fax number

Incoming call from user XXX

Service for this
call = VOICE?

NO

NO

Detection of
fax signals by

DSP? 

NO YES
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ANALOG CONNECTION 

Notas :

If the service is not active (no associated fax number), fax calls (with VOICE service) are put through to 
the user station.

The call rings station XXX

Fax number
 associated?

YES

NO

NO

YES

Incoming call from user XXX

Detection of fax
signals by DSP?

Call is routed to the
associated fax number
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CONFIGURATION

Enter the destination fax number:

Assigning welcome messages:

To define the pre-announcement mode (none, mode 1- before call distribution or mode 2- during
call distribution) in accordance with the time range:

Notas :

It is always the general pre-announcement that is used for fax call routing, even if there is a personal 
pre-announcement message configured.

Whatever the pre-announcement configuration, the message will be broadcast once and once only, 
always before call distribution.

The "Busy" flag (accessed via PM5 -> Subscribers Misc. -> Pre-announcement ->Details) does not 
apply to fax call routing.

ADDITIONAL INFORMATION

- Fax call routing cannot be used simultaneously with CCBS.
- Fax call routing can be used simultaneously with fax notification (see that section): in this case, the

user receives 2 messages signaling the receipt of a fax. 
- There may be a slight delay between the moment the call reaches the system and the moment it is

put through to the station or fax; this is due to the workload on the DSPs in charge of fax detection.

- by MMC-PM5 (Expert View): Numbering -> Numbering Plans -> Public Numbering Plan
-> Fax

- by MMC-Station: NumPln -> PubNum -> FaxRou

- by MMC-PM5 (Expert View): Subscribers Misc. -> Preannouncement
- by MMC-Station: PreAnn -> Add -> Msg

- by MMC-PM5 (Expert View): Subscribers Misc. -> Preannouncement
- by MMC-Station: PreAnn -> Add -> Mode
Ed. 044/4 Réf. 3EH 21000 BSAA



53

FAX NOTIFICATIONCALL SERVER : TELEPHONE FEATURES

 

File
 FAX NOTIFICATION 
DESCRIPTION

The fax notification service informs users (whose stations have displays and Message LEDs) when they 
have just received a fax.

CONFIGURATION

Program the "Fax Notification" table by creating the Fax n° <-> Subscriber n° links with:
• fax numbers from the internal, public or private numbering plans
- subscriber numbers from the internal numbering plan.

ACTIVATION/USE

When a fax has been received, the system displays the message: "Incoming Fax" on the recipient subs-
criber's station (depending on the configuration of the "Fax Notification" table) along with the number 
of the receiving fax machine.

ADDITIONAL INFORMATION

- A subscriber can supervise several fax numbers.
- A fax n° can be supervised by several subscribers.
- The "Fax Notification" table is limited to 30 entries.
- To deactivate fax notification on a subscriber station, break the Fax n° <-> Subscriber n° link con-

figured in the "Fax Notification" table.

- by MMC-PM5 (Expert View): Subscribers Misc. -> Fax Notification for Subscribers
- by MMC-Station: Global -> FaxTab -> ReSubs and FaxNum 
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File
LIST OF SERVICES OFFERED
4003 
First

4011 
Easy

4012 
Pre-

mium

4023 4034 
Advan-

ced

Z DECT

Account code before setting up a call • • • • • • •

Account code during communication • • • • • •

Amplification of the handset audio • • • • •

Amplified reception • • • • •

Answering a call (automatic connection) • • • • • • •

Answering a call (manual connection) • • • • •

Answering camped-on calls • • • • • • •

Appointment reminder • • • • •

Auto. call setup on going off hook • • • • • • •

Auto-answer mode (intercom mode) • • •

Automatic call-back request on busy station • • • • • • •

Automatic call-back request on busy trunk 
group

• • • • • • •

Background music • • • •

Block dialing mode • • • • •

Broadcast call (receive) • • • •

Broadcast call (send) • • • • • • •

Call by collective speed dial number • • • • • • •

Call parking and parked call retrieval • • • • • • •

Call pick-up within a group • • • • • • •

Calling Line Identification Restriction (CLIR) • • • • • • •

Camp-on on busy station or group • • • • • • •

Cancel all active forwardings • • • • • • •

Common hold (and retrieval) • • • • • •

Communication mute • • • • •

Conference • • • • • • •

Service
Station
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COnnected Line identification Presentation 
(COLP)

• • • • •

COnnected Line identification Restriction 
(COLR)

• • • • • • •

Connection handover •

Consultation of camped-on caller identities • •

Contrast of the display and icons • • • •

Deferred call-back request (leave a) • • • • • • •

Deferred call-back request (receive a) • • • • • if LED •

Dial by name • • • • •

Digit-by-digit dialing mode • • • • • • •

Direct internal or external call by program-
med key

• • • • • •

Display correspondent's name or number • • • • •

Display date and time • • • • •

Do Not Disturb (DND) • • • • • • •

DTMF end-to-end signaling • • • • • • •

Dynamic routing • • • • • • •

Enquiry call • • • • • • •

Exclusive hold (and retrieval) • • • • • • •

External forwarding • • • • • • •

Fax Notification • • • • •

Follow-me • • • • • • •

Forced DTMF end-to-end signaling • • • • • • •

Forward on busy • • • • • • •

Forwarding to pager • • • • • • •

Gain switch forcing • • • • •

General monitoring • • • • • •

Handsfree • • • •

Headset mode manual or automatic res-
ponse

• • •

Identity of the station (number and name) • • • • •

4003 
First

4011 
Easy

4012 
Pre-

mium

4023 4034 
Advan-

ced

Z DECT

Service
Station
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Identity of the sub-device connected to the 
station

• • • •

Immediate forwarding of group calls • • • • • • •

Immediate forwarding of personal calls • • • • • • •

Indication of the cost of a communication • • • • •

Individual call pick-up • • • • • • •

Intercom intrusion on free • • • • • •

Internal group call • • • • • • •

Internal station call • • • • • • •

Intrusion • • • • • • •

Keypad dialing features • • • • •

Main PABX recall (calibrated loopbreak) • • • • • • •

Malicious call identification • • • • • • •

Meter total recall • • • • •

Non answered calls repertory • • • • •

On-hook dialing • • • • •

PABX forwarding • • • • • • •

Paging • • • • • • •

Personal Assistant • • • • • • •

Personal code • • • • • • •

Personal speed dial numbers • • • • • •

Private call • • • • • • •

Programmable function keys • • • • • •

Protection of a call against camp-on and 
camp-on tone

• • • • • • •

Redial (last emitted number redial) • • • • • • •

Release-reseize • • • •

Remote forwarding • • • • • • •

Remote substitution • • • • • • •

Roaming •

Screening (manager station) • • • •

4003 
First

4011 
Easy

4012 
Pre-

mium

4023 4034 
Advan-

ced

Z DECT

Service
Station
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Screening (secretary station) • • • •

Seamless handover •

Select the display language • • • • •

Select the ringing tune and adjust its volume 
level

• • • • • •

Select the type of alphabetical keyboard • •

Select the type of calls to be forwarded • • • • • •

Selective forwarding • • • • • • •

Selective monitoring • • • •

Shuttle • • • • • • •

Station lock/unlock • • • • • • •

Sub-address • • • • •

Supervised call ringing • • • • •

Supervised transfer • • • • • • •

Switch to normal or restricted mode •

Teamwork • • • • •

Temporary memory • • • • •

Text answering • • • •

Text mail • • • • •

Transfer of two external lines • • • • • • •

Trunk allocation • • • • • • •

Unassigned night answer • • • • • • •

Unsupervised transfer (on camp-on) • • • • • • •

Unsupervised transfer (on no answer) • • • • • • •

User-to-User Signaling (receiving) • • • • •

User-to-User Signaling (sending) • •

Voice mail unit • • • • • • •

Wake-up • •

Withdraw from group • • • • • • •

4003 
First

4011 
Easy

4012 
Pre-

mium

4023 4034 
Advan-

ced

Z DECT

Service
Station
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File
OVERVIEW
ENVIRONMENT

The voice server (or VMU: Voice Mail Unit) is an integrated Alcatel OmniPCX Office application (built 
into the CPU board) that offers the following functions:
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Consultation of messages

Consultation of conversations

Sending/Forwarding 
of messages

Recording of conversations

Statistics

Alcatel OmniPCX 
Office Voice Server

Customization of mailbox

- Welcome/Name
- Notification (signal)
- Answering-only mode
- Personal assistant
- Language
- Password

- Number of calls forwarded / mailbox
- Number of calls forwarded / personal assistant
- Number of messages / mailbox
- Capacity of memory / mailbox

Filtering of messages

Initialization of mailbox

- Recording of name

Automated Attendant

Distribution lists

Personal assistant

- Entry of password

- Previous/Next
- Playback
- Delete
- Send a copy
- Callback

- Previous/Next
- Playback
- Delete
- Send a copy
- Callback
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FEATURES

BASIC SERVICES

- Voice mail unit: all the standard voice mail features are provided, including filtering, personal
assistants, and a mailbox for every user.

- VMU ports: 2 ports are provided for voice mail access in Connected mode; they are included in
the VMU group (1st system group) and in the default OS (Operator Station) group.

- Message storage capacity: 20 minutes

OPTIONAL SERVICES

The following services can be accessed with the appropriate software licenses:

- VMU ports: up to 8 ports; each new port is added to the VMU group and the default OS group
automatically (or by the installer).

- Message storage capacity: the message storage capacity can be extended up to 80 minutes with
an XMEM64 board and up to 200 hours with a hard disk.

- Automated Attendant and Audiotex
- Distribution lists
- Recording of conversations.

Nota : If the Automated Attendant is not open, calls go through to the general mailbox.
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OPERATING MODES: CONNECTED/APPLICATION/CSTA

Application mode (or VMU user with the Mail key)

This mode can only be used by Alcatel OmniPCX Office system subscribers. The voice server is not 
affected by incoming calls, but is activated like any other system application – in this case, by a Mail 
key or by dialing the Mail code defined in the internal numbering plan.

If the required DSP resources (monitoring, recording, and MF detection for analog terminals) are una-
vailable, the server will not be activated.

User interface

In this mode, the method for navigating through the voice server menus depends on the type of termi-
nal:

- 4023, 4034 and Advanced terminals: all operations are performed using soft keys and are gui-
ded by hints on the display.

- 4011, 4012, Easy and Premium terminals:  all operations are performed using the keypad and
are guided by hints on the display as well as by voice prompts and the dynamic menu called up by
the i key.

- 4003, First and analog terminals: all operations are performed using the keypad and are gui-
ded by voice prompts.

Port allocation

Analog ports are not used in Application mode. 

Connected mode (or user with VMU group access code)

In this mode:

- the VMU is accessed by dialing the VMU group directory number (in France, 500).
- the Automated Attendant is accessed by dialing the OS group (in France, 9)
- Audiotex is accessed via the numbering plans DDI and internal.

If the required DSP resources (monitoring, recording, silence/noise, DTMF) are unavailable, the acti-
vation of the server is postponed and the user is camped on.

User interface

In this mode, navigation is performed with the aid of voice prompts, whatever type of terminal is used.
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Port allocation

The CPU board provides from 2 to 8 ports, meaning that up to 8 users in Connected mode can simul-
taneously access the Voice Mail Unit, the Automated Attendant and Audiotex. 

Port addresses: 91-001-1 to 91-008-1; all ports are seen at all times; those that are not "In Service" 
are seen as "Out of Service". 
Each service is called up using the number of a group containing one or more ports. The same port 
can be assigned to 1, 2 or 3 groups.

Reaction on VMU busy

If the server is called by a port directory number, the system recognizes two kinds of busy status:

- 1st-degree busy (up to 2 calls on the same port): new calls are camped on until the port is released;
- 2nd-degree busy (more than 2 calls on the same port): new calls are immediately rejected.

If the server is called by a group number, the call distribution mechanisms on group busy are applied; 
the caller is camped on the group, depending on the number of terminals in the group.

CSTA mode

This is the mode used when the server is accessed via the CSTA interface; for details of how this mode 
is used, see "Visual Mailbox Interface".
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SYSTEM LIMITS

Global constraints (dependent on software keys)

- 2 to 8 VMU ports 
- Storage capacity 20 minutes (CPU), 80 minutes (with XMEM64) or 200 hours (with hard disk)
- 2 to 4 languages

Voice mail

- 250 user mailboxes + 1 general (or common) mailbox
- up to 51 distribution lists (including one broadcast list for all users)
- recording times are limited:

- access to certain features may be barred or dependent on access rights

Service Limit Default value

Welcome message Max.30 seconds, and depen-
ding on available memory: 

- basic CPU: 250 seconds
- with XMEM64: 1000 se-

conds
- with hard disk: 8750 se-

conds

None

Mailbox name Max. 5 seconds None

Message recording Max. 180 seconds 120 seconds

Recording a conversation Unlimited Depends on voice server stora-
ge capacity

Remote notification message Max. 20 seconds 

Service Barring Access right

Remote message notification YES YES

Remote consultation of a mail-
box after message notification

N/A YES

Recording a conversation N/A YES

Personal assistant YES for external destinations NO
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Automated Attendant

- recording times are limited:

Audiotex - information messages

- up to 50 information messages
- recording times are limited:

CONFIGURATION TOOLS

The voice server is configured using the system configuration tool PM5. The configurator PC must 
have a sound card to record the welcome messages and the Automated Attendant menus.

If the PC does not have a sound card, the MMC-station can be used to record enterprise welcome mes-
sages and good-bye messages, Automated Attendant menus and sub-menus, Audiotex messages, dis-
tribution list names and the welcome message for the general mailbox.

Service Limit Default value

Enterprise welcome message Max. 120 seconds None

Announcement menus and sub-
menus

Max. 120 seconds None

Good-bye message Max. 20 seconds None

Service Limit Default value

Enterprise welcome message Max. 20 seconds None

Good-bye message Max. 20 seconds None

Information message Max. 240 seconds 120 seconds
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SYSTEM FEATURES
ACCESS TO THE VMU OR TO THE AUTOMATED ATTENDANT

Nota : You can switch from the VMU to the Automated Attendant at any time by pressing the * key 
and back again by pressing the # key.

VMU response: dial the 
number of the mailbox

Enter password
(4 digits)

Access in Connected Mode (GP 500)

Enter number 
of mailbox Key * 

Automated 
Assistant Menu

Access to 
Automated Assistant

Key # 

Access to user's 
voice mailbox
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AUTOMATED ATTENDANT

Description

The Automated Attendant is only accessible in voice server Connected mode:

- by dialing the enterprise’s public number (outgoing call);
- or by dialing the VMU group number (internal call) or the directory number for the VMU port. The

user then presses the * key to access the Automated Attendant Main menu;
- or exclusively by dialing the VMU group number if the Mailbox Consultation flag (PM5 -> Voice

Processing -> General Parameters -> Mailbox Consultation) is inactive;
- or by dynamic routing:

• level 1: an internal or external call is routed through to the user's mailbox, if one exists: if not,
the 'no mailbox' default function is activated and the call goes through to the Automated Atten-
dant;

- level 2: an external call is routed through to the OS group; if there is no answer, the default OS
group is used and the call goes through to the Automated Attendant (provided the VMU ports
are included in the default OS group).

The Automated Attendant greets the caller with the enterprise welcome message and transfers the call 
to the appropriate destination. To establish communication, all the possibilities open to the caller are 
set out in a Main voice menu and/or sub-menus.

The Automated Attendant can be customized to suit the individual requirements of the enterprise. For 
this reason, the range of options available during working hours is different from that offered out of 
hours. There are consequently two Automated Attendant menus, completely independent from each 
other. The switch between the "Opening Hours" menu and the "Closing Hours" menu can be made 
either manually by the Administrator (by forcing restricted or normal mode) or automatically, accor-
ding to a pre-programmed schedule defined in the system opening hours settings (opening hours = 
normal mode, closing hours = restricted mode).

The Automated Attendant is multilingual: The voice prompt language can be selected by the caller.

Call processing example

For a more detailed look, let's take the example of a caller picked up by the Automated Attendant. First 
of all, he hears the enterprise welcome message. Then he is instructed to press the star key (optional). 

The "Press Star" question is a specific function for establishing whether the correspondent has a set with 
a voice frequency keyboard. 
He can then select the language for the voice prompts (optional). 
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The caller now comes to the Automated Attendant Main menu, in which specific menus are assigned 
to the keyboard keys. He can choose from the proposed Main menu functions:
- Free dialing: the caller is prompted to dial an internal destination number.
- Transfer to subscriber: the caller is routed to a predefined internal number.
- Transfer to operator station: the caller is routed to the OS.
- Information message: the caller hears an information message (which may chain up with additio-

nal information messages).
- General mailbox: the caller is routed to the general mailbox.
- Leave a message: the caller is prompted to enter a mailbox number in order to leave a message.
- Mailbox: the caller is routed to a predefined mailbox.

Notas :

The possibilities available on initialization are specific to each country.

Example of Automated Attendant structure

0 - Not used
1 - Free dialing
2 - Transfer to station
3 - Transfer to OS
4 - Information message
5 - Leave a message
6 - Mailbox
7 - Common mailbox
8 - Release
9 - Sub-menu

Automated Attendant

Mailbox
welcome
message

Enterprise welcome message + optional question 
Press * key + select language (option)

System call

Mailbox
n°

Record
message
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Default function

The "Default function" is obtained when the caller fails to choose a function from the proposed list or 
when the application cannot interpret his choice (the caller may not have a voice frequency terminal).

On initialization, the default function is “Transfer to Attendant".

Direct call

The Automated Attendant can be used at a simple level, replacing the Main menu with a single pos-
sibility. The Direct Call function routes the caller directly to a predefined function after the welcome 
message and the optional "Press Star" and "Select Language" questions. 

Consulting a mailbox

Once he has got through to the Automated Attendant, the caller can access his mailbox directly (if he 
has one) by pressing the # key and entering his subscriber number and password. For a more detailed 
description, see the "Consulting a mailbox" section under "Services available to users".

Notas :

This possibility is not announced by the voice server.

Configuration

To record the 2 welcome messages (opening hours/closing hours):

To record the good-bye message:

To enable/disable the "Press Star" question:

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours-> Voice Prompt - Greeting

- By MMC-station: VMU -> AutoAt -> Day or Night

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Good Bye ->
Voice Prompt - Good Bye

- By MMC-station: VMU -> AutoAt -> GdBye

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> "Press Star" question
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To enable/disable the "Select Language" question:

To define the "Direct Call" function (opening hours/closing hours):

To define the action to be taken in the event of transfer to a non-existent mailbox or in answering-
only mode:

To define the "Default" function (opening hours/closing hours):

Additional information

- For internal calls, only the semi-supervised type of call transfer is available 

- The Automated Attendant only transfers calls to available internal users:
• If the user doesn't answer: the call is transferred and dynamic routing is activated;
- If the user is busy (degree 1 or 2): the call is not transferred and the user is returned to the Auto-

mated Attendant Main menu.

- For external calls, the Automated Attendant transfers the call and goes back on hook regardless of
the called party status; if the call doesn’t get through (e.g. if the line is busy), it comes back to the
Automated Attendant Main menu.

- Role of the * key

• on connection to the Automated Attendant: the enterprise welcome message and the "Press
Star" question are skipped and the caller is prompted to select his preferred language (if con-
figured) or is put through directly to the Main menu.

• while listening to an information message: 
- if the caller accessed the information message from the Automated Attendant Main menu,

pressing the * key while listening to the message brings him back to the Main menu, where
all the options are listed anew;

- if the caller accessed the information message from one of the Automated Attendant sub-
menus, pressing the * key while listening to the message brings him back to the sub-menu,
where all the options are listed anew.

- Role of the # key

• on connection to the Automated Attendant: the caller can consult his mailbox (if he has one);

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> "Select Language" Question 

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> Single Function AA

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> Mailbox Function

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> AA Function
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the enterprise greeting, "Press Star" question and "Select Language" question are skipped.
- while listening to an information message: enables the user to skip the message.
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AUDIOTEX

Description

An Audiotex consists of a sequence of information messages. 

Two mutually independent Audiotex services are provided: one for opening hours, the other for the 
company's closing hours.

One can switch between them either manually or automatically, using the same time ranges as defined 
in the Alcatel OmniPCX Office system.

Activation

Audiotex can be accessed in either of 2 ways (if a menu is available for access to an information mes-
sage):

- by an external call - dialing the Audiotex DDI number, or
- by an internal call - dialing the internal number for the Automated Attendant.

When the caller dials the DDI number for the Audiotex service, he automatically hears the enterprise 
welcome message. The next two stages are optional: 

- He is asked to press the * key to check that he has a voice frequency terminal (this option can be
configured by PM5);

- Then he can select his preferred language for navigating in Audiotex (configurable using PM5).

Finally he will be put through to the first information message; this message may be chained with 
others or followed by forwarding to the OS, for example.

Audiotex 

                ( )Optional

System call

Enterprise welcome message + optional question 
Press * key + select language (option)

Information message 1

+

Information message 2

+

Information message 3
Transfer to Operator Station
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Default function

The default function is obtained when the application cannot interpret the numbers dialed by the caller 
(for example, at the end of an information message, the caller is prompted to dial the number of the 
person he wants to contact). This default function is identical to the one used for the Automated Atten-
dant and must be configured from within the Automated Attendant (see "Default function" in the "Auto-
mated Attendant" chapter).

Role of the * and # keys 

- * key:
• on connection to Audiotex: the enterprise welcome message and "Press Star" question are skip-

ped and the caller is prompted to select his preferred language (if configured) or is played the
first information message;

- while listening to a message: the voice server is released after playing a good-bye message.
- # key: skips the current information message and moves on to the next

Configuration

To set the first information message:

To set the information messages: 

Number of configurable messages: 50.
The various functions at the end of the welcome message are only available with PM5: 
• Not used: if the caller is in the Automated Attendant, then he is returned to the previous level;

if the caller is in Audiotex, the good-bye message is played and the voice server is released.
• Free dialing: the caller is prompted to dial an internal destination number.
• Transfer to subscriber: the caller is routed to a predefined internal number.
• Transfer to operator station: the caller is routed to the OS.
• Information message: the caller is played an information message.
• General mailbox: the caller is routed to the general mailbox.
• Leave a message: the caller is prompted to enter a mailbox number in order to leave a messa-

ge.
• Mailbox: the caller is routed to a predefined mailbox.
- Release: the call is released after playing a good-bye message.

- By MMC-PM5 (Expert View): Voice Processing -> Information Messages -> Audio Text

- By MMC-PM5 (Expert View): Voice Processing -> Information Messages 
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To record the information messages:

To record the 2 welcome messages (day and night):

To record the good-bye message:

 To enable/disable the "Press Star" question:

 To enable/disable the "Select Language" question:

- By MMC-PM5 (Expert View): Voice Processing -> Information Messages 
- By MMC-station: VMU -> InfMsg

- By MMC-station: VMU -> AudTx -> Day or Night

- By MMC-station: VMU -> AudTx -> GdBye

- By MMC-PM5 (Expert View): Voice Processing -> Information Messages ->Audio Text ->
Opening Hours/Closing Hours -> "Press Star" question 

- By MMC-PM5 (Expert View): Voice Processing -> Information Messages ->Audio Text ->
Opening Hours/Closing Hours ->"Select language" question
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MANAGING MAILBOXES

Description

On initialization, every subscriber in the installation (except analog Z terminals) is automatically allo-
cated a mailbox.

Each mailbox can operate in any of 3 modes. The operating mode of each mailbox is configured by 
the installation Administrator (standard mode on initialization):
- Mailbox in standard mode

This mode provides access to a range of functions. The owner can switch between standard mode 
and answering-only mode, but not into guest mode.

- Mailbox in guest mode
This mode, designed for Hotel use, offers more limited functions. Only the "Leave Message" and 
"Consult Message" functions are available; any caller can leave a message to be consulted by the 
guest, but under no circumstances can the guest send any messages. The password is only required 
when the guest consults his mailbox remotely. The guest cannot switch his mailbox into standard 
or answering-only mode.

- Mailbox in answering-only mode
This mode can be adopted by users who don't want to receive messages; the caller hears only the 
welcome message but cannot leave a message, then the server releases the call (if a personal gree-
ting has been recorded).
The owner of a mailbox in answering-only mode can switch it into standard mode and vice versa 
(see "Customization"), but not into guest mode.

First consultation

When the mailbox is used for the first time, the messaging service must be activated from the terminal 
in Application mode. The user is then asked to enter a password and register his name; the mailbox 
is then initialized.

If the user accidentally activates the voice mail unit in Connected mode, he will find that he is refused 
access to his mailbox.
Subsequent consultations can be made in Application mode or Connected mode (see "Operating mo-
des: Connected/Application/CSTA" section).

Nota : The password is only required if the parameter Password required for mailbox consul-
tation (PM5 -> Voice Processing -> General Parameters) is validated; if not, the password 
is not necessary.
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Deleting a mailbox

The Administrator can delete mailboxes. If the mailbox contains messages (read or unread), these are 
kept for X minutes and can be consulted by the user in Application mode; if the mailbox is allocated 
to someone else within the period of X minutes, the messages are lost.

Dead mailbox timeout durations:

- System in "Business" mode: timeout X = 5 minutes
- System in "Hotel" mode: timeout X = 50 minutes

This value can be modified in PM5 (unit = 100 milliseconds; min value = 0; max value = 32767 i.e. 
about 54 minutes): System Miscellaneous -> Memory Read/Write -> Timer Labels -> DeadM-
bTo

Non-Existent Mailbox function 

This function offers the following possibilities in the event of a call being forwarded or put through by 
the Automated Attendant to a non-existent mailbox: 

- Not used: the caller is routed to the Automated Attendant (default setting).
- Free dialing: the caller is prompted to dial an internal destination number.
- Transfer to subscriber: the caller is routed to a predefined internal number.
- Transfer to operator station: the caller is routed to the OS.
- Information message: the caller is played an information message chained to the welcome mes-

sage.
- General mailbox: the caller is routed to the general mailbox.
- Leave a message: the caller is prompted to enter a mailbox number in order to leave a message.
- Mailbox: the caller is routed to a predefined mailbox.
- Release: the call is released after playing the good-bye message.

Nota : This function is also activated for mailboxes in Answer Only mode when the user has not 
personalized the greeting.

Configuration

To define the type of each mailbox: 

To define the action to be taken in the event of transfer to a non-existent mailbox or in answering-
only mode: 

- By MMC-PM5 (Expert View):  Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox -> Options -> Mailbox Mode

- With the Customization function: MbxAnn -> Mode -> Select

- By MMC-PM5 (Expert View): Voice Processing -> Automated Attendant -> Greeting ->
Opening Hours/Closing Hours -> Mailbox Function
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MANAGING THE GENERAL MAILBOX

Description

On initialization, a general (or common) mailbox is created. This mailbox, accessible in consultation-
only mode from the operator station, enables the messages left there to be forwarded to other users 
in the installation.

The caller accesses the general mailbox via the Automated Attendant or Audiotex, providing the Ge-
neral mailbox function has been configured by the Administrator.

Activation

The general mailbox is accessed from an operator station (equipped with soft keys) by:

- pressing the fixed Mail key
- pressing the GalMbx soft key 
- entering the Operator/Attendant password ('help1954' by default).

Nota : For sets without soft keys but with a number pad, proceed as follows:

- press the fixed Mail key or dial the corresponding code
- press the * key
- enter the general mailbox number (= operator/attendant call number as defined in the internal

numbering plan).
- enter the Operator/Attendant password ('help1954' by default).

Additional information

- Not being assigned to any individual subscriber, the general mailbox cannot be customized; only
the welcome message can be configured.

- For the operator, there is no difference in the way general mailbox and private mailbox messages
are notified.

- As with other mailboxes, the general mailbox can only be consulted by one operator station at a
time.

- When the operator forwards messages left in the general mailbox, the transfer data (identification,
date and time) are those of the initial message.

Configuration

To record the general mailbox welcome message: 

- By MMC-PM5 (Expert View): Voice Processing -> Mailboxes -> General Mailbox  -> Voice
Prompt - General Mailbox

- By MMC-station: VMU -> GalMbx
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DISTRIBUTION LISTS

Description

Distribution lists enable users to send and copy messages to all the members on the list simply by dia-
ling the list name or number.

The system allows for a maximum of 51 lists to be compiled:
- 1 general broadcast list (number 000); this list is used to send a message to every voice mailbox

in the system
- 50 distribution lists (001 to 050)
- distribution lists can only be configured by the installation Administrator.

Configuration

To configure the distribution lists by means of users' directory numbers:

Notas :

The content of distribution lists cannot be deleted or modified by the users.
To record the distribution list names:

To key in the distribution list names:

- By MMC-PM5 (Expert View): Voice Processing -> Mailboxes -> Distribution Lists
- By MMC-station: VMU -> List

- By MMC-PM5 (Expert View): Voice Processing -> Mailboxes -> Distribution Lists
- By MMC-station: VMU -> List -> Record

- By MMC-PM5 (Expert View): Voice Processing -> Mailboxes -> Distribution Lists -> Name
- By MMC-station: VMU -> List -> Edit -> Name
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STATISTICS

Description

The statistics are intended for:

- the administrator or operator (i.e. the person responsible for managing the messaging service on
the client side)

- the maintenance service (the distributor, for example).

The statistical function gathers data on the voice server and how it is used. The counter readings cor-
respond to the server activity since the last Reset.

Depending on the results, appropriate changes can be made to the settings in order to improve the 
service. 

Statistics on the Automated Attendant

To read and reset the counters:

- Number of calls received by the Automated Attendant (= number of times the welcome message
was heard).

- Duration of calls for the Automated Attendant.
- Number of failed calls (no response to the "Press Star" question or no caller selection in the Auto-

mated Attendant Main menu).

Nota :  All of these counters can be reset using the Reset function.

Statistics on Audiotex

To read and reset the counters:

- Number of calls received by Audiotex (= number of times the welcome message was heard).
- Length of calls for Audiotex.
- Number of aborted calls (no response to the "Press Star" question or no selection by caller in the

Audiotex main menu).

Nota : These statistics are provided for opening and closing hours. All of these counters can be 
reset using the Reset function.

- By MMC-PM5 (Expert View): Voice Processing -> Statistics -> Automated Attendant

- By MMC-PM5 (Expert View): Voice Processing -> Statistics -> Audiotex
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Information messages statistics

To read and reset the information message counters:

- Number of times each information message was heard (via the Automated Attendant or Audiotex).

Mailbox statistics

To read and reset the mailbox counters for all subscribers:

- Number of calls received by each subscriber (= number of times the welcome message was heard).
- Number of calls received by the personal assistant of each terminal.
- Number of messages left by callers.
- Length of recording of the messages not read by each subscriber.
- Length of recording of the messages read by each subscriber.
- Length of recording of conversations by each subscriber.

Statistics on VMU resources 

To read and reset the counters:

- Cumulative total for voice messages as a percentage of available memory capacity.
- Record of use over the last 7 days.

- By MMC-PM5 (Expert View): Voice Processing -> Statistics -> Information Messages 

- By MMC-PM5 (Expert View): Voice Processing -> Statistics -> Mailboxes

- By MMC-PM5 (Expert View): Voice Processing -> Statistics -> Resources
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HOTEL FEATURES

This chapter deals exclusively with the features provided in Hotel mode (as opposed to Business mode, 
which concerns all the other chapters).

Check-in

When guests check in, they are automatically allocated a mailbox; its mode of operation (guest mode), 
the password, and the language used for the voice prompts are all assigned automatically on check-in.

On consulting the mailbox for the first time, the guest must enter a password and register his or her 
name. The guest cannot consult the mailbox until the user name and password have been registered.

Consulting the mailbox

First consultation

Until the user name and password have been registered, the guest cannot access his or her mailbox. 
The first consultation must be in Application mode (by dialing the Mail code or pressing the Mail key); 
the guest is put directly through to his mailbox and must only register his name.

Subsequent consultations

The mailbox can subsequently be consulted in Application mode or in Connected mode (by dialing the 
VMU or port number).

In Connected mode, the guest has to enter his mailbox number followed by his password.
In Application mode, the guest is directly connected to his messages.

The messages received are automatically played back in sequence. The guest can replay messages 
and use the Return, Pause, Next or Delete functions. Messages that have been listened to but not de-
leted are kept.

Check-out

When the guest checks out, the mailbox is automatically unallocated if it contains no messages. If any 
messages remain, they are kept for 50 minutes, after which time the mailbox is definitively deleted. 
However, these messages can only be consulted by activating the VMU in Application mode from the 
hotel room terminal.
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File
SERVICES AVAILABLE TO USERS
USER INTERFACES

Description

The interface available for using the voice server depends on the type of terminal:

- sets without displays (First, 4003, 5010, 5015 and Z): voice prompts only; the options pro-
posed by the voice prompts are selected using the keypad.

- sets with displays but without soft keys (Easy, Premium, 4011, 4012, 5018, 5022 and
DECT): voice prompts as well as display menus (using the keypad to navigate).
Voice prompt guidance can be disabled with the Customization function (it is enabled on initiali-
zation).

- sets with soft keys (Advanced, 4023, 4034 and 5028): navigation exclusively with soft keys,
depending on the menus displayed.

Specific functions

The # key can be used for:

- confirming the previous data
- skipping the current voice prompt and moving on to the next (e.g. skipping a mailbox greeting to

go straight to the recording stage, or skipping a message in order to access the processing options:
replay, delete, call back, send a copy, etc).

- consulting a mailbox from within the Automated Attendant.

Nota : For decadic terminals, the 9 key is used in place of the # key.

The * key can be used for:

- deleting an item of data
- returning to the previous menu.
- returning to the Automated Attendant menu from the Mailbox menu. 

The 0 key can be used to access any additional menu options when a user consults his or her mailbox.
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Configuration

To set the maximum waiting time for a response from the user. Input a value  (5 seconds by de-
fault): configurable from 5 to 15 seconds in 1-second increments:

To set the number of times the server should repeat messages requiring a response from the user
(to input a value, for example): 2 by default, configurable from 0 to 5:

INITIALIZING MAILBOXES

Description

Mailboxes are initialized by their owners when they entering their individual passwords and register 
their names. These operations are performed when the mailbox is first opened (Application mode 
only).

Activation

Additional information

- On first opening the mailbox: while recording the name, the user can (these options are displayed,
but not announced in the voice prompt):
• restart the recording from the beginning (* key);
- stop and terminate the recording (# key).

- By MMC-PM5 (Expert View): Voice Processing -> General Parameters -> Timeout for user's
response 

- By MMC-PM5 (Expert View): Voice Processing -> General Parameters -> Number of war-
nings if no response

Sets without soft keys Sets with soft keys (SK)

Initialization on first access Mail FK (or "Mail" code) + Pas-
sword + Record name

Mail FK + Password + Record 
name

Service
Type of station
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CONSULTING A MAILBOX (STANDARD MODE) 

The diagram on the next page summarizes the mailbox consultation stages and options.

Description

This service enables users to call their mailbox and listen to any messages received (whether new or 
already heard), listen to recorded conversations and send messages.

This service is protected by a password (the same as for the subscriber); in Application mode, however, 
consultation is possible without a password, depending on the state of the mailbox consultation flag 
(PM5 -> Voice Processing -> General Parameters -> Mailbox Consultation).

Activation

Users access their mailboxes:

- in Application mode:
• sets with a fixed Mail key: using this key (or the appropriate code) 
• sets with displays: Voice key + password.
• sets without displays: password. 
- sets without a fixed Mail key: Mail service code or programmed key + password.

Additional information

- The new message notification mode (voice prompt on going off-hook, LED or icon) depends on the
type of terminal; for analog sets with a LED, a virtual key has to be created. Conversation recor-
dings are not notified.

- Number of messages/conversations:
• sets with displays: the number of messages (old and new) and the number of conversations re-

corded are displayed at the start of the consultation.
• sets without displays: 
• case 1: mailbox containing new messages only: a voice prompt indicates the number of new

messages.
• case 2: mailbox containing old messages only: a voice prompt indicates the number of messa-

ges already heard.
• case 3: mailbox containing new and old messages: only the number of new messages is an-

nounced.
- case 4: the number of conversations is never announced.

- When accessing the mailbox (Connected or Application mode) the "Mailbox -> Please enter the
mailbox number" menu can be opened by pressing the * key before entering the password (this
enables users to access their chosen mailbox).
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Fixed mail key

1 - Messages (read and unread)
2 - Conversations
3 - Send message

Consult Mailbox
1 - Listen
2 - Delete
3 - Call
4 - Next
5 - Back
6 - Copy

Play Back
Messages

Mailbox
n°?

Record
message

Directory number 
of VMU group

Enter mailbox n° 

Default password 
Yes Enter password

(4 digits)

Enter your name
No

Voice

Yes

Invalid entry

Yes

No

Default password

No

Name
registered

No

Record
message
(option)

Name
registered

Yes

Yes

Mail code or
programmed key

Application Mode Connected Mode 

Enter your password

Mailbox
n°?

Password: only if managed by PM5 -> 
Voice Processing -> General Parameters

(or code)
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PLAYING BACK MESSAGES

Description

If at least one message has been left, the user can play back the messages in his mailbox, using a 
range of possible functions (delete, next, replay, send a copy, call back, etc).

Messages are played back in two series: the new messages first, then the old ones. Each series is in 
chronological order.

Caller identification

While the messages are played back, the terminal display indicates:

- the name of the caller - if known, and if the user has the corresponding feature rights
- otherwise, the caller's number 
- **** if the caller has activated the CLIR or "Secrecy" service 
- "Unknown" if the caller number is not recognized by the system.

The identity of the caller is never announced.

Date and time

The date and time of arrival are displayed on the terminal and announced before the message is 
played back.

Call-back

When the caller's identity is known to the system (CLIP: Calling Line Identification Presentation), this 
service enables the user to immediately call back correspondents (whether internal or external) who 
leave a message. The call-back number can contain a maximum of 20 digits. Call-back can be re-
quested while still listening to the message, or afterwards.

There are several possibilities:
- Internal call: internal callers can be called back without restriction. 

• If the VMU was activated in Connected mode, the transfer is of the semi-supervised type:
• If the user doesn't answer: the call is transferred and dynamic routing is activated.
• If the user is busy (degree 1 or 2): the call is not transferred and the user is returned to the mes-

sage playback menu.
- If the VMU was activated in Application mode, the transfer is of the blind type: the application

transfers the call regardless of caller status and immediately goes on-hook; if the call-back fails,
the user has to hang up and call back the VMU (or press Redial).

- External call: The call-back of external callers is governed by barring mechanisms. The VMU
transfers the call when the connection is established (correspondent off-hook) or simulated.
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SENDING MESSAGES

Description

From the consultation menu, the user can send a voice message directly to the recipient's mailbox by 
performing the following operations:

- pressing the Send soft key or dialing code 3
- defining the destination(s) for the message
- recording the message; validating the message sends it to its destination.

Defining the destination

The destination can be:

- the user's name (display terminals only)
- a distribution list name (display terminals only)
- the user's directory number (up to 8 digits)
- a distribution list number (000 to 050).

Notas :

If the terminal has soft keys, the user can browse the destination list. He can then:
- go to the next member 
- go back to the previous member
- delete a member
- delete all the members in the list
- insert a distribution list.

Recording the message

While recording the message, the user can pause (key 8) and then continue the recording (key 8 
again). He can also stop the recording (# key) or start over from the beginning (* key). These options 
are available even though they are not announced (they are displayed, however).

SENDING COPIES OF MESSAGES

Description

This function is identical to sending a message except that the user can also add an introduction (a 
comment telling the recipient that the message is a copy).
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FILTERING MAIL

Description

This function enables users, with the terminal on idle, to monitor messages being left and answer a 
call if desired.

Activation/deactivation

Additional information

- The set's speaker is automatically activated when the message is left.
- This function is only available for idle sets with programmable keys and a loudspeaker.
- The messages that can be filtered correspond to calls to users with fixed or dynamic routing on their

lines; messages sent from a mailbox cannot be filtered.
- The general mailbox cannot be filtered; messages sent from the "Mailbox" menu cannot be filtered.
- Filtering can only be activated for a single message at a time. 
- If filtering is activated while a message is being left, there is no effect.
- The call can be answered by pressing the "Hands Free" key or going off-hook. The part of the mes-

sage left before answering is wiped. After going back on hook, filtering remains active for any new
incoming call.

Service Activation/deactivation

To activate filtering PK: VMU: Screening + Password

Deactivate filtering PK: VMU: Screening 

Deactivate call monitoring PK: VMU: Screening:  stops monitoring and deactivates filtering.

Fixed End key: monitoring of the filtered call is deactivated; the user 
cannot replay the message currently being filtered, but filtering re-
mains active for other incoming calls, which can still be monitored.
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REMOTE NOTIFICATION (OR SIGNALING)

Description

This feature notifies users when someone has left a message for them; a call is emitted by the voice 
server. When the recipient answers, he can consult his mailbox directly, if the service is active.

Notification can be validated for a given time period.

Configuration

To enable external notification, for each subscriber:

In the case of external notification, the call is subject to barring mechanisms.
To activate remote notification of messages in mailbox, for each subscriber:

To set the internal or external destination to be notified, for each subscriber (in the case of external
numbers: 22 digits max., including trunk code):

To define the type of notification, for each subscriber (with or without consultation of mails):

To define the applicable time range for notification, for each subscriber:

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List-
> Details -> Mailbox -> Notification -> check o Subscriber is allowed to activate notifi-
cation

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox  -> Notification -> check o Notification activated

- With the Customization function: Notif (or 5) -> On/Off (or 1)

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox  -> Notification -> ->  Notification Destination

- With the Customization function: Notif (or 5) -> Desti (or 2)

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox  -> Notification ->  Kind of Notification

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox  -> Notification ->  Notify Destination 

- With the Customization function:  Notif (or 5) -> Sched (or 3)
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To define, for all subscribers, the delay before the 2nd and 3rd notification call (the default values
are country-specific):

RECORDING A CONVERSATION

Description

This function enables authorized users to record ongoing telephone conversations. The recorded con-
versation is stored, with its date and time stamp, in the user's mailbox.

Activation/deactivation

Configuration

To authorize conversation recording, for each subscriber:

To program a key with the "Conversation recording" function:

Additional information

- The maximum recording time depends on the server's memory capacity.

- By MMC-PM5 (Expert View): Voice Processing -> Mailboxes -> Miscellaneous->  Notifica-
tion: Minutes till second/third alert

Sets without soft keys Sets with soft keys

To activate recording PK: VMU: Conversation Recor-
ding or dial the function code

Record SK with pause and re-re-
cord options

Deactivate recording (the 
conversation continues)

PK: VMU / Conversation Recor-
ding or dial the function code

Stop SK

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox -> Options  -> check o Recording of conversation allowed

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys -> Voice Mail: Conversation recording

Service
Type of station
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PLAYING BACK RECORDED CONVERSATIONS

Description

This function enables authorized users to listen to the conversations they have recorded, using replay, 
delete, send a copy, call-back, etc.

 Conversations are played back in reverse chronological order.

Activation/Deactivation

Sets without soft keys (with dis-
play)

Sets with soft keys

To activate playback Fixed Mail key + 1 + Password + 
2

Fixed Mail key +  Voice SK + Pas-
sword +  Conv SK

Service

Type of station
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PERSONAL ASSISTANT

Description

Incoming calls forwarded to the voice server are routed to the user's mailbox or the user's personal 
assistant (depending on the configuration).

If the call is forwarded to the personal assistant, the caller is put through to the Main menu, enabling 
him for example to leave a message (so that he can be called back) or to be transferred to the reci-
pient's mobile terminal.
For the caller, forwarding to the mailbox or personal assistant is guided by voice prompts only.
If the personal assistant is activated:
- the caller is informed that the person cannot be reached
- he then listens to the various options offered by the personal assistant (transfer to the operator sta-

tion or to a predefined internal/external destination)
- then he hears the voice prompt for his chosen option.

Forwarding to the personal assistant is immediate, and is activated from the set customization menu; 
the personal assistant voice prompt is pre-recorded and cannot be customized.

Notas : Option 1 - Mailbox is proposed automatically, even if the personal assistant has not been 
configured, whenever the function is validated.

Even if the personal assistant has not been validated, the Operator station can still be rea-
ched by dialing the attendant (operator) number during the mailbox announcement (blind 
transfer to OS).

y
to its personal assistant

1 -  Mailbox 
2 -  Colleague
3 -  Mobile
4 -  Outside line
5 - Switchboard

Personal assistant Mailbox
welcome
message

Record
message

Yes

1
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Configuration

To activate the personal assistant, for each subscriber:

To configure, for each subscriber, the options proposed by the personal assistant (in the case of
external numbers: 22 digits max., including trunk code):

To enable an external caller getting through to a personal assistant to reach an outside number. If
these parameters are not configured, the external-to-external transfer will fail (see "Additional in-
formation"):
• For each VMU port:

- For the system as a whole:

Additional information

- Blind transfers are used.
- If the external/external transfer fails, the system's response will depend on the configuration and in

particular on the Go to initiator if transfer fails flag (accessible via PM5 under System Miscel-
laneous  ->  Feature Design): 
• If the flag is not positioned (the default setting for France, Italy and Spain), the call is routed to

the OS;
- If the flag is positioned (the default setting for all other countries), the voice server is called back

in Automated Attendant mode. If the Automated Attendant is not open, the call goes through
to the general mailbox.

- Destination number: 
• external numbers must include a network access prefix. 
• external numbers are subject to barring checks.
- if the predefined number is invalid or barred, the call is returned to the personal assistant menu.

- With the Customization function: Assist (or 2) -> On/Off (or 1)

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Mailbox  -> Personal Assistant -> Transfer to secretary/operator/home/
mobile phone

- With the Customization function: Assist (or 2) -> Menu (or 2)-> IntNum, ExtNum, Mobile or
Operat (or 1, 2, 3 or 4)

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Features -> Part 2 -> "Join Incoming and Outgoing"

- By MMC-PM5 (Expert View): System Miscellaneous -> Feature Design ->check Transfer Ext/
Ext

- By MMC-PM5 (Expert View): System Miscellaneous  -> Feature Design  ->check Transfer Ext/
Ext by on-hook
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CUSTOMIZATION

Description

Customization allows users to define their own set, voice mail and personal assistant settings. 

Entering customization mode

Depending on the type of terminal, press the Custo key (2nd page, Advanced terminal on idle) or i + 
5 or dial the "Enter programming mode" function code.

The following pages set out the proposed branching structures for each type of terminal; navigation is 
done using soft keys or by codes (with assistance from voice prompts).

Additional information
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Sets with soft keys

OK

OK

Activate/deactivate

OK Validate current selection

OK Validate current selection

OK Validate current selection

OK Validate current selection

MBXANN

Mailbox: welcome message

CUSTOM

LISTEN

RECORD PAUSE

RECORD

DEFAULT

YES

NO

MODE SELECT

PERATT ON/OFF

OPTION

CODE

LANG

NOTIF ON/OFF

NUMBER

SCHED

SELECT

Remote message notification

Record personal greeting 

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Mailbox utilization mode:
standard or answering-only

Activate/deactivate personal assistant

Select user language from available options

Activate/deactivate notification of new messages

Number of the station to notify

Applicable time range for notification

Personal assistant

Custom options

MELODY Choose ringing tune

CNTRST

PHONE

HEADST

Station settings

SELECT Activate/deactivate headset mode

EXTNUM

OPERAT

HANDY

Route to operator station

MENU

STOP

Keep recorded personal greeting

SELECT

Pause recording

Stop recording (End)

Re-record

SELEC

MELODY

LEVEL+

SCREEN

ICON

Set ringing tune volume 

Set display contrast

Set icons contrast

Route to internal number

Route to external number

Route to mobile station

MODIFY

DISABL

Modify destination number

Validate current selection

Deactivate selection

Change personal code (enter old code followed by new code)

NAME RECORD RECORD

STOP

Record user's name Re-record

Stop recording (End)

INTNUM

MODIFY

Validate current selection
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Sets without soft keys but with displays

1
Mailbox: welcome message

1

LISTEN

RECORD1 PAUSE8

*2

DEFAULT3 YES1

NO2

MODE5

PERATT2 ON/ OFF1

INTNUM

OFF2

1

EXTNUM2

4 OPERAT

HANDY3

OPTION4 CODE1

LANG2

VOICE3

NOTIF5 ON/ OFF1

NUMBER2

SCHED3

ON1

OFF2

ON1 Activate personal assistant

Select user language from available options

Number of the station to notify

Applicable time range for notification

Remote message notification 

Personal assistant

Custom options

MELODY1MELODY Choose ringing tune

CNTRST Adjust display contrast

PHONE3 1

2

HEADST3

Station settings

ICON1

MENU2

STOP#

Keep recorded personal greeting

RECORD1

SIMPLE2

Mailbox in standard mode (answering and recording)

Mailbox in answering-only mode

Activate remote notification of new messages

Deactivate remote notification of new messages

1 ACTIVE

2

Activate voice prompts on station

Deactivate voice prompts on station

Record personal greeting Pause

Stop recording (End)

Re-recordListen to (personal or default) greeting

Delete recorded greeting; select default greeting

Deactivate personal assistant

LEVEL+2 Set ringing tune volume 

INACT

1 ACTIVE

2

Activate headset mode

Deactivate headset mode

Route to operator station

Route to internal number

Route to external number

Route to mobile station

MODIFY1

DISABL2

OK#

Modify destination
number

Validate current
selection 

Deactivate selection

Change personal code (enter old code followed by new code)

1 4

NAME4 RECORD1 *

STOP#

Record user's name

Stop recording (End)

Re-record

MBXANN CUSTOM

RECORD

RECORD

to

INACT

Activate/deactivate 

Validate current 
selection

MODIFY1

OK#
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Sets without displays and without soft keys

1 1 8

*2

3 1

2

5

2 1

2

4 1

4 *

#

5 1

2

3

1

2

1

3 1

3

1

2

4

3

2

1

22

#

1

2

#

2 1 4

1

#

1

2

#

1

2

6 0 9 On-hook

Mailbox: welcome message

Personal assistant

Custom options

Mailbox in standard mode (answering and recording)

Mailbox in answering-only mode

Activate personal assistant

Deactivate personal assistant

Record user's name

Activate remote notification of new messages

Number of the station to notify

Applicable time range for notification

Remote message notification

Choose ringing tune

Station settings 

Activate headset mode

Pause

Stop recording (End)

Re-record

Deactivate selection

Stop recording (End)

Re-record

Set ringing tune volume

Deactivate headset mode

Deactivate remote notification of new messages

Confirm current tune

Change personal code (enter old code followed by new code)

Keep recorded personal greeting

Record personal greeting

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Select user language from available options

Modify destination number

Route to operator station

Route to internal number

Route to external number

Route to mobile station

to

Validate current selection

Activate/deactivate

Internal/external n° to be saved

Programming the personal directory
to

Validate current selection
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Analog Z terminals 

1 1 8

*2

3 1

2

5

2 1

2

4 1

4 *

#

5 1

2

3

1

2

1

1

2

4

3

2

1

22

#

1

2

#

2 1 4

1

#

6 1

7 1

Mailbox: welcome message

Personal assistant

Custom options

Mailbox in standard mode (answering and recording)

Activate personal assistant

Deactivate personal assistant

Record user's name

Activate remote notification of new messages

Number of the station to notify

Applicable time range for notification

Remote message notification

Pause

Stop recording (End)

Re-record

Deactivate selection

Stop recording (End)

Re-record

Deactivate remote notification of new messages

Change personal code (enter old code followed by new code)

Keep recorded personal greeting

Record personal greeting

Listen to (personal or default) greeting

Delete recorded greeting; select default greeting

Select user language from available options

Modify destination numberRoute to internal number

Route to external number

Route to mobile station

Validate current selection

Activate/deactivate

Activating general call monitoring (OS help)

Deactivating general call monitoring

Decadic stations use the 9 key for validation; the functions accessible with the * key are not available
(even though they are announced)

Route to operator station

Validate current selection
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File
 "VISUAL MAILBOX" INTERFACE
OVERVIEW

Description

The "Visual Mailbox" interface gives Alcatel OmniPCX Office users access to mailboxes via the PC-
based application PIMphony. It provides:

- easier and more intuitive navigation thanks to the services offered by the integrated voice server;
- direct access to voice server functionality without having to manipulate the telephone.

The main services available are:

- Backup messages/conversations on the PC
- Consult new mail 
- Consult recorded conversations
- Insert into Outlook
- Send mail
- Record new messages.

Copy messages with or without adding a comment.

The "Visual Mailbox" interface can be used either:

- on the telephone terminal, or
- on the PC, if it has a sound card.

Environment

The user workstation consists of:

- a Z, DECT or Reflexes terminal (connected to the system by a UA, DECT, analog or IP link) and a
PC connected to the LAN (the system must also be connected to the LAN);

- or simply a multimedia PC (PIMphony IP Edition) connected to the LAN.

Z

User workstation

LAN
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SERVICES PROVIDED

The application enables you to initialize and configure the password required for access to the messa-
ges window.

Mailbox supervision 

The "Mailbox" icon in the toolbar indicates whether all the messages have been heard or whether there 
is at least one new message. 

Clicking the icon opens the "Visual Mailbox" window, containing information on all the messages and 
conversations stored in the mailbox:
- date and time of message
- type of message: voice mail or recorded conversation
- caller identity: name registered in PIMphony, PABX name or number
- the length of the message
- message status: new or old.

The information list is updated dynamically each time a message arrives in, or is deleted from, the 
mailbox, or changes status from "new" to "read". This is represented by 2 distinct icons: the application 
also synchronizes the status of the LED on the set (signaling the presence or absence of new messages).

Handling messages

Messages/conversations are viewed in list form in the "Visual Mailbox" window.

A set of static buttons are available for:

- deleting items 
- playing them back
- copying them, with or without a comment
- recording a new message
- creating or displaying the caller's Outlook file
- calling back the person who left the message (if their identity is linked to the voice message).

Dynamic buttons appear during playback.

Remote notification of new messages (copy to Outlook mail client)

The "Follow Me" function enables authorized users to receive e-mail on the local PC to advise them that 
a new message has arrived in their mailbox.

The voice message is inserted as an attachment to a new message in the main Outlook message list. 

This option is configurable.
This function requires Outlook to be installed locally. 
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MANAGING THE TERMINAL

Entering VMB mode 

The terminal acts as the audio input/output for recording and playback services.

When a new voice mail is detected, the server informs the terminal (the LED flashes) and the PC (the 
"Mailbox" icon changes state). Pressing the "Listen" key in the "Visual Mailbox" window has the following 
effect:

- the terminal goes directly to Hands Free mode; alternatively, it rings and the user has to pick up
the receiver. The user then hears the new message.

- the display is updated ("Visual Mailbox").
- all the terminal keys except End, Loud+, Loud-, off-hook and on-hook are disabled.
- the terminal is now considered busy (incoming calls entrants are camped on); with PIMphony, calls

can still be taken.

Quitting VMB mode 

The terminal quits this mode after:

- going on-hook or pressing END
- closing the VMB window
- after an inactivity timeout of 2 min 30 sec.
Ed. 04 3/4Réf. 3EH 21000 BSAA



"VISUAL MAILBOX" INTERFACE CALL SERVER : INTEGRATED VOICE
MAIL UNIT

 

Ed. 044/4 Réf. 3EH 21000 BSAA



5

EXTERNAL VOICE MAIL UNITCALL SERVER : INTEGRATED VOICE 
MAIL UNIT

 

File
EXTERNAL VOICE MAIL UNIT
From version R1.1 onwards, an External Voice Mail Unit ("external VMU"), using the VPS protocol, can 
be utilized in place of the integrated voice server.

The external VMU is connected to the Alcatel OmniPCX Office system by analog links (SLI boards). 

The following integrated voice server features are no longer available when an external VMU is used:

- Personal Assistant
- conversation recording
- voice mail filtering
- Audiotex
- integrated Automated Attendant 
- general mailbox
- visual mailbox (PIMphony)

ACTIVATION/DEACTIVATION

Activating the external Voice Mail Unit

Activating the external VMU has the following effects:

- The keys and other data defined for the integrated voice server are not used by the external VMU;
- on each terminal, the number of messages received is set at 0 and the Message LED is off.

Reactivating the integrated voice server

When reactivated using PM5, and provided the settings are coherent, the voice server takes up from 
where it left off (with all statuses and voice mail recorded) before the switch to the external VMU.
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CONFIGURATION

The integrated voice server is used by default.

With PM5 (but not with MMC-station), the integrated voice server can be deactivated in order to ope-
rate with the external VMU. This deactivation has to be confirmed; using the external VMU calls for the 
following additional adjustments:

- defining the links between the external VMU and the SLI equipment
- allocating the external VMU ports to the OS group and VMU group
- checking that the VPS codes are compatible with the numbering plan
- reprogramming the VMU access keys
- adapting the dynamic routing settings to the VMU for each user with a mailbox.

To deactivate the integrated voice server:

To specify the SLI equipment for connection to the external VMU:

To check, for each SLI device, that camp-on on busy is authorized and that it has intrusion and
warntone protection:

To add the directory numbers of the Voice mail equipment to the OS group in order to run the Auto-
mated Attendant function with the external VMU:

To create a VMU group:

- By MMC-PM5 (Expert View): Voice Processing -> Activate Voice Processing -> o Deactivate
Voice Processing -> click Yes to confirm

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Misc -> Special function = Voice Mail Unit

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details - > Features -> check o Camp-On Allowed, o Intrusion Protection o Warntone
Protection  

- By MMC-PM5 (Expert View): List of operator groups -> Details -> Modify -> Add 

- By MMC-PM5 (Expert View): List groups -> Details -> Modify -> Add 
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For Reflexes terminals and analog sets with a Message LED: to create a "Voice Mail" key (virtual in
the case of analog terminals) assigned with the VMU group number:

To adapt dynamic routing of level 1 and/or 2 (forwarding to general level): if the box is checked,
the call is forwarded to the Automated Attendant on the external VMU; otherwise it goes through
to the user's mailbox.

To check the coherence of the internal numbering plan for the "Mail Booking" and "Cancel Mail
Booking" functions (used by the VPS protocol): 

To check the values of the other VPS codes defined by labeled addresses relative to the numbering
plan: 

To return to integrated voice server mode (check that the settings are coherent!):

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Keys -> Function Keys = Voice Mail Unit (or Vir. keys -> check o Voice Mail
Unit and enter the VMU group number) 

- By MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers/Basestations List
-> Details -> Dyn. Rout. -> check or uncheck o VMU as Auto. Attendant (lev 1) and/or
o VMU as Auto. Attendant (lev. 2)  

- By MMC-PM5 (Expert View): Numbering -> Numbering Plans -> Internal Numbering Plan  

- By MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Other labels
-> VMCodBsyTo, VMCodCall, VMCodCnsTo, VMCodDiaTo, VMCodDirCl, VMCodFwdCl,
VMCodOosTo, VMCodRecCl, VMCodRecal, VMCodRelea, VMCodRgToE, VMCodRngTo 

- By MMC-PM5 (Expert View): Voice Processing -> Activate Voice Processing -> o Activate
Voice Processing
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ADDITIONAL INFORMATION

For systems operating with an external VMU, the following particularities needed to be taken into con-
sideration:

- Message notification: as with the integrated voice server, the presence of new messages is signaled
by icon/LED or by voice prompt on going off-hook, depending on the type of terminal.

- Number of messages: with the external VMU, users are not shown the number of messages:

• sets with displays: the sign "+1" means at least one message is available;

- sets without displays: on picking up the handset, the user hears a specific tone signaling the
presence of new messages.

- Consulting the mailbox: mailbox consultation is still accessed by pressing the Mail key or by dialing
the Mail function code; on connection to the external Voice Mail Unit, the user is guided by the voice
prompts (soft key navigation is no longer available).

- Customization: all the voice server options contained in the customization tree structure are disa-
bled.

- General Mailbox soft key: the display on terminals in the OS group no longer offers a soft key for
calling the general mailbox.
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GENERAL
ETSI STANDARD

The DECT protocol is based on pico-cellular technology (cells of 30 to 150 m depending on the envi-
ronment) allowing high traffic throughput: up to 10000 E/km2.

The frequency band used is between 1880 MHz and 1900 MHz (UHF) i.e. a passband of 20 MHz. 
These 20 MHz are split into 10 radio channels.

The passband of a radio channel is 1.728 MHz and radio channels are spaced 2 MHz apart to avoid 
interference between adjacent channels.
The DECT system is based on the use of FDMA (frequency multiplexing) and TDMA (time multiplexing) 
techniques. It thus has a maximum capacity of 120 simultaneous communication channels (10 radio 
frequencies x 12 time slots).

GAP (Generic Access Profile): part of the DECT protocol required for interworking by cordless handsets 
from different manufacturers.

PRINCIPLES

The DECT features integrated into the Alcatel OmniPCX Office system allow for the creation of a wire-
less PABX. 

The DECT features are offered by 4070 IO/EO base stations connected to UA Reflexes interfaces (UAI 
boards).

A radio base station can support up to 6 communication channels simultaneously, on 2 UA links. 

The base stations have a range of:

- 150 meters over open ground
- 30 to 50 meters horizontally and 7.5 meters vertically in an enclosed space
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DECT UA/GAP SYSTEM

A DECT system managing the UA/GAP (Generic Access Profile) protocols allows simultaneous use of 
the following cordless handsets: 

- DECT UA + GAP cordless handsets (Mobile Reflexes, 4073 GS, 4074 Gx handsets; Reflexes DECT
sets) 

- third party DECT GAP cordless handsets (the available features may differ).

Cell

DECT set: Alcatel 
Mobile Reflexes, 4073,
4074 or 
Reflexes DECT sets or 
GAP DECT set

Base 1

Coverage area

Operator station

PUBLIC
NETWORK 

Base 2

Base 3

Intercell handover zone
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AVAILABLE FEATURES

Mobility management

- roaming
- intracell handover  (on the same base station)
- intercell handover  (between base stations).

System access and dynamic channel selection

Before making or receiving calls, the handset must obtain information about the environment in which 
it is being used to ensure that it does in fact have access to the system.

To enable the handset to synchronize itself with the system, each base station is always active on at 
least one radio channel (the dummy bearer), broadcasting information concerning the system and its 
identity. 

Any handset will thus be able to recognize the system coverage area in which it is working. When on 
standby, each handset is tuned to the nearest base station, receptive to search messages indicating an 
incoming call.

Channels are allocated dynamically when requested by the handset. Once synchronized with the sys-
tem, the handset decides on the most appropriate channel for a communication. It chooses the least 
disrupted of the free channels.

Inter- and intra-cell handover procedures

The coverage radius of a DECT radio base station forms a "cell".

Intercell handovers to another cell are commanded by the handset when the signal from the active 
base is weak and there is a stronger base in the vicinity. During the communication, the mobile re-
quests an appropriate available channel from the second base. Once the second link has been esta-
blished, it releases the first one, maintaining the communication on the second base.

If transmission errors arise, an intracell handover is performed on the same base station towards a 
higher quality channel.

GAP MODE: GENERAL

By default, Alcatel DECT GAP handsets operate in proprietary mode (i.e. like Reflexes sets); third party 
DECT GAP handsets usually operate in basic mode (though some may operate in advanced mode):

- basic mode: this mode offers a reduced level of operation (no enquiry call, no call waiting, no dis-
play management, etc.)

- advanced mode: this mode offers access to a level of operation essentially equivalent to that of an
analog Z terminal (all functions defined by feature access codes).

With PM5, the mode of each set can be modified individually at the registration stage.
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INSTALLING 4070 IO/EO BASE 
STATIONS
CAPACITIES

The following limits must be respected (number of bases remotely supplied by the system) for each Al-
catel OmniPCX Office solution:

CONNECTION

The 4070 IO base station is designed for internal installation, and the 4070 EO for external installa-
tion. They are connected up to the RJ45s on the UAI board. 

A 4070 IO/EO base station with a single UA link can be connected up to any UAI board interface; the 
UA link will be connected to the "master" (wires 1 and 2).

Wiring

Local Power Supply

- The mains adapter serves as a sectioning device
- The surface socket must be installed as close to the base as possible and must be easily accessible.

e-Xs S / e-S M / e-M L / e-L XL / e-XL Max. limits

4 4 8 20 40 60

14

Terminal board

1: L1
2: L2
3: L1
4: L2

To UA1

To UA2
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CONFIGURATION

- Define the length of the line: because the connection distances between the modules and the base
stations (1200m max.) differ, you must compensate by making the propagation length more or
less identical. The following choices are available:
• short line: 0 to 400 m (default value)
• medium line: 400 to 800 m
• long line: 800 to 1200 m

This programming operation is necessary to install the base station. If modified during use, the 
base station will be reset (regardless of any communication in progress).

- Define the number of antennae used: it may be necessary to cancel antenna diversity for specific
needs.

In the event of modification during use, the base station will be reset (regardless of any communi-
cation in progress).

- Define the DECT frequencies used: a 4070 IO/EO base station can operate with 1, 2, 4, 5, 8, or
10 frequencies. When booted up, all 10 frequencies are available.

By MMC-PM5, select:
 Subscribers/Basestations List -> Subscribers/Basestations List -> IBS Master -> Details -> 
Line Length.

By MMC-PM5, select:
 Subscribers/Basestations List -> Subscribers/Basestations List -> IBS Master -> Details ->  
Antenna Diversity  -> No Diversity = 1 antenna; Diversity = 2 antennae.

By MMC-PM5, select:
 System Miscellaneous -> Memory Read/Write -> Debug Labels -> "Dect_Freq" -> enter the 
2-byte value corresponding to the mask for the desired frequencies.
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The default value of the mask is 03FF (all 10 frequencies used); this value must only be modified 
under particular installation conditions, normally outside Europe.

Carry out a warm reset of the system, or reboot each base station individually.

INSTALLING THE BASE STATIONS

To install the base stations, follow the steps below:

- position the base stations (depending on the result of the coverage studies)
- connect the base stations
- power down the system 
- by MMC-PM5:

. if necessary, modify the numbering plan and the account codes table

. give a name to each station installed

. if necessary, modify the value associated with the "Line length" parameter 

. create the DECT accesses then declare the type of station (DECT UA) or use automatic registra-
tion (DECT GAP)

. the default value being the same for all the systems, modify (if necessary) the PABX ARI value
by configuring it with the ARI from the manufacturer

. complete the system settings (trunk groups, call barring, etc).

PROGRAMMING EFFECT ON SYSTEM

Value of mask ( "Dect_Freq" ad-
dress)

Chosen fre-
quencies

Mask validated by the system Validated fre-
quencies

Hex Binary Num-
ber

Range Hex Binary Num-
ber

Range

03FF 0000 0011 1111 
1111

10 1 - 10 0000 0011 1111 
1111

10 1 - 10

003F 0000 0000 0011 
1111

6 1 - 6 0000 0000 0000 
1111

4 1 - 4

0282 0000 0010 1000 
0010

3 2, 8, 
10

0000 0000 1000 
0010

2 2, 8

0000 0000 0000 0000 
0000

0 none 0000 0011 1111 
1111

10 1 - 10

003C 0000 0000 0011 
1100

4 3 - 6 0000 0000 0011 
1100

4 3 - 6
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CONFIGURING THE SYSTEM
Configuring the system's DECT mobile functionality consists in programming the ARI number and the 
GAP authentication code (if necessary). Both of these parameters must be completed before registering 
a set on the system.

Before starting the DECT configuration, the numbering plan must be defined and the hardware con-
figuration (installing interface boards, recognizing sets, etc) completed.

ARI NUMBER 

The ARI (Access Right Identifier) number identifies the system uniquely to mobiles. It contains 11 octal 
digits (base 8). This number, assigned to an ETSI base by the installer, must be entered on installing 
the system.

It is structured as follows:

- the ARC (Access Right Code) specifies the usage environment (private, public, etc); in the case of
Alcatel OmniPCX Office, a type-B ARI is allocated by the DECT protocol (ARC = 1, non modifiable)

- the EIC (Equipment Installer Code) is the number assigned by ETSI to each maker or distributor
offering DECT systems

- the FPN/S (Fixed Part Number/Subnumber) is a number entered by the installer: each system ins-
talled by the same installer must have a different number.

- To enter the system ARI number with PM5 (Expert View):

-  To enter the system ARI number with MMC Station:

Important : The ARI number must be modified by the installer (in accordance with the above rules) 

Select: System Miscellaneous-> DECT ARI/GAP Authentication-> enter the ARI number (the sys-
tem deduces the EIC, FPN and FPS fields automatically).

Select DECT -> ARI -> enter the ARI number and validate by clicking OK

0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 1  1 1 1 0
ARC EIC

0 0 0 1 1  1 1
FPN FPS

ARI

1 0 0 0 0 4 3 6 0 7 4
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before registering any DECT sets.
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GAP AUTHENTICATION

This service secures data exchange between the system and the DECT GAP handsets. 

An authentication code can be sent by the mobile to the system during the registration procedure. This 
code is then compared with the one configured in the system. If it matches, the registration of the set 
can continue; if not, it is stopped.

- To define an authentication code with PM5 (Expert View):

- To define an authentication code with MMC Station:

REGISTERING A GAP HANDSET

DECT sets are identified by their IPUI N (International Portable User Identity type N). Each handset has 
a different IPUI N number, used when the set is declared to the system.

In the case of a DECT GAP handset, the IPUI N and ARI parameters are exchanged automatically du-
ring the registration procedure. It is through these parameters that the system recognizes the handset, 
and vice versa.

Procedure with PM5

On the mobile

Procedure with MMC Station

Select: System Miscellaneous-> DECT ARI/GAP Authentication-> check o Activate GAP 
Authentication -> enter a code of between 4 and 8 digits in Authentication code

Select DECT -> AuthCd -> enter a code of between 4 and 8 digits and validate by clicking OK

Select DECT -> Authen -> activate or deactivate with Choice and validate by clicking OK

Select: Subscribers/Basestations List-> Subscribers/Basestations List-> Add -> add the requi-
red number of DECT accesses by selecting  DECT handsets  and the number of devices, then vali-
date by clicking OK

Select Subscribers/Basestations List -> Subscribers/Basestations List ->  GAP Reg. -> The 
GAP registration procedure is under way when the Register GAP Handsets window appears.

 Launch the registration procedure on the handset (refer to the accompanying documentation).

As soon as the mobile's IPUI number appears, select an unassigned number mobile and click Assign. 
The IPUI number, preceded by the mobile number, then appears in the Assigned Handsets window 
Ed. 04 3/4Réf. 3EH 21000 BSAA



CONFIGURING THE SYSTEM CALL SERVER : MOBILITY

 

Basic GAP and Advanced GAP 

In certain instances, the handset shown in the Unassigned IPUIs window may be a GAP type set; if so, 
you can select the preferred mode: basic or advanced. 

Select DECT -> Add -> GAP -> The message "In Progress…" is displayed; the registration proce-
dure is under way.

Launch the registration procedure on the handset (refer to the accompanying documentation).

When the mobile's IPUI number appears, validate by clicking OK.

The mobile is registered and a number is automatically assigned to it.

Select the IPUI number and click Modify Mode.
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IMPLEMENTING MOBILE REFLEXES 
HANDSETS 
REGISTERING THE HANDSET

In new sets, the battery included is factory pre-charged. When the terminal is brought into service, the 
residual charge level is usually enough to power the registration stage. 

Fit the battery into the handset and check that the level of charge is adequate (full or half-charge icon); 
if not, put it on charge.

Start the registration procedure on the PABX.

When the system is ready, continue with the handset.

Step A

Turn on the handset by a long press on  and observe the screen display.

- If the set is new (never been assigned) and has enough battery charge, the display shows "SYSTEM

1 Auto install ?" ; go to Step B.
- If the set does not display "SYSTEM 1 Auto install ?", it is already assigned on another system; go

to Step C.

Step B

- If the installation doesn’t use the authentication function (AC code), go directly to Step D for the
simplified procedure.

- If the system uses an authentication code, configure the AC code as described below, and move
on to Step D to complete the association process.

Select "AC" option Dial the "AC" code 

Launch
subscription?

Configure
AC Code?

AC Code
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Step C

Step D

Launch the registration procedure. 

After registration, the set switches automatically to the main language of the PABX.

Select the "installa-
tion" function 

Dial the code 
(314987)

Select a free system Select the "Install" function 
and proceed with step D

Launch the association process 

Launch
subscription?

SYSTEM 1
Subscription
running…
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UNINSTALLING HANDSETS

It may be necessary to uninstall a handset when it is no longer used on the system or when the terminal 
is replaced. The operation must be performed simultaneously on the system and on the terminal.

IMPORTANT

We recommend performing the operation on the terminal (as described below) before deleting it from 
the system. If this sequence is reversed, it is still possible to delete data from the terminal, but this has 
to be done outside the radio coverage area.

Select the "installa-
tion" function 

Dial the code 
(314987)

Select the system to 
be uninstalled

Validate the "Unins-
tall" option 

Confirm the uninstall 
operation

Password?

Uninstall
Edit name
Read PARK

SYSTEM 1
Remove
Subscription?
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UTILIZATION / AVAILABLE FUNCTIONS 

Basic terminal functions (accessible in GAP or AGAP mode)

- Lock / unlock keypad (long press on )
- Activate/deactivate keypad beep, key beep, radio beep, vibrator * back lighting **

- Quick switching from ringer to vibrator * (long press on )
- 3-level reception volume adjustment with storage of the most recent setting
- Registration possible on 5 different GAP systems 
- Special radio test function (see "Radio Test Mode ")

* Mobile Reflexes 100 

** Mobile Reflexes 200/200 Ex

Functions specific to simplified GAP mode 

In GAP mode, the following functions should be available (unless inhibited by system constraints):

- Manual language selection for the local menu 
- Choice of ringing tunes
- Personal speed dial
- Local redial 
- DTMF end-to-end signaling
- Calibrated loop

Functions specific to AGAP advanced mode 

 Outline of the main functions available, built into the PABX:

- Diversion and cancel diversion
- Audio and text message consultation 
- Dial by name / collective speed dial
- Personal speed dial (system numbers)
- Automatic language configuration 
- Choice of ringing tunes
- Interactive features in conversation 
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MAINTENANCE OPERATIONS 

Reading the handset software version number 

Note: each terminal model has its own identification prefix:  70 xxxx for Mobile Reflexes 100 models 
and 60 xxxx for the Mobile Reflexes 200 models.

Reading the handset IPEI number (handset ID)

Resetting the EEPROM

This function restores the terminal to its factory settings, i.e. associated with no system and containing 
no saved data.

- Turn the handset off and on again, simultaneously pressing On-hook, Off-hook and i.

- Select EEPROM Reset and validate.

Select the "installa-
tion" function 

Dial the code 
(314987)

Read version 
n° 

Select the "installa-
tion" function 

Dial the code 
(314987)

Read the IPEI

Password?

Password?
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Quitting battery security mode 

The set can activate automatic security mode on the battery in the event of a short circuit, a critically 
flat battery (after several weeks without charging) or an excessive charge voltage. Some of these inci-
dents may arise when the handset suffers a violent impact. 

When security mode is activated, the mobile is powered down and will not come back on.
To deactivate security mode:
- remove the battery and replace it in the mobile
- place the handset (turned off) on the charger
- press the handset "on" key without removing it from the charger.

RADIO TEST MODE

Activating radio test mode

To activate radio test mode:

- turn off the mobile by a long press on 

- turn it back on by pressing simultaneously on ,  and 

- when the display comes on, do a long press on 

The screen displays the state and reception level measurements. 
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Description of radio test mode functions 

STATE / RSSI (state / reception level)

Mobile transmission status 
L: mobile synchronized with system (no communication established)
C: DECT link active between base station and mobile (in communication)

L  F:3  S:3  B:11  0
RSSI->017/11H:-49
M:0 ->051/33H:-59

Frequency (0 to 9) used for transmission
In the example: frequency number = 3.

Identifier of the base station on which the mobile is synchronized
(RPN number). In the example: RPN = 11.

Time interval (0 to 11) used for transmission (displayed as 0 to B 
in hexadecimal)
(In the example: time interval number = 3.

0 = mobile free to perform handovers between all system base stations 
1 = mobile restricted to using a single base station (no handover)

Reception level (in -dBm) of the 2 base stations that the mobile picks up
best. In the example, base 11 is received at -49 dBm and base 33 at 
-59 dBm. There are two display modes:
- rapid measurement (over 16 frames)
- average measurement (over 256 frames)
You can switch between measurement modes with a long press on *.
NB: the max. RSSI level displayed is around -42 dBm 
(beyond this threshold the figures are insufficiently accurate).

1 = average measurement
0 = rapid measurement
You can switch between measurement modes with a long press on *.
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IDENTITY (system RFPI number) / CONNECTION STATUS

System RFPI number (DECT identifier)
-  in hexadecimal -> first line
-  in octal -> second ligneRFPI 1E798F0F15

171743607425

Mobile connection status:
-  restricted to one station “Lock to XXX/XXX”
- “No base locking” means that the mobile can automatically choose
between base stations on the same system. A long press on # switches
from locked mode (one base only)
to unlocked mode (handover authorized between all system bases).

No base locking
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QUALITY (reception quality)

Note: the quality index gives an objective picture of the communication quality in order to determine 
the practical range limits (depending on the distance from the handset and the nature of the environ-
ment).

In practice, you have to select this function (preferably the averaged measurement), set up a call, and 
observe the index value (Q):  at a given location, the quality can be considered good if the value dis-
played is equal to or greater than 12 on a stable basis.

A:xx ANumber of CRC errors detected in field 
(measured over 120 frames and displayed in hexadecimal)

A:0A   X:00   Z:00   0
SYN:00   Q/15:16   0

X:xx XNumber of CRC errors detected in field 
(measured over 120 frames and displayed in hexadecimal)

0 = mobile free to perform handovers between all system base stations
1 = mobile restricted to using a single base station (no handover)

Z:xx ZNumber of CRC errors detected in field 
(measured over 120 frames and displayed in hexadecimal)

0 = rapid measurement
1 = average measurement

Number of synchronization errors reported by the mobile
(measured over 120 frames and displayed in hexadecimal)

transmission quality index (preceded by base station identifier).
The index corresponds to the number of frames received without error 
(graded out of 16). There are two display modes:
- rapid measurement (over 16 frames)
- average measurement (over 256 frames)
You can switch between measurement modes with a long press on *.

B : 017/11H  R:-49
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CONNECTION STATUS (synchronization)

This function makes it easier to determine the coverage area of a base station.

Mobile connection status:
-  synchronized on a system (LOCK) -> first line
-  Unlocked xx means that the mobile can automatically choose
between base stations on the same system. A long press on # switches
from locked mode (one base only)
to unlocked mode (handover authorized between all system bases)Wed 16 Aug   11:00

LOCK TO BASE
Unlocked xx
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INSTALLING A REFLEXES DECT SET

The registration of a Reflexes DECT set (with the 4097 CBL option) is performed by radio data exchan-
ge with the system. Before attempting the association, it is therefore important to check that the DECT 
bases are operational and that the sets are located in a zone with adequate coverage. 

In order to limit traffic during installation of the sets, it is advisable to register the Reflexes DECT sets 
in sequence, one after the other. 

Notas :

The DECT-GAP authentication procedure (described in file 3) is not available with Reflexes DECT sets.

REGISTRATION PROCEDURE FOR A NEW SET

New sets are delivered from the factory without any registration data; they are brought into service 
using a simplified procedure.

After adding a DECT set, go into GAP registration mode (MMC-Station or MMC-PM5) and initialize 
the association procedure up to "Subscription running".
Then switch on the set's power supply, connecting the transformer block to the mains and check the 
red indicator LED at the back of the set: the LED should emit a short series of "long ON/short OFF" 
flashes, then go out as soon as the set is synchronized with a base station.
At this point, the registration request is performed automatically by the set. The terminal identifier ap-
pears on the system's MMC and the operator only needs to validate the directory number and confirm 
the registration.
Note: after the registration phase, if the directory number of a Reflexes DECT set has to be changed, 
its power supply block must be disconnected, then reconnected, after the modification has been made 
in the system.
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REGISTRATION PROCEDURE FOR A PREVIOUSLY REGISTERED SET

If, during a registration attempt, the red indicator LED flashes "short ON/ long OFF", this means that 
the set contains configuration data. To delete the data, proceed as follows:

- disconnect / reconnect the power supply;
- 2-3 seconds after switching on the power supply again, enter the following sequence of digits on

the keyboard: *#*86734#*# (which corresponds to the alphabet code *#*UNREG#*# using the
number keys); the first character must be entered within 10 seconds;

- again disconnect / reconnect the power supply; automatic registration as described in the para-
graph above is initialized.

General conditions of installation 

- location: this office set must be located in an environment with limited risk of electro-magnetic dis-
turbance and which allows for good quality radio transmission. For example, avoid placing the set
near items such as dense metal structures, television, fluorescent strips, halogen lamps, PC moni-
tors, etc. 

- PABX limits: a Reflexes DECT set is considered both as a Reflexes line set and a DECT terminal.
The installation must include a Reflexes corded set in order to perform the Operator function.

- radio operation: the Reflexes DECT set operates in dynamic DECT link mode (just like a conven-
tional DECT mobile) or static mode (just like a corded set). The communication channel is set up
with the base station each time there is a need to exchange data with the PABX. At the end of an
exchange, when the set is in stand-by mode, the radio link and communication channel resources
are released and made available to the base station.

- coverage study: this is performed in the conventional way, just as for a system equipped with
DECT mobile terminals. Apart from the specific use of the terminal as a static office set, it is recom-
mended that a sufficient radio level be maintained in order to guarantee excellent communication
quality. 

- limits for standard traffic needs: the maximum number of Reflexes DECT terminals that can ope-
rate in the same zone is the following: 
• for a zone covered by one radio base station (NOTE 1)
• 4070IO/EO base station with 3 channels: 4 sets
• 4070IO/EO base station with 6 channels: 12 sets
• for a zone covered by a group of co-located base stations (NOTE 2)
• cluster of two 4070IO/EO base stations with 6 channels: 30 sets
- cluster of three 4070IO/EO base stations with 6 channels: 50 sets

Notas :

1. irrespective of the model of the DECT set (any type of 4074, or Reflexes DECT)
2. the topology of co-located base stations is a specific solution that makes it possible to increase traffic 
capacity in a given zone: this specific zone is thus identically covered by the various base stations that 
make up the cluster. To set up a base station cluster it is necessary to make sure that the DECT sets are 
compatible with this topology, which requires an overflow function not available on some DECT set 
models.

Remarques :

- Operating and programming limits at system level (inherent in the dynamic DECT link opera-
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ting mode of Reflexes DECT sets). 
- Avoid allocating Reflexes DECT sets to hunting groups; however, if the use of this type of set is ine-

vitable, limit their number to 4 per group.
- Number of Reflexes DECT sets in manager-secretary configurations: 4 manager sets and 4 secre-

tary sets.
- Do not allocate Reflexes DECT sets to broadcast groups.
- Do not use Reflexes DECT sets as call monitoring sets (selective or general) nor to monitor resour-

ces.
- Programming the RSP keys is impossible on Reflexes DECT sets.
- Status signaling (free or busy) for sets monitored on RSL keys is unavailable except for sets allocated

to manager-secretary configurations.
- Background music is not available on Reflexes DECT sets.
- After a time change made by MMC or after reception of the time sent by the public exchange, it is

possible that this modification will not be taken into account immediately by all the Reflexes DECT
sets; in this case, a simple user action (going off-hook, making a call, etc.) is enough to reset the
time synchronization on the display.

MOVING A REFLEXES DECT SET

To move a Reflexes DECT set, it is necessary to disconnect the mains power supply block before ins-
talling it in another place.

Reconnect the set for normal use (the set's number and programming will be kept).
Make sure the terminal is relocated in a zone with an adequate radio reception level, one that can 
cope with the traffic requirements.
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DECT MODULE 4097 CBL INDICATOR LED

The red indicator LED at the back of the Reflexes DECT terminal shows the operational status of the 
module at any given moment:

LED constantly lit (ON) 4097 CBL module defect

LED unlit (OFF) The module power supply is switched off or the module is cor-
rectly synchronized with a base station

Flashing long ON / short OFF The module is not registered with the system and is searching for 
radio synchronization

Flashing short ON / long OFF The registered module is searching for radio synchronization
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IMPLEMENTING 4074 GX HANDSETS
REGISTERING A 4074 GX HANDSET

System: consult the system administrator or user manual to obtain all the necessary details. Attention 
should be paid to the start up procedure; also check whether registration requires a particular access 
code (authentication code) to be entered on the station.

Set: the 4074 Gx can be programmed to manage up to 5 different DECT systems (labeled SYS1 to 
SYS5). As a general rule, the first entry (SYS1) is reserved for your Alcatel PABX and must not be mo-
dified. New data relating to another GAP system must be introduced on a free entry (SYS5 for simpli-
city).

Fri 15 Mar  14:30

4074GB
GAP
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Simplified registration procedure 

This method can be used if the PABX does not use an authentication code or if the code is 0000. In 
case of doubt, you can always try to use this method; if it doesn’t work, then the specific code procedure 
must be used.

- Activate the registration phase on the fixed system

- Switch on the 4074 Gx: long press on 
- 7 (long press): PASSWORD is displayed
- Key in the code 123456 followed by OK (long press): displays 1: SYSTEM NUMBER
- OK: displays ENTER 1-5: 1
- 5 then OK: displays 1: SYSTEM NUMBER
- 6 then OK: displays SUBSCR. #5 OK?
- OK: displays subscr. Running

Specific code registration procedure

The GAP system uses an authentication code with a value different from 0000.

- Activate the registration phase on the fixed system

- Switch on the 4074 Gx: long press on 
- 7 (long press): PASSWORD is displayed
- Key in the code 123456 then OK (long press): displays 1: SYSTEM NUMBER
- OK: displays ENTER 1-5: 1
- 5 then OK: displays 1: SYSTEM NUMBER
- 3: displays 3: CONFIG SYSTEM 
- OK: displays 1: TERMINAL TYPE
- OK: displays SYS 5 TYPE: FREE 
- t (4 times): displays SYS 5 TYPE: UNDEF 
- OK: displays 1: TERMINAL TYPE
- 7: displays 7: AC
- OK: displays SYS 5AC: 0000
- Type the authentication code followed by  OK: displays 1: TERMINAL TYPE
- ÿ on the navigator: displays 1: SYSTEM NUMBER
- 6 then OK: displays SUBSCR. #5 OK?
- OK: displays Subscr. Running

Registration completed/failed

After a few seconds (one or two minutes maximum), if the registration is successful, the radio field icon 
and subsc. accepted are displayed. The 4074 Gx terminal is now ready to function in GAP mode with 
the new system.

In the case of failure, if after several minutes the message subsc. accepted is not obtained, or if the 

message subsc. Rejected appears, switch off the terminal (long press on ) and restart the process.
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PROGRAMMING THE PERSONAL SPEED DIAL NUMBERS ON A 4074 GX 
HANDSET

It is possible to compile a directory of 12 numbers maximum (names and telephone numbers); pro-
gramming is carried out when the station is idle.

Press , the display is positioned on the first entry. To select another entry press 1 to 9, 0, * or # or 
use the navigator's t or s keys.

To enter a name, press  (the ? symbol flashes). Enter the name (8 characters maximum) by pres-
sing once or several times on the appropriate key (marked with letters of the alphabet).

For example, pressing on  displays A. Pressing several times on this key successively displays B 
C a b c 2.

To enter a number, press ÿ (the ? symbol flashes). Enter the number (20 digits maximum) with the key-
pad.

To insert a pause in a number do a long press on the 1 key (a dash appears on the display).
To insert a flashing character, press t (an "R" appears on the display).

When entering a name or number the s key enables you to delete the last character entered. Pressing 
repeatedly it deletes the whole entry.

To validate programming press OK; the programmed name is displayed. To return to idle, press the 

red  key.

2 ABC
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USING A 4074 GX HANDSET

Except for specific cases, the operations described above correspond to the options offered by the 
4074 Gx in liaison with the obligatory features available on a fixed GAP system.

Automatic radio cell transfer 

This feature, offered by the 4074 Gx, allows you to move from one base station to another without 
interrupting communication. Nevertheless, this possibility depends on the fixed system's own limits, 
particularly its capacity to manage several bases.

Role of the display

When calling from the handset, the figures dialed on the keypad are displayed. When receiving a call, 
the display indicates the caller's number, if the fixed system offers this feature, otherwise the display 
remains empty.

Receiving a call

An incoming call is signaled by the station's ringing tone as well as the flashing green lights and the 

icon on the display.

To answer the call, . To go off hook and end the communication,  

Calling by dialing manually

, then dial the number on the keypad. The line seizure icon  lights up on the display. It is also pos-
sible to dial the number directly; in this case, the line is seized automatically.

Calling by personal speed dial

Press : the display shows the first entry in the directory. 

To dial this number press OK. To select a different entry use the navigator's t or s keys then validate 
the number to be dialed by pressing OK.

Last number redial

When the set is idle, do a long press on the  key.

Flashing (calibrated cutoff)

Press t. When you press the Flashing key, the letter R appears on the display. Depending on the options 
offered by the fixed system, the flashing feature can be an essential step in activating other options 
(example: transferring communication to another station).
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SELECTING A FIXED SYSTEM

Programming the system entries

Your 4074 Gx set can be programmed to operate on 5 different DECT systems. The first entry is ge-
nerally reserved for use with your main Alcatel system. To allocate the other entries, it is recommended 
that you respect a descending order saving the most frequently used systems on the entries correspon-
ding to the lower numbers (entries 2 to 5).

Automatic/manual selection

When the systems used are installed on remote sites (far away from each other and without overlap 
zones), the system is selected automatically when the set is turned on. In contrast, when fixed systems 
share geographic zones, system selection can be modified by the user in the following way: 

- 9 (long press): displays 1: SYSTEM NUMBER
- OK: displays ENTER 1-5: X (X: value between 0 and 5 indicating the number of the active system).
- Y (Y: value between 1 and 5 representing the number of the new system to be used): displays EN-

TER 1-5: Y
- OK: displays 1: SYSTEM NUMBER
- t: displays 2: TERMINAL TYPE
- t: displays 3:SYS TO LOCK ?
- OK: displays SYS Y OK ?
- OK:the station's green light starts flashing and the radio field icon disappears temporarily. After a

few seconds, when the handset has homed in on the new system, the green light goes off and the
radio field icon reappears. The display indicates 1: SYSTEM NUMBER.

-  to return to idle state. Your station is ready to operate on the selected system.
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DEFAULT FUNCTION OF PROGRAMMABLE KEYS

The 4074 has 2 programmable keys.

On creating the handset, the system creates the following keys by default:

Fri 15 Mar 14:30

Line key

Line key

Message

Conference
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 IMPLEMENTING 4073 GS SMART 
HANDSETS 
The handset can be linked with 3 different systems, although it can only operate with one system at a 
time.
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REGISTERING THE HANDSET

For new handsets, the battery included is factory pre-charged; the level of charge is sufficient to register 
the terminal. Fit the battery into the handset and check that the level of charge is adequate (full or half-
charge icon); if not, put it on the charge base.

Start the registration procedure on the PABX. When the system is ready, continue with the handset.

Step A 

Long press on i to turn on the handset. 

If the set is new (never been assigned) and has enough battery charge, the display shows "Auto install 
system 1-OK ? ", there are two possibilities:

- if the installation doesn’t use the authentication function (AC code), go directly to step C for the
simplified procedure 

- if the system uses an authentication code, press briefly on the "On-hook" key,   and move
on to step B.

If the set does not display "Auto install system 1-OK ? " (it is already assigned on another system), go 
to step B.

Step B 

Long press on '#', for enter in the handset's local menu.

Press briefly on 't', to enter the 'System' sub-menu.

Press briefly on 'OK' to enter the 'Install' sub-menu.

Use the navigator to select a free position for the system to occupy (1, 2 or 3).

Press briefly on 'OK' to validate.

Enter the AC code, if the system uses one; otherwise go to step C. 

Step C

Press briefly on 'OK' to validate and launch the registration request

When the set identifier appears on the MMC system window, validate the entry to complete the ope-
ration. Registration becomes effective once the set has been turned on and off, or after an outgoing 
call has been made (the call attempt will fail).
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USING THE HANDSET

The 4073 GS Smart operates at optimal effectiveness with a DECT PABX from the Alcatel OmniOffice 
range: under these conditions, the handset uses an advanced proprietary protocol (AGAP) which gives 
it access to a large number of PABX functions.

It can nonetheless be used in reduced operating mode (GAP mode) on DECT GAP systems.

Functions specific to the terminal (accessible in either operating mode)

Lock / unlock keypad (long press on "On-hook" key)

- Activate/deactivate keypad beep, key beep, radio beep, vibrator
- Quick switching from ringer to vibrator (long press on 8).
- 3-level reception volume adjustment with storage of the most recent setting
- Registration possible on 3 different GAP systems 
- Manual or automatic system selection 
- Special radio test function (see "Radio Test Mode ")

GAP reduced mode

These functions should be available (unless inhibited by system constraints):

- Manual language selection for the local menu 
- Choice of ringing tunes
- Personal speed dial list: 10 internal numbers 
- Redial
- DTMF end-to-end signaling
- Calibrated loop

AGAP advanced mode functions 

Outline of the main functions available: 

- Diversion or cancel diversion key 
- Audio or text message consultation key
- Dial by name key 
- Personal speed dial key (10 system numbers)
- Automatic language configuration for the local menu 
- Choice of ringing tunes
- Features in conversation:

• Taking waiting calls by a long press on 'OK'
• Broker function by a long press on '->'
• Transfer by a long press on 't'
- 3-party conferencing by a long press on 's'

- Redial
- MF codes
- Calibrated loop
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 MAINTENANCE OPERATIONS 

Reading the handset software version number 

- Long press on '#' to enter the handset's local menu 

- Press briefly on 'ok' to go into 'mobile'  

- Press briefly on '#' to display the handset software version  
Typical display: "POCKET PRO DECT 4-0-42-17".

Reading the handset IPEI number (handset ID)

- Long press on '#' to enter the handset's local menu  

- Press briefly on 'ok' to go into 'mobile'  

- Press briefly on '*' to display the handset's IPEI number  
Typical display: "IPEI: 0810700014881 "

Resetting the handset (restoring the factory settings)

To delete the handset configuration data (recordings, customization, etc.):

- Long press on 'i' to turn off the handset  
- Press simultaneously on 'On-hook', '#' and 'i' until the display lights up

- Long press on 6, until the display turns itself off again.  
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RADIO TEST MODE

Presentation

The terminal software has a "radio test" mode for gauging the radio transmission parameters. This test 
mode is restricted to technical personnel: it is essential for coverage studies, or for maintenance ope-
rations on existing sites. 

Note: thanks to this function, the 4073 GS Smart can be used with existing coverage tools.

Limitations of radio test mode

The radio test mode is active in idle mode or in communication. The second line of the display is used 
for radio measurement values; some of the function keys are rendered inoperative (only the simple call 
setup function is maintained). 

The available measurement functions serve to monitor handovers performed by the handset, to identify 
local base stations and to measure the perceived reception level on the 2 closest base stations. There 
is also a new function which provides an objective quality index for any given call in order to validate 
the practical range limits.

All 4073 GS Smart terminals include the measurement function; no provision is made for after-sales 
re-calibration. Depending on the tolerance of the components, the theoretical maximum variation of 
RSSI measurements is +/- 7 dBm between several handsets. In practice, the RSSI measurement varian-
ce over several 4073 GS Smart terminals is generally within +/- 3dBm.

Entering and quitting radio test mode

To enter radio test mode (the handset must already be registered on the system):

- Long press on 'i' to turn off the handset 
- Press simultaneously on 'On-hook', 'S' and 'i' until the display starts up (2nd line: "STATE-RSSI-QUA

").

To quit radio test mode:

- Long press on 'i' to turn off the handset 
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Structure of radio test mode menus 

L F:1 S:5 B:01STATE-RSSI-QUA RSSI 01:xx 03:xx QUAL 01:xx

RFPI1e798f0f05IDENTIFY 31171714360744

A:xx X:xx Z:xxQUALITY SYNC:xx QUAL 01:xx

Home menu STATE RSSI QUALITY

Quality menu Transmission errors Synchronization errors QUALITY

Identity menu Hex. ID Octal ID
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Description of radio test mode functions 

STATE

Identifier of the base station on which the mobile is synchronized (specific RPN number linked to the 
base station connection board slot). In the example: RPN = 01 

Time interval (0 to 11) used for transmission. Display (0 to b in hexadecimal). In the example:  time 
interval number = 5 

Frequency (0 to 9) used for transmission. In the example:  frequency number = 1

Mobile transmission state.
L: mobile synchronized to the system (no communication established)
C:  DECT link active between the base station and the mobile (in communication).

RSSI (reception level)

Reception level (in – dBm) of the 2 base stations picked up most clearly by the mobile.

There are two display modes:
- rapid measurement (on 16 frames). Obtained by briefly pressing 'Speed Dial' 
- averaged measurement (on 256 frames). Obtained by a long press on 'Speed Dial'.

QUAL (transmission quality)

Transmission quality index (preceded by base station ID n°).

The index corresponds to the number of frames received without error. 
There are two display modes:
- rapid measurement (on 16 frames). Obtained by briefly pressing 'Speed Dial' 
- averaged measurement (on 256 frames). Obtained by a long press on 'Speed Dial'

Note: this function gives an objective picture of the communication quality in order to determine the 
practical range limits of a base station (depending on the distance from the handset and the nature of 
the environment).

In practice, you have to select the QUAL function (preferably the averaged measurement), set up a call, 
and observe the quality index value: at a given location, the quality can be considered good if the value 
displayed is equal to or greater than 12 on a stable basis. 

L   F:1    S:5    B:01

RSSI 01:xx 03:xx

QUAL 01:xx
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IDENTITY (system identity)

System RFPI number: in hexadecimal.

System RFPI number: in octal.

QUALITY (global DECT quality)

Z:xx Number of CRC errors detected in field Z (Value measured on 120 frames and displayed in 
hexadecimal).

X:xx Number of CRC errors detected in field X (Value measured on 120 frames and displayed in 
hexadecimal).
A:xx Number of CRC errors detected in field A (Value measured on 120 frames and displayed in 
hexadecimal).

SYNC:xx Number of synchronization errors reported by the mobile. (Value measured on 120 frames 
and displayed in hexadecimal).

Transmission quality index (preceded by base station ID n°). See previous page: the index corresponds 
to the number of frames received without error. There are two display modes:

- rapid measurement (on 16 frames). Obtained by briefly pressing 'Speed Dial' 
- averaged measurement (on 256 frames). Obtained by a long press on 'Speed Dial'

RFPI 1e798f0f05

31171714360744

A:xx X:xx Z :xx

SYNC:xx

QUAL 01:xx
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TRAFFIC COUNTERS
The Alcatel OmniPCX Office PABX manages a set of DECT traffic counters. These specific counters are 
mainly used to ascertain that there are enough DECT devices in an installation (correct quantity and 
location given the traffic to be handled, number of communications per handset, etc.). They can also 
be used during active maintenance, for example to monitor any link loss problems with a base station 
or handset.

DECT counters are read with MMC-PM5, using the labeled addresses (this displays the content of a 
specific memory area in table form).

GENERAL OPERATION

To measure the DECT traffic, 7 counters are associated with each active DECT base station (connected 
and in service) and another 6 are associated with each DECT set. Each of these counters gives specific 
traffic data. When there is a cold system reset, the content of the counters is automatically reset.

The counters associated with the radio base stations (" base station counters") and those associated 
with the handsets (" handset counters") are placed in two separate tables.

The start address of each of these tables varies from one system to another, depending on the software 
version. This address must therefore be read beforehand by the usual means:" Memory Read/Write 
-> Debug Labels":

- the start address of the base station counters is given by the label DectBasCnt
(005BED0 in the next example).

- the start address of the handset counters is given by the label DectHdsCnt
(0053CBC4 in the next example).

Remarques :

The address System Miscellaneous -> Memory Read/Write -> Other Labels  -> DectCntOn 
activates or deactivates the traffic counters when using the system:

- 01: active counters (CAUTION: incrementing the counters may have an impact on the response
time of an already heavily loaded system)

- 00: inactive counters (default value)

 Debug Labels

Label: Address

0053CBC4 0A 01 01 35DectHdsCnt

Len: Value:Rel: Format Hex.

2

005BED0DectBasCnt 2 5C 01 0B 00
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- In MMC-PM5, the content of a traffic counter is always a hexadecimal (base 16) value encoded
over several consecutive addresses. To obtain the corresponding decimal value, the values dis-
played must be converted manually (see following examples).

- On the first initialization, during the installation startup, all the addresses corresponding to the
DECT counters contain the value zero (00 hex.). Only the addresses "position" and "device" con-
tain a fixed value other than zero at this stage.
All counters are automatically reset to zero when there is a cold system reset. It is however possible 
to reset one or more base station or handset counters manually, by assigning the value 00 to the 
corresponding addresses.
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BASE STATION COUNTERS

DESCRIPTION OF FIELDS

Board position:

To find the board's physical address from the counters' "board position", convert into decimal and apply 
the following rule: board position/2 + 1 = physical address.

Example:

- For 00: 00/2 + 1 = 01 -> the board is in the first slot.
- For 02: 02/2 + 1 = 02 -> the board is in the second slot.

Device:

 Base index in hexadecimal on the board.

nb = ((((d x 256) + c) x 256) + b) x 256) + a

nb =  (b x 256) + a

Start address
given by
content of
pointer
DectBasCnt

Byte
nbr Content

1

2

3

4

5

6

7

8

9

10

1 1

12

13

14

15

16

17

18

19

a

b

board position
device

nbr calls

nbr simult calls

nbr saturations

saturation time (ms)

nbr inter handovers

nbr intra handovers

position next board
device

a

a

a

a

a

b

b

b

c

d

b

b

a

b

nbr links lost

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a
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N° of calls:

The cumulative total of calls achieving connected status on the base in question.

N° of simultaneaous calls:

The maximum number of simultaneous communications recorded on the base station.

N° of saturations: total (sat1 + sat2)

sat1 = number of times all the channels in the base were in simultaneous use.
sat2 = number of times all the available channels were in simultaneous use.

Saturation time:

The cumulative time (in ms) for sat1 saturations.

N° of inter handovers:

The cumulative total of handovers between the base and other bases. 

N° of intra handovers:

 The cumulative total of handovers performed on the base.

N° of links lost:

The total number of radio links cut off accidentally.
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Example: How to read the base station counter table

For the minimum length of the memory area to be listed, assume 18 bytes per base station, hence: 
(minimum value to be entered in "Length" field) = 18 x total number of base stations. 

In the example, the results recorded for the first base station are as follows:

- board position: 0A hex (10 dec); slot number 6
- device : 01 hex (1 dec); first device on the UAI board
- n° of calls : 03 B2 hex (946 dec)
- n° of simult calls: 00 05 hex (5 dec)
- n° of saturations: 00 02 hex (2 dec)
- saturation time: 00 00 79 3A hex (31.034 seconds)
- n° of inter handovers: 00 83 hex (131 dec)
- n° of intra handovers: 01 4C hex (332 dec)
- n° of links lost: 00 1A hex (26 dec)

Address Len:
005BED0E 512

Write

Read

Return

Modify

0A 01 B2 03 05 00 02 00 . . . . . . .

3A 79 00 00 83 00 4C 01 . . . . . . .005BED16
1A 00 0C 03 43 01 03 00 . . . . . . .005BED1E

00 00 00 00 00 00 22 20 . . . . . . .005BED26
3B 00 0C 00 FF FF FF FF . . . . . . .005BED2E
FF FF FF FF FF FF FF FF . . . . . . .005BED36
FF FF FF FF FF FF FF FF . . . . . . .005BED3E
FF FF FF FF FF FF FF FF . . . . . . .005BED46
FF FF FF FF FF FF FF FF . . . . . . .005BED4E
FF FF FF FF FF FF FF FF . . . . . . .005BED56
FF FF FF FF FF FF FF FF . . . . . . .005BED5E
FF FF FF FF FF FF FF FF . . . . . . .005BED66

0A 01 B2 03 05 00 02 00 . . . . . . .005BED0E

Numeric Addresses
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HANDSET COUNTERS

DESCRIPTION OF FIELDS

Position:

The virtual slot: its value is always 5C (92 in decimal).

Device:

The handset index (in order of creation).

N° of links:

The cumulative total of radio links established by the handset.

N° of calls:

The cumulative total of calls achieving connected status on the handset in question.

N° of coms lost:

The number of communications cut off in conversation (lost signal).

N° of links lost:

The total number of radio links cut off accidentally.

nb =  (b x 256) + a

1

2

3

4

5

6

7
8

9
10

1 1

12

13

14

15

16

Start address given by
content of pointer
DectHdsCnt

Byte
nbr Content

position (fixed value = 5C h)
device

nbr links

nbr calls

nbr coms lost

nbr links lost

nbr inter handovers

nbr intra handovers

position

device

a

b

a

a

b

a

b

a

b

a

b

b

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a

nb =  (b x 256) + a
Ed. 046/8 Réf. 3EH 21000 BSAA



File
8

TRAFFIC COUNTERSCALL SERVER : MOBILITY

 

N° of inter handovers:

The cumulative total of handovers performed by the handset between different base stations.

N° of intra handovers:

The cumulative total of handovers performed by the handset on the same base.

Example: How to read the handset counters table

For the minimum length of the memory area to be listed, assume 14 bytes per handset, hence: (mini-
mum value to be entered in "Length" field) = 14 x total number of handsets. 

First handset : position:5C h (92 dec)

device : 01 h (1 dec). See Subscriber menu in MMC-PM5 to read the corresponding 
directory number.
n° of links : 00 0B h (11 dec)
n° of calls : 00 02 h (2 dec)
n° of coms lost: 00 00 h 
n° of  links lost: 00 00 h
n° of inter handovers: 00 00 h
n° of intra handovers: 00 00 h

Second handset: position: 5C h (92 dec)

device : 02 h (2 dec)
n° of links : 00 45 h ( 69 dec)
n° of calls : 00 2E h (46 dec)
n° of coms lost: 00 08 h (8 dec)
n° of links lost: 00 10 h (16 dec)
n° of inter handovers: 00 04 h (4 dec)
n° of intra handovers: 00 05 h (5 dec)

Numeric Addresses

Address Len:

0053CBC4 50

Write

Read

Return

Modify

5C 01 0B 00 02 00 00 00 R . . . . . .

00 00 00 00 00 00 5C 02 . . . . . .R .0053CBCC

45 00 2E 00 08 00 10 00 . . . . . . .0053CBD4

04 00 05 00 52 03 00 00 . . . . R . .0053CBDC

5C 01 0B 00 02 00 00 00 R . . . . .0053CBC4

00 00 00 00 00 00 00 00 . . . . . . .0053CBE4

00 00 52 04 00 00 00 00 . . R . . . .0053CBEC

00 00 . .0053CBF4 00 00 00 00 00 00
Ed. 04 7/8Réf. 3EH 21000 BSAA



TRAFFIC COUNTERS CALL SERVER : MOBILITY

 

Ed. 048/8 Réf. 3EH 21000 BSAA



CALL SERVER : Voice on IP

Alcatel OmniPCX Office
REF3EH 21000 BSAA Ed. 04
SECTION
CALL SERVER : VOICE ON IP





CALL SERVER : VOICE ON IP

ALCATEL OMNIPCX OFFICE
Section CALL SERVER : Voice on IP

SERVICES AND TOPOLOGIES FILE 1

INSTALLATION - CONFIGURATION FILE 2

DIMENSIONING - LIMITS FILE 3

MAINTENANCE FILE 4
Ed. 04 1/2Réf. 3EH 21000 BSAA



SECTION CALL SERVER : VOICE ON IP 
(INDEX)

CALL SERVER : VOICE ON IP

ALCATEL OMNIPCX OFFICE
Section CALL SERVER : Voice on IP (Index)

DIMENSIONING - LIMITS FILE 3

INSTALLATION - CONFIGURATION FILE 2

MAINTENANCE FILE 4

SERVICES AND TOPOLOGIES FILE 1
Ed. 042/2 Réf. 3EH 21000 BSAA



1

SERVICES AND TOPOLOGIESCALL SERVER : VOICE ON IP

 

File
SERVICES AND TOPOLOGIES
SERVICES

Alcatel OmniPCX Office provides 2 services that can be combined:
- Voice over IP is based on the Integrated H.323 Gateway, the core of Voice over IP (VoIP), which

allows communication between the conventional telephony world and the data world.
- IP telephony enables an enterprise to share its data infrastructure (local IP network) between the

data world and the telephone world by means of an adapter known as an "IP Enabler" which con-
nects up an Alcatel Reflexes station on the LAN and/or a Windows application on a Multimedia PC
(PIMphony IP Edition) to simulate a LAN PC station. The level of service offered by the IP Enabler is
identical to that of standard Reflexes stations.

The Voice over IP services are provided by one or more CoCPU (CoProcessing Unit) VoIP boards (max. 
6). This board integrates an H.323 gateway which has the following main characteristics:

- from 4 to 96 DSP channels for the H.323 gateway and IP Telephony services (DSP channels for
coding / decoding the audio signal).

- supports the audio compression algorithms G711, G729a and G723.1.
- IP communications in Full Duplex mode.
- a V2-compatible H.323 gateway that complies with the following recommendations:

• supports Q.931/Q932 signaling.
• supports the H.225 v2 protocol for establishing signaling channels between H.323 gateways

(including Fast Connect).
• use of the H.245 v4 protocol to monitor communications: establishing channels, negotiating

the Codec, etc.
- RAS signaling for communications with the H.323 internal gatekeeper (H.323 v2) to the product

or to the outside (authentication, authorization, bandwidth management).
- use of RTP/RTCP to send audio signals in real time.
- echo suppression.
- silence suppression (VAD).
The gateway also integrates an H.323 v2 gatekeeper that provides the following functions:
- RAS (Registration Admission Status) server.
- protection and authentication of recording sequences (H.235).
- testing the presence of remote H.323 gateways (ICMP or H.323 packets).

Nota : All communications and VoIP signals transit through the VoIP CoCPU board, except in the 
case of PC to PC or terminal to terminal communications.
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The Alcatel OmniPCX Office VoIP offer does not provide:

- specific services such as optimization of call transfers or forwarding such as exist with the ISVPN;
likewise, H.450 protocol is not supported.

- the FoIP (Fax over IP) service. A Fax (or Data) call must not be routed via Voice over IP; fax trans-
mission is not guaranteed.

- the encrypting of VoIP channels.

Quality of Service (QoS)

Mechanisms in the system's ARS determine whether a VoIP call to a remote H.323 gateway can be 
made without degradation of the bandwidth (see "Installation - Configuration" File).

The aim of quality of service in the network sense is to provide "end-to-end" QoS for all the audio IP 
packets.

To achieve this, the system supports the IP ToS (IP Type of Service): each IP VoIP packet contains a 3-
bit precedence field indicating a level of priority. This information can be used by the network equip-
ment (routers, gateways, etc.) to assign a level of priority to the IP voice packets with respect to the IP 
data packets. Alcatel OmniPCX Office also supports "DiffServ" (RFC 2475).

Nota : End-to-end quality of service can only be guaranteed if all the items of equipment in the 
network are IP ToS or DiffServ compatible.

Principle of operation of the CoCPU board

The CoCPU board fulfils the following functions:

Environment

The H.323 gateway (VoIP CoCPU board) connects either to a 10 Mbps Ethernet LAN or to a 100 Mbps 
Fast Ethernet LAN via an RJ45 cable, while the IP Enablers provide a 10 Mbps Ethernet connection (IP 
Enabler V1) or a 10/100 Mbps Ethernet connection (Enabler V1S) and integrate a 2-port Hub (V1) or 
switch (V1S) permitting chaining with a PC.

 (Masterboard) TFTP Server / DHCP Server

H.323 Gateway / Gatekeeper

Ë
Soft stack

T C P / U D P / I P

Boot/BIOS Operating System Kernel / R T 
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 H.323 GATEWAY SERVICE

This service can be implemented in 2 ways: 

- using Alcatel OmniPCX Office as a router to the Internet with integrated Proxy and Firewall; in this
case, a CoCPU@ board is necessary;

- using an external router to the Internet or to a dedicated link providing the same level of service as
the Office R42 range.

Nota : In the following diagrams, Alcatel OmniPCX Office is used for the Internet connection con-
figuration and the external router is used for other types of connection (leased line, ADSL, 
etc.).

The Alcatel OmniPCX Office H.323 Gateway service can be implemented in either of 2 contexts:
- H.323 gateway integrated into a standalone configuration.
- H.323 gateway integrated into an H.323 zone.

H.323 gateway integrated into a standalone configuration

In a standalone configuration the integrated gatekeeper is alive; it is masked to the exterior and cannot 
be managed from the 
LAN.

Nota : - The integrated gatekeeper does not manage H.323 zones.

 - In this topology, only the PCs with NetMeeting and equipped with the Alcatel secure plug-
in can make PC to Station calls.

WAN IP network

H.323

@IP

G
@IP

@IP : IP Address
G : H.323- compatible gateway
R : IP/Proxy/Firewall router

R

@ IPn

@IP1

ISDN / PSTN

Alcatel OmniPCX

@IP@IP

LAN

Company

Permanent connection
 or Callback

Netmeeting with
Secure plug-in
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Gateway in a H.323 zone

In a network topology like the one below, the H.323 gateway of Alcatel OmniPCX Office can be inte-
grated into an H.323 zone managed by an external gatekeeper.

In this configuration, the gatekeeper integrated into Alcatel OmniPCX Office must be deactivated and 
the network administrator must supply the IP address of the external gatekeeper.

WAN IP network

H.323

G

@IP

@IP
R

@IP1

@ IPn

@IP@IP

LAN

RR

Gatekeeper H.323

@IP @IP
@IP

@IP

Alcatel OmniPCX
(Gatekeeper
deactivated)

ISDN / PSTN

Company

Permanent connection
 or Callback

Netmeeting without
secure plug-in

@IP : IP Address
G : H.323- compatible gateway
R :  IP/Proxy/Firewall router

secure plug-in
Netmeeting without
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IP TELEPHONY

This service does not require any specific external equipment (IP and/or Proxy/Firewall Router), unless 
it is provided for Remote/Home Workers.

The IP router (R) connected to the Intranet can be a simple IP router. The reservation of bandwidth is 
"guaranteed" if this router supports IP ToS (DiffServ).
The number of remote IP Enablers or PIMphony IP subscribers depends on the line bandwidth (not 
more than 2 simultaneous communications for 64 Kbps, not more than 5 for 128 Kbps).

HOME WORKER (remote IP Telephony via a VPN)

Remote worker

Home worker

 WAN IP network

@IP1

@IP

@IP : IP Address
R : IP/Proxy/Firewall router

  VPN Server

VPN
Pimphony
MultiMedia

R

R

@ IPn

Public @IP
@IP

LAN

Company

IP ENABLER

@IP

@IP
Pimphony
MultiMedia

@IP

Alcatel OmniPCX

(DHCP Server)

IP ENABLER
IP ENABLER IP ENABLER

@IP @IP @IP

Permanent connection

ISDN / PSTN

Pimphony
MultiMedia

ISDN / PSTN

R/F: IP/Firewall router with permanent
connection (leased line, ADSL,
modem cable) +VPN Server

LAN

Company

Pimphony IP

R/F
Permanent
connection

Internet

VPN

Home Network

Alcatel OmniPCX

IP ENABLER

IP ENABLER

IP ENABLER

R/F
Permanent
connection
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The connection between the Home Worker and the Internet must be 'always-on' (ADSL, cable, etc.). It 
is indispensable to have an IP/Proxy/Firewall router or VPN server on the Home Worker side.
The IP router (R/F) at the front end of the VPN must offer Proxy/Firewall and VPN server functionality 
(IPSec with 3DES encryption for interoperability with the system's built-in router).
The number of remote IP Enablers or PIMphony IP subscribers depends on the line bandwidth (not 
more than 2 simultaneous communications for 64 Kbps, not more than 5 for 128 Kbps).
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REMOTE WORKER (PIMphony IP via a VPN)

The connection between the remote PC (PIMphony IP Edition) and the Internet is of the "dial-on-de-
mand" type (V90 analog, ISDN BRA or ADSL modem). The remote PC first establishes a connection 
with the nearest access provider, then a PPTP connection with the company's VPN server.

PC with Microsoft NetMeeting

The remote NetMeeting PC establishes a PPTP connection with the company's VPN server.

LAN

Pimphony IP

R/F
Internet

VPN

IP ENABLER

IP ENABLER

dial-in
Connection

Pimphony IP
Remote Worker

R/F: IP/Firewall router with permanent
connection (leased line, ADSL,
modem cable) +VPN Server

Permanent
connection

Company

ISDN / PSTN

Alcatel OmniPCX
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TOPOLOGIES

This section describes typical IP network architectures for implementing the Alcatel OmniPCX Office 
Voice over IP services.

The following topology is recommended for connecting up an Alcatel OmniPCX Office:

The bandwidth of an Ethernet LAN can be 10 or 100 Mbps. If the network operates at 100 Mbps, ad-
ding terminals operating at 10 Mbps risks downgrading the bandwidth used by VoIP and hence audio 
quality: you might need to isolate these devices on external LAN switches hooked up to the system.
CoCPU boards are connected to the local client network using a LAN switch; this solution helps reduce 
Ethernet traffic on the CoCPU board.

LAN Switch

Server

LAN Switch

Alcatel OmniPCX
Internet

10/100 Mbps

10/100 Mbps
10/100 Mbps

10/100 Mbps

     IP WAN
Intranet/Extranet

CoCPU@ Board (Internet Access)

CoCPU VoIP Board (Voice over IP)

IP Router
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Multi-site configurations

A multi-site configuration is possible via an extended Intranet or an Internet VPN.

H.323 gateway integrated into an extended Intranet

The IP router (R) connected to the Intranet can be a simple IP router. The reservation of bandwidth is 
"guaranteed" if this router supports Ipv4 ToS (DiffServ).

H.323 gateway integrated into a VPN

The IP router (R/F) at the front end of the VPN must offer Proxy/Firewall and VPN server functionality 
(IPSec with 3DES encryption for interoperability with the system's built-in router).

Extended Intranet

G : H.323- compatible gateway
R : IP router with permanent

connection

R

G

R

LAN

Company

ISDN / PSTN

Permanent
connection

Alcatel OmniPCX

R/F

R/F
Internet

VPN

LAN

G

ISDN / PSTN

Company

IP/Firewall router with permanent
connection (leased line, ADSL,
modem cable) +VPN Server

Alcatel OmniPCX

Permanent
connection Permanent

connection
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IP telephony in an extended Intranet

Nota : See also the Home Worker and Remote Worker topologies described earlier.

PIMphony IP through RAS (Remote Access Server)

The RAS is equipped with a pool of modems or a T0 / T2. The RAS client PC is authenticated by a PAP/
CHAP authentication procedure, then is called back by the RAS (call back).

LAN

Pimphony IP

Pimphony IP

R

Alcatel OmniPCX

IP ENABLER

@IP

IP ENABLER

IP ENABLER

R

Company

ISDN / PSTN

R/F: IP/Firewall router with permanent
connection (leased line, ADSL,
modem cable) +VPN Server

Permanent
connection

RAS : Remote Access Server
LAN

Pimphony IP

Pimphony IP
IP ENABLER

IP ENABLER

RAS ISDN / PSTN

Company

ISDN / PSTN

Alcatel OmniPCX
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PC with Microsoft NetMeeting

A NetMeeting PC can connect to the company via the VPN (PPTP connection on Internet) or directly by 
an RAS connection via the telephone network (PSTN/ISDN).
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INSTALLATION - CONFIGURATION
INSTALLATION GUIDE

Preliminary

A few precautions must be taken when inserting a machine into a local network to ensure the lasting 
compatibility and quality of the network.
The starting point for the integration and configuring of the PBX on a LAN is the knowledge of the 
network structure, its characteristics and the equipment. After that it is necessary to collect the signifi-
cant parameters and characteristics of the LAN.
Below is a non-exhaustive list of the parameters to be collected:

VoIP CoCPU board

- Hostname: DNS name or alias of the board.
- IP Address: IP address of the board.
- IP Subnet Mask: subnet mask of the LAN.

General

- Number of IP trunk DSP channels: number of channels associated with remote H.323 gateway ac-
cess.

- Number of IP subscriber DSP channels: number of channels associated with the IP Telephony ser-
vice.

- Implicit router address: default address of router.
- Quality of service: type of quality of service to be implemented according to the LAN equipment.

Gatekeeper

- Gatekeeper integrated into the PBX: use of an integrated gatekeeper or not.
- Identification of gatekeeper: IP address of external gatekeeper.

DHCP

- Activate integrated DHCP server: use of the integrated DHCP server or not.
- Dynamic Range: dynamic IP address range for IP telephony (IP Enabler).
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INSTALLING THE VoIP CoCPU BOARD

You can install up to 6 VoIP CoCPU boards (2 per unit) connected to a given Ethernet LAN via RJ45 
connectors. Each board has its own IP address.

If several boards are installed, one of them is the "master" board: its IP address and software charac-
teristics serve as a reference. The other VoIP CoCPU boards are known as "slaves".

Default IP addresses

- Master VoIP CoCPU: 192.168.92.248

- Slave VoIP CoCPU: 192.168.92.249 to 192.168.92.253

Nota : Whatever the configuration, there is at least one master board and up to 5 slave boards:

The CoCPU boards can only be inserted when the system is powered down.

General software configuration

The general configuration defines the minimum parameters to be set regardless of the VoIP service to 
be implemented: 
- H.323 gateway only.
- IP telephony only.
- H.323 gateway and IP telephony.

VoIP CoCPU board

General network parameter settings

- Hostname: DNS name or alias of the board (optional parameter).
- IP Address: IP address of the board.
- IP Subnet Mask: subnet mask of the board.
- Master/Slave: (read-only parameter) the master / slave role of the CoCPU boards is determined

by their order of appearance in the PBX.

Configuring the parameters of a CoCPU board using PM5

- You can enter the IP addresses of the VoIP CoCPU boards together with their DNS name.
- Indication of subnet mask common to all the VoIP CoCPU boards.

- by MMC-PM5 (Expert View): Hardware and Limits -> IP Boards
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General network parameters

Significant parameters:

- Default router address:  IP address of the CoCPU@ (Internet Access) board or of the external
router.

- Subnet Mask (read only): subnet mask on which the PBX is located. This is the parameter pro-
grammed in the IP Boards menu.

These fields are necessary to access the WAN.

Configuring the DSPs (optional)

It is recommended not to change these parameters.

Meaning of parameters:

- Law Mode: Law A or Law µ compression (read only).
- Echo Cancellation: cancellation of the echo (yes by default).
- Voice Active Detection: cancellation of silence (no by default).

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> General tab

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> DSP tab
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CONFIGURING THE INTEGRATED H.323 GATEWAY

H.323 Gateway:this application layer forms the interface between the IP telephony (H.323 stack) and 
switched telephony worlds (Alcatel OmniPCX Office PBX call manager). 

Configuring the PBX as the H.323 gateway

After an initialization by default all the DSPs are assigned to the pool of VoIP subscriber channels (IP 
telephony).
In a pure H.323 gateway configuration, all the DSPs of the PBX VoIP daughter boards will be used for 
"IP network" accesses. 

Number of VoIP access channels (IP trunks):Number of channels for VoIP access, i.e. 1 DSP chan-
nel for 1 "network access" (generally for small configurations; see also the abacus in the "Dimensioning 
- Limits" section).

Quality of service: selection of the type of QoS used for the remote H.323 gateway VoIP calls.

If all the network equipment items support the IP ToS, one can choose an IP priority from 1 to 7:

If all the network equipment items are "DiffServ" compatible, one can choose from:
- DiffServ PHB Best Effort Forwarding (BE) (priority bits: 00000000),
- DiffServ PHB Expedited Forwarding (EF) (priority bits: 10111000).

Nota : Each DSP placed in the "VoIP access" pool is considered as a "network access" by the PBX, 
i.e. 1 VoIP DSP = 1 B-channel. As there can be a maximum of 6 VoIP daughter boards, 
each with 16 DSPs, there can be no more than 96 VoIP access DSPs.

Network accesses (T0, T2, analog TL, DLT2, analog ATL) + VoIP Accesses ≤ 120

Configuring the gatekeeper (optional)

- Integrated gatekeeper: if the H.323 gateway is in Stand-alone configuration, the gatekeeper is
integrated into the PBX; check the box.

- IP Address: if the PBX is a gateway in an H.323 zone, one must use an external gatekeeper that
is the manager of the H.323 zone it covers, indicating its IP Address provided by the network ad-
ministrator.

- Reset Code: allows the resetting of a password on NetMeeting PCs that have a safety Plug-in.

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> General tab

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> Gatekeeper
tab
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Configuring the Gateway timeouts (optional)

NB: The parameters have standardized values, do not change them without prior analysis.

- RAS Request Timeout: maximum authorized response time for an RAS request ("Registration, Ad-
mission, Status") made to the gatekeeper; between 10 and 180; default value = 20.

- Remote Gateway Presence Timeout: determines the presence of a remote Gateway; value
between 10 and 600; default value = 50.

- Connect Timeout: maximum authorized time interval between initialization and connection; value
between 10 and 1200; default value = 500.

- H.245 Request Timeout: maximum authorized response time for an H.245 request; value
between 10 and 60; default value = 40.

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> Gateway tab
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REMOTE H.323 GATEWAY

Configuring outgoing communication (ARS table)

The choice of routing a telephone communication between a public network access or a VoIP access 
and the busy trunk overflow feature are defined in the ARS table.
Like conventional outgoing telephone calls, a VoIP call is subject to the ARS mechanisms: link catego-
ries, ARS time slot management, overflow on busy, etc.
In the diagram below sites A and B are Alcatel OmniPCX Offices. Site C is a remote system integrating 
an H.323 ga-
teway.

- @IP1: IP address of the master VoIP CoCPU board at site A - @IPn: IP address of slave board(s)
- @IP2: IP address of the master VoIP CoCPU board at site B, e.g. 192.189.50.120

Base call

The site A stations call the site B stations by dialing their internal numbers:
Internal numbering plan (site A):

Function Start End Base NMT Priv

Secondary trunk 
group

2 2 ARS Keep Yes
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ARS table:

- The "Called/HH" field has the value "Heterogeneous" by default: the notions of ISVPN do not apply
to VoIP calls. 

- The "User Comment" field enables a comment to be associated with the ARS input (20 characters
maximum).

Nota : The IP parameters in the ARS table are accessed by right-clicking and selecting "IP parame-
ters".

- The "Destination" field of an ARS input to VoIP accesses must be of the "Gateway" type (H.323 ga-
teway).

- For a "Gateway" destination, the "IP Type" must be a static IP address (non-modifiable field).
- The "IP Address" field must be that of the remote H.323 gateway. In the example, this value corres-

ponds to the IP address of the master VoIP CoCPU board at site B.
- The name associated with the remote gateway is optional ("Hostname" field optional).
- Gateway Alive Protocol / Gateway Alive Timeout:

The integrated gateway tests the presence of the remote gateway every 300 seconds (Gateway Ali-
ve Timeout, from 0 to 3600 seconds). The test protocol (Gateway Alive Protocol) used by default is 
ICMP: the H.323 test protocol can only be used if the remote gateway is H.323 V2-compatible!

Nota : Gateway Alive Timeout: if this field is at 0, the "Gateway Alive Protocol " mechanism is in-
hibited. This option is to be used in the specific situation where it is impossible to use ICMP 
or H.323 to test for the presence of the remote gateway; but in this case, there is no means 
whatsoever of knowing whether the remote gateway is alive or out of service.

It can, however, turn out to be judicious to deactivate the mechanism if one is sure of network reliability 
(IP connectivity between the 2 gateways), in order to reduce the traffic.

Networ
k

Prefix Ranges Substitute List. Trunk 
group list

Called/HH User Comment

Priv. 2 00-49 2 4 Het H.323 to site B

Destination IP Type IP Address Hostna-
me

Gateway 
Alive Pro-

tocol

Gateway 
Alive Ti-
meout

Bandwidth Gateway 
Alive Sta-

tus

Gateway Static 192.189.50.120 option ICMP 300 128 Kbits 
(5 calls)

Alive
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- Gateway Bandwidth / QoS: for each ARS input to a remote H.323 gateway, a bandwidth must be
reserved for the Voice over IP to the remote H.323 gateway. The number of simultaneous commu-
nications that can be held depends on this value:

E.g. if the total bandwidth corresponding to the data rate to a remote gateway is 256 Kbps and the 
mean traffic level is 50%, it is wise to define a bandwidth of 128 Kbps for Voice over IP. 

Remark concerning the quality of service - QoS

If we take our example, site A can make H.323 calls to sites B and C. One assumes that the bandwidths 
reserved for Voice over IP at the LAN/WAN gateways of each site are:
- bandwidth reserved for VoIP on site A: 1024 Kbps (20 calls or more)
- bandwidth reserved for VoIP on site B: 128 Kbps (5 simultaneous calls)
- bandwidth reserved for VoIP on site C: 64 Kbps (2 simultaneous calls)
In this configuration one sees that it is possible to make 7 simultaneous calls from site A to the remote 
H.323 gateways: 5 to site B and 2 to site C.
7 DSPs can therefore be assigned in the "VoIP access" pool for site A (7 being the number of DSPs nee-
ded to call sites B and C simultaneously).
However, let us assume that there is no ongoing communication between sites A and C, and that 5 
calls are established between A and B. The total number of VoIP network access DSPs consumed in 
PBX A is 5: therefore 2 DSPs remain available to establish two other calls to site B.
Yet in this example we exceed the bandwidth reserved for Voice over IP at the LAN/WAN gateway of 
site B: the quality of service is no longer guaranteed.
To avoid downgrading the VoIP service, the system uses the "Gateway Bandwidth" field of the ARS table 
associated with the input to the remote H.323 gateway of site B, which will be configured at 128 Kbps 
(5 calls), as quality indicator (QoS): although there are still 2 DSPs available, the PBX will refuse a 6th 
call to site B.

Nota : This service is not available if an external gatekeeper is used.

Bandwidth Number of simultaneous commu-
nications possible

None No communication possible De-
fault value

55.6 Kbps 1

64 Kbps 2

128 Kbps 5

256 Kbps 10

512 Kbps 20

≥ 1024 Kbps > 20
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Nota : To optimize management of this ARS table parameter, it is vital to have information about 
the bandwidth available (reserved) for VoIP calls that is as precise as possible.

- Gateway Alive Status: this regularly updated read-only field indicates the status of the remote ga-
teway:
•  Alive: remote gateway present
-  Deactivated: remote gateway absent / out of service.

It can, however, turn out to be judicious to deactivate the mechanism if one is sure of network reliability, 
in order to reduce the traffic.

Incoming call

An incoming "VoIP access" call is analyzed in the private numbering plan. In our example:
Private numbering plan of site B:

Forcing a public call to the H.323 gateway

LCR: Least Cost Routing
When a site A subscriber dials the public number of the site B station, the call can be forced to the VoIP 
network accesses:
Internal numbering plan of site A:

ARS table:

Function Start End Base NMT Priv

Local call 200 249 200 No

Function Start End Base NMT Priv

Main trunk group 0 0 ARS Drop No

Networ
k

Prefix Ranges Substitute List. Trunk 
group list

Called/HH User Comment

Pub. 04723542 00-49 2 4 Het H.323 to site B
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Overflow

When a site A subscriber calls a site B station by its internal number, ARS routing enables the calls to 
be re-routed to the public network when it is no longer possible to call via the VoIP accesses. The fol-
lowing criteria render a "VoIP access" trunk group inaccessible:
- the VoIP CoCPU board of site A is out of service.
- no more DSPs associated with the VoIP accesses are available.
- the remote H.323 gateway is out of service (VoIP CoCPU board of site B out of service).
- the quality of service (QoS) to the remote gateway is poor (exceeding of the possible simultaneous

communication threshold for the bandwidth reserved for Voice over IP for this remote H.323 ga-
teway).

ARS table of site A:
Calling the site B station by its internal number:

Calling the site B station using its public number:

*: As the public numbers 04723542 50 to 99 do not belong to site B, they must be routed to the public 
network.

Break In

The break-in service enables the PBX to re-route a public number from site A to site B. In our example, 
the public network subscriber dials the number 03 88 67 71 50 which is routed to station 250 on site B:
Public numbering plan (site A):

ARS table:

Networ
k

Prefix Ranges Substitute List. Tru-
nk group 

list

Called/HH User Comment Destination

Priv. 2 00-49  2 4 Het H.323 to site B Gateway

04723542 1 Het ISDN Access No IP

Networ
k

Prefix Ranges Substitute List. Tru-
nk group 

list

Called/HH User Com-
ment

Destination

Pub. 0472354
2

00-49  2 4 Het H.323 to site 
B

Gateway

04723542 1 Het ISDN Access No IP

Pub. 0472354
2

50-99 04723542 1 Het ISDN Access No IP *

Function Start End Base NMT Priv

Secondary trunk 
group

7150 7150 ARS Keep No
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Reminder: it is vital for the PBX "Installation number" field to be configured; e.g. for site A: 388677100.

Break Out

The break-out service enables proximity calls to be made. In our example a site A station dials a public 
number starting with 04, the call is routed to site B via the H.323 gateway, then routed to the public 
network from site B, configuration:
Internal numbering plan of site A:

ARS table of site A:

*: as the prefix 0 is dropped in the internal numbering plan, 004 must be substituted for 04,

**: this sub-line allows overflow to the public network lines of site A if the VoIP access calls are inac-
cessible.
As an incoming VoIP access call is analyzed in the private numbering plan, the following must be pro-
grammed in the private numbering plan of site B:

Networ
k

Prefix Ranges Substitute List. Trunk 
group list

Called/HH User Comment

Pub. 0388677150 250 4 Het H.323 to site B

Function Start End Base NMT Priv

Main trunk group 0 0 ARS Drop No

Networ
k

Prefix Ranges Substitute List. Tru-
nk group 

list

Called/HH User Com-
ment

Destination

Pub. 04  004 4 Het H.323 to site 
B

Gateway *

 04 1 Het ISDN Access No IP *
*

Function Start End Base NMT Priv

Main trunk group 0 0 0 Drop No
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IP TELEPHONY

IP Enabler

IP Enabler connection hardware

The IP Enabler is an optional interface that plugs into the back of Alcatel Reflexes 3G sets. It is connec-
ted as shown below:

- The IP Enabler is connected to the LAN via an RJ45 connector with 10 Mbps Ethernet access for IP
Enabler V1.0, and 10/100 Mbps for IP Enabler V1S.

- Initialization, through static or dynamic IP addressing via DHCP, involves downloading the binary
file into the IP Enablers from the master VoIP CoCPU board, which is considered as a TFTP server.

- The PABX then considers an IP Enabler as a "fully-fledged" Reflexes station. Voice and signaling are
encapsulated in UDP packets and enable communications:
• IP Phone with UA / DECT / analog stations and network accesses.
• IP Phone with IP Phone.
• IP Phone with an H.323 terminal or an H.323 gateway (e.g.: NetMeeting PC).
- IP Phone with a PIMphony IP Edition.

Nota : The bandwidth of an Ethernet LAN can be 10 or 100 Mbps. If the network operates at 100 
Mbps, adding terminals operating at 10 Mbps risks downgrading the bandwidth and hence 
VoIP performance quality: it might be necessary to isolate these terminals on external LAN 
Switches.

PC LAN
PC LAN CPU

UA

LAN

IP ENABLER
4098 FRE

Mains power
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CONFIGURING AN IP ENABLER

Depending on the network topology, the configuring of the IP Enablers can be:
- completely automatic, if they are on the same subnet as the PBX: simply connect the IP Enabler to

the LAN and connect the power supply unit. The DHCP server allocates the dynamic IP addresses
and the TFTP server integrated into the CPU/CPUe board downloads the binary into the IP Enabler.

- manual, if the IP Enablers are connected to a different subnet of Alcatel OmniPCX Office, or if the
DHCP server integrated into the VoIP CoCPU board is deactivated: in this case the three IP para-
meters and the TFTP server address have to be entered on the terminals.

General IP Telephony parameter settings

Significant parameter: 

Number of VoIP-Subscriber Channels: number of channels dedicated to IP subscribers: 1 channel 
= 1 access (generally for small configurations; see also the abacus in the "Dimensioning - Limits" sec-
tion).

These channels are used by the IP Enabler for communications between the IP Enabler and the system 
terminals and client PC H.323 IP Enabler.

Activating/deactivating the DHCP server

Significant parameters:

Enable Integrated DHCP Server: if the box is ticked, it is the internal DHCP that assigns the IP ad-
dresses dynamically; otherwise, the DHCP is inhibited and the IP addresses have to be entered ma-
nually.

Dynamic Range: when DHCP is in service, the following two parameters delimit the range of availa-
ble IP addresses.

Start IP Address: start of the address range.

End IP Address: end of the address range.

Nota : - no address in the range must be assigned to any other LAN equipment!

- the integrated DHCP server only manages IP Enablers.

- by MMC-PM5 (Expert View): System Miscellaneous -> VoIP -> Parameters -> General tab

- by MMC-PM5 (Expert View): System Miscellaneous-> VoIP ->Parameters -> DHCP tab
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IP Enabler connected to the same Subnet as the PBX

The IP Enabler is connected to the same LAN as the PBX and the integrated DHCP server is activated: 
the recording sequence is automatic. This sequence is displayed on the station display and runs in 6 
phases. Each phase is represented by a flashing block on the display:
- Phase 1: IP initialization
- Phase 2: downloading of the configuration file (TFTP)
- Phase 3: downloading of the binary file (TFTP)
- Phase 4: binary flashing (not systematic). Remark: the binary is only flashed when there is a change

of version in the TFTP server (VoIP CoCPU board).
- Phase 5: downloading of the starting file
- Phase 6: establishing of UA signaling

At the end of phase 6, the station is initialized and appears on the list of terminals of the MMC-PM5.

Nota : Creation of the station is automatic, the system automatically assigns the first free directory 
number (it is not necessary to create an IP terminal beforehand). 

If an error occurs during the initialization sequence, a specific error message "Error x.yy" is displayed: 
see "Maintenance" File. 
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IP Enabler connected to another subnet than the PBX

The following example shows the cases where IP Enablers have to be installed manually:
- The IP Enabler (A) is connected to the same subnet as the H.323 gateway (VoIP CoCPU board), but

the integrated DHCP server is not active: manual initialization will be necessary.
- The IP Enablers (B and C) are not connected to the same subnet as the PABX: the registration se-

quence will have to be manual (even if the Alcatel OmniPCX Office integrated DHCP server is ac-
tive).

Nota : an IP Enabler cannot be managed by an external DHCP server.

- @IP 1: IP address of the master VoIP CoCPU board (e.g. 192.168.90.110)
- @IP n: IP address of the slave VoIP CoCPU board (1 to 5 boards) (e.g. 192.168.90.111)
- @IP RA: IP address of the router, subnet A side (e.g. 192.168.90.1)
- @IP RB: IP address of the router, subnet B side (e.g. 192.168.75.1)
- @IP RC: IP address of the router, subnet C side (e.g. 192.168.122.10)
Ed. 04 15/20Réf. 3EH 21000 BSAA



INSTALLATION - CONFIGURATION CALL SERVER : VOICE ON IP

 

CONFIGURATION

An IP Enabler has a configuration interface that can be used to program the IP parameters to establish 
the link with the PBX if necessary. The configuration menu is accessed by pressing the i and # keys in 
succession, immediately after connecting the IP Enabler mains power adapter. The following com-
mands are used in the menus:
- #: validation and return to previous menu;
- 0: return to previous menu / exit;
- *: cancellation and return to previous menu;
- HP- and HP+ keys: previous screen / next screen (signaled by the symbols ` / ).

Access to the configuration menu is inhibited as soon as phase 5 of the initialization sequence begins.

Access the configuration menu by pressing the i then # keys in succession, immediately after connec-
ting the IP Enabler mains power adapter. 
Main menu:

- 1. Mac Address: display of the MAC address of the IP Enabler (read only).
- 2. IP Parameters: display and modification of the IP parameters.
- 3. Versions: displays of the different software versions.
- 4. Others: display of the IP Enabler status.

Accessing the IP parameters menu: Option 2 - Parameters

- Press key 1 to switch from Dynamic mode to Static mode:
- Access the IP address configuration menu, option 2. Enter the IP address of the IP Enabler and con-

firm by pressing # (validation and return to previous menu) or quit by pressing *. E.g.
• IP Enabler A: 192.168.90.100
• IP Enabler B: 192.168.75.6
- IP Enabler C: 192.168.122.201

Nota : An address such as 192.168.75.6 will have to be entered as follows: 192 168 075006. To 
confirm the data entry, press #, the display returns to the previous menu.

- Access the subnet mask configuration menu, option 3. Enter the subnet mask and confirm by pres-
sing # (validation and return to the previous menu). E.g. 
• IP Enabler A: 255.255.255.0
• IP Enabler B: 255.255.255.0
- IP Enabler C: 255.255.255.0

1 . M A C A d d r e s s 3 . V e  
r

s i o n s

2 . I P P a r a m e t e r s 4 . O t h e r s
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- Access the default router configuration menu, option 4. Enter the IP address of the default router
and confirm by pressing # (validation and return to previous menu). In our example:
• IP Enabler A: @IP RA = 192.168.90.1
• IP Enabler B: @IP RB = 192.168.75.1
- IP Enabler C: @IP RC = 192.168.122.10

- Access the TFTP server configuration menu, option 5. Press # to enter the IP address of the TFTP
server and confirm by pressing # (validation and return to previous menu). In our example:
• IP Enabler A: 192.168.90.110
• IP Enabler B: 192.168.90.110
- IP Enabler C: 192.168.90.110

- After configuring the 4 parameters, return to the main menu by pressing 0, then validate the con-
figuration by selecting 0 again in the main menu, the display will propose the confirmation screen
"Save modification":
• press " * " to cancel and restart the configuring procedure
- press " # " to save the parameters, the terminal will display the 2 screens "Modification saved"

and "IPPhone will reset" in turn before reinitializing itself:

Nota : The IP Enabler power supply must not be disconnected during this phase.

- On restarting the IP Enabler will perform 6 registration phases:
• Phase 1: IP initialization
• Phase 2: downloading of the configuration file
• Phase 3: downloading of the binary file
• Phase 4: flashing of the binary
• Phase 5: downloading of the starting file
- Phase 6: establishing of IP signaling

At the end of phase 6, the station is initialized and the terminal appears in the list of the PM5 stations. 
Creation of the station is automatic, the system automatically assigns the first free directory number (it 
is not necessary to create an IP terminal beforehand).
If an error occurs during the initialization sequence, a specific error message "Error x.yy" is displayed: 
see "Maintenance" File.
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PIMPHONY IP EDITION

A PC equipped with PIMphony IP is considered by the PBX as an IP subscriber, in the same way as an 
IP Enabler. No specific programming is needed.
After installing the PIMphony IP software on a PC (conventional installation procedure by Wizard), a 
"Multimedia PC" type IP terminal is automatically created in the list of subscribers, with the first free 
directory number. Unlike the IP Enablers, Alcatel OmniPCX Office does not manage the IP address of 
a Multimedia PC; only its MAC address is registered at the first connection. No software (firmware) is 
transferred between the system and PIMphony IP during the registration procedure.
Registration is an "uncovered" mechanism based on the IP protocol: the PC generates a Multicast re-
quest and waits for the reply from a VoIP CoCPU board. During the reply / registration phase, the VoIP 
CoCPU board indicates its IP address to the PC and the PC transmits its Ethernet address (MAC Ad-
dress) to the PBX.
If there is no reply (e.g. IP routing problems), the PC generates the Multicast request several times, and 
if no reply is obtained, PIMphony IP enters a "failure" mode. The user is then asked to indicate the IP 
address of the master VoIP CoCPU board; if the address is incorrect, another request is made.
Once registration has been performed, the IP address of the VoIP CoCPU board is stored in the Win-
dows register base, and will be used for all the future connections. If a problem arises, such as a chan-
ge of the IP address of the VoIP CoCPU board, a new registration sequence (Multicast request) is 
initiated.
After initialization of PIMphony IP, IP connectivity must be permanent, otherwise the PBX considers the 
PC to be out of service. 
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PC H.323

A PC equipped with NetMeeting can establish PC - Station and Station - PC communications. Only the 
base station can be called with a PC equipped with NetMeeting.
A NetMeeting PC is not seen by the PBX as an IP Enabler but as a private directory number by the PBX, 
and requires a specific entry in the ARS table to be authenticated and have access to the PBX services.
A NetMeeting PC uses a DSP from the "VoIP access (IP trunks)" pool for these communications with the 
PBX and with a remote H.323 gateway.
A call to a NetMeeting PC is transparent for the user.
If the integrated gateway is used, the secure plug-in is required in order for the PC to establish com-
munication.
The configuration of a NetMeeting PC can be either:
- Static: its IP address serves as a reference, or
- Dynamic: the number (or the range) in the ARS entry is used for the connection.

NetMeeting PC in "static" configuration

PC with static IP addressing (permanent): authentication is based on the IP address of the PC.
ARS table:

- The "network" field must be "Private" when a PC is involved.
- In the case of a static IP address, only one PC can be registered, therefore there is only one directory

number: "prefix" field = "substitute", the "ranges" field is empty.
- List of trunk groups: corresponds to the index of the table containing the VoIP access trunk group,
- The destination field must be "PC" and its IP addressing type is static,
- IP address field: contains the IP address of the PC,
- None of the other parameters, Gateway Alive Protocol, Gateway Alive Timeout, etc., are applicable

in this configuration.

Notas : - only the "Destination - IP Type - IP Address" fields are obligatory. The hostname field is 
optional. None of the other IP fields in the ARS table are applicable.

- during communications in the PBX, the name associated with PC n° 124 (Remote PC) will 
be used except where a name has already been registered in the PBX directory for n° 124.

Netwo
rk

Prefix Ranges Substitute List. Trunk 
group list

Destina-
tion

IP Type IP Address Hostname

Priv. 258 258 4 PC Static 192.189.50
.120

option
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NetMeeting PC in "dynamic" configuration

- Dynamic addressing: authentication of the PC is based on its directory number (125 to 126) and
a password: this configuration requires a proprietary Alcatel Secure Plug-In in NetMeeting.

- The "network" field must be "Private" when a PC is involved.
- In the case of a dynamic IP address, several PCs can connect: "prefix" field = "substitute", the "ran-

ges" field contains the range of private numbers assigned to the PCs.
- None of the other parameters, IP Address, Hostname, Gateway Alive Protocol, etc., are applicable

in this configuration.

In both cases, remember that in the private numbering plan: there is no network between different PA-
BXs.

Netwo
rk

Prefix Ranges Substitute List. Trunk 
group list

Destina-
tion

IP Type IP Address Hostname

Priv. 26 0-5 26 4 PC Dynamic -- --

Function Start End Base NMT Priv

Main trunk group 258 258 ARS Keep Yes
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File
DIMENSIONING - LIMITS
SYSTEM DIMENSIONING

DSP channels required for IP Trunk services

The following table indicates the mean number of DSPs required depending the number of IP Enablers 
one wishes to install. The mean number of DSPs required is called "A":

Number of

IP Trunks

5 10 15 20 25 30 35 40 45 50

Number of DSPs 
(A)

5 10 15 20 25 30 35 40 44 47

VoIP Trunk Pool

10

20

30

40

50

60

70

80

90

100

110

10 20 30 40 50 60 70 80 90 100 110 120

VoIP trunks

Pool

Number of 
DSP channels
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The number of DSP channels (VoIP ports) required depends on the system configuration and the VoIP 
services to be implemented.
The main situations are as follows:
- H.323 gateway only
The number of DSP channels is equal to the number of IP network accesses required, in accordance 
with the IP trunk abacus above.

Nota : The desired number of DSP channels can be limited by the bandwidth reserved for VoIP ac-
cesses. E.g. if the reserved bandwidth is 64 Kbps, only 2 calls can be made simultaneously; 
the number of VoIP accesses can thus be limited to 2 channels.

In the case of PC-to-PC or IP Phone-to-PC communications using H323 PCs, the number of 
IP trunks is as defined by the abacus + 30 % of the number of PCs; for instance, you need 
to add 6 IP trunks in order to use 20 NetMeeting PCs.

- IP Telephony only
The number of DSP channels needed is indicated in the following paragraph.
- Conventional telephony (UA / DECT / Z, etc.) and IP Telephony
The number of DSP channels needed is indicated in the following paragraph.
- H.323 gateway and IP Telephony
The number of DSP channels needed is indicated in the following paragraph.
The number of DSP channels equals the desired number of IP network accesses.

Number of

IP Trunks

55 60 65 70 75 80 85 90 95 100

Number of DSPs 
(A)

51 55 59 62 66 69 73 76 80 83

Number of

IP Trunks

105 110 115 120

Number of DSPs 
(A)

87 90 93 96
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Calculating the mean number of DSPs required (IP Telephony)

The following table indicates the mean number of DSPs required depending the number of IP Enablers 
(IP terminals) one wishes to install. The mean number of DSPs required is called "A":

Number of

IP Enablers

4 5 10 15 20 25 30 35 40 45

Number of DSPs 
(A)

4 5 8 10 12 14 16 18 20 22

Number of

IP Enablers

50 55 60 65 70 75 80 85 90 95

Number of DSPs 
(A)

24 25 26 28 29 31 33 34 35 37

Number of

IP Enablers

100 105 110 115 120 125 130 135 140 145

Number of DSPs 
(A)

39 41 43 44 46 48 49 51 52 54

IP Phone Pool

0
5

10
15
20
25
30
35
40
45
50
55
60
65
70

4 5 10 15 20 25 30 35 40 45 50 60 70 80 90 100 120 140 160 180 200

IP terminals

Pool

Number of
DSP channels
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The mean number A must be reduced by the number of network accesses one wants to have in this 
system. A new value, called B, is calculated from the following formula:

B = Total number of network accesses - int.(B1/10) + int.(B2/20)
- B1 represents the total number of non-IP subscribers in the system (the number of IP Enablers in

the system is not included)
- B2 represents the total number of IP Enablers in the system.
- Int(B1/10) represents the whole number resulting from dividing B1 by 10 and int(B2/20) the whole

number resulting from dividing B2 by 20.

From the values A and B one obtains:

Mean number of DSP channels required for VoIP services = Min(A, absolute value of B)

Where Min(A, B) means: the smaller of the two values A and B.

Nota : The total number of DSP channels to be implemented for IP Telephony and/or IP network 
accesses will be increased to the next higher value out of the possible combinations of DSPs 
present in the system (reminder: a VoIP daughter board supports 4, 8 or 16 DSPs; the sys-
tem contains from 2 to 96 DSPs, varying every 2, except for 92). 

In the case of IP telephony and IP trunk mixing, simply total the DSPs.

Number of

IP Enablers

150 155 160 165 170 175 180 185 190 195

Number of DSPs 
(A)

55 57 58 60 61 63 64 66 67 69

Number of

IP Enablers

200

Number of DSPs 
(A)

70
Ed. 044/8 Réf. 3EH 21000 BSAA



File
3

DIMENSIONING - LIMITSCALL SERVER : VOICE ON IP

 

Configuration examples

H.323 gateway only

- 1 Operator station (non-IP)
- 40 Reflexes stations (non-IP)
- 5 T0 accesses
- 6 VoIP network accesses (example: 2 to a site A with a bandwidth = 64 Kbps and 2 accesses to a

site B with a bandwidth = 64 Kbps plus 2 other channels for NetMeeting PCs).
As all the DSP channels are associated with the H.323 gateway (no IP telephony), the number of DSP 
channels needed for this configuration corresponds to the number of VoIP accesses, i.e. 6 (increased 
to 8).

Small IP Telephony configuration

- 1 Operator station (non-IP)
- 20 IP Enabler stations
- 3 T0 (=6 channels)
In this case the mean number of DSPs associated with the 20 IP Enablers is: A=12.
B = 6 - 0 + 1 = 7.
The mean number of DSPs needed for this configuration is: Min(12, 7) = 7 (increased to 8).

Large IP telephony configuration

- 1 Operator station (non-IP)
- 70 IP Enabler stations
- 1 T2 access with 30 channels
A = 29; B = 30 0 +3 = 33.
The mean number of DSPs needed for this configuration is: Min(29, 33) = 29 (increased to 32).

Mean configuration in mixed telephony: IP and conventional telephony

- 1 Operator station (non-IP)
- 25 IP Enabler stations
- 25 DECT stations
- 6 T0 accesses
A = 14; B = 12 -2 +1 = 11.
The mean number of DSPs needed for this configuration is: Min(14, 11) = 11 (increased to 16).

Mean configuration in mixed telephony: IP and conventional telephony

- 1 Operator station (non-IP)
- 5 IP Enabler stations
- 40 conventional Reflexes stations
- 6 T0 accesses
A = 5; B = 12 - 4 + 0 = 8.
The number of DSPs needed for this configuration is: Min(5, 8) = 5 (increased to 8).
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Medium configuration for mixed telephony + H.323 gateway

- 1 Operator station (non-IP)
- 5 IP Enabler stations
- 40 conventional Reflexes stations
- 4 T0 accesses
- 5 VoIP network accesses
A = 5; B = (8+5) - 4 + 0 = 9.
- The number of DSP channels needed for IP telephony is: Min(5, 9) = 5.
- The H.323 gateway requires 5 additional DSP channels. 
The mean number of DSPs needed for this configuration is 10 (increased to 16).

Bandwidth

In an H.323 gateway configuration, a bandwidth can be associated with each ARS table entry to a 
remote H.323 gateway.

Number of DSPs depending on communication type:

- IP Phone - IP Phone: 0 DSPs
- PC - PC: 0 DSPs
- PC with internal H323 gateway - PC with internal H323 gateway: 1 DSPs
- IP Phone in conference: 1 DSPs
- IP Phone or PIMphony IP - Reflexes station or analog/ISDN network: 1 DSPs
- IP Phone or PIMphony IP - PC H323 or H323gateway (IP trunk): 2 DSPs

The following table indicates the potential number of simultaneous communications depending on the 
bandwidth reserved for Voice over IP calls:

Data rate (bandwidth) Number of simultaneous com-
munications possible

CODEC used

55.6 Kbps (or less) 1 G.723.1/G729a

64 Kbps 2 G.723.1/G729a

128 Kbps 5 G.723.1/G729a

256 Kbps 10 G.723.1/G729a

512 Kbps 20 G.723.1/G729a

≥ 1024 Kbps Depends on the number of IP 
trunks

G.723.1/G729a
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LIMITS & RECOMMENDATIONS

VoIP services

Voice over IP services require a software key.

VoIP CoCPU board

There can be a maximum of 6 boards in a system: one "master" board and five "slave" boards.
The "master" VoIP CoCPU board will be the first board seen by the system. If a VoIP CoCPU board is 
added to the system, it will be considered as a "slave" board.
A VoIP CoCPU board is equipped with a daughter board of 4, 8 or 16 DSPs maximum.
An Alcatel OmniPCX Office can contain a maximum of 96 DSPs.
If there is more than one VoIP CoCPU board in a system, each of the Ethernet ports of each board 
must be connected to the LAN and they must be connected to the same subnet.
It is possible to combine VoIP CoCPU boards with a different number of DSPs: if the system combines 
the IP Telephony and H.323 Gateway services, it is strongly recommended for the board with the lar-
gest number of DSPs to be the "master" board and that its IP address should be used as the reference 
for the remote H.323 gateways.
The VoIP CoCPU boards are to be connected via a LAN Switch: this solution reduces Ethernet access 
traffic.

DSP channels

After a cold reset, all the DSPs of the VoIP CoCPU board are assigned to the VoIP subscribers channels 
pool by default. The DSP allocation can be modified using MMC-PM5. 
Any DSP allocated to the VoIP access pool is removed from the VoIP subscriber pool: it will therefore 
no longer be available for IP telephony. Conversely, a DSP from the VoIP subscriber pool will not be 
able to be used for H.323 gateway calls.

IP Enabler

The theoretical limit on the number of IP Enabler + PIMphony IP stations that can be connected is 200, 
however:
- it is obligatory for the operator station to be a Reflexes station connected to a UA link, which means

that at least one UAI board must be installed in the system,
- the IP Enablers are "deducted" from the limit on Reflexes stations.

The Ethernet access of an IP Enabler is at 10 Mbps (IP Enabler V1) or 10/100 Mbps (IP Enabler V1S).

"VoIP Access" channels: H.323 gateway

A DSP channel of a VoIP CoCPU board assigned to the pool of VoIP access channels is considered by 
the system to be a public network access, that is to say "1 B channel".
Alcatel OmniPCX Office can have a maximum of 120 public network accesses: the maximum number 
of DSPs assigned to the VoIP access pool is 96.
Network accesses (T0, T2, DLT2, TL, ATL) + VoIP accesses ≤ 120
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ARS entry

The number of entries in the ARS table with a remote H.323 gateway as destination is limited to 500.
The number of entries in the ARS table that make reference to a PC (individual entry or with a range) 
is limited to 150.

Communication from station to NetMeeting PC

Station-to-PC and PC-to-Station communications depend on the configuration of the gatekeeper (in-
tegrated or external) and the presence of the secure plug-in on the NetMeeting PCs:

Yes: corresponds to a type of configuration that allows PC-to-Station and Station-to-PC communica-
tions, and Break-out calls from a PC.

No: corresponds to a type of configuration that does not allow PC-to-Station or Station-to-PC commu-
nications.

PC with secure plug-in PC without secure plug-in

Static IP Ad-
dress

Dynamic IP Address Static IP Ad-
dress

Dynamic IP Address

Integrated gatekeeper Yes Yes No No

External gatekeeper Yes (no 
Break-out 
security)

Yes (no Break-out se-
curity)

Yes (no 
Break-out 
security)

Yes (no Break-out se-
curity)
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File
MAINTENANCE
VoIP SERVICES - VoIP CoCPU BOARD

System with a single VoIP CoCPU board

If the VoIP CoCPU board is out of service, none of the VoIP services (H.323 gateway and IP Telephony) 
are available.
Resetting the H.323 gateway (VoIP CoCPU board reset) releases all ongoing communications on the 
H.323 gateway; reinitializing the IP telephony service resets all the IP Enablers and the communications 
in progress on the Multimedia PCs.
Modifying the IP address associated with the VoIP CoCPU board resets the board and all the ongoing 
VoIP services.

System with several VoIP CoCPU boards

If the master VoIP CoCPU board is out of service, all the VoIP services (H.323 gateway and IP Telepho-
ny) are temporarily unavailable. The PBX "switches" the VoIP services over to a slave VoIP CoCPU 
board: the PBX assigns it the IP address of the faulty board (reference address for the VoIP services: 
H.323 gateway, TFTP server, etc.) thereby enabling the VoIP services to be maintained (the number of 
possible VoIP communications will however be limited to the number of DSPs remaining).
After replacing the faulty VoIP CoCPU board, it will automatically be assigned the old IP address, which 
is now free, of the master VoIP CoCPU board: the new board will be "slave"; the PBX does not return 
to the pre-failure configuration.

Nota : It is recommended that the master VoIP CoCPU board of a PBX should be the one that has 
the largest number of DSPs. For systems with 2 boards, such as a VoIP CoCPU board with 
16 DSPs and a VoIP CoCPU board with 4 DSPs, if the 4-DSP VoIP CoCPU has become the 
system master board following a fault affecting the 16-DSP VoIP CoCPU board, then you 
should return to the original configuration after replacing the 16-DSP VoIP CoCPU board 
by unplugging the 4-DSP VoIP CoCPU board for a few minutes. 

If a slave VoIP CoCPU board is out of service, all the VoIP services will be redirected to the master VoIP 
CoCPU board. However, the number of possible VoIP communications will be limited to the number 
of DSPs remaining.
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IP TELEPHONY

Loss of IP connectivity

It takes several seconds for loss of connection to be detected: the IP Enabler attempts to restore the 
connection for several seconds. During this period the user may observe a slowing in the station dis-
plays resulting from repeated restoring and loss of connections.

Multimedia PC

If the "keep alive" mechanism detects a problem between a NetMeeting PC and the system (PBX reset, 
VoIP CoCPU board reset, IP connectivity problems), NetMeeting sends the user an error message: the 
user can either quit the application or wait to be reconnected.

IP Enabler: error messages

The following table gives the different causes of errors during the implementation of an IP Enabler (the 
"Num" field represents the number of the error message displayed on the station): 

Nu
m

LABEL MEANING

1.0
1

 NoMacAddress There is no MAC Address in the flash memory.

1.0
2

 NoDhcpServer No response from the DHCP server.

1.0
3

 BadLocalIpAddress Incorrect IP address.

1.0
4

 BadTftpIpAddress Incorrect IP address of the TFTP server.

1.0
5

 BadRouterIpAddress Incorrect IP address of the router.

1.0
6

 RouterNotResp No response to the "ping" of the router.

1.0
7

 IpInitError IP Enabler initialization error.

1.0
8

 EtherInitError Ethernet interface initialization error.

1.0
9

 IpDupli xxxxxxxxxxxx IP address duplicated with the MAC address equipment xxxxxxxxxxxx.

2.0
1

 LoadCfgNotResp TFTP server not responding: impossible to download the configuration 
file.

2.0
2

 LoadCfgRemoteEr-
ror

Loading of the configuration file: remote-end error.
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2.0
3

 LoadCfgLocalError Loading of the configuration file: local error (e.g.: memory allocation 
error).

3.0
1

 LoadBinNotResp TFTP server not responding: impossible to download the binary file.

3.0
2

 LoadBinRemoteEr-
ror

Remote-end error during downloading of binary file (e.g.: no binary file 
in the server, CPU not operational).

3.0
3

LoadBinChecksu-
mError

Error in binary file downloading: the calculated checksum differs from 
that in the file header.

3.0
4

 LoadBinLocalError Downloading of the binary file: local error.

3.0
5

 LoadBinHeaderEr-
ror

Downloading of the binary file: length error, the size of the file differs 
from that indicated in the file header.

3.0
6

 LoadBinFileTooLar-
ge

Downloading of the binary file: the size of the file exceeds the capacity 
of the flash memory.

3.0
7

 LoadBinGetErBadFi-
le

Downloading of the binary file: incorrect file name.

4.0
1

 BinUpdateFailed Failure when placing the binary file in the flash memory.

5.0
1

 LoadStartNotResp TFTP server not responding: impossible to load the starting file.

5.0
2

 LoadStartLocalError Local error in the starting file (e.g.: memory allocation error).

5.0
3

 LoadStartRemoteEr-
ror

Remote-end error in the starting file (e.g.: incoherent port number).

6.0
1 

 UaLinkLost Loss of the UA signaling link with the PBX (e.g.: master VoIP CoCPU 
board out of service). 

6.0
2

 AomNotSupported AOM refused. Incorrect version of the Add On Module.
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VoIP SERVICES ALARM MESSAGES

The NMC (Network Management Center) application Alcatel 4740 enables the following alarm mes-
sages specific to Voice over IP to be retrieved:
- Reset of VoIP CoCPU board xxxxx (message identical to those of the other boards in the system).
- VoIP CoCPU board xxxxx out of service.

• Diagnosis: reset and/or replace the board.
- DSP of VoIP CoCPU board xxxxx out of service.

• Diagnosis: reset and replace the VoIP CoCPU board if the fault persists or recurs.
- Ethernet interface of VoIP CoCPU board xxxxx Out of Service.

• Diagnosis: check the connection to the LAN and possibly the LAN components (Hub, switch,
etc.).

- Ethernet interface of VoIP CoCPU board xxxxx In Service.
- Remote gateway xxxxx Out of Service.

• Diagnosis: check the IP connectivity with the remote gateway (LAN, intermediate IP router) and
the status of the remote gateway.

- Remote gateway xxxxx In Service.
- External gatekeeper inaccessible.

• Diagnosis: check the IP connection with the external gatekeeper (LAN, intermediate IP router)
and the presence of the external gatekeeper.

- External gatekeeper refused.

• Diagnosis: check that the external gatekeeper has been configured correctly to accept the re-
gistration of Alcatel OmniPCX Office

- Automatic overflow: too much traffic to/from remote gateway xxxxx.
• Diagnosis: if this alarm occurs frequently, the bandwidth associated with this remote gateway

in the ARS table and the number of DSPs assigned to VoIP accesses must be increased if pos-
sible.

- Automatic overflow: VoIP call to/from gateway xxxxx refused because "not enough VoIP access
channels available".
• Diagnosis: if this alarm occurs frequently, the dimensioning of the DSPs must be reviewed:

either the bandwidth in the ARS table must be increased, or the number of DSPs assigned to
VoIP accesses must be increased, or another VoIP CoCPU board must be added.

- IP Telephony failures: no more DSP channels available.

• Diagnosis: if this alarm occurs frequently, the number of DSPs assigned to the IP subscriber pool
must be increased (either by reducing the number of VoIP access DSPs or by adding a VoIP Co-
CPU board).

- The IP Enabler cannot be initialized because of a DHCP server fault (no IP addresses available).
• Diagnosis: increase the number of IP addresses in the DHCP server range (this range of IP ad-

dresses must be greater than or equal to the number of IP Enablers to be installed).
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VoIP SERVICES - TRAFFIC COUNTERS

The VoIP services feature the following specific traffic counters accessible via MMC-PM5 in the menu: 
System Miscellaneous -> VoIP -> Traffic counters:

"General" tab:

- Number of incoming H.323 calls.
- Number of outgoing H.323 calls.
- Number of transiting H.323 calls (Break In, Break Out).
- Number of outgoing H.323 calls to H.323 gateway xxxxx refused because "insufficient bandwidth".
- Number of incoming H.323 calls to H.323 gateway xxxxx refused because "insufficient bandwidth".
- Number of outgoing H.323 calls to H.323 gateway xxxxx refused because "remote gateway out of

service".
- Number of outgoing H.323 calls to remote gateway xxxxx refused because "all VoIP access chan-

nels busy".
- Number of incoming H.323 calls to gateway xxxxx refused because "all VoIP access channels busy".
- Number of failed IP Telephony (audio) communications: all the DSP channels reserved for IP Tele-

phony are busy.

"Gateways" tab:

These counters indicate the number of VoIP calls to each of the remote H.323 gateways refused for the 
following reasons:
- Overflow on outgoing VoIP calls: VoIP CoCPU board(s) out of service.
- Overflow on outgoing VoIP calls: no more bandwidth available.
- Incoming VoIP calls refused: no more bandwidth available.
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File
THE NETWORK OFFERING
Nota : Alcatel OmniPCX Office supports analog ATLs from release 
R1.5 onwards; please bear this restriction in mind when reading the "Private 
Networks" section.

Global offering

Depending on the medium (or protocol) used, placing Alcatel OmniPCX Office systems on private 
networks offers the following main services:

- calls on TLs and ATLs: conversion from private dialing for outgoing calls.
- calls on ISDN, QSIG_BC and VPN lines: CLIP/COLP services, conversion into private dialing for

outgoing and incoming calls.
- Public or Private ISVPN: in addition to the previous services, optimization of transfers and forwar-

ding, additional information (transmission of the name, busy status, forwarding).
- ISVPN+: with regard to ISVPN services, addition of metering information.
- IP Networking: setting up an IP network using the existing data network to carry voice data at lower

cost; for more details see the "Voice over IP" section.

The table below shows the principles of use for the various protocols, depending on the amount of 
traffic and the requested level of service.

A private network can be homogenous or heterogeneous:

- homogenous: all the PABXs in the network belong to the same family (Alcatel OmniPCX Office,
Alcatel Office or Alcatel OmniPCX 4400).

- heterogeneous: the PABXs in the network belong to different families (Alcatel and others).

SUPPORTED STANDARDS

QSIG_BC: ETS 300-172 of ETSI specifications.

Colisée Performance specifications: CSE S 13-11 W.

ISDN Heterogeneous ISVPN Public ISVPN

VPN Public VPN + ISVPN

QSIG_BC Private ISVPN

ISVPN+

Voice + data traffic IP Networking

Integration of services

Voice
traffic
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DEFINITIONS

MASTER/SATELLITE CONFIGURATION

Only the master system has an operator station and incoming, external access. The satellite system 
uses the master system's external resources; The satellite can, however, have outgoing, external access. 
Several satellite systems can be connected to the same master system.

 

PEER TO PEER CONFIGURATION

In this topology, the 2 Alcatel OmniPCX Office systems each have their own Operator Station and their 
own incoming and outgoing external accesses.

 

Alcatel OmniPCX Office 
OR OTHER PABX

PUBLIC
NETWORK

MASTER

OPERATOR

PRIVATE
NETWORK

SATELLITE

OPERATOR

PUBLIC
NETWORK

PRIVATE
NETWORK

OPERATOR
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DIGITAL PROTOCOLS 

The following protocols can be used:

- QSIG-BC: protocol belonging to the QSIG family managing exchanges between private networks
at basic communication level.

- ISVPN: proprietary protocol = ISDN protocol + additional information by means of UUS (User to
User Signaling).
• on public lines: public ISVPN
- on leased lines: private ISVPN

- ISVPN+: proprietary protocol = QSIG + ISVPN protocol + additional information contained in the
UUS. This protocol can only be used with Alcatel OmniPCX Office/Office systems. The additional
information can be used by an Alcatel 4740 or Alcatel 4755 Management Center.

Nota :

All the accesses of the same DLT2 board (digital leased lines) can be used to connect several PABXs as 
long as they are all masters or slaves.
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ENVIRONMENTS

Nota :

The ATL - TL or QSIG-TL interconnection must be implemented with precaution in order to avoid any 
TL blocking (for example: a break-in by transfer between a TL without polarity inversion and an ATL 
joining on a remote user forwarded to an external number by another TL; in this case, there is no re-
lease of communications on these TLs).

VPNs ON PUBLIC LINKS

These virtual networks are specific to the country and the network operator. In these networks, which 
use the public operator protocols (analog or ISDN), private and public calls are routed on the same 
lines. Amongst these networks offering preferential rates, are:

- Fiat in Italy: analog or ISDN protocol
- Transgroupe (Collisée Performance) in France: ISDN only protocol

 

Characteristics of Transgroupe dialing

- public numbers are preceded by 0.
- private numbers are defined in a private numbering plan: closed dialing from 5 to 10 digits, with

short numbers as an option (10 to 15, 160 to 169, 36XX).

VPN

PUBLIC
NETWORK

TL/T0/T2
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MULTI-OPERATOR

With the ARS mechanisms, this environment enables: 

- use of the cheapest operator to call a correspondent.
- overflowing through the other operator when the cheapest one is unavailable.

 

INDIRECT OPERATOR

This environment makes it possible to redirect calls to operators offering attractive rates, for interna-
tional calls for example.

Depending on the analysis of the requested number, the ARS automatically redirects the call, transpa-
rently for the user, to another indirect substitution network and then retransmits the destination number 
as follows:
- seizure of a line in the network of the main operator
- dialing the access code or the number of the indirect operator
- waiting for an intermediary tone (or pause)
- switching into transparent MF dialing
- optional transmission of the account code (waiting for a 2nd tone or pause)
- waiting for a second intermediary tone (or pause)
- dialing the destination call number

 

OPERATOR
1 

OPERATOR
2 

TL/T0/T2

VPN

PUBLIC
NETWORK

OPERATOR
3 

SUBSTITUTION 1OPERATOR 

SUBSTITUTION OPERATOR 2
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ISVPN ON LEASED/PUBLIC LINKS

Using the proprietary ISVPN protocol on leased digital links makes it possible to connect an Alcatel 
OmniPCX Office system with an Alcatel OmniPCX 4400 system or another Alcatel OmniPCX Office/
Office system. 

 

QSIG-BC

The QSIG protocol on digital leased links can be used for interconnecting an Alcatel OmniPCX Office 
with a system from another manufacturer.

 

T0

T2
PUBLIC

NETWORK

     DIGITAL LEASED LINK

DLT2 if Alcatel OmniPCX Office or 
T0/T2 if Alcatel OmniPCX 4400

PUBLIC
NETWORK

OTHER
MANUFACTURER'S

PABX
DIGITAL LEASED LINK

(DLT0 or DLT2)
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Features

OPTIMIZED FORWARDING AND TRANSFER (digital networks only)

The path used by a call can be optimized in the following cases:

- immediate forwarding
- external dynamic forwarding
- external forwarding of operator calls
- transfer

Optimized immediate forwarding

Optimization of the path is carried out by rerouting the call.

- Optimization of the path between 3 nodes

 

A (1st node) calls B (2nd node) forwarded on C (3rd node). The result of the optimization corresponds 
to a direct call from A to C.

- Optimization of the path between 2 nodes

 

A (1st node) calls B (2nd node) forwarded on C (1st node). The result of the optimization corresponds 
to a local call from A to C.

Nota :

The same rules apply to the other types of forwarding.
If the forwarding destination calls the forwarding initiator, then the forwarding is overridden.
The maximum number of successive forwardings can be defined with a flag (transmission threshold: 
5 by default).

A

B

C

NETWORK

A

B

C

NETWORK
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Optimized transfer

The optimization mechanism is applied when the 2 external correspondents are on the same ISVPN 
node; the transfer can be monitored (connected) or not (on ringer).

Situation: B (master) is in communication with 2 correspondents (A and C) on the same system.

 

Optimization: the 2 communications are released and resynchronized on the remote system: a local 
call is made from A to C.

 

NETWORK FORCING (forced dialing)

For reasons of cost, a call from a public network user can be made to use private links as a priority, 
followed by public lines if the private network is completely busy.

OVERFLOW

When a destination can be joined in several ways and one of the paths fails (no more resources availa-
ble for example), the ARS automatically tries to take another path (private network -> public network 
or vice versa, from one public operator to another).

Overflow is controlled by the barring and traffic sharing mechanisms.

Overflow can also be applied to data communications after compatibility controls.

A
B

C

A B

C

NETWORK
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BREAK-IN / BREAK-OUT

Break-in and break-out services make it possible to carry out inter-establishment communications from 
a private network; this is realized with the use of lines leased between 2 or more PABXs belonging to 
this private network.

Break-in

This service corresponds to the transit of incoming calls from the public network to a private network 
via leased lines; thus, an external correspondent can join a private network user who is not connected 
to the same system as the line on which the call is routed.

Break-in can be implemented in 2 ways:

- automatically by DDI numbers
- manually by the operator (joining by transfer)

 

For the caller, it is also possible to set up a simple directory (a single group of numbers to call all users 
from one or several sites).

PABX A

PABX B

PUBLIC
NETWORK

Non DDI call

OPERATOR

DDI call

PRIVATE NETWORK
(LEASED LINES)

BREAK-IN
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Manual break-in

This is a joining by transfer between a T0/T2 access or a TL and a leased line.

In this case, the external correspondent accesses the line leased between PABXs A and B only through 
an operator; the operator of PABX A puts the caller on hold, establishes an enquiry call communication 
(seizure of the leased line + number of the remote subscriber) then carries out a transfer.

Settings:

According to the environment (analog/digital), authorize the various joinings between external
lines:

At system level, authorize external/external transfers select 

For each set, authorize external/external manual transfers select 

Automatic break-in

The public network correspondent joins a remote system subscriber using his DDI number (this service 
is only offered for calls routed on T0 or T2 access and personalized lines). 

Configuring with MMC-PM5:

The numbering plan for public incoming calls and ARS mechanisms enable correspondence between 
the DDI number coming from the public network and the subscriber (or hunting group) directory num-
ber in the private network.

Remarques :

- there is no monitoring (barring, traffic sharing) on break-in calls
- if the break-in call fails, the call is handled depending on the configuration of the analog protocol

or the table corresponding to incoming calls for digital leased lines (forwarded to operator or re-
leased).

- manual call pick-up (with RSP key) from a member of the operator hunting group is impossible in
call phase (before remote connection or re-routing to operator).

- distribution of a welcome message on a break-in call is impossible.

- by MMC-PM5 (Expert View), select: System Miscellaneous-> Traffic Sharing and Barring ->
Joining ->check the boxes to authorize the necessary joinings.

- by MMC-PM5 (Expert View) select: System Miscellaneous-> Feature Design -> check Transfer
Ext/Ext

- by MMC-PM5 (Expert View) select: Subscribers/Basestations List-> Subscribers/Basestations
List -> Details-> Cat. service -> check "Join Incoming and Outgoing" and "Join Outgoing and
Outgoing".
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Break-out/Proximity break-out

- Break-out

A break-out makes it possible for the user of PABX A to call, via leased lines, a public network user by 
using lines external to PABX B.

- Proximity break-out

A proximity break-out is a special use of the break-out: a call to the public network can be guided in 
order to exit via the pubic accesses which are closest to the destination.

Example: a PABX A user (STRASBOURG) calls C (PARIS); the call is redirected on the private network 
between PABXs A and B (PARIS) in such a way that it exits via B's public accesses.

This feature makes it possible to offer communications which are advantageous from a cost point of 
view; there are 2 ways of calling a public user from A:
- direct call by the public network; in this case, the communication is charged in full. 
- exit via A; thanks to the line leased between the 2 PABXs, only the part of the call from PABX B is

charged. 

 

The following break-outs are possible: 

- incoming call on leased line -> ISDN
- incoming call on leased line -> analog public network

The break-out can be implemented in 2 ways: 

- automatically
- manually (transfer by operator for example)

The ARS tables can be programmed so that the automatic break-out mechanism is used (overflow or 
forcing on the private network).

There is no monitoring (traffic sharing, barring) on break-out calls (PABX B); all these mechanisms must 
be set up on the caller side (PABX A).

PUBLIC
NETWORK

PABX B

BREAK-OUT

T2/T0
C

PABX A

PRIVATE NETWORK
(LEASED LINES)
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There is no operator recall in the following cases of failure (the call is released): 

- the trunk group is busy
- ISDN releases the call, the time-out for awaiting the 1st digit or interdigit having elapsed

TRANSIT

 

PABX B enables the transit of the following communications: 

- from a user A to users of PABXs C and D
- from the public network to users of PABXs C and D

These communications are established by:

- public or private break-in -> private
- private break-out -> private or public

The transit system acts as an access between the different protocols used; the level of service offered 
depends on the protocols implied in the communication: 

- QSIG <-> ISVPN: services offered by QSIG
- ISVPN on public line <-> ISVPN on leased line: ISVPN services
- VPN (ISDN) <-> ISVPN or QSIG: ISDN services

PUBLIC
NETWORK

PABX A

PABX B

PABX C

T0

T0

PABX D

QSIG
LEASED Ligne

VPN

ISVPN
LEASED Ligne

OTHER
MANUFACTURER'S
PABX

ATL
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CENTRALIZED OPERATOR

An incoming call, in transit on a PABX or transferred whilst ringing (unsupervised transfer) on a leased 
line, which is not answered after a certain amount of time, is automatically re-directed to the operator 
of the system which received the call.

The CENTRALIZED OPERATOR, the name given to this feature, is organized around the PABXs connec-
ted to the network over leased lines. One of the PABXs, configured as the "Master", will have the CEN-
TRALIZED OPERATOR STATION. The other "Satellite" PABXs may also have local operators.

 

Environment

When installing this feature on a PABX network, the following must be taken into account:

- A specific programming procedure, performed for each PABX in the network, makes it possible to
configure a Master PABX and Satellite PABXs. The operator of the PABX configured as the Master
becomes the Centralized Operator.

- Only incoming calls issued from the TL, T0 or T2 network interfaces of the Master PABX go through
the centralized operator mechanism. Nevertheless, Satellite PABXs can be equipped with network
junctors and a local operator thus enabling autonomous management of their traffic.

- An incoming call routed to the centralized operator benefits from the welcome message mecha-
nism, if it is active.

- The display on the centralized operator is usually provided for incoming calls which are routed to it.
- An incoming call which is considered as "non telephone" by the system, is not subject to the cen-

tralized operator mechanism. For example, an incoming T0 ISDN call a G4 Fax service.

B

A

DDI call
(station B)

MASTER SYSTEM

CENTRALIZED OPERATOR

Leased line

Call from B

TL/DDI (option)

SATELLITE  SYSTEM

LOCAL
OPERATOR
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Configuring a network with external lines on only one PABX

Only the ISDN external calls and the external communication transfers using these lines are taken into 
account.

The dynamic forwarding feature is used on these subscribers; forwarding is carried out by a speed dial 
number.

- program this new speed dial number in PABX 2 (N° 8000 for example) with the PABX 1 operator
as destination; the trunk group assigned to this speed dial number must be a logical direction for
optimization to be effective.

- program the PABX 2 subscribers supporting dynamic forwarding.

The external calls concern DDI direct calls (break-in).
If the called subscriber replies before time-out and wants to transfer a call to PABX 1, then Transfer 
Ext/Ext must be authorized.

If the same subscriber transfers to a PABX 2 user, two options are offered in the event of no reply:

• the set keeps ringing
• the call goes to the Centralized Operator; when this happens, program dynamic forwarding on

the sets:

Disadvantage: local calls are also forwarded to the Centralized Operator.
- the operator's local calls (9) can also be transferred to the Centralized Operator:

Numbering  -> Collective Speed Dial -> Add -> Trunk Group No = X

Subscribers/Basestations List -> Subscriber (select) -> Details -> Dyn. Rout. -> Timer T1 = 
length of ring, External Calls level 1 = X in T1 use , Destination N° = 8000 

System Miscellaneous -> Feature Design -> Add -> X to Transfer Ext/Ext 

Subscribers/Basestations List -> Subscriber (select) -> Details -> Dyn. Rout. -> Timer T1 = 
XX, Internal Calls level 1 = X in T1 use, Destination N° = 8000 

Numbering -> Internal Numbering Plan -> Function = Secondary Trunk Group, Start and 
End = 9, Base = 0, NMT = keep, Priv = yes

PABX 1

ISDN

PABX 2
Private T0

Centralized
operator
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Configuring a network with external lines on each PABX

If there is no local operator in PABX 2, use the programming shown in the previous example.

When there is a local operator in PABX 2, this operator can be put in or out of service by using the 
"Attendant Diversion" key. 
- the PABX 2 sets which have forwarding are in dynamic forwarding on their operator.

- to program an "Attendant Diversion" key.

Set up from the Operator:

• press the "Attendant Diversion" key
• operator code (1954 by default); the LED associated with the key flashes.
- to cancel: same procedure

- it is also possible to use the time ranges during which forwarding is active.

The operator's internal calls (9) follow the diversion (not the internal calls).

Numbering -> Automatic Routing Selection -> ARS Table -> Network = priv, Prefix = 9, Re-
place = Centralized operator number Trunk Groups List = private, Called = Hom

Subscribers/Basestations List -> Subscriber (select) -> Details -> Dyn. Rout. -> Timer T2 = 
XX, External Calls = X in T1 use, Level 2 = X in T2 use, X in Routing to Gen. Level, X in Di-
version Apply 

Subscribers/Basestations List -> Subscriber (select OS) -> Details -> Keys -> Type = Func-
tion Key -> Function = Attendant Diversion, Number = 8000

System Miscellaneous -> Time Ranges -> Auto Routing Destination = 8000, Activated Ma-
nually = yes in the Routing Time Ranges

PABX 1

ISDN

PABX 2
Private T0

Centralized
Operator
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Call handling

The table below describes the reactions of a centralized operator network with or without a satellite 
local operator.

SITUATION SAT. WITHOUT LOCAL OPER. SAT. WITH LOCAL OPER.

The call N° in the satellite does not 
exist or is incomplete

The centralized operator is 
rung

The time-out (ReroutOpe) starts 
up

The local operator is rung

No ATL available The centralized operator is rung

No connection rights

The called party is released The time-out (ReroutOpe) starts up

The set is rung

The called party is grade 1 busy The time-out (ReroutOpe) starts 
up

If the satellite has the right to 
camp on, then the call is cam-
ped on; if not, the centralized 
operator is rung

The time-out (ReroutOpe) starts 
up

If the satellite has the right to 
camp on, then the call is cam-
ped on; if not, the local opera-
tor is rung

The called party is grade 2 busy The centralized operator is 
rung

The time-out (ReroutOpe) starts 
up 

The local operator is rung

The call N° is out of service

The called party is in DND

The time-out (ReroutOpe) expires The call is directed to the centralized operator

The incoming call is transferred to 
the satellite

The time-out (TransfeTim) starts up

The set is rung

The time-out (TransfeTim) expires Depending on configuration of "Master recall" to the centralized 
operator the call is:

- either routed to the centralized operator
- or routed to the initiator of the transfer. When the time-out

(Duration of Hold Recall Ringing) has lapsed, the call is di-
rected to the centralized operator
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EXTERNAL FORWARDING OF OPERATOR CALLS

This service makes it possible to forward all operator calls (local calls, public and private incoming 
calls, operator recalls, dynamic forwardings) to a public or private external destination.

For a more detailed description, see the relevant section in "Telephone Features".

AUTOMATIC CALL-BACK ON BUSY TRUNK GROUP

If a call goes through ARS mechanisms and if all the configured trunk groups are busy, it is possible 
to activate an automatic call-back request on a busy trunk group. The user is called back as soon as 
a line in the first trunk group (traffic sharing) proposed by the ARS mechanisms is released.

DISTRIBUTION IN A PRIVATE DIGITAL NETWORK

- The handling of external calls (on public lines) and internal calls (on leased lines) can be configured
differently.

In the case of unanswered calls on leased lines, the dynamic forwarding mechanisms of an internal 
(local) call relative to the called set are applied.

- by MMC-PM5 (Expert View), select: External Lines-> Incoming Call Handling. For each type
of line, you can define the actions (call released or forwarded to the operator) in the following
situations:
• depending on whether the caller is public or private
• called party busy 2nd degree
• other called party status (in Do Not Disturb forwarding, out of service, recall situation fol-

lowing a transfer failure)
- misdial
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PRESENTATION OF CALLS

- Presentation to the called party
You can select the presentation mode for private calls: 
• presentation as local call:
• internal ringer
• number of the caller not memorized in the directory of last callers (except if the call has a UUS)
• no welcome message option
• presentation as external call:
• external ringer
• number of the caller memorized in the directory of last callers
• welcome message option

- Presentation to the caller

On the caller's set, the display always shows the number dialed by the user (not the one after modifi-
cations by the ARS).

The number can be replaced by the name (name received if ISVPN, or name in the personal or collec-
tive speed dial numbers).
- Transfer

In case of a transfer within an ISVPN network, the ISVPN subscribers' displays are handled as if they 
were in the same system. Especially after a transfer of an incoming call from user A to user B in a dif-
ferent node, the display of B indicates the external caller rather than the user A.

- Diversion/Dynamic routing

If an incoming call to subscriber A is diverted to subscriber B in a different node, the call is presented 
to B with the name of A on the display. Currently, only the number of A is displayed.

CALLED PARTY STATUS

During an outgoing call, the ISVPN protocol makes it possible to signal to the caller whether the called 
party is busy; the called party's busy status is only indicated by a message on the caller's display; there 
is no audio indication (the caller always hears the call-back tone transmitted by the network). 

INTRUSION

When the remote correspondent is busy, the ISVPN protocol makes it possible to intrude on this set 
(unless it is protected against intrusion).

- by MMC-PM5 (Expert View), select: System Miscellaneous-> Feature Design -> Private Call
Presentation
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INFORMATION DISPLAYED

ISVPN on leased lines

Example:

 

Forwarding

For a call on digital lines (ISDN or QSIG) and if the called party is forwarded, it is possible to define, 
using MMC-PM5 (Expert View), the identity which is transmitted to the rung set:

- either that of the caller (set B in the example)
- or that of the called set (forwarded set A)

Call Number dialed Number transmit-
ted

Caller's display Called party's dis-
play

A -> C 5135 (private network 
call)

5135 on leased line Name of C Name of A

B -> C 5135 (local call) 5135 Name of C Name of B

B -> 
OPER.

9 (private network 
call)

9 on leased line Name of operator Name of B

B ->D 00388677700 (public 
network call)

0388677700 by 
break-out

0388677700 or 
name of D (if mana-
ged locally)

0388675101

- by MMC-PM5 (Expert View), select: System Miscellaneous -> Feature Design ->check one of
the 2 boxes o CLI Transmission or o CLI is Diverted Party.

T0

T0

Station D (0388677700)

Node 51
03886751XX

ISDN

ISVPN

Node 52

Station B (5101)

Station C (5135)

CENTRALIZED
OPERATOR

ISVPN

Node 50

Station A
(500)
Ed. 04 19/20Réf. 3EH 21000 BSAA



THE NETWORK OFFERING CALL SERVER : PRIVATE NETWORKS

 

SUMMARY TABLE

Features VPN ISVPN 
"Public"

ISVPN 
"Priva-
te"

QSIG ISVPN+

Differentiation between public and private 
calls

YES YES YES YES YES

Internal or external incoming call handling YES YES YES YES YES

Break-in/break-out -- -- YES YES YES

CLIP/CLIR YES YES YES YES YES

COLP/COLR -- -- -- YES YES

Non answered calls repertory YES YES YES YES YES

Sub-addresses YES YES YES YES YES

Display of caller -- YES YES -- YES

Optimization of the transfer -- YES YES -- YES

Optimization of forwarding -- YES YES -- YES

Indication of forwarding on the centralized 
operator

-- YES YES -- YES

Transporting of the name in UUS -- YES YES -- YES

Intrusion -- YES YES -- YES

Information on metering sent to the master in 
Master/Satellite configurations

-- -- -- -- YES
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File
PRINCIPLES OF ARS MECHANISMS 
OVERVIEW

ARS is a mechanism which, during the routing of a call: 

- forces the use of the most appropriate path according to the number dialed.
- chooses another path if the most appropriate one is overloaded.

This mechanism is applied independently of the type of:

- trunk group: public or private
- handling: analog or digital
- call: voice or data

ARS is completely transparent for the user; the number dialed is, if necessary, modified automatically 
according to the chosen itinerary.

The ARS mechanism can be applied for the following calls: 

- outgoing call with manual dialing:
• without specific line seizure
• with specific public line seizure
- using resource keys assigned to a trunk group

- outgoing call with automatic dialing:
• call keys
• personal and collective speed dial numbers, call by name
• last number redial, temporary memory number
- last callers directory

- all types of forwarding and routing to an external destination
- VPN configurations (Transgroupe/heterogeneous network) for converting a public number into a

private number (incoming call) or vice versa (outgoing call).
Ed. 04 1/18Réf. 3EH 21000 BSAA



PRINCIPLES OF ARS MECHANISMS CALL SERVER : PRIVATE NETWORKS

 

CONFIGURING ARS PARAMETERS

ARS is implemented when the "Base" field is empty for the "Main trunk group seizure" and "Secondary 
trunk group seizure" features in the main numbering plan and the numbering plans for private and 
public incoming calls.

Main numbering plan

Base: if this field is empty, the call is of type ARS; if not, it is a trunk group call.

NMT: this field defines whether the digits defined in the "Start" and "End" fields are absorbed or con-
served.
Priv: this field is a reference for the "Network" parameter in the ARS table:
- Yes: the outgoing number in the numbering plan is compared to the entries in the ARS table with

"Network" = Private. 
- No: the outgoing number in the numbering plan is compared to the entries in the ARS table with

"Network Identifier" = Public, Urg. or Code auth.

After analysis and possible modification by the NMT, the outgoing digits in the numbering plan are 
entered in the ARS table.

ARS TABLES

The installer determines the numbers or parts of numbers in front of the ARS handling. For each des-
tination defined by a prefix, it creates a "trunk group list". For each index in the list, it is possible to 
assign one or several trunk groups and commands for modifying the dialing.

The ARS prefix replaces the external seizure prefix. On recognition of the prefix, the system determines 
the associated "trunk group list". The ARS mechanism therefore uses the route by activating the call on 
the corresponding trunk group. If the trunk group is busy, the next programmed route is used.

Nota : In some instances, the equivalent French acrostic "ADL" may be found instead of "ARS".

Start End Base Function NMT Private

XXXX XXXX Main trunk group Keep or 
Drop

Yes/No

XXXX XXXX Secondary trunk groups Keep or 
Drop

Yes/No

Number
dialled

Number
transmitted

ARS
TABLE
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USE OF THE VARIOUS TABLES

- The various parameters required for ARS mechanisms are configured using MMC-PM5 (Expert
View) only

- Structure of the main tables:

 

- Dimensions:

Max. number of prefixes (= number of lines in each of the 2 tables): 120

Max. number of entries in the trunk group lists (= number of lines in each of the 2 tables): 120
Max. number of ranges: 120.

- by MMC-PM5 (Expert View), select: Numbering -> Automatic Routing Selection. -> then con-
figure the following tables:
• ARS table
• Trunk groups list
• Hours table
• Day table
• Providers / Destinations
• Authorization codes
• Tone/Pause
- ARS miscellaneous

Network Prefix Ranges Called/HH
User 

Substitute
TrGrp

list

ARS table

Trunk group list

Pub 885040 Het51 1

TrGrp list Index TrGrp No. Char Tone/PauseAccess digits
Authorization

codes

Client code table
Tone/Pause table

1 3 503 T 08131 02

Fields and tables for multi-operator use

0-3 ; 6-7

Optional
fields

comment

Provider/
Destination

FT_NATIONAL
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ARS TABLE

Base fields:

These fields are necessary and sufficient for the majority of network topologies.

As many trunk group lists as are authorized can be allocated to each prefix; by default no prefix is 
defined.

Network: this network identifier defines the prefixes as public prefixes (Pub), private prefixes (Priv), pu-
blic emergency numbers (Urg) or public access codes (Code auth.).

Prefix: an empty field (default value) corresponds to the numbers which do not correspond to any pre-
fix for the network identifier concerned.
Ranges: this is used both for outgoing and incoming calls; there is no range for public emergency 
numbers or public access codes. It is possible to enter several ranges (separate them using the ";" cha-
racter) within the authorized limits (see previous page).

Substitute: the ARS prefix can be modified by the contents in this field.

- prefix = empty; replace = empty: transparent dialing in the ARS table.
- prefix = empty; replace = XXX: addition of digits XXX
- prefix = XXX; replace = empty: absorption of digits XXX
- prefix = XXX; replace = XXX: no modification (no addition nor absorption)
- prefix = XXX; replace = YYYY: XXX replaced by YYYY

TrGp list: this field defines the index for one or several selected trunk group lists. Priority is given to 
the trunk groups in the first list, in the order of programming, then to the second list, and so on.

Called/HH: the called party belongs to a homogenous network (Alcatel OmniPCX or Alcatel 4400) 
or a heterogeneous network (systems made by different manufacturers).
User comment: the information entered in this field is memorized in the system.

Optional fields:

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 885040 0-3; 6-7 51

885040

2

1

Het.

Metering Caller Called/PP

Priv Pub

Overflow Pub Pub
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Metering: only significant for a centralized metering application (NMC), this field is only used for en-
tering additional information in the metering data:

- field empty
- overflow
- network (private network forcing)
- VPN
- VPN + network
- VPN + overflow

Description of the "Caller" and "Called" parameters

The following fields are to be filled in for specific network topologies (in the majority of cases, the de-
fault values are sufficient). These fields concern the coding and contents of the data sent in a call.

Caller: the caller's number corresponds to the private numbering plan (the caller's private number, 
made up from the private installation number, must be transmitted) or to the public numbering plan 
(the public number is made up from the public installation number).

Called/PP: the sent called party's number is public or private (field reserved mainly for VPNs; "Type of 
dialing plan" in the setup: Public network).

Important : Use of default values in the "Caller" and "Called" fields.

For appropriate use of default values in these fields, the installer must take the following remarks into 
account:

- The type of line must be configured correctly.

- On a private link, the caller's private number is transmitted by preference; nevertheless, if the pri-
vate number is not available, the public number (break-out only) or the private installation number
(call in the private network) is transmitted.
On a public link, the caller's public number is transmitted; if it is not available, no caller identifica-
tion is supplied.

- The default values are to be used for all outgoing calls to the public network (the 2 fields are public)
and for all calls in the private network (the 2 fields are private).
On the other hand, it is recommended to use specific values for VPN calls (the 2 fields are private 
whilst the external line is public) or when the Alcatel OmniPCX Office is connected by a line leased 
to a particular system.

- By MMC-PC, select: External Lines -> External Lines ->select line -> Details ->select or
deselect o Public Trunk:
• a DLT2 access must be configured as a leased line (default value)
- a T0 or T2 access must be configured as a public line (or a leased line if linked with an

Alcatel OmniPCX 4400 system)
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Possible combinations

This paragraph describes the significant combinations for the "Caller" and "Called" fields according to 
the network environment of an Alcatel OmniPCX Office system.

- for an outgoing call on a leased link (QSIG): only the following fields are significant:
• caller = private or public
- called = private (heterogeneous and homogenous values are also used).

- for an outgoing call on public link: 
• caller = private or public
• called = values according to the table below:

TRUNK GROUP LISTS

Each trunk group list can have as many trunk groups as are authorized within the global limits.

The "Access digits", "Authorization code" and "Tone/pause" fields are specific to MULTI-OPERATOR 
MODE 

Example:

TrGp list: identifier for each trunk group list (see table of prefixes).

TrGp index: this field makes it possible to select one or several trunk groups identified by an index (1 
to 120); for a list with several trunk groups, priority is given to the first index. LOCAL is used when no 
trunk is used to call the destination.
TrGp No.: this field automatically displays the directory number of each trunk group in the list.
Char: this field defines a character used in metering or on set displays (for example: T for Transgrou-
pe).
Provider: the operator name used depends on the time range (see below).

Called/PP Called/HH Use

Public Homoge-
nous

Internal call from a user in a private network (homogenous ISVPN)

Public Heterogen. Outgoing call to the public network or internal call from a user in the pri-
vate network (heterogeneous ISVPN)

Private Heterogen. Internal call from a user in the private network (heterogeneous VPN) or 
outgoing call to the public network by VPN private dialing (ISDN user also 
declared in VPN)

Private Homoge-
nous

Internal call from a user in a private network (homogenous VPN)

TrG
p list

Index TrGp. 
No.

Char. Provider / Destina-
tion

Access di-
gits

Authoriza-
tion code

Tone/Pause

1 1 0 FT LOCAL

3 503 T FT LOCAL 131 02 02
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If a label is defined for a trunk, the control system checks the validity of the label for the considered 
time range. If it is valid, the trunk group is selected if it respects the traffic sharing conditions. If not, 
there will be an overflow to the next trunk group. The presence of a label in this field implies the con-
figuring of time slots, groups of days, etc.
Access digits: this field defines the code for accessing an indirect network.
Authorization code: index (1 to 24) in the "client code" table.
Tone/Pause: index (1 to 8) in the "Tone/Pause" table

NETWORK SERVICE PROVIDERS

This table defines the names of the various network service providers associated with a trunk group list 
for each time range. The table can also receive internal destinations.

TIME RANGES

The use of time ranges in the ARS allows the operator to select the route offering the best cost condi-
tions at any given instant. Access to the operator can be direct (e.g. Cégétel) or indirect (e.g. Espadon).

The table defines different time ranges and to associate providers with each day group in each range; 
it is also possible to enter internal destinations (the same as are indicated in the "Provider / Destina-
tions" table).
4 providers can be associated with each combination of time range/day groups. If 2 labels out of the 
4 relate to the same destination, the associated trunk groups must be different so as to enable overflow 
if one of the providers is busy.
If no provider is defined for a given combination, a route will be selected from amongst the trunk 
groups without associated provider labels, independently of the time ranges. The same mechanism 
applies for the days in the week or bank holidays not associated with a day group.
It is recommended to put one trunk group without provider in each trunk group list to be able to flow 
the call in all possible cases of figures.
Total number of time ranges: 500 maximum.

Start End Day group Provider / 
Destination 1

Provider / 
Destination 2

Provider / 
Destination 3

Provider / 
Destination 4

08:00 1 FT LOCAL ESPADON CEGETEL

2 CEGETEL

3

12:00 1 FT LOCAL

2

3
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DAY GROUPS

This table defines an operating mode (carrying out a day group) for each day of the year.

- Days of the week:

In order to simplify management, the 7 days of the week are split into 7 groups (for example: the 5 
working days = group 1, Saturday and Sunday = group 2)

- Bank holidays:

There is no need to define the year for fixed bank holidays (* character); for variable bank holidays, 
indicate the year (using 4 figures).

Nota : The data contained in this table can also be entered using MMC-Station.

AUTHORIZATION CODES (MULTI-OPERATOR MODE ONLY)

This table (24 entries of up to 10 characters) defines the secret access codes between the networks of 
different operators; these codes are used in establishing a specific charge for access from one network 
to another.

Day of the week Day Month Year Day group

Monday 1

Tuesday 1

Wednesday 1

Thursday 1

Friday 1

Saturday 2

Sunday 2

14 7 * 2

1 5 * 2

30 3 1997 2
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"TONE/PAUSE" (MULTI-OPERATOR MODE ONLY)

This table (8 entries max.) is indicated by the "Tone/Pause" parameter of trunk group lists. It defines 
the reactions when a call is redirected to an indirect network: pause duration or tone detection, auto-
matic switch over to MF dialing.

Example:

Time/Tone: the following values are possible:

- Tone: if value = 0, the PABX waits for the dial tone before transmitting the dialing on the line. Wai-
ting for the tone is only possible on analog lines.

- XXX: the PABX waits XXX milliseconds (from 8 to 20000, in multiples of 8 ms) before transmitting
the dialing on the line.

Force MF: after the access code, the network which is called indirectly can receive the digits in a si-
gnaling mode different from the one on the line in use. If the value in this field is YES, then all dialing 
transmitted after the access code is MF.

ARS MISCELLANEOUS (MULTI-OPERATOR MODE ONLY)

2 flags are proposed:

- Manual direct access: this flag is only analyzed if the "Prefix" field in the ARS table relates to a public
access code (code auth). If the dialed number has a public access code and if the flag is not autho-
rized, the call is rejected.

- Automatic indirect access: this flag is analyzed when the "Access digits" field in a trunk group list is
filled in. When the flag is not authorized, the next line in the trunk group list is analyzed.

Index Time/Tone before Auth.(ms) Time/Tone after Auth (ms) Force MF

1 Tone 8 No

2 Tone Yes
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BASIC PRINCIPLES FOR UNDERSTANDING ARS MECHANISMS 

For a particular prefix, it is possible to define several ranges

36123 dialed -> selection of the first entry (123 belonging to the range 0-1).

368899 dialed -> selection of the second entry (8899 belonging to the range 87-97).
3699 dialed -> selection of the third entry (99 not belonging to any range defined for the prefix 36).

If a range covers other prefixes for outgoing calls, the first range corresponding to the digits 
dialed is selected

3655 dialed -> selection of the first entry (55-66 included in 5-6).

36889 dialed -> selection of the first entry (888-999 included in 88-99).

Different ranges cannot be defined between the fields "Prefix" and "Substitute"

36 [01-03] cannot be replaced by 03886777[51-53] -> 3 entries have to be created in the ARS table.

Network Prefix Ranges Substitute

Priv 36 0-1; 22-23; 444-555; 6666-7777 03887766

Priv 36 24-25; 87-97 03884433

Priv 36 - 03881100

Network Prefix Ranges Substitute

Priv 36 5-6; 888-999 03887766

Priv 36 88-99 03884433

Priv 36 55-56 03881100

Network Prefix Ranges Substitute

Priv 3601 0388677751

Priv 3602 0388677752

Priv 3603 0388677753
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As soon as a prefix is recognized and if the digits dialed do not belong to the range, there is 
no overflow from one prefix to another

77299 dialed -> recognition of prefix 77: 299 not belonging to the range defined for this prefix, the 
dialed number is not taken into account by the ARS mechanisms (even though this number corresponds 
to entry 7[1000-7299]. To remedy this situation, configure the following ARS table:

Pay attention to overlaps in the "Substitute" field

There is an overlap between 03887766[00-99] and 0388776688. For incoming calls, there are 2 
possible conversions of the public number 0388776688 into private numbers: 3688 and 3588. For 
example, to convert the public number into the private number 3588, configure the ARS table as fol-
lows:

For incoming calls, the public number received, 03887766XX is converted into the private number 
35[88-99] if XX does not belong to the range 00-87.

Network Prefix Ranges Substitute

Priv 7 1000-7299 7

Priv 77 300-320 1

Network Prefix Ranges Substitute

Priv 7 1000-6999 7

Priv 77 000-299 77

Priv 77 300-320 77

Network Prefix Ranges Substitute

Priv 36 00-99 03887766

Priv 3588 - 0388776688

Network Prefix Ranges Substitute

Priv 36 00-87 03887766

Priv 3588 88-88 03887766

Priv 3689 89-99 03887766

Network Prefix Ranges Substitute

Priv 36 00-87 03887766

Priv 35 03887766
Ed. 04 11/18Réf. 3EH 21000 BSAA



PRINCIPLES OF ARS MECHANISMS CALL SERVER : PRIVATE NETWORKS

 

ARS INTERACTIONS WITH OTHER SERVICES

LINE ALLOCATION

This feature is incompatible with ARS mechanisms.

BARRING AND TRAFFIC SHARING

The traffic sharing mechanism within a trunk group list or between trunk group lists can be used to 
authorize overflow between trunk groups for specific users.

When barring prohibits dialing on the selected trunk group, no overflow is possible and the call is re-
leased.

EMERGENCY NUMBERS

This paragraph only concerns the emergency numbers defined when the system is initialized (numbers 
installed in ROM).

ARS table base fields:

The only possible configurations for emergency numbers ("Network" field = Urg.) are:

- prefix = empty; replace = empty: transparent dialing in the ARS table.
- prefix = empty; replace = XXX: addition of digits XXX (used for break-out).

The traffic sharing and barring mechanisms are not applied to emergency numbers (as with collective 
speed dial numbers).

If the emergency number is dialed after line seizure, the call goes through the ARS mechanisms if the 
line figures among the trunk groups in the ARS tables; if not, the number is transmitted on this line 
directly.
If the ARS table has no entry for emergency numbers, the trunk group associated with the default public 
prefix is used, if there is one; if not, the main trunk group is used.

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Urg - - - XX
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INTERNAL ARS DESTINATIONS 

ARS mechanisms can handle internal destinations.

INTERNAL CALL FORCING

When a user tries to call a correspondent (connected to the same Alcatel OmniPCX Office system or 
belonging to the same private network) by dialing the correspondent's public number, the ARS mecha-
nism converts the public number into an internal number, and an internal call is made.

Configuration example

 

"ARS Table" configuration:

"Trunk group list" configuration:

In this example:

- the public call from user 2102 to user 2103 (by dialing 08840722103) is converted into a local
call by replacing 8840722 by 2; the system therefore sends the number 2103.

- the public call from user 2102 to user 1101 (by dialing 08840721101) is converted into a local
call by replacing 8840721 by 1; the system therefore sends the number 1101 over trunk group 2
(as the 2 sets do not belong to the same PABX).

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 8840722 100 - 200 2

Pub 8840721 100 - 200 1 1

TrG
p list

Index TrGp. 
No.

Char. Provider / Destina-
tion

Access di-
gits

Authoriza-
tion code

Tone/Pause

1 2 500

PUBLIC
NETWORK

User 1101

User 2102
User 2103

Node 1

Index 2 trunk group

Index 1 trunk group

Node 2

NDI : 884072
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SELECTING THE DESTINATION ACCORDING TO THE TIME

It is also possible to route a call to different internal destinations depending on the date and time. This 
is achieved using overflow mechanisms between trunk group lists with the same index.

Configuration example

"ARS Table" configuration:

"Trunk group list" configuration:

"Time Ranges" configuration:

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Priv 5000 102

103

100

200

TrG
p list

Index TrGp. 
No.

Char. Provider / Destina-
tion

Access di-
gits

Authoriza-
tion code

Tone/Pause

100 LOCAL User 102

200 LOCAL User 103

Start End Day group Provider / 
Destination 1

Provider / 
Destination 2

Provider / 
Destination 3

Provider / 
Destination 4

00:00 12:00 1 User 102

12:00 00:00 1 User 103
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"Day Groups" configuration:

- All the days of the week are assigned to day group 1.

"Providers / Destinations" configuration:

In this example, if an internal user dials 5000: a call made between 0 and 12.00 hours will be put 
through to set 102 and a call made between 12.00 and 0 hours will be put through to set 103.

- between 0 and 12 hours: trunk group list 100 is selected; 5000 is replaced by 102 and user 102
is called.

- between 12 and 0 hours: first of all trunk group list 100 is selected; 5000 is replaced by 102. Over-
flow occurs in the ARS table and the second entry (trunk group list 200) is selected. 5000 is replaced
by 103 and user 103 is called.

Providers / Destinations

User 102

User 103
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REROUTING ON OPERATOR BUSY

Definition

When a call cannot get through because the operator is busy, this mechanism automatically reroutes 
it via another operator. 

The rerouting mechanism is totally transparent to the user (no specific tone or display).

The mechanism is only offered for calls routed by ARS over ARS trunk groups (ISDN trunk groups only).

Automatic rerouting when the operator is busy is activated by the triggers defined by the "BsyPrvCaus" 
flag and refers to the ARS table settings.

Configuration example

In this example, at any moment of the week calls starting by 089 are processed by the operator Mo-
bilcom, and by Teldafax if Mobilcom is busy. If Teldafax is also busy, these calls will be processed by 
the preselected operator Telekom.

All other external calls (calls not starting with 089) are processed by Telekom.

 

"Dialing plan" configuration:

- "Secondary trunk groups seizure" function: Start, End = 0; Base = ARS; NMT = Absorbed. All calls
starting with 0 are ARS calls and the subsequent figures are analyzed by the ARS tables.

OPERATOR 1
(MOBILCOM for

example)

OPERATOR 2
(TELDAFAX for

example)

PRESELECTED
OPERATOR

(TELEKOM for exemple)

Trunk group 1 Trunk group 2
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"ARS Table" configuration:

"Trunk group list" configuration:

"Time Ranges" configuration:

"Day Groups" configuration:

- All the days of the week are assigned to day group 1.

"Providers / Destinations" configuration:

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 089 089 1 Het Operator

Pub 2 Telekom

TrG
p list

Index TrGp. 
No.

Char. Provider / Destina-
tion

Access di-
gits

Authoriza-
tion code

Tone/Pause

1 1

1

1

0

0

0

Mobilcom

Teldafax

None

01019

01030

None

None

None

None

None

None

2 1 0 None None None

Start End Day group Provider / 
Destination 1

Provider / 
Destination 2

Provider / 
Destination 3

Provider / 
Destination 4

00:00 00:00 1

2

3

Teldafax

None

None

Mobilcom

None

None

None

None

None

None

None

None

Providers / Destinations

Mobilcom

Teldafax
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Configuration

- Define the activation causes for the mechanism (5 causes maximum, FF indicating the end of the
list of causes)

- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Misc. Labels
-> "BsyPrvCaus"

- by MMC-station: Global -> Rd/Wr -> Address -> "BsyPrvCaus" -> Back -> Memory
Ed. 0418/18 Réf. 3EH 21000 BSAA
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EXAMPLES USING ARS
ELEMENTARY CONFIGURATIONS

BREAK-IN

A public user calls a user of a remote system  by break-in in system .

 

Public numbering plan of 

ARS table of 

Start End Base Function NMT Private

7900 7949 100 Set - Yes

7950 7999 - Secondary trunk group Keep No

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 03886979 - 41 1

B A

PUBLIC
NETWORK

4185
DDI : 7985
Range : 7950 - 7999

A

B Node 41

0388677700 dial
0388697985

QSIG_BC

DDI : 7901
Range : 7900 - 7949

Public installation
number : 388697900

A

A
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Private numbering plan of 

BREAK-OUT

Set 500 in system  (node 50) calls user 0388677700 on the public network. The ARS mechanisms 
force the call to use the private network.

 

Main numbering plan of 

ARS table of 

Start End Base Function NMT Private

4150 4199 100 Set - Yes

Start End Base Function NMT Private

0 0 - Main trunk group Absorb No

51 51 - Secondary trunk group Keep Yes

300 300 2 Secondary trunk group Absorb No

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub - - - 0

Priv 51 - 51 2

Pub 038867 -

-

0038867

038867

2

0

B

A

PUBLIC
NETWORK

50

0388677700

00388677700

QSIG_BC
B

A
Node 51

Trunk group 0

Trunk group 2

Station 500 dials 00388677700

A

A
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CONVERSION BETWEEN PUBLIC AND PRIVATE NUMBERING PLANS

Case 1: Peer to peer - ISVPN and overflow

This configuration corresponds to a call in an ISVPN heterogeneous network or an overflow on a public 
link when the private QSIG-BC link is busy.

 

ARS table of  for overflow mechanism

 

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 32 -

00 - 99

32

03886777

1

0

Heterogen.

Heterogen.

PUBLIC
NETWORK

0 0

1 1

0384273045

QSIG_BC
BA

DDI : 0388697901
3101

DDI : 0388677710
3210

A

PUBLIC
NETWORK

0

0

1
1

0384273045

A B

DDI : 0388697901
3101 DDI : 0388677710

3210
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ARS table of  for ISVPN

This table entry, used for calls from  to , also makes it possible to guarantee the conversion of 
the caller's public number into a private one in the event of a call in the other direction.

Case 2: Peer to peer - private network forcing

ARS table of 

In this configuration, if user 3210 calls a user of  with his public number (0388697901), the call is 
forced to use the private link with the private number 3101.

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Priv 32 00 - 99 03886777 0 Heterogen.

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 03886979 -

00 - 99

31

03886979

1

0

Heterogen.

Heterogen.

A

A B

B

A
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Case 3: master/satellite

In this configuration, the DDI numbers in  are managed remotely by ; a public numbering plan 

in  is therefore not necessary if:

-  can convert a private number into a public number (for outgoing call by break-out).

-  can convert the private number of the connected set into a public number (incoming call by
break-in).

-  can convert the public DDI number of a user of into a private number (incoming DDI call by

break-in destined for a  user).

 

Main numbering plan of 

Public numbering plan of 

ARS table of 

Start End Base Function NMT Private

0 0 - Main trunk group Absorb No

Start End Base Function NMT Private

7700 7710 100 Set - -

7711 7720 - Secondary trunk group Keep No

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub 03886777 11 - 20 31 1 Heterogen.

A B

A

B

B

B A

A

PUBLIC
NETWORK

0

1

1

0384273045

A B

QSIG_BC

DDI : 0388677711
3111

public NDI : 0388677700

DDI : 0388677710
3210

B

B

B
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Nota : Private -> public conversion requires the full public number (ABPQMCDU) to be entered in 
the ARS (and not only the MCDU).

In , these settings make the following services available:

- Break-in: a public network subscriber dials 0388677711.  receives the call and analyzes 7711
in the DDI numbering plan. The full number is handled by the ARS table and converted into the

private number 3111.  can now make a private call on the QSIG link and join with the incoming
public call.

- Private network forcing: for example, user 3210 dials the number 00388677711; the ARS converts
this public number into the private number 3111.

- Break-out: user 3111 calls 0384273045; he dials 00384273045. The caller's number sent on the

QSIG link is the private number 3111. In , 3111 is converted by the ARS into the public number
0388677711.

B

B

B

B
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TYPICAL NETWORK CONFIGURATION

 

OVERFLOW

Purpose:

The call from a user of  from a set in  must, in order of priority, use the QSIG link, then the analog 
ATL and finally the T0 public accesses. 

Settings:

PABX 

- Main numbering plan

- ARS table

Start End Base Function NMT Private

120 199 120 Set - No

835 839 ARS Secondary trunk group Keep Yes (1)

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Private 8 35-39 8

01478588

1

2

Heterogen.

Heterogen.

 (2)

 (4)

A

ATL

QSIG

PARIS

STRASBOURG

RNIS

B

Subscriber in
Paris
0155665555

Trunk group
300

T0 : 0147858835-39

TrGrp 301

TrGrp 302

TrGrp 301

TrGrp 302

Stations 835 to 899

T0 : 0388408120-24

Trunk group
 300

Stations 120 to199

A B

B
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- TrGp list

- Private numbering plan

PABX 

- Main numbering plan

- Public numbering plan

- Private numbering plan

Call description:

- (1): a user of  dials 836, number recognized as ARS call in the main numbering plan with con-
servation of the private prefix declared (836).

- (2): in the ARS table, the system consults the line corresponding to the private prefix 8 and compa-
res the rest of the numbers with the range 35-39 (36 in this case).

- (3): the system guides the dialing to trunk group list 1 then tries to establish a communication with
trunk group 302 (QSIG); if this trunk group is busy, the system tries to establish the communication
with trunk group 301 (ATL).

- (4): if the ATL trunk group is busy, the system returns to consult the ARS table; it replaces 8 with
01478588 followed by 36.

- (5): the dialing is guided to trunk group 2; the communication is established with the public T0 tru-
nk group (if this trunk group is not available, the call is released).

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

1 4

3

302

301

- - - - (3)

2 2 300 - - - - (5)

Start End Base Function NMT Private

120 199 120 Set - No

Start End Base Function NMT Private

835 899 835 Set - No

Start End Base Function NMT Private

8835 8899 835 Set - No

Start End Base Function NMT Private

835 839 835 Set - No

A

B

Ed. 048/16 Réf. 3EH 21000 BSAA



File
3

EXAMPLES USING ARSCALL SERVER : PRIVATE NETWORKS

 

Remarks:

- the 2 lines of the private numbering plans of  and  make it possible to display the internal
number on the QSIG link. 

NETWORK FORCING (forced dialing)

Purpose:

To force dialing on the QSIG link, then on the ATL and then on the public T0 accesses when a  user 
dials the public number 00147858835-39.

Settings:

Add the following elements to the PABX settings :

- Main numbering plan

- ARS table

Call description:

- (6): a user of  dials 00147858835-39; 0 is interpreted by the main numbering plan as a public
ARS call with absorption of the 1st 0 and sends the number to the ARS table.

- (7): 0147858835-39 is recognized in the ARS table; it is replaced by 835-39 and sent on trunk
group list 1 (QSIG then ATL). If all of these trunk groups are busy, the system returns to consult the
ARS table and 0147858835-39 is sent on trunk group list 2 (public T0 access - the same goes for
overflow).

- (8): if the user dials a number other than 0147858835-39, the system sends this number to the
ARS table; the call is routed on the public T0 accesses.

Start End Base Function NMT Private

0 0 ARS Main trunk group Absorb No  (6)

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Public 01478588 35-39 8

01478588

1

2

Heterogen.

Heterogen.

(7)

Public Empty Empty Empty 2 Heterogen. (8)

A B

B

B

B
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BREAK-OUT (proximity break-out)

Purpose:

To use the T0 access of  if a user of  dials a number beginning with 01.

Settings:

Add the following to the ARS table of PABX :

Add the following elements to the settings for PABX :

- Private numbering plan

- ARS table

- Trunk Group list

Call description:

- (9): if a user of  dials 001XXXXXX; the first 0 is absorbed by the main numbering plan (see pre-
vious example); the system sends 01XXXXXX back to the ARS table where it is replaced with
001XXXXXX and sent on trunk group list 1.

- (11): in , the call is received in the ATL numbering plan where it is considered as a public ARS
call.

- (12): in the ARS table of , 001XXXXXX is truncated by cutting the 1st 0.

- (13): the number is sent on trunk group list 1 (public T0 accesses of ).

BREAK-IN

Purpose:

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Public 01 - 001 1 Heterogen. (9)

Start End Base Function NMT Private

0 0 ARS Secondary trunk group Keep No  (11)

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Public 0 - - 1 Heterogen. (12)

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

1 2 300 - - - - (13)

A B

B

A

B

A

A

A

Ed. 0410/16 Réf. 3EH 21000 BSAA



File
3

EXAMPLES USING ARSCALL SERVER : PRIVATE NETWORKS

 

To make a call from 0388408124 on PABX  arrive at set 836 on PABX  (after someone has mo-
ved to new office, for example).

Settings:

Modification of the public numbering plan of PABX :

In the ARS table of PABX , add:

Call description:

- (14): the range of DDI numbers is modified in order to retrieve a number.
- (15): an incoming call for user 0388408124 is analyzed by the public numbering plan as an ARS

call with conservation of the prefix.
- (16): the number arriving in the ARS table is changed to 836 then sent on trunk group list 1.

Nota : Identification of a public call as a private call.

In the event of overflow, during a call on the QSIG link from  to , the display on a set belonging 

to  states the internal number of the user of  (for example: 121 calls 835; the display on set 835 
states "121 calling"). 

On the other hand, if the call is sent via the T0 accesses (if QSIG and ATL busy), the display states the 
public number (in the example, the display on set 835 states "0388408121 calling").

Start End Base Function NMT Private

8120 8123 120 Set - No  (14)

8124 8124 ARS Secondary trunk group Keep No  (15)

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Public 0388408124 - 836 1 Heterogen. (16)

B A

B

B

B A

A B
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To convert public numbers into private numbers, add the following line into the ARS table of .

In this case, an incoming call 0388408120-23 is converted into the internal (private) number 120-23.

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Private 1 20-23 03884081 1 Heterogen.  

A
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TRANSGROUPE VPN 

 

The Alcatel OmniPCX Office  system, as a member of Transgroupe (PIN = 667000) must be con-
figured to:

- make direct private calls without prefix (internal destination).
- make public calls after dialing an outgoing prefix (0) with automatic insertion of the outgoing prefix

on Transgroupe (0).

Main numbering plan of 

ARS table of 

Start End Base Function NMT Private

0 0 - Main trunk group Absorb No

68 68 - Secondary trunk group Keep Yes

69 69 - Secondary trunk group Keep Yes

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub - 0 1 Heterogen.

Priv 68 - 68 2 Heterogen.

Priv 69 - 69 2 Heterogen.

688123

A

667712

B

PUBLIC NETWORK

TRANSGROUPE

PABX

NDI : 88678000
TRANSGROUPE : PIN = 688000

Trunk groups 1 and 2

Public subscriber
0388697985

Public subscriber known
by the Alcatel OmniPCX Office
system by the VPN number : 691234

NDI : 388677700
TRANSGROUPE : PIN = 667000

B

B

B
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- Trunk group list 1

- Trunk group list 2

The table below summarizes the different types of possible outgoing calls with the values entered in 

the "called party number" and "caller number" fields (PABX ).

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

1 1 - - - - -

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

2 1 - T - - -

Outgoing calls Called party number Caller number

Call to public network Number dialed: 
0388697985

Num. plan: public

Public NDI + MCDU DDI: 
388677700 + 7712

Num. plan: public

Internal call in Transgroupe Number dialed: 688123

Num. plan: private

PIN prefix + MCDU DDI: 
667000 + 7712

Num. plan: private

Call to public network by Transgroupe Number dialed: 691234

Num. plan: private

PIN prefix + MCDU DDI: 
667000 + 7712

Num. plan: private

B
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MULTI-OPERATOR CONFIGURATION

 

When a number beginning with 1XXXXXXX (belonging to network 1) is dialed from network 0, the ac-
cess prefix 111 and the client code 3333 are sent from network 0 to network 1.

Main numbering plan

ARS table

- Trunk group list 1

- Trunk group list 2

Start End Base Function NMT Private

0 0 - Main trunk group (ARS) Absorb No

Network Prefix Ranges Substitute TrGp list Called/HH User com.

Pub - 1 Heterogen.

Pub 0 - 0 2 Heterogen.

Pub 1 - 1 3 Heterogen.

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

1 1 - - - - -

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

2 1 - - - - -

2 - - 000 01 -

NETWORK 0
0XXXXXXX

NETWORK 1
1XXXXXXX

Trunk group 1 

Code for accessing network 1 : 111
Business code : 3333

Code for accessing network 0 : 000
Business code : 4444

Trunk group 2 
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- Trunk group list 3

Authorization code table

When the user dials 0 0XXXXXXX, the ARS table forces the use of network 0 and sends the number 
0XXXXXXX; the overflow mechanism allows the use of network 1 and sends the number 000 4444 
0XXXXXXXX. 

When the user dials 0 1XXXXXXX, the ARS table uses public trunk group 2 and sends the number 
1XXXXXXX; the overflow mechanism allows the use of public trunk group 1 and sends the number 111 
3333 1XXXXXXXX. 
Any number beginning with 0X, where X is other than 0 or 1, uses public trunk group 1 (the default).

TrGp list Index TrGp. No. Char. Access di-
gits

Authoriza-
tion code

Tone/Pau-
se

3 2 - - - - -

1 - - 111 02 -

Index Authorization code

01 4444

02 3333
Ed. 0416/16 Réf. 3EH 21000 BSAA
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METERING - ISVPN+
ISVPN+ is used for a network of Alcatel OmniPCX Office systems linked together by digital leased lines 
with the QSIG-BC protocol.

The principal use of ISVPN+ is for centralized metering.

For all incoming and outgoing calls made within the network, the master system (the one connected 
to the public network) gathers the required information and sends it to a centralized metering appli-
cation. The following information is transmitted to the master system:

- outgoing call: all the data presented in the following paragraph is managed at the caller's system
level then transmitted to the master system. The flags characterizing the call are accumulated throu-
gh the different systems during transmission to the master.

- incoming call: the number "transmitted" to the called party and the various flags are generated by
the master system. During the setup of a communication with the called party, the flags characte-
rizing the call are accumulated through the different systems. The number of the charged caller,
the metering node number and the accumulated flags are forwarded to the master system with the
connection message.

PUBLIC
NETWORK

QSIG
QSIG

QSIG

MASTER CENTRALIZED
METERING

APPLICATION
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DATA TRANSMITTED

This paragraph describes the information which is transmitted to the master system by the other sys-
tems in the network; this data is conveyed by the QSIG protocol UUS.

Global data: Node number

This datum (unique value 0 to 127; by default: 255) identifies the system in the network.

Data relative to each communication

- "transmitted" number: number resulting from the NMT conversion of the number dialed after ana-
lysis in the main numbering plan (or NMT conversion of the number received after analysis in the
incoming public call numbering plan); it is thus possible to compare the number sent (to the ARS
table) by the system with the original number dialed.

- charged user: This datum depends on the type of call:
• outgoing call or break-out: caller
• incoming call or break-in: user having answered the call; this user may be different to the called

user (forwarding, call pick-up, etc.)
- transfer: user who is the destination of the transfer

- flags characterizing an ARS call: 

- complementary services: This data indicates the services activated in order to carry out the current
call:
• substitution (DISA transit)
• use of the ARS table
• homogenous ISVPN call
- VPN call (Transgroupe for example)

- supplementary network facility: indirect access to an operator
- on-line metering request in the event of break-out

- by MMC-PM5 (Expert View), select: External Lines -> Protocols ->  ISVPN Protocol ->
Node Number. This information is only used by the metering application (not used in a tele-
phone context). The node number indicated is the one to which the charged user is connected.

- by MMC-PM5 (Expert View), select: Numbering -> Automatic Routing Selection -> ARS
Table -> Option: Metering: 
• forcing onto private network (private): this flag indicates whether an outgoing call has

been rerouted onto leased lines by the ARS.
- overflow: this flag indicates whether the trunk group used for the current call has been ob-

tained after overflow by the ARS.
Ed. 042/4 Réf. 3EH 21000 BSAA



File
4

METERING - ISVPN+CALL SERVER : PRIVATE NETWORKS

 

EXAMPLES

Local call in the network

A (5212) calls B (4103) by dialing 4103.

 

Information transmitted:

- Charged user: 5212
- Number of the metering node: 20
- Transmitted number: 4103

Break-in

A public network user calls A (4103) by dialing 0388408003. A is forwarded on B (4142).

 

Information transmitted:

- Charged user: 4142
- Number of the metering node: 10
- Transmitted number: 4103

PUBLIC
NETWORK

4103 5212

B

A

10 20

41
52

MASTER

CENTRALIZED METE
RING

APPLICATION

PUBLIC
NETWORK

4103

4142

A
B

10 20

41
52

0388408003

4103

MASTER

CENTRALIZED METE
RING APPLICATION
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Break-out

A (4103) calls C (8012) by dialing 8012.

 

Information transmitted:

- Charged user: 4103
- Number of the metering node: 10
- Transmitted number: 8012

PUBLIC
NETWORK

4103

A

10 20

41
52

0388677712

8012

30

8012

C

80

MASTER

CENTRALIZED
METERING

APPLICATION
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CLOCK SYNCHRONIZATION
SYNCHRONIZATION IN MODULES

The digital accesses (T0, T2, etc.) in an add-on module can under no circumstances serve as synchro-
nizing accesses for the system (it is impossible to feed the clock back from an add-on module to the 
basic module CPU over an HSL link).

If the system includes digital accesses, then there are several eventualities:

- Case 1: No accesses in the base; they are all in the extensions:
• The accesses will try to supply the clock to the system, and the system will refuse.
- System message 51 - Clock Problem; the system operates on the local clock.

- Case 2: There is a T2 in the add-on module and a non-permanent level 1 T0 in the basic module:
• If the T0 is in communication, its level 1 is therefore established and it is the T0 which provides

the clock for the system.
- If the T0 is not in communication, the T2 access will attempt to supply the clock to the system

when it synchronizes with the network public (as in case 1). The clock supplied by T2 will be
refused; a message 51 is generated; the system operates on the local clock.

- Case 3: There is a permanent T0 or a T2 in the basic module. Regardless of the accesses present
in the add-on modules, the clock is supplied by one of the accesses in the basic module.

Conclusion: You need to equip at least one digital access in the basic module and, if possible, a per-
manent level 1 T2 with a priority higher than that of T0.
Ed. 04 1/4Réf. 3EH 21000 BSAA



CLOCK SYNCHRONIZATION CALL SERVER : PRIVATE NETWORKS

 

SYNCHRONIZATION IN NETWORKS

To avoid loopbacks in the synchronization paths, you need to define a hierarchy of network nodes.

DEFINITIONS

- Pilot node (= level 1): node with the most interfaces to the public network; preferably a T2.
- Level 2: node with at least one synchronizing link coming from a pilot node.
- Level 3: other nodes.

PRIORITY NUMBERS

To be able to modify and enlarge a network, you should construct a tree diagram for the synchroni-
zation of each node in the network. 

A priority number must be assigned (P) to each node.

For the clock priority settings for the ISDN/Q_SIG boards to be taken into account, the system requires 
a warm reset.

- by MMC-PM5 (Expert View), select: System Miscellaneous -> Hardware -> Lineboard
Details (part 2) -> Clock Priority -> enter the number (0 to 255).

YES NO

NOYES

Pilot
node?

Public
access

?

If public T2 :         0
If permanent T0 :       1
If non permanent T0 :    9
If link from level 2 :       20
If link from level 3 :       30
Other links :          255

If public T2 :         0
If permanent T0 :       9
If non permanent T0 :    19
If link from level 1 :       10
If link from level 2 :      20
If link from level 3 :      30
Other links :          255

If link from level 1 :      10
If link from level 2 :      20
If link from level 3 :      30
Other links :          255

France Type : T0 with non permanent activation of level 1
Germany Type : T0 with non permanent activation of level 1
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Principles which must be respected:

- to avoid 2 nodes from the same level synchronizing each other, assign priority 255 to the links
between the 2 nodes on the system (synchronizing) side and a smaller priority value on the slave
(synchronized) side.

- a node can only be enslaved on another node having an identical or lower hierarchic level.
- for any given node, assign a single priority number to links of the same type (T2, T0, leased lines).
- for any given node, a T2 link must always be assigned a smaller priority number than a T0 link.

EXAMPLES

Node 1
(pilot)

Node 2 Node 3

Node 4

Permanent T0

Non permanent T0

T2

LEVEL 
1

LEVEL 
2

LEVEL 
3

P = 0

P = 1

P = 19

P = 255
P = 255

P = 255 P = 255

P = 255

P = 10

P = 20

P = 10

P = 20 P = 21

Node 1
(pilot)

Node 2 Node 3

Node 4

P = 255

P = 10

Network with 4 nodes and 3 
hierarchic levels

Addition of a link between nodes 1 
and 4 (no modifications in the 

existing configuration)
Ed. 04 3/4Réf. 3EH 21000 BSAA



CLOCK SYNCHRONIZATION CALL SERVER : PRIVATE NETWORKS

 

RESTRICTIONS

The 2 configurations below present situations which lead to operational restrictions. 

 

Synchronization of the QSIG on PABX B has priority over the synchronization of the T0 on PABX B: 

- a subscriber belonging to A is in an external communication (simultaneously or not with subscribers
on B) -> no problem.

- no external communication in A: A operates on the local clock. 
A subscriber belonging to B makes an external call: B remains synchronized on A and is therefore 
not synchronous on the public network -> no data transmission from B to the network.

Synchronization of the T0 of PABX B has priority over the synchronization of the QSIG: 

- a subscriber belonging to B is in an external communication (simultaneously or not with the subs-
cribers on A) -> no problem.

- a subscriber belonging to B is in an external communication: A operates on the local clock -> no
data transmission between B and A via the QSIG link. 

- no external communication in A or B: A and B operate on their local clocks -> no data transmission
between B and A via the QSIG link.

 

B is synchronized via the QSIG link of PABX A: 

- a subscriber on A is in an external communication -> no problem.
- no external communication in A: A operates on the local clock; this clock is supplied to B -> DECT

problems in B.
- if B has a non-permanent T0 link, the DECT problems will be compounded by the problems from

the previous case.

PUBLIC NETWORK

PABX A PABX BQSIG link

Non permanent T0
Non permanent T0

master slave

PUBLIC NETWORK

PABX A 
master

PABX B slave     
      with DECT

QSIG link

Non permanent T0
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OVERVIEW
ENVIRONMENT

PRINTING

BOOTH

ROOM SERVICE

ROOM
Reflexes Dect,

Z stations

RECEPTION
Advanced Reflexes station

Features available with the HOTEL key :
-   check-in (name, ddi n°, deposit, wake-up, ...)
-   room consultation, modification 
-   pre check-out and check-out (bill, ...)
-   room status (free, occupied, cleaned, ...) 

Visualization on the RSL key :
-   room status (free or occupied)
-   station status (free or occupied)
-   room status (clean or not)
-   problem with room status or wake-up alarm 

Metering :
-   metering reminder ticket or
-   assignment of charges to a room

Using the features :
-   metering total recall
-   trunk allot

Hotel printing :
-   room status ticket
-   client information ticket
-   client global bill ticket

System printing :
-   metering ticket 
-   wake-up ticket
-   metering total recall (booth)

Client :
-   DDI N°, wake-up,  message, ...
-   room service call

Room status :
-   room free or occupied
-   room cleaned or not
-   problem identification

-   service on an RSD key 
-   display of the client’s name, language 
and room n°

VOICE
MAIL

-   allocation of a voice mail box to each room
-   automatic reset of the voice mail box contents at check-in
-   automatic allocation of the client’s language and password 
to the mailbox
Ed. 04 1/6Réf. 3EH 21000 BSAA



OVERVIEW CALL SERVER : HOTEL

 

Sets in the installation

The sets of the installation are divided up according to their types and roles:

- Reception and Operator: Advanced Reflexes (or 4034) obligatory, fitted with add-on modules
- Administration and Rooms: Reflexes, DECT, Z 
- Room Service: Reflexes
- Booths: Reflexes, Z
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 HOTEL INSTALLATION 

When the system is brought into service, the PM5 Easy View session allows you to specify that the ins-
tallation is a hotel installation. By doing this, the system automatically creates predefined profiles (Re-
ception set, phone booth, room sets, administration sets, etc) described below:

- the first set is the Operator Station; this 4034/Advanced set in PABX mode belongs to all active
operator groups as well as the default operator group.
This set has the profile of a Reception set: it has a direct call key for the booth station and, on the 
add-on-modules, a direct call key for each room set in the installation (up to 80 sets).

- the Reflexes sets are administration sets.
- the Z sets (except fax machines and booths) are room sets.
- dynamic routing level 1 for administration sets: any unanswered call is routed to the voice mail unit

after 12 seconds.
- dynamic routing level 2 for administration sets: any unanswered external call is routed to the ope-

rator group after 24 seconds; for room sets, this mechanism only applies after customer check-in.
- OS calls overflow to general level (default operator group) after 24 seconds; for room sets, this

mechanism only applies after customer check-in.
- the first Z interface is configured to connect a fax machine (VOICE and FAX2/3 services; no dyna-

mic routing; protection against camp-on, intrusion and camp-on tone).
- the second Z interface is configured to connect a booth station (automatic call setup on going off-

hook, delayed by 3 seconds, meter total recall at the operator station).
- the internal numbering plan is programmed with the prefixes for "room status," "room service" and

"wake-up programming".
- the public numbering plan (if the public numbering system is "open") contains 2 ranges of DDI

numbers: one for the OS, the other for the administration sets, the booth and the Z interface of the
fax machine; the DDI numbers correspond to the internal call numbers of the sets.
The remaining ranges can be used for the room sets.

- the table of features in conversation is programmed with the default codes for the features "DND
override", "trunk allot" and "meter total recall".

- all the programmable keys on Easy, Premium and Advanced sets are modifiable by the user (or by
the installer).

Using the pre-defined profiles of the PM5 Easy View session means you can avoid some of the system 
programming described in the "Configuration" section.

See the "Starting Up" section of the installation manual for a description of the PM5 Easy View session; 
this session also enables you to configure some of the key Hotel application parameters (the DDI num-
bers, for example) right from the initialization stage. 
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FEATURES 

The main services proposed are listed below.

Administrative aspects:

Room Status

Room Status (free, occupied, cleaned, problem with room).

Check-in

Name, language, allocation of a DDI n°, opening of the line, barring level (external outgoing calls), 
prepayment (metering credit), wake-up call, printout of an information ticket, etc.

Consultation of an occupied room

Guest prepayment status (metering credit), consultation of the guest's mail box (text mail, voice mail, 
Reception call-back request), printout of an information ticket, etc.

Pre-checkout and Check-out

Closing of the line, printout of a bill, room status, resetting of the parameters, etc.

The pre-checkout enables a guest to settle the telephone bill the day before an early morning depar-
ture, for example (external outgoing calls no longer possible), whilst at the same time keeping the fea-
tures programmed on the phone (wake-up call, message, DDI N°, DND, etc).

METERING

Specific parameter settings for calculating the cost of communications on guest sets and booths.

Standard parameter settings for calculating the cost of communications on administration sets.
Surcharge for guest communications set up with the help of Reception.
Printout of a metering ticket with VAT.

New voice mail integrating the hotel features

Allocation of a voice mail box to each room.

Automatic reset of the contents of a voice mail box at check-in.
Automatic allocation of the guest language and password to the voice mail box.
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Telephone aspects:

Programming of the wake-up call either by the guest or by Reception

Password

Service enabling Reception to assign guests a password.

The password can be used by guests to lock their set (prohibit external calls), to remotely access their 
voice mail box and to establish communications with protected account codes.

Room Service

Certain services are accessible by a simple call: bar, dry cleaning, breakfast, for example.

Phone booth

Use of features: Trunk Allot (with meter recall) or Metering Total Recall.

During a metering total recall: printout of a metering ticket or allocation of charges to a set in the ins-
tallation.

DND OVERRIDE

Service enabling Reception to override DND.

Account code with substitution

Service enabling a subscriber to set up a communication on one set with the account code allocated 
to another set.

The user establishes communication in the following way: account code prefix +  account code + 
n° of the substitution set (optional) + password (optional) + prefix for accessing the trunk group 
+ called party's n°
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CONFIGURATION
PARAMETERS TO BE CONFIGURED 

This chapter presents the main parameters that need to be configured for the hotel application.

Installation numbers

- Enter the installation number, the intercity code and the international access prefix

Numbering plans

- Internal numbering plan, enter the:

• station numbers: administration, rooms, booths, fax, etc.

- prefixes: wake-up call, main and secondary trunk group, Room status (see System Parame-
ters), Reception call, etc.

- Public numbering plan, enter the:

• station DDI numbers: administration, Reception, fax, etc.

- room set DDI numbers (see the VisFr and VisAl features in System Parameters)

- Feature access codes, enter the suffixes for: enquiry call, shuttle call, DND override (see System
Parameters), conference, etc.

Set categories

- Declare the sets: "Administration", "Guest" or "Phonebooth" (see the Class feature in System Para-
meters)

Reception set

- Create a "Hotel" key (see the Hotel feature in System Parameters)

- Create the "RSL" keys for the sets: rooms, booths, etc. (see the RSL feature in System Parameters)

 Room service station

- Create the numbers for the service in the internal numbering plan

- Create a "RSD" key for each service on the Room service station (see the RSD feature in System
Parameters)
Ed. 04 1/18Réf. 3EH 21000 BSAA



CONFIGURATION CALL SERVER : HOTEL

 

Phone booth

- Configure the phone booth by using the features:

• "Automatic call setup (on reception) on going off-hook" (or bar the line in order to exclude out-
side calls. To call out, the user dials the call number for reception).

- "Metering total recall" in automatic mode (or using the manual mode from the Reception set)

- Configure the Reception set by using the features:

• "Trunk allot" (use, for example, barring table n°2 which only authorizes local calls)
• "Trunk allot with metering total recall" (use, for example, table n°4 which authorizes national

and international calls)

- "Metering total recall" in manual mode

- Authorize the feature rights: "trunk allot" and "metering total recall"

- Position the flag "metering total recall if there is no charge" (see the Metering total recall feature
in System Parameters)

Analog room sets

- Allocate a "voice mail" virtual key to the analog sets which will light the LED when there is a call-
back request from Reception or from the voice mail unit

Barring tables

- Check the link category on the sets installed

- Check the link category on the trunk group and network lines

 Hotel Parameters 

- Configure the parameters: "Wake-up", "DDI", "Language", "Barring", "DND", "Exit time" and "Check-
in" (see Customizing the configuration screens)

- Configure the Room status parameters (see Configuring room status)

Guest metering

- Configure the parameters: "Deposit", "Currency" and "VAT" (see Customizing the configuration
screens)

- Configure the parameters: "Room status" print out, Thank-you messages, VAT, Cost of communi-
cations, Surcharge and Cut-off (see the Metering features in System Parameters)
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SYSTEM PARAMETERS 

The following flow chart shows the required system parameters; they are only accessible in the installer 
session.

INSTAL SUBSCR

COUNT Extens    Call      Reset→ →

NUMPLN

IntNum        Funct      RoomS→ →
Code        Funct         DND override→ →
PubNum      Funct      VisFr→ →

METER
Param1     VAT→
Visit         Cost       Cost 1, Cost 2, Cost 3, Ovload→ →
                UnitTh      Unit1T, Unit2T, Beep→ →

Keys     Call          DNDovr→ →→
            Option     Hotel→ →
           Resou      RSL→ →
                             RSD→
Class

GLOBAL
Accoun      Param1      UserId→ →

Rd/Wr        Memory→
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DND OVERRIDE

This service enables an authorized subscriber (Reception) to override a set's DND (Do Not Disturb) sta-
tus. It is activated either with a function key or with a feature access code.

- To assign a feature access code to the service:

- To assign the service to a key:

- Authorize the service on the calling party set:

- Protect the called party against the service:

HOTEL KEY

This feature enables Reception to enter the hotel application in order to enter, consult and/or print 
guest data.

- To assign the feature to a key:

- by MMC-Station: NumPln -> Code -> Funct -> DND override
- by MMC-PM5 (Expert View): Numbering  -> FAC Numbering Plan -> DND Override

- by MMC-Station: Subscr -> Keys -> Call -> DNDovr
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Keys

-> Function key -> DND Override

- by MMC-Station: Subscr -> SubPro -> Featur -> High
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Fea-

tures -> Part2 -> check DND override allowed

- by MMC-Station: Subscr -> SubPro -> Featur -> High or Middle
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Fea-

tures -> Part2 -> check Protection against DND override

- by MMC-Station: Subscr -> Keys -> Option -> Hotel
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Keys

-> Function key -> Hotel Menu
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RSL KEY

The Reception set must be equipped with add-on modules. The modules are programmed with RSL 
resource keys (essentially room N°s) which allow Reception:

- to call a set in the installation directly
- to receive a call on the resource from a set in the installation 
- to see the busy status of a set in the installation
- to find out the occupation status of a room (free or occupied)
- to view a problem with a room wake-up call 
- to view the status of a set's ringer (internal or external call)
- to find out the status of a room (cleaned or uncleaned)
- to view a problem with the room

Notas :

The new features are accessible if the set has a Hotel key. They are detailed in "Reception set features".
- To assign RSL keys to the Reception set:

RSD KEY

To call Room Service, the user dials a number corresponding to a service (the "breakfast" service for 
example). This number must be known by the system and must be assigned to the "Room Service" sta-
tion.

- To assign service numbers to the "Room Service" station:

The "Room Service" station is programmed with RSD resource keys which have the n°s of the services. 
It has a display showing the name, directory n° and language of the caller.

- by MMC-Station: Subscr -> Keys -> Modify -> Resou -> RSL -> enter a directory n° (that of
a room set, for example)

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Keys
-> Resource Key -> Local Call -> enter a directory n° (that of a room set, for example)

- by MMC-Station: NumPln -> IntNum -> Subsc feature-> n°of the service in Begin and End -
> directory n° of the "Room Service" station in Base

- by MMC-PM5 (Expert View): Numbering  -> Internal Numbering Plan -> Subscriber feature
-> n°of the service in Start and End -> directory n° of the "Room Service" station in Base
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- To assign RSD keys to the "Room Service" station:

CLASS

This feature assigns one of the following categories to each set in the installation: "Administration", 
"Guest" or "Phonebooth".

- To assign a role to the set:

Default value: Administration

CALL COUNTERS

This feature enables Reception to find out the number of charged calls made from a set in the instal-
lation and to reset the counter.

In the Hotel application, the call counter is automatically reset on check-in; the number of calls (char-
ged communications) is given as a reminder on the printout of the "Guest Global Bill Ticket" and on 
the "Client Information Ticket".

- To read and reset a set's call counters:

This feature also allows you to edit, on the screen, the call and cost counters for sets.

- To read the call and cost counters for all the sets:

- by MMC-Station: Subscr -> Keys -> Modify -> Resou -> RSD -> enter a service n° (the "break-
fast" service, for example)

- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Keys
-> Resource key -> DDI call  -> enter a service n° (the "breakfast" service, for example)

- by MMC-Station: Subscr -> Class -> assign Administration set, Guest set or Phone booth
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Ho-

tel -> assign Admin, Guest or Phonebooth

- by MMC-Station: Count -> Extens -> Call to read the counter and -> Reset to reset it
- by MMC-PM5 (Expert View): Subscribers/Basestations List -> Subscribers -> Details -> Me-

tering to read the counter and -> Reset to reset it

- by MMC-PM5 (Expert View): System Miscellaneous -> Metering  -> Metering Counters
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ACCOUNT CODES

Use of this service involves a new parameter, USER-ID, which makes it possible to carry out "substitu-
tion" (charging to the account code of a set other than the one being used). This parameter means 
modifying the BARRING field and specifying the PROTECTION field.

- To select whether or not to assign an identification request for substitution to the account code:

- To assign a barring category to the account code (see also the table below):

The table below shows, depending on the link category assigned to the account code, the system reac-
tions on the various link categories.

* Link Categories service operation: Normal or Restricted

Remarques :

- if the account code is with "Identification" then the n° of the substitution set is to be entered
- if the account code is with password, the password expected by the system is either that of the set

in use or that of the substitution set

The user establishes communication in the following way: account code prefix +  account code + 
n° of the substitution set (optional) + password (optional) + prefix for accessing the trunk group 
+ called party's n°

- by MMC-Station: Global -> Accoun -> Param1 -> UserId ->select NO no identification or
YES with identification

- by MMC-PM5 (Expert View): System Miscellaneous -> Traffic Sharing and Barring -> Ac-
count Code Table -> User-Id -> select none no identification or User with identification

- by MMC-Station:
 Global -> Accoun -> Param2 -> Barrin -> select None, a category between 1 and 16, SET
or GUEST

- by MMC-PM5 (Expert View): System Miscellaneous -> Traffic Sharing and Barring -> Ac-
count Code Table -> Bar.Lvl. > select none, a category between 1 and 16, set or guest

Traffic Sharing (LC3) Barring Matrix(LC2) Collective Speed 
Dial Rights (LC1)

Set LC3 of the set (*) LC2 of the set (*) LC1 of the set (*)

Guest LC3 of the guest (*) LC2 of the guest (*) LC1 of the guest (*)

Forced barring Cat. 
1..16

LC3 of the set (normal 
service)

Fixed category Cat. 
1..16

LC1 of the set (*)

None (no barring) LC3 of the set (normal 
service)

Call not barred LC1 of the set (*)

Link categories
of the system

Account code,
Possible barring level
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METER TOTAL RECALL

The meter total recall (MTR) mechanism can recall the service beneficiary even if there is no charge.

- Recall the service beneficiary in all cases:

Default value: "00" (no recall if no charge)

WAKE-UP CALL

In the case of a wake-up problem, the system alerts Reception by sending a message and a ringing 
tone to the set which is repeated approximately every 30 seconds.

- Inhibiting the ringing and visual alarm mechanism:

Default value: "01" (alarm activated)

Notas :

With the hotel application, it is always possible to visualize a guest wake-up problem on the RSL keys 
on the set at Reception (see "Hotel Features").

- by MMC-Station: Global -> Rd/Wr -> Addres ->enter 01 in MtrNoCharg -> Memory 
- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Other Labels

-> enter 01 in MtrNoCharg 

- by MMC-Station: Global -> Rd/Wr -> Addres ->enter 00 in WakUpPrbRg -> Memory
- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Other Labels

-> enter 00 in WakUpPrbRg 
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ROOM STATUS AFTER CHECK-OUT

After check-out the room is automatically switched to "uncleaned" status.

- Inhibiting the status changing mechanism:

Default value: "01" (switch to "uncleaned" status after check-out)

NUMBERING PLANS

Room Status

The "Room Status" feature in the internal numbering plan allows you to define the "Room Status" prefix 
for the installation.

- To create the "Room Status" prefix:

DND override

The "DND Override" feature in the "features in conversation" table serves to define the suffix for acces-
sing the "DND Override" service.

- To create the "DND Override" service:

VisFr (DDI Deallocated)

The "DDI Deallocated" feature of the DDI numbering plan groups together all the DDI numbers assi-
gned to the rooms in the hotel. The feature's base is 9. 9.

- To assign the DDI n°s to the Reception set:

Remarques :

- by MMC-Station: Global -> Rd/Wr -> Addres ->enter 00 in UnclChkOut -> Memory 
- by MMC-PM5 (Expert View): System Miscellaneous -> Memory Read/Write -> Other Labels

-> enter 00 in UnclChkOut 

- by MMC-Station: NumPln -> IntNum -> RoomS feature
- by MMC-PM5 (Expert View): Numbering -> Internal Numbering Plan -> Room Status fea-

ture

- by MMC-Station: NumPln -> Code -> Funct -> DND Override
- by MMC-PM5 (Expert View): Numbering -> FAC Numbering Plan -> DND Override

- by MMC-Station: NumPln -> PubNum -> VisFr feature -> enter all the numbers in Begin and
End, enter 9 in Base

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan -> Guest DDI deallo-
cated feature -> enter all the numbers in Start and End, enter 9 in Base
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- a DDI n° allocated to a room at check-in automatically switches from "DDI Deallocated" to "DDI
Allocated" 

- likewise, a DDI n° which is no longer assigned to a room at check- out automatically returns to its
initial function, "DDI Deallocated". This mechanism allows you to route all the DDI calls for free
rooms to the Reception set.

VisAl (DDI Allocated)

The "VisAl (DDI Allocated)" function in the DDI numbering plan adds a DDI n° to all the DDI n°s which 
are reserved for rooms and assign it directly to a room.

- To add a room DDI n°:

Notas :

As the previous note states, this DDI n° will automatically switch to "DDI Deallocated" on check-out. It 
will thus rejoin all the DDI n°s reserved for rooms.

- by MMC-Station: NumPln -> PubNum -> VisAl feature-> enter the DDI number in Begin and
End, enter the directory n° of the room in Base

- by MMC-PM5 (Expert View): Numbering -> Public Numbering Plan -> Guest DDI allocated
feature -> enter the DDI number in Start and End, enter the directory n° of the room in Base
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METERING

Room Status Tickets

This feature allows you to define whether a "Room Status Ticket" or "Statement" should be printed auto-
matically when a room changes status.

- To select whether or not to print out a "Room Status Ticket" or "Statement" automatically:

Default value: rst (no automatic printout)

A "Room Status Ticket" or "Statement" includes:

- the room n°
- the date and time of the status change
- the "Room status change" label
- a value (1 to 4 digits) representing the room status (free or occupied, problem n°)
- the name of the guest

Notas :

The Hotel application allows you to:
- program a precise time at which all rooms (or only those which are occupied) switch automatically

to the "uncleaned" status,
- automatic switching, after check-out, of a room to "uncleaned" status.

These two operations do not involve the transmission of a "Room Status Ticket" or "Statement".

Conclusion String

This feature allows you to enter a thank-you message of up to 40 characters printed at the bottom of 
the "Guest Global Bill Ticket" or the "Guest Information Ticket". 

- To enter the thank-you message:

Default value: THANKS FOR COMING

- by MMC-Station: Meter -> Ticket -> List -> select RST for automatic printout or rst for no prin-
tout

- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> select Print
Room Status Ticket... for automatic printout

- by MMC-Station: Meter -> Ticket -> Conclu
- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> Guest Ticket

Footnote
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VAT

This feature allows you to enter the VAT rate to calculate the cost of communications.

The total VAT as well as the VAT rate are printed on the "Guest Global Bill Ticket", the "Phone Booth 
Bill" and the "Guest Information Ticket".

Notas :

The Hotel application also allows you to program the VAT.
- To program the VAT rate:

Default value: depends on the country

Visit: cost of the guest communication without VAT

First, the "Visit" feature enables the system to calculate the cost of communications (without VAT) made 
from the "Guest" or "Booth" sets in the installation.

Three basic metering and two cost thresholds can be programmed.

- To enter the first, second and third basic metering values:

- To enter the first and second thresholds used for the 2nd and 3rd basic metering values:

With the "Visit" feature you can now assign a surcharge to communications set up by the operator and 
transferred to "Guest" and "Phonebooth" sets.

- To enter the surcharge:

Finally, the "Visit" feature allows you to cut off the active (metered) communication and prohibit other 
communications when a guest's overall communication cost reaches the prepayment total.

- To cut off the active communication:

- by MMC-Station: Meter -> Param1 -> VAT
- by MMC-PM5 (Expert View): Administration -> Hotel -> Metering -> Value Added Tax

- by MMC-Station: Meter -> Visit -> Cost -> assign a value (integers then decimals) to Cost1 ,
Cost2 and Cost3

- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> assign a value
(integers then decimals) to Charge Rate 1 , Charge Rate 2  and Charge Rate 3 

- by MMC-Station: Meter -> Visit -> UnitTh -> assign a value (in minutes) to Unit1T and Unit2T
- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> assign a value

(in minutes) to Threshold 1 and Threshold 2

- by MMC-Station: Meter -> Visit -> Cost -> assign a value (integers then decimals) to Ovload
- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> assign a value

(integers then decimals) to Additional Services
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Using the feature: 

The system converts the guest's prepayment total into meter pulses (metering credit). When the mete-
ring credit reaches the value programmed in "Beep ", the system transmits a sound signal (succession 
of beeps) to the guest, for each pulse received.

When the metering credit is exhausted, the communication is cut off.

Default value:

- COST1, COST2 and COST3 = 0
- THRESHOLD1 and THRESHOLD2 = 0
- OVERLOAD = 0
- BEEP THRESHOLD = 0 (no communication cut off)

PRINTING THE GUEST'S TICKET AUTOMATICALLY

The automatic print of the "Guest Information Ticket" after the guest has checked in or the "Guest Glo-
bal Bill Ticket" after check-out can be deleted.

- Inhibiting the automatic print mechanism:

Notas :

It is always possible to print the tickets manually with the hotel application.

- by MMC-Station: Meter -> Visit -> UnitTh -> assign a value (number of pulses) other than 0
to activate the mechanism in Beep

- by MMC-PM5 (Expert View): System Miscellaneous -> Hotel -> Metering -> select Cut if pre-
payment consumed to activate the mechanism, select a value (number of pulses) in Beep at
credit threshold

- by MMC-PM5 (Expert View): Admin -> Hotel -> Parameters -> deselect Print Check-In/
Check-Out Ticket
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CUSTOMIZING THE CONFIGURATION SCREENS

The application requires a customized configuration, dedicated to the environment in which it is situa-
ted, in order to present the check-in screens, the guest consultation screens and the check-out screens 
as well as to calculate the cost of communications and activate the default features.

The application is customized using the default screens, which must be configured. These screens are 
accessible from Reception sets with a "Hotel" key or through MMC-PM5 (Expert View).

Notas :

Only programming which is done via a terminal is presented in this document. In MMC-PM5 (Expert 
View), the relevant data are proposed when you select System Miscellaneous -> Hotel -> Parame-
ters or Metering.
-  To configure the default screens:

The display presents the following flowchart menu.

Wake-up time - WAKEUP

This feature allows you to choose whether or not to define a default time for a wake-up call.

Enter 06: 45 for example, or press  --: -- so as not to have a default wake-up call.
Validate.

Allocating a DDI number - DDI

This feature allows you to allocate a DDI n° by default.

Press  to select "DDI ALLOCATION BY DEFAULT" or "NO DDI BY DEFAULT". Validate.

- Reception set: Hotel key -> DEFVAL

HOTEL KEY DEFVAL WAKEUP

DDI

LANG

DEPOSI

BARRIN

MONEY

DND

EXTIME

VAT

CHECIN

Wake-up time

Allocating a DDI number

Default language

Metering credit

Room set barring

Local currency

Activate Do Not Disturb function

Quit the application

VAT rate

Check-in chain

CLEAR

CHOICE
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Default language - LANG

This feature allows you to select a language by default.

Press  to select one of the languages offered. Validate.
Note: the language is automatically assigned to the guest's voice mail box and set (if it has a display).

Metering credit - DEPOSI

This feature allows you to choose whether or not to activate the "prepayment request" (metering credit) 
menu and enter a total corresponding to a default prepayment.

Enter a total or press  to inhibit the menu. Validate.

Notas :

When the menu is activated, a line reserved for the prepayment total is printed on the "Guest Global 
Bill Ticket" and on the "Guest Information Ticket".

Room set barring - BARRIN

This feature allows you to define a default barring for room sets.

Press  to select "INTERNATIONAL", " NATIONAL", "LOCAL" or "NO EXTERNAL". Validate.

Notas :

By MMC-PM5, under System Miscellaneous -> Hotel -> Parameters, the default barring on room 
sets takes the values 1 for "INTERNAL", 2 for "CITY", 3 for "NATIONAL" or 4 for "INTERNATIONAL"

Local currency - MONEY

This feature allows you to enter the country's monetary unit.

Enter EUR for example. Validate.

Notas :

The monetary unit is printed on the "Phone Booth Bill", the "Guest Global Bill Ticket" and on the "Guest 
Information Ticket".

Activate Do Not Disturb function - DND

This feature allows you to activate or deactivate the Do Not Disturb feature by default.

Press  to select "ACTIVE" or "INACTIVE". Validate.

CHOICE

CLEAR

CHOICE

CHOICE
Ed. 04 15/18Réf. 3EH 21000 BSAA



CONFIGURATION CALL SERVER : HOTEL

 

Quit the application - EXTIME

This feature enables the Reception set to exit the Hotel application automatically if no action is carried 
out during the set time.

Enter 20 (minutes) for example. Validate.

VAT rate - VAT

This feature allows you to enter the country's VAT rate.

Enter 20.60 for example. Validate.

Notas :

The cost of communications with VAT, the total VAT, and the VAT rate are printed on the "Phone Booth 
Bill", the "Guest Global Bill Ticket" and the "Guest Information Ticket".

Check-in chain - CHECIN

This feature allows you to program the order in which six consultation screens – the ones most often 
used during check-in – appear (maximum of six from a choice of eight).

Position yourself on the field to be modified using  or  then press  to select "DEPOSIT", 
"NAME", "WAKEUP", "DND", "LANGUAGE", "DDI", "BARRING", "PASSWORD" or "__" (no screen). Vali-
date. 

Notas :

The consultation screens which are not selected remain accessible at the end of check-in.

NEXT PREV CHOICE
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CONFIGURING ROOM STATUS

Configuring room status allows you to define whether all the rooms, or only those which are occupied, 
switch manually or automatically (at a programmed time) to "UNCLEANED" status.

- To enter the Room Status menu:

The display below shows the possible functions.

The first line of the screen recalls the configuration of the Room Status which may be as follows: Only 
occupied rooms switch to "Uncleaned" status at 7:30

Rooms concerned- ROOMS

This feature allows you to define the rooms which will switch to "UNCLEANED" status.

Press  to select "ALL BUSY ROOMS" or "ALL ROOMS". Validate.

Conditions - NOW, TIME

This feature allows you to define whether the rooms concerned (those in the "ROOMS" menu) switch 
to "UNCLEANED" status automatically or manually.

- Manual switch, press  
- Automatic switch, press  then enter 06: 30 for example, or press  --: -- to cancel the

time. Validate.
Validate the operation.

Notas :

The feature is activated either immediately (manual mode), or at the time defined by the settings (auto-
matic mode).

- Reception set: Hotel key -> Status -> Global

      Return         Rooms         Now         Time         Apply

      All      busy      rooms      Unclean      at      07:30

ROOMS

NOW

TIME CLEAR
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File
RECEPTION SET FEATURES
The Hotel application is the direct interface between the guest and Reception. It manages a range of 
services such as check-in, room consultation (message, prepayment deposit, etc), check-out and room 
status.

The application is accessible on the Reception set (set equipped with a Hotel key) whether it be free, in 
communication or ringing.

CHECK-IN

- To select a free, cleaned room:

Depending on how the programmed consultation screens are chained, you must:

- fill in the "empty" fields (the NAME of the guest for example)
- modify the fields which do not correspond to the default values (the LANGUAGE for example)
- validate all the check-in screens as and when they are presented.

Validating the last consultation screen is equivalent to exiting CHECK-IN; the room is considered oc-
cupied, and a "Guest Information Ticket" is printed automatically.

Below are the screens which correspond to check-in (maximum of six screens from a choice of eight):

- Deposit:  deposit total (metering credit) or select  (no prepayment)
- Guest name: guest name (10 characters maximum)
- Wake-up time: wake-up time or select : no alarm
- DND Status : to activate (DND) or deactivate (dnd) the "Do Not Disturb" function 
- Language : choice of language
- DDI number: allocation of a DDI N°, select  to allocate a new one
- External calls:  line barring, select  to allocate a new one
- Password: allocation of a password, select  to allocate a new one

Notas :

All the consultation screens, including those not selected, are grouped together in the room consulta-
tion screens once the check-in is completed.

- Reception set: Hotel key -> RSL key or directory n° of the room

NOPREP

CLEAR

CHOICE

CHOICE

CHOICE
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ROOM CONSULTATION

The application allows you to consult and modify a guest's data.

- Select an occupied room:

Notas :

To exit the application, press the Release key .
To consult another room without quitting the application, select an RSL key or enter a directory n° .

The display presents the guest data for the selected room. The data is displayed over three screens.

The first line of each screen gives:

- the name of the guest
- the guest's language
- the guest's wake-up call time (if programmed) and warning of any problem with the wake-up call
- the guest's DND (do not disturb) feature status 
- the guest's prepayment status (signs + for "credit" and - for "debit") and the monetary unit used
- the segment , off or lit, representing the guest's mail status (text mail, voice mail and Reception

call-back request)
- the directory number of the room

The second line of each display enables Reception to consult and/or modify guest data, or to print out 
an information ticket.

- Reception set: Hotel key -> RSL key or directory n° of the room

F F

<   Passwd

Torelli      It      07:30      dnd      + 7 EUR                 211

<   Name         Lang         Messag      DDINum         Barrng >

Torelli      It      07:30      dnd      + 7 EUR                 211

Torelli      It      07:30      dnd      + 7 EUR                 211

   Print      WakeUP         DND         Deposi         CheOut   >
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Print guest information ticket - PRINT

Press  to print out the "Guest Information Ticket" which includes:

- the name of the guest
- the room n°
- the language
- the password
- the DDI n°
- the barring status
- the guest's overall deposit total (metering credit)
- the total remaining to be paid by the guest (debit) or to be reimbursed by the hotel (credit); total of

the deposit paid minus the cost of the communications
- the VAT rate and the total VAT corresponding to the cost of the communications
- the number of communications made
- the active or inactive status of the DND feature
- the guest's mail status (messages present or not: text, voice and Reception call-back request)

Wake-up call time and status - WAKEUP

 allows you to read and modify the guest's wake-up call time and consult the guest's wake-up 
call status.

Reading the wake-up call time:

The room consultation screen allows you to read the guest's wake-up alarm time.

Modifying the time:

Press . Enter 06: 45 for example or press  --: -- so as not to have an alarm. Validate.

Consultation of the alarm status, several choices are possible:

- LEFT-HAND SEGMENT OF THE ROOM RSL KEY
On the add-on module for example, the left-hand segment of a flashing room RSL key signals an 
undefined problem with the wake-up alarm.

- ROOM OCCUPATION SCREEN
The consultation screen of a room signals whether a wake-up time is programmed or whether there 
is an undefined problem with the wake-up call. Example:
• 06: 45: programmed wake-up time; wake-up time active if : (colon) flashes
• 06: 45: programmed wake-up time; wake-up time inactive if no character flashes
• --: --: no programmed wake-up time (problem with wake-up call if all segments flash)
- 06: 45: programmed wake-up time and problem with wake-up call if all characters flash

PRINT

WAKEUP

WAKEUP CLEAR
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- WAKE-UP CALL STATUS
Press ; the wake-up call status will then be one of the following:
• active: the wake-up call is active
• --- (inactive): the wake-up call is inactive
• busy: problem – the set was busy during the three attempts
• unanswered: problem – the set did not answer during the three attempts
- inaccessible: problem – the set was inaccessible during the three attempts

- WAKE-UP CALL
In the case of a wake-up problem, the system alerts Reception by sending a message and a ringing 
tone to the set, repeated approximately every 30 seconds.

Do Not Disturb - DND

This feature allows you to read the status of the guest's DND feature and modify it.

Reading the status of the DND (Do Not Disturb) feature:

The room consultation screen allows you to read the DND status directly:

- DND: feature active
- dnd: feature inactive

Modifying the DND feature:

Press  ->  to select "ACTIVE" or "INACTIVE". Validate.

Metering credit - DEPOSI

This feature allows you to read the guest's credit (after calculation of the cost of the guest's communi-
cations) and to enter the amount of a new deposit.

Guest credit (with use of metering credit only):

The room consultation screen allows you to read the guest's account. It is either:

- + xxxxx EUR: positive (in credit)
- - xxxxx EUR: negative (in debit)

Amount of a new deposit (with use of metering credit only):

Press  and enter a new amount.

Validate the operation; the system recalculates the total deposit and the remaining credit.

Checking out a guest - CHEOUT

See "Guest Check-out ".

WAKEUP

DND CHOICE

DEPOSI
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Guest name - NAME

This feature allows you to read the name of the guest and modify it.

Reading the name:

The room consultation screen allows you to read the name of the guest.

Modifying the name:

Press  and modify the name (10 characters maximum); validate the operation.

Guest language - LANG

This feature allows you to read the guest's language and modify it.

Reading the language:

The room consultation screen allows you to read the guest's language.

Modifying the language:

Press  ->  to select one of the languages offered. Validate.

Note: the language is automatically assigned to the guest's voice mail box and set (if it has a display).

Voice mail status - MESSAG

This feature allows you to read the guest's message status (message left or not), it enables the operator 
to leave the guest a call-back request (activation of the message LED) and find out the type of mes-
sage left for this guest (operator call-back, voice mail or text mail). 

Reading the guest's mail:

The room consultation screen allows you to find out whether a message has been left for the guest.
To the right of the display and before the room n°, a segment provides information on this status:

- at least one message is waiting for the guest: 
- no message is waiting for the guest: 

Operator call-back request:

The operator can leave a call-back request on the guest's set. Press  ->  to:

- activate a call-back request: 
- cancel the call-back request: 

Validate the operation.

NAME

LANG CHOICE

MESSAG CHOICE
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Reading the type of message left:

The operator can find out the type (voice or text message) of message left for the guest.

Press  and analyze the display according to the headers presented:
- OPERATOR: operator call-back request:  or no call-back: 
- VOICE: voice message waiting:  or no message: 
- TEXT : text message waiting:  or no message: 

Guest DDI number - DDINUM

This feature allows you to read the guest's DDI n°and select another one.

Reading the DDI n°:

Press , the screen displays the guest's DDI n°.

Selecting another DDI n° for the guest:

Press  -> , the system allocates another DDI n°. Validate.

Barring - BARRNG

This feature allows you to read and modify the barring for the guest's set.

Reading the barring:

Press , the screen displays the guest's barring level.

Modifying the barring:

Press  ->  to select "INTERNATIONAL", " NATIONAL", "LOCAL" or "NO EXTERNAL". Validate.

Guest password - PASSWD

This feature allows you to read the guest's password and select another.

Reading the password:

Press , the screen displays the guest's password.

Selecting another password:

Press  -> , the system assigns another password. Validate.

Note: The password is automatically assigned to the guest's voice mail box and set. The guest can use 
it to:
- lock the set (block outside calls)
- make calls using a protected account code (with or without substitution)
- read his or her voice mail remotely 

MESSAG

DDINUM

DDINUM CHOICE

BARRNG

BARRNG CHOICE

PASSWD

PASSWD CHOICE
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CHECK-OUT

The application allows you to free a room.

- Select an occupied room then the Check-out menu:

The following appears on the display:

The first line shows:

- the name of the guest
- the guest's language
- the guest's prepayment status (signs " +"for credit and " -" for debit) and the monetary unit used
- the directory number of the room

The second line enables Reception to print out an information ticket and perform "Pre-checkout" as well 
as Check-Out.

Print out a guest's telephone bill - PRINT

Press ; the bill indicates:

- the name of the guest
- the room n°
- the guest's total deposit (metering credit)
- the number of communications made
- the total cost of the communications
- the VAT rate and the total VAT corresponding to the cost of the communications
- the total remaining to be paid by the guest (debit) or to be reimbursed by the hotel (credit); total of

the deposit paid minus the cost of the communications

Pre-checkout of a guest - PREOUT

This feature enables a guest to settle the telephone bill the day before an early morning departure, for 
example, (external outgoing calls are then no longer possible) whilst at the same time keeping the fea-
tures programmed on the phone (wake-up call, message, DDI N°, DND, etc).

Press  PRE CHECK-OUT to activate the pre-checkout features.
Caution: The pre-checkout cancels the guest's amount "Remaining to be paid", see the table below.

- Reception set: Hotel key -> RSL key or directory n° of the room -> CheOut menu

Print                                          PreOut         CheOut

Torelli      It                           + 7 EUR                 211

PRINT
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Check-out of a guest - CHEOUT

This feature enables Reception to make a room free; see the table below.

Press  to reset the room's parameters; a "Guest Global Bill Ticket" is printed automatically.

The following table and analysis show the role of each of the features.

Analysis of the table:

- / : this symbol means that the feature remains unchanged from the previous report.
- No external call: new room set barring. The set will return to its default configuration upon check-

in.
Active communications, ringing, calls on hold etc. are cut off immediately upon activation of "PRE-
CHECKOUT" or "CHECK-OUT".

- --- in the "Remaining to be paid" column: the total remaining to be paid by the guest (debit) or
reimbursed by the hotel (credit), resulting from the cost of the communications and the deposit gi-
ven, is erased.
The guest's call counters, partial metering counter and partial cost counter are reset only upon 
check-in (input of a new guest) or by system command.

- Reset: reset of the features. The Wake-up, DND and Barring features return to their default value
upon check-in.

- 1 Hour: new messages are kept for 1 hour. Check-in resets the voice mail box.
- Free / Uncleaned: the room is assigned "Free" and "Uncleaned" status.
- Room n°: the guest name is replaced by the room number (directory update).

Wake-
up

Messa-
ge

DND Forwar
d

DDI 
allo-

cation

Bar-
ring

Room 
Status

Pas-
sword

Name Re-
mai-
ning 
to be 
paid

Pre-
chec-
kout

/ / / / / No ex-
ternal 
call

/ / / ---

Check-
out

Reset 1 hour Reset Reset Reset No ex-
ternal 
call

Free / 
Unclea

ned

Reset Room 
n°

---

CHEOUT
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ROOM STATUS

The Room Status feature enables:

- the Room Manager: to inform Reception of the status of rooms
- Reception to:

• find out the status of a room
• change the status of a room
- see the status of the rooms on the Reception set (segments of an RSL key)

- print a Room Status ticket or statement

Use of Room Status by the Room Manager

The Room Manager informs Reception of the status of the rooms (cleaned, uncleaned, with or without 
problem) by using the room set to dial the "Room Status" code corresponding to its status.

- To enter the Room Status code for a room:

Use of Room Status by Reception

Reception enters the Room Status menu then selects "Global" or a room RSL key.

- To enter the Room Status menu:

Notas :

To exit the application, press the  Release key.
To consult the status of another room, select an RSL key.
To return to room consultation, enter a directory n°

- On the room set: Room Status prefix + 0 (cleaned) or 1 (uncleaned) + if necessary, N° of
problem (3 digits max.; enter 000 to cancel the previous problem ).

- Reception set: Hotel key -> Status

F F

HOTEL KEY STATUS GLOBAL All rooms

All busy rooms

Unclean now

Unclean timer

Read problem

RSL / ROOM Clean/Unclean

Erase problem

Free / Busy
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Configuring Room Status - GLOBAL

The grayed area represents the Room Status configuration. On the use of this service to switch rooms 
to "Uncleaned" status immediately or at a preset time, see "Configuring Room Status" in the "Configu-
rations" section.

ROOM STATUS – RSL KEY OR DIRECTORY N° 

The RSL key or directory n° allows you to read and modify the Room Status of a room. There is: 

- its "Cleaned" or "Uncleaned" status
- its problem number, if there is indeed a problem
- its free or busy status (read only).

Reading the status of a room:

The screen displays the three types of status above.

Notas :

The CHECK-IN, PRE-CHECKOUT and CHECK-OUT operations do not reset the room problems.

Modifying room status:

- Press  to select "UNCLEANED" or "CLEANED"
- Press  to erase the problem
- Press  to enter a problem n°, 012 for example, and validate
Validate the operation.

Printout of a Room Status Ticket or Statement

A Room Status Ticket or Statement can be printed automatically when a room changes status. 

Below is an example of a "Room Status Statement".

The field ROOM STATUS CHANGE is specific and includes the following data:

- the first digit indicates the room status: 0=room CLEANED or 1=room UNCLEANED
- the other digits (3 maximum) represent the problem number, if there is one.

CLEANS

NOPROB

PROBLM

USER LINE HOUR TAXES FACILITIES

TYPE DATE DURATION SERV. DIALLED NUMBER

08:31A122 03/06/97 ROOM STATUS CHANGE 0034

ALCATEL

USER NAME- -

TORELLI

- -
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Function of the RSL key segments

The three-segment display associated with each RSL key not only allows you to see the telephone status 
(normal operation), but also provides at-a-glance information on the overall status of the room (free, 
occupied, cleaned, uncleaned or problem with wake-up call or room).

To access these types of status, the set must have a Hotel key. Each segment has a function:

- the first segment (on the left-hand side) indicates the free or occupied status of the room as well as
a possible wake-up call problem

- the second segment indicates the telephone status of the room set
Note: if the segment is flashing, this indicates an internal or external call

- the third segment indicates the "cleaned" or "uncleaned" status of the room as well as a possible
problem with the room

The table below sums up this information.

ROOM SERVICE

To call Room Service, the user dials a number corresponding to a service (the "breakfast" service for 
example). This number, recognized by the system, is assigned to the "Room Service" station on an RSD 
key.

The "ROOM SERVICE" station has a display enabling the Room Service operative to read the name, 
directory n° and language of the caller.

Segment N°

Status 1st segment 2nd segment 3rd segment

Not lit

Lit

Flashing

Room free Station free Room cleaned

Room occupied Station busy Room uncleaned

Wake-up problem Station ringing Room problem
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GENERAL PRESENTATION
INTRODUCTION

Alcatel OmniPCX Office is a voice/data convergence product intended for small and medium-sized 
enterprises.. Alcatel OmniPCX Office can be administered locally or remotely and can be integrated 
into any LAN on a single site or a multiple site. Given its overall communication range, Alcatel Omni-
PCX Office offers an Internet access solution, and can be used to manage the following elements:

- the LAN.

- client terminals (PC) that can be used to access Internet resources.

- remote client terminals that can access the LAN via the VPN.

Alcatel OmniPCX Office does not required any special software for the Internet access installation, but 
it can only be integrated into a TCP/IP environment . The range of services proposed for Internet 
access are configured by means of an Internet navigator (Netscape Navigator, Internet Explorer...).

The administration tools and the integrated software programs are used to configure the network pa-
rameters (IP addresses, masks, domain names and DNS, routing tables...) corresponding to the ins-
talled hardware.

In this section, we shall deal in turn with the connections, the proposed service offers in terms of Internet 
access and LAN services, along with the associated hardware configurations.

CONNECTIONS

The LAN and Internet connections are required for the installation of Alcatel OmniPCX Office Internet 
access. 

LAN connection

this is provided by a Base-T 10/100 Base Ethernet (RJ45) or by an internal switch installed in the Alcatel 
OmniPCX Office cabinet.

Internal connection

Alcatel OmniPCX Office is used to connect to the Internet by three types of access.

ISDN access

The ISDN functionality provides Internet access by means of a shared access (T0 or T2) that is limited 
to two B channels. Connection is usually by "call on demand", but can also be "permanent". The autho-
rised bandwidth varies between 64 Kbps and 128 Kbps.
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DSL modem access

The DSL modem functionality allows connection of Alcatel OmniPCX Office to an external IP network 
via an external DSL modem connected to the system by means of the WAN interface (second Ethernet 
interface of the CoCPU@) card). Connection is “permanent” if the protocol used is PPTP and optionally 
can be "permanent" or "on demand" if the protocol used is PPPoE. The authorised bandwidth is between 
64 Kbps and 2 Mbps.

LAN access to LAN routing

The LAN to LAN routing functionality uses an external router to manage the connection to the Internet. 
The router is connected to Alcatel OmniPCX Office via the WAN interface (second Ethernet interface 
of the CoCPU@) card). The connection to the WAN can be of any sort, ISDN or ADSL for instance. 
Connection is generally “permanent”, but can also be “call on demand”. The authorised bandwidth 
is between 64 Kbps and 2 Mbps.

Nota : for the description of the Alcatel OmniPCX Office sub-systems, refer to the "Hardware" sec-
tion.
Ed. 042/6 Réf. 3EH 21000 BSAA



File
1

GENERAL PRESENTATIONE-SERVER : INTERNET APPLICATIONS

 

SERVICES

The range of services available on the Alcatel OmniPCX Office Internet access is linked to the hardware 
and purchased software keys. It is made up of two main offers: a "Basic" offer with shared Internet ac-
cess for all company users, and a "Full" service offer combining the "basic" offer and some extra servi-
ces.

With the "Basic" offer, Alcatel OmniPCX Office provides users with fast access to the resources of the 
Internet world. It allows all users of the company to access the Internet simultaneously by using a single 
connection account. The functionalities associated with this offer are the LAN functions, integrated fi-
rewall protection and NAT.

With the "Full", Alcatel OmniPCX Office provides users with access to the resources of the Internet 
world, together with additional functionalities such as the Web cache, access control, electronic mes-
saging and VPN.

All the available services are:

- Internet access: the system offers several methods of connection to the Internet Access Provider
(IAP):

• Connection on demand: connection to the IAP is provided in accordance with user demands
(Internet access, sending electronic messages, etc...). It is disconnected when there is no more
traffic. The speed chosen can be static (64 Kbps, 128 Kbps) or dynamic (bandwidth on demand
between 64 and 128 Kbps).

• Connection on demand with call-back service ("Call-back"): the IAP sends a signal to Al-
catel OmniPCX Office that establishes the connection by return. This mechanism is validated
by virtue of the ISDN caller identification where only authorised numbers can be called back.
This type of connection must be used as part of the implementation of VPN services on an ISDN
link (for more details, refer to the "VPN" section).

- Permanent connection: the link to the IAP is permanent.

The authentication protocols used are PAP/CHAP (ISDN and DSL modem). Similar to the case of 
the Router, if OmniPCX Office does not communicate directly with the IAP,  there is no need for 
authentication.

- Connection protocol:

• ISDN: MPPP
• DSL modem: PPTP or PPPoE

- LAN to LAN routing: OmniPCX Office communicates with the IAP via the external Router. The
protocol used depends on the external Router.

- LAN functions : integrated DNS and DHCP server.

- NAT: address translation is used to internally store private IP addresses and to use only one single
public address.

- Protection by integrated firewall: the integrated packet filtering and IP address translation func-
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tions offer protection to the LAN against the Internet.

- Access control : Alcatel OmniPCX Office offers control solutions for user access by integrated
proxy. It is used to control Internet access and to provide related statistics (user, protocols, URL ...).

- integrated cache: this function is used to accelerate Internet requests and to reduce the costs of
accessing the telephone network.

- Electronic messaging server: it allows users to make use of a personal electronic address in the
company. It is possible to create as many messaging accounts as required within the limits of the
system, while optimising the corresponding traffic to the Internet The functions are as follows:

• SMTP server

- POP3 server

- VPN : this solution allows safe connections to the LAN via the Internet infrastructure . Consequently,
remote users take advantage of all the resources of the LAN. Several sites can be remotely connec-
ted by VPN. The existing possibilities are:

• Remote access to the LAN via Internet ("Client to LAN" configuration, PPTP protocol)

- Access between two LAN ("LAN to LAN" configuration, IPSec protocol)
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HARDWARE CONFIGURATIONS

Three CPU cards are used for Internet access: An "Enhanced" CPU (CPUe), a coprocessing CPU@ (Co-
CPU@) and a coprocessing CPU@ with a 2nd LAN interface (CoCPU@). The configurations corres-
ponding to Internet services are summarised in the table below (for more information, refer to the 
"Hardware" section).

Services Card(s) used

Internet access via ISDN
- Access (on demand/permanent/Call-Callback)
- NAT
- Firewall (packet filtering)
- LAN (DHCP server, DNS server)

CPUe

Internet access via DSL modem or LAN to LAN Rou-
ting

- Permanent access
- NAT
- Firewall (packet filtering)
- LAN (DHCP server, DNS server)

CoCPU@ with a 2nd 
Ethernet interface

Web cache and access control(Proxy)
- Cache
- Restrictions

CoCPU@

Electronic messaging
- Messaging server
- Messaging cache
- Internal SMTP server

CoCPU@

VPN
- Client-LAN terminal
- LAN-LAN

CoCPU@
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INTERNET ACCESS
To take advantage of the shared Internet access on a client terminal, several steps have to be under-
taken:

- Installation of Alcatel OmniPCX Office.

- Creation and configuration of an Internet connection.

- Configuration of the client terminal

PROCEDURE FOR INSTALLING ALCATEL OMNIPCX OFFICE

There are four stages to installing Alcatel OmniPCX Office:

- the necessary hardware on Alcatel OmniPCX Office.

- the equipment required at the client terminal.

- subscription with an IAP.

- the installation procedure.

The necessary hardware on Alcatel OmniPCX Office

- a CPUe card (Internet access only) or a CoCPU@ card (Internet access + Proxy, E mail, etc ...), in
the case of an ISDN connection. In the case of an ADSL or LAN to LAN routing connection, a Co-
CPU@ card fitted with a 2nd Ethernet interface is added.

- an ISDN T0 or T2 connection or an STN connection.

- a client terminal connected to the LAN.

- a LAN switch (LANX8, LAN X16 or external switch).

Items required on the client terminal

- the latest version of the PM5 software.

- an Internet navigator (Netscape Navigator or Internet Explorer version 4 or higher).

Subscription with an IAP

A subscription with an IAP is necessary to access the Internet.. After you have subscribed, the IAP sends 
you back the information vital for installing you Internet access. This information must be entered 
when configuring Alcatel OmniPCX Office.
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The information required to install the Internet access varies according to the type of connection to be 
established.

All this information is described below.

- Connection account

This account is used when identifying the connection to the IAP. This account is unique, and is use 
to identify oneself when connecting to the access provider by giving the account and the related 
password.

• "Login": account delivered by the access provider. This account is used during the PAP/CHAP
authentication process when connecting to the IAP. This account, a form of security used by the
access provider, must be entered only once in Alcatel OmniPCX Office. It must not be confused
with the user account and password, the parameters that are entered when requesting access
to a Web site, and that allows the number of users with Internet access to be controlled.  So
there are two level of authentication:

- authentication (client terminal) managed by Alcatel OmniPCX Office for each Internet user
in the company.

- authentication (Alcatel OmniPCX Office) managed by the access provider. Internet access
is access that is shared by all users. Consequently, this authentication is unique and trans-
parent for the users.

- “Password”: password linked with the connection login.

- Access provider's telephone number

ISDN connection DSL model connection LAN to LAN routing connec-
tion

Login

Password

Primary and secondary tele-
phone number

Bandwidth

Type de connection

IP address

Primary and secondary name 
server

Login

Password

Connection protocol

- If PPPoE:

• Type de connection

- If PPTP

• IP address of modem
• Network mask

- IP address of system

Primary and secondary name 
server

IP address of router

IP address of system

Network mask

Primary and secondary name 
server
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• "Telephone number": telephone number dialled when connecting to the IAP.

- "Secondary telephone number (backup)" : it may or may not exist depending on the access pro-
vider used.. This number is dialled if the main telephone number is not available..

- Bandwidth

The allocated bandwidth corresponds to the throughput between Alcatel OmniPCX Office and the 
access provider for an ISDN type connection. . The bigger the bandwidth, the faster the throughput 
(connection costs will be higher in turn). Three choices are possible in the number of B channels 
used:

• "1 64 Kbps B channel": a single B channel is used statically.
• "2 128 Kbps B channels": two B channels are used statically. In this case, call charges are mul-

tiplied by two.

- "on demand (64-128 Kbits/s)": two B channels are used dynamically. The charges are identical
to those applied to 128 Kbits/s, but the traffic is optimised to the bandwidth requirements. The
throughput to the IAP must correspond to a 128 Kbps access. This option must not be chosen
if the connection to the access provider is 64 Kbits/s.

- Type de connection

The type of link between Alcatel OmniPCX Office and the access supplier can be established with:

• “On demand call”: the B channel(s) is (are) active in relation to user requests, and is (are) closed
down when there is no more traffic. This type of connection avoids charges when there is no
traffic.

• "Permanent": the connection between the IAP and Alcatel OmniPCX Office is permanent, it is
like using a leased line from the telephone operator..

- "Callback": this option is chosen when a client terminal outside the LAN wishes to access Alcatel
OmniPCX Office via Internet (See Section VPN). It allows Alcatel OmniPCX Office to dial auto-
matically the call number of the IAP in order to establish connection. 

- IP address allocation

The IP address is allocated to Alcatel OmniPCX Office by the access provider. This address is public. 
If the access provider manages the IP address negotiation, the “dynamic” option must be checked, 
otherwise enter the assigned IP address. A fixed IP address is required in the case of a permanent 
connection and in order to use a VPN.

- DNS servers

This information corresponds to the IP addresses of the DNS servers on the premises of the access 
provider. These servers are used to translate site names into IP addresses.

• "Address of primary DNS server”".

- “Address of secondary DNS server”.

- Connection protocol
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This information is provided by the IAP for a connection using a DSL modem. In this case, a point 
to point connection is established between OmniPCX Office and the DSL model. Two types of com-
munication protocols are available to manage this connection.

• PPPoE: this protocol is used to send PPP packets over Ethernet. This protocol allows "permanent"
or "on-demand call" type connections.

- PPTP: This protocol consists of establishing an IP tunnel between Alcatel OmniPCX Office and
the modem. This protocol allows only “permanent” connections.

- Connection properties

To define the connection parameters, the IAP gives the following elements:

• “DSL modem address” or “Router address”: this is the IP address of the router or of the DSL
modem.

• “Network mask”: parameter determining the range of the network.

- “System IP address”: this is the IP address of the WAN interface. These parameters must be con-
sistent with the IP address of the router or of the DSL modem.

Instllation procedure

1. Connect the CPU card using an Ethernet cable:

• either to an RJ45 jack available on the company's LAN.

- or to the internal switch in the Alcatel OmniPCX Office cabinet. This switch can then be connec-
ted to another switch if Alcatel OmniPCX Office has several switches.
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2. If necessary, change the default IP addresses (192.168.92.246 for CPUe, 192.168.92.247 for Co-
CPU@) and the mask of the sub-network to IP addresses that are compatible with the existing LAN
(for more information, contact the company's network and system administrator). The IP addresses
of the different cards can be accessed through the heading PM5 -> PABX Client -> Hardware
and limits-> IP cards.

3. Internet access configuration:

• either via the Internet navigator of a customer terminal connected to the LAN by entering the IP
address of the CPU Main or CoCPU@ card in the address bar.

- or via the PM5 software, from the PM5 -> PABX Client -> Internet access configuration
menu. 
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CREATION AND CONFIGURATION OF AN INTERNET CONNECTION.

Alcatel OmniPCX Office provides three types of connection to access the Internet:

- ISDN

- DSL modem

- LAN to LAN routing

Configuration of an ISDN connection 

The different fields to be completed in the order of appearance on the configuration screens are the 
following.

- "”IAP profile name” : this name identifies the new Internet connection managed by Alcatel Om-
niPCX Office. It holds all the parameters linked to this connection. It is recommended that a name
that is representative of the created connection is entered, such as the name of the access provider.

- "Type" : this field is used to define the type of connection. Click on "ISDN".

- "Login": enter the account name sent by the access provider. 

- "Password": enter the password linked with the connection login.

- "Confirm the password": password identical to the one entered earlier. This information is used
to avoid keying errors.

- "Telephone number" : enter the telephone number dialled when connecting to the IAP. This num-
ber must contain the dialling prefix required to dial a number outside the company.

- "Bandwidth": three choices are possible in the number of B channels used:

• "1 64 Kbps B channel"
• "2 128 Kbps B channels"

- "on demand (64-128 Kbits/s)": this option must not be chosen if the connection to the access
provider is 64 Kbits/s.

- using WBM: Assistants -> Internet access

- Profile name tab 

-  IPA configurationtab 

-  Access configuration tab 
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- "Connecyion": three choices are possible:

• “On demand call”
• "Permanent":

- "Callback":

- "IP address": two choices are possible:

• Check the "dynamic" option, if the access provider manages the IP address negotiation.

- Enter the IP address provided in the “fixed” field

- "Name server": two choices are possible:

• check the "Dynamic" option if the resolution of the DNS is automatic during connection.

- Enter the IP address of the access provider's primary DNS. It is recommended that recognition
of the IAP's DNS is left at automatic.

This stage is used to verify the connection properties.

Click on "Apply" to accept these parameters and enable the profile. Click on "Back" to return to the 
last screens and modify the desired parameters.

A connection test is possible, and can be done by clicking on "Test the connection " after accepting 
the configuration.

Configuration of a DSL modem connection 

The different fields to be completed in the order of appearance on the configuration screens are the 
following.

This stage consists of defining the connection name and type.

- “IAP profile name”: this name identifies the new Internet connection managed by Alcatel Omni-
PCX Office. It holds all the parameters linked to this connection. It is recommended that a name
that is representative of the created connection is entered, such as the name of the access provider.

-  Internet configuration tab 

- Summary tab  

- using WBM: Assistants -> Internet access

- Profile name tab 
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- "Type" : This field is used to define the type of connection. Click on "ISDN". 

This stage is used to identify the IAP.

- "Login": enter the account name sent by the access provider. 

- "Password": enter the password linked with the connection login.

- "Confirm the password": password identical to the one entered earlier. This information is used
to avoid keying errors.

This stage is used to define the connection protocols. 

Depending on your subscription, you will choose the protocol Over Ethernet (PPPoE) or Tunnelling 
(PPTP)

Over Ethernet protocol (PPPoE) 

Choose "on Demand" if your access is not permanent.

This stage is used to define Internet properties, i.e. the IP address and the name servers.

- "Allocation of IP address": two choices are possible:

• if the IAP gives an IP address, enter it in the “fixedfield”

- Otherwise select the “dynamic" option.

- "Primary DNS server”: Two choices are possible:

• Check the “Dynamic” option if the resolution of the DNS is automatic during connection.

- Enter the IP address of the access provider's primary DNS. It is recommended that recognition
of the IAP's DNS is left at automatic.

Click on “Next” to access the Summary screen. Click on “Back” to return to the last screens and modify 
the desired parameters.

This stage is used to verify the connection properties.

-  IPA configurationtab 

-  Access configuration tab 

- Internet configuration tab 

- Summary tab  
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Click on “Apply” to accept these parameters and enable the profile. Click on “Back” to return to the 
last screens and modify the desired parameters.

A connection test is possible, and can be done by clicking on “Test the connection ”.

Tunnelling protocol (PPTP)

This stage is used to define the connection parameters between the DSL modem and Alcatel OmniPCX 
Office. Complete the following fields:

-  “DSL Modem IP address”: enter the IP address of the external modem.

-  “System IP address”: enter the IP address of the WAN interface.

- "Network mask": enter the defined mask.

This stage is used to verify the connection properties.

Click on “Apply” to accept these parameters and enable the profile. Click on “Back” to return to the 
last screens and modify the desired parameters.

A connection test is possible, and can be done by clicking on "Test the connection " after accepting 
the configuration.

Configuration of a LAN to LAN routing connection

The different fields to be completed in the order of appearance on the configuration screens are the 
following.

This stage is used to define the connection name and type.

- “IAP profile name”: this name identifies the new Internet connection managed by Alcatel Omni-
PCX Office. It holds all the parameters linked to this connection. It is recommended that a name
that is representative of the created connection is entered, such as the name of the access provider.

- "Type": this field is used to define the type of connection. Click on “Ethernet to router”.

-  Access configuration tab 

- Summary tab  

- using WBM: Assistants -> Internet access

- Profile name tab 

-  Connection configuration tab 
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This stage is used to define the parameters of the external IP router.

- "Router address”: enter the IP address of the external router.

- "Network mask”: enter the defined mask.

This stage is used to define the system's IP address.

- "System's IP address”: enter the IP address of the WAN interface.

- "Primary DNS”: Enter the IP address of the access provider's primary DNS.

-  “Secondary DNS”: Enter the IP address of the access provider's secondary DNS.

This stage is used to verify the connection properties.

Click on “Apply” to accept these parameters and enable the profile. Click on “Back” to return to the 
last screens and modify the desired parameters.

A connection test is possible, and can be done by clicking on "Test the connection " after accepting 
the configuration.

Connection test

Click on “Test the connection”. The connection test runs all the stages involved in connecting to an 
IAP, and gives the causes and related solutions to solve the problem if the connection fails. The fol-
lowing are tested in succession:

- test of the initial state: the system checks that the active IAP is in “Enabled” mode, and that connec-
tion is possible in accordance with the configured time ranges.

- Call to the IAP's telephone number, or ping to the DSL modem or router.

- Authentication verification: the system tests the login and password authentication in accordance
with the protocol supported by the IAP (PAP/CHAP). This verification is tested during a connection
using ISDN or DSL modem. 

- Negotiation of IP addresses: the system sends back the IP addresses of Alcatel OmniPCX Office,
and of the router on the IAP's premises. This negotiation is tested during a connection using ISDN
or DSL modem.

- Testing the remote address by pinging the IAP's router. This test is used to verify that the router is
working properly.

- Verification of the DNS configuration: this test is used to verify that the DNS configuration entered
in the system is correct, and, if not, it is used to dynamically locate the DNS servers on the IAP's

-  Internet Settings tab

- Summary tab  
Ed. 0410/14 Réf. 3EH 21000 BSAA



File
2

INTERNET ACCESSE-SERVER : INTERNET APPLICATIONS

 

premises.

- Resolution of the IP address of the URL www.ietf.org: is used to verify that the DNS resolution is
working properly.

- Pinging the DNS: this test is conducted if the DNS resolution is not working. It is used to check if
the problem is due to an incorrect IP address or the DNS service.

- Pinging www.ietf.org: is used to check accessibility of a site on the Internet.

Advanced configuration (R1.0)

This menu gives access to several screens that are used to make more precise settings to the the active 
profile.

Depending on the type of connection of the active profile, advanced configuration can provide access 
to different settings. 

- "Hanging up": time (seconds) after which the link to the IAP is cut in the absence of traffic on the
ISDN link. This setting is used only for on-demand connections, and the default value is two minu-
tes.

• "Secondary telephone number”: IAP's second access telephone number. This parameter is
optional. It is automatically dialled if the first telephone number is not available.

• "Callback number”: this field is present only if the callback option was chosen earlier. It cor-
responds to the number authorised to call Alcatel OmniPCX Office, and is generally the IAP's
access number.

• "Secondary callback number”: corresponds to the second number authorised to call Alcatel
OmniPCX Office. It is optional.

• "Secondary DNS address”: this entry corresponds to the IP address of the IAP's secondary
DNS server. It is optional.

- "QoS (Quality of Service)”: click on  “Yes” to activate this function, then enter the bandwidth.

• "Compression (VJ)”: it corresponds to the compression of the IP headers. Check “Yes” if the
IAP supports this functionality, “No” if not.

Click on “Apply” to accept the settings entered. It is recommended that the newly created connection 
is tested.

- using WBM:  Configuration -> Internet access

- Maintab  

-  Access tab 

- Connectiontab  
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Connection management

If you wish to configure access to other IAP, you need only re-launch the operation from the  Assistants 
-> Internet accessmenu.  So it is possible to create several connections to various IAP with different 
types of connection. These connections (activation, test and deletion) are managed from the Adminis-
tration ->Access providersmenu. The configuration screen gives information on the list of profiles 
generated by the system and the active Internet connection.

The Test, Activate and Delete buttons are used to test in succession the connection corresponding to 
the active profile, to activate and delete the profile selected from the list of different profiles..

The Modify button (R1.1) is used to modify all the profile parameters of the selected IAP, including 
those set by default when creating this profile (see paragraph "Advanced configuration (R1.0)".

Using the Welcome page -> Overall view->Communicationmenu, it is possible to enable or di-
sable the connection and to view the status of the connection to the active IAP as well as the  incoming 
and outgoing traffic by clicking on connection status.

CLIENT TERMINAL CONFIGURATION 

The client terminal needs to be configured in order to use Alcatel OmniPCX Office's shared Internet 
Access The changes must be made to the network configuration (TCP/IP configuration ), and to Internet 
navigator.

TCP/IP configuration 

Alcatel OmniPCX Office is a routing element between LAN and Internet. Alcatel OmniPCX Office needs 
to be configured as the default gateway on the client terminal to access the Internet.

Exemple :  configuration of a Windows 98 client terminal

- Click on the “Network neighbourhood” icon, and choose the “Properties” option from the con-
text menu.

- In the “Network ” window, double-click the “TCP/IP” icon under the “Configuration” tab.

- Enter Alcatel OmniPCX Office's IP address in the “New gateway” field (“Gateway” tab of the
“TCP/IP properties) window).

- Click on “Add” then shut the windows by clicking “OK”.

- Re-boot the client terminal to have the changes take effect.

Nota : This configuration is valid only if Alcatel OmniPCX Office is the main router in relation to 
the client terminal. In the case of other network configurations, contact the company's sys-
tem administrator.

Configuration of the Internet navigator

The Internet navigator must be configured to take account of the existing LAN.
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Exemple :  configuration Internet Explorer 5.0

- Run an Internet Explorer session.

- Choose the heading “Internet options ...” from the “Tools” menu.

- Click on the “Connections” tab of the “Internet options ” window.

- Click on “LAN settings...”

- Change the options in the “Local network (LAN) settings” window.

- Click on “OK” to accept the changes.

Nota : If the proxy server is active on Alcatel OmniPCX Office, enter the IP address of the CoCPU@ 
card, otherwise enter the IP address of the client's proxy server.
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 LAN SERVICES 
INTRODUCTION

Corporate internal networks – or local area networks (LANs) – are made up of different elements, or 
"host names", such as servers, client stations, routers, hubs, and so on. To be effectively integrated into 
a LAN, these devices are subject to integration rules that govern the definition of an IP address plan, 
the adoption of domain names and naming conventions, etc. OmniPCX provides features that facili-
tate integration into a LAN, whatever topology it may present. These features correspond to DNS and 
DHCP services. What follows is a general description of how these services work, before dealing with 
their configuration in OmniPCX.

DESCRIPTION

DHCP SERVER 

The protocol usually implemented and run on LANs is TCP/IP, the standard protocol used on the In-
ternet. In TCP/IP, each host name belonging to a network (LAN, WAN) has its own unique IP address  
enabling it to be recognized or called up by the other host names when they need to communicate 
with each other.
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There are two types of IP address:

- public addresses: each public address is assigned and unique on the Internet;

- private addresses: these are assigned in a LAN and recognized within the LAN, but not recognized
by elements outside the LAN.

Using private addresses in a LAN allows total freedom of choice in allocating addresses. A host name 
can have a fixed IP address, or it can be assigned one dynamically by a DHCP server each time it con-
nects to the LAN. There are several stages in the LAN connection process (see diagram above):

1. the DHCP client connects up to the LAN, and requests an IP address allocation. The request is made
by sending out ("broadcasting") a DHCP request over the LAN;

2. the DHCP server on the LAN receives the request and allocates an available IP address from the
pre-defined range of addresses;

3. the allocated IP address is sent to the DHCP client;

4. the DHCP client accepts the IP address.

OmniPCX provides DHCP server functionality. The following parameters can be configured:

- the value range of IP addresses that the DHCP can allocate. These IP addresses are allocated for
all the network elements: client stations, telephones and mobile terminals;

OmniPCX
(integrated DHCP server)

Router

DHCP clients 
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- the lifespan or "lease" of a dynamically allocated IP address.

When integrating into a LAN, two types of situation are encountered:

- there is no existing DHCP server: if a DHCP server is required, an address plan must be defined
with a range of fixed addresses for the specific network elements (servers, printers, routers, etc) and
a range of DHCP-attributable addresses for the client stations;

- there is already a DHCP server: in this case OmniPCX requires no particular DHCP configura-
tion.

Nota :  LANs can accommodate more than one DHCP server, so long as their IP address ranges 
don’t overlap.
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DNS SERVER 

With its integrated DNS server, OmniPCX provides you with DNS server functionality on the LAN. DNS 
servers handle the correspondence between an IP address and the host name of a machine. DNS ser-
vers perform two main functions:

- DNS caching for the resolution of names external to the LAN. The cache is updated whenever a
DNS request is resolved by DNS servers other than OmniPCX. This means that if an identical re-
quest is received, it can be resolved directly by OmniPCX without calling on the DNS servers at the
ISP. The request is thus resolved faster, with a corresponding reduction in communications costs.
The OmniPCX DNS also has a negative cache for memorizing name resolution failures. The lifes-
pan of the information in the cache is kept short so that the user can make a new attempt at resol-
ving these names;

- resolution of local host names with a fixed IP address on the LAN. These names are resolved on
condition that the elements have been entered in OmniPCX.

Resolving DNS requests from client stations involves several stages (see diagram):
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- The client station emits a DNS request (Step 1).

- The host name - DNS server IP address correspondence table is consulted (Step 2). If the host name
is found, the DNS server sends the corresponding IP address back to the client station (Step 3). If
not, the request is relayed to the ISP's DNS servers (Step 4).

- The ISP's DNS servers are consulted. If the request is resolved, the servers send the corresponding
IP address back to the DNS server on the LAN (Step 6). The LAN DNS server updates the DNS cache
to take account of the request (Step 7), and proceeds from Step 3.

- If the request can’t be resolved by the ISP's DNS servers, it is relayed to other DNSs on the Internet
(Step 8). At this stage, the request is continuously relayed until a DNS server manages to resolve
the host name (Step 9). The resolved IP address is then returned to the ISP's servers (Step 10), from
whence it follows the same route as before.

DNS Servers

DNS Servers
ISP

OmniPCX
(integrated DNS server)
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CONFIGURATION

OmniPCX

Click on "Network" in the "Settings" menu inside the configuration menu. Enter the following settings:

- "DNS" tab

• Your Domain Name: enter the internal domain name used on the LAN. The default setting is
company.world.

• Association List: the list of the host names on the LAN with a corresponding fixed IP address.
Each new element entered with an IP address and host name will be added to the OmniPCX
DNS table. To add an entry, enter the IP address and associated name, then validate by clicking
"Add". The new element appears automatically in the list underneath.

Important :DHCP clients must not be entered in this list.

- "IP Address Allocation" tab

• DHCP Lease Time: the lapse of time after which an IP address allocated to a DHCP client that
logs off is made available to another DHCP client. The shorter the lease time, the easier it will
to redistribute the IP address pool dynamically to the client stations.

• Dynamic IP Address Allocation: ranges of IP addresses allocated to LAN elements. These
ranges are defined by a "begin" IP address and an "end" IP address. They are allocated to the
PCs, phone terminals and VPN clients. To configure a range of IP addresses:

- enter the IP address for the start of the range in "Begin";

- enter the IP address for the end of the range in "End";

- in "Type", choose "Computer" to assign the range to PCs, "IP Enabler" for telephones, or
"Client to LAN" for remote PCs that access the LAN via a VPN tunnel;

- click "Add" to validate. The newly configured range is added to those already defined;

- repeat the operation as many times as there are ranges to define. After validation, ranges
can be deleted by clicking "Remove".

- "Routing Table" tab. The routing table allows OmniPCX to direct the various IP packets it receives
towards their respective destinations (Internet, LAN-based server or router, PC, etc). The table is in
two parts: 

• A non-modifiable section ("Static Routes"), which covers the routes integrated by default at the
OmniPCX level, i.e. OmniPCX, the LAN and the Internet.

• a configurable section covering other IP routings. To configure an additional route, fill in the
following fields:

- "Destination": destination IP address;

- "Gateway": IP address of the gateway to contact in order to reach the destination address;

- "Mask": sub-network mask associated with the destination address;
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- "Note": comment for identifying the route entered.

Exemple : Configuration of the routing table with three sub-networks present on the LAN.

In the architecture corresponding to the diagram above, routers 1 and 2 must be entered into the 
OmniPCX routing table so that requests destined for elsewhere than the Internet can be rerouted 
to the LAN. Two entries will need to be added to the "Additional Routes" table:

• a route for sub-network 155.132.2.0 with the following entries: 155.132.2.0 (Destination), IP
address of router 2 (Gateway), 255.255.255.0 (Mask).

- a route for sub-network 155.132.3.0 with the following entries: 155.132.3.0 (Destination), IP
address of router 1 (Gateway), 255.255.255.0 (Mask).

Configuring the client station

To bring in the OmniPCX LAN services, you have to change the TCP/IP configuration on the client sta-
tions at two levels:

- reconfiguration as DHCP client. This is only necessary where there was no DHCP server on the LAN
beforehand and OmniPCX is configured as a DHCP server. If the client station keeps a fixed IP ad-
dress, then the OmniPCX IP address must be entered as the default gateway;

- Insertion of the domain name and of the OmniPCX IP address as the DNS service.

Exemple : Configuring a Windows 98 client station

1. Right-click the "Network Neighborhood" icon on the Windows desktop.

2. Choose "Properties" from the context-sensitive menu that pops up.

Sub-network 155.132.3.X

Sub-network 155.132.2.X

Router 1

Router 2

Sub-network 155.132.1.X

ISP

OmniPCX
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3. Click the "Configuration" tab in the "Network" window.

4. Double click on "TCP/IP -> Ethernet controller" in the list for "The following network components
are installed". This calls up the "TCP/IP Properties" window.

5. Modify the settings as shown below.

6. Close the windows by clicking "OK".

7. Reboot the computer to register the modifications.

Select this option if the PC
is a DHCP client1. Enter the OmniOffice IP address 

2. Click "Add" 

3. The IP address appears in the list
of installed gateways 

Select this option to configure
the DNS

Enter the domain name as
configured in OmniOffice Enter the PC host name 

1. Enter the OmniOffice IP address 
2. Click "Add" 

"Gateway" tab "IP Address" tab

"DNS Configuration" tab
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SECURITY
DESCRIPTION

As OmniPCX Office is the gateway between the company LAN and the Internet, it has to guarantee 
Internet access for LAN users while protecting all machines on the LAN from external intrusion. It is for 
this purpose that it incorporates the firewall and NAT (Network Address Translation) features described 
below.

FIREWALL

The OmniPCX Office integrated firewall works on the principle of packet filtering. As packets enter the 
system, they are filtered by type, source, destination and port (as declared in each packet) and are only 
authorized to leave the system if the firewall rules allow.

If the firewall is active, these rules are generated automatically when Internet access is first configured, 
and subsequently each time one or more security parameters are modified according to the following 
criteria:

- Contents of the software key (for example, if the proxy software key is present, it will be impossible
to access the Internet or download a file without going through the proxy).

InternetInternet
Firewall

NATOmniPCX Office

LAN
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- Certain Internet access configuration options:

• OmniPCX Office used as mail server (or not);
• Explicit authorization of an application or protocol (cf. <Protocol Control>);

- Authorization or refusal of Internet access on the basis of the user's "position" in the local
network (cf. <Services Access>).

NAT (Network Address Translation)

Definition: 

- NAT is a mechanism devised to palliate the shortage of web addresses. It enables a group of com-
puters in a local network to access the Internet using a single IP address, in this case that of Om-
niPCX Office, which makes it appear as the only system using the Internet connection.

Remarque : OmniPCX Office only has one official IP address at any given moment – the one provi-
ded by the currently active ISP. The correlation of addresses in the NAT process is the-
refore always of the type: n local addresses to 1 public address.

How it works:

- Computer X is instructed that OmniPCX Office is its default gateway.

- When a packet arrives in OmniPCX Office from X, it is assigned a new port number, and the Om-
niPCX Office IP address is declared in the packet header, without overwriting the original header.
The modified packet is then sent to the Internet via the PPP interface.

- When a packet arrives in OmniPCX Office from the Internet, if the port number is one of the num-
bers assigned in the preceding stage, then the header is again modified to restore the original port
numbers and IP addresses, and the packet is passed on to machine X.

Advantages:

- flexibility in the private address plan of the LAN;

- the shared use of a single public IP address for any number of private addresses in the LAN;

- tighter security by using only one IP address that can be identified on the Internet.

Restrictions:

These are of two kinds:

- An OmniPCX Office user (see User Management) is an Internet service client.

In this case certain protocols are incompatible with NAT, either because they make use of the port 
numbers or because they encode IP addresses. The table below lists applications or protocols and 
their compatibility with NAT.
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- A computer on the local network hosts a service for clients on the Internet (i.e. acts as a web server).

The way NAT works rules out this kind of topology. However, thanks to OmniPCX Office's port 
forwarding functionality, a mail server and/or a VPN server can be hosted on the local network (by 
forwarding the SMTP and/or PPTP ports respectively). This functionality is activated automatically 
whenever one of these servers is declared (see the sections on e-mail and VPNs). With the current 
version of OmniPCX Office it is not, however, possible to host a web server on the LAN that is ac-
cessible from the Internet. 

Application/Protocol Functionality Supported

Archie FTP search Yes

FTP Download file Yes

Gopher Web search in text mode Yes

Http Web search Yes

Nntp/snews Discussion Yes

Ping Access host name Yes

POP3/IMAP4 Receive mail Yes

SMTP Send/Receive mail Yes

Ssh Secure Telnet/FTP Yes

Telnet Remote connection Yes

Traceroute Internet routing Yes

Vrml 3D web modeling Yes

Wais Database search Yes

Windows Media Player Audio/Video Yes

RealG2 Audio Yes

H323 applications Internet telephony No

Netscape Cooltalk Internet telephony No

IRC Discussion No

VDOlive Video No

Winamp Audio No

ICQ Communication No
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CONFIGURATION

The configuration for the firewall is done using the Settings -> Security menu. 

- Main tab:

• Firewall

Choose Enable to activate the firewall (default setting), and Disable to deactivate it. If the fi-
rewall is deactivated, any packets transiting over OmniPCX Office will no longer be filtered. Ac-
cess to OmniPCX itself, however, remains protected, and only the explicitly configured services 
will be accessible (Mail, VPN, DNS): all the others (Telnet, FTP, etc.) remain prohibited.

• NAT

Choose Enable to activate NAT (default setting), and Disable to deactivate it. This service can 
be disabled if the local network computers that you want to use for Internet access have their 
own official IP addresses, or if the service is hosted by the ISP. 

• Services Access

Services access discriminates between users on the basis of their situation on the enterprise 
computer network, and the type of service they request.

- Situation on the network:

Users accessing OmniPCX Office directly (from the Subnet) are distinguished from those ac-
cessing it through a router. 

Subnet OmniPCX

Intranet

ISP
Internet

Subnet 155.132.1.X

Router 2

Router 1

Subnet 155.132.2.X

Subnet 155.132.3.X
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The data for defining the user situation are located in the computer's network parameters; 
if the default gateway is not declared, or if it corresponds to OmniPCX Office, then the user 
is in the Subnet.

- Type of service requested:

The configuration of Internet access is distinguished from the other services provided by 
OmniPCX Office (web browsing, messaging, etc). 

On the "Configuration" line, click the Intranet button (default setting) to authorize Internet access 
administration from all the computers in the company, or click Subnet to restrict the service to 
the computers in the sub-network to which OmniPCX Office belongs. Proceed in the same way 
on the "Services" line for all the other services.

• Protocol Control

If the firewall is activated, all the protocols will be prohibited except those listed in the table be-
low, which can be authorized or prohibited by the Internet access administrator.

Service Filtered protocols default

Web access HTTP, HTTPS, Gopher authorized

File transfer FTP authorized

Multimedia Realg2 not authorized

News NNTP, snews not authorized

Remote connection Telnet not authorized

Messaging SMTP, POP3, IMAP4 authorized if OmniPCX 
Office is the mail server
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PROTOCOLS AND PRINCIPLES OF FILTERING

The table below presents the protocol filtering possibilities, depending on the OmniPCX Office confi-
guration.

It sets out the options for inhibiting or allowing a particular protocol, as a function of the services pre-
sent in OmniPCX Office.

Exemple : A client wants to inhibit the Real Audio Player protocol. 

This protocol is one of those supported by NAT; its filtering principle depends on the fi-
rewall alone.

If the firewall is active, the Security->Protocol Control [Multimedia] box must not be 
checked; if it is inactive, the client cannot inhibit this protocol.

protocols/applications Firewall 
activated?

Proxy

present?

Omni-
PCX Offi-
ce = mail 
server?

NAT

activated?

Filtering principles

M
essaging

SMTP

POP3

YES """"""""""""""" """"""""""""""" """"""""""""""" Depends on configuration

Security->Protocol Con-
trolMail

NO """"""""""""""" YES """"""""""""""" Depends on configuration

Security->Protocol Con-
trol

Mail

NO """"""""""""""" Authorized protocols
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Internet navigation and

HTTP

HTTPS

Gopher

FTP

VDOLive(http)*

ICQ(http)*

Winamp(http)*

YES """"""""""""""" """"""""""""""" """"""""""""""" Depends on configuration

Security->Protocol Con-
trol

Web access

(HTTP, HTTPS, Gopher)

File Transfer

(FTP)

NO YES """"""""""""""" """"""""""""""" Depends on configuration

Security->Protocol Con-
trol

Web access

(HTTP, HTTPS, Gopher)

File Transfer

(FTP)

NO """"""""""""""" """"""""""""""" Authorized protocols

protocols/applications Firewall 
activated?

Proxy

present?

Omni-
PCX Offi-
ce = mail 
server?

NAT

activated?

Filtering principles
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""""""""""""""" The functionality (columns) has no effect on the filtering of the protocols concerned (rows).

protocols supported by N
A

T

Archie

NNTP

Ping

IMAP4

SSH

TELNET

TRACEROUTE

VRML

WAIS

Real Audio Player

Wds Media 
Player

YES """"""""""""""" """"""""""""""" """"""""""""""" Some protocols depend on 
the configuration

Security->Protocol Con-
trol

Multimedia

(Real audio player, Win-
dows Media Player)

News

(NNTP)

Remote Connection

(SSH, TELNET)

Mail

(IMAP4)

The other protocols are not 
authorized

NO """"""""""""""" """"""""""""""" """"""""""""""" Authorized protocols
protocols not

H.323

IRC

Netscape Cool-
Talk

VDOLive

ICQ

Winamp

YES """"""""""""""" """"""""""""""" """"""""""""""" Unauthorized protocols

NO """"""""""""""" """"""""""""""" YES Unauthorized protocols

NO Authorized protocols

Other protocols

YES """"""""""""""" """"""""""""""" """"""""""""""" Unauthorized protocols

NO """"""""""""""" """"""""""""""" YES To be tested

NO Authorized protocols

protocols/applications Firewall 
activated?

Proxy

present?

Omni-
PCX Offi-
ce = mail 
server?

NAT

activated?

Filtering principles
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 * Protocols used on top of HTTP (streaming).

To prohibit these protocols without affecting Internet navigation, you have to use the URL control 
principle provided by the proxy (see section on proxy -> configuration) by adding an appropriate 
rule to the "Control List" in the "Proxy/Cache Settings" menu.

For example, the rule "http://*\.ext" will block the consultation of links corresponding to files with 
the extension ".ext".

The extensions for the main streaming applications are:

Windows Media Video: asf asx wmv wvx
Windows Media Audio: wma wax
Real Audio/Video: ra rm ram rmm rnx rv
Quicktime: qts qtx mov qt
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PROXY
INTRODUCTION

A proxy server is an application that gathers requests from client stations and passes them on to a re-
mote server. The remote server's response is then relayed back to the local PCs. Because these servers 
handle communications, they are in a position to provide a number of services:

- they can record everything they do, with a view to compiling statistics on user access.

- they can filter access on the basis of the content of requested URLs.

- they can filter previously connected users.

- Proxy servers can also handle caching: i.e. storing the most recently downloaded or used files on
a local disk for easier availability. This means a file need only be downloaded once from a web
site, and can then be transferred locally at much greater speed in response to identical requests.
The main advantage lies in reducing traffic to and from the Internet, and therefore the connection
costs incurred by Alcatel OmniPCX.

Remarque : Where the proxy license is available, the web access (HTTP, HTTPS and Gopher) and file 
transfer (FTP) services are obliged to go through the proxy.

Description

Alcatel OmniPCX includes a HTTP and FTP proxy server with all the features described in the introduc-
tion.

- User control

Prior to each Internet connection, the user is asked for an account identifier and password; the ac-
count is associated with certain web access rights (see User Management). If user control is active, 
then accounts without the necessary rights will be rejected. An Internet navigation session is defined 
by the launch of a browser (Internet Explorer, Netscape Navigator), access to one or more web 
sites, and the closure of the browser. In sessions like these, the user account and password will be 
requested when the first web site is accessed.

- URL control

If URL control is active, there are two alternatives:

• Authorizing access to one or more sites specified in a list, and to no others. If the list is empty,
then Internet navigation (http) and file transfers (ftp) will be impossible. 

- Blacklisting certain URLs by indicating, for each list entry, either a complete name or a character
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string within the name.

• Connection statistics: Alcatel OmniPCX provides a tool to enable the Administrator to get an
overview of Internet activity and, using log file data, to compile statistics for a range of criteria,
namely users, services and destinations. These statistics describe web access in terms of: 

- users: statistics on Internet use

- services used: statistics on the traffic for each service (HTTP or FTP)

- web sites: the list of web sites visited.

Nota : Access Control is only possible when the proxy option is selected

CONFIGURATION

The proxy is configured from within the Settings -> Proxy/Cache menu. There are two tabs:

- Main tab

• Proxy Port Number: the port number to which the http and ftp requests from the client stations
are sent. The default number is 8000.

• Properties: 

- User authentication required for web access

To activate the service, check the corresponding box.

If the service is activated, a username (login) and associated password will be requested at 
the start of each web browsing session. The required names and passwords are input when 
users are created (see User Management).

- URL Control List

To activate the service, check the corresponding box.

If the service is activated, access is controlled in accordance with the settings in the Control 
List tab.

- Control List tab: 

• Control Policy: there are two control strategy options:

- Forbidden: authorizes all sites except those containing character strings that match the re-
gular expressions in the "List of RegExp". Regular expressions may contain:

- alphanumeric characters;

- wildcards: these characters stand for other characters or strings:

- represents any character;

- .* represents a string of from 0 to n characters;
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- + represents a string of from 1 to n characters;

- ? represents 0 or 1 character.

- Authorized: blocks all sites except those corresponding to the URLs in the "List of URLs"

E.g. www.alcatel.com

CONFIGURING THE CLIENT STATION

Using the Alcatel OmniPCX proxy features calls for some configuration of the web browser on the client 
stations.

The browser needs to be instructed that http and ftp requests are to be sent to the proxy: to this end, it 
is given the IP address of the proxy server (the OmniPCX IP address, on the LAN side) and the destina-
tion port number, which must correspond to the one entered in OmniPCX (Settings -> Proxy/Cache 
-> Main -> Proxy Port Number).

Internet Explorer configuration example

After launching Internet Explorer, the proxy settings can be reached by opening the Tools -> Internet 
Options  menu and clicking on  LAN Parameters  in the Connections tab. Check "Use Automatic 
Configuration Script" and enter the following address in the Address field:

- http://<@CPU_IA>/proxy.pac

<@CPU_IA> represents the IP address or the name of the Internet Access CPU.

Exemple : http://192.168.92.247/proxy.pac

or

http://iaccess.company.world/proxy.pac

The default name for the IA CPU is iaccess.<domain_name>.
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USER MANAGEMENT
Introduction

In Alcatel OmniPCX Office, users are defined by an account name or "login" and its associated pas-
sword. The login and password are in a very real sense the user’s ID card, and will be asked for in the 
following circumstances:

- By the e-mail server, in order to enable the user to collect mail from his local mailbox;

- By the proxy, if configured to require authentication (see Proxy chapter), in order to clear the user
for Internet access;

- By the PPTP server, if the user wants to access the local network via the Internet (see VPN chapter);

- On each access to OmniPCX, in order to enable the user to modify certain account settings.

Configuration

Creating users

The various input fields – in the order in which the configuration screens appear – are as follows:

• First Name: the user's first name (optional)
• Last Name: the user's last name
• Password: the user's password.
• Confirm Password: the user's password again.

The account name (login) thus created will be:

- <First Name>.<Last Name> if the First Name field is not empty.

- <Last Name> if the First Name field is empty

the user created can be either a standard user or an administrator. Administrators have wider-ran-
ging rights in terms of access to OmniPCX Office configuration.

- by WBM: Wizards -> User, Main Properties tab 

-  Identification field 

-  User Type field 
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This tab only appears in the POP3 mail caching configuration (see E-Mail chapter). The correspon-
ding parameters Identification, Password, E-mail Address enable OmniPCX Office to access 
the POP mailbox at the ISP.  They are provided by the ISP when the user account is created. The 
identification and e-mail address are sometimes mixed up; in this case, fill in both fields with the 
available information. 

• Internet Access: this field enables Internet access control if the authentication request function
is active in the proxy (see Proxy chapter). If this box is checked, then the user can access the web
sites authorized by the proxy filters (see "Proxy/Cache"). Some users, however, can override the-
se filters to gain unrestricted access to all web sites by using an additional parameter accessible
from the user administration interface described below.

• Mail Vacation: If this box is checked, then the user can employ the mail vacation service. This
service consists in sending a message to anyone trying to contact the user in the latter's absence;
it can only be activated by the user him or herself via their own WBM.

• E-Mail Forwarding: If this box is checked, then the user can employ the service that transfers
mail automatically to another mailbox. This service is implemented by the users themselves. 

- Remote Worker: users can connect to OmniPCX Office from a mobile terminal, establishing
a VPN tunnel to the local network via the Internet.

User administration

The first screen lists all the users created in OmniPCX Office; users can be modified or deleted. 

Once a user has been selected from the list, a number of tabs are available for modifying or extending 
the user data.

Remarque : This tab is also accessible from the users' WBM.

All the settings entered when the user was created can be modified; the account name cannot, howe-
ver, be modified by the user him or herself: only the administrator has the right to do so.

Remarque : Only available in POP3 caching configuration, this tab is also accessible from the users' 
WBM

-  POP3 Account field 

-  Rights field 

- by WBM: Administration -> Users

-  Main tab

-  POP3 tab 
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The details of the POP3 account with the ISP can be entered or modified as described in the Creating 
Users section.

For modifying the rights specified when the user was created (see Creating Users). Additionally, the 
administrator can grant Internet access to the user in such a way as to override the URL check perfor-
med by the proxy (see Proxy Management) by using Internet Access: YES without URL checking.

Remarque : For this parameter to be operational, user authentication has to be active at proxy level; 
otherwise URL checks will apply to every Internet access. 

Remarque :  This tab is also accessible from the users' WBM.

For entering the absence message, consisting of a title (subject) and the content (text). For the mes-
sage to be sent, the service must be authorized by the administrator (see rights in the Creating Users 
section) and activated by the user or administrator via this tab.

Remarque :  This tab is also accessible from the users' WBM.

For entering the e-mail addresses to which mail for the user is to be sent on; a copy can be kept at the 
user's base address. This service needs to be authorized by the administrator (see rights in the Creating 
Users section) and activated by the user or administrator via this tab.

-  Rights tab 

-  Absence tab 

-  Forward tab 
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ELECTRONIC MESSAGING 
INTRODUCTION

Alcatel OmniPCX Office is used to offer an electronic messaging solution for all users in a company. 
To do this, it supports various configurations:

- it can be the company's messaging server,

- it can be integrated into the company network if it already has a messaging server, or 

- it can facilitate access to an external messaging server.

These various possible configurations are described below:

PRINCIPLES OF OPERATION

Case 1 : ALCATEL OMNIPCX OFFICE IS THE MESSAGING SERVER

Alcatel OmniPCX Office makes available to each user a local letter box, and manages the flow of mes-
sages between users of the local network and those to and from the Internet. The protocols used by 
this server are SMTP, to send messages, and POP3, to manage mail boxes.

Two possibilities must be considered:

- POP3 subscription: the IAP stores the mail messages (POP3 accounts),
- SMTP subscription: the IAP does not store the mail box.

1 - POP3 SUBSCRIPTION: THE IAP STORES THE MAIL MESSAGES (POP3 ACCOUNTS)

Each user has available:

- a private mail box with the IAP, 
- a mail box on Alcatel OmniPCX Office (local).

It is Alcatel OmniPCX Office messaging server that downloads the mail to the local mail boxes for each 
IAP connection or at pre-defined time intervals. 

This principle, called POP3 caching, is used to optimise connections to the IAP: a user is not authorised 
to access his mail box directly with the FAI (since this would automatically create a connection), he has 
access only to his local mail box.

For the description of the available Email addresses (Stand alone, PO3 or SMPTP subs-
cription), see the ANNEX 2 at the end of this file.
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In addition to private mail boxes for each user, the IAP can also store a default mail box.  This box, 
which is optional, receives all the mails for an addressee who does not have a private mail box. Alcatel 
OmniPCX Office retrieves the contents of this mail box and distributes it to different local mail boxes 
depending on the addressee. This function is called Multidrop.

Nota : Refer to case 1 - B of the Using the E-mail Assistant section

The mode of operation is as follows:

• Outgoing mail

The mail sent by a user is "entrusted" to Alcatel OmniPCX Office that sorts it in accordance with the 
following criteria:

• If the recipient's e-mail address corresponds to an address linked to a local user, the message
is deposited in the addressee's local mail box.

- In all other cases, the message is stored temporarily in Alcatel OmniPCX Office, then sent du-
ring the next connection or by default, at time intervals pre-defined in the Configuration -
>Email [Main tab] menu, the Activity field of the mail.

• Incoming mail

The mail deposited in the mail boxes with the IAP(user letter boxes or default letter boxes) is retrie-
ved by Alcatel OmniPCX Office during the first connection following the depositing operation, or a 
pre-defined time intervals (as described above), and routed to local mail boxes. Each user will then 
be able to retrieve his mail in Alcatel OmniPCX Office.

Important : The type of connection can be "on demand", "on demand with callback" or "permanent". 
Alcatel OmniPCX Office's IP address can be static or dynamic.

LAN INTERNET

Users

OmniOffice ISP server

Periodic
exchanges
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2 - SMTP SUBSCRIPTION:  THE IAP DOES NOT STORE MAIL BOXES

Mail boxes exist exclusively in Alcatel OmniPCX Office, and mail intended for users must be deposited 
directly in these boxes. 

In the case of a non-permanent connection, this procedure is not possible for mail coming from the 
Internet without an additional service to store messages temporarily. This service, that is available for 
a large number of FAI, is called "SMTP relay".

Two possibilities must be considered depending on whether the IAP provides the SMTP relay service or 
not:

SMTP relay service provided by the IAP 

Nota :  Refer to case 1 - A - a of the section on Using the E-mail Assistant

The mode of operation is as follows:

• Incoming mail

The SMTP relay service consists of temporarily storing messages intended for Alcatel OmniPCX 
Office users in a queue, then transferring them to local mail boxes as soon as the connection 
is established, or on explicit request from Alcatel OmniPCX Office by virtue of the ETRN (Exten-
ded Turn) command.

INTERNET

LAN

OmniPCX

Users

ISP server

Transmission on connection

Job queue

Direct transmissio
n if connection established

Smart hosting

Dire
ct tra

nsm
issi

on
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Nota : If the ETRN box has been checked, this command will be sent to the IAP's SMTP server 
whenever a connection is made (on expiry of the "mail activity" time or voluntary con-
nections). The command will be ignored by the IAP in principle if the latter does not 
provide this service.

• Outgoing mail

Outgoing company mail and mail intended for the Internet can also be relayed by the IAP SMTP 
server, and this service is called “smart hosting”. 

Nota : "Smart hosting" is accepted by most IAPs, and it is preferable initially to apply it sys-
tematically (check the "smart hosting" box) and to run the messaging configuration 
test.

Important : The type of connection can be "on demand", "on demand with callback" or "permanent". 
Alcatel OmniPCX Office's IP address must be static. The company must have its own do-
main name.

No SMTP relay service provided by the IAP (direct SMTP connection)

Nota :  Refer to case 1 - A - b of the section on Using the E-mail Assistant

Alcatel OmniPCX Office is the main messaging server, the mail from the Internet is deposited di-
rectly into the users' mail boxes.

Important : The type of connection must be "permanent". Alcatel OmniPCX Office's IP address must 
be static. The company must have its own domain name.

LAN

Omni Office

INTERNET

Users
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Case 2 : A MESSAGING SERVER EXISTS ALREADY ON THE LAN

If the company is connected to the Internet via Alcatel OmniPCX Office, it is used as the gateway 
between the LAN and the Internet for the exchange of messages. The firewall allows use of the SMTP 
protocol when sending and receiving (see security chapter).

Important : The type of connection can be "permanent", "on demand" or "on demand with callback". 
Alcatel OmniPCX Office's IP address can be static or dynamic.

Case 3 : THE MESSAGING SERVER IS HOSTED ON THE IAP.

There is no messaging server in the company. The messaging server is hosted by the IAP.

Alcatel OmniPCX Office is used as the gateway between LAN and Internet. The firewall allows use of 
the SMTP, POP3 and IMAP4 protocols (see security chapter).

If the connection to the IAP is on demand, a connection will be established whenever a message is sent 
and whenever the mail box is consulted.

Users

LAN
INTERNET

OmniOffice ISP server
Ed. 04 5/18Réf. 3EH 21000 BSAA



ELECTRONIC MESSAGING E-SERVER : INTERNET APPLICATIONS

 

PROPOSED SERVICES

When Alcatel OmniPCX Office is the messaging server, the three following services are available:

- alias management,

- multi-domain management,

- routing to external users.

Alias management

This service is used to provide several recipient names per user.

When Alcatel OmniPCX Office receives messages, a recipient name / mail box correspondence table 
allows the messaging server to distribute the messages to suitable local mail boxes. For each local mail 
box this correspondence table contains the various recipient names that can be used to reach it.

This service is available:

- as an SMTP subscription, either with or without the SMTP relay service,

- as a POP3 subscription, only if the IAP hosts a default mail box and if Alcatel OmniPCX Office has
multidrop management enabled.

Multi-domain management

This service is used to manage several domain names for the same company. A main domain name 
and one or more secondary domain names are defined in the IAP and in Alcatel OmniPCX Office. 

This service is available irrespective of the chosen subscription (POP3 or SMPT). 

- as a POP3 subscription: the messages are sorted in the iap and directed to the user mail boxes
hosted on the IAP The messages are then sorted when Alcatel OmniPCX Office retrieves them and
forwards them to the local mail boxes. 

- as a SMPT subscription: Alcatel OmniPCX Office sorts the messages when received; all messages
whose address includes a pre-defined domain name (main or secondary) are accepted, and routed
to users' local mail boxes. 
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Routing to external users

When Alcatel OmniPCX Office is the messaging server, it is possible to define uses as “remote wor-
kers”.  These users have a personal mail box stored with the IAP, but they do not have a local mail box 
on Alcatel OmniPCX Office.

The mail intended for them is routed as follows:

- mail from the company

Alcatel OmniPCX Office recognises the address and routes the message to the IAP. The mail is sto-
red in the remote user's personal mail box in the IAP, and is retrieved by the remote worker when 
he logs onto the IAP server.

- Mail from the Internet

The mail is stored in the remote user's personal mail box in the IAP, and is retrieved by the remote 
worker when he logs onto the IAP. This mail is not retrieved by Alcatel OmniPCX Office.

This service is available only in the case of a POP3 subscription: 

CONFIGURATION 

Configuration needs two stages:

- configuration of Alcatel OmniPCX Office

- configuration of client terminals 

Prerequisites

The information needed to install the messaging server varies accordance to the configuration to be 
selected. Generally speaking, the parameters to know in relation to the IAP are as follows:

- Name of the POP3 server: server that hosts the mail boxes (POP3 accounts).

- Name of the SMTP server: server tasked with sending mail.

- Passwords of the POP3 accounts: each mail box (POP3 account) created in the IAP is password
protected. Alcatel OmniPCX Office uses this password to download the mail before distributing it
to users. 

- Support for ETRN commands functionality supported by the IAP or not.

- Domaine names: these domain names can be private (used internally only) or public (filed and re-
gistered with the authorities that manage the Internet domain names).

Configuration of Alcatel OmniPCX Office

Alcatel OmniPCX Office is configured using two menus:

- Assistants --> E-mail: to make the e-mail settings,
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- Assistants --> E-mail: to refine the setting of the parameters entered by the e-mail assistant (ad-
vanced configuration),

- Assistants --> User: to set parameters for the user accounts,

- Administration --> Users: to refine the parameters set for the user accounts (advanced configura-
tion),

- Administration --> distribution lists: to create and set the parameters for the distribution lists.

Using the E-mail assistant

the following figure shows this assistant along with the parameters to be entered in accordance with 
the different ways of configuring Alcatel OmniPCX Office.

Notas : The rectangles correspond to the choices to be made for configuration, the rounded rectan-
gles correspond to the data to be entered.

- using WBM: Assistants --> E-mail:
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Advanced e-mail configuration:

This menu is used to return to the parameters entered when configuring the messaging system via the 
assistant. The additional configurable parameters are:

- "Main" tab, "Domain name" field:

this field is used to define several domain names for e-mail accounts managed by Alcatel Omni-
PCX Office. The main domain name is entered in the "Main"field. The secondary domain names 
are listed in the "List of names" field.

To add a domain name, enter the new name in the "New name " field and click on the "Add" 
button. To delete a domain name, select the name to be deleted from the "List of names " field 
and click on the "Destroy" button.

- "Main" tab, "Mail activity"field: 

This field corresponds to the connection frequency (in minutes) used to send and retrieve electronic 
messages.

- "Access" tab, "Envelope Field" field

In the case of a POP3 subscription with Multidrop option, Alcatel OmniPCX Office needs to know 
which enveloped field is being used. Alcatel OmniPCX Office uses the default parameter X-Enve-
lope-To. If a different parameter is used, select the "Other" option and enter the parameter in the 
adjacent text entry area.

Nota : The IAP must provide the parameter used. If this should happen, you can send a mes-
sage to a mail box using the default account, and consult the message header to find 
the parameter used.

- "Message" tab, "Welcome message " field 

As soon as a new mail box is created, a welcome message, the subject and body of which can be 
modified, is sent to the relevant user.

Using the User Assistant 

The User Assistant is used to create all local e-mail accounts when Alcatel OmniPCX Office is the mes-
saging server.

The following figure shows this assistant and the parameters to be entered in relation to the choices 
made.

- using WBM: Configuration --> E-mail

- using WBM: Assistants --> User:
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Notas : The rectangles correspond to the choices to be made for configuration, the rounded rectan-
gles correspond to the data to be entered.

User advanced configuration 

This menu is used to return to the parameters entered when configuring the messaging system via the 
assistant. The additional configurable parameters are:

- "Alias" tab, "Alias " field:

This field is used to enter all the aliases that can be used for a user account, i.e. all the addresses 
that can be used to reach the same user account. All the aliases defined for the user are listed in 
the "List of aliases" field.

To add an alias, enter the new name in the "New alias " field and click on the "Add" button. To 
delete an alias, select the alias to be deleted from the "List of aliases " field and click on the "Des-
troy" button.

Distribution list management

Once the user and the messaging accounts have been created, Alcatel OmniPCX Office is used to 

- using WBM: Administration --> Users:
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create and manage the distribution lists. A distribution list holds several electronic addresses under the 
same name, which allows users to fill in the name of the list as the recipient of a message (name of a 
service for instance), rather than having to fill in all the addresses of the individuals concerned.

Using this menu, the administrator has the facility to create and manage distribution lists. It is then 
possible to add, delete or modify one or more existing distribution lists. During the operations and for 
the purpose of ergonomics, Alcatel OmniPCX Office displays the entire list of users held both on the 
system and in the distribution list being looked at, along with their related electronic address.

Nota : When electronic messages are sent to a distribution list, the name of the distribution list de-
fined in Alcatel OmniPCX Office has to be entered in the "Recipient" field. The system then 
replaces the list with persons involved, and sends the message to these persons. The user 
needs to know the name of the distribution lists entered in OmniPCX Office, because he 
does not have direct access to this list from his workstation.

Configuration of the client terminal

The messaging client present on the client terminal (Messenger, Eudora, Outlook, Exchange, etc ...) 
must be configured to allow the LAN user to send and receive electronic messages from his PC.

Three possibilities can be considered in relation to the topologies encountered:

- Alcatel OmniPCX Office is the messaging server for the client terminals. In this case, the messaging
client must be configured in order to include Alcatel OmniPCX Office as the POP3 and SMTP server.

- There is already an internal messaging server for the client terminals of the LAN. In this case, there
is no need to re-configure the client terminals. Only the messaging server will need to be re-confi-
gured in order to talk to Alcatel OmniPCX Office and to send or receive electronic messages to and
from the outside.

- The IAP is the messaging server, Alcatel OmniPCX Office is only a gateway. In this case, the mes-
saging client must be re-configured to include the IAP's POP3 and SMTP servers together with the
POP3 account of the user and his password.

- using WBM: Administration --> distribution list:
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ANNEX 1 : SUMMARY OF THE DIFFERENT CONFIGURATIONS 
SUPPORTED

Case 1: Alcatel OmniPCX Office is the messaging server

POP3 subscription: the IAP stores the mail messages (POP3 accounts)

Protocol supported in this configuration:

Is an e-
mail server 

software 
key requi-

red?

Type of Internet 
connection that can 

be used

IP address required E-mail services required from the 
IAP

Comments

YES - Demand Dial
- Callback
- Permanent

- Dynamic
- Static

Hosting of electronic messaging with 
POP3 accounts customised for 
users, and possibly a default ac-
count (multidrop).

The company can have its own do-
main name (company.com) or can 
use the IAP's (IAP.com) 

If the company does not have its 
own domain name (company.com) 
and uses the IAP name (IAP.com):

- it is not necessary to fill in the
"domain name" field in the e-
mail creation assistant or in the
mail configuration parameters.

- The “POP3 account” field has
to be completed for every user
by specifying the domain name
of the IAP (for example jo-
hn.smith@IAP.com).

ALCATEL OMNIPCX
OFFICEE-MAIL CLIENTS ISP/INTERNET

SMTP SMTP

POP3 POP3
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SMTP subscription: the IAP does not store mail boxes

The company uses an SMTP messaging relay service

Protocol supported in this configuration:

The company does not use an SMTP messaging relay service

Protocol supported in this configuration:

Is an e-
mail server 

software 
key requi-

red?

Type of Internet 
connection that can 

be used

IP address required E-mail services required from the 
IAP

Comments

YES - Demand Dial
- Callback
- Permanent

- Static SMTP electronic messaging relay 
service.

The company must have its own do-
main name. 

If the IAP does not provide an SMTP 
messaging relay service for 
outgoing company messages 
("smart hosting"), the ISP SMTP field 
must not be completed in the assis-
tant or in the mail configuration pa-
rameters.

If the IAP does not provide a messa-
ging relay service using the ETRN 
option, the corresponding field must 
be completed in the assistant or in 
the mail configuration parameters.

Is an e-
mail server 

software 
key requi-

red?

Type of Internet 
connection that can 

be used

IP address required E-mail services required from the 
IAP

Comments

YES - Permanent - Static The company must have its own do-
main name.

There is no help for incoming traffic 
if the line or the system are tempora-
rily out of order.

ALCATEL OMNIPCX
OFFICEE-MAIL CLIENTS ISP/INTERNET

SMTP SMTP

POP3 SMTP

ALCATEL OMNIPCX
OFFICEE-MAIL CLIENTS INTERNET

SMTP SMTP

POP3 SMTP
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Case 2: A messaging server exists already on the LAN

Protocol supported in this configuration:

Case 3: The messaging server is hosted on the IAP.

Protocol supported in this configuration:

Is an e-
mail server 

software 
key requi-

red?

Type of Internet 
connection that can 

be used

IP address required E-mail services required from the 
IAP

Comments

NO - Demand Dial
- Callback
- Permanent

- Dynamic
- Static

If they depend on the e-mail server 
used in the company then the IAP 
services supported by Alcatel Omni-
PCX Office in this configuration are: 

- Hosting of POP3 or IMAP4 ac-
counts

- SMTP messaging with or wi-
thout relay service

If the company uses an SMTP mes-
saging relay in its own IAP, the "smtp 
relay" field must be checked,.

Is an e-
mail server 

software 
key requi-

red?

Type of Internet 
connection that can 

be used

IP address required E-mail services required from the 
IAP

Comments

NO - Demand Dial
- Callback
- Permanent

- Dynamic
- Static

Hosting of electronic messaging with 
as many POP3 or IMAP4 accounts 
as users.

SMTP

POP3 or IMAP4

SMTP

SMTP

OR

ALCATEL OMNIPCX
OFFICEE-MAIL SERVER

ALCATEL OMNIPCX
OFFICEE-MAIL SERVER

SMTP

POP3 or IMAP4
ALCATEL OMNIPCX

OFFICEE-MAIL CLIENTS
Ed. 0414/18 Réf. 3EH 21000 BSAA



File
7

ELECTRONIC MESSAGINGE-SERVER : INTERNET APPLICATIONS

 

ANNEX 2 : SUMMARY OF THE AVAILABLE EMAIL ADDRESSES

This annex present a summary of available Email addresses when Alcatel OmniPCX Office is 
the messaging server (cas 1).

Terminology

- User part: The user part is usually a person's name. The user part may be more than one string,
such as john.smith. It could be also the name of a department, a team like team.research, an of-
fice, etc..

- Domain part: For Alcatel, "alcatel.com" is the "domain_part" in the address, and .com  is the do-
main. The domain part tells you the Internet address of the company, and may be more than one
string, such as "research.alcatel.com". ".com", the last part of the address, tells more about what
kind of institution the address belongs to, or what part of the world it's from. For instance :

• ".com" is usually a company or commercial institution
• ".gov" means government site 
• ".net" gateways and other administrative hosts for a network
- ".org" private organizations who don't easily fit into other categories

- Internal_domain_name: It is the name of the internal network (LAN) of the company.

- External_domain_name:  It is the name of the private domain(s) of the company bought at an
ISP/ASP.

- ISP_domain_name: The company hasn't bought a domain name part. The ISP defines the domain
part. Very often, the domain name part corresponds to the name of the ISP. For example Wanadoo
uses "wanadoo.fr" in France and the user John SMITH will have for email address "john.smith@wa-
nadoo.fr".

- User’s login: The login of an Alcatel OmniPCX Office account is built with the first name and the
surname of the user.The login has the form: first_name.surname. Example: the Alcatel OmniPCX
Office account login for JHN SMITH is "john.smith".

- User’part of a POP3 email address:

• User managed on Alcatel OmniPCX Office: The user has a POP3 account on the ISP email
server. An email address is associated to this account with the format
"user_part@domain_part". Most of time, the ISP's administrator could configure the user_part
and uses the convention "first_name.surname". 

- External user: External users are only available if the Alcatel OmniPCX Office email server
mode is configured in POP3. An external user has his private POP3 mailbox by the ISP/ASP.
Alcatel OmniPCX Office doesn’t manage this mailbox (this mailbox is not polled by the Al-
catel OmniPCX Office email server). The user part of the external user's email address should
be in accordance with the address defined by the ISP/ASP's administrator.

- User’s alias: Alcatel OmniPCX Office administrator can define for each user, one or more aliases.
An alias is an alternative name for a user. Example: user aliases for "john.smith" could be "jsm",
"johns", "bigboss", etc...
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- mailing list name: A mailing list contains one or more user's login and/or one or more email ad-
dresses. If an email is sent to this mailing list, the message will be broadcast to every member be-
longing to this list. Example: Members of the "team_rd" mailing list: "john.smith", "nicole.kidman",
"mariane.seegelbrecht@end-puretec.de".

User part Email from LAN Email from ISP

STAND ALONE (System without Internet Access)
user login@internal_domain_part not possible

user alias useralias@internal_domain_part not possible

mailing list mailinglist@internal_domain_part not possible

external user not relevant not relevant

SMTP SUBSCRIPTION
user login@internal_domain_part

login@external_domain_part
login@external_domain_part

user alias useralias@internal_domain_part
useralias@external_domain_part

useralias@external_domain_part

mailing list mailinglist@internal_domain_part
mailinglist@external_domain_part

mailinglist@external_domain_part

external user not relevant not relevant

POP3 SUBSCRIPTION WITH PRIVATE DOMAIN NAME PART
user with POP3 
account

login@internal_domain_part
login@external_domain_part
user_part@external_domain_part

user_part@external_domain_part

user without 
POP3 account

login@internal_domain_part
login@external_domain_part

not possible

user alias useralias@internal_domain_part
useralias@external_domain_part

not possible

mailing list with 
POP3 account

mailinglist@internal_domain_part
mailinglist@external_domain_part

mailinglist@external_domain_part

mailing list wi-
thout POP3 ac-
count

mailinglist@internal_domain_part
mailinglist@external_domain_part

not possible

external user receives email vis ISP: 
user_part@external_domain_part

user_part@external_domain_part

POP3 SUBSCRIPTION WITHOUT PRIVATE DOMAIN NAMES
user with POP3 
account

login@internal_domain_part
user_part@isp_domain_part

user_part@isp_domain_part
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user without 
POP3 account

login@internal_domain_part not possible

user alias useralias@internal_domain_part not possible

mailing list with 
POP3 account

mailinglist@internal_domain_part
mailinglist@isp_domain_part

mailinglist@isp_domain_part

mailing list wi-
thout POP3 ac-
count

mailinglist@internal_domain_part not possible

external user receives email vis ISP: 
user_part@isp_domain_part

user_part@isp_domain_part

POP3 SUBSCRIPTION WITH MULTIDROP CAPABILITIES
user with POP3 
account

login@internal_domain_part
login@external_domain_part
user_part@external_domain_part

user_part@external_domain_part

user without 
POP3 account

login@internal_domain_part
login@external_domain_part

login@external_domain_part

user alias useralias@internal_domain_part
useralias@external_domain_part

useralias@external_domain_part

mailing list with 
POP3 account

mailinglist@internal_domain_part
mailinglist@external_domain_part

mailinglist@external_domain_part

mailing list wi-
thout POP3 ac-
count

mailinglist@internal_domain_part
mailinglist@external_domain_part

mailinglist@external_domain_part

external user receives email vis ISP: 
user_part@external_domain_part

user_part@external_domain_part

User part Email from LAN Email from ISP
Ed. 04 17/18Réf. 3EH 21000 BSAA



ELECTRONIC MESSAGING E-SERVER : INTERNET APPLICATIONS

 

Ed. 0418/18 Réf. 3EH 21000 BSAA



8

VPNE-SERVER : INTERNET APPLICATIONS

 

File
VPN
OVERVIEW

A virtual private network is an extension to a private network incorporating one or more public network 
links such as the Internet. These links conserve the characteristics of a private point-to-point link by en-
capsulating data by means of tunneling protocols. Authentication methods are deployed to maintain 
the security of the private network, while the confidentiality of the data transiting over these links is gua-
ranteed by encryption procedures. The idea behind VPNs is to offer companies exactly the same ser-
vices as a private link at far less cost by utilizing a public infrastructure.

Alcatel OmniPCX offers two types of VPN:

- A remote-access VPN connection called "VPN Client to LAN"

- A router-to-router VPN connection called "VPN LAN to LAN"

VPN Client to LAN

Description

The remote user can connect up to the company LAN from fixed or mobile terminals. In this case, the 
user logs on to the Internet via the nearest point of presence and requests the creation of a VPN tunnel 
between his terminal and OmniPCX.

The protocol for managing this type of VPN tunnel is PPTP (Point to Point Tunneling Protocol), a data 
link layer protocol on the OSI (Open Systems Interconnection) model. The remote user is termed the 
"VPN client" and OmniPCX the "VPN server".

When the VPN client issues a connection request, the authentication protocol, client IP address and 

InternetInternetISP

ISP

 VPN Client

 VPN Client

VPN

Server
VPN

ISP
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data encryption method are all negotiated with the VPN server.

- Authentication

The protocol proposed by OmniPCX is MS-CHAP (Microsoft Challenge Handshake Authentication 
Protocol) version 2. Unless the client can provide this type of authentication, connection will be re-
fused.

- Client IP address

The IPCP (Internet Protocol Control Protocol) negotiation process with the VPN server allocates an 
intranet IP address to the client. This address is configured beforehand in OmniPCX (see "Configu-
ration for OmniPCX”). 

- Data encryption

The data encryption method used by OmniPCX is MPPE (Microsoft Point to Point Encryption) with 
continuous RSA RC4 encoding and 40-bit or 128-bit encryption keys. Connection attempts will be 
rejected if the client cannot use these methods.

- Data tunneling

After data encryption, a PPP header is added to create the PPP frame, which is then encapsulated 
with a modified GRE header (Generic Routing Encapsulation, RFC 1701 and 1702). The resulting 
frame is itself encapsulated with an IP header.

The diagram below illustrates a frame that has been tunneled by the VPN client:

The number of simultaneous connections depends on bandwidth. Alcatel OmniPCX carries out no 
checks on this, but the maximum number of remote connections for a 128-Kbps link should not exceed 
5, otherwise the quality of service will be degraded.

Configuration for OmniPCX

The Client-to-LAN VPN is installed using the Getting Started -> VPN Wizard menu.

IP GRE PPP Encrypted data

IP TCP
UDP Application data

Source = fixed or ISP-allocated public IP address 

Desti = public IP address of the PPTP server 

Source = intranet IP address allocated by the PPTP server

Desti = intranet IP address
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- In Main Properties, select "Client to LAN with PPTP to be a road warrior? " and click Next

- In Client to LAN: (Topology) select OmniPCX as the PPTP server or key in the IP address of another
PPTP server on the LAN, then click Next

-  In Client to LAN: (IP Allocation) enter the range of IP addresses to be allocated to VPN clients and
validate.

The VPN Client to LAN topology can subsequently be consulted and modified in the Settings -> VPN 
- Client to LAN tab. This menu also activates and deactivates the PPTP server. If it is deactivated, all 
VPN tunnel creation requests will be rejected.

The range of IP addresses for VPN clients can be consulted and modified in the Settings -> Network - 
IP Address Allocation tab by selecting the address type Client to LAN.

The VPN client must be declared as an OmniPCX user with the Remote Access option (see User Mana-
gement chapter).

Attention : On the OmniPCX side, the Internet connection type must be "Callback" or "Permanent"

Configuring the client station

VPN LAN to LAN

Description

The idea behind a LAN-to-LAN VPN is to provide a secure connection between two remote sites while 
using a shared or public infrastructure. It utilizes a router-to-router connection on which all packets are 
encrypted and secured using negotiated methods.
Ed. 04 3/10Réf. 3EH 21000 BSAA



VPN E-SERVER : INTERNET APPLICATIONS

 

The tunneling protocol used by OmniPCX is IPSec (Internet Protocol Security, RFC 1825 1826 1827), 
a network layer protocol on the OSI (Open Systems Interconnection) model, which works by encrypting 
IP packets and encapsulating them in an additional IP header before sending them over an IP network.

Configuration

The LAN-to-LAN VPN is installed using the Getting Started -> VPN Wizard menu. Check the LAN 
to LAN with IPSec  option in the Type of VPN section, then click Next and fill in the various fields as 
follows: 

- Tunnel Name: the identifier for the tunnel created between the two VPN servers

- Method of Authentication: the choice is between a PSK or RSA key:

• RSA option: type in any keyname, then enter the public part of the RSA key (my_rsa_key) of the
remote VPN server. The input method is at the configurator’s discretion. A unique RSA key is
generated automatically when OmniPCX boots. The public part of the key is stored in
"my_rsa_key" and can be seen using the Administration -> Manage VPN IPSec menu: in VPN
Keys select "my_rsa_key" and click "See". The key thus revealed can be saved to a file (copy-
>paste) and sent to the Administrator of the remote VPN server.

- PSK option: both ends of the tunnel must use the same key. Enter a keyname and generate the
key at one end, then import it to the other end.

- Information on the remote network. If the remote gateway is an OmniPCX, this information can be
found in Administration->Manage VPN IPSec->Data to Export. Otherwise, the Administrator of the
remote gateway must send the information.

InternetInternet

I P

VPNVPN - Gateway VPN - Gateway

I S P
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Administration

The Administration -> manage VPN IPSec menu is used for viewing and modifying earlier settings, 
but also – and in a less directive way than the VPN Wizard – for creating new tunnels.

The full range of administration possibilities:

VPN Keys

• view selected key 
• delete selected key 
• import key

- regenerate RSA key ("my_rsa_key") or generate new PSK key 

VPN Tunnels

• create new VPN tunnel 
• modify selected tunnel 

- delete selected tunnel 

Data to Export

• view network info for Administrator of remote gateway

Attention : If the tunnel-initiating gateway is deemed to be the VPN client and the remote gateway 
the VPN server, then the Internet connection (if used) on the server side must be a "Call-
back" or "Permanent" connection with a fixed IP address. No such restrictions apply on 
the client side.

However, if both sides happen to initiate the VPN tunnel, then the restriction applies to 
them both.

The maximum number of simultaneous VPN tunnels is two.
Ed. 04 5/10Réf. 3EH 21000 BSAA



VPN E-SERVER : INTERNET APPLICATIONS

 

INTEROPERABILITY WITH OTHER IPSEC GATEWAYS

IPsec Tunnel establishment phases

The IKE (Internet Key Exchange) protocol is used to establish secure IPsec connections. There are two 
phases in the protocol.

IKE phase 1

Phase 1 purpose is to establish a bi-directional secure connection between the two IPsec gateways, 
which is associated to an ISAKMP SA (Security Association). During this phase, the peers negotiate a 
set of parameters to be used to secure this connection (encrypton and hashing algorithms), create keys 
and authenticate each other.

The standards define two modes for Phase 1, namely Main Mode and Aggressive Mode. Alcatel Om-
niPCX Office only support Main Mode, which may sometime be referred as ID PROTECT.

IKE phase 2

The Phase 1 secure channel is then used to negotiate security parameters for a particular mechanism, 
e.g. IPsec ESP in our case. This is the Phase 2 of IKE and it allows establishing IPSEC SA, which will 
further be used to convey data securely between the two LANs.

The mode used for IKE Phase 2 is always Quick Mode.

Interoperability troubleshooting

This section describes the points in the IKE negotiation where interoperability problems are likely to 
arise. Information about the Alcatel OmniPCX Office features should help tuning the peer device’s IP-
sec configuration and make the secure connection happen.

Foreward

The configuration of the IPsec VPN feature has been voluntary simplified on Alcatel OmniPCX Office 
to feet the "Plug-and-Play" aspect and ease of configuration of product. This hides most of the technical 
aspects implied by IPsec, i.e. details of protocols and algorithms used, and makes Alcatel OmniPCX 
Office -Alcatel OmniPCX office IPsec connections straightforward.

However, this does not prevent interoperability with other products, as Alcatel OmniPCX Office inclu-
des support for the set of mandatory IPsec features required in the IETF standards. The only constraint 
is that parameter’s tunning (other than IP parameters and authentication data) will have to be perfor-
med on the peer device, as the Alcatel OmniPCX Office configuration is rather static for the more "tech-
nical" details.

SA parameters negotiation

A security association gathers the parameters that are used to secure a connection. They contain al-
gorithms, keys, peers addresses, etc ... As explained in the previous section, a SA negotiation is per-
formed in each of the two IKE phases. They both follow the same negotiation, scheme, explained 
herafter.
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During negotiation,the initiator of the connection sends a list of proposals, i.e. combination of SA pa-
rameters it can accept. The responder then selects an acceptable proposal (if any) and tells the initiator 
about this choice.

- Phase 1 SA parameters

The table below depicts the parameters being negotiated during phase 1 and the possibilities offered 
by Alcatel OmniPCX Office.

Parameter Purpose Supported in Alcatel OmniPCX 
Office

Encryption Algorithm Data confidentiality DES

3-DES

Hash function Data authentication + integrity SHA-1

MD5

Diffie-Helman Group Key computation Group 1 (Oakley MODP768

Group 2 (Oakley MODP1024

Group 5 (Oakley MODP1536

Authentication method IPsec peers authentication Pre-Shared secret (PSK)

RSA signature using "raw" public keys

SA lifetime Time before re-negotiation of 
this SA

Maximum 8 hours

3DES
SHA
RSASig
DH Group 2

DES
MD5
Pre-shared
DH Group 1

Proposal

Choice 1 Choice 2

Selection

DES
MD5
Pre-shared
DH Group 1

IKE parameters
negotiation
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Thing to know :

- The authentication method must be configured consistently on the two IPsec gateways. As the use
of raw RSA public keys is not widely deployed aside from Linux Freeswan-based implementations,
PSK will be preferred way to autenticate with other implementations. The shared secret ty-
pically consists in a character string password.

- Authentication using digital certificates is not supported on R1.x.

- Upon failure of a SA negotiation, a NO_PROPOSAL_CHOSEN informational message may be re-
ceived by the Alcatel OmniPCX Office.

- Phase 2 SA parameters

The same parameters as in Phase 1 are negotiated, except the authentication method. The mecha-
nism used to protect the traffic for the VPN is always ESP, with tunnel mode encapsulation.

Thing to know :

- AH is not used on Alcatel OmniPCX Office.

- Perfect Forward Secrecy (PFS) must be enabled at the peer.

- If ever it is possible to configure separate Diffie Helpman groups for Phase 1 and Phase 2, it is
highly recommended to set the same group for both phases.

Peers identity checking

Before Phase 2 can begin, the peer devices must authenticate each other. For this purpose, they use 
the method defined during the Phase 1 SA negotiation to compute some data that can be derived only 
by acknowledge of a secret (RSA private key or shared secret). This piece of data is sent along (and 
also depends on) an identity payload that identifies the IPsec gateway.

The Alcatel OmniPCX Office does not allow configuration of peer’s identities, hence identities are 
always the WAN IP addresses of the systems.

It must be ensured that the remote system is configured to send its IP address to identify itself (often 
referred as "local id" parameter), and also uses an IP address to identify the remote Alcatel OmniPCX 
Office system. Such a configuration is shown in the next figure.
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Phase 2 identities

There is also an identity payload exchange during Phase 2, but this one only refers to the subnets being 
protected. Both parties send the IP parameters of the subnets (both local and remote) that are going 
to be protected by this tunnel. These parameters must match on the two sides for the exchange to be 
valide.

Any misconfiguration of remote subnet and/or remote mask may cause the remote to send an 
INVALID_ID information message.

Branch Office

Main Office

OmniPCX Office
IPsec gateway

IPsec Gateway

Internet

212.25.53.212

193.193.28.19

192.168.168.32/255.255.255.240

10.0.20.0/255.255.255.0
WAN Public IP addresses

Protected Subnets

LocalSubnet = 192.168.168.32
Local Mask = 255.255.255.240
(Local ID = 212.25.53.212)*

Remote Gw = 193.193.28.19
Remote Subnet = 10.0.20.0
Remote Mask = 255.255.255.0
(Remote ID = 193.193.28.19)*

Local Subnet = 10.0.20.0
Local Mask = 255.255.255.0
Local ID = 193.193.28.19

Remote Gw = 212.25.53.212
Remote Subnet = 192.168.168.32
Remote Mask = 255.255.255.240
Remote ID = 212.25.53.212

* These parameters are not configurable on the
Alcatel OmniPCX Office
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Debugging tools

A VPN test tool is available from the Alcatel OmniPCX Office web-based management tool (WBM) : 
Management -> Manage VPN IPsec -> VPN Tunnels. It should help detecting the most frequent 
problems.

If it does not help, with a "no answer from peer" message, the first ping consists in verifying the IP ad-
dresses of the IPsec peers. This is particularly true in test environments where IP addresses may be dy-
namic, requiring modifications to the IPsec configuration each time a WAN re-connection occurs. If 
doubts subsist, testing this IP connectivity can be performed in different manners:

- From the Alcatel OmniPCX Office, by pinging the remote IPsec gateway address. Beware that this
may not work if the remote does not answer to pings due to some fierewall rules. This is the case
for Alcatel OmniPCX Office.

- One way to verify that the peer device’s IPsec packets reach the Alcatel OmniPCX Office system is
to disable the Ipsec service on the latter and look for traces of firewall-dropped packets with peer’s
IP address as source and UDP port 500. These traces are available from WBM home page.
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TROUBLESHOOTING
Implementing Alcatel OmniPCX and its functionalities brings into play three main elements which may 
lie behind any problems encountered on installation and configuration. They are:

- the client station;

- the system (OmniPCX);

- the Internet access provider.

INTERNET ACCESS

- Nothing works: check that all the network elements can communicate with each other.

• Alcatel OmniPCX fails to respond to a ping from any of the PCs. Alcatel OmniPCX doesn’t have
access to the LAN. Check the Ethernet connections, and the IP address on the LAN side. Check
that the LAN settings in the Settings -> Network menu are correct.

• OmniPCX fails to respond to a ping from a particular PC. There is a network problem on the
PC. Check the connections (network card and cable) and the settings (Network icon in the con-
trol panel).

- Alcatel OmniPCX responds to a ping from all the PCs. Alcatel OmniPCX is correctly configured
at LAN level. The problem therefore lies in the Internet connection.

- OmniPCX can’t connect up to the ISP:

• Check the ISDN connection.
• Check the connection settings provided by the ISP and configured in OmniPCX.
• Check that the ISP profile is active, and that communication has not been deactivated.

- Use the OmniPCX connection testing tool (E-Mail Tests menu, Test Mail button): this tool goes
through the ISP connection step by step and lists the main causes of the problem as well as the
associated solutions if one of the connection steps fails.

- The browser on the PC can’t access web sites.

• OmniPCX fails to respond to a ping from the PC. See the instance above.
• OmniPCX responds to a ping from the PC.

- It may be a browser configuration issue. Check that the configuration is compatible with the
OmniPCX security function (proxy software key active or not).

- It may be a security issue:

- If user access control is enabled, check that the user has been properly declared. If neces-
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sary, change the password.

- If web access control is enabled, check that the site is authorized.

- If a particular protocol is being used, check that it is correctly configured in OmniPCX.

E-MAIL

When a client station can’t send and/or receive e-mail, check the following:

1. The POP3 mailboxes are hosted by the ISP.

• Check the mail server configuration on OmniPCX.
• Check the POP account settings (name and password) for the user created in OmniPCX.
• Test the mail server configuration using the testing tool included in OmniPCX. The tool will test

the ISP's mail servers and suggest appropriate solutions in the event of failure.
• Contact the ISP to check that the POP accounts are valid.

- Check the mail client configuration. OmniPCX should be the POP3 and SMTP server. The POP3
logins and passwords entered on the client station should be as provided by the ISP.

2. The ISP is the SMTP relay for the messaging service.

• Check the mail server configuration on OmniPCX.
• Test the mail server using OmniPCX's integrated testing tool.
• Contact the ISP.

- Check the mail client configuration. OmniPCX should be the POP3 and SMTP server. The POP3
login and password for each user should correspond to the OmniPCX settings.

3. The ISP has a direct SMTP connection to OmniPCX. Check the configuration of OmniPCX, and of
the ISP.
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THIRD PARTY CTI - TAPI
SUPPORTED ENVIRONMENTS

Third Party CTI connectivity relies on a server/client model:

- TAPI 2.0: the application developer has to program the link between client and server

- TAPI 2.1: Microsoft provides the link (via Microsoft Windows Remote Service Provider) between the
client PC and a server PC (an NT 4.0 server belonging to the NT domain) that hosts the Third Party
TAPI service provider.

The Alcatel Third Party TAPI service provider is implemented like a CSTA and uses the Alcatel OmniPCX 
Office CSTA API.

* TAPI version not delivered with Operating System but can be downloaded from http://www.micro-
soft.com.

Applications available

- PIMphony Basic, Pro or Team. PIMphony is capable of monitoring sets (analog, Reflexes or cor-
dless) and of acting as an IP phone.

Supported terminals

- All the terminals supported by CSTA.

Operating system Microsoft TAPI ver-
sion

Alcatel TAPI Third 
party SPI

Remarks

Windows 3.x

Windows 95

Windows 98

Windows 98 Ed. 2 2

Windows Millennium

Windows NT 4.0 SP4

Windows 2000 Prof.

1.3 *

2.1 *

2.1

3.0

3.0

2.1 *

3.0

/

5.0x

5.0x

5.0x

5.0x

5.0x

5.0x

Not possible

TAPI 2.1 is included in 
SP4
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TAPI SERVER/CLIENT CONNECTIVITY 

Microsoft TAPI 2.1 server

Various architecture solutions are available:

This architecture requires:

- Microsoft remote service provider on the client PC
- Microsoft TAPI 2.1 server and Alcatel TAPI SPI 5.0x on the server PC
- the CSTA server on Alcatel OmniPCX Office

Alcatel TAPI Server

In this case no TAPI server is required: the CPU board acts as a TAPI server. As each Alcatel TAPI SPI 
5.0x requires an CSTA session, the number of clients is limited by the number of possible CSTA ses-
sions.

Alcatel OmniPCX
Office

TAPI Server TAPI Client

IP network 

TAPI interface

IP stack 

Microsoft 
remote SPI 
for TAPI 2.1

Alcatel
TAPI
SPI
5.0x

Micro
soft 
TAPI 
2.1 ser
ver

TAPI interface

CSTA
Server

IP stack 

Alcatel OmniPCX
Office

TAPI Client

IP network

TAPI interface

IP stack 

Alcatel
TAPI SPI

5.0x 
CSTA
Server
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Comparison between these 2 architectures

Service Microsoft TAPI 2.1 server Alcatel TAPI Server

Constraints on the client PC - TAPI 2.1 remote SPI must be
installed

- Must belong to an NT do-
main

- User must log into the NT
domain

- Must have TAPI 2.0 or later
installed

- Must have Alcatel TAPI SPI
5.0x installed on each client

Constraints on server PC - Must have TAPI 2.1 installed
- Must be an NT 4.0 server
- Must belong to an NT do-

main
- Must have Alcatel TAPI SPI

5.0x installed

No server PC

Security Yes No

Centralized management Yes No

Mandatory configuration - Client PC must be configu-
red as a client of the TAPI
2.1 server

- Server PC must be configu-
red as a TAPI 2.1 server

- Alcatel TAPI SPI 5.0x must be
configured with the IP ad-
dress of the Alcatel Omni-
PCX Office CPU board 

Alcatel TAPI SPI 5.0x must be 
configured with the IP address of 
the Alcatel OmniPCX Office 
CPU board 

Number of client PCs No limit (except server PC load) Limited by number of CSTA ses-
sions

Number of CSTA sessions used 1 Number of client PCs

Impacts on customer IT organi-
zation

Can be high Very low

Cost Can be expensive Cheap
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THIRD PARTY CTI - CSTA
PRESENTATION

The CSTA protocol is proposed on an Ethernet TCP/IP link via the Alcatel OmniPCX Office system CPU 
board. 

The CSTA application is built around an ECMA standard. This standard covers:
- a set of services for applications involving both telephone and computer (ECMA-179)
- a protocol for system/computer exchanges (ECMA-180) enabling the above-mentioned services to

operate

Version implemented: version 1

Applications available

- Alcatel Office Call Center (AOCC)

FUNCTIONAL ARCHITECTURE

A typical CSTA application involves:

- an Alcatel OmniPCX Office system which manages the application's telephone resources
- a CTI server on which the CSTA application is run. It is connected to the system's CPU board via a

CTI link (third party connectivity).
- client PCs associated with the telephone sets and constituting the operator's workstation.

LA
N

ad
ap

te
r

LA
N

ad
ap

te
r

CTI Server

Telephone sets

Data
processing

section

Telephone section

Public
network

Third party CTI 
connectivity
(to CPU board)

Workstation
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SOFTWARE ARCHITECTURE

The CSTA connection is made via a CSTA agent located in the system. The maximum number of si-
multaneous sessions is 28. The tasks performed by an agent are:

- management of connection with the CTI server
- ASN1 encoding/decoding of requests and events in compliance with ECMA 180
- recovery of telephone events for the monitored devices
- management of the connection between the telephone application and the system corresponding

to the service request from the CTI server

CSTA DIALOGUE

CSTA dialogue is built around the Client/Server model. Each party (system, computer server) can send 
or reply to a service request and provide an event report.

CSTA MODEL

The CSTA standard makes the application independent of physical implementation of the switching 
networks used. To do this, it provides the applications it addresses with an abstract view of the under-
lying telephone assembly. This abstraction is obtained by modeling the switching part. The generic mo-
del developed to represent the working of the telephone part is built around three notions:

The Device

This notion refers to:

- physical devices such as: telephone sets, circuit groups, lines,
- logical devices: groups, ACD.
- Device Type

CSTA defines several types of devices which can be handled or observed (ACD, operator, circuit 
group, etc.).

- Device Class
The devices observed can belong to different families (data, image, voice, other)

- Device Identifier
The devices handled are referred to by a device identifier for the CSTA service. Depending on 
whether or not the device is involved in a call, the identifier will be dynamic or static.

- Device State
This is a set of connection states linked to a particular device.
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Call

This is a switching relationship (generally) between two or more devices. It is also a CSTA object. In a 
CSTA domain, the behavior of telephone call establishment and release can be observed and han-
dled. To characterize a call, two parameters are of use:

- Call Identifier
A call reference is automatically created by the switching domain as soon as a call appears.

- Call State
This is a list of connection states (see connection below) for all the devices involved in a particular 
call.

Connection

A Connection is a relationship between a call and a device. This relationship can be both monitored 
and handled. In fact, the various services provided by the CSTA protocol consist in observation and 
handling of connections. A connection is defined by an identifier and a state.

- Connection Identifier
The connection identifier consists of the pairing of a call identifier with a device identifier.
• For each call, there are as many connection identifiers as there are devices connected.
- For each device, there are as many connection identifiers as there are calls connected.

- Connection state
A state is allocated to each connection, to characterize the position of the connection.
Changes in the state of the connection can be described using a states machine.

CAPACITIES

The CSTA processing capacities of the Alcatel OmniPCX Office system are listed in the following table:

Processing capacities Maximum

Number of simultaneous CTI applications 25

Number of simultaneous monitoring requests for 
a terminal

208

Max. number of active simultaneous supervi-
sions per node (Alcatel OmniPCX Office system) 

208 

Number of CSTA requests processed simulta-
neously

30

Number of CSTA events per second 10

Number of CSTA switching requests per second 2
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DESCRIPTION OF THE CSTA LINK (SYSTEM <-> SERVER)

PRESENTATION

The CSTA link is the one which connects the system's CSTA server to the CTI server. It consists of an 
Ethernet link supporting a stack of BSD4.3 compatible TCP/IP protocols for the lower layers and OSI-
compliant ACSE/ROSE/ASN1 for the higher layers. The RFC 1122 and RFC 1058 recommendations 
are also adhered to.

LINK MANAGEMENT

Initialization

To initialize the link, the CTI server must connect to the transport layer (TCP protocol) on TCP port 
2555. Once this connection is made, the application identifies itself at session level (by sending the 
character 'B'), the system then responds by sending the character 'P'.

Message Transmission direction Meaning

B CTI Server -> System Identification of the application

P System -> CTI Server CPU

EXIT CTI Server -> System End of connection

Application

Transport

Session

Presentation

ACSE ROSE

Link

Physical

Network

Transport

Session

Presentation

Application

Link

Physical

CSTA

CTI Server Alcatel OmniPCX Office

ACSE ROSE

ASN1

Proprietary

Transmit Control Protocol 
(TCP)

Internet Protocol 
(IP)

802.3

10BASE-T

Network

Transmit Control Protocol 
(TCP)

(IP)

ASN1

Proprietary

802.3

Internet Protocol 

10BASE-T

CSTA

(IP)
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Identification (future version)

The CSTA protocol falls into layer 7 (application) of the OSI model. Its implementation in the system 
uses the ACSE (Association Control Service Element) defined by OSI for managing application links.

In the association request (AARQ) the CTI application specifies the list of CSTA versions supported and 
the list of CSTA services and events used.

The association can be rejected by the system's CSTA server if:
- the ACSE versions are incompatible
- there is no common CSTA version between the CTI server and the system

When the association is accepted, the system sends back a reply (AARE) containing the chosen CSTA 
version and the list of usable CSTA services and events.

Connection release

The CTI application sends an association cancellation request (RLRQ ADPU); the system replies with 
RLRE ADPU.

The connection is then released by an EXIT message sent by the server. Each side then releases the TCP 
connection.

Surveillance

A surveillance mechanism is installed at application level, to ensure that the link is available. This me-
chanism enables the CTI server to detect any malfunctions (reboot) on the system side. This function 
exists in TCP but the reaction time is longer.

When there are no exchanges on the link, the system's CSTA server periodically (every 30 s) sends sys-
tem status requests (bi-directional services). These requests must be acknowledged by the CTI server. 
If the requests are not transmitted or if the replies are not received, the link is considered to be faulty 
after two messages have been sent with no reply.

Failures

- Failure of the CTI server or failure of the link:
• the calls established remain unchanged
• the monitoring events are lost
• the monitoring requests are cancelled
- the system's CSTA server cancels the connection context
The CTI server must reconnect and restart monitoring.

- Failure of a terminal (UA set, UA link or DLC board): the calls established are deleted. When the
terminal returns to valid status, the CSTA server resumes the monitoring process.
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- System reset:
• all the calls are lost
• the monitoring events are lost
- the monitoring requests are cancelled
The CTI server has to reconnect.

DEVICE IDENTIFIER

This paragraph describes the internal structure of the device identifiers used by the system's CSTA ser-
ver.

Static Device Identifier

As long as a device is not involved in a call, it is designated by its directory number. Thus, to establish 
a call with "Make-Call", or request monitoring with "Monitor Start", the directory number of the device 
concerned is used.

Dynamic Device Identifier

As soon as the device concerned is involved in a call, reference must be made to it in the connection 
identifier, using the dynamic identifier. Thus, for a "Transfer-Call", the dynamic identifier obtained in 
the previous events is used.

Label  Length       Dynamic identifier (4 bytes)

Label  Length                Connection identifier (10 bytes)          .

Label  Length        Call identifier (2 bytes)
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DESCRIPTION OF CSTA SERVICES

The implementation of CSTA services in the Alcatel OmniOffice system uses the principle of device mo-
nitoring. Each monitoring request creates a "data stream" between the monitored system device and 
the CSTA application of the CTI server which made the request. All the events of all the connections in 
which the device is involved are reported by this "data stream" which is identified by a reference 
(cross_ref_id). All the events carried by the "data stream" are identified by this reference, which enables 
them to be routed through the CSTA application. 

The CSTA services are available for the following elements:

- Alcatel multiline Reflexes sets (including DECT sets and IP Phones)
- Monoline Alcatel Reflexes sets
- Analogue Z terminals
- Virtual terminals

Nonetheless, devices not supported can be involved in communications with supported devices. In 
such cases, the CSTA service requests can only be made on the supported devices.

The switching services introduced by CSTA use those offered by the system. This means that from the 
viewpoint of the telephone set, the CSTA services behave in the same way as the equivalent telephone 
services provided manually.
To be able to activate switching services on a device, the device must be the subject of a valid super-
vision request.

SERVICES PROVIDED

The services offered by the CSTA protocol are of four types:

- switching services enable a computer to control the switching capacity of the system. For all these
services, the server is, therefore, the system and the client is a computer on the network. 

- monitoring services enable a client situated in the computing domain to receive information con-
cerning calls or system devices situated in the switching domain.

- computer services enable a client situated in the computing domain to request routing of a call.
- bi-directional services allow installation of services not defined in the protocol.

SWITCHING SERVICES

Answer Call

This service can be used to connect a call presented or camped on.
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Alternate Call

This service can be used to combine the "Hold Call" service followed by the "Retrieve Call" service.

The call on hold becomes active while the current call is placed on hold.

Clear Connection

This service can be used to clear a call from a specific device (similar to going on-hook manually).

Consultation Call

This service can be used to combine the "Hold Call" service followed by the "Make Call" service.

The call active on a device is placed on hold and a new call is made from the same device.

Hold Call

This service places an established connection on hold (similar to manually placing on hold).

Make Call

This service is used to generate a CSTA call between 2 devices.

The "Make Call" service is unaware of the device states (forwarded, controlled, etc.). The user can reject 
(soft key, End key, time-out) or accept the call (off-hook, soft key, hands-free key, time-out).
The system can be programmed for automatic answer mode. After a time-out (5 seconds by default), 
the system simulates a "hands-free" mode on the original device.
If the service is accepted, the application automatically dials on behalf of the user.

Query device

This service provides terminal status indications. 

Reconnect Call

This service is used to combine the "Clear Connection" service with the "Retrieve Call" service.

Retrieve Call

This service is used to connect a call on hold (similar to the corresponding manual operation).

Transfer Call

This service transfers a holding call into an active call on the same device (similar to a supervised trans-
fer).

Associate data

This service (available through use of the "Escape" service) associates information (project code, autho-
rization, code, etc.) with a specific call (this information has no impact on the call). 

Send DTMF tones
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This service (available by using the "Escape" service) enables DTMF tones to be added after a call is 
connected.

Dial digits

This service (available by using the "Escape" service) allows a dialing sequence to be associated with a 
call (the call is initiated manually by going off-hook or via a "Make Call" or "Consultation Call" service). 

Pick up Edn

This service (available by using the "Escape" service) camps a (ringing) call on a given terminal.

Get config

This service (available by using the "Escape" service) returns information about the system configura-
tion.

Device status

This service (available by using the "Escape" service) enables you to:

- start monitoring the creation/deletion of a terminal on the system
- stop monitoring
- request a device status
- request the status for all the terminals.

A terminal status gives the following information: direct number, physical status of terminal, in service 
/ out of service.

Nota : Particularities of mono-line terminals:
Certain CSTA services (Answer Call, Consultation Call, etc.) may be rejected by mono-line 
terminals, as a mono-line terminal can simultaneously manage only one connected call and 
one call on hold (or 1 or more camped calls).
Example: it cannot answer a camped call when another call is on hold.

SUPERVISION SERVICE

This service enables a CSTA client to receive messages concerning the CSTA events occurring on a mo-
nitored device. 

- It must be activated by the event monitoring activation service, used to specify the device monitored.
- Monitoring stops by itself if the monitored device disappears (as is the case with a call) or can be

stopped by the monitoring deactivation service. 
- A client can find out the current state of a call or device simply by requesting it.
- The client may not necessarily receive all the events generated by the monitoring process, but sim-

ply a sub-set of them by activating a monitoring filter. 

Monitor Start

This service activates Call Event Monitoring. There are two types of activation service:

- call monitoring activation: all events on the devices in which the call is involved are reported.
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- device monitoring activation

When the CSTA server has accepted the monitoring activation request, it sends the client an on-the-fly 
data stream describing the CSTA events of the call or device being monitored. If a filter has been ac-
tivated, only the chosen events will be transmitted. The server automatically ends supervision when the 
monitored object disappears, which can happen with a call.

The CSTA server also provides a reference: Cross Reference Id, associated with the monitoring process 
for as long as it lasts. This reference will be used whenever anything is done on the monitoring process 
(change filter, deactivate, etc.).

Monitor Stop

This service is used to stop the monitoring process for a given object (device or call). It can be invoked 
by a client who no longer wishes to receive information concerning a previously monitored object, or 
by a system no longer able to provide information about the object.

When the request is accepted by the server, the data stream describing the CSTA events for the moni-
tored call or device ceases.

Change Monitor Filter

This service is used to change the monitoring filter on an existing monitoring process. The monitoring 
filters are used to define the information to be transmitted by the monitoring process.

Snapshot Device

This service is used to obtain information concerning a specified device. This information includes the 
list of calls involving the device and the state of each connection.

BI-DIRECTIONAL SERVICES

Escape

The escape procedure permits the installation of services not defined in the protocol.

System Status

This service identifies the system status, whether for the switching part or the computing part.

PROTOCOL CONFORMITY: PICS

The implementation of the CSTA protocol on the Alcatel OmniPCX Office system is set out in the fol-
lowing tables.

Nota :

This list is not exhaustive and the implementation of the protocol can change with time.

Refer to the PICS (Protocol Implementation Conformance Statement) for a description of the state of 
conformance of this implementation of the protocol compared with the standard.
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A Initialization Services Alcatel 
Omni-
PCX 
Office

Remarks

A.1 Security services

A.2 ACSE negotiation (Non ECMA V1 Ad-
ditional Features)

� For version, service capability and 
authentication

B Switching Function Services Alcatel 
Omni-
PCX 
Office

Remarks

B.1 Answer call �

B.2 Alternate call �

B.3 Call completion � Intrusion supported

Callback supported

B.4 Clear call Not applicable for Alcatel OmniPCX 
Office (use clear connection instead)

B.5 Clear connection � In a basic call when you clear one con-
nection of the call, the other one is 
automatically cleared.

B.6 Conference call �

B.7 Consultation call � Correlator data supported

B.8 Divert call � Call deflection supported

Individual call pickup supported
Group pickup supported
Correlator data supported

B.9 Hold call �

B.10 Make call � Correlator data supported

AutoOriginate authorized

B.11 Make predictive call (group)

B.12 Query device � Device info supported (type and class)

Forwarding supported
Do Not Disturb supported

B.13 Reconnect call �

B.14 Retrieve call �
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B.15 Set feature � MsgWaiting supported

Forwarding supported
Do Not Disturb supported

B.16 Transfer call �

Non ECMA V1 Additional Features
(using Escape service)

B.17 Associate data � Only for CSTA Application Correlator 
Data

B.18 Send DTMF tones �

B.19 Dial digits �

B.20 Pickup EDN �

B.21 Get config �

B.22 Device status �

C Status Reporting Services Alcatel 
Omni-
PCX 
Office

Remarks

C.1 Events reports

C.1.1 Agent state event reports

C.1.1.1 Logged on

C.1.1.2 Logged off

C.1.1.3 Not ready

C.1.1.4 Ready

C.1.1.5 Work not ready

C.1.1.6 Work ready

C.1.2 Call event reports

C.1.2.1 Call cleared Not applicable for Alcatel OmniPCX 
Office

C.1.2.2 Conferenced � Correlator data supported

C.1.2.3 Connection cleared � Correlator data supported

C.1.2.4 Delivered � Correlator data supported

Used B-channel supplied with private 
data (Network Time Slot)
Group number supported
Correspondent name supported
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C.1.2.5 Diverted � Correlator data supported

C.1.2.6 Established � Correlator data supported

C.1.2.7 Failed � Correlator data supported

C.1.2.8 Held � Correlator data supported

C.1.2.9 Network reached � Correlator data supported

C.1.2.10 Originated � Correlator data supported

C.1.2.11 Queued � Correlator data supported

Used B-channel supplied with private 
data (Network Time Slot)
Group number supported
Correspondent name supported

C.1.2.12 Retrieved � Correlator data supported

C.1.2.13 Service initiated �

C.1.2.14 Transferred � Correlator data supported

C.1.3 Feature event reports

C.1.3.1 Call information �

C.1.3.2 Do not disturb �

C.1.3.3 Forwarding �

C.1.3.4 Message waiting �

C.1.4 Maintenance events

C.1.4.1 Back in service �

C.1.4.2 Out of service �

C Status Reporting Services Alcatel 
Omni-
PCX 
Office

Remarks

C.2 Monitor/snapshot

C.2.1 Change monitor filter �

C.2.2 Monitor start � Device-type only, with filters on events

C.2.3 Monitor stop �

C.2.4 Snapshot call

C.2.5 Snapshot device �
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D Computing Function Services Alcatel 
Omni-
PCX 
Office

Remarks

D.1 Re-route

D.2 Route end

D.3 Route request

D.4 Route select

D.5 Route used

E Bi-directional Services Alcatel 
Omni-
PCX 
Office

Remarks

E.1 Escape � See associate data

E.2 System status � Used for the keep-alive mechanism
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CONFIGURATIONS

The CPU board IP address is configured in PM5 -> Hardware and Limits -> IP Addresses.

VIRTUAL TERMINALS

Definition

A virtual terminal (so called because the terminal does not physically exist) is not visible and can only 
be managed from a CSTA application. Created using MMC-PC (Expert View), it is assigned an internal 
directory number and has the same characteristics as a Reflexes set.

An Alcatel OmniPCX Office system can have a maximum of 24 virtual terminals.

Description

A virtual terminal can receive internal and external calls. Incoming calls can be answered via CSTA 
service requests; outgoing calls are also made in response to a CSTA service request. 

A virtual terminal can form part of hunting group or an attendant (operator) group.

Default parameter setting:

- intercom profile (one resource key for each network access)
- 2 RGM keys for local calls
- 1 dedicated key for outgoing calls

A virtual terminal can have a maximum of 104 keys.

Configuration

- To create virtual terminals (max. 24) – MMC-PM5 (Expert view) only:

The system assigns the available directory numbers to the virtual terminals.
All the set parameters (accessible by Subscribers -> Subscriber List -> Details), with the excep-
tion of the individual directories and personal codes, can be modified.

Subscribers -> Subscriber List -> Add -> Custom. Set: Add -> Virtual Terminals  -> specify 
the number of virtual terminals you want to create.
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DOORPHONES
DESCRIPTION

With the doorphone, it is possible to identify the person who has pressed the button before opening 
the door. Identification is made after a communication has been set up between a set connected to the 
system and the doorphone.

2 doorphone types are available, depending on the operating mode used: 

- Type A:  relay-controlled doorphones (e.g. NPTT)
- Type B:  doorphones controlled by MF Q23 signals (e.g. TELEMINI and UNIVERSAL DOORPHONE)

These doorphones are mutually exclusive on the same system. A flag must be placed to define the 
operating mode in use.

A doorphone call is managed in the same way as all internal calls: 

- it is indicated on the destination set display as another call
- a doorphone call may be intercepted, forwarded, put in a conference with other correspondents

and camped on if the destination set is busy.

Notas :

The destination of a doorphone call can be an external number (defined using a collective speed dial 
number); in this case, the set in question cannot control the door opening mechanism.

By MMC-PM5 (Expert View), select:

System Miscellaneous -> Memory Read/Write -> Misc. Labels -> flag DPHMode -> enter 00 
(default value) for a TELEMINI or UNIVERSAL DOORPHONE or 01 for an NPTT doorphone.

Station or
operator

ALCATEL
BUSINESS
SYSTEMS

Alcatel 
OmniPCX 

Office
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USING A TELEMINI DOORPHONE

These doorphones must only be connected to a Z station interface.

Basic characteristics of these doorphones:
- recognition of the opening and closing of the loop and passing into conversation.
- no detection of the ringing current (incoming call) except for those that are MF Q23 programma-

ble.
- recognition of MF Q23 signals or tones transmitted by the system (system -> doorphone dialog).
- possibility of configuring a directory n° (programmed in the memory) transmitted to the system.

Several doorphones may be connected to the system; the limit is defined by the maximum number of 
analog set interfaces that the system can contain.

A system cannot have TELEMINI and UNIVERSAL doorphones at the same time.

Operating principle

Pressing the doorphone call button sends an MF code (START) which, after validation by the system, 
maintains the call and triggers an off-hook signal on the doorphone destination set or group.

There is a specific key for answering the call, while another controls the automatic doorstrike (latch) by 
sending an MF code (LOCK).

Hardware requirements

- a free Z device on an SLI board
- 2 free keys on one or more Reflexes sets
- a Telemini doorphone with doorstrike

Programming

- defining the Z interface (for subscriber 111, for example).

- the feature access code for controlling the doorstrike

By MMC-PM5 (Expert View), select:

Subscribers/Basestations List -> Subscriber ->111 -> Details -> Misc.  -> Special Function 
= Door Phone  -> Hotline = Immediate -> destination n° = set or group Subscribers -> 
Subscriber -> 111 -> Details -> Features = protection against camp-on tone and intrusion 
(optional)

By MMC-PM5 (Expert View), select:

Numbering -> Features in Conversation -> XX = Doorphone Unlock
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- to create specific keys on the set(s) linked to the doorphone
• Supervision keys

• Doorstrike key

- specific programming instances
If the doorphone uses other MF command codes, refer to its instructions. 

Connection diagram

Functional description

Setting up a doorphone requires a functional analysis of the device (expected signals or tones, system 
open to programmable signals), before moving on to the system configuration, or that of the door-
phone.

Nota : It is recommended that you consult the doorphone installation manual.

By MMC-PM5 (Expert View), select:
Subscribers/Basestations List -> Subscribers/Basestations List (select doorphone destination 
set)  -> Details -> Keys -> select a key -> Type = Resource Key -> Function = RSL  -> Num-
ber = 111

By MMC-PM5 (Expert View), select:
Subscribers/Basestations List -> Subscriber (select set) -> Details -> Keys -> select a key -
> Type = Function Key -> Function = Doorphone Unlock 

By MMC-PM5 (Expert View), select:
System Miscellaneous -> Doorphone Signals -> change MF code values (start/stop signal), 
if desired, add the ringing tone to the doorphone using Alert Signal / Tone 

Z station interface

220V

Towards theDoor opener command
 door opener

TELEMINI
or

UNIVERSAL
DOORPHONE

PABX

(SLI board)
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Functional analysis of the "UNIVERSAL DOORPHONE"

DOORPHONE
USER IN

FRONT OF
DOORPHONE

STATION/OPERATOR

Selection of the
call button

Closure of the loop,
preparation of the

programmable

Sending of the
"START" signal (Tone)

Station rings

Station off hook,
conversationConversation

Feature code
opening of the door

Sending of the
"ALERT" signal (Tone)

Sending of the 
"LOCK" signalDoor opened Reception of the 

programmable MF code

Sending of the 
"STOP" signal (Tone)

Opening of the loop if:
- reception of the dial tone
- T time-out has lapsed
and moving into not avail.

Moving into
availability

Station
on hook

Detection of the
closure of the loop

Reception of the station
directory No. and call

If the station
is not available
or inaccessible

Dial tone reception
(reception acknowledged)

T time-out

MF Q23 transmission of the
programmed directory No.

for door opener control

Call back

  

(MF code)

Alcatel 
OmniPCX 

Office
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Functional analysis of the "TELEMINI" doorphone

Alcatel 
OmniPCX 

Office

t = 3s

DOORPHONE
USER IN

FRONT OF
DOORPHONE

Selection of the
call button

Closure of the loop,
preparation of the
T1 = 2s time-out

Sending of the
"START" signal (A)

Station rings

Station off hook,
conversationConversation

Feature code
opening of the door

Sending of the
"ALERT"  signal (Tone)

Sending of the
"LOCK" signal (D)

Door opened Reception of the MF D code,
door opener control

Sending of the 
"STOP" signal (C)

Opening of the loop if:
- reception of MF C code
- T1 time-out has lapsed
- T2 time-out has lapsed

Moving into
availability

Station
on hook

Detection of the
closure of the loop

Reading of the station
directory No. in

Automatic call on off hook
and station call

If the station
is not available 
or inaccessible

and moving into not avail.

while t = 1.5s

Reception of the MF A code
(reception acknowledged)

cancelling of T1 and
preparation of the

T2 = 2 mins time-out

Call back

  

STATION/OPERATOR
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USING AN NPTT DOORPHONE

The doorphone interface comprises an intercom and an optional doorstrike powered by the mains 
supply through a SELV (Safety Extra Low Voltage) transformer.

A single doorphone with doorstrike may be connected to the system.

The system also allows for the connection of 2 doorphones without doorstrikes.

Operating principle

Pressing the doorphone call button triggers a loop on the associated Z terminal. The loop is maintai-
ned by relay 1 on the AFU board until the call is answered. The Z terminal is in immediate selection 
mode on the doorphone destination group or terminal.

There is a specific key for answering the call, while another controls the automatic doorstrike (latch) 
via relay 2 on the AFU board.

HARDWARE REQUIREMENTS

- an AFU board (a CPU daughter board)
- a free Z device on an SLI board
- 2 free keys on one or more Reflexes sets
- an NPTT doorphone
- a doorstrike with transformer

Programming with MMC-PM5

- set the flag "DPHMode" to 01.
This flag, with a default value of 00, enables the PABX to manage the type of doorphone interface 
employed. Only the values 00 and 01 are currently used.

- defining the Z interface (for subscriber 111, for example).

- the feature access code for controlling the doorstrike

By PC- PM5 (Expert View), select:
System Miscellaneous -> Memory Read/Write -> Misc. Labels -> DPHMode -> Details -> 
01 -> Modify -> Write

By MMC-PM5 (Expert View), select:
Subscribers/Basestations List -> Subscriber -> 111 -> Details -> Misc. -> Special Function 
= Door Phone  -> Hotline = Immediate ->  destination n° = set or group  Subscribers -> 
Subscriber -> 111 -> Details -> Features = protection against camp-on tone and intrusion 
(optional)

By MMC-PM5 (Expert View), select:
Numbering -> Features in Conversation -> XX = Doorphone Unlock
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- to create specific keys on the set(s) linked to the doorphone
• Supervision keys

• Doorstrike key

- configuring the Auxiliaries board relays

Connection diagram

By MMC-PM5 (Expert View), select:
Subscribers/Basestations List ->  Subscriber (select doorphone destination set) -> Details -
> Keys ->  select a key -> Type = Resource Key -> Function = RSL -> Number = 111

By MMC-PM5 (Expert View), select:
Subscribers/Basestations List -> Subscriber (select set) -> Details -> Keys -> select a key -
> Type = Function Key -> Function = Doorphone Unlock

By MMC-PM5 (Expert View), select:
Hardware and Limits -> Auxiliary Interfaces -> Doorphone 1: Hold Line = relay1 (maintain 
call), Doorstrike = relay2 (open doorstrike), N° = doorphone Z interface number (111)

PABX DOORPHONE

Z station interface

A

B

220V

Towards door opener

Loop catch control

Door opener control

Audio (intercom)

White

Orange

Red

Blue

(AFU board)

(SLI board)
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ALCATEL OFFICE CALL CENTER 
(AOCC)
Alcatel Office Call Center (AOCC) provides voice applications such as Voice Mail, Automatic Atten-
dant, Audiotex, ACD (Automatic Call Distribution), etc.

CONNECTION

AOCC is connected to the Alcatel OmniPCX Office system by 2 types of link: 
- analog connections, corresponding to analog set interfaces (SLI boards)
- a CSTA connection, corresponding to the LAN link to a LanX8/X16 board.

Analog connections

SLI boards

The SLI boards interface between the Alcatel OmniPCX 2-wire analog Z sets and the AOCC voice 
boards. For the SLI board connection details, see the relevant paragraph in "Hardware" section.

AOCC voice boards

The voice board devices connect to the analog set outlets.

For 2 or 4-line boards, 1 or 2 double cables are supplied, with an RJ12 connector (6 positions, cabled) 
at each end. 

For 2-wire analog accesses, the following cables are supplied:

- 1 board with 2 accesses: 2 CDR 4015 (RJ12) cables or 1 CDR 4029 (RJ45) cable.
- 1 board with 4 accesses: 2 CDR 4015 (RJ12) cables or 1 CDR 4029 (RJ45) cable.

Connector locations:

Upper RJ12: accesses 1 and 2
Lower RJ12: accesses 3 and 4

Access 13 to 16

Access 9 to 12 Access 5 to 8
Access 1 to 4
Ed. 04 1/4Réf. 3EH 21000 BSAA
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CSTA connection

LanX8/X16 board

The AOCC application is connected to the system using a LanX8/X16 board via an 10 base T Ethernet 
link (straight cable).

AOCC network board

The PC network board is equipped with an RJ45 connector for connection to a 10 base T Ethernet link; 
the pins are numbered 1 to 8 from left to right (front view, clips on top).

Pin n° Signal Function

1 TX+ Transmission +

2 TX- Transmission -

3 RX+ Reception +

6 RX- Reception -

PROCESSING UNIT

ETHERNET LANSWITCH

Ethernet 10 Mbits

AOCC

LANX8

CPU
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INSTALLATION

- Connect up the AOCC application (Ethernet link and analog links).

- Configure the system IP address (PM5 -> Hardware and Limits -> IP Boards); this address is
usually supplied by the IT network administrator (when using an existing LAN) but it can be any
address (in the case of direct connections) providing it matches the one entered in AOCC.

CONFIGURING THE SYSTEM SIDE

To ensure that the application works well, you need to modify a number of Alcatel OmniPCX settings:

- in PM5 -> System Miscellaneous -> Feature Design, make sure "o Group Called with Signa-
lisation Mode" and "o CLI for VPS" are unchecked. 

- check that the "EnquiEButt" flag is set to 00H (applies particularly to Belgium)

- cancel dynamic routing on all the analog accesses used for the AOCC connection

- check that these analog accesses have the "Telephone" service

- a number of general rules have to be adhered to when configuring agent stations and analog ac-
cesses:

• cancel all dynamic routing
• prohibit intrusion
• prohibit call pickup (a statistics issue)
• prohibit conference calls
• do not use forwarding (of whatever type)
• if external transfer is used, authorize joining for the Z accesses used by AOCC
- check the barring levels and traffic sharing settings for the AOCC lines.

CONFIGURING THE AOCC SIDE

See the documentation supplied with the application.
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CALL METERING SERVICES
The CALL METERING module is used for collecting specific information concerning telephone commu-
nications and printing this information in various formats, depending on the type of management se-
lected.

This section describes the implementation and use of call metering statements or tickets; these can be 
printed on any printer connected to a V24 4083 ASM or 4093 ASY-CTI option on a Reflexes terminal.

It is also possible to display data relating to communication. 

Nota : Not all the metering information supplied by the ISVPN+ protocol (operator, node, 
services: transit, overflow, ARS, etc.) appears on the tickets; this data can only be 
used from within a central management application (Alcatel 4740 or other). 

V24 metering printout:

Metering printout parameters: format (information bits, parity, stop bits) and speed; by default:
8N1, 9600 bps).

Activating external metering: printing of tickets/statements is or is not activated (default setting)

Nota : The details on configuring the V24 metering printout can be found in the "Annexes" section.

- By MMC-PM5 (Expert View), select: Subscribers/Basestations List -> Subscribers/Basesta-
tions List -> select V24 access -> Details -> V24

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts->check External Me-
tering Activation
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Connection

15 m max.

V24
UAI

RD

TD

0V

3

2

7

4

5

RTS

CTS

15 m max.

V24

RD

TD

0V

3

2

5

7

8

RTS

CTS

UAI

Printer or external
management system

Metering
printer

Option 4083ASM
Connector

SUBD 25 pins

If the printer does not manage the

RTS/CTS signals, strap 4-5.

Alcatel
OmniPCX

Office

Printer or external
management system

Metering
printer

Option 4093 ASY-CTI
Connector

SUBD 9 pins

If the printer does not manage the 

RTS/CTS signals, strap 7-8.
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PRINCIPLES

Meter charging according to the operating phase

Operation Meter charging method

Conversation Metering units received on the line are charged to the subscriber 
in conversation with that line.

Park or Hold Metering units received on a parked or holding line are charged 
to the subscriber who parked the call.

Retrieve from parking or hold The metering units are charged to whomever activated the ser-
vice. Subsequent metering units are charged to the user who re-
trieved the call.

Automatic forwarding The system does not manage charges for external forwarding; 
this is managed by the public network.

Conference Any conference costs are charged to the conference initiator.

Transfer If a transfer takes place on an external call, the cost of the com-
munication is charged to the initial user until the external user is 
put through to the new correspondent.

When a call is transferred while ringing or on busy, metering 
units are charged to the transfer destination.

No units are charged to the OS when external calls are transfer-
red to a system user; all the metering units are charged to the 
destination subscriber. 

However, if a call is meant for the OS (by transfer or callback), 
the communication is charged to the OS.

Ext/Ext transfer Metering units received after the transfer are charged to the user 
who made the second external call. 

Transfer failure A callback after a transfer failure is always treated as an inco-
ming communication for the set to which the call is rerouted after 
the no-answer time-out.

External forwarding When an internal call is made to a user whose calls are being 
diverted to an external number, the metering units are charged 
to the forwarded subscriber.
Ed. 04 3/30Réf. 3EH 21000 BSAA



CALL METERING SERVICES APPLICATIONS

 

DURATION AND COST

Duration

The system counts two types of duration:

- Duration of the communication: this corresponds to the time during which the system considers that
a line is allocated to a subscriber; this accounting occurs after the first switch to conversation mode
by the subscriber with the line.

- Call phase duration: the system counts the call phase duration of an incoming external communi-
cation from the moment when the system detects the call to when the line changes to conversation
with a system terminal. This information is used during external management.

Cost

The cost of a communication is calculated according to the number of units charged: 

- The value of the basic metering unit may be constant, regardless of the length of the communica-
tion.

- The value of the basic metering unit may be variable: the cost of the first x metering units is calcu-
lated according to an initial basic metering unit value. As soon as a threshold number of metering
units is reached, the cost is calculated according to a second metering unit value.

Notas :

The software allows the actual duration of the communication to be shown on the metering ticket:

- on receipt of a CONNECT message on digital networks
- on receipt of a polarity inversion or a metering pulse on analog networks.

In all other cases, the duration given is only approximate since it is calculated by an off-hook simulation 
mechanism.

Useful parameters for calculating the cost of a communication:

Value of the basic metering unit before reaching the configured threshold (6 digits in the chosen
monetary unit, of which 0 to 2 are decimals)

Threshold for using the second basic metering unit value (in metering numbers from 0 to 99)

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> 1. Base Charge Rate

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> N° of units for cost threshold
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Second basic metering unit value (6 digits of which 0 to 2 are decimals)

Number of decimals in the cost

Notas : If it has been decided to operate with a single metering unit value, the same value must be 
given to the second metering unit value.

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency -> 2. Base Charge Rate

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency -> Fractional Part Length for Costs
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COST OF ISDN SERVICES

Since the costs of some facilities are not transmitted by the public network, it is possible to assign a 
given value to the cost meter whenever such a service is activated. 

Cost of ISDN services:

Cost of on-line metering (in metering units) in the case of manual activation (if the network does
not add the cost of the service at the beginning of the communication).

Cost of user to user signaling (in the chosen monetary unit, 6 digits – of which 0 to 2 are decimal).

Cost of PABX forwarding (in the monetary unit chosen, 6 digits – of which 0 to 2 are decimal).

Example of the calculation of the cost of a communication

This example shows the effect of using the "On-line metering" and "UUS" services in terms of commu-
nication costs.

Parameters configured: 

- basic metering unit value: 1.70 F
- threshold: 1 metering unit
- second basic metering unit value after threshold: 2 F
- cost of on-line metering: 4 metering units
- cost of UUS: 5.10 F

Example of a statement:

The 8 metering units are made up as follows:

- 1 metering unit for the call; cost = 1.70 F
- 4 metering units for activation of the on-line metering; cost = 7.70 F (1 x 1.70 F + 3 x 2 F)
- 3 metering units for UUS (number of metering units =UUS/first basic metering unit value cost, i.e.

5.10/1.70 = 3); cost = 5.10 F

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> Online Metering

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> User to User Information

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> Diversion Charge Rate

08:31A100 23/10/96 00:00:08 8 ST TI 00388677700............--> N01 14.500
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COMPLEMENTARY SERVICES

- On-line metering
This complementary service includes the services TOTAL COST (display of the total cost on release 
of the communication) and COST INDICATION (display of the cost during a communication). Dif-
ferent cases are possible:

Subscription to the TOTAL COST or COST INDICATION service means that the complementary service 
is activated on subscription to the network operator.

TOTAL COST or COST INDICATION on request (call by call) signifies that the complementary service 
is activated by system configuration (MMC) or by activation from an S0 set.
+ CS signifies that the cost of complementary services (UUS, terminal forwarding) is managed by the 
system (-CS if not).
At each automatic or manual activation of an ON-LINE METERING request, a charge unit is assigned 
to the caller. 

Activation of online metering during communication

Notas : The "At the end of the call" field (TOTAL COST on demand) is not used in France.

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency -> Advice of Charge -> check During the Call or At the End of the Call 

During a call

Complete
metering

management

Subscription

management.
Only

management of
the duration

TOTAL COST
NO

YESNO

YES

YESNO

Subscription
COST IND.

YES

NO
YES

NO

Subscripion
COST IND.

TOTAL COST
on request

COST IND.
on request

No metering Complete
management without

cost sharing 

YESNO
COST IND.

on request YESNO
COST IND.

on request

YESNO

TOTAL COST

for all calls for the call
(+ CS)

Complete
management without

cost sharing
for the call

(+ CS)

Complete
management with

cost sharing
for the call

(+ CS)

Complete
metering

management
for all calls

(+ CS)

Complete
metering

management
for all calls

(+ CS)

Complete
metering

management
for all calls

(+ CS)

Complete
metering

management
for all calls

(- CS)

on request

(+ CS)
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- User to User Signaling (I)
The cost of this service is programmable by MMC.
It does not depend on the length of the message. It is assigned as soon as the UUS is transmitted 
(even if the called party has not answered). The cost is assigned to the user who initiated the call: 
it therefore only applies to outgoing calls.
Note: During such a call, the cost of outgoing and incoming messages is assigned to the initiating 
user.

- Terminal forwarding or external forwarding (R)
A ticket or statement is printed whenever this feature is activated or deactivated.

BEARER SERVICES

One of the metering ticket fields mentions the "bearer service" used for the communication.

The following bearer services are provided:
- ST: voice, group 3 facsimile, teletext and videotex type services.
- T+: group 4 facsimile, transparent data transmission.
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INFORMATION DISPLAYED ON SETS

Temporary counters keep track of information destined to be displayed during a network conversation.

Information which can be displayed on all system terminals with displays (except S0 sets):

- duration
- duration + number of metering units (including for complementary services)
- duration + cost

Pulse meter

- This counter counts the number of metering units received on a line and assigns them to a given
subscriber.

- It is reset when the line is released or the call is transferred to a new subscriber.

Duration counter

- This counter adds up the duration (in minutes) during which a given line is in connection with a
given subscriber.

- It is reset when the line is released or allocated to a new subscriber.

Cost meter

- This counter records the cost of a communication (in local currency) between a given subscriber
and a trunk line.

- It is reset when the line is released or allocated to a new subscriber.

Examples of displays

- 4034 and Advanced sets: 

- 4023 set: 

- 4011, 4012, Easy and Premium sets: 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency -> Display on Sets

   00388736458   xxx.yy Frs xxx'   11:00
   Hold         jConf       jMF>

Hold

xxx.yy Frs xxx'

   xxx.yy Frs xxx'
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METERING COUNTERS

Description of the counters

The recording of the number of metering units and the cost of communications is done by 12 counters, 
distributed as follows:

- 10 set counters:
• 2 adding counters (one for the number of metering units and one for the cost):
• read only
• no reset possible
• the number of metering units displayed returns to zero when the maximum number is reached
• 8 partial counters (4 pulse meters, 4 cost meters) according to the on-line services defined:
• read only
• reset possible by MMC
• the storage capacity of these counters is 65535 metering units
- for a non S0 set, there is only one pulse and cost meter.

- 2 line counters:
• one partial pulse meter which can be reset
• one adding pulse meter which cannot be reset
- the storage capacity of these counters is 4 thousand million metering units.

All of these counters can be read from MMC-Station or from MMC-PM5 (the updating of metering 
counters at MMC-PM5 level can only be done during a PABX -> PC backup in a new file). 

Metering counters

Reading and resetting set counters

Reading and resetting line counters

Reading all the subscriber adding counters

Counter changes in break-out/transit

- normal break-out (leased line to public line): the line counter changes
- break-out by external forwarding (leased line to public line): the set counter changes
- normal transit (public line to public line): no counter change
- transit by hunting group external forwarding (public line to public line): the hunting group counter

changes

Meter printouts

- By MMC-PM5 (Expert View), select: Subscribers/Basestations List -> Subscribers/Basesta-
tions List -> subscriber identification -> Details -> Metering

- By MMC-PM5 (Expert View), select: External Lines -> List of Accesses -> line identification ->
Details

- By MMC-PM5 (Expert View), select: Metering -> Metering Counters
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The contents of the counters can also be printed out by the metering printer (by MMC-Station: Instal/
Admin -> Count -> Subscr or Access).

Set counters and operator counters

FIELD DESCRIPTION

USER Terminal number (max. 9 characters, right justified); the number format is:

- AXXX for a subscriber

- GXX for a hunting group

C1-C2-C3-C4 Partial pulse and cost meters per subscriber/hunting group (5 characters)

TOTAL Total cost meter per subscriber/hunting group (5 characters)

USER TAXES           : C1 C2 C3

TAXES AND COST COUNTERS PER SUBSCRIBER                                   -         12/08/00   14:05

C4 TOTAL
COST C1 C2 C3 C4 TOTAL:

A101 1203 20 0 400 2645
2467.50 422.32 0 53 23577.45

G1 23 0 2 0 60
47.05 0 23.76 0 458.32
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Line counters

Notas :

- Once a counter printout has been launched, no statement or ticket can be printed.
- A form feed is automatically performed before and after a counter printout.
- If the installer wants the SUBSCRIBER and the ACCESS counters to be printed on the same page,

the second printout request must be done before the end of processing the first printout.
- Pressing successively on the Subscr (or Access) key results in printing the counters twice. A third re-

quest is only taken into account when the first request has been printed.
- If a printout problem occurs (for example no more paper), any printout request is ignored.
- There is no specific display on the set for printer problems; only a system message is generated.

FIELD DESCRIPTION

ACCESS Access number (max. 5 characters, right justified); the number format is:

- LXX for an analog line during break in/break out

- NXX in the case of a T0 basic access

- PX in the case of T2 primary access

PARTIAL Partial pulse meters per access (10 characters)

TOTAL Total pulse meters per access (10 characters)

ACCESS PARTIAL

TAX METERS PER ACCESS                           -             12/08/00      14:05

TOTAL

L01 12030 26452584

N01 23532 6052487

L03 24543 6503452
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MANAGING METERING TICKETS AND STATEMENTS

The system enables metering tickets and statements to be printed out.

Selecting the type of metering printout

line-by-line statement printout or ticket printout (1 ticket per call)

Every call that meets the monitoring parameters defined for the various system terminals triggers a tic-
ket printout.

If a communication is free of charge (incoming call for example) or if an incoming call remains 
unanswered, the transmitted ticket will specify the call history (ringing time, call duration, etc.).

Set monitoring

Definition of the monitoring criteria values: cost threshold (monetary value), duration threshold
(from 0 to 99 minutes), international prefix (4 digits maximum).

Assigning the type of monitored communications for each set (parameter to be defined set by set):
none (no monitoring) or for all communications (outgoing and incoming) or all outgoing commu-
nications with monitoring criteria active; if this is the case, define the active criteria: duration thres-
hold (in minutes), cost threshold (6 digits of which 0 to 2 are decimals) or monitored (international
prefix).

It is also possible to assign a profile defining the applied monitoring criteria to a group of sets.

To print out a ticket or statement if an incoming call is unanswered (default setting = no)

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Type of Printout 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Active
Currency-> Activation Criteria 

- By MMC-PM5 (Expert View), select: Subscribers/Basestations List -> Subscribers/Basesta-
tions List -> subscriber identification -> Details -> Metering

- By MMC-PM5 (Expert View), select: Subscribers/Basestations List -> Subscribers/Basesta-
tions List -> Profiles

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts->check or uncheck
Print non-answered IC calls 
Ed. 04 13/30Réf. 3EH 21000 BSAA



CALL METERING SERVICES APPLICATIONS

 

FUNCTION OF THE BUFFER MEMORY

This is used to temporarily store the different messages (output terminal not available, several simul-
taneous messages, etc.).

The maximum number of tickets or statements that can be stored is 1000.

Alarm activation threshold

percentage of tickets or statements printed before the alarm is activated (between 0% and 99%:
70% by default)

As soon as the programmed threshold has been reached, an alarm is generated alerting the user 
(message in the call history + flashing of the operator LED).

When the buffer memory is full, any new information is lost.

XON/XOFF TRANSMISSION PROTOCOL

When the printer is ready to print, it transmits an XON control character. The data received is stored 
on a buffer. If there are only a certain number of bytes available on this buffer, the printer will transmit 
XOFF. It continues to receive characters and print before transmission halt. When part of the buffer is 
released, it transmits XON. The printer also transmits XOFF in the event of the following problems: 
printer off-line, no more paper, paper jam, etc.. It transmits XON when these problems have been re-
solved.

Notas : The printer DTR signal is connected to the interface CTS signal if XON is not received.

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Printer alarm
threshold  
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STATEMENTS PRINTED LINE BY LINE

Each statement corresponds to a communication (16 fields maximum, separated by a space.) 

Statement output format:

Definition parameters for a statement:

language for the printout

company name: max. 16 characters

masking the last 4 digits of the number dialed

maximum number of statements per page: 1 to 99 (50 by default)

form feed at the end of the day: yes/no (no by default)

Select printing of a header on each page, on the first page or not at all

Notas :

If the form feed is active, it will be performed:

- when the maximum number of statements per page has been reached
- at the end of the day: the number of statements printed in one day is indicated at the bottom of the

page on the right-hand side (5 digits maximum)
- during startup if the header printing parameter is active

- By MMC-PM5 (Expert View), select: Metering -> Printouts -> Language

- By MMC-PM5 (Expert View), select: Metering -> Printouts -> Company Name

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> check or uncheck
Masking 4 last digits

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Proofs per page 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> check or uncheck
Form feed permitted

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Head 

USER LINE TIME TAXES ADD. SERVICES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:02:40 6 ST 00388677700--> L04

I I I I

MODE COST

RINGI I BUSIN. CODE I

USER NAME

M 00:00 1.000
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fields to be printed on the statement; if none of the fields below have been defined, a default me-
tering statement is printed. It includes all the fields preceded by an asterisk (*):

Selecting:

- (*) charged user (yes/no)
- (*) communication type (yes/no)
- (*) trunk n° (yes/no)
- (*) date (yes/no)
- (*) time (yes/no)
- (*) duration (yes/no)
- (*) number of taxes (yes/no)
- (*) services (yes/no)
- (*) facilities (yes/no)
- (*) number dialed (yes/no)
- dialing mode (yes/no)
- ringing duration (yes/no)
- cost of communication (yes/no)
- business code (yes/no)
- subscriber name (yes/no)
- account code name (yes/no)
- initial user (yes/no)
- operator (yes/no)
- initial user – 8 digits (yes/no)
- charged user – 8 digits (yes/no)
- 4-digit line (yes/no)
- node (yes/no)

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Printed Fields ->
select each field: 
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DESCRIPTION OF THE FIELDS IN THE STATEMENT

FIELD DESCRIPTION

INITIAL USER (1) 5 characters (left justified)

Outgoing call: empty field indicated by ****

Incoming call: called number (hunting group or set)

- AXXXX for a subscriber (2, 3 or 4-digit numbering plans, or the last digits 
in the case of 8-digit numbering plans)

- GX for a hunting group (G9 for the attendant group)

CHARGED USER (2) 5 characters (left justified)

Outgoing call: caller

Incoming call: user who answered the call

Trunk identity not supplied: access number

- AXXXX for the calling or called user * (2, 3 or 4-digit numbering plans, or 
the last digits in the case of 8-digit numbering plans)

- LXX for an analog line during break in/break out

- NXX for T0 access (no private/public distinction)

- PXX for T2 primary access (no private/public distinction)

TYPE 3 characters (left justified)

Type of communication:

-->: outgoing call on public network

<--: incoming call on public network

CS+: request complementary service

CS-: cancel complementary service

LINE 3 characters

Number of the line:

- LXX for a public analog line

- NXX for a public or private T0 base access

- PXX for a public or private T2 primary access

For wake-up calls: R (for room)
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DATE 8 characters

Date of the communication, made up of 3 x 2 numbers separated by "/"

TIME 5 characters

Start time of the communication, made up of 2 x 2 numbers separated by ":"

DURATION 8 characters

Duration of the communication, 3 x 2 numbers separated by ":"

For wake-up calls: programmed time

TAXES 5 characters

Number of metering units

SERV 2 characters

Bearer services:

- ST: telephone service (voice, G3 fax, teletex, videotex)

- T+: G4 fax, transparent data transmission

FACILITIES Max. 6 characters (each character indicates one complementary service; all 
6 complementary services can thus be activated together)

Complementary service:

- I: user to user signaling

- R: terminal forwarding (external forwarding)

- T: on-line metering

- S: substitution (DISA transit)

- X: change correspondent (transfer)

- N: PABX forwarding

EXTERNAL CORRES-
PONDENT NUMBER

26 characters (left justified)

Dialed number:

- outgoing call: the number transmitted on the line (public or private)

- incoming call: the number received on the line (public or private)

- the destination number for external forwarding

For wake-up calls: WAKE-UP PROGRAMMED, WAKE-UP CANCELLED, 
WAKE-UP ACKNOWLEDGED, WAKE-UP NOT ACKNOWLEDGED: FREE or 
BUSY, SET NOT AVAILABLE
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MODE 1 character

Dialing mode

- M: manual dialing

- I: individual (or personal) speed dial numbers

- R: collective speed dial numbers

RING 5 characters

Duration of the ringer, for all incoming ringing phases, made up of 2 x 2 
numbers separated by ":"

COST 10 characters

Cost of the communication including ISDN service activation, where appli-
cable

BUSIN CODE 16 characters (right justified)

Charge account code specific to the communication

SUBSCRIBER NAME 16 characters

User name:

- outgoing call: caller

- incoming call: called party

- name associated with the account code

NODE Field not used

OPE. 1 character

Operator identifier

INITIAL USER 9 characters (left justified)

Same functions as field 1; employed when using an 8-digit numbering plan

CHARGED USER 9 characters (left justified)

Same functions as field 2; employed when using an 8-digit numbering plan

LINE 4 Field used instead of LINE when identification requires 4 characters; in this 
case, the NXX and VXX identifiers from the LINE field are replaced by N** 
and V**.
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EXAMPLES OF STATEMENTS

Outgoing call

Transfer of an outgoing call

t A101 calls an external number then transfers the communication to 125.

Transit call

t A101 is forwarded on the private external number 751234.

Incoming subscriber call

t Incoming call answered by the called subscriber.

t Incoming call answered by a subscriber (A125) other than the called subscriber (dynamic forwarding, 
interception, monitoring, immediate forwarding).

Incoming hunting group call

t Incoming answered hunting group call. 

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:02:40 6 ST 00388677700--> N1

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

M 00:00 1.000 DUPONT

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:02:40 6 ST 00388677700--> N1

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

M 00:00 1.000 DUPONT
08:31A125 23/10/00 00:03:20 8 STX 00388677700--> N1 M 02:00 1.000 MARTIN

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:00:00 0 ** 751234CS+

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

M 00:00 0.000R DUPONT
08:31A101 23/10/00 00:03:20 1 ST 751234I-> N1 M 00:00 1.000 DUPONT
08:31A101 23/10/00 00:03:20 0 ST<-I N1 M 00:00 1.000 DUPONT

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:02:40 0 ST 00388677700<-- N1

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

A101 M 00:04 0.000 DUPONT

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A101 23/10/00 00:02:40 0 ST 00388677700<-- N1

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

A125 M 00:04 0.000 MARTIN

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBER

08:31A125 23/10/00 00:02:40 0 ST 00388677700<-- N1

I I I I

MODE COST

RINGI I BUSIN CODE I

USER NAME

G50 M 00:04 0.000 MARTIN
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External forwarding

t The operator is forwarded on the external number 0388677700; 125 calls the operator.

USER LINE TIME TAXES FACILITIES
TYPE DATE DURATION SERV DIALLED NUMBER

08:31G9 23/10/00 00:00:00 0 ** 00388677700CS+

I I I I
MODE COST

RINGI I BUSIN CODE I

USER NAME

M 00:00 0.000R PO
08:31G9 23/10/00 00:03:20 1 ST 00388677700--> N1 M 00:00 1.000

G9 CS- indicates forward cancelled
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METERING TICKETS

Printout format of a ticket

Definition parameters for a ticket:

language for the printout

company name: max. 16 characters

masking the last 4 digits of the number dialed

number of lines between tickets (1 by default)

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Language 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Company Name 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> check or uncheck
Masking 4 last digits

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts -> Number of Blank
Lines 

N 19 ALCATEL

SUBSCRIBER : A122
23.10.2000:
11:

DATE
LINE

08:35:TIME
00388677700:NUMBER
3.50:COST

Number of the ticket prin
ted during the day (here, it 
is the 19  ticket printed on  th

23/10/2000).
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Description of the fields in the metering ticket

WAKE-UP

Conditions for printing a ticket/statement for wake-up calls or temporary appointment re-
minders:

- wake-up activated
- wake-up cancelled
- wake-up failed
- wake-up answered

Printout format for a ticket

FIELD DESCRIPTION

SUBSCRIBER or TER-
MINAL

Number of the set or terminal (max. 8 characters) 

This number is preceded by A if it corresponds to a set

DATE Current date. 8 characters: 3 x 2 digits separated by "/" 

LINE 3 characters

Number of the trunk line used (2 characters)

- LXXX for a public analog line

- NXXX for a public or private T0 base access

- PXXX for a public or private T2 primary access

- VXXX for an IP trunk

TIME Start time of the communication, made up of 2 x 2 numbers separated by 
"H".

NUMBER Number dialed (max. 26 characters)

COST Cost of the communication or complementary service

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Printouts-> Appointment prin-
tout for… 

N 19 ALCATEL

SUBSCRIBER : A122

25.12.2000:

08:35:

DATE

TIME

ALARM ACKNOWLEDGED
Ed. 04 23/30Réf. 3EH 21000 BSAA



CALL METERING SERVICES APPLICATIONS

 

Printout format for a statement

The fields TYPE, TAXES, MODE, RING, COST, BUSIN CODE and SUBSCRIBER NAME are not signifi-
cant. The DURATION field is only filled in if the time is programmed. 

R = room.

USER LINE TIME TAXES FACILITIES

TYPE DATE DURATION SERV DIALLED NUMBERI I I I

MODE COST

RINGI I BUSIN CODE I OPERAT. I

USER NAME NODE

08:31A122 25/12/00 07:45 ALARM PROGRAMMED-->
08:31A122 25/12/00 CANCELLED-->
08:35A122 25/12/00 ACKNOWLEDGED-->
08:31A140 25/12/00 NOT ACKNOWLEDGED : FREE-->
08:35A145 25/12/00 NOT ACKNOWLEDGED : BUSY-->
08:35A146 25/12/00 STATION NOT AVAILABLE-->

ALARM
ALARM
ALARM
ALARM
ALARM

R
R
R
R
R
R
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USING THE EURO

This paragraph describes the configurations which need to be carried out to accommodate for the fu-
ture integration of the Euro in several European countries.

The following parameters need to be configured: 

the conversion rate with the current currency of the country:

Specify whether the public network operator carries out this conversion at the same date.

the label used ("EUR", for example):

the date and time of the conversion: 

At the date and time specified, the system will manage the following Euro conversions: 

- partial counters and accumulators of sets and meter credit for Hotel clients.
- basic meter charge cost and cost thresholds (Business and Hotel), cost of VAT (Hotel).
- cost of metering reminder.

If the public operator carries out the conversion, then the conversion report between the system cur-
rency and the public network currency is equal to 1, and the following parameters are to be configu-
red:

- real cost of the metering unit.
- cost of UUS and PABX forwarding.

- By MMC-PM5 (Expert View), select: Metering -> Currency Conversion -> Exchange Rate

- By MMC-PM5 (Expert View), select: Metering -> Currency Conversion -> check o No Con-
version, o User Defined or o Immediately 

- By MMC-PM5 (Expert View), select: Metering -> Metering -> Metering Options for Inactive
Currency -> Currency Name

- By MMC-PM5 (Expert View), select: Metering -> Currency Conversion->  Conversion Date
& Time (only on selecting o User Defined 
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ANNEX: V24 CONFIGURATIONS

V24 Signals

Functions performed by the various managed circuits (indications for 25-point connectors)

(*): pin not assigned in standard EIA-RS232

101 (1): Protection Ground (PG)

This pin ensures continuity between the earth on the cable and on the optional board (the protection 
and signal grounds are in this case connected to a joint reference).

Female socket
(view from behind station)

DSR

CTS

RTS

RD

TD

PG

TI RI DTR LL

13

25

1

14

DCD

SG

RTS

RD TD

5

6

1

9

0V CTS

No of
pin

No of
circuit Meaning

Abbreviation
Direction

7 102

2 103

3

4

5

6

20

8

22

104

105

106

107

108/2

109

125

18 141

DTE --> DCE

DTE <-- DCE

DTE

DTE

DTE

DTE

DTE

DTE

-->

<--

<--

<--

<--

-->

DCE

DCE

DCE

DCE

DCE

DCE

DTE --> DCE

TS

CCITT EIA

ED

RD

DPE

PAE

PDP

TPD

DS/DP

IA

25 142

BL

IT

SG

TD

RD

RTS

CTS

DSR

DTR

DCD

RI

LL

TI DTE <-- DCE

1 101 PGTP

108/1 DTE --> DCECPD (*)

Protection Ground

Signal Ground

Transmit Data

Receive Data

Request To Send

Clear To Send

Data Set Ready

Connect Data Set
Data Terminal Ready

Data Carrier Detect

Ring Indicator

Local Loop

Test Indicator
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102 (7): Signal Ground (SG)

Reference potential for the junction circuits.

103 (2): Transmitting Data (TD)

The data signals from the DTE are transmitted to the DCE on this circuit.

104 (3): Receiving Data (RD)

The data signals from the DCE are transmitted to the DTE on this circuit.

105 (4): Request To Send (RTS)

This circuit commands the DCE to prepare to transmit on the data channel.
Closed status forces the DCE into transmission mode.
Open status forces the DCE into non transmission mode on the data channel once all the data trans-
ferred on circuit 103 has been transmitted.
When connecting a DTE without a circuit 105, you should loop circuits 105 and 106 on the DCE soc-
ket.

106 (5): Clear To Send (CTS)

This circuit indicates whether the DCE is ready to receive data signals on circuit 104 and to transmit 
them on the data channel.
Closed status indicates that the DCE is ready to receive data signals from the DTE on circuit 103.
Open status indicates that the DCE is not ready to receive data signals from the DTE on circuit 103.
In full-duplex mode, this circuit, in association with circuit 105, enables flux control during the data 
transfer phase. Closed status means that the remote unit authorizes transmission.

107 (6): Data Set Ready (DSR)

The closure of this circuit indicates that the DCE is ready to operate. This acknowledges the data chan-
nel trunk seizure.
In addition to the trunk seizure, this circuit indicates that the DCE is ready to exchange other signals to 
trigger the data exchange (initialize the dialog).

108/1 (20): Connect data set to line (CDSL)

This signal, transmitted by the DTE, forces the DCE to connect to the data channel.
Incoming call: As a general rule, the DTE emits this signal in response to an incoming call defined by 
the closure of circuit 125 on the DCE. The DCE then closes circuit 107 as soon as the line is seized, 
which triggers the dialog initialization phase. This circuit enables the DTE to remain in control of the 
response to incoming calls, postponing or barring trunk seizures during critical operating phases.
Outgoing call: The closed status of this circuit can be used to initialize an outgoing direct call with an 
automatic call DCE.
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108/2 (20): Data Terminal Ready (DTR)

The DTE closes this circuit to tell the DCE it is ready to operate.
Incoming call: closing circuit 108/2 authorizes the DCE to take an incoming call. The DTE is advised 
accordingly by the closure of circuit 107 to indicate the trunk seizure. The dialog initialization phase 
now begins.
Outgoing call: the outgoing call is initialized between the DTE and the DCE by a local dialog exchan-
ged on circuits 103 and 104.

109 (8): Data Carrier Detect (DCD)

Closing this circuit indicates that the carrier signal received on the data channel meets the relevant spe-
cifications.
This circuit can also be used in the closed state for DTE-DCE data exchanges when programming or 
controlling serial automatic call DCEs.

125 (22): Ring Indicator (RI)

This circuit is closed to tell the DTE that a call signal has been received by the DCE.

141 (18): Local Loop (LL)

This circuit controls type 3 test loops in the DCE.
The closure of the circuit loops the DCE transmission channel back to the reception channel, on the 
data channel side. On detecting that circuit 142 is closed, the DTE can then, in full-duplex mode, test 
the DCE transmission interfaces. This looping function is not yet available in the current state of deve-
lopment of the product.

142 (25): Test Indicator (TI)

The closure of circuit 142 indicates that the DCE is in test mode, which precludes any transmission with 
a remote DTE.

V24 metering printouts: configuration details

Physical characteristics

- Type of interface: V24
- Operating mode: asynchronous
- Interface function: DCE

Transmission characteristics

- Number of significant characters: 5, 6, 7 or 8 (default value)
- Parity: even, odd, no (default value), marked (set at 1) or spaced (set at 0)
- Number of stop bits: 1 (default value), 1.5 or 2
- Baudrate: 50, 75, 150, 300, 600, 1200, 2400, 4800, 9600 (default value), 14400, 19200
- Rate adaptation: V110 (default value), X31, V120 or V14E (for 57600 bps)
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Flux control

Possibilities available in either instance – flux control of the terminal by the adapter and vice versa:

- Mode: none (no flux control), inband (control with 2 characters - XON and XOFF by default) or
circuit (control with the RTS and CTS signals)

- If Mode = inband, then decimal value for XON (17 by default) and XOFF (19 by default)

Implicit number of XON characters

This field defines the number of XON characters required to boot the equipment:

- Zero
- One
- Two
- Three
- Four
- XANY (non-significant option)

Echo

Check the box for a local or character by character echo in Command mode. 

No input acknowledgement

Check the box to operate without V24 device input acknowledgements at the terminal.

Display caller address

Check the box to send the caller address to the terminal or DCE. 

Escape sequence

This field defines a sequence of 3 characters maximum for switching the V24 device from CONNEC-
TED (data transmission) mode to COMMAND mode. Each character is defined by entering its decimal 
value: the hexadecimal value and the character are displayed automatically.

Communication protocol

- Hayes
- Automatic
- V25 bis 108/1
- V25 bis 108/2
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DSR option

This field defines the operating mode for the DSR signal:

- Always active
- Active during the call
- Inactive in release phase

DTR option

This field defines the reaction of the DTR signal:

- Normal
- Forced

RTS option

This field defines the reaction of the CTS signal when the RTS signal changes state:

- CTS tracks RTS
- RTS ignored, CTS ON

Inactivity timeout

This field defines, in 30-second increments, the period of inactivity after which the call is released.

Loopback mode

This field defines the test loopback employed:

- no loop
- loop 1 (as defined by the V54 recommendation)
- loop 2 (as defined by the V54 recommendation)
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STARTING-UP AN ELITECOST 64-128
The Elitecost 64-128 Enterprise (or Business), Guest or Hotel can be installed on the system Alcatel 
OmniPCX Office. It operates starting from the version 19.3 release R1.1. 

CONNECTING THE ELITECOST 64-128

Connect the V24 cord supplied, from the DB9 ’PBX" connector of the Elitecost 64-128 to the DB9 "V24" 
connector on the 4093 Box (V24 option).

PROGRAMMING OF ELITECOST 64-128

Refer to the Installation Manual of the Elitecost 64-128 section III page 38.

Alcatel OmniPCX Office

Eltecost 64-128

Reflexes set (UA)

UA cord V24 cord

"PABX" connectorV24 connector

with V24 option

UA connector
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CONFIGURING THE ALCATEL OMNIPCX OFFICE

The Elitecost 64-128 Guest or Hotel operates only in the Hotel mode. To configure the system Alcatel 
OmniPCX Office, please perform the following operations via PM5 (Expert View):

Check that the system is operating in the Hotel mode ; if not, perform a cold reset and run the
"Wizard" to shift into the "Hotel" mode.
Connect the PC with the system and open the "Communication path" session.
Activate monitoring for alls calls on all subscribers:

Activate the external metering and choice the language:

In the Printed Fields of Proof, select all the fiels except User 8 and Trunk 4.
Manage appointment calls by Elitecost (applicable from Elitecost version 4.2 only:

Nota :Check the Amount of taxes field only if you have configured in the Elitecost te "4. Unit rat 
= 0 field in "3. Configuration" menu -> "3. Costing" -> "1. Costing parameter

Set option V24/UA (ASM 4093) used for metering inMetering -> Metering Transmission Cha-
racteristics" , ensure that the format is 9600 8 N1.
For the V24 port, remove the flow control, check the transmission format and change the commu-
nication protocol to V25 bis 108/1

Check printing check-in/check-out tickets:

- Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> Metering ->
Monitoring -> select o All calls 

-  Subscribers/Basestations List -> Subscribers/Basestations _> Details -> Metering -> ac-
tivate o External Metering Activation, Language = English 

-  Subscribers/Basestations List -> Subscribers/Basestations _> Details -> Metering ->
Appointment printout for... : Activation, Cancellation, Failed, Complete 

- Subscribers/Basestations List -> Subscribers/Basestations List -> Details -> V24

- System Miscellaneous -> Hotel parameters -> Print check-in/check-out
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NMC (Network Management Center)
The Alcatel 4740 network Management Center has been designed to enable telephone network ma-
nagers to manage, administer and optimize one or several Alcatel OmniPCX Office communication 
systems remotely.

ENVIRONMENT

Connecting remote Alcatel OmniPCX Office systems (Management Center subscribers)

All remote Alcatel OmniPCX Office subscribed systems which are managed by the same Management 
Center are connected to the public network (PSTN or ISDN) through analog trunk lines or T0/T2 ac-
cesses.

Notas : ANALOG NMC:

The TL must be configured with Polarity Inversion to release the modem (the Management Center 
being the master of the communication).

Connecting the Management Center

The Alcatel 4740 station is connected to the Alcatel OmniPCX Office system by an Ethernet link (the 
client LAN).
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CONFIGURATION AND IMPLEMENTATION

The Network Management Control option makes it possible to access the various configuration win-
dows to set the network management parameters. To access the NMC home window from within the 
main menu:

Attention :

Programming the authorized callers also affects access to the system by NMC, as well as remote access 
by PM5.

"NETWORK MANAGEMENT" SUB-MENU

Network Management Active

Check the box to activate the central management feature (this avoids starting up the management 
feature before the end of the system configuration). By default, the feature is inhibited. 

General

- Access Type: this field, not modifiable by PM5, indicates the access mode: direct or guarded.
-  NMC N°  for automatic alarm reporting (outside NMC sessions): the collective speed dial number

(4 digits) of the Management Center to be dialed for automatic notification of alarms if there is no
active NMC session.

- Network Management Software Version: this field, not modifiable, states the software release
of the remote system.

- System label: this field, with a maximum of 30 characters, states the name of the remote system.
The name is defined by the Management Center; it cannot be modified by PM5 (Expert View).

Notas :

The fields which are not modifiable by PM5 (Expert View) are defined either by the system or by the 
Management Center; thus, as a minimum, an "on-line" connection with the remote system is required 
so that these fields can be exploited.

Select the Network Management Control menus -> the following sub-menus are proposed: 
Network Management, Urgent Alarms
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Call Accounting

- Active call accounting for: Activation of the metering management according to the type of calls:
the following choices are offered:
• no call
• incoming calls
• outgoing calls
- incoming and outgoing calls (default value)

- Database threshold for alarm activation (by default: 80 % ):100 % = from 1,000 to 30,000
tickets, depending on the software license and the hardware configuration. When the assigned
threshold is reached, an alarm is sent to the Management Center (on condition that automatic
alarm reporting is activated and the 'NMC_THRESHOLD_METERING_TBL' alarm is configured as
urgent); the Management Center reacts to the alarm and connects up to the remote system in order
to collect and void the metering tickets.

Alarm Reporting (Only visible after clicking the "Part 2" button)

Alarm reporting enables the remote system to inform the Management Center as soon as an abnormal 
event arises with the PABX.

- Automatic alarm reporting: check the box to activate automatic alarm reporting; by default, this
feature is inhibited.

- Reaction on erroneous call (for example, the call number does not correspond to that of the Ma-
nagement Center):
• Time before retry (min): waiting time, in minutes, before trying again (value between 1 and

12 minutes inclusive, by default: 12 minutes)
- Max. number of retries: maximum number of call backs (a single call back authorized)

- Reaction on non-answered calls (for example, the Management Center has not answered, as all
the accesses are busy):
• Time before retry (min): waiting time, in minutes, before trying again (value between 1 and

12 minutes inclusive, by default: 12 minutes)
- Max. number of retries: maximum number of call backs (value between 1 and 99, by default:

50)
- Threshold for alarm reporting activation (by default, when the threshold is reached, an alarm is

sent to the Management Center). The Management Center is connected to the remote system auto-
matically so as to deduct the alarm information:
• History table: by default 80 % (100 % = 400 history messages)
• HW anomaly table: hardware messages, by default 80 % (100 % = 200 hardware messages)
- Urgent Alarm table: by default 80 % (100 % = 200 urgent alarm messages)
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"URGENT ALARMS" SUB-MENU

This window makes it possible to define the urgent alarms for hardware anomalies as well as historic 
messages.

Pre-defined urgent events in the Hardware Anomalies table:

- UNSUCCESSFUL ATTEMPT TO PRINT:  Message emitted by the formatter (printer) after every 5
failed print attempts.

- T2_NO_SIGNAL: A signal shortage has been detected on a T2 access.
- T2_RECEIVE_REMOTE_ALARM: A remote alarm indication has been received on a T2 access.

RECOMMENDATIONS FOR IMPLEMENTATION OF THE NMC FEATURE (remote system)

The recommended procedure is as follows:

- activate network management (value deactivated by default or after a cold reset)
- enter the remote system's complete configuration: 

• station number for alarm reporting
• validation of the automatic alarm reporting feature
• definition of the various thresholds
• definition of the urgent alarms
- etc...

- activate the central management feature by checking the "Network Management Active" box in
the "Network Management" window

- carry out a warm reset for table dimensioning
- check that the call number has been programmed properly.
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POINT TO POINT / POINT TO 
MULTIPOINT T0
DEFINITIONS

Point to Point link: a Point to Point link is a digital access to the public network used exclusively by 
Alcatel OmniPCX Office. The TEI settings are generally fixed, as there is only one terminal (Alcatel Om-
niPCX Office) for this access, but they can also be dynamic.

Point to Multipoint link: a Point to Multipoint link is a digital access to the public network shared by 
several terminals. In this type of configuration, each terminal is identified by its TEI and dedicated DDI 
sequence. The TEI management mode can be fixed or dynamic, depending on the public operator.

Both types of link can be supported simultaneously on the same system. The TEI management mode 
(fixed or automatic) is configured separately for each access.

Example of the environment

This example illustrates both connection types: Point to Point and Point to Multipoint.

Terminal 1 (TEI 1= 64)

Auto TEI = 64 to 126

Public ISDN
exchange   

T0 bus

T0 MSN 1

MSN 2, MSN 3

MSN 4, MSN 5, MSN 6, .... MSN n

DDITEI fixed = 0

T0 Point-to-Multipoint

T0 Point-to-Point

... other terminals
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DYNAMIC TEI

This feature assigns a TEI automatically to each T0 bus (mainly assured by the public network on mul-
tipoint accesses).

At each connection and at each reset, (cold or warm), each T0 "asks" the network to allocate it a TEI; 
this procedure is carried out by sending 2 level 2 messages: the "Identity Request" message sent by the 
system to the network, then the "Identity Assigned" message sent by the network. The value assigned is 
stored by the system until the next reset.

Possible TEI values (in accordance with ETS300 125)

- 0 to 63: fixed TEIs (values used on the system side)
- 64 to 126: automatic TEIs (values used on the network operator side)
- 127: value reserved for management operations

CONFIGURATION

T0 configured in Point to Point

To define the management mode:

For fixed TEI, assign a value between 0 and 63 inclusive:

Configuring the installation number:

Completing the substitution table (refer to the file concerning DDI with more than 4 digits in the
"System Features" section):

When changing from a digital access with fixed TEI management to automatic TEI manage-
ment, it is essential to perform a warm reset so that the PABX sends the TEI allocation re-
quest to the public exchange; if not, the TEI management on the system will be unstable.

By MMC-PM5 (Expert View), select: External Lines -> List of Accesses -> Details -> check o Fixed 
TEI  or o Auto TEI  

By MMC-PM5 (Expert View), select: External Lines -> List of Accesses -> Details -> Value

- by MMC-PM5 (Expert View): Numbering -> Installation Number
- by MMC-Station: Global -> Ins Num -> Public

- by MMC-PM5 (Expert View): Numbering -> DDI Number Modification Table
- by MMC-Station: Num Pln -> PubNMT
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Fill in the public numbering plan:

T0 configured in Point to Multipoint

- To configure the T0 access in Point to Multipoint:

- To define the management mode:

- For fixed TEI, assign a value between 0 and 63 inclusive:

- Configuring the installation number:

- Completing the substitution table (refer to the file concerning DDI with more than 4 digits in the
"System Features" section):

- Fill in the public numbering plan:

- by MMC-PM5 (Expert View): Numbering -> Numbering Plans -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum

By MMC-PM5 (Expert View), select: External Lines -> List of Accesses -> Details -> select o Point 
to Multipoint

By MMC-PM5 (Expert View), select: External Lines ->  List of Accesses -> Details -> select o Fixed 
TEI or o Auto TEI

By MMC-PM5 (Expert View), select: External Lines -> List of Accesses -> Details -> Value

- by MMC-PM5 (Expert View): Numbering -> Installation Number
- by MMC-Station: Global -> Ins Num -> Public

- by MMC-PM5 (Expert View): Numbering -> DDI Number Modification Table
- by MMC-Station: Num Pln -> PubNMT

- by MMC-PM5 (Expert View): Numbering -> Numbering Plans -> Public Numbering Plan
- by MMC-Station: NumPln -> PubNum
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ADDITIONAL INFORMATION

- By default, the T0 accesses are in Point to Point with automatic TEI management for all countries.
- Once the system has been configured for automatic TEI and reset, the automatic TEI request is sent

to the network. If there is no reply before the T202 timeout, the system switches back to fixed TEI
mode;  otherwise, it stays in automatic TEI mode.
Ed. 044/4 Réf. 3EH 21000 BSAA



9

PERMANENT LOGICAL LINK (PLL)APPLICATIONS

 

File
PERMANENT LOGICAL LINK (PLL)
The Permanent Logical Link (PLL) service handles the simultaneous bi-directional transfer of data fra-
mes between a T interface (T0 or T2) and an S0 interface (ePLL) or between 2 S0 interfaces (iPLL), each 
interface being one extremity of a semi-PLL with:

- either a public network Packet Access Point (PAP) on the T interface side

- or an S0 terminal connected to the S0 bus on the S0 interface side.

The data packets are exchanged on this link in a transparent way through the D channels of these ac-
cesses.

The rate for this type of data transmission is limited to 9600 bps.

The link between the 2 Alcatel OmniPCX Office interfaces that connect the 2 semi-PLLs is established 
by configuring a routing table.

The S0 terminals are connected to 4084 or 4094 interfaces.

DEFINITIONS

- SAPI: Service Access Point Identification; the value in the SAPI field identifies the type of information
transported by the data link and, for this reason, identifies the targeted access point, source or fra-
me destination. By default, a SAPI value of 16 is assigned to links carrying X25 type packets to the
PAP.

- TEI: Terminal Extremity Identification

EXTERNAL PLLs

The system makes it possible to establish one or several external PLLs (ePLLs) between T accesses of 
the system and a data network access port and also to extend them to S0 accesses according to the 
following rules:

- each ePLL associates the trinome [Interface T, SAPI (16), TEI] with an [Interface S0, SAPI (16), TEI]
trinome.

- a T or S0 interface can be used for several ePLLs (max. 4) by changing the TEI value.
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General synopsis of an external PLL

INTERNAL PLLs

The system makes it possible to establish one or several internal PLLs. The following rules apply to in-
ternal PLLs (iPLLs):

- each iPLL associates the trinome [Interface S0, SAPI (16), TEI] with an [Interface S0, SAPI (16), TEI]
trinome.

General synopsis of an internal PLL

S0

S0

S0
S0

S0

T0

T0

PAP

S0 Terminal 

I
S
D
N

(fixed 16
sapi, tei)

(fixed 16
sapi, tei)

ePLL

Alcatel OmniPCX Office

S0 Terminal 

S0

S0

S0

S0

S0

Alcatel OmniPCX Office

S0 Terminal 

(fixed 16
sapi, tei)

(fixed 16
sapi, tei)

PLL
S0 Terminal 
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CONFIGURATION

Preliminary

Before configuring the PLL, the installer must:

- define the S0 and T0 accesses
- check that the interfaces to be used are present in the "Subscribers/Basestations List" screen (for S0

interfaces) and the "External Lines" screens (for T interfaces)

Creating a PLL

To create a PLL, proceed as follows:

- choose the PLL caller from the list of declared accesses presented in the left-hand part of the win-
dow.

- enter the TEI of the caller PLL (SAPI = 16 is displayed, this value is not modifiable): 
• for an external access, the TEI is given on subscription by the public network operator and is

between 0 and 63 inclusive.
- for an internal access, the TEI is between 1 and 63 inclusive (depending on the configuration

of the terminals).
- choose the PLL destination from the list of declared accesses presented in the right-hand part of the

window.
- enter the TEI of the destination PLL (follow the same procedure as for the TEI of the caller PLL)
- click Add to establish the connection. If all the checks are OK (see below), the connections are ad-

ded to the list of existing PLLs.

Checks

- The system can contain a maximum of 32 PLLs. 
- The system cannot contain PLLs between 2 external accesses.
- The caller and the destination of the same PLL cannot be one and the same (same physical address

and same TEI).
- 4 TEIs per basic access (S0/T0), 16 per primary access (T2); 2 PLLs associated with different acces-

ses can have the same TEI (there is no check at MMC-PM5 level).

Overflow

It is possible to overflow onto a second destination if the initial destination is busy by configuring the 
same caller with 2 different called parties. 

Nota : Once declared, an ePLL or iPLL is bi-directional, i.e. either interface can initiate a call.

- by MMC-PM5 (Expert View), select:  Subscribers Misc. -> Permanent Logical Link
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INSTALLATION PROCEDURES
PM5 is the unified administration and configuration tool for Alcatel OmniPCX Office; running on a PC, 
it can be used to program the system's voice functionality, voice mail, the network, Internet access, 
downloading… even the printing of mailing labels.

MINIMAL PC CONFIGURATION

- Pentium 166 MHz processor.
- RAM: 32 MB for Windows 95, 98 and 2000; 64 MB for Windows NT.
- Hard disk.
- Screen: 800 x 600 pixels
- 1 mouse.
- 1 serial port (connection to Alcatel OmniPCX Office for data transfer)
- 1 Ethernet board (IP mode).
- Operating system: Windows 95, 98, 2000 or NT4, pack 5 minimum.
- 64K PPP-compatible ISDN or V34 modem for remote access.

INSTALLING THE PM5 SOFTWARE

The PM5 software is installed from a CD-ROM.

The application is installed by making selections from the options proposed in the various windows. 

When installation is completed, you access the application by double-clicking on the new icon created 
on the Windows desktop or:

- Select Start then Program then Alcatel OmniPCX Office then PM5.

- The window Welcome to PM5 appears.

PM5 REMOTE ACCESS

Remote access with PM5 makes it possible to configure or download to an Alcatel Omni PCX Office 
system.This access can be managed with:

- an ISDN modem able to use ISDN PPP (point to point) protocol at 64 K.

- a V34 analog modem in Hayes protocol at 33600 bds.

These two modems are integrated on Alcatel OmniPCX Office.
It is implied that software PM5 will have to be installed before on the PC using remote maintenance.
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REMOTE ACCESS BY ISDN MODEM

ISDN modem recommended

Alcatel OmniPCX Office is equipped with an 64 K ISDN modem using PPP protocol for remote access 
through the public network. It offers a point-to-point link accessible for standard LINUX protocols (SLIP, 
PPP...). The following modems has been validated:

- KORTEX NOVAFAX ISDN 128000/33600 with PPP protocol 
- FRITZ!  X CAPI 2.0 or any standard "FRITZ" modem 
- Multitech I Way Hopper MTA 128 ST 128 KBPS ISDN

Usually, an ISDN modem from 64 to 128 K supporting PPP protocol will be compatible.

RAS installation process

The procedures described hereafter relate to PC under Windows NT4 having the "IP stack." option The 
use of remote access requires to have RAS (Remote Access Service) installed on the PC.

There are two phases for installation process:

- Install the RAS for the Alcatel modem (V24 modem)

- Install the ISDN modem and configure the RAS to use it.

Nota : To install the RAS, it is mandatory to have the Administrator rights , the Windows NT instal-
lation CD-ROM and service Pack 6.

RAS installation process

- Open the Control panel.
- Open the Network folder.
- Select Services tab
- Click on Add.
- Select in the list Remote Access Services.
- When asked by Windows NT"Set-up", select the driver's path or provide Windows NT CD installa-

tion CD Rom.
- Select in the modem list, Com 1 Alizé direct connection 115000 Bds or Com 2 Alizé ... for a

future use of V24 PM5 connection
- Click on Continue
- Click on Close, then click on continue
- CAUTION CAUTION CAUTION
- At the end of the installation, the system asks "to restart the computer now"
- Click on NO.
- Now install service Pack 6 "spxi386.exe" with your Windows NT CD Rom Installation.
- Reboot the PC
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ISDN modem installation process (example)

This is for a FRITZ modem.

- Insert the modem installation CD-ROM
- Click the FRITZ !X PC Capi driver installer icon
- In the Wizard mode, indicate the serial port to connect the modem.
- At the end of the Wizard, reboot the PC
- Insert the modem installer CD-ROM
- Click the FRITZ !32 Communication Software installer icon
- In the Wizard mode, select Install and configure
- Use the default installation (click on Next in each Wizard screen)
- At the end of the Wizard mode, check the Install Capi-port driver box
- Select AVM ISDN1 Internet (PPP over ISDN)
- Reboot the PC.

RAS configuration process

- Open the Control panel.
- Open the Network folder.
- Select Services tab
- Click on Add.
- Select in the list Remote Access Services or, if not installed, add "remote access service" using pro-

cedure described in previous paragraph.
- Click on Properties.
- The list shows Com 1 Alizé Direct serial link connection
- Add FRITZ AWM ISDN1 Internet (PPP over ISDN. Important If another modem is all ready

installed on the port you decided to use, remove it and install the new one.
- Click on Continue
- Click on Close
- Reboot the PC

Alcatel OmniPCX Office remote access creation

- Open the My Computer Windows.
- Select the Dial up network icon.
- Create a new connection using default parameters and entering a connection name (xxx)
- Verify that the modem used is well AWM ISDN1 Internet (PPP over ISDN).
- Click on Next
- Do not enter any telephone number
- Click on Finish.
- Close the folder.
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Use of the remote access with PM5

- Launch PM5.
- Select the Expert menu.
- Click on Comm.
- Select Connect.
- Click on Modem direct, then click on OK
- Click on Dialing and Select AWM ISDN1 Internet (PPP over ISDN).
- Dial the customer phone number and click on OK.
- Write the password pbxk1064.
On the modem the LED PC & B1 have to be lit; the connection is establish.
The configuration session is open.

Remote access to the ISDN modem

When an ISDN modem is used, it is necessary to reserve a DDI number in the public numbering plan 
in order to be able to carry out a remote access.
If no DDI number is available, just check if the system ISDN modem access is present in the attendant 
group by default (default group). Consequently, it is not necessary to hold a DDI number.

Nota : if the modem is not in the current attendant group, it is interesting to position the flag " Re-
routdata " with value 01H; the system then recognizes automatically the "ISDN Service" cor-
responding to the incoming call and search automatically in the default attendant group if 
a data terminal is present.

REMOTE ACCESS BY THE ANALOG MODEM

Analog modem recommended

Alcatel Omni PCX Office is equipped with an analog modem V34 for remote access through the public 
network.  This one offers a point-to-point communication link accessible by standard protocols LINUX 
(SLIP, PPP...).
Its main characteristics are: Modem V34, 33600 bds transmission speed max., protocol Hayes.
In the current 1.1 version of the system, only the modem V34 "US Robotic" has been validated.
The " Multitech " modems are not compatible.
The other types of modems were not validated.

Installation process of the remote access by analog modem

Follow the same procedures described in previous paragraphs . in the preceding chapter but replace 
modem FRITZ by analog modem US Robotics.

Remote access to the analog modem

When the analog modem is used, it is necessary to hold a DDI number in the public numbering plan 
in order to be able to carry out a remote maintenance.
In the case of no DDI number is available, the access to the modem will be possible only via the ope-
rator transfer.
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OPERATING MODE

- Open PM5 on the remote access PC.
- Select the Expert menu.
- Click on Comm.
- Select Connect.
- Click on Modem direct, then click on OK.
- Select an entries already used in the .
- Or click on Dialing"Dialing" then select the modem to use by "used modem" then dial the customer

remote access number in "dialing number".
- Write the system password pbxk1064 by default.
- Wait some seconds to have the connection established.

SECURITY

In the remote access, the protocol used in the "data link" OSI layer is PPP (Point-to-Point Protocol). The 
TCP/IP protocols are used respectively in the "transport" and "network" layers. For each layer, Alcatel 
OmniPCX Office carries out an access control.

Authentication

At the start of the connection (PPP), an account name (system masked) and password (pbxk1064) are 
required. This account name is automatically generated by PM5, the password is asked by PM5 for a 
direct connection (LAN) to Alcatel OmniPCX Office, all other authentication will be rejected.

Firewall

If the authentication is accepted by the system, connection PPP will be established, and all the data 
packets received on this interface will be filtered according to following rules:
All the packets are refused except:
- packages bound for Alcatel OmniPCX Office FTP server via two TCP ports preset for the PBX con-

figuration by PM5.
- packages bound for Alcatel OmniPCX Office HTTP server via the HTTP port preset for the Internet

access configuration by WBM(Web Based Management).
- control packets using the ICMP protocol (Internet Control Message Protocol).
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LOCAL V24 ACCESS FOR PM5

It is possible to use PM5 software to dialog with OmniPCX Office using a V24 connection.
In this case the network connection is not necessary.
A specific cable has to be connected between the "Config" RJ45 connector on the system CPU to the 
Port Com of the PC using PM5.

Wiring of the connection cable:

Installation procedure

- Open PM5 software on the PC.
- Select the Expert mode.
- Click on Comm menu.
- Select Connect menu.
- select Local menu
- The system proposes to install Alcatel OmniPCX Office direct V24
- click on Yes
- the system open the window Modem properties
- click on Add
- in Installation Window click on Next (put a cross in the box  "do not detect the modem automati-

cally")
- select Alcatel in the manufacturers list
- select OmniPCX direct V24 for Windows NT or OmniPCX direct V24/W9xMe for Windows 95

or 98 and Millenium.
- select the Port Com used
- click on Next
- click on Finish
- click on Close
- back in PM5, click on  Com
- the "local" box in now active and port Com is displayed
- click on Ok and enter the password
- wait for few seconds; the PM5 is now connected to the system.

RJ45  SUB D 9-point (F)

1
2
3
4
5
6
7
8

7
4
3

5
2
6
8
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LOCAL ACCESS BY LAN

When connected to the LAN port on the CPU/CPUe board via a UTP Category 5 100-ohm crossover 
cable, or to the switch on which the CPU/CPUe board is connected via a straight cable, the default IP 
address for the main CPU/CPUe board is 192.168.92.246.

The PC IP address and network mask must be compatible with the address of Alcatel OmniPCX Office; 
for example: 192.168.92.1 and 255.255.255.0.
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DOWNLOADING THE SOFTWARE

Proceed as follows:

- Open PM5
- Open the Tools folder
- Open the Software Download application
- In the Communication window, select the type of download:

• Local V24
• Modem Direct
• Modem Callback
- LAN

- Enter the password alize
- The Software Download window opens.

How to fill in the Software Download window fields:

- In the Delivery file field, select the directory containing the description file for the new software
release; by default, the file will be in the BOOT directory.

- Check the Download all files box to download all the files or just those where the Action field
contains the value install.

- Check the Data saving box (or not, as required). Warning: this option entails a cold system boot
(in which the client configuration is lost).

- In the Swap field, define the software changeover mode: check Immediate for immediate swit-
ching, or specify the preferred date and time for the changeover. If you select immediate switching,
it will take effect as soon as you quit the download application.

- The Downloadable Item area is read-only; it displays the various version numbers of the appli-
cations that make up Alcatel OmniOffice. The Action column lists the downloaded applications.

- The bottom part of the window tracks the progress of the download; each download or acknowled-
gement action gives rise to a message.

IMPORT/EXPORT

This function is used to import into Alcatel OmniPCX Office data files sent by clients (or files previously 
exported from an Alcatel Office system; for example, a file of collective speed dial numbers with the 
extension .CRP):

- Edit the file in EXCEL
- Check the syntax (the name must contain no punctuation, spaces, digits in the first 2 characters, or

more than 15 characters)
- Select All
- Copy
- In PM5 (connected beforehand), select "Collective Speed Dial"
- Right-click
- Paste. The system checks the syntax and asks for confirmation before copying the data.
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MIGRATING AN ALCATEL OFFICE CONFIGURATION TO AN ALCATEL 
OMNIPCX OFFICE CONFIGURATION 

This section provides the information you need in order to carry over a maximum of configuration data 
when migrating from an Alcatel Office installation to an Alcatel OmniPCX Office system; the migration 
process is made easier by the 4-page Database Transformation Wizard.

Procedure

- Select PM5 -> Tools -> Database Transformation: page 1/4 Source Database Selection ap-
pears. 

• In this window, you select the database saved by PCMMC PAA422. The files may be com-
pressed (*.cdb) or not (*.db).

• The destination target (the name shown in the Destination Target System field) is selected in
the PM5 -> Options -> Target Product menu.

- Restrictions: conversion from one country to another is impossible; within the same country,
however, databases can be converted from one distributor to another.

- Press Next: the format of the selected file is checked. If everything is OK, the migration process is
launched; if not, page 2/4 Transformation Results appears, indicating the state of the new da-
tabase: what was kept, what was modified, and the errors detected. If no blocking errors are de-
tected, the Next key is available.

- Press Next: a connection is established to the Alcatel OmniPCX Office system; the module, boards
and user data are all read. The external lines are brought into conformity with the boards fitted (not
the users). 

- Page 3/4 Subscriber Assignment appears. Users have to be associated with physical addresses
manually. Follow these rules:

• the terminal type cannot be modified
• the Reflexes option type (V24, S0 or Z) cannot be modified

- Reflexes options can be neither created nor modified.

- Press Next: page 4/4 Assignment Results appears, listing all the elements that couldn’t be allo-
cated (for example: networks not assigned to a board, or users in excess of the authorized limits).

- Press Finish: a confirmation window opens. The elements for printing can be selected by pressing
OK ("Customer Information" and "Subscriber List" are checked by default). The Save As window
opens. After saving, clicking Yes restores the database to the Alcatel OmniPCX Office system. If
you click No, the restore is not launched and the database can be viewed off-line. 
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FEATURES INCLUDED
PM5 provides a complete set of configuration tools for Alcatel OmniPCX Office systems.

2 packages are available: 

Easy View offers Wizard-type configuration.
The Wizard (or configuration assistant) serves to configure the most commonly used system parame-
ters; PM5 helps configure these parameters using a series of simple questions, with plenty of guidance 
and explanation. Indeed, using the default configuration avoids having to program a lot of the para-
meters.
For customized installation, there are links to Expert View menus from the pages of the Wizard, flagged 
by the "Advanced" and "Details" buttons in EasyPlus View. The configuration assistant is available on 
installation and throughout the life of the system.

Expert View gives you unrestricted access to all the configuration possibilities.

Package Corresponding views Levels of use (passwords)

PM5 Expert Expert View, EasyPlus View, Easy 
View

Manufacturer

Installer (pbxk1064)

PM5 Easy Easy View Attendant (help1954)

Features included Easy Expert

Tools � �

Client/supplier information

. Client information � �

. Supplier information � �

Installation Typical

. Initial Wizard Business Installation � �

. Front-end DECT initial Wizard Installation � �

. Installation Wizard � �

Modification Typical

. Subscribers � �

. Groups � �

. System � �
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. Collective Speed Dial � �

. External access � �

Numbering Plan

. Installation numbers: 

- Installation number
- Customized caller number
- Private installation number
- VPN prefix to delete

� �
�
�
�

. Default numbering plans � �

. Internal numbering plans �

. Public numbering plan �

. Restricted public numbering plan �

. Private numbering plan �

. Features in conversation �

. DDI number modification table �

. Number modification table �

. Table of splitting prefixes �

. Table of end of dialing prefixes �

. Automatic Routing Selection (prefixes, trunk group 
lists, time ranges, day groups, operators/destina-
tions, client codes, call tone/pause, miscellaneous)

�

. Public directory number conversions �

Collective Speed Dial � �

Directory �

Subscribers/Basestations List

. List of subscribers � �

. Details �

.. Keys �

.. Service category �

.. Metering �

.. Personal Speed Dial �

.. Barring �

.. Dynamic forwarding �

Features included Easy Expert
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.. DECT �

.. Voice mailbox �

.. V24 �

.. Personal code �

.. ISDN �

.. Remote services �

.. Miscellaneous �

.. Forwardings �

.. Selective forwardings �

.. Hotel �

.. Wake-up call �

.. Mailbox �

.. IP �

Voice Processing

. Automated Attendant �

. Mailboxes �

. Information Messages �

. General Parameters �

. Statistics �

Time ranges �

List of operator groups �

List of hunting groups � �

List of broadcast groups � �

List of pick-up groups � �

Manager/secretary relationship �

Subscribers Misc.

. Pre-announcement �

. Permanent Logical Links (PLLs) �

. Fax notification for subscribers �

External Lines

Features included Easy Expert
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. External access table:

- Access to collective speed dial numbers
- Call distribution
- Link categories
- T2 Alarms

�
�

�
�
�
�

. Trunk group list �

. Remote substitution �

. Traffic counters (number of outside calls) �

. Protocols (TL time-outs and parameters, ATL time-
outs, parameters, pulses and variants, levels 2 and 3 
of public and private ISDN access, ISVPN protocols)

�

. Selection of analog protocols �

. Incoming call processing �

Hardware and Limits

. Main cabinet �

. Auxiliary interfaces �

. IP Boards �

. Licensed features �

Metering

. Printing �

. Metering options for current monetary unit �

. Currency conversion �

. Metering counters �

Traffic Sharing and Barring

. Trunk access matrix �

. Barring matrix �

. Barring tables �

. Joining �

. Account code table �

Network Management Control

. Centralized management �

. Urgent alarms �

Voice over IP

Features included Easy Expert
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. VoIP: Parameters �

. VoIP: Traffic counters �

Internet Access Configuration

Hotel

. Parameters �

. Metering �

System Miscellaneous

. PABX date and time adjustment �

. System reset �

. Features �

. DECT ARI/GAP Authentication �

. Memory Read/Write �

. Message and Music �

. Gatekeeper signals �

. Manual normal/restricted mode �

. Software Version �

Import/Export

. Data import/export �

. Labels to export �

History & Anomalies

. History table �

. Messages table (Hardware) �

Data Saving & Swapping

. Commands �

. Data backup �

. Downloading �

Features included Easy Expert
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VOICE PROMPTS MANAGEMENT
On Alcatel Omni PCX Office, it is possible to manage "Voice prompts" using Alcatel software PM5.

The facility of importing, exporting and saving voice mail names and greetings, all automated atten-
dant greetings and all information messages is offered by PM5.
The voice prompts are managed via sound files under "Wav" formats. Different formats are used ac-
cording exportation or importation.
Access to these facilities depends of softwra licences and system hardware (Hard disk, ...).

"VOICE PROMPTS" EXPORTATION

Individual Voice prompts exportation is possible using different sub-menu in PM5 or collectively using 
a general "Save" procedure (see "Voice prompts importation").
All voice prompts used by the system are managed via sound files under the specific format Alcatel 
Wav ADPCM G726. It is usually not possible to edit files with this format on regular sound editors.
To have the possibility to listen, record and import sound files via standard PC's sound editors, it is 
necessary to convert them to more popular format.
This operation is done by PM5 software which converts file system from format Alcatel Wav ADPCM 
G726 to format Wav PCM 16 bit 8kHz mono.
Knowing that each converting operation causes a loss of sound quality, it is advisable to use the 
ADPCM format as much as possible for an export/import of the same voice prompts.

"Voice prompts" exportation process

In order to export voice prompts (mail box greeting in this example) it is necessary to open the Alcatel 
PM5 software in direct connection and expert mode and use the following process:

- select the Subscribers/Basestations list
- select subscriber of you choice which as a mail box all ready personalized
- click on Details
- click on Mailbox
- select the property page Option in windows Subscriber mailbox select Combo box Voice

prompt - Personal greeting Transfer and save as
- At this step, it is possible to:

• export the voice prompt in different format
• listen directly the message (click on "Play") 
- delete it (click on "Erase" )

- Specify the destination path on your main drive (eg C:/Temp/Prompts) and the file name.
- Click on  " export" ; at this step, the system will propose to use a standard Wav PC format or the

regular Alcatel ADPCM format.
- The voice prompt is then transfered from the system to the PC; this operation may take few seconds

according the size of the file). The voice prompt will be stored on your drive in format Alcatel
ADPCM G726 or PCM 16 bit 8 kHz mono according your choice.
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Nota : if no greeting has been prerecorded (no customization), the combo boxes "personal 
greeting" are Grey. This operation is possible for all voice prompts about Mail boxes, 
Automated Attendant and information messages. The procedure is the same as descri-
bed before; just select the corresponding menu.

"VOICE PROMPT" COMPLETE SAVE

All "Voice prompts" may be saved used the following system save procedure:

- start the Alcatel PM5 software in direct or remote connection
- select the menu Com -> Read from PBX -> Voice Prompts
- click on OK
- wait until the end of the transfer.
- save the file selecting File -> Save as
- enter a file name and click on  OK.

The "prompts" files stored this way are available under: C:/Program Files/Alcatel/PM5/R110-13.3/tar-
gprod/afr100/customer.dbs/saved file name.

Nota : Directory "R110-13.3" corresponds to the PM5 version used during save procedure- ;direc-
tory "afr100" corresponds to "Target" system used during PM5 installation

"Wav" files stored after this procedure are in format Alcatel ADPCM G 726 and can't be listen to or 
modified only via specific software and Codec.

"VOICE PROMPT" IMPORTATION

As described in exportation procedure, it is necessary to convert "Wav" files from PCM to ADPCM for-
mat. This operation is done in PM5 during the transfer from the PC to the system.
If the prompt to be imported is in ADPCM format (file imported from a system) the conversion will not 
be necessary. If the prompt to be imported is in PCM format , the conversion will be automatically pro-
ceed during the PM5 transfer. 
In this case, the format to use is Wav PCM 16 bits 8 kHz Mono these type of sounds file and formats 
can be generate on all PC types equipped with Sound baster music boards.
Importing procedure is the same as the exporting one described in the previous paragraph. It is only 
necessary to specify the exact path where the file to be imported is located.
Then click on "Import".
At any time, it is also possible to listen or erase the message (only the message present in the system. 
The transfer duration depends of the file size (or prompt duration).

RECORDING OF MUSIC ON HOLD (MOH)

It is possible to record the system music on hold using either a "Reflexes" set and it's microphone or 
using Internet explorer for importing sound files.

In the last case, the sound file must me in one of the following format:

- .wav, ADPCM 32 kbps, 4 bit, mono
- .wav, PCM 8 kHz, 8 bit, mono
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- .wav, CCITT A-law (PCM A law) 8 kHz, 8 bit, mono
- .wav, CCITT Mu-law (PCM Mu Law) 8 kHz 8 bit, mono

The maximum size of the file (or the music) to import is 10 minutes.

Importing sound file for Music on Hold

- Select via PM5 or MMC set, the music on hold by default (standard;  example via MMC set: menus
"Voice", "SrcMus", "Stndart".

- Create a sound file for the new music on hold using a PC equipped with a sound baster board (for
instance) with the correct format listed before. The format and the size of the file may be verified
using "Windows recorder" (select file properties) 

- (It is also possible to convert a sound file to the correct format using the same "Windows recorder"
tool, and menus "save as", Choose the correct format in the list and Click on "Convert now") 

- Open Internet browser and remove the proxy.
- Access to the main CPU with it's IP address (by default: 192.168.92.246:81)
- Enter the login Operator
- Enter the password help1954
- The system displays the following Windows
- "Alcatel OmniPCX Office"  "  Boards monitoring and music on hold"
- Select the sound file to be imported clicking on "Parcourir" or "Browse"
- Then click on "Submit" to import the file
- If the operation is successful, the following screen "MOH CODER : Success" appears (this operation

may take few seconds according the size of the file)
- Then select with PM5 or MMC Set the recorded music; example via MMC Set: menus "Voice", ""Src-

Mus", "Prvoice".
- The new music is available in the system.

Recording music on hold via MMC station

It is also possible to record the music on hold using the MMC station programming mode. To do so, 
proceed as follow

- enter in programming mode using 4034 or Advanced set
- enter in "System" session
- select "Instal" menu
- enter the password
- select "Voice" menu in the second page
- select "MOH" menu
- select "Music" message by access on "Prev" or "Next" keys (Message 1 is selected by de-

fault).
- press "Record" key twice in order to record the music on hold using the handset
- once the music on hold recorded, enable it using "Muscrc", VoicPr" and "OK" menus.

RECORDING PREANNOUNCEMENT MESSAGES 01 TO 08 VIA MMC 
STATION

It is also possible to record preannouncement messages 1 to 8 using the MMC MR2 programming 
mode as in the previous systems. 
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To do so, proceed as follow:

- enter in programming mode using 4034 or Advanced set
- enter in "System" session
- select "Instal" menu
- enter the password
- select "Voice" menu in the second page
- select "MOH" menu
- select "Message 1 to 8 by access on "Prev" or "Next" keys (Message 1 is selected by default).
- press "Record" key twice in order to record the message using the handset
- listen to the message and assign it with the normal procedure

Nota : It is not possible to import preannouncement messages.
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SYSTEM LANGUAGE MODIFICATION

The list of languages present in the system Alcatel Omni Pcx Office is installed during software down-
loading in the manufacture. It depend of hardware and key (license) ordered:

- 2 languages are installed in case of no XMEM is equipped (no memory expansion)
- 4 languages are available if a XMEM or a hard disk is equipped.

It is possible to modify the number and the type of languages using the software downloading mecha-
nism in PM5.

Procedure

In a first time it is necessary to choose a software version to be downloaded (usually the current softwa-
re version already installed on the system). This way, only the languages will be loaded during the 
downloading.
Languages modification could also be done during a software downloading for a migration to a new 
version. 
Proceed as follow:
- open PM5 software.
- select the "Tools" menu.
- select "Software Download".
- in the window "Software Download", choose the desired version in "Delivery file" (V19_09 for exam-

ple).
- click on "OK".
- select the box  "languages" in "Languages" menu, modify order and/or choice of languages.
- click on "OK".
- select "Data saving" box (if data saving is not performed, all customers datas will be lost after the

swap.
- click on "Start"
- the system downloads the different languages and corresponding voice prompts. The new langua-

ges will be available at the end of downloading, swap and the system reset. All other configuration
parameters will stay unchanged.

Notas : The list of available language can be easily checked using the customization mode on 
Reflexes set (menu Custom, option, language) 

During languages downloading, the system does not check if the memory capacity is 
correct for the number of languages loaded; it is to installer to make sure the system 
configuration is correct for 4 languages max. 

If one language is selected for a subscriber and after language downloading, the lan-
guage is not present in the system anymore, silence will replace the missing language 
for this subscriber.

The primary default languages is always the first one in the list.
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GENERAL
The Man-Machine Conversation (MMC) by 4034/Advanced station enables modification of  the para-
meters of the different system elements.

Notas :

- only a single 4034/Advanced station can be in MMC at a given moment.
- simultaneous access to the MMC by station and by PC is impossible.

The modifications are made in 2 ways:

- By introducing a numeric value (number of the station for example) or an alphanumeric value.
- By choosing one of the predefined values presented on the display using the soft  keys.

ACCESS TO THE MMC

Access to the MMC is enabled by:

- entering the code 70 (by default) or by using a key programmed with this code, or by pressing the
 key (Advanced station).

- choosing the session: 3 sessions are offered: INSTALLER (  key), ADMINISTRATOR (  key)
and OPERATOR * (  key). These different levels of access to the parameterizable features thus
enable modifications to be authorized to cleared people only.

- entering the password corresponding to the chosen session.

Notas : * Only Installer and Administrator sessions are presented in this notice; for  the Operator 
session, refer to the Installation guide.

Password default values

SYSTEM

INSTAL ADMIN 

OPERAT

INSTALLER session

ADMINISTRATOR session

pbxk1064

kilo1987
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CONFIGURABLE FEATURES

All the features configurable in the Installer session are described in the  different files contained in the 
current guide.  The features and sub-features  available in the Administrator session are indicated by 
the symbol  positioned beside the titles of the configurable elements.

Each feature has a diagram describing the entry procedure (in Installer  session). The features which 
are accessible by soft keys are indicated by:

- soft key for moving through the MMC tree or for choosing a feature.
- giving access to the drop-down menu.

Quitting the session

To quit the MMC session press the  key (4034 station) or the  key (Advanced station). You 
will quit the session automatically, after a time delay after the last key has been pressed. 

A

SUBSCR

CHOICE

F F
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GENERAL COMMANDS

Soft keys

- ADD : adds an item to a list
- GOTO : moves quickly through a list
- READ+ : displays the next page
- CLEAR : cancels
- RUBOUT : corrects the last character
- MODIFY : modifies an item in a list
- NEXT : next entry in a list
- PREV : previous entry in a list
- BACK : returns to previous menu
- OK : validates an entry
- -> : forward cursor movement
- <- : backward cursor movement

Using the alphabetic keypad

Each time you need to enter a name or a label associated to a key or a feature,  use the alphabetic 
keypad. If the station does not have an alphabetic keypad, use the dialling keypad. To enter a letter, 
press the key which has the  required letter on it: once for the first letter, twice for the second and  three 
times for the third. To enter two consecutive letters on the same dialling key, press  -> before entering 
the second letter. Entering special  characters:

- "space" : press   1
- "-" : press  1 twice
- "." : press  1 three times
- "#" : press  #
- ":" : press  # twice
- "=" : press  # three times
- "*" : press  *
- "+" : press  * twice
- "/" : press  * three times
- "0" to "9" : press  #0 or  #9
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CONFIGURABLE FEATURES IN INSTALLER SESSION

INSTALL session CONFIGURATION OF STATIONS

METERING COUNTERS

GENERAL COMMANDS

COLLECTIVE SPEED DIAL NUMBERS

TIME RANGES

ANALOG LINES AND DIGITAL ACCESSES

TRUNK GROUPS

GROUPS

SYSTEM RESET

TERMINAL PROFILES

METERING CONFIGURATION

BARRING PREFIXES

PARAMETER DUPLICATION

WELCOME AND PLEASE-WAIT MESSAGES

NUMBERING PLANS

SPLITTING AND END OF DIALLING PREFIXES

PRE-ANNOUNCEMENT MESSAGES

DECT STATIONS

BACKUP AND RESTORATION OF THE CONFIGURATION

MOVING OF 2 STATIONS

DISA TRANSIT AND ANALOG DISA

ARS CALENDAR

MULTI REFLEXES

INTEGRATED VOICE SERVER

TERPRO

METER

BARPFX

COPY

VOICE

NUMPLN

EODPFX

PREANN

SUBSCR

COUNT

GLOBAL

COMSPD

TIMERA

ACCESS

TRGP

GROUPS

RSTSYS

DECT

DATSAV

MOVING

DISA

1st page

2nd page

3rd page
ARSCAL

MLTRFX

VMU
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CONFIGURABLE FEATURES IN ADMINISTRATOR SESSION

ADMINISTRATOR 
session CONFIGURATION OF STATIONS

METERING COUNTERS

GENERAL COMMANDS

COLLECTIVE SPEED DIAL NUMBERS

TIME RANGES

METERING CONFIGURATION

WELCOME AND PLEASE-WAIT MESSAGES

BARRING PREFIXES

DECT STATIONS

PRE-ANNOUNCEMENT MESSAGES

GROUPS

ANALOG LINES AND DIGITAL ACCESSES

MOVING OF 2 STATIONS

DISA TRANSIT AND ANALOG DISA

ARS CALENDAR

METER

BARPFX

SUBSCR

COUNT

GLOBAL

COMSPD

TIMERA

DECT

MOVING

DISA

1st page

2nd page

VOICE

PREANN

GROUPS

ACCESS

ARSCAL

VMU INTEGRATED VOICE SERVER
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CONFIGURATION OF STATIONS
This feature makes it possible to define particular characteristics for each station.

Station No.

A

Switched on

Switched off

Feature rights

Barring profiles

Reading of station type

Normal or restricted mode for each time range

Inhibition flag against system locking

User code reset

SUBSCR OUTINS

TERMNL

SUBPRO

NORRES

PWDRES

FEATUR

BARRNG

VLOW

LOW

MIDDLE

HIGH

VLOW

LOW

MIDDLE

HIGH

INSERV

OUTOFS

INHIBI

NORRES

NNV

RNV

NV

RV

N

R

BARTYP CATEGO

Choice of language

Automatic call setup on going off-hookAUTOCA

LANG

DESTI

ACTIVE

TEMP

Barring or traffic sharing (trunk group access) 
link categories
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Station No.

A

SUBSCR

Key No. Function Parameter Role of programmable keys

B

Various possibilities depending on key type

destination

destination

1st time-out

2nd time-out

Dynamic call distribution

Transmission protocol (Hayes, 108/1, 108/2, etc.)

Flow control (XON-XOFF, RTS/CTS, none)

Speed (1200, 2400, 4800, 9600, 19200, 57600)

Nbr of significant bits (7 or 8)

Parity (even, odd, none, fixed at 0, fixed at 1)

Nbr of stop bits (1 or 2)

KEYS

DYNROU

V24PRO PROT

FLOW

SPEED

SIGBIT

PARITY

STPBIT

LOCAL

TMOUT1

TMOUT2

EXTERN

PERSPD CLEAR

PREV

NEXT

MODIFY

Modification of an entry in the individual directory
- deletion of an entry
- entry of name (up to 8 characters)
- entry of public number (up to 22 digits, trunk group included)

Number Paging receiver codePAGING

WIRLSS PERM

VISIT

IPUI

Date

Permanent registration of a DECT handset

DECT UA station identification code

Visitor registration 
completion date

Validation/inhibition of the management 
of a GAP DECT handsetDISPL

DECT stationDECT station

Allocation of a special feature (paging, voice mail, etc.)

Definition of remote services:
(voice, G4 fax, AB, ISDN, All or None)

SERVIC

SPEDEV

SERVI1

SERVI3

CHOICE

SERVI2

SERVI4

Headset modeHEADST CHOICE Headset mode
ADMINISTRATOR session only

Gain switchingHANDST CHOICE

ou Aucun)

PRIO Priority level

Hotel: choice between Administrative, Host and Booth stationCLASS CHOICE

Registration of a new station (if the selected number corresponds to a DECT access)
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Press .
Enter the directory number of the station concerned.

STATUS OF THE STATION - OUTINS   

Before allocating a terminal profile or carrying out a remote customization of a station, this station 

must be switched off by pressing  . After allocation, the station can be switched on again.

The station can be:
- In Service
- Logical OOS
- Physical OOS/Logical OOS: station not operational
- Physical OOS/Logical IS: station not regarded by the system (not declared or disconnected) and

switched off by the installer

Choosing  + validation switches the station ON (IN SERVICE). Choosing  + validation swit-
ches the station OFF (OUT OF SERVICE). 

Nota : The Administrator session only allows the status of the station to be read.

TYPE OF STATION USED - TERMNL   

Press  .

The station directory number, type and software version are displayed. 

SUBSCRIBER PROFILE - SUBPRO   

Feature rights profile - FEATUR 

Press  followed by .

Choose the feature rights to be allocated to the station.

FEATURE RIGHTS VERY LOW LOW (de-
fault)

MIDDLE HIGH

Authorized camp-on YES YES YES

Protection against camp-on -- -- -- --

Authorized intrusion -- -- YES YES

Protection against intrusion (station busy) and 
protection against intercom (station free)

-- -- YES YES

Protection against camp-on tone -- -- -- YES

Conference -- YES YES YES

SUBSCR

A

OUTINS
A

INSERV OUTOFS

A

TERMNL
A

A

A

SUBPRO FEATUR
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Automatic call back YES YES YES YES

Call pick-up authorized -- YES YES YES

Paging -- -- YES YES

Calling line identity secrecy -- -- -- YES

UUS reception authorized -- -- YES YES

Restricted mode inhibited -- -- -- --

Private station -- -- -- --

VM = automated attendant dyn. forward le-
vel 1

-- -- -- --

VM = automated attendant dyn. forward le-
vel 2

-- -- -- --

Name display YES YES YES YES

External accesses joining by transfer -- -- -- --

Trunk access by transfer YES YES YES YES

Selective forwarding -- YES YES YES

External forwarding -- -- -- --

Allocation of a line -- -- -- --

DISA Transit -- -- -- --

Protection against DDC calls -- -- -- --

Automatic call setup on going off hook (im-
mediate or after time-out)

-- -- -- --

DND override authorized -- -- -- YES

Protection against DND override -- -- YES YES

Assign authorization for cost (hotel: possibility 
of charging costs to a room telephone

-- -- -- --
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Barring profile - BARRNG 

Press   followed by .

Choose the barring profile to be allocated to the station.

CONTENT VERY LOW LOW (de-
fault)

MIDDLE HIGH

Traffic sharing (access 
to trunk groups)

Normal mode No trunk 
group

Main trunk 
group

Main and 
even trunk 

groups

All trunk 
groups

Restricted mode No trunk 
group

No trunk 
group

Main trunk 
group

All trunk 
groups

Station traffic sharing Normal mode (N) 16 12 8 4

Restricted mode 
(R)

16 16 12 4

Barring level of trunk 
groups  (result from 
the barring matrix with 
station barring below 
and trunk group bar-
ring by default)

Trunk groups 1 to 
9, 50 to 57 and 
98 to 105

1 2 3 4

Trunk groups 10 
to 17, 58 to 65 
and 106 to 113

2 3 4 5

Trunk groups 18 
to 25, 66 to 73 
and 114 to 120

3 4 5 6

Trunk groups 26 
to 33 and 74 to 
81

4 5 6 1

Trunk groups 34 
to 41 and 82 to 
89

5 6 1 2

Trunk groups 42 
to 49 and 90 to 
97

6 1 2 3

Station barring (voice 
or data)

Normal mode 
(NV and NNV)

1 2 3 4

Restricted mode 
(RV and RNV)

1 1 1 4

Station speed dial ri-
ghts (voice or data)

Normal mode 10000000 11100000 11111000 11111111

Restricted mode 10000000 11100000 11111000 11111111

A

SUBPRO
A

BARRNG
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NORMAL/RESTRICTED MODE FOR EACH STATION - NORRES   

  is used to define the time range operating mode.

 makes it possible to inhibit the switch to restricted mode. By pressing successively on , you 
can define whether changing the operating mode by operator command or by a key at central pro-
cessing level is taken into account for this station:

 by successively pressing this key, you can choose the operating mode for the time range concer-
ned.
- inhibited: changing the operating mode is not possible for this station.
- possible:changing the operating mode is possible.

REINITIALIZATION OF THE USER CODE - PWDRES   

Press  . Validating makes it possible to return to the default value for the personal code of the 
station concerned: 1515).

BARRING AND TRAFFIC SHARING CATEGORIES - BARTYP 

  makes it possible to define barring and traffic sharing link categories for each station.

NNV :  barring link category for data communications in normal mode

RNV :  barring link category for data communications in restricted mode
NV :  barring link category for voice communications in normal mode
RV : barring link category for voice communications in restricted mode
N : traffic sharing link category in normal mode
R : traffic sharing link category in restricted mode

Notas :

Barring link categories make it possible to define the controls carried out during a trunk seizure by a 
means other than the collective speed dial numbers or during the seizure of a trunk group. Traffic sha-
ring link categories define the controls for accessing the  trunk groups (outgoing traffic sharing).

Having pressed , enter the value (from 1 to 16) to be allocated to the category concerned then 
validate.

CHOICE OF LANGUAGE - LANG   

Having pressed  , choose the display language for the station from the proposed languages.

A

NORRES
A

INHIBI CHOICE

NORRES

A

PWDRES
A

A

BARTYP
A

CATEGO

A

LANG 
A
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AUTOMATIC CALL SETUP ON GOING OFF-HOOK - AUTOCA 

   makes it possible to define:

- the destination of an automatic call setup on going off-hook
- the type of call: immediate or after a time-out

 : enter the destination of an automatic call (station's directory or hunting group number or exter-
nal number using a speed dial number).

 : by successively pressing this key, you can define whether the automatic call is active (YES) or 
inactive (NO) for the station concerned.

 : by successively pressing this key, you can define whether the automatic call is after a time-out 
(YES) or not (NO).

PERSONAL SPEED DIAL NUMBERS - PERSPD   

   makes it possible to create/modify the name and number stored in an entry in the individual 
directory of the station concerned (the complete entry of an entry with the line or trunk group used and 
sub-address is only possible through MMC PM5).

 and  make it possible to select a personal directory entry (01 to 30 for a 4034/Advanced 
station, 01 to 15 for 4023 stations and 01 to 10 for other stations). If this entry is already configured, 
the name and associated public number (last 18 digits) are displayed.

 makes it possible to modify the data stored in a directory entry. 

Enter the name (up to 8 characters) and press . Then enter the public number (up to 22 digits, 
including the trunk group number) and press .

 makes it possible to erase ALL the data of a directory entry (even those that can not be configured 
in this session).

A

AUTOCA
A

DESTI

ACTIVE

TEMP 

PERSPD
A

PREV NEXT

MODIFY

OK 

OK 

CLEAR 
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ROLE OF THE PROGRAMMABLE KEYS - KEYS 

  makes it possible to define the role of the programmable keys.

Notas :

Before performing a remote customization of a station, the station must be switched off. It is advisable 
to cancel a key's current configuration before beginning a new configuration. 

The display may show:

- the number (for example 01/98)
- the type of key (for example RGM)
- the rights associated with it (INS = installer)
- the current feature
- the possible parameter(s)

State the number of the key to be programmed (see location below) by pressing  or by selecting 
the next or previous key. 

 makes it possible to show the display which groups together all the  functions offered. Press 
the soft key corresponding to the list which contains the desired function.

Function list

Choosing  

KEY FUNCTION PARAMETERS

oCback Automatic call-back request --

nCback Cancellation of an automatic 
call-back request

--

Procom Protection of a call against 
any intrusion

--

oIntru Intrusion --

Pgpfix Paging call by prefix --

Pgsfix Paging call by suffix --

CLIR Calling line identity secrecy --

BMdial  Block mode dialling --

SubAdd  Sub address --

DNDovr  Override DND/Priority call --

A

KEYS 
A

GOTO 

MODIFY
B

CALL
B

Ed. 048/18 Réf. 3EH 21000 BSAA



File
2

CONFIGURATION OF STATIONSMMC STATION

 

Choosing  

KEY FUNCTION PARAMETERS

Redial Last number redial --

TmpRep Putting a number into a tem-
porary memory

--

PerSpD Access to personal speed dial 
numbers

--

Call Direct local or external call Trunk number
External number (22 digits maximum)
Sub-address (4 digits maximum)

Dir Directory access --

Macro1 Local call + intercom intru-
sion on free; equivalent to an 
incoming RSL

Station directory number
Data for dynamic routing

Macro2 External call + business ac-
count code + business ac-
count code value

Trunk number
External number (22 digits maximum)
Sub-address (4 digits maximum)
Business account code (16 digits maximum)

Macro3 Calibrated loopbreak + 
time-out +  number

Number to be transmitted after the calibrated loop break

PrCall Priority call --

ABBNUM
B
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Choosing  

KEY FUNCTION PARAMETERS

IndPic Individual call pick-up Station directory number

GrpPic Group call pick-up --

GenBel General bell answer --

Monit Selective monitoring Station directory number (internal or DDI numbers)
Type of calls monitored (local, external, all)

SubMon Subscriber monitoring Station directory number (internal or DDI numbers)
Type of calls monitored (local, external, all)

GrpSup General monitoring Hunting group number

AutAns Intercom mode answering --

Ring Supervised melody activation --

Pgasel Paging call answer --

Pgagen General paging answer --

GenMon Group supervision --

2ndCal Enquiry call (only for 4073 
stations)

--

ANSWER
B
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Choosing  

KEY FUNCTION PARAMETERS

SelFwd Selective forwarding --

PABXË PABX diversion --

IndFwd

- Imme-
dË

- BusyË

- TextË

- FolloË

- PageË

- DND

Access to personal call forwar-
ding

Immediate diversion

Diversion on busy

Diversion to text mail

Follow me

Diversion to paging

"Do Not Disturb"

Internal or external destination

Internal or external destination

--

Number of the station concerned

--

--

GrpFwd

- Imme-
dË

- GrpWd

Group forwarding

Immediate group call forwar-
ding

Disconnect from group

--

--

Station number

MstFwd

- M 
ImmD

- M Busy

- M Grp

Master forwarding keys

Immediate diversion

Diversion on busy

Group call diversion

Internal destination

Number of the station or group

Number of the station or group

ScrMgr Screening Directory number of the secretary station

ScrSec Screening Directory number of the manager station

DelAll All diversion cancellation --

DIVERT
B
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Choosing  

KEY FUNCTION PARAMETERS

oConf Conference --

AccCom Modification of the business ac-
count code during the call

Value of the code (16 digits maximum)

AccOut Business account code entered 
before new outgoing call

Value of the code (16 digits maximum)

Mail K Access to text mail --

Read+ Display next screen --

VMail Access to Voice Mail Number of the voice mail box

oPBX Calibrated loopbreak --

NRMode Normal or restricted mode for 
attendant

--

Reserv Trunk group reservation for at-
tendant

--

Config Switch to programming mode --

Hold Common hold for voice transfer --

Transf Transfer of a call --

Digits Putting dialling into a memory --

Mail L Access to mailing --

oDTMF Send MF code Digits (22 max) to be sent in MF

Forced Intercom intrusion on free --

Lock Station lock/unlock --

Park Call parking/retrieval --

MTR Metering reminder --

AllotN Allocation of a line Barring level

AllotM Allocation of a line with total me-
ter recall

Barring level

AttDiv External forwarding of operator 
calls

Internal or external destination

BkgMus To choose the emitting source of 
please wait message

--

Door Door opener control --

Broker Shuttle call (only for 4073 sta-
tion)

--

OPTION
B
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Choosing  

PARAMETERS ASSOCIATED WITH RESOURCE KEYS

Notas :

This paragraph only describes the main parameters which can be defined according to the role assi-
gned to the key; other parameters are possible (trunk number if RSD or RSB, station sub-address if RSL, 
type of monitoring key and number of the monitoring key if RSP). 

o Dynamic routing

This sub-function is only provided for the MACRO1, RGI, RGM, RSL, RSD, RSB and RSP keys.  
makes it possible to define the data necessary for the dynamic routing of calls managed by the key 
concerned. Press  : 

- : by successively pressing this key, you can define whether the time-out 1 is active (TP1) or

RecCal Recording of conversations --

MVScrn Filtering of vocal messages --

KEY FUNCTION PARAMETERS

RGI Handles local incoming calls Type of call: local, external, all
Data for dynamic routing

RGO Handles local outgoing calls Type of call: local, external, all

RGM Handles mixed calls (inco-
ming-outgoing)

Type of call: local, external, all
Data for dynamic routing

RSL Handles local calls with a given 
station

Station directory number (4 digits max)
Sub-address (4 digits maximum)
Data for dynamic routing

RSD Reception of local or external 
calls 

Outgoing seizure on a given 
trunk

Station directory number or hunting group directory 
number (local call) or DDI (external call)
Trunk directory number or ARS for outgoing call (optio-
nal)
Data for dynamic routing

RSB Set up of an external call on a 
specific trunk group and recep-
tion of external call

Trunk directory number or ARS
Data for dynamic routing

RSP Reception and transmission of 
calls on a specific external in-
terface

Line number
Data for dynamic routing

SUP Station monitoring Monitored station directory number
Monitored resource key address

RESOU
B

DYNROU

MODIFY

TP1 
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inactive (tp1).
-  : by successively pressing this key, you can define whether the time-out 2 is active (TP2) or

inactive (tp2).
-  or  : by successively pressing on this key, you can define whether the system should route

the call to the operator and/or the general bell after the non-response time-out TP2 has lapsed
(active = ATTD or GBEL; inactive = attd or gbel).

-  makes it possible to authorize (DIVE) or not (dive) forwarding for this key.
-  makes it possible to define a destination station (or group) for the dynamic routing in the

case of no answer after a time-out TP1 (12 seconds by default).

o Type of call

This sub-function is only provided for the RGI, RGO and RGM keys.

 makes it possible to determine the type of calls managed by the key concerned.

By successively pressing the  key, you can choose between Ext/Loc, External and Local.

o Number of the associated station

This sub-function is only provided for the RSL, RSD and SUP keys.  makes it possible to define the 
directory number of the associated station.

DYNAMIC ROUTING OF CALLS - DYNROU 

Dynamic routing of calls makes it impossible to have a call (internal, external, private, ...) remaining 
unanswered.

Press  . 

 and  make it possible to define whether the dynamic distribution (time-outs T1 and T2, des-
tinations) criteria for each type of call (external or local) are active or not:

-  makes it possible to define a destination station (or group) for the dynamic routing in the
case of no answer after a time-out TP1 (12 seconds by default).

- : by successively pressing this key, you can define whether the time-out 1 is active (TP1) or
inactive (tp1).

-  : by successively pressing this key, you can define whether the time-out 2 is active (TP2) or
inactive (tp2).

-  or  : by successively pressing on this key, define whether the system should route the call
to the operator and/or the general bell after the non-response time-out TP2 has lapsed (active =
ATTD or GBEL; inactive = attd or gbel).

-  makes it possible to authorize (DIVE) or not (dive) forwarding for this key.

 and  make it possible to define the time-outs in tenths of a second. The default value is 12 
seconds.

TP2 

OPERAT GENBEL

DIVERT

NUMBER

CALTYP

CALTYP

NUMBER

A

DYNROU
A

EXTERN LOCAL 

NUMBER

TP1 

TP2 

OPERAT GENBEL

DIVERT

TMOUT1 TMOUT2
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CHARACTERISTICS OF THE V24 OUTPUT OF A DIGITAL STATION - 

V24PRO   

  (when the selected station corresponds to a V24 interface) makes it possible to define the 
characteristics for the V24 option installed on a Reflexes station.

 : by successively pressing this key, you can choose the transmission protocol: 108/1, 108/2, 
Hayes or Dec. auto (Hayes by default).

 : by successively pressing this key, you can choose the type of flow control: XON/XOFF, RTS/CTS 
or without (XON/XOFF by default).

: by successively pressing this key, you can choose the transmission speed: 1200, 2400, 4800, 
9600, 19200 or 57600 bits/s (9600 bits/s by default).

: by successively pressing this key, you can choose the number of significant bits: 7 or 8 (8 by 
default).

: by successively pressing this key, you can choose the parity: 0, 1, even, uneven or no parity (no 
parity by default).

: by successively pressing this key, you can choose the number of stop bits: 1 or 2 (1 by default).

CORDLESS DECT STATIONS - WIRLSS   

  (when the selected station is a DECT) makes it possible to define the parameters for DECT 
stations.

 makes it possible to select a permanent association to the system.

 makes it possible to select a temporary association to the system ; enter the date on which the 
mobile is to be automatically disconnected from the system and validate.

 makes it possible to modify the IPUI value of the DECT station ; enter 14 octal digits and validate.
 makes it possible to validate or inhibit a GAP DECT display.

PAGING NUMBER - PAGING 

  makes it possible to define the number of the paging receiver for the station  concerned.

REMOTE SERVICES - SERVIC 

  makes it possible to define the remote service(s) accessible for the station concerned (4 ser-
vices maximum).

By successively pressing on keys  to , select the authorized remote service:

A

V24PRO
A

PROT 

FLOW 

SPEED 

SIGBIT

PARITY

STPBIT

A

WIRLSS
A

PERM 

VISIT 

IPUI

DISPL 

A

PGSFIX
A

A

SERVIC
A

SERVI1 SERVI4
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- VOICE (telephone services)
- ALLSVC (all remote services)
- ABS (analog data service)
- FAX2/3
- FAX4
- V24AE (asynchronous V24)
- TLTX64 (64 kbits/s teletext)
- DATA64 (64 kbits/s data transmission)
- VIDEO
- X21
- X25
- Bdx
- BdxNw
- MixMod
- NOSERV

Only calls compatible with the services programmed are accepted for both outgoing and incoming 
calls. All other types of call are rejected and not presented when incoming. For non S0 stations, only 
service 1 is to be defined.
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SPECIAL FEATURES - SPEDEV 

After pressing  , by successively pressing on , you can select features from those offered:

- Normal
- Paging Device
- Voice Mail Unit
- Doorphone
- Bank Alarm (priority call)
- Fix DTMF

PRIORITY LEVEL - PRIO

  makes it possible to define the priority level (0 to 7, 7 = highest level) for external calls (prio-
rity call feature).

FEATURES ONLY PROVIDED IN AN ADMINISTRATOR SESSION - 
HEADST, HANDST AND CLASS

Headset mode - HEADST

After pressing  , by successively pressing on   you can tell whether or not the station ope-
rates with a headset. If it does, plug the headset into the handset slot.

Gain improvement - HANDST

After pressing  , by pressing successively on   you can activate or cancel gain improve-
ment on a station (improves hearing in noisy surroundings).

Hotel  type telephone set - CLASS

After pressing  , select Administrative, Host or Booth by successively pressing on .

A

SPEDEV
A

CHOICE

PRIO 
A

HEADST
A

CHOICE

HANDST
A

CHOICE

CLASS A
CHOICE
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File
 METERING COUNTERS
The system sums up the following metering information in the form of partial and  adding counters:

- For each station or group (stations or OS):
• 4 partial charge counters and 4 partial cost counters
- 1 adding charge counter and 1 adding cost counter

- For each line:
• 1 partial charge counter
- 1 adding cost counter

Press . 

PRINTING OF STATION/GROUP AND LINE COUNTERS - PRINT   

 Press  .

 makes it possible to print the partial and adding counters for the stations and  groups.

Station or 
group No.

A

Slot No.

Reading of adding counters

Resetting of all the partial counters of all stations and groups or all lines

Equipment No.

B

Printing of partial and adding counters of lines

Access type Number

COUNT

RESET1EXTENS

ACCESS

RESET4

LOGACC

EXTENS

ACCESS

EXTENS

ACCESS

METER

COST

TOTAL

RESET1

RESET4

PRINT

RESALL

RESPAR

RESPAR

Printing of partial and adding counters 
for stations and groups

Reading and resetting of a station or 
a group partial metering 
pulse counters

Reading and resetting of a station or 
a group partial cost counters

Reading of the access partial counter 
and adding charge counter

Reading of the access partial counter 
and adding charge counter

Resetting of the line partial 
metering pulse counter

Resetting of the access partial 
metering pulse counter

ACCOUN

A

PRINT 
A

EXTENS
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 makes it possible to print the partial and adding counters for the lines.

READING OF A STATION'S/GROUP'S COUNTERS - EXTENS   

After pressing  , enter the directory number of the station (or group) whose counter should be  
printed. 

Reading and resetting of the meter pulse counters - METER 

  displays the contents of the 4 partial metering pulse counters for the station  concerned.

 to  make it possible to reset the 4 counters individually.

Reading and resetting of the cost counters - COST 

  displays the contents of the 4 partial cost counters for the station (or group)  concerned.

 to  make it possible to reset the 4 counters individually.

Readout of the adding counters - TOTAL 

   displays the station adding and cost counter values.

ACCESS

A

EXTENS
A

A

METER B

RESET1 RESET4

A

COST B

RESET1 RESET4

A O

TOTAL B
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READING AND RESETTING OF THE LINE COUNTERS (PHYSICAL 
ADDRESSES) - ACCESS

After pressing  , enter the data necessary for identification of the line whose partial and ad-
ding counters are to be displayed, validate.

Identification of interfaces:

- SLOT : slot number: 1 to 8 (basic module), 11 to 18 (extension module 1), 21 to 28 (extension
module 2)

- EQUIP : equipment number: 1 to 8

The display then shows the values for the line metering pulse and cost adding counters.

 makes it possible to reset the line partial metering pulse counter.

RESETTING OF THE STATION/GROUP AND LINE PARTIAL COUNTERS - 

RESALL   

  makes it possible to reset all the partial counters for the stations or lines.

 makes it possible to reset all the station or group partial counters.

 makes it possible to reset all the line partial counters.

Notas : Only the station partial counters can be reset in Administrator session.

READING AND RESETTING OF THE LINE COUNTERS (LOGICAL 
ADDRESSES) - LOGACC

After pressing  , enter the data necessary for identification of the access (access number and 
type) for which the partial and adding counters are to be displayed and then validate. 

To enter the access type, press the L(AG) soft keys for a TL, N(T0) for a T0 access or P(T2) for a T2/
DLT2 access. The display then shows the values for the line partial and adding counters.

 makes it possible to reset the line partial metering pulse counter.

ACCESS
A

RESPAR

A

RESALL
A

EXTENS

ACCESS

LOGACC
A

RESPAR
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GENERAL COMMANDS
This function is used for defining general elements which are common to the whole system.

Previous password

A

New password

No conference

Conference with up to 1 TL

Conference with up to 2 TL

ADMINISTRATOR default password

OPERATOR default password

History reading

Reading of the system message table

Resetting of the system message table

INTERNTL PREFIX

AREA PREFIX

CALL-BACK PREFIX

International prefix

Area prefix

Call-back number

Call-back from the operator or initiator of the transfer if a transfer fails

GLOBAL CONF

PASSWD

MAINTE

NUMPFX

MASREC

NOCONF

ONEEXT

2 EXT

RESADM

RESOPE

NEWPWD

RDHIST

RDANOM

RRANOM

CHOICE

RAM memory read/writeRD/WR MEMORY

ADDRES

TIMER

L1ALAR

RESALL

ReadingSlot number, equipment 
number or logical number

Reading and resetting of T1/T2/DLT2 
alarm counters

Modification of the 
INSTALLER password
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Press .

CHOICE OF THE TYPE OF CONFERENCE - CONF   

After pressing  , choose the conference operating mode (no conference, with one external 
line, with 2 external lines); by default: with one external line.

PASSWORDS - PASSWD   

Press  . 

Reinitializations of the passwords - RESADM and RESOPE

 and  make it possible to return to the default password required for entering the ADMINIS-
TRATOR and OPERATOR sessions. 

A

GLOBAL INSNUM

Number Name associated with a numberNAME

PUBLIC

PRIVAT

Installation public and private number

KOFPAG CHOICE Paging type (suffix, prefix 2, prefix 4 or prefix 5)

JOING. TRANSF Joining by transfer authorized or not

DIVERT Joining by forwarding authorized or not

ALTCLI Alternative CLIP number

DOWNLD SWAP

SWVERS

DATE

TIME

MODE

CURENT

OTHER

Software downloading:

- reading of software versions

MFTRAN CHOICE
DTMF end-to-end signalling

FAXTAB RESUBS

FAXNUM

Fax notification table

KEYPAD CHOICE Keyboard facilities

SWKEYS MAIN

CTI

Software keys (system and CTI)

- definition of switchover parameters 
(date, time, with or without data saving)

GLOBAL

A

¤CONF
A

A

PASSWD
A

RESADM RESOPE
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Modification of the Installer password - NEWPWD

 makes it possible to change the INSTALLER password.

Enter the current password (8 characters).

Enter the new password (8 characters).
Confirm the password by entering it a second time.

Notas :

In the Administrator session, only the password of the current sessions can be modified, that of a lower 
level may be reinitialized.

HISTORY AND EQUIPMENT MESSAGES - MAINTE   

Press  . 

 makes it possible to read the table of historic messages.

 makes it possible to read the equipment messages.
 makes it possible to reset the system message table.

Notas :

For more details regarding the messages, refer to the Maintenance guide.

T1/T2/DLT2 ALARM COUNTERS- L1ALAR   

  makes it possible to read and reset the T1/T2/DLT2 alarm counters. Select the link (slot num-
ber + equipment number or logical number).

- NOS: NO Signal indication
- RRA: Receive Remote Alarm
- AIS: Alarm Indication Signal
- LOS: Loss of Synchronization
- FEC: Error rate
- LV1: Level 1 unavailable
- LV2: Level 2 unavailable

 makes it possible to reset all the counters.

 DIALLING PREFIXES - NUMPFX

Press  .

NEWPWD

A

MAINTE
A

RDHIST

RDANOM

RRANOM

A

L1ALAR
A

RESALL

NUMPFX
A
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1st display: enter the international prefix, validate. 
2nd display: enter the area prefix, validate.
3rd display: enter the call back prefix (4 digits max, number of trunk group used to make an outgoing 
call from the directory of callers), validate.

REACTION ON TRANSFER FAILURE - MASREC

Press  . 

By pressing successively on , you can choose the destination station to which the call will be routed 
during  a transfer failure: ATTENDANT RECALL or MASTER RECALL (initiator of the  transfer).

READ/WRITE IN MEMORY - RD/WR

  makes it possible to read the contents of the system RAM memory noteworthy addresses. 
Modification of these contents makes it possible to parameterize certain particular system operations.

Entering a value at the wrong address may result in deterioration of system  operation.

Write in memory - MEMORY

 makes it possible to modify the value of a noteworthy address. Enter  the address (8 characters 
maximum) then validate.

Softkeys A, B, C, D, E and F are used to enter the hexadecimal noteworthy  address.

Read memory (except timers and maintenance and debug addresses) - ADDRES

 makes it possible to read the contents of the system noteworthy addresses, except for the addres-
ses which concern timers and maintenance and debug  features.

 makes it possible to position yourself on any index.

Reading the timers -  TIMER

 makes it possible to read the contents of the noteworthy addresses concerning the system timers.

INSTALLATION NUMBERS - INSNUM

  makes it possible to define the Alternative CLIP number and the public and  private numbers 
of the installation. 

 : number up to 20 digits max, separators * not included; the * character separates the different 
fields: country indication, area number (optional  field depending on country), PABX number. The size 
of the field depends on the country.

 : number up to 10 digits max. without separators.

MASREC
A

CHOICE

RD/WR 
A

CM MEM

CM ADR

GOTO 

CM TIM

INSNUM
A

PUBLIC

PRIVAT
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 : Alternative CLIP number (20 digits max.); this number, if configured, is sent to the ISDN corres-
pondent on an outgoing call in place of the installation number + DDI number of the calling party.

ALTCLI
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KIND OF PAGING - KOFPAG

Press  . 

 : by successively pressing this key, you can define the operating mode for the paging:

- suffix: paging connected to a trunk line interface; selective paging.
- prefix 2
- prefix 4: paging connected to a Z station interface; general paging
- prefix 5

JOINING - JOING.

Press  . 

 : by successively pressing this key, you can authorize or inhibit joining by  transfer (transfer ext -
ext).

 : by successively pressing this key, you can define the type of external forwarding: Joining or Re-
routing.

DIRECTORY - NAME    

  makes it possible to display all the names corresponding to a given number in  the numbe-
ring plan, with the possibility of modifying these names. 

 and  make it possible to modify/add a name; enter the user name (16 characters  maxi-
mum) as "surname-space-first name" using the alphabetic keypad or the station's dialling keypad 
which will have automatically switched to "letters" mode.

KOFPAG
A

CHOICE

JOING.
A

TRANSF

DIVERT

A

NAME 
A

MODIFY ADD 
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DOWNLOADING - DOWNLD

Press  .

 makes it possible to configure the date, the time and the software switchover mode: 

 : date of switchover

 : time of switchover
 : switchover mode; by successively pressing on , define the switchover operating mode: 

- normal with data saving
- normal without data saving
- forced with data saving (no restoration of the old version in the case of a transfer failure).

 makes it possible to read the software references of the CPU board:

 : current CPU software reference

 : new CPU software reference

FAX NOTIFICATION TABLE - FAXTAB

This 30-entry table defines the relationships between the user numbers to be notified by a message in 
an incoming fax which is intended for them and the number of the receiving fax machine.

Press  .

 makes it possible to define the number of the station to be called (sending a  message saying 
that a fax has arrived). 

 makes it possible to define the number of the fax machine concerned.

DTMF END-TO-END SIGNALLING - MFTRAN

Press  .

 : by successively pressing this key, you can define whether the DTMF end-to-end signalling is ap-
plied globally for all users, for no user or whether the passage in DTMF end-to-end signalling is carried 
out individually for the stations.

DOWNLD
A

SWAP

DATE 

TIME 

MODE CHOICE

SWVERS

CURENT

OTHER 

FAXTAB
A

RESUBS

FAXNUM

MFTRAN
A

CHOICE
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KEYBOARD FACILITIES - KEYPAD

Press  .

 : by successively pressing this key, define whether the “Keyboard facilities” feature is activated or 
not in the system. For further information, refer to the “Supplementary Services” of the “Telephone ser-
vices” section.

SOFTWARE KEYS - SWKEYS

Press  .

 makes it possible to configure the system software license (42 to 120 characters).

 makes it possible to configure the CTI software license (17 to 161 characters).

KEYPAD
A

CHOICE

SWKEYS
A

MAIN 

CTI 
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COLLECTIVE SPEED DIAL NUMBERS
The system makes it possible to create a general directory of 2000 numbers.

Each number can have 22 digits (trunk group number included).

Press .

 makes it possible to delete the programming of a specific speed dial number.

 after pressing this key, enter the call recipient’s name and validate; then enter the public number 
preceded by the trunk group number and validate.

Nota : A "pause" (character !) or an “MF forcing” (character /) can be entered in the public number 
entry screen using the alphanumeric keyboard.

 provides direct access to a specific speed dial number; enter the call recipient’s name or press 
the  key to provide access via the speed dial number, and then validate.

 after this key is pressed, the first free entry in the directory is displayed; the procedure is then 
identical to the procedure provided by the  key.

Speed dial No.

A

Creation of a new speed dial number
(1st free speed dial number)

Deletion of a speed dial number

Creation or modification of a speed dial number
(from a specific number)

COMSPD CLEAR

MODIFY

GOTO

NEW

Selection of a speed dial number

COMSPD

CLEAR 

MODIFY

GOTO 

NUMBER

NEW

MODIFY
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TIME RANGES
This function is used for dividing a day's 24 hours into a maximum of 7 time ranges defined by the 
starting time. Each range can be in normal or restricted mode. A group of a maximum of 8 operator 
stations can be assigned to each time range. At least one time range must be defined in the system.

Press . 

  : by successively pressing this key, you can choose the desired operating  mode: normal 
mode or restricted mode.

  makes it possible to state the operator group number (1 to 8) assigned to the  time range 
concerned.

  makes it possible to enter the start time of the time range.

  makes it possible to add a new time range (if less than 7).

  makes it possible to delete all time ranges.

Time

Group No.

Start time of a new time range

Normal or restricted mode

A

Time Start time of a time range already defined

Deletion of all time ranges

MODETIMERA

ATTGRP

TIME

ADD

DELALL

Assignment of an operator group to 
the time range

TIMERA

MODE 
A

ATTGRP
A

TIME 
A

ADD 
A

DELALL
A
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ANALOG LINES AND DIGITAL 
ACCESSES
This function is used to define the characteristics of the analog lines (possibility provided from version 
R1.1 onwards) and T0/T2/DLT2 digital accesses.

Access identification TL connection (incoming, outgoing, mixed, PABX)

Decadic or DTMF dialling

With or without polarity reversal

Switched on

Switched off

INSERV

OUTOFS

if analog

if digital access

Call destination in normal and 
restricted mode (DDI No.)

Switched off

INSERV

OUTOFS

Incoming

Outgoing

Total

Paging connection interface

Normal

Restricted

Normal

Restricted

A

B

B_CHAN

DIRECT

NUMBER

POLARI

PAGING

ACCESS

OUTINS

CALDIS

OUTINS

CALDIS

Line used for DISA transit callsDISA

Protection against DDC callsDDCPRO

NNV, RNV, NV, RV: barring link categoryCATEGO
N, R: traffic sharing link category

REPENT

REPENT

NNV, RNV, NV, RV: barring link categoryCATEGO
N, R: traffic sharing link category

Call destination in normal and 
restricted mode (DDI No.)

NNV, RNV, NV, RV: collective speed dial rights 
(access to collective speed dial numbers)

NNV, RNV, NV, RV: collective speed dial rights 
(access to collective speed dial numbers)

Number of incoming, outgoing channels, 
total number of channels

Switched on
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Press .

Enter the data necessary for identifying the access and validate:

Identification of interfaces:

- SLOT : slot number: 1 to 8 (basic module), 11 to 18 (extension module 1), 21 to 28 (extension
module 2)

- EQUIP : equipment number: 1 to 8

ANALOG LINES (from version R1.1 onwards)

  : by successively pressing this key, you can display the desired line connection mode:

- PBX : line behind PABX
- INC : incoming line
- OUT : outgoing line
- MIX : mixed line

  : by successively pressing this key, you can display the desired dialling mode:

- DE : decadic dialling
- MF : MF dialling
- NO : no dialling

  : by successively pressing this key, you can display the desired characteristic:

- YES : with polarity reversal
- NO : without polarity reversal

  : by successively pressing this key, you can display the desired characteristic:

- YES : interface for connection of a paging device
- NO : TL interface

  makes it possible to read the current access status: In Service, Out of Service, Physical OOS/
Logical OOS or Physical OOS/Logical IS.

Choosing INSERV + OK sets the access to LOGICAL IN SERVICE.
Choosing OUTOFS + OK sets the access to PHYSICAL OUT OF SERVICE/LOGICAL OUT OF SERVICE.

   : enter the DDI number of the destination station or hunting group for calls in normal 
mode. A second similar display is presented indicating the destination for calls in restricted mode.

  : by successively pressing this key, state whether the line can be used for DISA calls or not.

ACCESS

DIRECT
A

NUMBER
A

POLARI
A

PAGING
A

OUTINS
A

A CALDIS
A

DISA 
A
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  : by successively pressing this key, it is possible to accept or refuse DDC calls when this line 
is used for a station external forwarding.

   makes it possible to define barring and traffic sharing link categories for each station.

NNV : barring link category for data communications in normal mode

RNV : barring link category for data communications in restricted mode
NV : barring link category for voice communications in normal mode
RV : barring link category for voice communications in restricted mode
N : traffic sharing link category in normal mode
R : traffic sharing link category in restricted mode

Enter a value from 1 to 16 to assign to the category concerned then press APPLY.

   makes it possible to define the collective speed dial numbers which can be transmitted 
on each trunk. For example, a trunk with category 10100000 may be used to transmit speed dial num-
bers in categories 1 and 3.

: speed dial rights link category for voice communications in normal mode

: speed dial rights link category for data communications in normal mode
: speed dial rights link category for voice communications in restricted mode
: speed dial rights link category for data communications in restricted mode

 : by successively pressing this key, you can define whether the station concerned has the right (1) 
or not (0) to access the chosen directory list (NV, NNV, RV, RNV), then validate.

DDCPRO
A

A CATEGO
A

A REPENT
A

NV 

NNV

RV 

RNV 

FEATUR
Ed. 04 3/4Réf. 3EH 21000 BSAA



ANALOG LINES AND DIGITAL 
ACCESSES

MMC STATION

 

DIGITAL ACCESSES

  : for T0/T2/DLT2 accesses, state the number of incoming (INC) or outgoing (OUT) channels 
as well as the total number of channels (value non modifiable for T0 access), then validate; the number 
of mixed (MIX) channels is deduced from the other data. 

  makes it possible to read the current access status: In Service, Out of Service, Physical OOS/
Logical OOS or Physical OOS/Logical IS.

Choosing INSERV + OK sets the access to LOGICAL IN SERVICE.
Choosing OUTOFS + OK sets the access to PHYSICAL OUT OF SERVICE/LOGICAL OUT OF SERVICE.

   : enter the DDI number of the destination station or hunting group for calls in normal 
mode. A second similar display is presented indicating the destination for calls in restricted mode.

   makes it possible to define barring and traffic sharing link categories for each access.

NNV : barring link category for data communications in normal mode

RNV : barring link category for data communications in restricted mode
NV : barring link category for voice communications in normal mode
RV : barring link category for voice communications in restricted mode
N : traffic sharing link category in normal mode
R : traffic sharing link category in restricted mode

Enter a value from 1 to 16 to assign to the category concerned then validate.

   makes it possible to define the collective speed dial numbers which can be transmitted 
on each access. For example, an access with category 10100000 may be used to transmit speed dial 
numbers in the speed dial rights and traffic sharing categories.

: speed dial rights link category for voice communications in normal mode

: speed dial rights link category for data communications in normal mode
: speed dial rights link category for voice communications in restricted mode
: speed dial rights link category for data communications in restricted mode

 : by successively pressing this key, you can define whether the station concerned has the right (1) 
or not (0) to access the chosen directory list (NV, NNV, RV, RNV), then validate.

B CHAN
B

OUTINS
B

A CALDIS
B

A CATEGO
A

A REPENT
A

NV 

NNV 

RV

RNV 

FEATUR
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TRUNK GROUPS
It is possible to create 120 trunk groups with up to 120 lines in each trunk group.

Each trunk group is allocated barring and traffic sharing link categories and a control mode (cyclic or 
sequential).

Press .

Enter the trunk group number (1 to 120), validate.

TRUNK GROUP CONTROL MODE - MODE

  : by successively pressing on this key, you can choose the trunk group control mode: se-
quential (SEQ) or cyclic (CYC).

TRUNK GROUP CONFIGURATION - CHANNL

  grants access to the trunk group configuration window.

 makes it possible to add a line (or an access) to the trunk group. Enter the data necessary for 
identification of the trunk group and validate:

Identification of interfaces:

- SLOT : slot number: 1 to 8 (basic module), 11 to 18 (extension module 1), 21 to 28 (extension
module 2)

- EQUIP : equipment number: 1 to 8

Trunk group control mode (cyclic or sequential)

Barring and traffic sharing link categories

Reading of the trunk group configuration
A

Trunk group No.

Level 1 to 16

Trunk group content

TRGP MODE

CHANNL

CATEGO

ADD

TRGP 

MODE 
A

CHANNL
A

ADD 
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BARRING AND TRAFFIC SHARING CATEGORIES - CATEGO

  makes it possible to define the barring and traffic sharing link categories for each trunk:

NNV : barring link category for data communications in normal mode

RNV : barring link category for data communications in restricted mode
NV : barring link category for voice communications in normal mode
RV : barring link category for voice communications in restricted mode
N : traffic sharing link category in normal mode
R : traffic sharing link category in restricted mode

Enter a value from 1 to 16 to assign to the category concerned then validate.

CATEGO
A
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GROUPS
This function is used to create:

- 50 hunting, call pickup or broadcast groups with up to 32 stations in each group.
- 8 groups of operator stations with up to 8 stations in each group.

Call pickup groups

Hunting groups

Broadcast groups

Operator groups

Group No. Station No.

Station No.

Station No.

Station No.

GROUPS PICKUP

HUNT

BROADC

ATTGRP

Group No.

Group No.

Group No.

ADD

ADD

GRPTYP

ADD

TRANS

RECEPT

ADD

ADD

OTHER

destination

destination

1st time-out

2nd time-out

DYNROU

LOCAL

TMOUT1

TMOUT2

EXTERN

LEVEL1

LEVEL2

destination

destination

1st time-out

2nd time-out

DYNROU

LOCAL

TMOUT1

TMOUT2

EXTERN

LEVEL1

LEVEL2

VMUBEH

VMUBEH

ADDOTHER

Dynamic distribution of hunting 
group calls

Dynamic distribution of operator
group calls
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Press . 

CALL PICKUP GROUPS - PICKUP

After pressing  , enter the group index and validate. The directory number of the first station  
in the group is displayed.

 makes it possible to add a station directory number to the group.  Enter the  number of the station 
to be added to the group.

HUNTING GROUPS - HUNT

After pressing  , enter the hunting group directory number. The directory number of the first 
station  in the group is displayed.

 makes it possible to add a station directory number to the group.  Enter the  number of the station 
to be added to the group.

 : by successively pressing this key, you can choose the type of group: parallel, sequential or cyclic 
then validate.

  makes it possible to define the dynamic routing mechanisms for hunting group  calls:

-  and  make it possible to define whether the dynamic distribution (time-outs T1 and T2,
destinations) criteria for each type of call (external or local) are active or not:
•  makes it possible to define a destination station (or hunting group) or a  collective speed

dial number for the dynamic routing in the case where the call  has not been answered after a
time-out TP1 (12 seconds by default).

• : by successively pressing this key, you can define whether the time-out 1 is active (TP1) or
inactive (tp1).

•  : by successively pressing this key, you can define whether the time-out 2 is active (TP2)
or inactive (tp2).

-  or  : by successively pressing this key, define whether the system should route the
call to the operator and/or the general bell after the non-response time-out TP2 has lapsed (ac-
tive = ATTD or GBEL; inactive = attd or gbel).

-  and  make it possible to define the time-outs in tenths of a second. The default value is
12 seconds.

-  makes it possible to define the role of the office communicator when it is used  in a level 1
or 2 dynamic routing; by successively pressing  or , you can choose between "Auto-sec"
or "Mailbox".

GRPPIC

PICKUP
A

ADD 

INDPIC
A

ADD 

GRPTYP

DYNROU

EXTERN LOCAL 

NUMBER

TP1 

TP2 

OPERAT GENBEL

TMOUT1 TMOUT2

VMUBEH

LEVEL1 LEVEL2
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BROADCAST GROUPS - BROADC

After pressing  , enter the broadcast group directory number. The directory number of the first 
station  in the group is displayed.

 makes it possible to add a station directory number to the group.  Enter the number of the station 
to be added to the group; press  to add the general bell to the group.

 : by successively pressing this key, you can choose whether the station  concerned can transmit 
a broadcast call.

 : by successively pressing this key, you can choose whether the station  concerned is subjected to 
a broadcast call.

Notas : In a group with an external loudspeaker, the following rights must be observed: for the sta-
tions: transmission = YES, reception = NO; for the loudspeaker: transmission = NO, re-
ception = YES

OPERATOR STATION GROUP - ATTGRP

After pressing  , enter the group index and validate. The directory number of the first station  
in the group is displayed.

 makes it possible to add a station directory number to the group.  Enter the number of the station 
to be added to the group.

 proposes another destination; by successively pressing this key, you can choose the destination 
(General bell, Welcome 1 to 8) then validate.

  makes it possible to define the dynamic routing mechanisms for operator station  group calls:

-  and  make it possible to define whether the dynamic distribution (time-outs T1 and T2,
destinations) criteria for each type of call (external or local) are active or not:
•  makes it possible to define a destination station (or hunting group) or a  collective speed

dial number for the dynamic routing in the case where the call  has not been answered after a
time-out TP1 (12 seconds by default).

• : by successively pressing this key, you can define whether the time-out 1 is active (TP1) or
inactive (tp1).

•  : by successively pressing this key, you can define whether the time-out 2 is active (TP2)
or inactive (tp2).

-  or  : by successively pressing this key, define whether the system should route  the
call to the operator and/or the general bell after the non-response  time-out TP2 has lapsed
(active = ATTD or GBEL; inactive = attd or gbel).

BROADC
A

ADD 

OTHER 

TRANS 

RECEPT

ATTGRP
A

ADD

OTHER 

DYNROU

EXTERN LOCAL 

NUMBER

TP1 

TP2 

OPERAT GENBEL
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-  and  make it possible to define the time-outs in tenths of a second. The default value is
12 seconds.

-  makes it possible to define the role of the office communicator when it is used  in a level 1
or 2 dynamic routing; by successively pressing  or , you can choose between "Auto-sec"
or "Mailbox".

TMOUT1 TMOUT2

VMUBEH

LEVEL1 LEVEL2
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SYSTEM RESET
This function is used for defining the conditions of the next system reset (warm, cold, manual or auto-
matic).

Press .

 : by successively pressing this key, you can display the type of reset to be carried out: 

- warm reset: simple reset.
- cold reset: reset + loss of client configuration (return to default configuration).

 : by successively pressing this key, you can display the condition for the next reset: manual or 
automatic.

HOT

MANUAL

COLD

AUTOMATIC

RSTSYS TEMP

TYPE

RSTSYS

TEMP 

TYPE
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TERMINAL PROFILES
This function is used for assigning a terminal profile to the stations, in the following order:

- assignment of a basic profile:
• key system mode (operator and stations)
• PABX mode (operator and stations)
- single line (stations only)

- assignment of an advanced profile:
• manager/secretary
- teamwork

Station No. Trunk group No.

Manager 
station No.

Secretary 
station No.

Station No. Teamwork

A

Cancellation of the terminal in the systemStation No.

Erasing of the station key programmingStation No.

TERPRO PABX

KEYSYS

MGRSEC

TEAMWK

DELSET

DELKEY

MODE

ADD

SUBSCR

MONO

Station No. Trunk group No.PABX

KEYSYS

OPERAT

Station No.

Station No.

Station No.

TERACC CNStation No. De-registration of a DECT Reflexes handset

Station in PABX, key system 
or single-line mode

Operator in PABX 
or key system mode

Manager/secretary pair in Basic 
or Advanced mode
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TERMINAL PROFILES AVAILABLE ACCORDING TO THE TYPE OF STATION

Press . 

STATION PROFILE - SUBSCR

After pressing  , choose the profile to be assigned: single line, key system or PABX.

Enter the station directory number; for the PABX mode, state the trunk group number associated with 
the RSB keys and validate. To load the selected profile, validate.

OPERATOR PROFILE - OPERAT

After pressing  , choose the profile to be assigned: key system or PABX. 

Enter the operator station directory number; for the PABX mode, state the trunk group number asso-
ciated to the RSB keys and validate. To load the selected profile, validate.

Station type BASIC PROFILE ADVANCED PROFILE

Single line Multiline Working 
group

Manager/Secretary couple

PABX Key system Manager Secretary

Stations with 
display

YES YES YES YES YES

Multiline sta-
tions wi-

thout display Except 4003 YES YES YES YES

Single line 
stations

YES Except 4003 Except 4003

Z Option YES

TERPRO

SUBSCR
A

OPERAT
A
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MANAGER-SECRETARY PROFILES - MGRSEC

After pressing  , enter the manager station's directory number followed by that of the secretary 
station.

 : by successively pressing this key, define the mode for the secretary station: ADVANCED or 
BASIC, then validate. After choosing Basic, each station in the pair has:

- A Filter key for activating or deactivating the filtering of manager station calls.
- An RSL key which allows both members of the couple to call the other member directly.

If the secretary station is to monitor the manager stations resources, choose Advanced mode instead 
of Basic mode.

To cancel the manager-secretary configuration, cancel the programmed Filter key and the RSL resour-
ce key on each station of the filtering pair.

TEAMWORK PROFILE - TEAMWK

Press  .

 makes it possible to add a member to the group. Enter the station directory number. Validate. 
The display then states the number of station resources.

CANCELLATION OF DATA - DELSET AND DELKEY

  after a logical switchoff, makes it possible to erase the data from the station (station type, 
appointment reminders, messages, forwardings, etc.). Enter the station directory number. Validating 
erases the data from the station.

  after a logical switchoff, makes it possible to cancel all programmings of the keys (MMC 
station or MMC PM5) so that a new profile may be loaded. Enter the station directory number. Valida-
ting cancels all key programming.

MGRSEC
A

MODE 

TEAMWK
A

ADD 

DELSET
A

DELKEY
A
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REMINDER OF FUNCTIONS AVAILABLE WITH THE RESOURCE KEY

A resource key is a line key that manages only one incoming/outgoing, local or external communica-
tion. Resource keys can be specialized or not. If a resource key is not specialized, that key can handle 
all types of call:

- mixed resource key (RGM): handles local and/or external calls, whether incoming or outgoing.
- outgoing resource key (RGO): handles local and/or external outgoing calls.
- incoming resource key (RGI): handles local and/or external incoming calls.

If the key is specialized, that key handles a particular type of call:

- resource key dedicated to external access (RSP): handles the calls coming from or going to that ac-
cess.

- resource key specialized in destination (RSD):
• dedicated to a directory number, handles local calls for this number.
• dedicated to a DDI number, handles incoming calls for this number.
- associated to a trunk number, handles the outgoing calls on this trunk.

- resource key dedicated to a station (RSL): handles the calls coming from and going to a particular
station

- resource key dedicated to a trunk (RSB): for making external outgoing calls via a particular trunk
and receiving all network calls.

TERMINAL PROFILE IN KEY SYSTEM MODE

This profile consists of:

- 2 mixed resource keys (RGM) for local and external calls
- as many network monitoring, physical resource keys (RSP) as trunks in the system.

TERMINAL PROFILE IN PABX MODE

This profile consists of:

- 2 mixed resource keys (RGM) for local and external calls
- 2 RSB keys for external calls
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TERMINAL PROFILE IN SINGLE LINE MODE

This profile consists of 3 virtual keys (RGM) for local and external calls.

TEAMWORK PROFILE

assigning this profile gives stations:

- n-1 RSL keys ("n" being the number of members in the group)
- a selective ringing monitoring key
- a group call pickup key

MANAGER/SECRETARY TERMINAL PROFILES

DE-RECORDING OF DECT REFLEXES STATIONS - TERACC

This function makes it possible to de-record a DECT Reflexes station.

Enter its directory number, erase it and then confirm the de-recording.

Mode MANAGER SECRETARY

Basic

Advanced

- key for direct call from the secretary 
station
FILTER key-

-

FILTER key-

- key for direct call from the secretary 
station
FILTER key-

-

FILTER key-
-

key for direct call from the secretary 
station

key for direct call from the manager
station

monitoring keys for all manager's 
resources
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METERING CONFIGURATION
This function defines all the parameters related to the pulse metering operation.

Value

Value

Value

Value

1st basic charge value

2nd basic charge value

Cost of the public network metering pulse

Number

A

Type of printout: ticket or statement

Form feed at the end of the day (ticket or statement)

Number of line spaces between 2 tickets

Masking of the last 4 digits of the dialled number

Information displayed during the communication

Ticket or statement printout language

Fields included in metering statements

Value Number of statements per page

Header printout format

METER

MODE

LANG

FORM_F

LINE_F

MASK

FIELD1

FIELD2

PRIPAR

TICKET

PRINTO

PARAM1

HEADPR

PROOFS

COST 1

COST 2

UNIT T

COSTPE

DISPL

FIELD3

Check of the V24 output used for ticket printout

Threshold at which the 2nd basic charge value 
is taken into account
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Press .

CHARACTERISTICS OF THE V24 METERING - PRIPAR

  makes it possible to check the V24 output used to print metering statements/tickets.

A

Value

Value

Duration threshold

Display of the cost at the end of communication

Cost threshold

Display of the cost during the communication

Value Company name for statements and tickets

Value International call access code

Value Alarm activation threshold

On-line metering cost

Number of decimals in the cost

Statement for untreated incoming calls

METER PARAM2

PARAM3

COMPAN

DUR TH

COST T

INTNAT

MTEND

MTDUR

CSTOLM

FRTCST

ICCALL

ALATHR

Activation of V24 output meteringACTMET

Value

Value

UUS cost

PABX forwarding cost

SUPSER UUSCST

PBXCST

WAKEUP Definition of the criteria for printing alarm tickets

Metering statements on QSIG leased lines (Alcatel)LLEASE

CLABEL Currency unit label

CURCNV Converting of the currency unit into Euros

METER 

PRIPAR
A
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DEFINITION OF THE PRINTOUT TYPE AND FORMAT - TICKET

Press  . 

Various parameters - MODE, LANG, FORM_F, LINE_F, MASK

 : by successively pressing this key, define the type of printout: TICKET, LISTING or NETWORK.

  : by successively pressing this key, define the language for the ticket and statement printouts.
  : by successively pressing this key, define whether a form feed will (YES) or will not (NO) be per-

formed at the end of the day for the printing of statements.
: after pressing this key, state the number of lines you wish to have between each metering ticket.
 : by successively pressing this key, define whether the last 4 digits of the number dialled are to 

be masked (YES) or not (NO) in the printouts of statements and tickets.

Fields to be shown on a pulse metering statement - FIELD1, FIELD2 and FIELD3

,  and  make it possible to define the fields which are to be shown on the metering 
statements.

o Field 1: 

SUB : station number
TYP : call type
TRK : trunk number
DAT : date
TIM : time
DUR : call duration
TAX : number of metering units
SER : remote services

o Field 2: 

FAC : supplementary services
DNU : dialled number
DMO : dialling mode
RIN : ringing duration
CST : call cost
ACC : account code
SUN : printout of user name or business code or no printout

o Field 3: 

IUS : initial user (charged user)
NOD : node number (modifiable only if MODE = NETWORK)
CAR : operator
SU8 : 8-digit user identification
TR4 : 4-digit trunk identification

The selected field flashes.

TICKET
A

MODE 

LANG 

FORM_F

LINE F

MASK 

FIELD1 FIELD2 FIELD3

FIELD1

FIELD2

FIELD3
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 : by successively pressing this key, you can choose whether the flashing  field must be included 
(label in capitals) or not (label in lower case letters)  on the statement.

INFORMATION DISPLAYED ON A STATION DURING A CALL - DISPL

After pressing  , by successively pressing , you can choose the type of information to be 
displayed on the stations during  a communication: duration (DISPLAY DURATION), units + duration 
(DISPLAY UNITS)  or cost + duration (DISPLAY COST).

PRINTOUT FORMATS (HEADER AND NUMBER OF STATEMENTS/PAGE) - 

PRINTO   

After pressing  , by successively pressing , you can choose the type of printout for the 
header: on each page (EP), on the  first page (FP) or no header printout (NO). 

 makes it possible to define the number of statements (0 to 99) per page.

PARAMETERS CONCERNING THE COST OF A CALL - PARAM1    

Press  .

: first basic charge value
: second basic charge value
: threshold where the second basic charge value is taken into account (number of  pulse meters)
: cost of the meter pulse sent by the public exchange (this value is used to  calculate the number 

of meter pulses to be displayed during or at the end of a call).

When choosing , , and , state the value (value then decimal value).

When choosing , state the number of meter pulses after which the second basic charge value is  
taken into account.

FEATUR

DISPL
A

DISPL 

A

PRINTO
A

HEADPR

PROOFS

A

PARAM1
A

COST 1

COST 2

UNIT T

COSTPE

COST 1 COST 2 COSTPE

UNIT T
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THRESHOLD VALUES-V24 ON-LINE METERING - PARAM2  

Press  . 

 : state the duration threshold value (in minutes).

 : state the threshold value (integer value then decimal value).
 : state the monitored business code.
 : by successively pressing this key, you can choose whether the total cost is  displayed at the end 

of the call (END) or not (end).
 : by successively pressing this key, you can choose whether the cost is to be  displayed during the 

communication (DURC) or not (durc).
 : by successively pressing this key, you can choose whether the V24 metering  is activated (TAX) 

or not (tax).
 : by successively pressing this key, you can choose whether the pulse  metering statements are 

to be printed (LEAS) or not (leas) on QSIG leased  lines. 

ON-LINE METERING COST-NUMBER OF DECIMALS-ALARM THRESHOLD 

- PARAM3   

Press  .

 : by successively pressing this key, you can choose the on-line metering cost  (0 to 9 pulse me-
ters).

 : by successively pressing this key, you can choose the number of decimals  for the costs (0, 1 or 
2).

 : by successively pressing this key, you can choose whether a statement is  printed or not in the 
case of an untreated incoming call.

 : to define the percentage of statements stored before an alarm is activated (0  to 100, 0 = no 
alarm).

COMPANY NAME - COMPAN   

After pressing   , enter the company name (16 alphanumeric characters maximum) shown 
on the  statements and tickets and validate.

A

PARAM2
A

DUR TH

COST T

INTNAT

MTEND 

MTDUR 

ACTMET

LLEASE

A

PARAM3
A

CSTOLM

FRTCST

ICCALL

ALATHR

A

COMPAN
A
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COST OF SUPPLEMENTARY SERVICES - SUPSER

Press  . 

: cost of the user to user signalling (UUS)
: cost of the PABX forwarding

For these 2 choices, state the value (value then decimal value).

PRINTOUT OF ALARM TICKETS - WAKEUP   

After pressing   , by successively pressing , you can choose whether to validate the va-
rious printout criteria or not (a  criterion is active when its label is displayed in capital letters on the first  
line of the display; if not, it is displayed in lower case letters):

ACT: alarm activated

CANC:alarm cancelled
FAIL: alarm aborted
ANSW:alarm answered

MONEY UNIT- CLABEL   

  makes it possible to define the label for the present money unit used in the  country and 
displays it on the stations.

CONVERTING THE MONEY UNIT - CURCNV    

Press  .

This feature makes it possible to define the application methods for the change over to the Euro.

  : label displayed (Eur).

 : date of change over to Euro.
 : time of change over to Euro.
 : exchange rate of the Euro with the country's own money unit.
 : cost of basic charge (COST 1 and COST 2); cost of charge sent by the public network (COSTPE); 

threshold  of the basic charge's 2nd value (UNIT T).
 : cost of on-line metering and number of decimals.
 : cost of signalling from user to user and PABX forwarding.

SUPSER
A

UUSCST

PBXCST

A

WAKEUP
A

FEATUR

A

CLABEL
A

A

CURCNV
A

CLABEL

DATE 

TIME

EXRATE

PARAM1

PARAM2

SUPSER
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BARRING PREFIXES
This function is used for defining a maximum of 100 barring prefixes.

Press . 

 : by successively pressing this key, you can change the prefix barring level.
 : by successively pressing this key, you can change the type: FORBIDDEN or AUTHORIZED prefix.

After pressing  , enter the prefix value (10 digits max.) and validate. The following  possibilities 
are offered:
- Choose the barring level (  to ). 
- Choose the type of prefix: press  for an authorized prefix or  for a forbidden prefix.

 makes it possible to position yourself at any position in the barring prefixes  table.

Prefix authorized

Prefix forbidden

Prefix index

A

Number

Barring level (1 to 6)

Prefix authorized or forbidden

BARPFX LEVEL

AUT/FB

MODIFY LEVEL1

LEVEL6

YES

NO

Selection of a specific prefixGOTO

BARPFX

LEVEL 

AUT/FB

MODIFY
A

LEVEL1 LEVEL6

YES NO

GOTO 
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PARAMETER DUPLICATION
This function is used for assigning the parameters of a given station to other stations:

- duplicating user parameters (dynamic forwarding, metering profile, ...): the source and destination
stations can be of different types.

- duplicating terminal parameters (keys); the source and destination stations must be of the same
type.

Notas :

The personal speed dial numbers, RSL and RSD keys cannot be duplicated from one station to another.

Press .

Choose the duplication type (  or ). Enter the source station directory number followed by 
that of the destination  station.

User parameter

Terminal parameters

Source station No. Destination station No.

Source station No. Destination station No.

(irrespective of station type)

(same station type)

COPY SUBSCR

TERMNL

COPY 

SUBSCR TERMNL
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WELCOME AND PLEASE-WAIT 
MESSAGES
This function makes it possible to record welcome messages and define the source of the please-wait 
message.

Press .

RECORDING OF WELCOME MESSAGES - MOH  

 of  makes it possible to record 8 welcome messages and one please-wait message.

After selecting the type of message to be recorded, press .

Record the message using the station handset. 

 makes it possible to stop the recording and then restart it by .  lets you stop the recor-
ding.

 lets you return to the default welcome message.
 lets you listen to the recorded message.

EMITTING SOURCE OF THE PLEASE-WAIT MESSAGE - MUSSRC   

 of  makes it possible to select the emitting source for the please wait message.

-  : default please-wait music (DEFAULT displayed on the first line of the display).
-   : external please-wait music (EXTERN displayed on the first line of the display).
-   : customized please-wait music (CUSTO displayed on the first line of the display).

The please wait message music is subject to composer's rights. For further information, consult the appropriate body.

Recording of welcome messages and please wait music

Selection of please wait music source

A

VOICE MOH

MUSSRC

RECORD

DFAULT

STNDRD

VOICPR

TAPE

VOICE 

A

MOH A

REGIST

SPLIT CONTIN STOP

DFAULT

LISTEN

A

MUSSRC A

STNDRD

TAPE

VOICPR
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NUMBERING PLANS
This function is used for defining the codes associated to the features of the main numbering plan, the 
private numbering plan, the public numbering plan and the table of features in conversation.

Press . 

Preprogrammed NP with 2, 3 or 4 digits, national or with 

Main, private and public numbering plans

Features in conversation

A

NUMPLN INTNUM

RESNUM

CODE

NBDIGI

3CHIFF

GOTO

BEGIN

END

FUNCT

BASE

PRIVAT

GOTO

FUNCT

NUMBER

PUBNUM

TMN

Number modification tableTMN ADD

ABSORB

DDI number modification tablePUBTMN EXTDIG

INTDIG

FAXROU

- range start and end
- base
- function
- private or otherwise
- TMN

Fax call routing (public numbering plan only)

PRINUM

(normal or restricted mode)

NUMPLN
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NUMBERING PLANS - INTNUM, PUBNUM, RESNUM AND PRINUM

 grants access to the selected main numbering plan (99 ranges) for analysis of the dialling made 
on a terminal.

 grants access to the public numbering plan in normal mode (99 ranges), grants access to 
the public numbering plan in restricted mode (99 ranges); these plans are selected for analysis of the 
dialling received by the system via a T0/T2 access or to carry out call distribution (TL or T0/T2). 

 grants access to the selected private numbering plan (36 ranges) for analysis of the dialling re-
ceived by the system via a private line. 

 lets you select a function from those offered.

DESIGNA-
TION

Function USE OF 
THE BASE

USE OF 
THE TMN

MTrG Main trunk group seizure (private or not) YES YES (33)

Subsc Station call (private or not) YES

STrG Secondary trunk group seizure (private or not) YES YES (33)

Code Collective speed dial numbers YES

Group Group call YES

Broad Broadcast group call YES

Prog Switch to programming mode

Pickp Call pick-up YES

Rdial Last number redial

ProCo Data connection protection against intrusion

Forwd Diversions YES

Attd Operator call station

PagS Paging call answer

Pagin Answer to a general paging call

PagP Paging by prefix

CClbk Automatic call back on busy station cancellation

Lock Locking / Unlocking

Mail Text mail

VMU Voice mail unit LED lighting

CVMU Voice mail unit LED lighting off

MTR Metering reminder

DESIGNA-
TION

Function USE OF 
THE BASE

USE OF 
THE TMN

INTNUM

PUBNUM RESNUM

PRINUM

FUNCT 
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The VisAl, VisFr, Disa and Audtx functions are only provided in the public numbering plans (normal 
and restricted mode).

 : by successively pressing this key, state whether the number is private or not; this parameter is 
only used for the Subsc, Main trunk groups and Secondary trunk groups functions.

 makes it possible to enter the index (1 to 32) of the NMT table; enter 33 to retain the initial value 
(without modifications) for the Main trunk group and Secondary trunk group functions.

 makes it possible to enter the number which starts the range (0 to DDDD). The characters *, #, 
A, B, C, D are allowed in the fixed part of the range but not in the variable part (A00 to A99; 100 to 
10B: incorrect).

 makes it possible to enter the number which ends the range (0 to DDDD).
 : used for working out the directory number. The base is included between 0 and 9999. For the 

functions which use the base, the calculation is done as follows: Directory number = Dialled number 
- Begin + Base

 followed by the destination Fax number: makes it possible to associate the user’s DDI number 
with the Fax number to which incoming Fax calls must be routed. This function is only provided in the 
public numbering plan.

FEATURES IN CONVERSATION - CODE

These codes make it possible to access services during an established call.

Press  .

: makes it possible to enter the features in conversation value

Accou Business account code for new outgoing call

Disa DISA Transit

Appmt Appointment reminder / Alarm

CLoop Loopback of dialling into current numbering plan YES (1 to 32)

Main Change of numbering plan (loopback of number in the 
main numbering plan)

YES (1 to 32)

VisAl Temporary allocation of a DDI number to a room

VisFr Cancellation of the allocation of a DDI number to a 
room

RoomS Room status

Replc Station replacement

Move Station movement

OwnVM Mailbox call

Audtx Audiotex service DDI number YES

PRIVAT

TMN 

BEGIN 

END 

BASE 

FAXROU

CODE
A

NUMBER
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: makes it possible to select a function from those offered.

Preprogrammed numbering plans - NBDIGI

  makes it possible to choose one of the preprogrammed numbering plans (2 to 4 digits, na-
tional or with *). Validate.

DESIGNATION Function

PBX recall Calibrated loopbreak

Canc enquiry Enquiry call cancellation

Broker Shuttle call

Callback Automatic call back

Consult Waiting call consultation

Conference Conference

Intrusion Intrusion on busy

Code paging Paging

Resend MF DTMF end-to-end signalling

Parking Parking

Send MF num Automatic switch DTMF end-to-end signalling and retransmission of this service 
access code

Doorphone Open door

AllotN Cat 1 to 7 Allocation of line with barring category 1 to 7

AllotM Cat 1 to 7 Allocation of line with barring category 1 to 7 + Metering reminder

Mcid Malicious call identification

DND override Override Do not disturb

Conv record Recording of conversations

FUNCT 

NBDIGI
A
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NUMBER MODIFICATION TABLE - TMN

  makes it possible to define the modifications to be made to the incoming dialling. Position 
yourself at the beginning (index 1 to 32) of the table quoted by the main numbering plan function.

 : digits to be added (16 maximum).

 : number of digits to be deleted (4 maximum). 

DDI NUMBER MODIFICATION TABLE - PUBTMN

  makes it possible to define the digits to be substituted before analysis by the DDI numbering 
plan (this function concerns DDI with more than 4 digits). Position yourself at the beginning (index 1 
to 32) of the table quoted by the DDI numbering plan.

 : digits to be deleted (16 maximum).

 : digits to be added (8 maximum). 

TMN 
A

ADD 

ABSORB

PUBTMN
A

EXTDIG

INTDIG
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SPLITTING AND END OF DIALLING
This function is used for defining the following elements:

- maximum number of digits in closed dialling mode
- 20 end of dialling prefixes and their associated counters
- 16 splitting prefixes for all lines (PABX or public network)

END OF DIALLING - EODIAL

Press  then  .

End of dialling prefixes - PREFIX

  displays the end of dialling prefixes and value of the counters associated with the different 
prefixes.

After pressing , enter the end of dialling prefix (6 digits max) and validate. Then state the value 
of the counter associated with the prefix and validate.

Reference counter - REFCNT

After pressing  , enter the value of the counter and validate.

A

Prefix End of dialling prefixes

Number of digits Number of digits in closed dialling mode

Prefix Splitting prefix

Tone detection

B

C

EODPFX EODIAL

SPLIT

PREFIX

REFCNT

PREFIX

TONDET MANUAL

SPLIT

TONE

PAUSE

EODPFX EODIAL
A

PREFIX B

MODIFY

REFCNT B
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SPLITTING - SPLIT

Press  then  .

Splitting prefixes - PREFIX

 of  displays the splitting prefixes.

After pressing , enter the splitting prefix and validate.

By successively pressing , define the type of connection associated with the prefix, PABX, PSTN, 
ALL or CTRYCD then validate.

Tone detection/pause - TONDET

Press  .

TONE or PAUSE are provided by successively pressing  or  to define the operation in manual 
seizure mode (  key) or during dialling (  key).

PAUSE: the system must insert a pause

TONE: the system uses the tone detection mechanism

EODPFX SPLIT 
A

PREFIX
C

MODIFY

MODIFY

TONDET
C

MANUAL SPLIT 

MANUAL SPLIT 
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PRE-ANNOUNCEMENT MESSAGES
This function makes it possible to assign up to eight 16-second welcome messages to stations or hun-
ting groups (up to 15 entries with DDI numbers + 1 entry corresponding to all stations and hunting 
groups) with validity according to the time ranges.

Press . 

After pressing  or :

 makes it possible to choose the operating mode (OFF, MODE1, MODE2, MODE1 BUSY or 
MODE2 BUSY).

- MODE 1: the external correspondent hears the message from start to finish then the called station
is rung. 

- MODE 2: the external correspondent hears the message while the called station is being rung. 
- MODE 1 BUSY: message broadcasted in mode 1 only if the station or hunting group is busy.
- MODE 2 BUSY: message broadcasted in mode 2 only if the station or hunting group is busy.
- OFF: no access to welcome message

 makes it possible to choose the welcome message: Msg 1 to Msg 8.

 makes it possible to choose the time range (the starting time for the range is displayed).

 makes it possible to delete the data from the selected entry.

 makes it possible to delete all the entries in the table.

Deletion of an entry

PREANN

CLEAR

ADD

MODIFY Modification of the current entry

MODE

MSG

Destination Operating mode

Choice of welcome message

Deletion of all data in the tableDELALL

NEXT Next time range

PREANN

ADD MODIFY

MODE 

MSG 

NEXT 

CLEAR

DELALL
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DECT 
This function is used to define the parameters for the use of DECT handsets.

Press .

System ARI modification

A Addition of DECT handset data structures

Reading of data concerning handsets

Base station characteristics

DECT ARI

NEWHDS

HANDST

BASES

Authorization to carry out an access procedure from a GAP DECT handset.REGIST

VISIT

GAP PERM

VISIT

MODE

Date

Permanent registration of a GAP DECT handset

GAP DECT handset operating mode

Visitor registration completion date

UA DECT station identification codeIPUI

WUA1 PERM

VISIT Date

Permanent registration of a UA DECT handset

Visitor registration completion date

Feature not usedDISPL

NAME

OUTINS

Identification 
(slot, equipment)

DETAIL

DELSET

FIRMID

BOOTID

LENGTH

ANTDIV

System operating with an authentication code or notAUTHEN

Authentication code modification (AC)AUTHCD

DECT
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MODIFICATION OF THE SYSTEM ARI - ARI

When a system is put into service for the first time, its ARI (Access Right Identifier) has the default value. 
If there are two ALCATEL DECT systems which belong to two different clients but which have the same 
radio signalling zones, the default values must be modified and a different ARI value assigned to each 
one of the systems. After modification of the ARI, the base stations are informed of the new ARI.

After pressing , enter 11 octal digits, the first being non-modifiable (always equal to 1) and the 
last being equal to 0 or 4.

ADDITION OF DECT MOBILE DATA - NEWHDS

  makes it possible to create new data structures for DECT mobiles.

Data associated with a DECT access - VISIT

 makes it possible to create data associated with a DECT access specified as a visitor. This DECT 
access is then used to record a DECT station subsequently (UA or GAP). 

Data associated with a GAP DECT handset - GAP

This command makes it possible to automatically register a new GAP DECT handset. This registration 
is based on the reception of an access right sent by the GAP DECT handset (after a manoeuvre on the 
part of the user). Only one GAP DECT handset can be registered at a given time.

 makes it possible to select a permanent association to the system.

 makes it possible to select a temporary association with the system; enter the date on which the 
mobile is to be automatically disconnected from the system and validate.

 makes it possible to define the operating mode for the GAP DECT handset: Bas, Enh or UA 
(WUA: significant choice for UA + GAP DECT).

Data associated with a UA DECT handset - WUA1

A UA DECT handset is registered manually by entering its IPUI.

 makes it possible to select a permanent association with the system.

 makes it possible to select a temporary association with the system; enter the date on which the 
mobile is to be automatically disconnected from the system and validate.

 makes it possible to modify the DECT handset IPUI value; enter 14 octal digits and validate.

ARI

ADD 
A

VISIT 

PERM 

VISIT

MODE 

PERM 

VISIT 

IPUI 
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READING OF THE DATA CONCERNING MOBILES - HANDST

  makes it possible to display the data (directory number, type of association with the system, 
IPUI) relative to all the DECT mobiles declared in the system.

 makes it possible to display the data of a specific mobile; enter the directory number of the mo-
bile whose data you wish to see.

BASE STATION FEATURES - BASES

Press  and then enter the slot number and the equipment number of the interface to which 
the base station to be parametered is connected.

 makes it possible to modify the name of the base station.

 makes it possible to display the status of the base station concerned.  and  make it 
possible to put the base station concerned in or out of service.

 displays the number of DECT channels (3 or 6) and gives access to the following sub-features 
for the 4070 IO base station:

-  : by successively pressing this key, indicate the connection distance from the base to the sys-
tem: short line (0-400 m), average line (400-800 m) or long line (800-1200 m). This data is ne-
cessary for synchronization with trame DECT.

-  : by successively pressing this key, indicate whether the 2 antennas (Diversity) or only the first
(No diversity) are used. 

-  : reading the software version currently on the base station.
-  : reading the software version for initialization of the base station.

 makes it possible to delete the data relating to the base station concerned.

ACCESS PROCEDURE FOR A GAP DECT HANDSET - REGIST

  makes it possible for a registered GAP DECT handset to carry out an access procedure. A 
particular piece of information is sent to the DECT handset enabling it to carry out this procedure.

MANDATORY AUTHENTICATION CODE - AUTHEN

  is used to define the system operating mode: recording of stations with or without an 
authentication code.  lets you switch from ON to OFF.

HANDST
A

GOTO 

BASES
A

NAME 

OUTINS INSERV OUTOFS

DETAIL

LENGTH

ANTDIV

FIRMID

BOOTID

DELSET

REGIST
A

AUTHEN
A

CHOICE
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MODIFYING THE AUTHENTICATION CODE - AUTHCD

  makes it possible to modify the authentication code (up to 8 digit AC code) requested during 
system access.
AUTHCD

A
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BACKUP AND RESTORATION OF THE 
CONFIGURATION
This function provides manual backup controls and restoration controls and enables the definition of 
parameters enabling backup and restoration of the configuration.

Press .

MANUAL BACKUP - MANBKP

Press  . Validate; the backup starts.

AUTOMATIC BACKUP - AUTBKP

  makes it possible to define the date and time of the first automatic backup as well as the 
periodicity. 

 makes it possible to state the interval (00 to 99 days) separating 2 automatic backups (00 cor-
responds to an infinite interval: no backup).

 makes it possible to state the date (as: Day 01-31/Month: 00-12) of the first backup.

 makes it possible to state the time (as: Hour 00-23/Minutes: 00-59) of the first backup.

AUTOMATIC RESTORATION - RESTOR

Press  . Validate; the restoration starts.

Manual backup control

Automatic backup:

Restoration control

- date of first backup
- time of first backup

- periodicity

A

DATSAV

PERIOD

DATE

TIME

MANBKP

AUTBKP

RESTOR

DATSAV

MANBKP
A

AUTBKP
A

PERIOD

DATE 

TIME 

RESTOR
A
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MOVING OF 2 STATIONS
This function is used to move the physical addresses of 2 stations of the same family.

Press .

Enter the directory number of station 1 (source station). 

Enter the directory number of station 2 (destination station).

Follow this moving procedure:

- press  : the 2 stations are put out of service and logically moved.
- physically move the 2 stations.
- press  : the 2 stations are put back in service.

Backup:
- 2 stations switched off

Station 1

- logical moving of 2 stations
Physical moving of 2 stations

Station 2

Restoration
- 2 stations switched on again

MOVING SAVING

RESTOR

MOVING

SAVING

RESTOR
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DISA
This function is used to define the various parameters necessary for analog DISA and DISA transit ser-
vices.

Press .

ANALOG DISA - ANALOG

Press .

 by successively pressing this key, it is possible to select the message transmitted during a DISA 
call on an analog line:  Msg1 to Msg8.

DISA TRANSIT - TRANSI

Press .

 makes it possible to modify the personal code for accessing the DISA transit service. Enter the 
current code then the new code and validate.

 by successively pressing this key, it is possible to define the system response in the case of an 
unavailable MF receiver for a DISA transit call:  camp-on authorized or call failure and redistribution.

 by successively pressing this key, it is possible to select the message transmitted during a DISA 
transit call:  Msg1 to Msg8.

 makes it possible to reset the DISA service access control code.
 makes it possible to reset the DISA call failure counter (this counter's value is not displayed).

DISA

PASSWD DISA service access control code (up to 16 characters)

Await DTMF receiver

DISA message number

WTDTMF

MSG

TRANSI

MSG Message for DISA on analog linesANALOG
Analog DISA

DISA Transit

RESCOD Reset code

RESCNT Reset DISA call failure counter

DISA 

ANALOG

MSG 

TRANSI

PASSWD

WTDTMF

MSG 

RESCOD

RESCNT
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ARS CALENDAR
This feature makes it possible to define the operation parameters by ARS mechanism time ranges.

Press .

TIME RANGES - TIMERA

Press  .

By successively pressing  and , it is possible to switch to the previous and next time range.

By successively pressing  and , it is possible to switch to the group for the previous and next 
days (Day 1, Day 2, Day 3).
By successively pressing  and , it is possible to switch to the group for the previous and next 
operator (1 to 4) defined for the time range and for the current day's group.

 makes it possible to delete the name of the operator.
 makes it possible to modify the name of the operator; press  or enter the first letter of the 

ARSCAL

A

CHOICEDAYS

CHOICEHOLID.

MODIFY

TIMERA

CLEAR

MODIFY

HOUR-

HOUR+

DAY-

DAY+

OP-

OP+

ADDTIM

DELTIM

DELALL

Allocation of a day group to the days of the week

Definition of bank holidays (+ allocation of a day group)

Time ranges (addition and deletion of a range, deletion of all the ranges, 
operator deletion and modification)

ARSCAL

TIMERA A

HOUR− TIME 

DAY− DAY 

OP− OP− 

CLEAR 

MODIFY MODIFY
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name of the operator using an alphabetic keypad.
 makes it possible to add a time range by defining a start time (information in the current visible 

range is copied into this new time range). 
 makes it possible to delete the current time range (visible range).
 makes it possible to delete all the time ranges and their contents.

Notas :

The operators can only be defined by MMC PM5.

The 7 days of the week can be split up into 3 groups of days (example: Day 1 for Sunday, Day 2 for 
the 5 working days, Day 3 for Saturday); this makes it easier to allocate operators to the days of the 
week.

ALLOCATION OF A GROUP FROM DAY TO DAY IN THE WEEK - DAYS

Press  .

 makes it possible to switch to the next day of the week.

By successively pressing , choose the group of days to be associated with the current day of the 
week.

DEFINITION OF BANK HOLIDAYS - HOLID.

   makes it possible to enter bank holidays.  

 makes it possible to switch to the next bank holiday.

By successively pressing , choose the group of days to be associated with the next bank holiday.
 makes it possible to modify or create a bank holiday.

- For changeable bank holidays (Easter for example):  enter the date as DD/MM/YYYY.
- For set bank holidays (Christmas for example):  enter the date as DD/MM (at the next consultation,

the character * is displayed instead of the year).

ADDTIM

DELTIM

DELALL

DAYS A

NEXT 

CHOICE

HOLID. A

NEXT 

CHOICE

MODIFY
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MULTI REFLEXES
This feature makes it possible to define the parameters concerning each Multi Reflexes connected to 
the system; each Multi Reflexes allows 3 Reflexes stations to be connected.

Press  and then enter the slot number and equipment number of the interface to which the Multi 
Reflexes to be parameterized is connected.

MULTI REFLEXES NAME - NAME 

Press .

Enter the Multi Reflexes name (18 characters):
- either using the alphabetic keypad
- or the station's numeric keypad which automatically switches to "letters" mode

Switch Multi Reflexes on/off

MLTRFX

OUTINS INSERV

OUTOFS

Enter MultiReflexes nameNAME

DETAIL INTF1

INTF2

INTF3

INSERV

OUTOFS

Switch Multi Reflexes 3 interfaces on/off

FIRMID

DELSET

Read Multi Reflexes software version

Delete Multi Reflexes data

Identification 
(slot, equipment)

MLTRFX

NAME
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MULTI REFLEXES STATUS - OUTINS  

 lets you switch the Multi Reflexes off and then on again. Reminder:  a Multi Reflexes is switched 
on automatically (as in the case of a Reflexes station). 

If the secondary UA interfaces (see DETAIL function) are not declared as off, the Multi Reflexes cannot 
be switched off.
A Reflexes station cannot switch off the Multi Reflexes it is connected to.

The Multi Reflexes can be:

- In Service
- Out of Service
- Physical OOS/Logical OOS: Multi Reflexes not operational
- Physical OOS/Logical IS: Multi Reflexes not seen by the system (not declared or disconnected) or

switched off by the installer

STATUS OF SECONDARY UA INTERFACES - DETAIL

 makes it possible to read the last 3 digits of directory numbers and declare the 3 secondary UA 
interfaces of the Multi Reflexes as on/off.

 and  make it possible to modify the state of each secondary UA interface.

SOFTWARE VERSION - FIRMID

 makes it possible to read the software version embedded in the Multi Reflexes.

ERASING OF DATA - DELSET

 makes it possible to delete all Multi Reflexes data (this operation is only possible after the Multi 
Reflexes is switched off.

OUTINS

DETAIL

INSERV OUTOFS

FIRMID

FIRMID
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INTEGRATED VOICE SERVER
This feature makes it possible to manage voice guides and configure broadcasting lists.
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VMU AUTOAT DAY

NIGHT

GDBYE

LISTEN

RECORD

DFAULT

NEXT

PREV

AUDTX DAY

NIGHT

LISTEN

RECORD

DFAULT

LIST CLEAR

NEXT

PREV

LISTEN

RECORD

EDIT

GALMBX LISTEN

RECORD

DFAULT

Configuration broadcasting lists

General mailbox welcome message

INFMSG LISTEN

RECORD

Recording of information messages

NEXT
PREV

NOTIF LISTEN

RECORD
Recording of the message notification announcement

GDBYE

DFAULT

Voice guides of the opening and closing times 
of the Audiotex "Goodbye" announcement

Voice guides for the opening and closing times of the 
automated attendant "Goodbye" announcement
Ed. 042/6 Réf. 3EH 21000 BSAA



File
25

INTEGRATED VOICE SERVERMMC STATION

 

Press .

AUTOMATED ATTENDANT - AUTOAT 

 lets you define 3 different types of automated attendants:

-  : lets you access voice guides for opening times.
-  : lets you access voice guides for closing times.
-  : lets you access voice guides for the “Goodbye” announcement.

For the  and  functions, the following possibilities are provided: 

-  : lets you listen to the recorded or default voice guide.
-  : lets you return to the previous voice guide (main menu, sub-menu 0 to 9, welcome messa-

ge).
-  : lets you go on to the next voice guide (main menu, sub-menu 0 to 9, welcome message).
-  : lets you record a customized voice guide.
-  : lets you erase the recorded voice guide and replace it by the default voice guide; this key is

only provided if recorded voice guides are available.
Select   (return to default voice guide) or .

For the  function (end of "Goodbye" announcement) the following possibilities are provided: 

-  : lets you listen to the recorded or default voice guide.
-  : lets you record a customized voice guide.
-  : lets you erase the recorded voice guide and replace it by the default voice guide; this key is

only provided if recorded voice guides are available.
Select   (return to default voice guide) or .

AUDIOTEX - AUDTX

 lets you define 3 different Audiotex types.

-  : lets you access Audiotex voice guides for opening times.
-  : lets you access Audio voice guides for closing times.
-  : lets you access the Audiotex “Goodbye” announcement voice guide.

The following possibilities are offered: 

-  : lets you listen to the Audiotex recorded or default voice guide.
-  : lets you record a customized Audiotex voice guide.
-  : lets you erase the recorded voice guide and replace it by the Audiotex default voice guide;

this key is only provided if a recorded voice guide is available.
Select   (return to default voice guide) or .

VMU 

AUTOAT

DAY

NIGHT 

GDBYE 

DAY NIGHT 

LISTEN

PREV 

NEXT 

REGIST

DFAULT

YES NO

GDBYE 

LISTEN

REGIST

DFAULT

YES NO

AUDTX 

DAY 

NIGHT

GDBYE 

LISTEN

REGIST

DFAULT

YES NO 
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BROADCASTING LISTS - LIST 

 lets you customize broadcasting lists (51 possible lists including a general broadcasting list).

The following possibilities are offered:

-  : makes it possible to delete all data relative to a broadcasting list.
-  : lets you create/modify the parameters of each broadcasting list.

•  : lets you add a member to a broadcasting list.
•  : lets you return to the previous member.
•  : lets you go on to the next member.
•  : lets you delete a member from the list.
-  : lets you modify the name allocated to the list

-  : lets you listen to the broadcasting list name.
-  : lets you record the broadcasting list name.

GENERAL MAILBOX - GALMBX

 lets you define the general mailbox welcome message:

-  : lets you listen to the recorded or default welcome message.
-  : lets you record a customized welcome message.
-  : lets you erase the recorded welcome message and replace it by the default message; this

key is only provided if a recorded message is available.
Select   (return to default message) or .

LIST 

CLEAR 

EDIT 

ADD 

PREV 

NEXT 

CLEAR 

NAME 

LISTEN

REGIST

GALMBX

LISTEN

RECORD

DFAULT

YES NO 
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INFORMATION MESSAGES - INFMSG

 lets you record up to 50 information messages used by the Automated Attendant and the Audio-
tex service (opening or closing times).

-  : lets you listen to the recorded information message.
-  : lets you record an information message
-  : lets you return to the previous message.
-  : lets you go on to the next message.

Nota : Other parameters (message name, end of message response) have to be configured by 
PM5.

MESSAGE NOTIFICATION ANNOUNCEMENT - NOTIF

This function makes it possible to define the announcement for a remote notification of messages:

-  : lets you listen to the recorded or default announcement.
-  : lets you record a customized announcement.
-  : lets you erase the recorded announcement and replace it by the default announcement; this

key is only provided if a recorded announcement is available.
Select   (return to default announcement) or .

INFMSG

LISTEN

REGIST

PREV 

NEXT 

LISTEN

RECORD

DFAULT

YES NO 
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SOFTWARE KEYS
DESCRIPTION

The Alcatel OmniPCX Office system a software key is represented by  a string of alphanumeric cha-
racters which opens functionality's. To each Alcatel OmniPCX Office system (each Main CPU) are as-
sociated 2 software keys: 

- The  MAIN Software key for the main services

- The  CTI Software key  for the CTI services

The software key correspond to a text file where the name takes the CPU hardware number with the 
.MSL  (MAIN key), or .CSL (CTI key).

Example: file 000068DA.msl and 000068DA.csl for CPU N° 000068DA.
Each system needs the Main and CTI Software keys even if no CTI application is used on the system.
The systems are delivered with a default software key or with a client personalised key . The Distributor 
needs to load if necessary the personalised key on the non factory configured systems.

CONFIGURATION

The key downloading is necessary when CPU  replacement or when modification for features enhan-
cement on the System.

However, the installation can be adapted to meet new needs when the system is in place by entering 
a new software key:

Two software keys can be entered: one for the system functionalities (Main key, 42 to 120 characters), 
the other for CTI functionalities (CTI key, 17 to 161 characters). 

Keys consist of: 

- all upper-case letters except I and O
- all digits except 1 and 0
- the special characters #, $, %, &, *, +, @, ( and )

In some case it's necessary to do a warm reset for taking account the new key, a message is 
displayed for doing this reset. ( See Table )

Nota : When reading out by PM5 the software key , the values displayed correspond to the actual 
opened services. The actual opened services are defined by both the software key and the 

- by MMC-PM5 (Easy View): Modification Typical -> System -> Software License 
- by MMC-Station: Global -> SwKeys -> Main/CTI
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hardware configuration of the system and not just the values contained in the key.

SOFTWARE KEY CONTROL MECANISM ON THE SYSTEM

On starting up the system different cases are possible :

- The services needed by the customer are open and work properly: the software key present
on the system is correct.

- Services needed are not open

- The key is valid but some services are not opened (verification done by MMC). 

• Check the Order to verify if it corresponds to the customer requirements,  if not contact your
Ordering Department. A new software key needs to be created including the news features.

- When loading the key via PM5 a warning message is displayed. In this case the features can
be reduced due to a missing of memory ( Hard disk or XMEM )or CPU power ( CPUe ) .(See
table below )

- The software key present on the system is  not correct :

• The software key checksum is correct but does not correspond to the CPU serial Number.The
system works correctly with all features for 30 days . A message " Software Key Error " is dis-
played on the Operator. The  pushing of the Alarm key indicates the expiring date.When loa-
ding a correct key ( good CPU serial number )during this period the system goes to normal
state. When no correct key is loaded after 30 days the system will restart in limited state with
only the Operator working, all other sets are out of service.

- The software key checksum is not correct. The system will start in limited state.When loading the
correct Software key (with the good serial number) the system restarts with all functions working.

After loading a correct software key the system will restart with all functionality's

PROCEDURE IN CASE OF PROBLEM

To get the right key corresponding to the CPU you need to contact ALCATEL.. You have to indicate 
what is the problem.

- Customer CPU was changed ( Indicate the old and new CPU N°)

- The system was delivered with a software key corresponding to the CPU but does not work 

- Etc….
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LIST OF SOFTWARE KEYS AND HARDWARE EQUIPMENT NECESSARY TO 
GET OPERATIONAL THIS FEATURES

APPLICATIONS Hardware Software keys

To order Extension to system 
with CPUe

 Extension to system 
with CPU

VOICE FEATURES

2 system languages No special hardware requirements No key

4 system languages CPU + XMEM64 or 
CPUe

No additional hardwa-
re

XMEM64 or Voice Hard 
disk

Add2 system langua-
ges 

4 pre-announcement messages No special hardware requirements No key

8 pre-announcement messages CPU + XMEM64 or 
CPUe

No additional hardwa-
re

XMEM64 or Voice Hard 
disk

No key

Default "Please Wait" music:16 
seconds

No special hardware requirements No key

Customized "Please Wait" 
music: 2 minutes

No special hardware requirements No key

Customized "Please Wait" 
music: 10 minutes

Voice Hard disk No key

NMC with 1000 metering tic-
kets

Voice Hard disk 1000 NMC tickets 

ARS features No special hardware requirements No key

Reflexes terminal users UAI boards Add Reflexes users

DECT (or Reflexes DECT) users 4070 IO/EO base stations DECT users 

 Analog terminals users SLI boards Add analog users 

VOICE MAIL

VMU: 2 ports - 20 minutes No special hardware requirements No key

Name announcement No special hardware requirements No key

Mailbox welcome messages CPU = 10 mailboxes with welcome messages or CPU + XMEM64/CPUe = 
50 mailboxes with welcome messages or Hard disk = up to 200 mailboxes 

with welcome messages 

Welcome messages

VMU: 4 ports - 20 minutes No special hardware requirements Add2 ports

VMU: 4 ports - 80 minutes CPU + XMEM64 or 
Voice Hard disk or 

CPUe

No special hardware 
requirements

XMEM64 or Voice Hard 
disk

Add2 ports + up to 80 
minutes

VMU: 6 ports - 80 minutes CPUe No special hardware 
requirements

IMPOSSIBLE Add4 ports + up to 80 
minutes

VMU: 6 ports - 8 or 200 hours CPUe + Hard disk Hard disk IMPOSSIBLE Add4 ports + up to 8 
or 200 hours

VMU: 8 ports - 8 hours CPUe + Hard disk Hard disk IMPOSSIBLE Add6 ports + up to 8 
hours

VMU: 8 ports - 200 hours CPUe + Hard disk Hard disk IMPOSSIBLE Open all VMU features

Distribution lists CPUe + Hard disk Hard disk IMPOSSIBLE Open all VMU features

Recording of conversations CPUe + Hard disk Hard disk IMPOSSIBLE Open all VMU features
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Pre-configured Automatic At-
tendant & Fax/Modem Swit-
ching

CPU + XMEM64 or 
Hard disk or CPUe

No special hardware 
requirements

XMEM64 or Voice Hard 
disk

Basic Automatic Atten-
dant 

Customized Automatic Atten-
dant & Audiotex

CPU + XMEM64 or 
Voice Hard disk or 

CPUe

Hard disk Hard disk Full Automatic Atten-
dant 

 INTERNET SERVICES 

Internet access CPUe No additional hardwa-
re 

CoCPU@, XMEM64 Internet access

Proxy/Cache server CoCPU@, Data Hard disk, SLanX4 XMEM64, CoCPU@, 
Data Hard disk, 

SLanX4

Full Internet service of-
fering

VPN CoCPU@, SLan X4 XMEM64, CoCPU@, 
Data Hard disk, 

SLanX4

Full Internet service of-
fering

e-mail server CoCPU@, Data Hard disk, SLanX4 XMEM64, CoCPU@, 
Data Hard disk, 

SLanX4

Full Internet service of-
fering

CTI

Integrated CTI server No special hardware requirements TAPI 2.0 interface 

External TAPI 2.1 server No special hardware requirements TAPI 2.1 server (4 ses-
sions, 10 monitoring)

CSTA interface No special hardware requirements Client CSTA (25 ses-
sions, 25 monitoring)

PIMphony Basic No special hardware requirements PIMphony Basic

PIMphony Pro No special hardware requirements PIMphony Pro

PIMphony Team No special hardware requirements PIMphony Team

VoIP

Voice over IP network CPU + XMEM64, CoC-
PU, SLanX4, VoIP dau-

ghter boards

CoCPU, SLanX4 XMEM64, CoCPU, 
SLanX4

IP channels 

IP Telephony with Fast IP Re-
flexes

e-Reflexes

IP Telephony with e-PIMphony PIMphony Pro or Team 
+ e-PIMphony Reflexes

NETWORK

Private access DLT2 or BRA Add B-channels

ISVPN ISVPN
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RESTRICTIONS

The following table lists the services controlled by the "Main" software key, the "limited" mode values 
and the configuration modularity.

Controlled servi-
ces

 Values 
in "limi-

ted" 
mode 

Mo-
dula-
rity

Max
Limit without 

X-MEN
Limit with X-

MEN 64
Limit with 

HARD DISK

 STANDARD TELEPHONY

Number of Reflexes 
sets

Accor-
ding to 
selected 
model

+1 236 236 236 236

Number of analog 
sets

+1 200 200 200 200

MOBILITY

Number of
 DECT +

 Reflexes DECT sets

0 +1 200 200 200 200

CALL MANAGEMENT

ARS open open open open open

DISA /Transit DISA open open open open open

ISVPN on ISDN closed open open open open

QSIG + closed open open open open

NETWORKS

Number of B-chan-
nels

0 +1 120 120 120 120

INTERNET ACCESS

Internet and Intranet 
Access

closed open

Proxy: Web cache 
and Access control

closed open

E mail closed open

VPN Internet closed open

Internet Access
on CoCPU

NO YES

LAN TELEPHONY

Number of IP Pho-
nes

0 +1 200 0 0 0 200 200 200
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Number of
PIM-Telephony Mul-

timedia terminals

0 +1 200 0 0 0 200 200 200

VoIP GATEWAY

Number 
of VoIP channels

0 +1 120 120 120 120 120 120 120

VoIP

VoIP on CoCPU NO YES

VOICE MAIL UNIT AND AUTOMATED ATTENDANT

Number of VMU 
ports

2 ports +1 8 4 8 4 8 4 8

Storage 
capacity

20’ 10’ 200h 20’ 1h20’ 200h

Automated
Attendant

closed open closed open & non 
configurable*

open & confi-
gurable

Audiotext closed open closed closed open

Fax switching closed open open open open

Mailbox welcome 
messages

closed open open open open

Name in mailing 
lists

closed open closed closed open

Recording of
conversations

closed open closed closed open

GREETING

Number of
 messages (16")

4 +4 8 4 4 4 8 4 8

PLEASE-WAIT MUSIC

Duration 2 min. 2 min. 10 
min.

2 2 10

METERING

Number of NMC tic-
kets

0 1000 30000 1000 1000 1000 1000 30000 30000

Controlled servi-
ces

 Values 
in "limi-

ted" 
mode 

Mo-
dula-
rity

Max
Limit without 

X-MEN
Limit with X-

MEN 64
Limit with 

HARD DISK
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LANGUAGES

Number of langua-
ges

2 2 4 2 2 4 4 4 4

Controlled servi-
ces

 Values 
in "limi-

ted" 
mode 

Mo-
dula-
rity

Max
Limit without 

X-MEN
Limit with X-

MEN 64
Limit with 

HARD DISK
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PROBLEM-SOLVING METHODOLOGY
This section does not deal with failures caused by configuration errors nor with those caused by errors 
in the telephone features.

In either of these cases, refer to the sections on MMC-Station and Telephone Features.
In all cases, a perfect knowledge of the system (architecture, distribution of function processing, etc.) 
and of its telephone features is essential, and in particular the limits of these features.

Faults concerning distribution must be eliminated first.

To avoid taking a wrong track when determining faults, it is vital to define the source of the fault from 
the outset:
- operating error by the user
-  programming error by the user or operator
- programming error in implementation
- genuine system failure

TROUBLESHOOTING PROCEDURE

For any system failure, it is essential to make visual checks (LEDs for the various boards, data testing, 
automatic set testing), to check the power supply voltage (mains and battery) and to read the system 
messages.

The procedure is as follows:

- locate the terminal(s) affected by the fault. If several terminals are affected by the same fault, de-
termine the common link which might be the cause (logical numbers of the same board, geogra-
phical distribution, same type of programming, etc.)

- determine at what level the faulty feature is occurring (local or external call, etc).

WARNING
NO INTERVENTION IN THE CABINET IS AUTHORIZED FOR THE USER. ONLY THE
INSTALLER OR THEIR REPRESENTATIVE IS AUTHORIZED TO INTERFERE WITH THE
CABINET
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EXTENT OF FAILURE 

A failure may be characterized by various aspects:

- Total system failure:
• In this case, the fault can only be located in the module
- The failure is most likely to come from the power supply or from the CPU (control unit); the next

most likely cause is a set or network interface board interfering with the CPU.
- Total failure of a group of sets: 

• if all the sets are on the same board, then the fault probably lies in the board
- if all the sets go out on the same cable, then the fault probably lies with the cable.

- Total failure of a single terminal: the fault is probably in the set itself. If not, check the equipment
in question.

- Partial failure of a single terminal: the fault is probably due to the configuration or mode of ope-
ration.

DELIBERATE REPRODUCTION OF DEFAULTS

To make sure that your analysis of the fault is correct, it is essential to try to repeat the failure intentio-
nally, unless it is unequivocal and permanent.

Once the fault is observed or repeated, and depending on the presumed source of the failure, replace 
the faulty element with a working one and try to repeat the original fault again.

If the fault remains, carry out the complete analysis of the failure again.
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LOCATING FAULTS

Power supply problem

If the mains and battery operation LEDs are both out, check all the fuses.

If the fuses are correct, this means that the duration of the mains power outage has been longer than 
the battery autonomy.

CPU board problem

If the CPU board LEDs are off, or are on steady, the system control unit is not working.

Miscellaneous

For any fault signaled on a terminal (set, add-on module or optional terminal such as a printer, etc), 
the following operations will be necessary:

- Test of the maintenance terminal in place of the failed terminal
- Test of the terminal at the module level

ELEMENT SUBSTITUTION

RULES TO RESPECT

Any substitution (power supply, CPU station board, interface board, etc.) must be carried out 
with the system powered down.

With PM5 you can save and subsequently restore the configuration (see "Data Saving").

If replacing a PRA board, make sure that the configuration of the new board is consistent with the old 
one.

Powering up/down the system 

- Press the ON/OFF button.
- Wait for the LED to go to steady red (about 30 seconds): system powered down
- Press ON/OFF to power up again after intervening (with the boards plugged back in). Wait 3 to 4

minutes for the system to initialize completely.
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BOARD MANAGEMENT
PLUGGING IN A BOARD

When a board is plugged in, the system allocates numbers to the board equipment (subscriber direc-
tory numbers or line numbers); these numbers are allocated in ascending order of free system num-
bers. The board equipment is initialized with the corresponding default configuration.

When a board is plugged into a slot previously taken up by another board, this board is managed in 
the following way:

- if the new board is of the same type (same scan point) as the board previously plugged in, the new
board is assigned the same data (numbers and configuration) as the previous one

- if the new board is different from the previous one, the system deletes the previous board and as-
sociated data (the numbers allocated are now available and the default configuration is cancelled).
The new board is then recognized as if it was plugged into a free slot (the equipment numbers are
allocated in ascending order and the board initialized with the default configuration corresponding
to the new board type).

UNPLUGGING A BOARD

The system should always be powered down before unplugging a board.

In general, unplugging a board from the module does not trigger an update of the data allocated to 
the board (directory numbers, key programming, line parameters, etc) ; the unplugged board is con-
sidered as "absent and accepted" (it is taken into account when the system checks the equipment limits) 
as long as no other board is plugged into this slot or a cold reset carried out on the system. 

ALLOCATING DIRECTORY NUMBERS

When the system is booted, the directory numbers are assigned to the internal and virtual terminals on 
the basis of the default numbering plan, in the following order of appearance of interface boards and 
connected terminals:

- terminals connected to the SLI and UAI boards of the basic module
- terminals connected to the SLI and UAI boards of the add-on modules (if fitted)
- virtual terminals (XRA, DECT handsets, VMU, IP).

At the end of the system boot, the following numbers are assigned to the set options in order of ap-
pearance. 
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Example:

We have an Alcatel OmniPCX Office system comprising 2 modules:

- a basic module with 2 VMU ports and fitted with a UAI16 board (a V24 option is embedded in the
Reflexes sets connected to board interfaces 1 and 16)

- an add-on module fitted with a UAI16 board (a V24 option is embedded in the set connected to
the first board interface) 

- after the system boot, 10 DECT handsets are added using MMC-PM5.

In the above configuration, and with a 3-digit numbering plan, the following directory numbers are 
assigned:

- 101 to 116: Reflexes sets on the basic module
- 117 to 132: Reflexes sets on the add-on module
- 133 and 134: VMU ports 
- 135 and 136:  V24 accesses on the basic module
- 137:  V24 accesses on the add-on module
- 138 to 147:  DECT handsets 

Configuration checks

Every time a hardware or configuration change is made, the following limits are checked:

- corded interfaces: maximum 236. Any additional interface will be refused.
- directory numbers: maximum 250. Any attempt to add another number will be rejected. The

directory numbers assigned to the auxiliaries (VMU, XRA, etc) are not covered by these checks, and
are always accepted.

- D-channels (T0/T1/T2/DASS2 interfaces): maximum 12. Any additional interface (T0) or
board (PRA) will be refused.

- B-channels (TLs, ISDN access, VoIP access): maximum 120. Any attempt to add another in-
terface will be rejected (and the interface containing the B-channel in question declared out of ser-
vice).

- hard disks: maximum 2.

INITIALIZING SETS

On powering up, Reflexes sets execute a self-test:

- display test
- test of the LEDs or icons of the set and add-on module, if any
- audio test
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REPLACING/RELOCATING SETS
REPLACING A SET

You can replace your Reflexes set by connecting a set of the same family, but of a different type, into 
your phone socket. This substitution can be temporary or permanent.

Replacing an analog set by another analog set, or replacing a Reflexes set by a set of the same type, 
requires no special procedure (simple hardware exchange).

Temporary substitution

The replacement set keeps its own default functions (customized settings are not transferred). The data 
not transferred are stored in the Alcatel OmniPCX Office system until a set of the same type as the 
initial one is connected.

Permanent replacement

The maximum quantity of data from the initial set is transferred to the replacement. Data not transfer-
red are deleted.

Unplug Plug in Plug inUnplug

Defective
terminal

Repaired
terminal

Replacement
terminal

Your terminal is unserviceable Your terminal is repaired

Replacement
terminal

Unplug Plug in

Defective
terminal

Replacement
terminal

"Terminal replacement"
code + password
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Characteristics preserved during temporary or permanent set substitution 

- Rights (restricted features)

- Barring level

- Metering profile

- Messages and last caller repertories

- Destination set for metering reminder, forwarding and/or monitoring

- Set belonging to a hunting group and/or a Manager-Secretary relation

- Appointment reminder

- Locked or unlocked set

- Callbacks

- Active forwarding

- Last number redial

Data preserved during permanent set replacement 

Replacement of Reflexes sets

Regardless of the type of the initial Reflexes set and that of the replacement, the function and resource 
keys are not preserved. The directory numbers are preserved in accordance with the size of the direc-
tories of the stations concerned (for example, when replacing a Reflexes Advanced set with a Reflexes 
Premium set, only the first 10 numbers are preserved.

The add-on modules are always transferred provided the substitution set supports these modules.

RELOCATING A SET

If you move office, you can move your set from one socket to another and still preserve all or part of 
its settings.

Before relocating the set:

- You need to change the personal code, which must be different from the default code.

- It is advisable to lock the set. 
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Relocating a set to an unused socket

ADDING SETS

When adding sets, attention must be paid to the limits on the number of sets and the features offered 
by the system software key.

The set is recognized as soon as it has been plugged into the socket.

Unplug Plug in

Movement

"Terminal movement" code
+ Dir. P1
+ password
(not default password)

Plug in
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DATA SAVING
OUTLINE

Configuration backup

The backup operation concerns all the parameters not reinitialized during a warm reset:

- global data (software version, backup time and date, etc)
- configuration data (types of boards and terminals, characteristics of terminals and groups, keys

and repertory settings, numbering plans, directory, barring tables)
- data recorded by users (mail, appointment reminders, forwarding)
- metering counters

The configuration data backup can be activated in either of 2 ways:

- manually by the installer (MMC-PC or Station backup command)
- automatically and periodically, at a time programmed by the installer, using MMC-PC or Station

The backup session is exclusive of any MMC-PC or MMC-Station operation or customization session; 
any modification is ignored during backup. During the backup, avoid any activation or inhibition of 
services (appointment reminders are not protected, diversions and filtering are refused) which would 
modify the settings.

Any system data modification and any hardware modification by MMC PM5 or Station must be fol-
lowed by a backup.

Duration of a backup session: about 20 seconds per module; more than a minute for a multi-module 
installation. 

At the end of the session, a message appears in the hardware message table (to signal failure) or in 
the system history table (to signal success).

Configuration restore

The restore session is activated manually by the installer (MMC-PC or Station restore command). All 
the saved data are restored.

Duration of a restore session: 1 to 7 minutes.

At the end of the session, a message appears in the hardware message table (failure indication) or in 
the system history table (success indication).
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CONFIGURATION

- Manuel backup:

- Automatic backup:

- Restore:

- by MMC-PM5 (Expert View): Data Saving & Swapping -> Commands -> check Backup
- by MMC-Station: DatSav -> ManBkp

- by MMC-PM5 (Expert View):  Data Saving & Swapping -> Data Saving  -> Enter date, time
and periodicity

- by MMC-Station: DatSav -> AutBkp -> Enter date, time and periodicity

- by MMC-PM5 (Expert View): Data Saving & Swapping -> Commands -> check Immediate
Restore

- by MMC-Station: DatSav -> Restor
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SYSTEM MESSAGES
The system messages are divided into 2 tables:

- the hardware message table
- the history message table

INTERFACE MARKERS

XX # 1 for the first half-board of slot XX, XX # 2 for the second half-board, XX - YY for the YY access 
of slot XX, ***** concerning the system messages.

A board can be cut into 2 half boards, this means that the same board uses 2 LCP codes (one per half-
board). The 2 half boards may or may not be identical.

FORMAT OF SYSTEM MESSAGES ON REFLEXES ADVANCED SETS

To see the messages, go into an Installer session and choose the  feature out of the features of-
fered. Choose the sub feature  then  to read the history messages,  to read the hard-
ware messages or  to empty the hardware messages table.

30-12 15: 30 106 **** 01030000 001/005

- 30-12: date
- 15: 30: time
- 106: type of message
- ****: location (XX - YYY: access YYY of slot XX, *****: system)
- 01030000: INFO 0 to INFO 3 hexadecimal (INFO 0 = 01; INFO 1 = 03; INFO 2 and 3 = 00)
- 001 / 005: message index in relation to the total number of saved messages

GLOBAL

MAINTE RDHIST RDANOM

RRANOM
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HARDWARE MESSAGES

All of the hardware faults detected locally by a board or by the CPU board are listed in this table.

When the table is full, a new fault is memorized in place of the most recent message (the table may 
be emptied by an MMC-PM5 command or by cold starting the system).

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION

5 CONFIGURATION BACKUP 
FAILURE

9 CONFIGURATION RESTO-
RATION FAILURE

Check the 
configu-
ration.

33 KEY REDUCED

The features normally asso-
ciated with the active key 
have been reduced due to a 
hardware problem (CPU ty-
pe, insufficient memory, etc)

CPU 
board 
(80)

INFO 0 = reduced feature set index 

- 01: VMU storage capacity dimi-
nished 

- 02: number of VMU and Automa-
ted Attendant ports diminished 

- 03: Automated Attendant una-
vailable

- 04: Audiotex unavailable
- 05: welcome messages unavaila-

ble
- 06:  distribution list names una-

vailable
- 07: recording of conversations

unavailable
- 08:  duration of please-wait mes-

sage diminished
- 09: number of welcome messages

diminished
- 10: number of NMC metering sta-

tements diminished
- 11:  number of directory entries di-

minished 
- 12: number of languages dimi-

nished 
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34 SOFTWARE KEY CHANGE CPU 
board 
(80)

INFO 0 = type of key (0= main key; 1 
= CTI key)

INFO 1 = type of event

- 01: system booted with a key
which doesn’t correspond to the
system: the services are open for a
reduced period 

- 02: system booted with a valid key 
- 03: system booted with a key pro-

blem: the services are closed
- 12: valid key entered
- 13: the key present does not cor-

respond to the system: end of re-
duced period -> services closed

- 21: the key entered does not cor-
respond to the system -> services
open for a reduced period 

- 32: the services are closed, valid
key entered -> services open

50 ISDN ACCESS REBOOT 
PROBLEM

Board lo-
cation.

Interface 
marker

INFO 0 = D-channel

51 CLOCK PROBLEM

Clock synchronization pro-
blem detected on an add-on 
module interface 

Board lo-
cation.

Access 
marker

INFO 0 = type of interface: T0, T2, 
DASS2, etc.

52 SPECIFIC ACCESS PRO-
BLEM DETECTED BY AN 
ISDN BOARD LEVEL 2 

Board lo-
cation.

Access 
marker

INFO 0 = 1: FCS (Frame Check Se-
quence)
2: CRC (Cyclic Redundancy Check)

If the fault 
recurs fre-
quently, 
check the 
connec-
tion to the 
public 
network.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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53 ALARM DETECTED ON A 
PRIMARY ACCESS

Board lo-
cation.

Access 
marker

INFO 0 = XX: type of alarm

- 00: Level 1 synchronized; all sys-
tems go.

- 01: Synchronization loss in "multi-
ple frame" mode (synchronization
in "double-frame" mode is correct).

- 02: No multiple frames; T2 auto-
matically starts "double-frame"
mode.

- 04: Remote Frame Alarm.
- 05: Synchronization loss in "dou-

ble-frame" mode.
- 06: Alarm Indication Signal; se-

quence of "1"s received, interface
not synchronized.

- 07: Loss of Frame Alignment (oc-
curs when the cable is disconnec-
ted).

- 08: Temporary clock lag; synchro-
nization established.

- 09: Error rate; number of error
frames > 5 in 1 second.

- 10: Erroneous frames received in
the checksum (CRC).

- 11: The network emits this alarm
when the FALC sends erroneous
frames in the CRC.

Ensure 
that the 
alarm di-
sappears. 

If the fault 
recurs fre-
quently, 
check the 
connec-
tion to the 
public 
network.

54 EXTERNAL FAULT ON S0

External problem detected 
on an S0 access following 
release message giving cau-
se as "deactivation of level 
1"

Board lo-
cation.

Access 
marker

55 INTERNAL FAULT ON S0

Internal problem detected 
on an S0 access following 
release message giving cau-
se as "deactivation of level 
1"

Board lo-
cation.

Access 
marker

If the fault 
keeps re-
curring, 
check the 
bus wi-
ring.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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58 ISDN BOARD FAULT

A level 1 error was detected 
by the board's OBC 

Board lo-
cation.

Access 
marker

INFO 0 =type of error (not significant)

72 UNSUCCESSFUL ATTEMPT 
TO PRINT

Message emitted by the for-
matter (printer) after every 5 
failed print attempts.

Check the 
printer 
and its 
connec-
tion ca-
ble.

103 OBC FAULT Board lo-
cation.

INFO 0 and 1 = type of fault

200 4070 IO/EO BASE: SLAVE 
LINK CONNECTED TO IN-
VALID INTERFACE

Board lo-
cation.

Interface 
marker

INFO 0 = interface number invalid

INFO 1 = base station operating sta-
tus 

Check the 
cables on 
the 2nd 
link in the 
base sta-
tion 

201 4070 IO/EO 
BASE: FREQUENCY REJEC-
TION

Discrepancy between the 
number of frequencies con-
figured by the installer and 
the number of DECT fre-
quencies processed 

Board lo-
cation.

Interface 
marker

INFO 0 to 3 = bitmap of frequencies 
authorized and in use

202 4070 IO/EO BASE: LOSS 
OF SYNCHRONIZATION 
ON UA LINK 0 

Board lo-
cation.

Interface 
marker

INFO 0 = link status (0 = link KO; 1 
= link OK)

203 4070 IO/EO BASE: LOSS 
OF SYNCHRONIZATION 
ON UA LINK 1 

Board lo-
cation.

Interface 
marker

INFO 0 = link status (0 = link KO; 1 
= link OK)

204 4070 IO/EO BASE: NO RE-
PLY ON DSP PRESENT (RE-
SET)

Board lo-
cation.

Interface 
marker

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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205 4070 IO/EO BASE: TRANS-
MISSION ERRORS DETEC-
TED ON SERIAL LINK TO 
DSP (RESET)

Board lo-
cation.

Interface 
marker

206 4070 IO/EO BASE: ERRORS 
DETECTED DURING INIT 
PHASE  OF BOOT PRO-
GRAM (RESET)

Board lo-
cation.

Interface 
marker

207 4070 IO/EO BASE: ERRORS 
DETECTED DURING 
SOFTWARE DOWNLOAD 
PHASE 

Board lo-
cation.

Interface 
marker

208 4070 IO/EO BASE: RECEP-
TION BUFFER FULL

Board lo-
cation.

Interface 
marker

209 4070 IO/EO BASE: RECEP-
TION BUFFER FULL

Board lo-
cation.

Interface 
marker

220 DSP OUT OF SERVICE ON 
ONE OF THE BOARDS

Board lo-
cation.

INFO 0 = DSP number

INFO 1 = cause (resource problem, 
DSP overload, etc)

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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239 STORAGE MEMORY 
CHANGED OR LOST

CPU (80) INFO 0 = type of error

- 0: medium KO
- 1: medium full
- 2: checksum error
- 3: system file control error

INFO 1 = type of medium

- 0: NAND FLASH CPU
- 1: NAND FLASH XMEM
- 2: HARD DISK

INFO 2 = type of initial medium 

INFO 3 = affected memory area (me-
tering, alarms, voice prompts, etc)

242 ERROR ON OPENING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

243 ERROR ON CLOSING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

244 ERROR ON READING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

245 ERROR ON WRITING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

246 ERROR ON OPENING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

247 ERROR ON OPENING VOI-
CE PROMPT FILE 

CPU (80) INFO 0 to 3 = type and value of voice 
prompt

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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HISTORY MESSAGES

The events identified by the codes in the system history messages table concern modifications to the 
system hardware configuration (appearance/disappearance of boards or terminals, refusal of a board 
on exceeding equipment limits) or other events (reset execution, buffer fill rate attained, etc).

When the table is full, a new event is memorized in place of the oldest message.

This table is only emptied in the event of a cold system reset.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION

0 SYSTEM REBOOT INFO 0 = cause of reboot

- 1: MMC reset command 
- 2: reset due to hardware fault 
- 3 to 5: reset following softwa-

re problem
- 7: reset following software

key problem (the values of
the default key are used)

- 11: reset following software
swap or after restoration (fol-
lowing swap)

- 12: too many one-way com-
munications 

- 13:  automatic reset pro-
grammed by MMC

- 14: timeout expiry
- 55: normal reset 

1 DOWNLOAD INFORMATION CPU (80) INFO 0 = information

- 1: begin download
- 2: download finished 
- 3: download failure

INFO 1 = cause of failure

- 0: download complete
- 9: date invalid
- 11: file transfer error 
- 14: download incomplete
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2 SWAP INFORMATION

Program change-over

CPU (80) INFO 0 = 1: swap OK; 2: data 
saving error; 3: fault during swap 

INFO 1 = type of swap: 0: nor-
mal with data saving; 1: normal 
without data saving; 2: forced 
with data saving 

INFO 2 = acknowledgement: 0: 
no problem; 1: save KO; 2: res-
tore KO; 3: save/restore KO

3 LAUNCH OF CONFIGURATION 
SAVE

Data Saving

CPU (80)

4 CONFIGURATION SAVE OK CPU (80)

6 AUTOMATIC CONFIGURATION 
SAVE REFUSED

MMC session in progress

CPU (80) End the 
MMC ses-
sion. Save 
manually 
or wait for 
the next 
automa-
tic save.

7 LAUNCH OF CONFIGURATION 
RESTORE 

Data Saving

CPU (80)

8 CONFIGURATION RESTORE OK CPU (80)

10 DATA SAVING OPTION ABSENT

Data saving refused

CPU (80)

20 NOT ENOUGH RAM

Available space < 15 %

CPU (80)

21 MESSAGE POOL LEVEL CPU (80) INFO 0 = not significant

INFO 1 = type of pool

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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22 FLUX CONTROL ON A MEMORY 
POOL

Exceeded size of memory alloca-
ted to flux control on a memory 
pool

Board lo-
cation

INFO 0 = type of pool

INFO 1 = state (95 = exceeded 
95 % threshold; 75 = gone un-
der 75 % threshold)

30 DBMS SUICIDE CPU (80) INFO 0 to 3 = causes of suicide

31 CURRENCY CONVERSION -> 
EURO 

CPU (80) INFO 0 = 1: conversion OK

32 PRIORITY CALL CPU (80) INFO 0, INFO 1 = number of 
the set with which communica-
tion was lost in order to take a 
priority call

56 ISDN BOARD FAULT

The ISDN protocol management 
module detected a level 1 fault 
on an ISDN access

Board lo-
cation.

Access 
marker

INFO 0 = access status (0 = ac-
cess KO, 1 = access OK)

57 TEI DELETION CPU (80) INFO 0 = D-channel

INFO 1 = TEI

Analyze 
the 
reason 
why the 
TEI was 
modified 
by the 
network 
operator.

70 METERING SPOOLER K.O.

Message emitted by the spooler 
when the metering buffer (the ar-
ray where the tickets are stored) is 
n% full (70% by default) 

Check the 
printer 
and its ca-
ble con-
nection

71  METERING SPOOLER O.K.

 Message emitted by the spooler 
when the metering buffer is 
available again(-n% full; -70% by 
default)

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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90 ENTERING AN MMC SESSION CPU (80) INFO 0 = 1:  ADMINISTRATOR 
password; 2:  INSTALLER pas-
sword; 3:  OPERATOR password; 
5: protected access 

91 QUITTING AN MMC SESSION CPU (80)

100 BOARD BACK IN SERVICE 

(Following a system stoppage or 
after being unplugged)

Board lo-
cation

INFO 0 = type of board

101 BOARD DISCONNECTION Board lo-
cation

INFO 0 = type of board (if 
known)

104  TEMPORARY BOARD RESET Board lo-
cation

INFO 0 = 1: hardware fault; 2: 
no response from board; 3: fan 
fault; 4: running on battery; 5: li-
cense problem; 6:  maintenance 
problem; 7: reason unknown

INFO 1 = cause of reset

105  PERMANENT BOARD RESET Board lo-
cation.

INFO 0 = 1: hardware fault; 2: 
no response from board; 3: fan 
fault; 4: running on battery; 5: li-
cense problem; 6:  maintenance 
problem; 7: reason unknown; 8: 
power supply problem

INFO 1 = cause of reset

Discon-
nect and 
reconnect 
the 
board. If 
the fault 
persists, 
replace 
the board

106 BOARD REFUSED

The board has been refused and, 
in the case of a digital board, a 
permanent reset is performed on 
it

Board lo-
cation

INFO 0 = type of board

INFO 1 = cause of refusal

Check the 
hardware 
configu-
ration (the 
system li-
mits may 
have 
been ex-
ceeded)

107 MMC BOARD RESET

The reset of an interface board 
processor has been requested by 
MMC

Board lo-
cation

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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108 POWER DOWN: LAUNCH OF 
BACKUP PROCEDURE FOR A GI-
VEN BOARD 

Board lo-
cation

110 APPEARANCE OF A TERMINAL

A terminal has been recognized 
by the system. This terminal is 
now operational

NB: this message will only be sent 
if the NMC is present and active

Board lo-
cation.

Interface 
marker

INFO 0 = type of terminal

111 TERMINAL REFUSED 

Configuration limit attained

Board lo-
cation.

Interface 
marker

INFO 0 = type of terminal

INFO 1 = cause of refusal

INFO 2 = 1 (software license 
problem; in this case, INFO 1 = 
255 (terminal not totally refused, 
because recognized by MMC)

Check the 
hardware 
configu-
ration (the 
system li-
mits may 
have 
been ex-
ceeded).

112 FAULT ON A TERMINAL Board lo-
cation.

Interface 
marker

INFO 0 = type of terminal

INFO 1 = type of error

If the fault 
recurs fre-
quently, 
check the 
terminal 
and its 
connec-
tions.

113 INTERFACE REFUSED

An interface was refused because 
the system limits were exceeded

Board lo-
cation.

Interface 
marker

INFO 0 =type of interface Check the 
hardware 
configu-
ration (the 
system li-
mits may 
have 
been ex-
ceeded).

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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120 MODULE BACK IN SERVICE Control-
ler board 
(81 or 82)

INFO 0 = type of backpanel 
board (4 = BACK1; 5 = BACK2; 
6 = BACK 3

INFO 1 = module operating 
mode (0 = restricted mode, run-
ning on battery; 1 = normal mo-
de, running on the mains)

121 MODULE REFUSED Control-
ler board 
(81 or 82)

122 MODULE DISCONNECTED Control-
ler board 
(81 or 82)

123 POWER SUPPLY FAULT CPU (80) INFO 0 = mains power state (0 
= Mains KO - battery activated; 
1 = mains OK)

124 FAN FAULT INFO 0 = module (0 = basic 
module; 1 = extension 1; 2 = 
extension 2)

INFO 1 = fan identity (0 = fan 1; 
1 = fan 2)

INFO 2 = fan state (0 = KO; 1 = 
OK

125 POWER SAVING

System in power saving mode ; 
only the 2 first Reflexes sets and 
the T0 access are taken account

INFO 0 = module (0 = basic 
module; 1 = extension 1; 2 = 
extension 2)

126 DSP RESOURCE KO

Message not processed by the 
DSP of one of the controller 
boards

CPU (80) 
or con-
troller 
board (81 
or 82)

INFO 0 = 0 or 1 (DSP0 or DSP1)

127 DSP RESULT CODES 

These codes are used in confir-
mation messages and by the re-
ception buffer 

CPU (80) 
or con-
troller 
board (81 
or 82)

INFO 0 = 0 or 1 (DSP0 or DSP1)

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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128 DSP KO

The DSP of one of the controller 
boards is out of service.

CPU (80) 
or con-
troller 
board (81 
or 82)

INFO 0 = 0 or 1 (DSP0 or DSP1)

129 CPU KO

CPU board not detected by the 
backpanel board 10 minutes af-
ter initialization

INFO 0 = type of CPU (0 = Inter-
net access; 1 = VoIP)

INFO 1 = number of CPU resets 
during the-10 minute period

INFO 2 = CPU state 

INFO 3 = final byte of CPU 
board Internet address 

160 HARDWARE TABLE THRESHOLD

The critical threshold (80 % by 
default) of the hardware fault ta-
ble has been reached

CPU (80)

161 HISTORY TABLE THRESHOLD

The critical threshold (80 % by 
default) of the history fault table 
has been reached

CPU (80)

162 METERING TABLE THRESHOLD

The critical threshold (80 % by 
default) of the data metering buf-
fer has been reached

CPU (80)

163 URGENT TABLE THRESHOLD

The critical threshold (80 % by 
default) of the urgent alarms ta-
ble has been reached

CPU (80)

164 HARDWARE TABLE FULL

The hardware fault table is full

CPU (80)

165 HISTORY TABLE FULL

The history fault table is full

CPU (80)

166 METERING TABLE FULL

The data metering buffer is full

CPU (80)

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
Ed. 0414/24 Réf. 3EH 21000 BSAA



File
5

SYSTEM MESSAGESMAINTENANCE

 

167 URGENT TABLE FULL

The urgent alarms table is full

CPU (80)

168 BEGINNING OF NMC CON-
NECTION

The NMC application has esta-
blished a connection with the 
PABX

CPU (80)

169 END OF NMC CONNECTION

The NMC application has ended 
the connection with the PABX

CPU (80)

170 UNAUTHORIZED CALL

NMC call by analog XRA (prohi-
bited)

CPU (80)

171 INCORRECT NMC CALL

The PABX tried to establish a call 
to an NMC but it was unsuccess-
ful

CPU (80)

172 NMC CALL NOT ANSWERED

The PABX tried to establish a call 
to an NMC, but the call was not 
answered

CPU (80)

173 NMC COMMUNICATION 
FAILURE

The PABX connected to an NMC 
and sent an INFO message 
saying that an urgent alarm 
should be read. The PABX did not 
respond to this message.

CPU (80)

174 NMC COMMUNICATION 
FAILURE

The PABX received no ack-
nowledgement for the data sent 
in the message. The communica-
tion failed.

CPU (80)

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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175 NMC COMMUNICATION 
FAILURE

The PABX received no ack-
nowledgement for the establish-
ment request sent to the NMC

CPU (80)

176 ALARM REPORT FAILURE 

The PABX attempted to call the 
NMC to send urgent alarms, but 
the NMC number was not speci-
fied

CPU (80)

177 PABX NOT SAVED

The PABX attempted to call the 
NMC, but the NMC refused the 
call because it didn’t recognize 
the PABX

CPU (80)

178 UNKNOWN ALARM

There was an alarm on the PABX 
but it was not recognized by the 
NMC

CPU (80)

190 UNKNOWN IPUI CPU (80) INFO 0, INFO 1, INFO 2, INFO 
3 = last 4 bytes of the IPUI

221 ETHERNET LINK OUT OF SERVI-
CE

Board lo-
cation

Ethernet 
interface 
marker

Check the 
LAN con-
nection 
and, if ne-
cessary, 
the LAN 
elements 
(hub, 
switch).

222 ETHERNET LINK IN SERVICE Board lo-
cation.

Ethernet 
interface 
marker.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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223 REMOTE GATEWAY OUT OF 
SERVICE

INFO 0 to INFO 3: bytes corres-
ponding to the IP address

Check the 
IP connec-
tivity to 
the remo-
te ga-
teway 
(LAN, in-
termedia-
te IP 
router) 
and the 
remote 
gateway 
status.

224 REMOTE GATEWAY IN SERVICE INFO 0 to INFO 3: bytes corres-
ponding to the IP address

225 TRAFFIC OVERLOAD TO OR 
FROM A REMOTE GATEWAY

For each gateway, a traffic coun-
ter logs the overflow calls due to 
total occupation of the band-
width; the step value N for gene-
rating this message can be 
defined for each labeled address.

CPU (80) INFO 0 to INFO 3: bytes corres-
ponding to the IP address

If this 
alarm 
keeps re-
curring, 
increase 
the band-
width as-
sociated 
with the 
gateway 
in the ARS 
table, and 
the num-
ber of 
DSPs allo-
cated to 
VoIP ac-
cess.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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226 EXTERNAL GATEKEEPER INAC-
CESSIBLE

Check the 
IP connec-
tivity to 
the remo-
te gate-
keeper 
(LAN, in-
termedia-
te IP 
router) 
and check 
that the 
remote 
gatekee-
per is in-
deed on 
line.

227 VoIP CALL REFUSED

All incoming and outgoing calls 
refused due to busy IP accesses 
(no DSP or B-channel available) 
are logged by a traffic counter; 
the step value N for generating 
this message can be defined for 
each labeled address.

CPU (80) If this 
alarm 
keeps re-
curring, 
increase 
the num-
ber of 
DSPs allo-
cated to 
VoIP ac-
cess, or 
increase 
the band-
width in 
the ARS, 
or add a 
CoC-
PU@ + 
VoIP 
board.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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228 VoIP CALL FAILED

Calls made by IP Phones due to a 
lack of DSP channels are logged 
by a traffic counter; the step value 
N for generating this message 
can be defined for each labeled 
address.

CPU (80)  If this 
alarm 
keeps re-
curring, 
increase 
the num-
ber of 
DSPs allo-
cated to 
the IP user 
pool (de-
crease the 
number 
of VoIP-
access 
DSPs or 
add a Co-
CPU@ + 
VoIP 
board).

229 IP ENABLER 4098 RE NOT INI-
TIALIZED

DHCP problem 

Increase 
the num-
ber of IP 
addres-
ses in the 
DHCP 
server 
range 
(this ad-
dress ran-
ge must 
be greater 
than or 
equal to 
the num-
ber of IP 
Enablers 
to be ins-
talled).

230 EXTERNAL GATEKEEPER RE-
FUSED

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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240 VOICE MESSAGES UNAVAILA-
BLE

Detection error on RAM initializa-
tion by the BIOS

CPU (80) INFO 0 = number of megabytes 
of DRAM detected by the BIOS.

241 VMU MEMORY THRESHOLD 

The voice message recording 
memory area is nearly full.

CPU (80) INFO 0 = 1 (ON) if there are just 
a few minutes of recording time 
left; 0 (OFF) end of the anomaly.

TYPE MESSAGE LOCA-
TION

ADDITIONAL INFORMATION ACTION
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INFORMATION DISPLAYED

The information given below concerns the hardware messages as well as those contained in the system 
history.

TYPES OF BOARD (INFO 0 of messages 100, 101, and 244)

82H: integrated voice server 
9EH:  SLI board 
A0H:  UAI board 
A1H:  PRA board = E1
A2H:  PRA board = DLE1
A3H:  PRA board = T1
A4H:  PRA board = DASS2
A5H:  PRA board = MIC ISDN
A7H:  virtual XRA board 
A8H:  virtual VoIP board on main CPU 
B0H:  main or applications CPU board 
B1H:  MIX board 
B2H:  BRA board 
B3H:  LanX board 

TYPES OF TERMINAL (INFO 0 of messages 111 and 112)

00H: 4034 1G set

02H: 4023 1G set
06H: 4034 2G set
07H: 5028 set
08H: 4023 2G set
0AH: 4012 set
0BH: 5022 set
0CH: 4011 set
0EH: 4001 or 4003 set 
0FH: 5010 set
12H: 5018 set
14H: 5015 set
15H: 4003 set
16H: 4088 adapter
17H: First set
19H: Easy set
1BH: Premium set 
1DH: Advanced set 
1FH: 4070 IO set
20H: multi-Reflexes
22H, 23H: 4081 L 40-key add-on module 
24H, 25H:4081 M 20-key add-on module 
26H: MAC/PC option (UA2G set)
27H: external keyboard (for Reflexes set)
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28H:  V24 option (Reflexes 3G sets)
2AH:  Z option (Reflexes 3G sets)
2BH:  DECT option (Reflexes 3G sets
2CH:  S0 option (Reflexes 3G sets)
3BH:  Z standard 2-wire set 
3CH:  Z-CLASS standard 2-wire set
3DH: Alcatel GAP DECT handset without display
3EH: Alcatel GAP DECT handset with 16-character display
3FH: Third-party GAP DECT handset without display
40H: Third-party GAP DECT handset with 16-character display
41H: Reflexes set + 4097 CBL adapter 
42H: 4073 set 
43H:  Mobile Reflexes 100/200 set 
44H:  S0 set 
45H:  CSTA virtual terminal 

REASONS FOR BOARD REFUSAL (INFO 1 of message 106)

01H:  consumption limits exceeded 
04H: unknown board type 
05H: board refused
06H: no primary access in basic module
07H: feature denied (rights linked to license)
08H: max. number of applications CPUs attained

REASONS FOR TERMINAL REFUSAL (INFO 1 of message 111)

06H: UA devices exceeded(2 add-on modules per set and 4 options) 
07H: total number of terminals exceeded 
08H: number of users exceeded
09H: max. number of B-channels exceeded
0AH: max. number of T0 accesses exceeded
0BH: max. number of primary accesses exceeded 
0DH: incompatible terminal
0EH: number of programmable keys exceeded 
0FH: memory capacity exceeded 
10H: number of S0 accesses exceeded
11H: unauthorized terminal 
13H: number of DLT2 accesses exceeded 
19H: max. number of DECT base stations exceeded 
1CH: exceeded equipment level in module in terms of available energy
1DH: exceeded max. number of HSL resources in a module
1EH: exceeded max. number of HDLC resources for the overall system 
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Additional information contained in message 112 (INFO 1: type of error)

01H: transmission fault (Reflexes sets)
03H: set not responding or response incorrect
04H: set no longer responding
05H: message flow too large for set (Reflexes sets)
07H: transmission fault (Reflexes sets)
08H: transmission fault (Reflexes sets)
09H: transmission fault (Reflexes sets)
10H: no more memory available to store the messages intended for the subscriber (Reflexes sets)

TYPES OF INTERFACE (INFO 0 of message 113)

01H: analog set interface 
03H: T0 access interface
04H: T2 access interface
05H: S0 set interface
14H:  Reflexes set interface 
20H:  master DECT base interface 
21H:  slave DECT base interface 
22H:  DECT Reflexes interface 
25H:  Multi-Reflexes interface 
26H:  IP interface 
27H:  IP network interface 
2AH to 2DH:  interfaces MSG1 to MSG4 
2FH:  Audio In interface 
30H:  Audio Out interface 
31H:  General bell interface 
35H to 38H: interfaces MSG5 to MSG8
1DH: analog modem interface on RAXX board
1EH: ECMA 102 modem interface on RAXX board
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MANAGEMENT OF TWO-COLOR LED ON OPERATOR STATION

The two-color LED on the operator station flashes quickly (orange) in the following cases:

- on detection of either of the 2 following T2 alarms (message 53):
• MS : Missing Signal.
- RFA:Remote Frame Alarm.

- the metering ticket storage buffer is 70% full (default value) (message 70)
- metering printer fault (message 72); this alarm is only transmitted if the "PrintFault" flag is other

than 0.
- problem regaining ISDN access (message 50)
- mains power fault (message 123).
- the hardware message table is 80% full (message 160); this alarm is only transmitted if the "Ope-

rAlarm" flag is other than 0.
- erroneous NMC call (message 171).
- unanswered NMC call (message 172).
- NMC communication failure (messages 173, 174 or 175).
- NMC:  alarm report failure (message 176).
- NMC: PABX not registered (message 177).
- NAND Flash memory (CPU or XMEM) or hard disk not detected (message 239).

URGENT ALARMS 

The PABX will generate a call to the network management center (NMC) if any of the following alarms 
is detected:

- either of the 2 following T2 alarms (message 53):
• MS : Missing Signal.
- RFA: Remote Frame Alarm.

- the metering ticket storage buffer is 70% full (default value) (message 70)
- metering printer fault (message 72); this alarm is only transmitted if the "PrintFault" flag is other

than 0.
- problem regaining ISDN access (message 50)
- mains power fault (message 125).
- the hardware message table is 80% full (message 160); this alarm is only transmitted if the "Ope-

rAlarm" flag is other than 0.
- NMC: history table full (message 165).
- NMC: metering ticket table 80% full (message 162).
- NMC:  metering ticket table full (message 166).
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DATA RESTORATIONS 
In case of maintenance and exchange of CPU board (main CPU and/or CoCPU@), the data stored 
on the daughter board XMEM64 and/or the Hard Disk will or will not be restored depending on the 
conditions described hereafter.

PROCEDURE TO EXCHANGE A MAIN CPU BOARD

CPU with XMEM64 (no Hard Disk)

The XMEM64 is not faulty and doesn’t have to be exchanged

- Install the old XMEM64 on the new main CPU board.
- All datas stored in the XMEM64 board are normally still available after the CPU exchange. Howe-

ver, data saved on the XMEM64 board (messages, conversations, metering tickets) will not be res-
tored if for some reason it is not stored (see Nota). After which it will be requiered to make a cold
reset of the system, launch the "Data saving" process via PM5 to restore the data configuration in-
formation (see paragraph A).

Nota : You could find a new/replacement CPU delivered from the factory which will not always res-
tore the data from the XMEM. But normally it would only occur if the exchange CPU is not 
charged with a software version.

Paragraph A : The XMEM64 is faulty and has to be exchanged

When the new XMEM64 board is installed, launch the "Data restore" process via PM5 to restore the 
data configuration information.

Select Comm ->Write to PBX, select the box Voice Prompts (screen "Write to PBX"). 

The data restored are :
- names and announcements of the voice mail unit.
- auto attendant announcements, greetings.

But, voice mail messages, NMC metering tickets and conversations recorded can not be restored.

CPU without XMEM64

Launch the "Data restore" process via PM5 to restore configuration information. The voice files will be 
available in the conditions of paragraph A (except for customizable voices announces used with Hard 
Disk or XMEM64).
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CPU with Hard Disk

The Hard Disk is not faulty and doesn’t have to be exchanged

- Install the old Hard Disk on the new main CPU board.
- After a cold reset of the system, launch the "Data restore" process via PM5 (see paragraph A). All

informations saved on the Hard Disk are normally available (including voice messages and con-
versations recorded).

- The Internet Access configuration (FAI, users, proxy, security, ...) can be restored. Select the box
"Internet Access Data" during the data base restore (screen Write to PBX.

The Hard Disk is faulty and has to be changed

- All messages, record conversations and NMC metering tickets are lost.
- The cache memory is also lost.
- E-mails are lost if the Internet Access is managed by the main CPU.
- Voice files (= Voice prompts) are available by respecting the condition explained in paragraph A.

PROCEDURE TO EXCHANGE A CoCPU BOARD

The Hard Disk is not faulty and doesn’t have to be exchanged

Install the old Hard Disk on the new CoCPU board. All information saved on the Hard Disk are still 
available.

The Hard Disk is faulty and has to be exchanged

- E-mails and cache are lost.
- The Internet Access configuration (FAI, users, proxy, security, ...) can be restored. Select the box

"Internet Access Data" during the data base restore (screen Write to PBX).

PRECAUTIONS

Handle Hard Disk carefully. Most failures are caused by shock : either electrical or physical.
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START AND STOP OF A SYSTEM
TIME EXAMPLES

Notas : The given times are equivalent to hot or cold reset.

For the swap/restore procedure, count 2*(start+stop time)

The times given are only approximate times

START MONITORING

It is possible to follow the progress of the start in 2 ways:

- On the display of the Reflexes stations.
- Using the web browser

On station

On the display of the Reflexes station you will see the different steps of the system start with the fol-
lowing: Start x.y (x is the step and y the sequence)

Detail:

- Start 2-6: detection of the cards of the main cabinet
- Start 2-5 : search of extention 1 and loading of the DSP if the extension exists
- Start 2-4 : detection of the expander cards 1 (optional)
- Start 2-3: Search of extension 2 and loading of the DSP if the extension exists

Configuration CPU CoCPU Application Start Stop

Rack 1 CPUe No Telephony 3 min. 30 
sec.

15 sec.

Rack 3 CPUe  + XMEM + 
Hard Disk

2 x VOIP Telephony + 
VoIP

8 min.

Rack 3 CPUe + XMEM + 
Hard Disk 

VOIP Telephony + 
VoIP + Internet 
Access

10 min. 2 min.

Rack 3 CPUe + XMEM IA Telephony + in-
ternet Access

8 min. 30 
sec

10 sec.

3 x Rack 3 CPUe + XMEM + 
Hard Disk

No Telephony 5 min.
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- Start 2-2: detection of the expander cards 2 (optionnal)
- Start 2-1: end of detection of telephony (appearance of virtual cards XRA IVPS)
- UNBLOCKINKG of the telephony (stations are on operational duties)
- End if no CoCPU
- Start 1-0 : starting of the CoCPU
- End.

Web navigator (browser):

- 1) Disable the proxy used by your browser (navigator):

• on Netscape: Edit/ Preferences/ Advanced/ Proxy

- on Internet Explorer: Tools/ Internet options/ Connections/ LAN settings

- 2) In the address fiel enter: http://192.168.92.246 :81/ or http:// IP addresse of the CPU followed
by " :81/ "

- 3) In the login window, enter:

• user name: operator

- password: pbxk1064

- 4) Click on Main monitoring on the left of the screen. On your right you will have the sequences of
starting of the CPU 

This operation is available as soon as the system is in phase 1-6 (as per the station display) and is 
memorized for later consultation.

EXAMPLE OF START MONITORING BY NAVIGATOR (BROWSER)

The main system is starting up. Please wait ...

----------------------------
--- CPU TYPE: MAIN ---
----------------------------

--- Start of BIOS ---
Succeeded

--- Start of Linux kernel ---
Operating system: Linux 2.2.13-RTL2.0

Succeeded

--- Ramdisk initialization ---
Succeeded

--- Hardware detected ---
CPU:  AuthenticAMD  486 DX/4-WB
CPU speed:133 MHz
Ed. 042/6 Réf. 3EH 21000 BSAA



File
7

START AND STOP OF A SYSTEMMAINTENANCE

 

RAM size:64 Mb
Flash size:30075 kb
Xmem flash:present
Xmem flash size:60879 kb
Hard disk:present
Hard disk size:5729 Mb
Hard disk manufacturer: FUJITSU MHK2060AT

  --- Start of the software ---

 ++++++++++++++++++++++++
 ++ 8 ++ Start of Init of telephony  ++ 8 ++
 ++++++++++++++++++++++++

Type of reset : WARM 
Cti licence Status :  open 

++++++++++++++++++++++
++ 7 ++ Init controller Master ++ 7 ++

 ++++++++++++++++++++++

Dld DSP 0 : OK 
Type of Backpanel  : RACK 3

 Dld DSP 1 : KO 
Power supply Status :  MAIN 
++++++++++++++++++++++++++++++++
++ 6 ++ Detection of boards on controller Master ++ 6 ++
++++++++++++++++++++++++++++++++

 Slot : 2 - Board :         EBUA - hb in slot : 1 
 status : accepted 

 Slot : 3 - Board :       EBZ_LH - hb in slot : 1 
 status : accepted

 
 Slot : 7 - Board :          BRA - hb in slot : 1 
 status : accepted 

 FAN1 Status :  OK 
 FAN2 Status :  OK 
++++++++++++++++++++++
++ 5 ++ Init controller Sat 1  ++ 5 ++
++++++++++++++++++++++

++++++++++++++++++++++
++ 3 ++ Init controller Sat 2  ++ 3 ++
++++++++++++++++++++++

++++++++++++++++++++++++
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++ 1 ++ End of Init of telephony ++ 1 ++
++++++++++++++++++++++++

- > Creation of virtual boards :

Slot : 91 - Board :          XRA - hb in slot : 1 
status : accepted 

Slot : 92 - Board :         IVPS - hb in slot : 1
 status : accepted 

Comment : no restore, call handling is available 

+++++++++++++++++++++++
++ 0 ++ telephony is running ++ 0 +++
+++++++++++++++++++++++

Comment : no restore, call handling is available 

Comment : no restore, call handling is available 

Comment : no restore, call handling is available 

Slot : 6 - Board :          CPU - hb in slot : 1 
status : accepted

 
Slot : 9 - Board :          CPU - hb in slot : 1 
status : accepted 

Comment : no restore, call handling is available 

+ SLOT: 1 - CPU TYPE : MAIN 
ANV number :                 3EH73026ACAA 04  
db1 : absent 
db2 : xmem 
db3 : absent 
db4 : absent 
CPU speed:      133 MHz 
RAM size:       64 Mb 
Flash size:     32 kb 
Hard disk:      present 
Hard disk size: 5729 Mb 
Hard disk manufacturer: FUJITSU MHK2060AT               a_ 

+ SLOT: 5 - CPU TYPE : VOIP 
ANV number :                 3EH73026ACAA 04  
db1 : absent 
db2 : absent 
db3 : absent 
db4 : absent 
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CPU speed:      133 MHz
 RAM size:       64 Mb 

Flash size:     32 kb
 Hard disk:      absent 

 + SLOT: 8 - CPU TYPE : INTERNET_ACCESS
 ANV number :                 3EH73026ACAA 04 
 db1 : absent 

db2 : absent 
db3 : absent 
db4 : slanx4 
CPU speed:      133 MHz 
RAM size:       64 Mb

 Flash size:     32 kb 
Hard disk:      present 
Hard disk size: 5729 Mb 
Hard disk manufacturer: FUJITSU MHK2060AT               a_ 

  Detected sets :
 =========
 UA         : 5 
 MUA        : 0 
 IBS        : 0

 Z          : 8 
 mobile set : 0 
 V24        : 0 
 TA         : 0 
 S0         : 0 
 AOM        : 0 
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DATA TRANSFER PROBLEM WITH 
WINDOWS NT4
PROBLEM DESCRIPTION

During data transfer from a PC under Windows NT4 pack 6 by using TCP protocol, the transfer can 
stop and the application can be blocked.

This is due to a loss of acknowledge frame during the transfer. This problem occurs during the transfer 
of a big file: downloading of a software version, global save of a configuration, ...

This problem is already identified in Microsoft under the number : Q254930.

SOLUTION

To solve this Microsoft problem, it is mandatory to load a patch of Windows NT4. Microsoft doesn’t 
allowed us to send directly this patch to our distributors, so you must contact the Technical Support of 
Microsoft. We can only provide a procedure to contact Microsoft and request this patch.

PROCEDURE

- Go to the Microsoft Web site : www.microsoft.com

- Click to the page "Support"

- Click on the field List of phone numbers.

- Call the Microsoft Technical Support by using the phone number of the Welcome center.

- Describe the problem to the technician as it is written in the chapter "Description" and don’t forget
to give the anomaly number Q254930.

- Give your contact to the technician to receive the patch by mail.
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A

ACSE
"Association Control Service Element". OSI convention used for establishing, maintaining and re-
leasing connections between two applications.

ADN
Additional Designation Number.

AFU
"Auxiliary Function Unit". Daughter board of the CPU/CPUe board supporting ancillary functions
such as general bell, doorphone, audio in, audio out, etc.

API
"Application Programming Interface".

ARI
"Access Right Identifier". System identification number (DECT feature).

ARS
"Automatic Route Selection". A logic direction is a set of trunks used for a call with the following fa-
cilities: seeking out the optimal path for a call, using the least-cost operator or network; overflow
management: enables a PABX to find a new route to make an outgoing call when there are no re-
sources available in the initial trunk.

ASN-1
"Abstract Syntax Notation 1". OSI language for describing data types independently of processor
structures and technical representations.

ATA
"Analog Trunk Access". Board for connecting analog network lines (switched network).

B

BACKGROUND MUSIC
External device (e.g. radio tuner) that can broadcast music over the loudspeakers of idle terminals;
broadcasting is stopped automatically if there is an incoming call to the terminal or if the user ma-
kes a call.

BACP
"Bandwidth Allocation Control Protocol". Control protocol associated with BAP.

BAP
"Bandwidth Allocation Protocol". PPP protocol that manages bandwidth by allocating it dynamically
between two ports, i.e. between the two extremities of a point-to-point link.

BOD
"Bandwidth On Demand". Service that allocates bandwidth automatically in response to traffic vo-
lume.

BRA
"Basic Rate Access". Board for connecting T0 digital basic accesses; each access supports a data
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rate of 144 kbps, structured as 2 B-channels at 64 kbps for voice and data transmission, and 1 D-
channel at 16 kbps for signaling.

C

CCP
"Compression Control Protocol".

CHAP
"Challenge-Handshake Authentication Protocol". Security function supported on connections that
use PPP encapsulation: prevents unauthorized access.

CLIP
"Calling Line Identification Presentation". Complementary service for digital protocols that allows
the caller number to be presented to the called party.

CLIR/COLR
"Calling/COnnected Line Identification Restriction". Service that inhibits CLIP or COLP.

CNIP
"Calling Name Identification Presentation". Complementary service for private digital protocols
(ISVPN or ABC-F) that allows the caller's name to be presented to the called party.

COLP
"COnnected Line identification Presentation". Complementary service for digital protocols that al-
lows the number of the connected user (the one who answered the call) to be presented to the caller.

CONP
"COnnected Name identification Presentation". Complementary service for private digital protocols
(ISVPN or ABC-F) that allows the name of the connected user (the one who answered the call) to be
presented to the caller.

CPU
"Central Processing Unit". Term designating the processor or microprocessor. The central proces-
sing unit executes computer program instructions.

CSTA
"Computer Supported Telephony Application". ECMA standard that defines command exchanges
between a PABX and a server.

CTI
"Computer-Telephone Integration". Interaction mechanism between 2 sections, namely a data pro-
cessing section (computer) and a telecommunications section (PABX), independently of the physical
layout of the 2 sections.

D

DASS2
"Digital Access Signaling Specification number 2"

DDI
"Direct Dialing In". Direct external call number for the system terminals (depending on the configu-
ration with the public network operator).

DECT
"Digital Enhanced Cordless Telecommunication". European cordless telephony standard. DECT ter-
minal: cordless terminal that complies with this standard.

DHCP
"Dynamic Host Configuration Protocol". Protocol that manages IP address allocation dynamically
Ed. 042/8 Réf. 3EH 21000 BSAA



File
1

GLOSSARYGLOSSARY

 

so that addresses can be reassigned when no longer being used by LAN hosts.
DISA

"Direct Inward Station Access". Services (Analog DISA and Transit DISA) enabling outside callers to
dial a specific number giving direct access to the system.

DLL
"Dynamic Link Library". Windows library linked dynamically to an application.

DLT2
"Digital Line T2". Private 2 MHz link in PRA mode (= digital ATL).

DNS
"Domain Name Server". System used on the Internet for converting domain names or machine na-
mes into IP addresses. A domain name, unlike an IP address, is an easily memorized Internet ad-
dress.

E

ECMA
"European Computer Manufacturers Association".

ETHERNET
Local network (LAN) operating at 10 or 100 Mbps (10 base T or 100 base T) over a coaxial cable.
Ethernet is similar to the IEEE 802.3-series standards.

F

FTP
"File Transfer Protocol". Standard protocol for exchanging files between remote computers over the
Internet.

FTP/STP/UTP
"Foiled Twisted Pairs/Shielded Twisted Pairs/Unshielded Twisted Pairs". Types of connection cables
to be used between an Alcatel OmniPCX and an external distribution panel.

G

GATEKEEPER
Secure directory server.

GATEWAY
Device connecting different networks.

GENERAL BELL
If the operator is absent, internal and external calls to the operator are directed to an external si-
gnaling device that lets any authorized terminal take these calls.

H

HSL
"High Speed Link". Link between the basic module and an add-on module; requires an HSL dau-
ghter board to be fitted on the CPU and MEX boards.

HTTP
"HyperText Transfer Protocol". Standard application protocol for exchanging files (text, images,
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audio, video, etc) over the Internet.
HTTPS

"Secure HyperText Transfer Protocol". Secure version of HTTP: encrypts and decrypts pages contai-
ning user requests as well as pages retrieved from a web server.

H.323
ITU standard for multimedia communication (voice, video, data).

I

IAP
"Internet Access Provider". See ISP.

ICMP
"Internet Control Message Protocol". Network protocol that provides error reports and information
on the processing of IP packets.

IMAP4
"Internet Message Access Protocol". A protocol of the same type as POP3, the difference being that
the messages always stay on the ISP server, even after consultation. IMAP requires continuous ac-
cess to the server while the messaging service is in use.

IN
Installation Number.

IPSec
"Internet Protocol Security". Standard taking network security into account. Protocol used in the im-
plementation of VPNs, and for remote access by connection to a VPN.

ISDN
"Integrated Services Digital Network". Standard for the transmission of digital data over telephone
cables or other communication vectors.

ISP
"Internet Service Provider". A company that provides Internet access for individuals and enterprises,
along with other services, such as web site construction and hosting.

ISVPN
"Integrated Services Virtual Private Network". Protocol used in a private virtual digital network; it of-
fers functions such as transfer optimization and the transmission of information such as the name,
busy status or diversions.

ISVPN+
Includes metering information in addition to the usual ISVPN services.

ITU
International Telecommunications Union: global coordination body.

K

KEY SYSTEM (mode)
Reflexes terminal operating mode in which the terminal features as many resource keys (RSP) as
there are network lines in the system.

L

LAN
Ed. 044/8 Réf. 3EH 21000 BSAA



File
1

GLOSSARYGLOSSARY

 

"Local Area Network". Network of interconnected machines that share the resources of a processor
or server in a relatively restricted geographical area, usually the premises of a company.

LOUDSPEAKER
External loudspeaker used for broadcasting messages.

M

MANAGER/SECRETARY
Set of specific services (profile, filtering, diversion) between a manager terminal and a secretary ter-
minal.

MEX
Add-on module. Controller board for extension or 'add-on' module.

MIX
Mixed equipment board: T0 accesses, analog and reflexes terminal connection interfaces.

MPPP
"Multi-link PPP". A protocol that aggregates bandwidth from a number of links to obtain faster com-
munication speeds.

MULTILINE TERMINAL
Terminal that has several lines for managing several calls at the same time.

N

NAT
"Network Address Translation". A service that converts the IP address used on one network into ano-
ther IP address recognizable by another network. Address translation allows companies to keep
their own private IP addresses for internal purposes while using just one IP address for communi-
cation with the outside.

NMC
"Network Management Center". Workstation allowing a communication server administrator to re-
motely manage, administer (storage of call metering tickets for example) and optimize one or more
Alcatel OmniPCX Office systems.

NMT
"Numbering Modification Table".

NNTP
"Network News Transfer Protocol".  Protocol used by computers to handle messages created in Use-
net forums.

O

OS
"Operator Station". Dedicated Reflexes terminal for answering incoming calls from the public
network.

P

PABX (mode)
Mode of operation of Reflexes terminals; in this mode, all the network lines are materialized by ge-
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neral-purpose resource keys (RSB).
PAP

"Password Authentication Procedure". Procedure used by PPP servers to validate connection re-
quests.

PASSWORD
Code acting as a password, controlling access to the voice mail unit and the terminal locking func-
tion.

PAT
"Port Address Translation".

PCBT
"PC Based Telephony".

PE
"Public Exchange". 

PLEASE WAIT MESSAGE
An audio component of the system (or an external device, such as a cassette player) which plays a
message or piece of music while keeping an external correspondent on hold. 

POP3
"Post Office Protocol". Standard Internet protocol for receiving electronic messages. POP3 is a
client/server protocol in which the messages are received and hosted by the ISP. When a message
is read, it is transferred to the client terminal and is no longer hosted by the ISP.

PPP
"Point-to-Point Protocol". Protocol used in communication between two computers using a serial in-
terface (typically a PC connected to a server via a telephone line).

PRA
"Primary Rate Access". Board for connecting a T2 digital primary access; the access supports 48
kbps structured as 30 B-channels at 64 kbps for voice and data transmission, and 1 D-channel at
64 kbps for signaling.

PROXY
A proxy server is used as an interface between a user and the external Internet network.

PSTN
"Public Switched Telephone Network". 

PTN(X)
"Private Telecommunications Network (eXchange)". A private network consisting of switches and ter-
minals connected together by telephone links.

Q

QOS
"Quality Of Service". Network characteristics (transmission speed, etc.) can be measured, improved
and, to an extent, guaranteed in advance.

QSIG
"Q Signaling Protocol". Set of standard signaling protocols between the private PBXs of a telephone
network (Q reference point) interconnected by digital ATLs.

R

RADIUS
"Remote Authentication Dial-In User Service". A client/server protocol that enables remote access
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servers to communicate with a central server in order to authenticate remote users before allowing
them access to the systems or services they have requested.

RGO, RGI, RGM
General resource keys supporting local and or/external calls, whether outgoing (RGO), incoming
(RGI) or mixed (RGM).

ROSE
"Remote Operations Service Element".

RSB
Resource key dedicated to a trunk group (bundle); used for making external outgoing calls on a
particular trunk group and receiving all network calls.

RSD
 Resource key for a particular destination; supports local calls for this number if assigned to a speed
dial number, incoming calls for the number if assigned to a DDI number or outgoing calls on a
trunk group if assigned to a trunk group.

RSL
Resource key dedicated to a set; supports calls to and from a particular set.

S

S0 BUS
Type of connection for S0 digital terminals (passive short bus, long/short point-to-point bus, exten-
ded bus); S0 buses and terminals are connected up via an S0 option embedded in an Alcatel Re-
flexes terminal.

SELV
"Safety Extra Low Voltage". Classification of interfaces in accordance with standards EN60950 and
IEC 950.

SLAN
"LAN Switch". Daughter board for mounting on a CoCPU/CoCPU@ board to enable it to commu-
nicate with the CPU/CPUe.

SLI
"Single Line Interface". Board allowing the connection of analog terminals (also known as Z termi-
nals).

SMTP
"Simple Mail Transfer Protocol". Standard protocol used for sending and receiving mail.

SPI
"Service Provider Interface".

SSH
"Secure Shell". A UNIX interface protocol for obtaining secure access to remote computers.

T

TAPI
"Telephony Application Programming Interface". Standard defined by Microsoft.

TCP/IP
"Transmission Control Protocol/Internet Protocol". Standard protocol used on the Internet. TCP cor-
responds to the Transport layer (layer 4) of the OSI model. IP corresponds to the Network layer
(layer 3) of the OSI model.

TERMINAL GROUP
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Series of terminals grouped under the same directory number. Any call to that number is routed to
a free terminal line.

TFTP
"Trivial File Transfer Protocol". The simplest network application for transferring files.

TL
"(Analog) Trunk Line" connecting the system to the public switched network.

TSAPI
"Telephony Services API". Standard defined by Novell, based on ECMA's CSTA standard.

U

UAI
"Universal Alcatel Interface". Board used for connecting up Alcatel Reflexes terminals or DECT 4070
IO/EO base stations.

URL
"Uniform Resource Locator". Address of a resource (file, program, image, etc) accessible on the In-
ternet.

UUS
"User to User Signaling". Information carried clear end-to-end by ISDN to enable exchanges
between network subscribers; the ISVPN protocol is contained within this information.

V

VMU
Voice Mail Unit. The integrated voice server provides a voice mailbox for each user as well as a
general voice mailbox and features such as Personal Assistant, Automatic Attendant and Audiotex.

VoIP
"Voice over IP". Term designating voice transmission over a data network using the Internet protocol.

VPN
"Virtual Private Network". Private data network that uses the public telecommunications infrastruc-
ture (e.g. the Internet) while maintaining confidentiality by means of tunneling protocols and security
procedures.

W

WAN
"Wide Area Network". A geographically dispersed telecommunications network. The term WAN is
used in contrast to LAN.

WINS
"Windows Internet Naming Service". In Windows environments, the service that manages the cor-
respondence between client station names and LAN locations relative to their IP addresses.

X

XMEM
"eXpansion Memory". Daughter board of the CPU board that extends the memory capacity and al-
lows a hard disk to be connected.
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